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Welcome!
Welcome to PlanMaker! You have purchased an extremely powerful and easy-to-use spreadsheet application.

In developing this program, we have made every effort to integrate and harmonize PlanMaker's functions in
such a way that you get the greatest possible benefit with the least amount of work.

PlanMaker gives you enough freedom to meet your individual needs. A wide range of settings lets you set up
PlanMaker the way you like it best.

Note: This manual was written in order to describe how to use the program via the new ribbon user
interface. A description of its use via classic menus with toolbars can only be found in older manuals.

Tip: A table in the appendix shows you which ribbon command corresponds to which menu command:
Ribbon commands and corresponding menu commands

Some features of PlanMaker

§ Available for Windows, Mac, Linux, Android and iOS 

§ Well-designed, ergonomic user interface – either with a modern "ribbon" or classic menus with toolbars

§ PlanMaker knows more than 400 arithmetic functions – from simple totals to varied financial and
statistical functions.

§ Makes creating attractive worksheets easy through numerous formatting options. Simple columns of data
can be transformed into clear and appealing tables at the touch of a button using the "Tables in
worksheets" feature. With cell styles and character styles, you apply frequently needed formatting at the
touch of a button.

§ Integrated charting module that lets you present numbers vividly in charts

§ ... and much more!

PlanMaker is being developed continually. If, when working, you discover the need for a feature that is not yet
available, or if you have any other suggestions, please contact us as we want PlanMaker to meet the needs of
users!

Android version and iOS version

PlanMaker is also available for Android and iOS devices and contains practically all features of the Windows
version.
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Technical support
If you have any questions, our technical support team will be happy to assist you. You can reach us as follows:

Website

Our website provides the latest program updates, tips and tricks, free downloads and much more.

For more information, see: www.softmaker.com

Support forums

In our support forums, you can ask our technical support team any technical questions you may have, while also
communicating with other users.

These forums can be found at: forum.softmaker.com

Inquiries to our support team

If you have any problems with our software, we will happily assist you.

You can post your questions here: www.softmaker.com/en/support-assistant

About this manual
PlanMaker has a wide variety of functions – but don't worry: you don't have to master all of them! While you're
getting started, just use those you need. If you would like to make use of PlanMaker's more advanced functions
at a later stage, you can review the appropriate pages in the manual.

This manual is structured as follows:

§ The chapter Installation and program startup deals with the installation of PlanMaker. You also learn
how to start the program. 

§ The chapter Application window describes the individual components of PlanMaker's main window.

§ The chapter Basics provides information on PlanMaker's most important functions and explains basic
spreadsheet terminology.

§ The chapter The PlanMaker tour deals with the subject of spreadsheet processing in tutorial form and
shows you to use PlanMaker by means of some practical examples.

§ The chapter Editing worksheets and the following chapters are the reference part of this manual. These
chapters are organized by subject and provide a detailed description of all functions of PlanMaker.

http://www.softmaker.com/
http://forum.softmaker.com
http://www.softmaker.com/en/support-assistant
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System requirements
In order to run this software, you require the following hardware and software:

Windows version

§ Windows 11, 10, 8 or 7 (32-bit or 64-bit) 

Mac version

§ macOS as of version 10.12 (Sierra) 
§ Intel or ARM based CPU

Linux version

§ Any x86 Linux (64-bit) 

Android version

§ Android 5.0 or higher 
§ ARM-compatible CPU (32-bit or 64-bit)

iOS version

§ iOS 14.0 or higher 
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Installation and program startup
This chapter provides information on installing and starting PlanMaker.

It is divided by operating system into the following sections:

§ Installing on Windows 

§ Installing on macOS

§ Installing on Linux

§ Installing on Android devices

§ Installing on iOS devices

Please read the section for your operating system.

Installing on Windows

Download

If you obtained the software by downloading it from our website, you will find installation instructions in the e-
mail that you automatically received after purchasing the software.

CD-ROM

If you obtained the software on a CD-ROM, please start the installation program provided in the root folder of
the CD. Then follow the installation program's instructions to install the software.

Starting the programs

To start the installed programs, use the Start menu (the button with the Windows logo) in the lower left corner
of the screen. You will find your SoftMaker Office applications in a sub-folder called SoftMaker Office.

Address entry upon initial start: When you start PlanMaker for the first time, you will be asked to enter your name, address, etc. This information is not
used for registering the program. In fact it allows you to insert your name, address, etc. in documents or document templates using the USERFIELD
function. You can always change this information at a later stage (see Settings, General tab).
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Installing on macOS
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Is an error message displayed when you start the installation program?

Depending on your system settings, the following error message may be displayed when you try to start the
installation program:

This occurs when your system's security settings specify that only programs that have been downloaded from
the App Store may be run.

Clicking on the question mark in the lower left corner of the message reveals how you can still run the
installation program. You then see a help window in which the following procedure is recommended:

1. Close the error message.

2. Hold down the Ctrl key and click on the installation program.

3. A context menu is displayed. Choose the command Open.

4. You then see a message which asks you if you really want to open the program. Confirm this by clicking on
the Open button.

The installation program will now start.

Starting the programs

After the installation is complete, icons for each of the installed programs will be displayed in both the
Launchpad and the Dock at the bottom of the screen. To start one of the programs, simply click on its icon.
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Installing on Linux
You will find information about installing the software in the e-mail that you automatically received after
purchasing it.

Starting the programs

In most Linux distributions, the installation program automatically creates shortcut icons for all SoftMaker
Office applications in the menu. To start any of the applications, click on the corresponding icon.

Alternatively, the following scripts are available for starting the programs:

§ textmaker21 starts TextMaker. 

§ planmaker21 starts PlanMaker.

§ presentations21 starts Presentations.

You can execute these scripts in a shell, for example.

Address entry upon initial start: When you start PlanMaker for the first time, you will be asked to enter your name, address, etc. This information is not
used for registering the program. In fact it allows you to insert your name, address, etc. in documents or document templates using the USERFIELD
function. You can always change this information at a later stage (see Settings, General tab).

Installing on Android devices
If you download an application via the Google Play Store on your Android device, you do not need to do
anything as the application will be automatically installed after downloading it.

Installing on iOS devices
If you download an application via the Apple App Store on your iOS device, you do not need to do anything as
the application will be automatically installed after downloading it.
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Application window
The following pages contain an introduction to the individual components of the PlanMaker user interface, both
for the ribbon interface and for the classic menu interface.

In all other chapters, this manual is designed for the user interface with the ribbon.

If you would like to continue working with the classic menu interface, a table in the appendix shows you
which ribbon command corresponds to which menu command: Ribbon commands and corresponding menu
commands.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu). On the Appearance
tab, click on the User interface button.

Alternatively: Right-click on a free space in the ribbon or toolbar, and choose User interface.

Program window with the "Ribbon" user interface

PlanMaker with the "Ribbon" user interface (Windows version)
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Tip: Even when using the ribbon user interface, the classic menu commands are always accessible in the

ribbon view. To access them, use the "hamburger menu" (the icon  to the left of the Quick access toolbar,
highlighted in red). There, you will find all familiar menu commands from the classic menu user interface.

Program window with the "Classic menus" user interface

PlanMaker with the "Classic menu" user interface (Windows version)

Note: Most of the illustrations in this manual were produced with the Windows version of PlanMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Title bar
In the top line of the program, you will find the title bar.

This displays the program name and the name of the document that you are currently editing.

If the document contains changes that have not yet been saved, an asterisk is displayed after its name.
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User interface: Ribbon
If, in the settings, you have selected that you would prefer to use the Ribbon interface instead of Classic menus,
the upper area of the program window will look like this on your device:

The "Ribbon" and the Quick access toolbar (at the bottom)

The ribbon

Ribbons are a modern type of user interface that combines menus and toolbars to simplify the use of the
software.

As you can see, the ribbon has several tabs whose tab headers are displayed at the top: File, Home, Insert, etc.
Each of these "ribbon tabs" contains logically combined groups (for example, on the ribbon tab Home: Edit,
Character, Alignment, etc.) with related commands for a certain task area.

To switch to another ribbon tab, click on its tab header.

Tip: You can also switch between the ribbon tabs with a shortcut key: Use Ctrl+F12 to move to the next tab
and Ctrl+Shift+F12 to move to the previous tab. You can also scroll with the middle mouse wheel while
pointing to the top bar with the tabs.

Each icon represents a specific command. If you click on it, the corresponding command is chosen. In the group
Character on the ribbon tab Home, for example, you will find commands for formatting. You can use it to
both read and change the most common text formatting (font, bold, italics, etc.) for table contents.

If you select a section of text beforehand, formatting changes will affect only the selected text.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons are switches that you can enable or disable by clicking on them – for example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a text box called
a "tooltip", which describes the icon's function. This requires Show tooltips to have been enabled in the
settings.
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The group arrows  in the bottom right corner of each command group indicate that there are other options and
commands available for that group. Simply click on this arrow to open the dialog box belonging to the group,
where you can make further settings.

The Quick access toolbar

The Quick access toolbar is displayed below the ribbon. It provides a choice of frequently used commands.

§ Touch mode 

If you enable this button, all icons in the ribbon will be slightly enlarged. This is useful when operating the
software with your finger (for example, on a tablet).

§ Create a new file 

This button opens a new document. For more information, see Starting a new document.

§ Open a file 

This button opens an existing document. For more information, see Opening a document.

§ Save file 

This button saves the document that is open in the current window. For more information, see Saving a
document.

§ Undo 

This button undoes the last change made to the current document. You can also choose this command
several times in succession, see Undoing changes.

§ Redo 

This button restores the last undone change(s). For more information, see Undoing changes.

§ Repeat last command 

Repeats the execution of the last selected command with exactly the same settings, see Repeating
commands.

§ Object mode 

Switch between edit and object mode to make it easier to edit either cells or objects. For more information,
see Object mode.

To the right of the Quick access toolbar, there is a double arrow . You can use its menu to add/remove
common buttons directly from the Quick access toolbar. You can also change the position of the Quick access
toolbar here and add additional icons via the command Customize (for Quick access toolbar and ribbon, see
below).

To the left of the Quick access toolbar, you will find the "hamburger-menu" . Even if you have selected
the "ribbon" as the user interface, the "hamburger menu" is still available in the Quick access toolbar in case
you would like to access the menu commands of the classic menu interface.
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Creating your own ribbon and Quick access toolbar

You can change the ribbon and the Quick access toolbar at will and add additional icons. To do so, either
choose File | Customize in the ribbon or right-click on a free space in the ribbon. In the following menu, you
will find the entries Customize ribbon or Customize Quick access toolbar to open a corresponding dialog box.

You can also hide the ribbon display completely (Minimize ribbon) or change the position of the Quick access
toolbar.

For more information, see Customizing the ribbon.

User interface: Classic menus
If, in the settings, you have selected that you would prefer to use Classic menus instead of the Ribbon interface,
the upper area of the program window will look like this on your device:

Classic menus with toolbars

The menu bar

The Menu bar is found directly under the title bar.

It contains all of PlanMaker's commands in the form of clearly arranged menus. Click on a menu item to open a
menu and choose a command.

The Standard toolbar

The Standard toolbar is displayed below the menu bar. It contains icons for PlanMaker's most frequently used
commands.

Toolbars such as the Standard toolbar enable quick access to the functions of a program. Each icon represents a
specific command. If you click on it, the corresponding command is chosen.

Tip: If you hover the mouse cursor over an icon (without clicking), the program will display a tooltip that
describes the icon's function. This requires Show tooltips to have been enabled in the settings.



33Application window

The Formatting toolbar

The Formatting toolbar can be found below the toolbar. You can use it to both read and change the most
common text formatting (font, bold, italics, etc.) for table contents.

If you select a section of text beforehand, formatting changes will affect only the selected text.

To choose a different font, for example, click on the small arrow to the right of the font name to open the list,
and then choose a font.

Other icons in the Formatting toolbar are switches that you can enable and disable by clicking on them – for
example, the B for bold.

There are also split buttons, where you can either click on the icon to directly apply the displayed command or
use the corresponding small arrow to the right of the icon to open its dropdown menu. This is the case, for
example, when choosing the font color.

Additional toolbars

There are additional toolbars in PlanMaker that you can enable and disable as you choose. To do so, either
choose the menu command View > Toolbars or right-click on one of the displayed toolbars. You then see a
menu in which you can select toolbars that you would like to have displayed.

Customizing toolbars

You can customize the default toolbars to your liking and even create your own toolbars. For more information,
see Customizing toolbars.

User interface on Android/iOS
In addition to the ribbon and classic menus user interfaces, the Android/iOS version provides another option:
the toolbar user interface.

The toolbars interface is designed in a manner that makes it easier to use PlanMaker on smartphones and
tablets. It constitutes a mixed form of the functionalities of ribbon and classic menus. On smartphones,
PlanMaker is started by default with this toolbars interface the first time you open it, while it is opened by
default with the ribbon interface on tablets.

To switch the interface, choose the command File | Options  in the ribbon interface or choose Tools >
Options in the classic menu interface. In the following dialog box, the Appearance tab contains the dropdown
list User interface. Here, you can choose between toolbars, ribbon or classic menus with different colors.

Tip 1: In the toolbars interface, you reach this dialog box by opening the "hamburger menu"  to the left of
the toolbar and choosing the command Tools > Options.
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Tip 2: The hamburger menu also contains all other menu commands of the classic menu interface.

Using the "toolbars" user interface

The toolbars user interface contains a bar with icons at the bottom of the program window, and each icon
represents a group of commands. If you click on a group icon, another bar opens with the corresponding group
commands.

Behind the File group icon , for example, you will find the commands Open document, Save document,
Print document, etc. To hide the displayed bar with the commands, simply click on the group icon again.

By default, the toolbar contains the following groups:

Group Commands (among others)

File Open document, Save document, Print document, etc.

Edit Undo, Format painter, Copy & Paste, Search, etc.

Table Filter and sort, Cells (insert, delete, hide), Manage worksheets

Character Font, Font size, Font color, Text styles (bold, italics, etc.)

Formatting Number formats, Cell formatting, Cell styles, Conditional formatting, etc.

Insert Table styles, Objects (picture, chart, AutoShape etc.), Comments, Hyperlinks

Layout Page setup, Headers and footers, Align objects, etc.

View Object mode, Zoom, Freeze first row/column, etc.

"Keyboard" button

In Options , the System tab contains an option Show/hide keyboard automatically. Once this setting is
enabled, it automatically opens the on-screen keyboard when you type something into the document.

If you disable the option, this behavior is suppressed and a freely movable Keyboard button  is displayed
instead on the document. If you click on the button, the keyboard is shown. By clicking on the button again, you
hide the keyboard.

Note: This setting is possible in any user interface for smartphones and tablets. For tablets, the Keyboard button
is only freely movable on the document in the toolbars interface if you disable the above option. In the ribbon
and classic menus interfaces, the Keyboard button is displayed instead in a fixed manner in the upper left area
of the command bar.

Change input mode

PlanMaker supports the use of certain input modes from Android/iOS devices.

§ Android 

The command Input method allows you to switch to a different keyboard mode on an Android device.
PlanMaker accesses the on-screen keyboard settings of your Android device for this.
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In the classic menus interface, you change the mode with the menu command View > Input method. In the

ribbon or toolbars user interfaces, you can choose this command via the hamburger menu  .

§ iOS

When Scribble mode is enabled in PlanMaker, you can write directly in the document on an iOS tablet
using the Apple Pencil. Your handwritten entries are converted directly into text. For other edits – for
example of objects – you have to disable the mode again.

In the classic menus interface, you enable or disable the mode with the menu command View > Scribble. In

the ribbon or toolbars user interfaces, you can choose this command via the hamburger menu  .

Note: The command View > Scribble is only available for iOS tablets, but not for smartphones. Also, please
make sure that you have enabled the option Apple Pencil > Scribble in the system settings of your iOS
tablet.

Unlocking locked commands

Some commands are locked in the Android/iOS version (recognizable by the lock in the command icon), but
they can be unlocked if necessary.

To unlock the commands, click on the command icon. The program opens a dialog box with the following
options: Users of SoftMaker Office NX Home and NX Universal can use their product key to unlock
commands. Users of other versions have the option of unlocking the functions via Google Play/Apple App
Store (subject to a fee).

Customizing command groups

You can customize the default groups as desired by adding/removing commands. Note: However, you cannot
add or delete an entire group in this interface.

In the hamburger menu , choose the command Tools > Customize. This opens the dialog box Customize
user interface, which is structured as follows:

§ On the left side, you will find all of the commands that are available in PlanMaker. On the right side, the
dropdown list Customize contains the groups that are in the toolbar. The list below it displays the
commands that are currently in the selected group. 

§ You can add new commands to each group (or remove them, change their position or insert separators). This
works in a similar manner to that described for the classic menus with toolbars user interface in the
Customizing toolbar icons section. Difference: Instead of "toolbaricons" you customize "groupicons".

Context menu
Regardless of the user interface in which you work, there is also another way to choose commands: via the
context menu.

This menu contains different commands depending on the current situation. If, for example, you select some
text and then right-click to open the context menu, it offers commands for cutting, copying or formatting that
text.
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Depending on what you have previously selected (text, objects, tables, etc.), you will be offered a variable –
contextual – selection of commands when opening the context menu. This makes it much easier for you to
quickly navigate to situational commands without a long search.

Android/iOS: In these versions, you can also open the context menu with your finger by tapping on the screen
and holding your finger there for about a second.

Edit toolbar
In the ribbon interface as well as in the classic menus you will find the Edit toolbar below the ribbon (or below
the standard toolbar and formatting toolbar in the classic menu interface).

The Edit toolbar contains the following control elements:

Cell address

The address of the currently active cell is displayed at the very left.

Symbols and input field for editing cell contents

To the right of the cell address are three icons and an input field.

Click into the input field to edit the content of the current cell. Or, to edit the cell directly, simply click in the
cell and begin typing. The latter is usually faster.

For more information on entering and editing cells, see Entering data in cells.

The Edit toolbar icons have the following functions:

Icon Function

Corresponds to choosing the ribbon command Formula | Function (menu command Insert > Function)

Accepts the user input in the input field (corresponds to pressing the Enter key¿)

Cancels the user input in the input field (corresponds to pressing the Esc key)
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For more information on entering formulas, see Formulas and functions.

Document tabs

Android/iOS: This function is not available for smartphones. For tablets, working with the tabs is possible
within the same program window.

A bar with document tabs can be seen above the document. It displays one tab for each open document.

The document tabs bar

The tabs can be used to perform the following actions:

§ To make a document become the active document, left-click its tab. This enables you to rapidly switch
between the open documents. 

§ To close a document, click on its tab with the middle mouse button.

Alternatively, left-click on the x icon displayed on the far right of each tab.

§ You can change the order of the tabs by dragging a tab to the desired position on the tab bar while holding
down the left mouse button. 

§ To release a tab and display it in a separate program window, drag it to a position outside the current
program window while holding down the left mouse button.

By the way, documents can also be started in a new program window when they are opened. For more
information on working with multiple documents, see Working with multiple documents.

Worksheet register
Below the document is the worksheet register.

A PlanMaker document can consist of multiple worksheets, which are layered like a stack of paper sheets, one
on top of another. These are called worksheets. With the worksheet register, you can switch between the
individual worksheets in a document, create new sheets, and manage the existing ones.

For more information, see Working with multiple worksheets.

The figure above shows the worksheet register for a workbook with three worksheets. The currently active
sheet, "Sheet1", is highlighted.
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Status bar
The Status bar is found at the bottom of the program window.

Note: If you do not see the status bar, you will have to change the settings for it as described in Settings,
Appearance tab (for the ribbon interface) or as described in Showing and hiding toolbars (for the classic
menu interface).

You can read the following information in the status bar:

Example Explanation

Font color,
Chart1,
etc.

Different information is displayed on the far left. If you hover the mouse cursor over a command icon, the
function of this command is displayed here. If you select an object, its name is displayed here. If you move
or resize an object, the current position/size is displayed, etc.

Sum=6 Next to it, the so-called Online calculation is displayed. If just a single cell is selected, its content is shown
here. If multiple cells are selected, the sum of their cell contents is indicated. (See also option Calculation
in status bar in the Settings).

This icon lights up if the worksheet contains circular references. This usually indicates an erroneously
written formula – for example, a formula in cell A1 that refers to cell A1 itself.

If you click this icon, PlanMaker selects the cell with the circular reference. If you click again, it jumps to
the next such cell (if more of them exist).

Ins Shows whether Insert Mode (Ins) or Overstrike Mode (Ovr) is active. This allows you to determine what
should happen to the existing cell contents when editing a cell:

Ins: Insert mode is enabled – newly entered text will be inserted in front of existing text.

Ovr: Overwrite mode is enabled – newly entered text will be written over existing text.

The default setting is Ins. You can use the Ins key on your keyboard to switch between these two modes (or
by clicking on the Ins/Ovr display).

The Ins key can also be disabled, see section Settings, General tab.

AUTO Indicates the current input mode:

AUTO: Normal input mode – numbers are automatically recognized as numbers, and formulas as formulas.
This is the default setting.

TEXT: Text input mode – everything you enter is interpreted as text, including formulas and numbers.

To switch between these two modes, either click on the text "AUTO" in the status bar or press the key
combination Ctrl+Shift+F4.

Note: If you switch to TEXT input mode, all numbers and formulas you enter are automatically preceded by
a single quotation mark ('). This converts them to text and they can no longer be used for calculations. (In
order to turn text into numbers or formulas again, switch back to AUTO mode and simply remove the
leading quotation mark.)
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The status bar also contains a zoom slider that allows you to change the zoom level for the document:

To do so, either drag the slider with your mouse or click on the plus or minus icon (see Zoom level).

Tip: Configuring the status bar

If you click on the double arrow  on the far right of the status bar, you will find the following options:

§ You can use the option Add/remove buttons to show or hide the individual preset elements of the status
bar. 

§ The option Customize opens the dialog box Customize user interface, where you can freely configure the
status bar from all commands available in PlanMaker.

In the dialog box, select the item "Status bar" in the list Customize (top right). You can then add or remove
buttons from the status bar and change their order. For more information, see Customizing icons and groups
in the ribbon.

§ Reset this toolbar restores all changes made to the status bar back to their original state.
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Basics
This chapter provides a brief description of PlanMaker's most important basic functions and terminology.

The chapter covers the following topics:

§ The structure of a spreadsheet 

First, you will learn how tables are actually structured.

§ Moving within a worksheet 

Afterwards, you will find out how to navigate in a table.

§ Entering data and Deleting data 

In the next two sections you will learn methods for entering and deleting data.

§ Undoing changes 

Here you will learn how to undo changes to the document.

§ Starting a new document 

This section shows you how to create a new document.

§ Opening a document, Printing a document and Saving a document 

These three sections deal with opening, printing and saving documents.

See the following pages for more information.



41Basics

The structure of a spreadsheet
In order to use PlanMaker immediately while working through this chapter, you should launch it now.

Spreadsheets are divided into lines and columns. Each spreadsheet can contain up to 1 million rows and 16384
columns. These are labelled as follows:

§ The rows are numbered. 

§ The columns are labeled with alphabetic characters: A to Z, then AA to AZ, then BA to BZ, etc.

The matrix of rows and columns results in a cell grid. These boxes are called the cells of the sheet.

Each of the cells has its individual coordinates: B5, for example, describes the cell in the fifth line of column B
(the second column). A3 would be the cell in the third row of column A (the first column), etc. These
coordinates are referred to as the cell address.

The cell address is very important because calculations often refer to other cells: If, for example, you want to
put twice the value of cell A1 in cell A2, you would enter in cell A2: =A1*2.

Twice the value of A1 is now displayed in A2. If you change the value in A1, the resulting calculation of cell
A2 is automatically updated.
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Moving within a worksheet
If you enter data in PlanMaker, it is always inserted into the active cell. A thin dark frame, known as the cell
frame, indicates the active cell:

You can move the cell frame to another cell as follows:

Mouse: Click on the desired cell.

Keyboard: Use the arrow keys of the keyboard to move the cell frame.

Via keyboard is also possible: Use the Tab key to get to the next right cell and Shift+Tab to the next left cell.
Press the Enter key¿ to move down and Shift+Enter to move up.

A list of available keys can be found in the section Shortcut keys.

Entering data
In order to enter data into a cell, move to the desired cell using the arrow keys or the mouse, and begin typing.

To complete your input, press the Enter key¿.

If you made an error during input, press the Esc key instead of the Enter key¿. PlanMaker discards what you
just typed and restores the original cell content.

Alternatively, use the following buttons of the Edit toolbar:

§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To subsequently edit the contents of a cell, navigate to the cell and press the F2 key. Alternatively, simply
double-click on the cell.

For more information on this topic, see Entering data in cells.

Deleting data
There are several ways to delete data from a document:
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§ Deleting the content of a cell 

To delete the entire contents of a cell, navigate to that cell and then press the Del key on the keyboard (or the
ribbon command Home | group Edit | Cut).

§ Deleting only parts of the cell content 

To delete only a part of the contents of a cell, double-click on the cell. Alternatively, you can select the cell
and press the F2 key. Now you can edit the cell content, for example, you can also delete parts of it by using
the Del key or the Backspace key Õ.

§ Deleting the contents of multiple cells 

To delete the contents of several cells at once, select them before pressing the Del key. How to select cells is
described in the section Selecting cells and cell content.

For more information on "Deleting cells", see Deleting cells and cell content.

Undoing changes

In the Quick access toolbar, you can use the Undo button  on the Quick access toolbar. This restores the last
action you undid. You can thus undo the cancellation of changes.

For more information about this topic, see the Undoing changes.
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Starting a new document

To start a new document, choose the command File | New . (Click directly on the icon itself.) Incidentally,
this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see the templates you previously used. For more
information, see "List of document templates used" below.)

Tip: Use the key combination Ctrl+N to quickly open a new document with the current default template,
while skipping the dialog box shown below.

After you click on the File | New icon , the following dialog box appears:

The dialog box of the command File | New

If you just want to create a normal sheet without any additional formatting, choose the default template Nor-
mal.pmvx.

Tip: If you hover over a template (without clicking), more information about the template will be displayed.
This requires Show tooltips to have been enabled in the settings.

As soon as you confirm with OK, the new document will be created.
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Using document templates

The above dialog box contains the following options:

Template: In addition to the default template Normal.pmvx, you will also see some predefined document
templates that you only have to fill in after opening.

The Favorites folder contains all "pinned" templates, which are permanently displayed at the top in the list of

the command File | New  for quick access. (For more information, see the paragraph below "List of slide
designs used").

Pinned templates are recognizable by the vertical pin icon . The default template always remains pinned,
while all other templates can be pinned or unpinned by clicking on the pin icon.

View: You can switch between small, medium and large for a clear arrangement of the available templates in
the dialog box.

Available languages: Here, you can select the language(s) in which document templates are to be displayed.

Set as default: Change the default template by clicking on a template and then pressing this button. In future, a
new document will always be opened with this template.

For more information on creating your own document templates, see Document templates.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in
its own program window. If the option is disabled, the new document will be created with a new tab in the
existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

List of document templates used

If you click on the small arrow of the File | New button , the program opens a list of previously used
document templates, which you can apply directly:

Default template: The current default template is displayed here. If you just want to select the default
template, you can also click on it here in the list and skip the dialog box.

Unpinned templates: This is displayed if you have already used templates other than the default template. You
can thus use these templates directly from the list for a new document without performing a long search.

If you click on the pin icon  of a template, the status changes to Pinned templates: These are permanently
displayed at the top of the list (and in the Favorites folder of the dialog box, see above). You can unpin the

template by clicking on the pin icon  again.

If you click on the cross icon , you remove an entry completely from the list. The command Delete all
unpinned items deletes all entries from the list – except the pinned templates and the default template.

The command More will take you again to the dialog box described above.
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Opening a document
To open an existing document, choose the command File | Open  by clicking directly on the icon itself.
Incidentally, this command is also in the Quick access toolbar.

(Note: If you click on the icon's arrow instead, you'll see a list of recently used files. See explanations in the
paragraph "List of recently opened files" below.)

After you have clicked directly on the Open icon , the program will display a dialog box which may look as
follows:

The dialog box of the command File | Open

This dialog box may look slightly different depending on the operating system, but its function always remains
the same. Use this dialog box to tell PlanMaker which document to open.

To do so, you could simply type in the name of the file you want to open manually. However, the dropdown list
with the files is more convenient because all files are listed here in the current folder and can be easily selected.

Option "New program window"

The option New program window means the following: If it is enabled, the new document will be displayed in its
own program window. If it is disabled, the document will be opened with a new tab in the existing program
window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.
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(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

Previewing a document

When the option Preview is enabled, a little box displaying a preview of the currently selected document is
displayed to the right of the dialog box.

Opening other file formats

In addition to opening documents created in PlanMaker's default file format, you can also open files created
with other software. All you have to do is select the desired format from the list of file types.

For more information, see Working with other file formats.

Using Quick paths

You can use the Quick path button to create and choose quick paths in order to quickly switch to a specified
folder when opening or saving files.

For more information, see Quick paths.

File manager

The File manager button opens the integrated file manager. This displays a list of your documents and allows
you to open, print, view or delete them, as well as perform searches.

For more information, see File manager.

List of recently opened files

If you click on the small arrow below the File | Open  button, you will see a list of recently opened files.
Simply click on one of these files to open it again.

In this file list, you can also select the following options:

If you click on the pin icon  of a file, it will appear in the list as a pinned file and will be displayed
permanently at the top of the list. Unpinned files will eventually be removed from the list of recently opened
files if the number of entries exceeds the limit that was set. For more information, see "Recently used files in
the File menu" in Settings, Files tab.

Click on the pin icon  again to unpin the file or click on the cross icon  to remove an entry from the list.
The command Delete all unpinned items deletes all entries from the list – except the pinned files.

The command Browse documents will take you again to the dialog box described above.
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Printing a document
To print the current document, choose the ribbon command File | Print.

The program will display a dialog box in which you can specify which parts of the document will be printed.

For more information on outputting documents, see Outputting documents.

Saving a document
When you have completed a document, you should save it to retain it permanently. To do so, click on the
ribbon command File | Save .

Tip: This command can also be found by default in the Quick access toolbar below the ribbon.

If the document does not yet have a name, PlanMaker automatically prompts you to assign a file name to it
before saving it.

Saving under a different name or in a different location

PlanMaker also has a ribbon command called File | Save as. This also saves your document, but you can first
assign it another name or select another folder in which to save it.

Saving in a different file format

You can use the ribbon command File | Save as to also save a document in the file format of another program.
To do so, select the desired format in the list Save as type. For more information, see Working with other file
formats.

Saving all open documents

If you have multiple documents open at the same time, you can use the ribbon command File | Save all to save
all of them at once. PlanMaker checks whether the documents have been changed since they were last saved
and saves only those that have been changed.
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Exiting the application

To exit PlanMaker, choose the command File | Close  and then File | Exit . Alternatively, just click on
the X icon on the far right of the title bar or tab.

If one of the open documents has been changed since it was last saved, PlanMaker automatically asks you
whether you want to save it before closing it.
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The PlanMaker tour
Welcome to the PlanMaker Tour!

On the next pages, you will get to know PlanMaker a little more closely than in the Basics chapter. Users
unfamiliar with spreadsheets should read this chapter thoroughly.

More advanced users are encouraged to browse through this section as needed.

Note: Most of the illustrations in this manual were prepared with the Windows version of PlanMaker. On
other operating systems, some of the controls look slightly different, but their functionality is the same.

Some theory to begin with
The topic "Calculating and computers" is most easily understood with a short review. Computer technology
originally made its triumphal procession into households and offices through the field of "computing". The first
step was taken with the pocket calculators. They are certainly a great help, but their disadvantages are a good
indicator of the power of a spreadsheet:

If, for example, you plan a computer purchase, you need to compare various systems, based on their hardware
components: you will need a PC, a monitor, and a printer. One vendor may offer a competitively priced
computer; another one might offer an inexpensive monitor, etc. Which is the best option?

To determine this, you have to add up the prices. So, you grab your pocket calculator, type in the numbers one
by one, jot down the result – and become frustrated: With every new offer, the game begins anew, even though
the method of calculation never changes, only the values do.

Such calculations can be carried out much easier with the help of a spreadsheet application.

The first technique you will learn when using PlanMaker, is to make use of "variables". Variables help you to
generate abstract formulas, without the use of actual number (or dollar) values. For instance:

computer + monitor + printer = total price

Abstracted:

a + b + c = d

Without spreadsheets, such a formula has only practical benefit if you use a programmable calculator – you can
enter the formula once, and then execute it many times. The calculator asks for the values one by one, and then
shows the total value. This is not much of an improvement over repeated individual calculations...
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First steps with PlanMaker
With these preliminary thoughts in mind, let's look at how such problems can be solved with PlanMaker.

To do this, start PlanMaker now.

Under Windows, PlanMaker looks like this:

Most of the program window is taken up by the worksheet. On the top, it is bordered by a row of alphabetic
characters, on the left by a column of numbers.

Let's have a closer look at the worksheet:

The structure of a spreadsheet

As you already know from chapter Basics, a worksheet is divided into rows and columns. This is also visible
through the gray lines that are displayed in the worksheet.

The cell in the upper left corner is surrounded by a dark frame. This is the so-called cell frame. The cell frame
indicates which cell is currently active:
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When entering data, it is always placed in the active cell.

You can use the arrow keys on your keyboard, e.g. â and à, to move the cell frame from one cell to another.

While you do that, take a look at the Edit toolbar above the worksheet: at the very left, PlanMaker displays the
address of the currently active cell. The address always consists of one or two alphabetic characters and a
number:

A1 means column 1, row 1.

A5 means column 1, row 5.

D5 means column 4, row 5, etc.

The fact that each cell has a unique address is the key to all functions of a spreadsheet: This allows you to enter
calculations in any cell that relate to other cells – for example, to form the sum of cells. You do not even need
to deal with variables like a, b, c, but simply use the coordinates of the cells.

This is like handing someone a worksheet and asking them, for example, "Please add the numbers in the
second, third and fourth row of the second column".

Entering values and formulas
Enough theory for now! Let's create our first calculation.

First we type in the price for the personal computer; under that, the price for the monitor; and under that, the
price for the printer.

To do so, navigate to cell B2 and type the value 799. The value appears both in the chosen cell and in the Edit
toolbar above the table.

Note: Do not make the mistake of typing the letter "O" or "o" instead of the numerical digit "0". PlanMaker
makes a clear distinction between letters and numbers. The letter "O" is not a number for the program.
PlanMaker would accept the input but interpret it as text. When attempting to calculate with it, PlanMaker
will generate an error message.

Press the Enter key¿ now to finish your input. The cell frame moves down one row to cell B3. Type the value
425 here, and in the row below that type the value 199.

Tip: If you entered a wrong value and have already pressed the Enter key¿, you can still correct your
mistake. Move the cell frame to the cell with the error, and enter the correct value. As soon as you press the
Enter key, the old content is overwritten by the new input. You can also edit the content of already filled-out
cells by pressing the F2 key.

Entering formulas

Let's enter our first formula.
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In order to calculate the total cost of our computer equipment, we have to add up the unit prices. This is simple
to do:

Go to cell B5 and type an = (equal sign). The equal sign shows PlanMaker that you would like to begin entering
a formula.

Now enter the formula. For this purpose, you use the cell addresses as "variables". Type in:

=B2+B3+B4

Note: Cell addresses are not case-sensitive, i.e., you can enter them in either upper or lower case.

When you press the Enter key¿, you will see the result of your first formula:

Let's see what happens if you change the numbers in the cells. For example, navigate to the cell that contains
425 and replace it by 259, or some other value. As soon as you press the Enter key¿, the result of the
calculation is updated immediately.

Regardless of what cells B2, B3 and B4 contain, PlanMaker will always sum them up. If you get a quote for a
computer system in which only the price for only one component has changed, you only need to update that one
value, and the new total price will be displayed in cell B5.

The SUM function

The example above is one method of adding up several numbers. But while this method is adequate for a few
numbers, it is clearly too cumbersome for adding 50 numbers - that would be one long formula! However, there
are better ways to achieve this: the arithmetic functions of PlanMaker.

Let's find out more about them! First, make cell B5 the current cell; it contains the formula you entered
previously.

Next, delete the old formula by pressing the Del key on the keyboard, or by simply overwriting the existing cell
content. Now enter the following formula:

=SUM(B2:B4)

After pressing the Enter key¿, you can see the result in the cell: the sum of the cells B2 through B4.

PlanMaker knows a whole range of calculation functions – and one of them is SUM. The SUM function
calculates the sum of the values that your formula references. The expression in parentheses after the function
name tells PlanMaker where to start and stop totaling.

You have directed PlanMaker to start adding in cell B2 and stop in cell B4. In this case, only the number of B3
is in between, but the SUM function would also work with a larger range, such as B2:B123.
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The notation StartingCell:EndingCell can also be used when both row and column changes. If, for example,
you enter B2 as the starting cell and C4 as the ending cell, these two coordinates form the corners of a
rectangle. The formula =SUM(B2:C4) would sum all numbers contained within this rectangle.

Formula varieties

To get an impression of the large number of arithmetic functions available in PlanMaker, you can now use the
Function command.

You will find the command on the ribbon tab Formula | Function  – alternatively, you will find it as Insert
function with an identical icon in the edit toolbar. Even faster: Simply press F7.

The program displays a dialog box now with a list of all functions PlanMaker supports.

Hint: In the Windows version of PlanMaker, you can open a help page for each calculation function. Click
on the desired function in the above dialog box and then press the F1key.

Let's try another function. Let's calculate the average value of our three numbers in the table:

Close the dialog box to return to the worksheet, and delete the contents of cell B5 again.

Then choose the command Function (Insert function) . Select the category "All functions" in the left list.
Now scroll through the list on the right, down to the "Average" function. Double-click the "Average" function.

In the input field of the dialog box, PlanMaker has now automatically inserted the

Average()

function. To complete the formula, type B2:B4 again – between the parentheses.
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Alternatively, you can select the cell range right in the worksheet: left-click on cell B2, then drag down the
mouse to cell B4. If the dialog box covers the cells you want to select, simply drag the dialog box out of the
way.

The completed formula should look like this:

=Average(B2:B4)

If you click the Insert button now, this formula is placed into cell B5 and calculated immediately.

You have now learned about two of the more than 400 arithmetic functions of PlanMaker. A comprehensive list
of all functions can be found in section Functions from A to Z.

Going three-dimensional
PlanMaker documents are not limited to single worksheets. As needed, you can stack several worksheets on top
of each other – just like a stack of papers. PlanMaker documents are therefore also called workbooks. Each
workbook can contain up to 2048 worksheets.

The main advantage of this is that calculations in one worksheet can also refer to cells in other worksheets of a
workbook, in essence, letting you create "three-dimensional" calculations.

An example: You record the balance sheets of several branches of your company on three worksheets. Now you
could create a fourth worksheet that, for example, sums the results of the other three sheets.

To add a new worksheet, use the ribbon command Insert | group Tables | Sheet . The program opens a
dropdown menu, where you can choose the Insert command.

Tip: You can create a new worksheet faster with the  icon in the worksheet register.

The worksheet register at the bottom of the document

To switch between the individual sheets, simply click on the desired worksheet tab in the worksheet register
with the mouse.

For more information on this topic, see Working with multiple worksheets.

Changing the layout of worksheets
Now, let's return to our first sample worksheet. Although it has proved to be an accurate calculation here, it is
not very attractive in terms of design. At the same time, PlanMaker has extremely powerful options for visually
preparing worksheets.

Let's try some of them out:
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Adding a headline

What is missing from our worksheet is a headline. So let's simply enter a text in a cell above the numbers and
increase the font size to make it stand out.

Click on cell B1 to make it the active cell. Then, for example, type the following text:

My first worksheet¿

Changing character formatting

Next, let's choose a different font for the heading – and make it a lot bigger.

For this purpose, first move the cell frame back to the cell B1 again. Then expand the font list on the ribbon tab
Home | group Character by clicking the small arrow to the right of the font name.

PlanMaker now displays a list of all fonts installed on your computer. Select the Tahoma font (or any other font
you like).

Then open the font size list  to the right (or below) of the font list and select size 24 point.

If desired, you can also set the font color , in the same command group you will also find three buttons
labeled B, I and U for toggling bold, italics and underlining.

Changing number formatting

When it comes to formatting numbers, PlanMaker not only allows you to change the character format of
numbers (font, font size, etc.), but you can also modify their number format.

Let's try this out: To display the values in the cells B2 through B5 with a currency symbol, proceed as follows:

First, select the cells B2 to B5. To do so, click on the cell B2 and then – with the mouse button still held down –
move the mouse cursor to the cell B5.
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Android/iOS: If you are using these versions, please note that selecting text there works slightly differently.
For more information, see Selecting cells and cell content.

When the desired cells are selected, click on the ribbon tab Home in the command group Number on the group
arrow  in the bottom right corner. The program opens a dialog box with numerous options. We are only
interested in the tab named Number format: On this tab, simply choose the entry "Currency" from the list and
confirm with OK.

Result: A currency symbol is now displayed with values in the selected cells. Also, the values are displayed
with two digits after the decimal point.

There are many more number format options at your disposal. For example, you can make values display as
percentages, change their number of decimal places, etc. Important: Applying a different number format to a
value only changes its display – not the value itself.

You have now met a tiny part of PlanMaker's options for improving the visual display of worksheets. Many
more are waiting to be discovered by you. For more information on this, see Formatting worksheets.

Charts
Before we end this tour, let's have a quick look at charts.

In spreadsheets consisting of nothing but long columns of numbers, it is often hard to interpret their meaning.
PlanMaker provides easy ways to turn raw numbers of a table into charts that get the point across.

To insert a chart, first select the values to be displayed.

Then choose the ribbon command Insert | Chart frame  (click directly on the icon itself). The program
opens a dialog box in which you have to specify the chart type. When done, the chart is inserted into the
worksheet.
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For more information about this topic, see Charts.

Outlook
The introductory part of the manual ends here. You now know many of the program's basic functions,
everything else you will learn in the reference section of the manual, starting with the next chapter.

This part of the manual provides detailed descriptions of all of PlanMaker's functions by subject matter. Of
course, you don't have to read it chapter by chapter to learn all the functions of PlanMaker at once. Just read the
chapters that you really require, and explore PlanMaker's features step by step.

Have fun with PlanMaker!
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Editing worksheets
This chapter marks the beginning of the reference section of the manual. This part of the manual provides
detailed descriptions of all of PlanMaker's functions organized into chapters by subject matter.

In this first chapter, you will learn how to enter data and how to edit worksheets. The chapter covers the
following topics:

§ Entering data in cells 

The first section describes what you have to consider when entering text, numbers, dates, calculations, etc.
in cells.

§ Undoing changes 

The Undo button  in the Quick access toolbar can be used to undo the last changes.

The Redo command  in the Quick access toolbar is the counterpart to this – and reverses the Undo
command.

§ Repeating commands 

The Repeat command  in the Quick access toolbar repeats the last command that you have used with
exactly the same settings.

§ Selecting cells and cell content 

This section describes how to select cells – for example, by using the mouse or the keyboard.

§ Deleting cells and cell content 

You can either use the Del key on the keyboard to delete only the cell contents or use the ribbon command
Home | group Cells | Delete to remove cells completely from the worksheet (the rest of the worksheet
moves up accordingly).

§ Inserting new cells 

The ribbon command Home | group Cells | Insert inserts new cells in your worksheet and pushes the
existing cells down (or right).

§ Moving and copying 

Selected worksheet areas can be copied or moved with the commands of the ribbon tab Home | group Edit
or simply by dragging them using the mouse. Formulas are automatically updated when you move or copy
cells.

§ Paste (special) 

The ribbon command Home | group Edit | Paste  | Paste special is a more powerful variant of the Paste
command. You can specify exactly what to be pasted; for example, just the values or just the formatting.
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§ Filling cells automatically 

With the ribbon command Home | group Contents | Fill you can easily fill ranges of cells with identical
values or a series of values.

§ Working with multiple worksheets 

You can create multiple worksheets in a single document and stack them like a pile of paper, enabling you to
do "three-dimensional" calculations.

§ Naming cell ranges 

If you assign a name to a range of cells using the ribbon tab Formula | group Named areas | Edit Names,
you can use this name in formulas – for example =SUM(Sales) instead of =SUM(A1:A5).

§ Transposing cells 

The ribbon command Data | group Edit | Transpose exchanges the row and column orientation of a
selected cell range.

§ Splitting text into multiple columns 

With the ribbon command Data | group Edit | Text in columns you can distribute text entered in one table
cell into multiple columns.

§ Sorting cells 

With the ribbon command Data | group Filter | Sort you can sort ranges of cells according to one or more
criteria.

§ Filtering cells by their content 

The ribbon command Data | group Filter | AutoFilter or Special filter filters ranges of cells so that only
cells that meet certain criteria are displayed. All rows in this range that do not match the filter conditions
will then be hidden.

§ Analyzing sheets 

This section introduces some tools that can be very useful for analyzing tables and detecting errors. These
include a command for displaying formulas, syntax highlighting, a watch window for cell content, and
several commands for auditing the formulas in a table.

§ Updating sheets 

The calculations in a table are kept up-to-date automatically. Whenever you change the content of a cell,
PlanMaker recalculates the entire workbook. If required, you can disable this behavior and use the ribbon
command Formula | group Refresh | Update data | Update calculations to update the table manually.

§ Using comments 

With the ribbon command Insert | Comment you can attach comments to cells. If you move the mouse over
such a cell, the comment will be displayed.

§ Goal seek 

The ribbon command Data | group Analyze | Goal seek determines by an approximation method which
value a certain portion of a calculation must meet to extract a predefined result from the calculation.
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§ Scenarios 

The ribbon command Data | group Analyze | Scenario manager allows you to create and display different
scenarios. You can use them to observe how the calculations in a worksheet change when the values in
specific cells are altered. This enables you to perform all kinds of "what-if" analysis.

§ Consolidating data 

The ribbon command Data | group Analyze | Data consolidation can be used to evaluate data from multiple
cell ranges, for example, in order to calculate their total sums.

§ Tables in worksheets 

This function is a particularly useful option: it formats an entire cell range in one of numerous predefined
formats – at the touch of a button. Select a cell range and create a "table in a worksheet" by using the ribbon
command Insert | Table.

This has the following effects:

The cell range is automatically formatted with a so-called table style. You can switch to a different table
style anytime in order to change the appearance of the entire cell range at once. In addition to this, an
AutoFilter is applied to the "table" automatically. Furthermore, special tools like adding a total row are
available.

§ Pivot tables 

Huge and complex amounts of data can be summarized to certain criteria very clearly with pivot tables.
Select an existing data range and use the ribbon command Insert | Pivot table to create meaningful
presentations of your data with little effort. With exercises in the section.

§ Freezing rows and columns 

With the ribbon command View | group Windows | Freeze cells you can fix the first rows or columns of a
worksheet on the screen. This will cause them to stay in place when you scroll the worksheet. This is ideal
for row or column headings.

§ Inserting special characters 

The ribbon command Insert | group Text | Symbol opens a dialog box with all available characters of a
font. It can be used to enter special characters that are not readily accessible from the keyboard.

For more information on these topics in the above order, see the following pages.

Entering data in cells
In order to enter data into a cell, navigate to the desired cell with the arrow keys or mouse, and begin typing.

To complete your input, press the Enter key¿.

If you made an error during input, press the Esc key instead of the Enter key¿. PlanMaker discards what you
just typed and restores the original cell content.

Alternatively, use the following buttons of the Edit toolbar:
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§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To subsequently edit the contents of a cell, navigate to the cell and press the key F2. Alternatively, simply
double-click on the cell.

Notes on entering numbers

§ Always enter numbers with the decimal separator specified in the country settings of your computer. Either
the decimal point commonly used in Europe (0.7) or the decimal point commonly used in the USA (0.7). 

§ Numbers can also be entered in scientific (exponential) notation. 4E03, for example, corresponds to 4 *
10^3, which equals 4000. 4E-03 corresponds to 4 * 10^-3, which equals 0.004.

§ Numbers can also be entered as fractions. For example, 2 1/2 corresponds to 2.5.

§ Numbers can also be entered as percentages. For example, 70% corresponds to 0.7.

On the ribbon tab Home, you can change the format of numbers in table cells at any time using the command
group Number. For example, you can tell PlanMaker to display numbers as percentages or as a currency with a
currency symbol. For more information, see Number format.

Notes on entering dates

§ Dates can be entered in various formats; for example, 09/25/18 or 9/25/2018 etc. 

§ You can enter dates between January 1st, 1900 and December 31st, 2500.

§ If you enter the year with only the last two digits, it is interpreted as follows:

00 to 29 -> 2000 to 2029

30 to 99 -> 1930 to 1999

1/1/29 is treated as 1/1/2029., whereas 1/1/30 is treated as 1/1/1930.

§ Times can be entered in numerous formats. For example, you can enter the time 09:30 as follows: 

9:30

09:30

09:30:00

09:30:00 AM

etc.

§ You can combine a date and a time in a single cell by typing the date, a space, and the time. For example,
when you type in 9/25/18 6:00, PlanMaker knows that you mean the 25th of September 2018 at 6:00 am. 

Note: Spreadsheets store dates and times internally as numbers (so that calculations can be carried out with
them). The number 0 represents 1/1/1900, the number 1 stands for 1/2/1900, etc. The time is stored in the
fractional part of the number.
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However, you don't have to worry about this. Simply enter dates and times in your preferred way. PlanMaker
automatically converts your input into a number but will display it formatted in date/time format. To learn more
about changing the format of dates and times, see Number format.

Tip: Press the shortcut Ctrl+. (period) to enter the current date in a flash and Ctrl+Shift+. to enter the
current time.

Notes on entering logical values (Boolean values)

§ To enter a logical value in a cell, type in either TRUE or FALSE. 

Notes on entering formulas

§ Formulas must always begin with an equal sign; e.g., =2+5. 

§ The command Insert function  in the Edit toolbar can be used to easily insert arithmetic functions. Of
course you can also input formulas manually.

§ For more information on creating formulas, see Formulas and functions.

§ For descriptions of all arithmetic functions, see Functions from A to Z.

Notes on entering text

§ To input text in a cell, simply type it in.  

§ In some rare cases, you may want to "force" PlanMaker to consider a number as text. This can be achieved
by putting a single quotation mark in front of the number. For example, when you enter '42 (including the
single quotation mark), PlanMaker will treat this as text, not as a number.

§ Tip: When you have entered several text entries in a column (one on top of each other), you can open a
dropdown list of these entries by pressing the key combination Alt+Shift+â in a cell directly above or
below the entries. 

A list of all text entries directly above and below this cell will open. You can now select one of these entries
and press the Enter key¿ to paste it into the cell. This can save you a lot of time when you have to enter a
large number of identical text entries.

Note: This feature works only with text entries – not with numbers, dates or formulas.

§ Another tip: In addition, while you type text in a cell, PlanMaker automatically makes suggestions from the
existing text entries found in the cells above and below this cell.  

Example: You have entered the values "New York", "Rio", and "Tokyo" in a column. If you now go to the
cell below these entries and type the letter "N", the program will automatically suggest "New York". If you
type the letter "T", "Tokyo" is suggested, etc.



64Editing worksheets

To accept the suggestion, press the Enter key¿. To reject it, simply continue typing or press the Del key.

Note: In case you do not want PlanMaker to make suggestions while you are typing, you can always disable
this feature.

Choose the ribbon command File | Options , switch to the Edit tab and disable the Autocomplete cells
option.

Undoing changes

In the Quick access toolbar, you can use the Undo button  to undo the last changes made to a document. If,
for example, you format cells in a different font, all you have to do is choose the command Undo and it will be
undone again.

This not only works for formatting, but for virtually all changes – for example, you can undo typing or the
deletion of text.

The command Undo can be applied repeatedly if necessary. For example, you can choose it five times to
reverse the last five changes.

If you click on the small arrow next to the Undo button, you will see a list of recent changes to which you can
revert. If you click on an entry in the list, several steps can be undone at the same time.

Redoing undone actions

There is also a counterpart to the command Undo: the Redo button  on the Quick access toolbar. This
restores the last action you undid. You can thus undo the cancellation of changes.

This command can also be chosen several times in succession. If, for example, you choose the command Undo
five times, the last five changes will be undone. If you then choose the command Redo five times, you will
restore the initial state.

Again, you can use the small arrow next to the Redo button to select entries from the list of recent actions to
restore multiple steps at the same time.

Repeating commands

The Repeat command  in the Quick access toolbar repeats the last command you have used with exactly the
same settings.

This is very useful especially when applying formatting. If, for example, you have assigned a different font to a
cell from the ribbon tab Home | group Character, you can then navigate to other cells and simply use the
Repeat command there. These cells are then formatted in the same font – as if you had chosen the last
command once again, with the same settings.
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There are many other commands that can be repeated as well.

Selecting cells and cell content
For some PlanMaker commands, you can first select a range of cells before you execute them. The command is
then applied to all cells within the selection.

For example, if you select some cells and then press the Del key on the keyboard, all selected cells are deleted
at once.

You can even select non-contiguous cell ranges (using the Ctrl key and the mouse).

The selection procedure differs depending on the operating system in use. Thus, this section is split into two
parts:

§ Selecting in the Windows, Mac or Linux version 

§ Selecting in the Android/iOS version

Selecting in the Windows, Mac or Linux version

In the Windows, Mac, and Linux version of PlanMaker, you can select cells and cell contents as follows:

Selecting via the mouse

To select something via the mouse, proceed as follows:
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§ Selecting cell ranges 

You can select arbitrary cell ranges by pressing and holding the left mouse button while you drag the mouse
pointer over the cells to be selected.

§ Selecting whole rows and columns 

An entire column can be selected by clicking on its column header. Column headers are buttons displayed
above the sheet, labeled A, B, C, and so on.

There are also row headers for each row. They are located at the left of the sheet and labeled 1, 2, 3, etc. If
you click on a row header, the entire row is selected.

If you left-click and drag the mouse over several column or row headers, you can select multiple columns or
rows at the same time.

§ Selecting the entire worksheet 

The button at the top left of the worksheet window (above 1 and to the left of A) has a special function:
clicking on it will select the entire worksheet.

Alternatively, you can do the same with the ribbon command Home | Select all .

§ Selecting a single cell 

To select a single cell, click on that cell, drag the mouse cursor to a neighboring cell, and drag it back again
(while holding down the left mouse button).

§ Selecting non-contiguous cell ranges 

You can also select non-contiguous (not connected) ranges of cells. For this purpose, hold down the Ctrl
key and use the mouse to select a range of cells as described above.

§ Selecting just a part of a cell content 

To select just a part of a cell content, proceed as follows:

First, double-click on the cell (in order to edit it). Then, drag the mouse cursor over the characters that you
want to select (while holding down the left mouse button).

§ Selecting objects 

To select an object (for example, a picture, a drawing, etc.), simply click on it with the mouse. A frame will
then appear around the object to indicate that it is now selected.

To select multiple objects, switch to object mode (see Object mode).

Selecting via the keyboard

Alternatively, you can use the keyboard for selecting. To do so, proceed as follows:

§ Selecting cell ranges 

To select a range of cells, hold down the Shiftñ key, and select the cells by navigating with the arrow keys.

For example, if you navigate to cell B5, hold down the Shiftñ key, and press â five times, the cells B5 to
B10 will be selected. You can find a list of all key combinations suitable for navigating in a table in the
section Shortcut keys.
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§ Selecting a single cell 

To select a single cell, navigate to that cell, hold down the Shiftñ key, use any arrow key to select a
neighboring cell and then go back to the original cell.

So, for example, from the cell to be selected while holding down the Shift keyñ first press the à key and
then the ß key.

§ Selecting non-contiguous cell ranges 

Non-contiguous cell ranges can only be selected with the mouse (see above).

§ Selecting just a part of a cell content 

To select just a part of a cell content, proceed as follows:

Navigate to the cell and press the F2 key (in order to edit the cell). Then, use the arrow keys together with
the Shiftñ key to select text in the usual manner.

§ Selecting objects 

Objects can only be selected with the mouse (see above).

Selecting in the Android/iOS version

Selecting works a little differently on Android/iOS devices. You can use either your finger or a mouse. Proceed
as follows:

§ Selecting cell ranges 

On Android/iOS devices, you can select cell ranges as follows:

Tap on the starting cell once (you should not see a blinking text cursor in the cell now). Wait a little
moment, then tap on the same cell once more and drag your finger to the cell where you want the selection
to end.

Tip: Use the ribbon command Home | Select all  to select the entire worksheet.

§ Selecting just a part of a cell content 

To select just a part of a cell content, proceed as follows:

First, double-click on the cell (in order to edit it). Inside the cell, double-click on the word that you want to
start your selection with. The word should now be selected. This is indicated by the large "handles" that
appear in front of and behind the word:

These two handles represent the beginning and end of the selection. To extend the selection to additional
text, simply drag the two handles to the desired positions.
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§ Selecting objects 

To select an object (for example, a picture or drawing, etc.), simply click on it. A frame will then appear
around the object to indicate that it is now selected.

To select all objects, switch to object mode (see Object mode).

Deleting cells and cell content
There are two methods for deleting data in a worksheet:

§ Deleting the content of cells 

If you use the Del key on the keyboard, only the contents of the selected cells are removed.

§ Deleting whole cells 

However, if you use the ribbon command Home | group Cells | Delete, the selected cells are completely
deleted from the worksheet. The other cells move up to take their space.

In addition, PlanMaker offers two commands especially for deleting empty rows and duplicate rows:
  

§ Deleting empty rows 

To delete all empty rows in a certain range of rows, select these rows and then click the ribbon command
Data | group Edit | Remove empty rows.

§ Deleting duplicate rows 

To delete all duplicate rows in a certain range of rows, select these rows and then choose the ribbon

command Data | group Edit | Remove empty rows  | Remove duplicate rows.

For more information, see the following pages.

Deleting the content of cells

To delete the contents of cells, proceed as follows:

1. Select the relevant cells.

For more information on how to select cells, see Selecting cells and cell content.

2. Press the Del key on the keyboard (or the ribbon command Home | Cut  ).

Only the contents of the cells are removed, not the cells themselves (see next section Deleting whole cells).

Selective deletion

If you use the ribbon command Home | group Contents | Delete  (Delete special) instead, you determine
exactly what will be deleted.
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The program displays a dropdown menu with the following options:

§ All 

Deletes everything – cell contents as well as formatting, comments, conditional formatting and input
validation.

§ Formatting 

Removes only the formatting (number format, character format, borders, etc.).

§ Contents 

Deletes only the contents. Everything else (formatting, comments, etc.) is kept.

§ Comments 

Removes only comments that have been added to the selected cells, leaving both content and formatting
intact (see Using comments).

§ Conditional formatting 

Removes only the conditional formatting (see Conditional formatting).

§ Input validation 

Removes only the input validation (see Input validation).

§ Reset character formatting 

Removes all character formatting, that you have applied, from the selected cells (see also Resetting the
character formatting).

§ Remove link 

Removes the hyperlink, but the cell or text passage to which it is assigned remains intact (see also Using
hyperlinks).

Deleting whole cells

The ribbon command Home | group Cells | Delete  not only deletes the content of the selected cells but also
removes them from the worksheet completely.

If you click on this command, a dropdown menu appears where you can determine how the other cells should
be moved up after the deletion process.

The following options are available:

§ Delete cell, move cells up 

The selected cells are removed, and the cells below move up.

§ Delete cell, move cells to the left 

The selected cells are removed, and the cells to the right of them move to the left.

§ Remove complete rows 

The entire row(s) including the selected cells are removed. The rows below move up accordingly.
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§ Remove complete columns 

The entire column(s) including the selected cells are removed. The columns right of them move to the left
accordingly.

§ Delete worksheet 

Removes the worksheet (including its contents), see Managing worksheets.

Deleting empty rows

To delete all empty rows in a certain range of rows, select the range from which you want to remove empty
rows.

Then choose the ribbon command Data | group Edit |  Remove empty rows.

PlanMaker scans this range for rows that are completely empty, (i.e. where none of its cells is filled with a
value). It then deletes all matching rows.

Note

Normally, you use this command with a range of entire rows selected. However, you can also select a cell range
that doesn't consist of entire rows. In that case, PlanMaker will first ask you if you want it to delete matching
rows entirely:

§ If your answer is Yes, the entire row will be deleted for all matching rows. 

§ If your answer is No, only cells inside the selection will be deleted. The cells left and right of the selection
are not affected.

Deleting duplicate rows

To delete all duplicate rows in a certain range of rows, select the range from which you want to remove these
rows.

Then select the ribbon command Data | group Edit |  Remove empty rows  | Remove duplicate rows.

PlanMaker scans this range for rows that are completely identical, (i.e. where the contents of all cells in one
row are identical to another row). It then deletes these duplicate rows.

Note

Normally, you use this command with a range of entire rows selected. However, you can also select a cell range
that doesn't consist of entire rows. In that case, PlanMaker will first ask you if you want it to delete matching
rows entirely:

§ If your answer is Yes, the entire row will be deleted for all matching rows. 

§ If your answer is No, only cells inside the selection will be deleted. The cells left and right of the selection
are not affected.
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Inserting new cells

The ribbon command Home | group Cells | Insert  inserts new cells, rows or columns in a worksheet.

If you click on this command, a dropdown menu appears where you can choose in which way the cells should
be inserted.

The following options are available:

§ Insert cell, move cells down 

Exactly as many cells are inserted as were selected before executing this command. If nothing was selected
before, just one cell will be inserted.

The cells below the insertion are moved down.

§ Insert cell, move cells to the right 

Exactly as many cells are inserted as were selected before executing this command. If nothing was selected
before, just one cell will be inserted.

The cells to the right of the insertion are moved further to the right.

§ Insert complete rows 

PlanMaker will insert as many complete rows as were selected before executing this command. If nothing
was selected before, just one row will be inserted.

The rows below the insertion are moved down.

§ Insert complete columns 

PlanMaker will insert as many complete columns as were selected before executing this command. If
nothing was selected before, just one column will be inserted.

The columns to the right of the insertion are moved further to the right.

The following options are also available in the Insert  icon's dropdown menu:

§ Insert copied cells, see next section 

§ Insert worksheet, see Creating new worksheets
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Inserting copied cells
It happens from time to time that you want to place copied cells at a position where values already exist. If you
do not want to overwrite these values, but move them when pasting something from the clipboard, the following
option is available.

The ribbon command Home | group Cells | Insert  | Insert copied cells inserts cells, rows or columns from
the clipboard into the worksheet.

The program opens a dialog box where you can choose in which way the cells should be inserted:

§ Move cells down 

The copied cells from the clipboard are inserted at the selected position.

The cells below the insertion are moved down.

§ Move cells to the right 

The copied cells from the clipboard are inserted at the selected position.

The cells to the right of the insertion are moved further to the right.

§ Insert complete rows 

The copied rows from the clipboard are inserted at the selected position.

The rows below the insertion are moved down.

§ Insert complete columns 

The copied columns from the clipboard are inserted at the selected position.

The columns to the right of the insertion are moved further to the right.
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Moving and copying
All operating systems that PlanMaker supports have an extremely useful feature: the clipboard.

The clipboard works as follows: You select something in the worksheet and then cut or copy the selected
content to the clipboard. You can then reinsert the selected content elsewhere in the worksheet. The clipboard
thus facilitates the deletion, copying and moving of cells (as well as objects).

All necessary commands can be found on the ribbon tab Home | group Edit:

Command Explanation

Cut The ribbon command Home | Cut deletes the content of a selection – but not permanently. This
content is moved to the clipboard, where it remains available for subsequent insertion anywhere.

Copy The ribbon command Home | Copy copies the content of the selection to the clipboard.

Paste* To paste the contents of the clipboard, use the Home | Paste command. Place the marker at the
desired position and then choose this command (click directly on the icon itself). You can also
insert the content of the clipboard multiple times in this manner.

Paste special If you click on the small arrow below the icon rather than directly on it at Home | Paste, a
dropdown menu opens with additional options for pasting the content. For more information, see
Paste special.

* How to paste from the clipboard without overwriting the existing values of the active cell, see chapter Inserting copied cells.

These works in the same manner for objects such as pictures, charts and drawings.

Pasting into a selected cell range

When you copy cells to the clipboard and select a range of cells before inserting them with the ribbon command
Home | Paste, the pasted cells will be fit into the selection.

This is shown as follows:

§ If the selected cell range is smaller than the cell range to be pasted, all cells which do not fit are omitted. 

§ If the selection is larger than the cell range to be pasted, the cells are repeated until the selected range is
completely filled.

§ There's one exception:

If the selected cell range consists of just one row, PlanMaker will still paste all columns of the source cells.

The same applies when the selected cell range contains only one column.

Moving and copying using the mouse ("Drag and Drop")

Android/iOS: This function is not available in the Android and iOS version.
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To move or copy cells using the mouse: Select the cells, drag them to a different place and drop them there.
With this technique, known as drag and drop, you can move or copy cell contents very quickly.

To do so, proceed as follows:

1. Select the desired cells.

2. Press the left mouse button on the selected cells and wait about one second until a small dashed rectangle
appears at the mouse cursor.

3. While still holding the mouse button down, drag the selected cells to the desired position.

4. When you release the mouse button, the cells will be moved to the new position.

If you hold down the Ctrl key down while releasing the mouse button, the cells will instead be copied to the
new position.

If you hold down the Alt key down while releasing the mouse button, a dialog box appears where you can
choose if you want the cells to be copied or moved. When you choose "Copy", you can also specify if just
the cell contents should be copied or also their formattings.

Moving and copying formulas containing relative coordinates

If you copy cells that contain formulas, the cell addresses in the formulas are automatically updated to the new
place in the worksheet.

An example:

Suppose you have a formula in cell A7 that adds up the values from the four cells above:

=SUM(A3:A6)

Now you copy this formula to position B7. PlanMaker will automatically update the formula so that it will work
again with the four cells above the total row. Cell B7 will therefore contain the following formula:

=SUM(B3:B6)

If you do not want this to happen, use absolute cell addressing instead of the usual relative cell addressing (see
Relative versus absolute cell references).
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Paste (special)

There is a more powerful variant for the ribbon command Home | group Edit | Paste : If, for example, you

have copied text or complete cells and click on the small arrow  below the icon, you can use the dropdown
menu to specify in which form the content from the clipboard should be pasted.

In detail:

When you use the commands Cut or Copy to save information to the clipboard, it is saved in multiple formats
simultaneously. If, for example, you have copied text, it appears in the clipboard in both formatted and
unformatted form.

Normally, you don't need to be concerned about this, because PlanMaker automatically selects the most
appropriate format when it pastes the content of the clipboard into the document by clicking directly on the icon
 Paste. However, if you need to, you can select the format yourself by clicking on the arrow of the icon Insert

.

The following options are available here:

Paste contents: Via the dropdown menu of the command

If you click on the small arrow of the ribbon command Home | group Edit | Paste , you will get a dropdown
menu with various entries for direct selection:

§ Paste :The original formatting of the copied content is retained. This results in the same program
behavior as when you click directly on the Paste icon above the small arrow. 

§ Paste unformatted text : appears contextually when you have copied text. If you select this entry, the
original formatting of the copied text is removed, and it adopts the formatting of the passage where it is
pasted. This option can also be found in the Paste special dialog box (see below)

§ Paste picture : appears contextually if you have copied an image. Use this entry to paste the picture from
the clipboard.

§ Paste formats, Paste values, Other paste options (appear contextually): If you have copied complete table
cells, the dropdown menu offers some common insert options, which you can also find in the dialog box
Paste special (see below).

§ Paste special opens a dialog box with differentiated options for pasting contents from the clipboard (see
below). 

Paste special: Via the dialog box with additional options

If you select the Paste special entry from Home | group Edit | Paste , a dialog box appears where you can
specify exactly how the content from the clipboard is to be pasted.

The dialog box displays a list of all formats in which the information currently residing in the clipboard is
stored. When you select a format from the Paste as list and then confirm with OK, the content of the clipboard
is inserted in the selected format.
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In addition, this dialog box offers several additional options, which are only available if table cells have been
copied to the clipboard:

Options available:

"Paste content" section

These options allow you to control how the content of the cells in the clipboard should be inserted when they
are pasted:

§ Paste special 

If this option is enabled, the content of the copied cells is pasted. If it is disabled, just their formatting is
pasted.
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§ Convert formulas to values 

If this option is enabled, PlanMaker will paste the results of formulas in the copied cells – rather than the
formulas themselves. For example, if the clipboard contains a cell with the calculation "=A1*2", PlanMaker
will calculate its current value and paste the result as a fixed number.

§ Ignore comments 

If this option is checked, comments attached to the cells in the clipboard will not be pasted.

"Paste formatting" section

These options allow you to control if the formatting of the copied cells should be retained when they are pasted:

§ All 

The cells in the clipboard retain their entire formatting when they are pasted. (Choosing this option activates
all the other options listed below.)

§ Number format 

The cells retain their number format when they are pasted.

§ Cell format 

The cells retain their cell format when they are pasted.

§ Input validation 

The cells retain their input validation settings when they are pasted.

§ Conditional formatting 

The cells retain their conditional formatting settings when they are pasted.

§ Borders, Shading 

The cells retain their borders/shading when they are pasted.

"Paste cell dimensions" section

These options allow you to control if the cell sizes of the copied cells should also be transferred to the target
cells on pasting:

§ Column width 

The cells retain their column width when they are pasted.

§ Row height 

The cells retain their row height when they are pasted.

"Options" section

This section contains the following additional options:
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§ Transpose 

If this option is enabled, the row and column order of the cells will be exchanged when they are pasted.
Rows become columns, and columns become rows.

§ Skip empty cells 

If this option is enabled, empty cells amongst the cells in the clipboard will be skipped when they are pasted.
Accordingly, if you paste an empty cell over an existing cell, the existing cell will keep its current content
and formatting.

§ Operation 

This option can be useful when you paste cells over existing cells. It determines whether the existing values
should be combined with the copied values. For this purpose, the four basic arithmetic operations are
available:

None: Do not combine the existing values with the values in the clipboard. Just overwrite the existing
values. This is the default setting.

Add to destination: Add the values in the clipboard to the existing values.

Subtract from destination: Subtract the values in the clipboard from the existing values.

Multiply with destination: Multiply the existing values by the values in the clipboard.

Divide the destination: Divide the existing values by the values in the clipboard.

Example: Copy a cell that contains the value 2 to the clipboard. Then select a cell that contains the value 8

and go to the command Home | Paste  | Paste special. If you choose the option Add to destination in the
dialog box, the cell will contain the value 10 now (8+2=10).

"Paste reference" button

The Paste reference button ignores any settings made in this dialog box, since it has the following special
function:

When you copy cells to the clipboard, select the command Home | Paste  | Paste special and then click the
Paste reference button, cell references to the addresses of these cells are pasted instead of the cell contents.

For example, when you copy the cell B15 to the clipboard, using this button will insert the cell reference =B15.

Tip: This even works when cells have been copied to the clipboard from within a different document. In this
case, PlanMaker will insert an external cell reference (see External cell references for details).
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Filling cells automatically
It is possible to copy the contents of one cell to other cells in an instant using the Fill function – or to create an
increasing or decreasing number series across several cells starting from a certain cell content.

There are two ways to use this function:

Filling with the mouse

The easiest way to fill cells automatically is via the mouse. Proceed as follows:

1. Enter the initial value in a cell.

2. Click on that cell (to make it the currently selected cell).

3. With your mouse, point to the small rectangle in the bottom-right corner of the cell frame (marked in red
color in the figure below):

4. Drag this rectangle, while holding the mouse button down, to cover the desired range of cells. Release the
mouse button when the target position has been reached.

All cells in the selection you created have now been automatically filled.

What the cells are filled with depends on the content of the initial cell:

§ If the initial cell contains text, PlanMaker fills all cells with this text. 

§ If the initial cell contains a number (e.g., 42), PlanMaker fills successive cells with incrementing values (in
this case, 43, 44, 45, etc.).

Tip: If you do not want PlanMaker to fill the cells with a series of numbers but, instead, duplicate the value
42 in all cells, press and hold down the Ctrl key, while dragging with the mouse.

To control the fill function precisely, press and hold down the Alt key while dragging. A dialog box (described
below) will appear, providing full control over how the cells are filled.

Filling via buttons/dialog

To fill cells automatically via buttons/dialog box, proceed as follows:

1. Enter the initial value in a cell.

2. Select the cell with this initial value and all cells you want to be filled.

3. Choose the ribbon command Home | group Contents | Fill .

4. In the dropdown menu, specify the fill direction (starting from the cell with the initial value in the direction
of the selected cells): Down, right, up or left.
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As soon as you have selected a direction, the corresponding cells are filled with the initial value (copied as
value and format, not incremented).

5. If you want to make further settings (for example, increment values instead of copying them), choose the
Series entry in the dropdown menu to open the dialog box.. Here you can define exactly how the cells
should be filled (see below).

As soon as you confirm with OK in the dialog box, the selected cells are filled according to your settings.

In the dialog box...

...the following settings can be configured:

§ Series in 

Select here if you want to fill in the direction of the rows (right) or in the direction of the columns (down).

Note: If you have selected only one row or only one column, this option is omitted and PlanMaker automatically defaults to rows or
columns.

§ Source 

Enable the Contents option if you want the cells to be filled with values.

Enable the Format option if you also want the formatting of the source cell to be continued in the new cells.

By default, both options are enabled.

§ Action 

This option is equivalent to pressing the Ctrl key during filling with the mouse. It lets you determine
whether to copy values or to increment them from cell to cell:

If, for example, the initial cell contains the number 42 and you select Copy, all cells will be filled with the
value 42.

If you select Increment, successive cells will be filled with a series of numbers (in this case, 43, 44, 45,
etc.).

The numerical increment can be specified using the other options in this dialog box:
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§ Series type 

Lets you specify how the series of values is continued:

Auto:

Arithmetic series with automatic increment. Each next value will be increased by an increment The
increment is determined by PlanMaker automatically.

If, for example, you continue two cells containing the values 10 and 20, the next cells will be filled with 30,
40, 50, etc. (see also tips and tricks in the next section).

Arithmetic:

Here, each next value will be increased by the increment.

If, for example, the initial cell contains the value 1 and you specify an increment of 2, the next cells will be
filled with 3, 5, 7, 9, 11, etc.

Geometric:

Here, each next value will be multiplied by the increment.

If, for example, the initial cell contains the value 1 and you specify an increment of 2, the next cells will be
filled with 2, 4, 8, 16, 32, etc.

Date:

Here, each next value in the chosen Date unit (see below) will be increased by the specified increment. This
type of series only works correctly if the initial cell contains a date.

If, for example, the initial cell contains the date 1/1/2018, the Increment is set to 1 and the Date unit is set
to "Months", the new cells will be filled with 2/1/2018, 3/1/2018, 4/1/2018, etc.

§ Date unit 

This option is only available if the Series type is set to "Date".

It allows you to specify the date unit of the increment:

Days: increment by days

Workdays: increment by days, excluding Saturdays and Sundays. For example, if the initial value is a
Friday, the next value would be the Monday (not Saturday).

Months: increment by months

Years: increment by years

§ Increment 

Lets you specify the amount by which each value will increase from cell to cell. For examples, see above.

Positive or negative increment values can be used.

This option is not available if the Series type is set to "Auto", because PlanMaker automatically determines
the increment in this case.

§ Increment each cell separately 
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When this option is enabled, the specified increment will be added to each of the currently selected cells
individually.

Example: Let's assume you have selected three cells containing the values 1, 2,and 3, and try to fill the cells
below them.

When this option is disabled, the sequence from the source cells is simply continued and the cells are filled
as follows:

4, 5, 6, 7, 8, 9, 10, 11, 12, etc.

When you enable this option, the cells are filled as follows:

2, 3, 4, then 3, 4, 5, then 4, 5, 6, etc.

§ Edit lists button 

You can also create your own lists for the Fill function.

If, for example, you create a list with the content "Red", "Green" and "Blue", and later start a fill operation
from a cell that contains the text "Red", PlanMaker will continue the series and fill with Green, Blue, Red,
Green, Blue, etc.

For more information on how to create such lists, refer to Editing lists for automatic filling.

Tips and tricks for automatic filling

The many options that are available for the Fill function make its application seem more difficult than it
actually is. This section offers some tips and tricks to help you effectively use this very useful feature.

Tip: The quickest way to fill a range of cells is to drag the small rectangle in the bottom-right corner of a cell
with the mouse in the appropriate direction. PlanMaker then sets the series type to "Auto". This means it will
automatically figure which values to use to fill the cells (see examples).

§ Filling with text 

When filling with text, you do not need to worry about any options, because text can only be copied anyway.

Then, drag the small rectangle in the bottom-right corner of the cell over the cells you want to fill.

§ Filling with numbers 

If you use the mouse to fill cells with numbers, PlanMaker will automatically determine the increment.

If, for example, you drag the small rectangle from a cell with the value 42, the other cells will be filled with
the values 43, 44, 45, etc.

If the initial cell value is 10, and the next cell value is 20, and you select both cells and drag the small
rectangle down, PlanMaker automatically recognizes how to continue this series and fills the other cells with
30, 40, 50, etc.

§ Filling with formulas 

If you use the mouse to fill cells with formulas, PlanMaker automatically attempts to update the formulas in
the new cells with incremented cell addresses.

For example, the formula =A1*2 in the initial cell will be updated to =A2*2, =A3*2, etc., in the other cells.
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§ Filling with dates 

Filling with dates is identical to filling with numbers:

Enter the starting date in the initial cell and drag the small rectangle over the desired cells. PlanMaker will
add one day in every next cell.

If desired, you can use the ribbon command Home | group Contents | Fill | Series to specify via the dialog
box whether to increment by days, months or years.

§ Filling with structures 

As you have already learned, it is possible to select multiple initial cells before starting the filling operation.
But what if the selected cells have no automatically recognizable increment or completely different values?

PlanMaker will attempt to find a pattern in these values. If, for example, you enter the values 1, 2, text,
PlanMaker will continue the series with 3, 4, text; 5, 6, text; 7, 8, text; etc.

If the initial cells contain just text, PlanMaker will simply repeat the text. For example, the series Red,
Green, Blue will be repeated as Red, Green, Blue, Red, Green, Blue, etc.

§ Filling with custom lists 

With the ribbon command Home | group Contents | Fill | Series you can create your own lists for the Fill
function using the Edit lists button in the opened dialog box.

If, for example, you create a list with the content "Red", "Green" and "Blue", and later start a fill operation
from a cell that contains the text "Red", PlanMaker will continue the series and fill with Green, Blue, Red,
Green, Blue, etc.

Note: If desired, you can also add a separate Edit lists button for direct access to a ribbon tab. For more
information on this and all other information on creating your own lists, see Editing lists for automatic
filling.

Working with multiple worksheets
PlanMaker documents are not limited to single worksheets. As needed, you can stack several worksheets on top
of each other – just like a stack of papers. PlanMaker documents are therefore also called workbooks. Each
workbook can contain up to 2048 worksheets.

The main advantage of this is that calculations in one worksheet can also refer to cells in other worksheets of a
workbook, in essence, letting you create "three-dimensional" calculations (see the section Calculating in three
dimensions).

In this section, you will learn everything you need to know about working with multiple worksheets in a
document. The following topics are covered:

§ Creating new worksheets 

To create a new worksheet, use the ribbon command Insert | Sheet | Insert.
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§ Working with the worksheet register 

The worksheet register displayed at the bottom of the document window allows you to switch between your
worksheets with a single mouse click. You can also use it to create, move and manage worksheets.

§ Managing worksheets 

The context menu of the worksheet register and the ribbon command Insert | Sheet are both containing
commands to manage worksheets (renaming, copying, moving sheets, etc.).

§ Calculating in three dimensions 

In the last section, you will learn how to create calculations that refer to cells in other worksheets.

The following pages provide detailed information on these topics.

Creating new worksheets

To create a new worksheet, choose the ribbon command Insert | group Tables | Sheet . The program opens a
dropdown menu, where you can choose the Insert command.

Tip: You can create a new worksheet faster with the  icon in the worksheet register.

PlanMaker creates the worksheet and makes it the active worksheet.

Working with the worksheet register

The worksheet register at the bottom of the document window displays tabs for each worksheet in the
document.

The active worksheet is highlighted.

With the worksheet register, the following actions can be performed:

§ Switching between worksheets 

To switch to a different worksheet, click on its tab in the worksheet register.

Note: If there are more worksheet tabs than can be displayed at the same time, you can scroll through the list
using the arrows displayed to the left of the register.

Tip: You can also switch between the worksheets using the keyboard: Use Ctrl+Tab to move to the next
worksheet and Ctrl+Shift+Tab to the previous worksheet.
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§ Changing the order of worksheets 

The worksheet register can also be used to move worksheets, allowing you to change their order.

To do so, click with the left mouse button for about one second on the tab of the sheet that you want to move
and, while still holding down the mouse button, drag the tab to the desired position in the worksheet register.

§ Editing multiple worksheets at the same time 

You can select multiple worksheets in the worksheet register and edit them simultaneously. To select
multiple worksheets, press and hold the Ctrl key while you click on their tabs in the register. (Note for Mac
users: Cmd key)

When multiple worksheets are selected, changes made to one of the worksheets affect all of the other
selected worksheets in exactly the same way.

Examples:

When you change the formatting of cells, your changes are also applied to the same cells on the other selected worksheets.

When you edit or delete the content of a cell, the same cell on the other selected worksheets will be changed the same way.

Changes to the cell size (ribbon tab Layout | group Cells) also affect all selected worksheets.

Tip: To select multiple worksheets at once, use the Shift key instead of Ctrl. To deselect, click again with
the mouse and Ctrl or Shift on the register tab(s).

§ Managing worksheets 

When you click on one of the tabs in the worksheet register with the right mouse button, a context menu will
appear, showing commands for creating and managing worksheets. For more information, see the next
section Managing worksheets.

§ Creating a new worksheet 

The tab to the right of the worksheet register with the icon  serves as a "shortcut" for creating new
worksheets: When you click it, PlanMaker immediately creates a new worksheet.

Managing worksheets

If you choose the ribbon command Insert | group Tables | Sheet , a dropdown menu opens with commands
for managing worksheets.

Tip: These commands (and a few more) also appear in the context menu by right-clicking on the desired tab
in the worksheet register at the bottom.

The following commands are available in the menu:

§ The command Insert creates a new worksheet. 

§ The command Copy creates a copy of a worksheet. A submenu opens where you can choose the position of
the copy (within the other worksheets).

If you want to place the copy in a different (currently opened) document or in a new document, choose the
option To another document.
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§ The command Move moves the worksheet to a different location. As with the command Copy a submenu
opens where you can choose the position. 

§ The Delete command removes a worksheet along with its contents.

Alternatively you can find the command under Home | group Cells | Delete | Delete worksheet.

§ The Rename command lets you change the name of a worksheet.

Tip: You can also simply double-click on the worksheet in the register at the bottom.

§ The Hide command hides a worksheet. 

Alternatively you can use the command Home | group Cells | Visibility | Hide sheet.

Hidden worksheets are invisible. They cannot be displayed or edited, and they do not even appear in the
worksheet register. However, PlanMaker still uses them as a source for calculations.

§ The Show command makes hidden worksheets (see Hide command) visible again.

Alternatively you can use the command Home | group Cells | Visibility | Show sheet.

This opens a dialog box that shows all hidden worksheets. In the list, click the sheet you want to show again.
Use the Select all button to select all hidden sheets from the list. Press OK to make the selected worksheets
visible again.

§ The commands Select all sheets and Deselect sheets (in the context menu of the worksheet register) select
or deselect all worksheet tabs in the worksheet register. 

§ The command Page Setup (in the context menu of the worksheet register) allows you to change page layout
options like paper format, page margins, etc. for a worksheet. The dialog box corresponds to the ribbon tab
Layout | command group Page Setup . See Page setup.

§ The command Copy page setup (in the context menu of the worksheet register) allows you to copy the page
setup of a worksheet – i.e. all settings made with Page setup – to another worksheet. It opens a submenu
with the following entries:

To all sheets: Copies the page setup from the current worksheet to all other sheets.

From...: Copies the page setup from any other worksheet to the current worksheet.

§ With the Properties command you can make general settings for a worksheet. For more information, see
Worksheet properties. 

Tip: As described in the section Working with the worksheet register, you can select multiple worksheets in the
worksheet register. Some of the commands mentioned (for example, Hide) can then be applied to all selected
sheets at the same time.

Note: If you enable workbook protection for a document, from now on no more changes to the worksheet
register can be made in the document. Also the ribbon commands under Insert | Sheet are no longer
available. For more information, see Workbook protection.
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Calculating in three dimensions

In a multi-worksheet document, you can create calculations in one worksheet that refer to cells in other
worksheets, allowing you to perform "three-dimensional" calculations.

To do so, place the name of the desired worksheet before the cell address and separate it with an exclamation
point. For example, "Sheet1!B2" refers to cell B2 on worksheet "Sheet1".

An example

Assume you want to create a profit/loss statement. For this purpose, you have created three worksheets named
"Sales", "Costs" and "Profit".

Now you want the value in cell D2 of the "Costs" worksheet to be deducted from the value in cell A8 of the
"Sales" worksheet and to appear in cell C9 of the "Profit" worksheet.

To do this, switch to the "Profit" worksheet. In it, navigate to cell C9 and enter the following formula:

=Sales!A8 - Costs!D2

After pressing the Enter key¿, cell C9 on the worksheet "Profit" will contain the result of your calculation.

Naming cell ranges

Use the ribbon command Edit names  to assign names to cell ranges.

For example, if your worksheet has four columns with the sales figures for spring, summer, fall and winter,
name these ranges accordingly. After that, a calculation like the following is possible:

=SUM(Spring)

The ribbon tab Formula | group Named areas contains all commands you need for named cell ranges.

Note: This command will not be available if at least one worksheet in your workbook has enabled a
worksheet protection (see also Sheet protection).

For more information on working with named ranges, see the next pages. The following topics are covered:

§ Assigning and editing names to cell ranges 

§ Defining names automatically from the selection

§ Creating a list of all named ranges

§ Using named ranges
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§ Applying names to existing formulas

Assigning and editing names for cell ranges

Assigning names

To assign a name to a range of cells:

1. Select the cell range that you want to name.

2. Choose the ribbon command Formula | group Named areas | Edit names .

3. Input a name for the cell range in the input field Name.

4. Click the Add button.

You have now assigned the specified name to the selected cell range.

From now on, this name can be used in formulas instead of the original cell addresses. If you assign the name
"January" to the cell range from A2 to A10, the formula =SUM(January) is equivalent to =SUM(A2:A10).

Note: Names may only consist of alphanumeric characters, underscores and periods. The first character must
be a letter or an underscore.
Furthermore, names that look like a cell address must not be used. For example, the name "A2" is not valid
because PlanMaker wouldn't be able to distinguish it from the cell address A2.

Tip: A faster method

There is a faster method for assigning names to cell addresses:

In the top left corner of the worksheet is an editable dropdown list that normally displays the current cell
address.

Use this dropdown list to quickly set up a new named range, as follows:

1. Select the cell range that you want to name.

2. Click with the mouse in this editable dropdown list.

3. Enter the new name for the selected cell range.

4. Press the Enter key¿.
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You have now assigned the specified name to the selected cell range.

Renaming or deleting names

To rename or delete a named cell range, proceed as follows:

1. Choose the ribbon command Formula | group Named areas | Edit names .

2. In the list of names, select the desired name.

3. To rename it, click the Rename button. To delete it, click the Delete button.

The name has now been renamed/deleted.

Note: When you delete a name, all formulas that use this name will now return a #NAME? error value
instead of a result. If, for example, a cell range was named "January", all references to this named range,
such as =SUM(January), will display a #NAME? error value.

Defining names automatically from the selection

If you select cells that contain values as well as row or column headings, you can let PlanMaker generate named
ranges automatically from these cells. PlanMaker then picks up the names from the headings.

Proceed as follows:

1. Select the desired cell range. It must contain both the values and the headings that will be used to create the
named ranges.

2. Choose the ribbon command Formula | group Named areas | Create names .

3. A dialog box appears, here you can select which row and/or column contains the headings that will be used
for naming the ranges (see example).

4. Confirm with OK.

The names will now be created from the selected headings.

An example

You have created the following table:

Now select all values and all headings and choose the ribbon command Formula | Create name. Select which
row and/or column headings to use:
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§ If you select Top row, PlanMaker assigns the names "January", "February" and "March" to the cells below
them. 

§ If you select Left column, PlanMaker names the cells to the right of "London", "Paris" and "Madrid" with
the corresponding name.

§ If both options are selected, PlanMaker will create all six names.

Creating a list of all named ranges

PlanMaker can insert a list of all named ranges into the worksheet. This is useful if you want an overview of all
named ranges in the workbook and the corresponding cell addresses.

To do so, proceed as follows:

1. Select the cell where the list is to be inserted.

2. Choose the ribbon command Formula | group Named area | Export names .

A list of all named ranges will now be inserted into the worksheet.

Using named ranges

If you have named cell ranges using the ribbon command Formula | group Named ranges | Edit names ,
you can perform various operations much more efficiently.

In practice, you use named ranges as follows:

Quickly selecting a named range

In the top-left corner of the worksheet window, you can see a dropdown list that displays the address of the
currently selected cell.

When you open this dropdown list, it will display a list of all named ranges. Clicking on one of these names
will select the corresponding cell range.
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Using names in formulas

In formulas, range names can be used instead of the cell addresses they represent. This saves time, but also
makes formulas easier.

An example:

You have entered sales figures for January in cells A2 to A10. You have also assigned the name "January" to
this range of cells.

To sum up the sales, you simply type:

=SUM(January)

This method is also considerably more understandable than the default naming convention of =SUM(A2:A10).

Of course you can now also name the sales for February, March etc. accordingly.

Tip: In the dialog box of the ribbon command Formula | Function  there is also an entry called "Named
ranges" in the Category list. If you select this category, all named ranges are listed in the Function list so
that you can easily insert them into formulas.

Applying names to existing formulas

The ribbon command Apply names on the ribbon tab Formula | group Named areas is a useful helper for
applying named ranges: It scans all formulas in the selected area. If it finds a cell reference within a formula for
which a name has already been defined, it replaces it with the name.

You use this command as follows:

1. Select the range of cells whose formulas you want to update. If you do not select anything, the entire
worksheet will be affected.

2. Choose the ribbon command Formulas | group Named areas | Apply names .

3. In the Names list, select all names you want to apply. Alternatively, click Select all to select all names.

4. Confirm with OK.

PlanMaker now searches all cell references within the selected area. Any cell reference that has a name
assigned to it will be replaced by the corresponding name.

An example:

The name "January" is assigned to cells A2 to A10. One of the cells in the worksheet contains the formula
=SUM(A2:A10). Using the ribbon command Formula | group Named range | Apply names, the formula in
this cell will be converted to =SUM(January).
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The option "Also apply to relative references"

In the dialog box mentioned above, you will find an option named Also apply to relative references. This
option should remain enabled in most cases.

This option means the following:

In PlanMaker, names always refer to cell ranges with absolute addressing (like $A$1:$A$10). But in most
calculations, the relative addressing is commonly used (like A1:A10).

If this option is enabled, PlanMaker will convert relative cell references as well.

If it is not disabled, PlanMaker will only convert absolute cell references.

An example:

Assume the range from A1 to A10 (more precisely: $A$1:$A$10) was named "January". If you apply the
Apply names function to the formula =SUM($A$1:$A$10), this formula will always be converted to
=SUM(January). But if you apply it to the formula =SUM(A1:A10), the formula will be converted only if the
option Also apply to relative references is enabled.

For more information on absolute and relative cell addresses, see Relative versus absolute cell references.

Transposing cells

The ribbon command Data | group Edit | Transpose  exchanges the row and column order of the selected
cells. Rows become columns, and columns become rows.

Select the desired cells before you use this command.

Important: Please note that transposing does not adapt any formulas or range names to the changes made to
cell addresses by transposing, neither inside nor outside the transposed range!

Splitting text into multiple columns

iOS: The command is not freely available in this version.

With the ribbon command Data | group Edit | Text in columns you can distribute text entered in one table cell
into multiple columns. If, for example, a cell contains a sentence, this command will move each single word
into its own column.

You apply this command as follows:

1. Navigate to the cell containing the text to be distributed.

(You can also select multiple cells or even an entire column.)
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2. Choose the ribbon command Data | group Edit | Text in columns .

3. The program displays a dialog box with several options (see below).

As a rule, PlanMaker determines appropriate settings for this dialog box automatically, so you don't have to
care about it.

4. Confirm with OK.

The text in the cell is distributed over several columns.

Options of the dialog box

Tip: The best settings for this dialog box are determined from the given cell content automatically. Usually,
no manual changes are required.

The dialog box for this command has the following options:

§ Target range 

If desired, you can enter a different target range here. If you do so, the distributed text will not be placed at
its original position, but at the specified target position.

It is sufficient to enter just the address of the cell in the top left corner of the target position.

§ Separator 

If required, you can specify which character PlanMaker should consider as a text separator here. If, for
example, the cell contains the sentence "This is a test", PlanMaker automatically chooses blanks as
separators, which will move each word of the sentence into one column.

§ Text marker 

If the text in the cell contains text marker characters, use this option to specify which character has been
used (e.g. quotation marks).

(Background info: The text export feature of some programs surrounds each data field with such a character,
in order to make it easy to determine where a data field begins and ends.)

Sorting cells
With the sort commands on the ribbon tab Data | group Filter, you can sort a cell range.

Tip: You will also find the commands on the ribbon tab Home | group Contents | Sort and filter.

Simple sorts: Quickly via the direct commands

If you only want to apply the sort to a certain column, you can do this using directly the commands Sort
ascending and Sort descending.

You can also select a cell range across several columns; in this case, the left column of the selected range is
sorted. The selected values to the right of it follow their left value in the same row.
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Select the cell range you want to sort and then choose one of the following commands on the ribbon tab Data |
group Filter:

§ Ascending  

The data of the selected column is sorted in ascending order (A-Z).

§ Descending 

The data of the selected column is sorted in descending order (Z-A).

If, on the other hand, you want to apply different sort criteria to the columns of a selected cell range or set
additional options, choose command Sort to open the dialog box (see below).

Sorting with different criteria: Via the dialog box

With the ribbon command Sort you can open a dialog box with additional sort options.

To do so, proceed as follows:

1. Select the cell range to be sorted.

2. Choose the ribbon command Data | group Filter | Sort .

3. The following dialog box opens:

4. Choose at 1: the Column you wish to sort on.

5. Next to the column, you can choose the Order of the sorting: Ascending (A to Z) or Descending (Z to A).
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6. If required, you can choose additional columns to sort on at 2: and 3:.

If, for example, you choose a column containing family names at 1: and a column with first names at 2:, the
cell range will be sorted by the family name – and then, in groups of identical family names, by the first
name.

7. Make any further settings as required, see below.

As soon as you confirm with OK, the cell range will be sorted accordingly.

Options of the dialog box

The dialog box offers the following options:

§ Column and Order 

Here, select the desired column(s) to determine the sorting sequence.

You can also specify the sorting direction for each column: Ascending goes from A to Z, and Descending
goes from Z to A.

By default, up to 3 columns can be specified. You can even add additional columns, if you need more than 3
sort criteria. Up to 64 columns are supported. Proceed as follows:

Adding a column: Click the Plus icon to add an additional column at the respective position.

Appending a column: Click the Append button (below the list) to append a column at the bottom.

Removing a column: Click the Minus icon to remove the respective column. (This only works if there
are more than 3 columns)

§ Sort row by row or Sort column by column 

Determines whether PlanMaker sorts by row or by column.

§ First row contains headings 

If the first row or column of the selected cells contains a heading, enable this option. PlanMaker omits it
from the sorting.

Example: You have selected a list of postal addresses that you want to sort by row. The first line of your
selection contains headings such as "Name", "Street", "City", etc. The actual addresses are in the rows
below. If you enable this option, the first row is not sorted along with the addresses, but stays on top.

§ Case sensitive 

If you enable this option, sorting distinguishes between uppercase and lowercase letters. For example, all
words that begin with a lowercase letter end up in front of the words that begin with a capital letter:

Disabled: Apples, bananas, Cherries. Enabled: bananas, Apples, Cherries.

§ Sort including borders/shading 

If this option is enabled, cells moved by the sorting operation take their assigned border lines and shading
with them.

If disabled, the selected cell range keeps its original layout as far as borders and shading is regarded.
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§ Include hidden cells 

If the selected range contains cells that have been hidden (see Showing and hiding rows/columns), these are
normally not sorted. Enable this option if you want hidden cells to be included in the sort.

Filtering cells by their content
You can select a range of cells and filter this data based on a filtering condition. PlanMaker will hide all rows
that do not match the condition.

There are four commands for filtering data available on the ribbon tab Data | group Filter:

§ The command AutoFilter  offers you different options to filter rows: When you select a cell range and
choose this command, from now on, an arrow will appear on top of each column in this cell range. Clicking
on one of these arrows opens a menu where you can easily choose between the values contained in the
corresponding column – and other predefined filter conditions. 

§ The command Special filter  opens a dialog box where you can formulate one or more filter conditions.
After clicking OK, the filter activates and hides all rows in the selected cell range that do not match the
chosen filter conditions. 

§ The command Show all  makes all hidden rows visible again, rendering the effect of the Special filter as
well as the AutoFilter inactive.

§ The command Reapply filter  allows you to update also subsequently added values in the cell range of
an active AutoFilter (not possible for Special filter).

Tip: You will also find the commands on the ribbon tab Home | group Contents | Sort and filter.

The following pages provide detailed information on these commands.

AutoFilter

Use the command AutoFilter to filter the rows of a cell range:

When you select a cell range and choose the command Data | group Filter | AutoFilter, from now on, an arrow
will appear on top of each column in this cell range. Clicking on one of these arrows opens a menu where you
can easily choose between the values contained in the corresponding column – and other predefined filter
conditions.

Note 1: The AutoFilter can only be inserted once per worksheet; two separate filters cannot be inserted on
one worksheet. Otherwise, you cancel the previously applied filter by selecting the AutoFilter command
again. If you have created Tables in worksheets, they have their own AutoFilters - even on the same
worksheet.
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Note 2: Newly added or updated values are not automatically sorted by the previously set filter conditions.
To integrate changed data into existing AutoFilter, use the command Reapply filter.

Proceed as follows to apply the AutoFilter:

1. Select the desired range of cells. Important: The first row of this range must contain headings for the data
below.

2. Choose the command Data | group Filter | AutoFilter .

The AutoFilter function is now enabled. Note the downward arrows in the first row of every column in the
selected range.

Clicking on one of these arrows  will open a menu listing the contents of the current column, as well as some
other options. By default, all values in the list are selected, meaning that currently no filtering is taking place.

To filter the data in the cell range, use this menu as follows:

§ Sort ascending : Sorts the filter results of the applied AutoFilter range in ascending order. 

§ Sort descending: : Sorts the filter results of the applied AutoFilter range in descending order.

§ More filters (contextual): Text filters, Number filters and Date filters open a submenu with additional
filters (see below).

§ (All): This menu entry is a useful placeholder: It allows you to add/remove all values the column contains
with just one click.

A check mark is displayed to the left of this entry to indicate that currently all cell contents are contained in
the filter.

When you click on the entry (All) now, all cell contents are removed from the filter (and the check mark
disappears). When you click it again, all cell contents will be added to the filter again (and the check mark
reappears).

If not all cell contents are included in the filter, but at least one cell content, a gray area is displayed instead
of the check mark.

§ (Blank): If you have empty cell contents in your column, you can use this selection to show/hide all empty
rows.

§ List of the cell contents: The most important part: This part of the menu lists all cell contents that the
column contains. You can add/remove a value to the filter by clicking on it. A check mark is displayed to the
left of all entries that are currently contained in the filter.
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Note: For the last 3 described options (All), (Blank) and List of cell contents please always be aware: To
confirm your selection, you have to press OK.

Example

For example, to filter a cell range in a way that it shows only rows that contain the name "Smith" in a column
with the heading "Name", proceed as follows:

Select the cell range (including the column headers) and use the ribbon command Data | group Filter |
AutoFilter to activate the AutoFilter.

An arrow  now appears next to each column header. Click on the arrow for the column "Name" to open the
AutoFilter menu for this column.

First, click on the (All) entry in this menu in order to remove all cell contents from the filter. Then, choose the
menu entry "Smith" and press OK. You have now created a filter condition "Name equals Smith" using the
AutoFilter function. PlanMaker will hide all rows that do not match the condition.

Filter result after the name "Smith" has been selected in the list of cell contents at the bottom of the AutoFilter

If, in addition, you would also like to have all rows with the name "Miller" listed, simply choose the menu entry
"Miller" as well. To remove the Millers again, click on the "Miller" entry once more to deselect it. Press OK to
confirm in each case.

If necessary, apply additional filter conditions in the other columns as well (e.g., "Mrs" for all female matches
of a given name) to further narrow down the results.

As you can see, the entries in the AutoFilter menu can be combined in any possible way. Just click on an entry
to add it to the filter – or remove it.
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More filters: Text filters, Number filters, Date filters

Depending on the format category of the filtered columns, PlanMaker automatically sets more filter options for
Text filter, Number filter or Date filter in the AutoFilter menu. The Text filter is offered for text-only values and
the Date filter for date-only values. If the formats are mixed, the Number filter is applied.

Use the offered filter to obtain specialized filter conditions, for example:

Text filters:

§ Equals... Display only rows with exact matches. 

§ Does not equal... Rows with exact matches are hidden. 

§ Greater than... Display rows with values that are alphabetically behind the entered filter value.

§ Greater than or equal to... See above, but including the entered value.

§ Less than... Display rows with values that are alphabetically before the entered filter value.

§ Less than or equal to... See above, but including the entered value.

§ Starts with... Display only rows with specific word beginnings.

§ Doesn't start with... Rows with specific word beginnings are hidden.

§ Ends with... Display only rows with specific word endings.

§ Doesn't end with... Rows with specific word endings are hidden.

§ Contains... Display only rows that contain specific strings as part of the text.

§ Doesn't contain... Rows that contain specific strings as part of the text are hidden.

Number filters:

§ Greater than... Works like the operator > . Display rows with values that are greater than the filter value
entered.

§ Greater than or equal to... 
equal to the filter value entered.

§ Less than... Works like the operator < . Display rows with values that are smaller than the filter value
entered.

§ Less than or equal to... 
to the filter value entered.

§ Between... Display values of the rows which are defined in a number range.

§ Not between... Hide values of the rows which are defined in a number range.

§ Top 10... Display only rows where the value in this column is amongst e.g. the 10 highest (or lowest) values.
You can customize this selection when the Top 10... dialog box has opened: In the field on the left, choose
between Top or Bottom values. In the middle field, you can set the number of top/bottom values. In the right-
hand field, you can choose between absolute values (Items) and relative values (Percent).

An example:
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If you want to get 50% of the lowest values from 60 values given, then set the following:

Left field: Bottom          Middle field: 50         Right field: Percent

§ Only empty: Display only rows where the value in this column is empty.

§ Non-empty: Display only rows where the value in this column is not empty.

§ Above average: Display only rows where the value in this column is larger than the average value (of this
column).

§ Below average: Display only rows where the value in this column is smaller than the average value (of this
column).

Date filters:

§ Equals... Display only rows with exact date matches. 

§ Does not equal... Rows with exact date matches are hidden. 

§ Before... Display only rows in which the date values are earlier than the entered date value.

§ Before or equal... See above, but including the entered value.

§ After... Display only rows in which the date values are later than the entered date value.

§ After or equal... See above, but including the entered value.

§ Between... Display rows where the date values are within a defined date range.

§ Not between... Hide rows where the date values are within a defined date range.

§ Day, Week, Month, Quarter, Year: Here you can make further selections to quickly narrow down the
desired date ranges.

Note: If you have applied the AutoFilter to date values, you will notice in the dropdown list of the AutoFilter that the single days
have already been sorted at year and month level. Click on the plus sign in front of the year/month level to expand it and view the
associated single values. If you have now expanded the date "tree" and, for example, selected only single day values from a certain
date level, in front of the associated date level (month/year) a gray area appears instead of a check mark. Only if all available values
of a date level are selected, also a check mark for this level appears. If no value of a date level is selected, you will see a white area in
front of it. This allows you to see at a glance whether all, none or single values of a date level have been selected.

In addition, there are the following options for each of the offered filter methods Text filters, Number filters or
Date filters:

§ Custom filter: Open a dialog box where you can define individual filter conditions. 

§ Delete filter: This option is only available if criteria have been set via the Text filter, Number filter or Date
filter selection. Press Delete filter to remove only the criteria applied through these filters.

Making all filtered rows visible again

If you want all rows hidden by AutoFilter to become visible again, choose the ribbon command Data | group
filter | Show all.
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Reapply filter

If values in the cell range set by AutoFilter have changed, you can use the ribbon command Data | group Filter
| Reapply filter to update the selection you have already defined.

For example, you have specified that all rows with the name "Smith" should not be displayed and further entries
with this name were added afterwards. With the command Reapply filter you can filter out such subsequently
created entries again and you don't have to define the terms of the filter again from the beginning.

Of course, this function is especially helpful for dynamic formula and date values.

Deactivating the AutoFilter

To completely disable the AutoFilter function, choose the ribbon command Data | group Filter | AutoFilter
once again. The downward arrows displayed at the top of the cell range disappear, and all filtered rows will
become visible again.

Special filter

In addition to the AutoFilter introduced in the previous section, there are further options to filter the data in a
cell range by one or more combinable conditions much more complex: with the ribbon command Data | group
Filter | Special filter.

Proceed as follows:

1. Select the desired range of cells.

2. Choose the command Data | group Filter | Special filter .

3. In the following dialog box, define one or more filter conditions (see below).

4. Confirm with OK.

All rows that do match the filter conditions will now be hidden.

Setting up filter conditions

To specify one or more filter conditions in the dialog box of the command Special Filter, proceed as follows:
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In the section 1st condition, first select on the left the column to apply to the filter condition. In the middle,
select the arithmetic operator. On the right, enter the value to compare against.

Some examples:

§ The condition "Column D equals Los Angeles" only shows entries where column D contains the text "Los
Angeles". 

§ The condition "Column E greater than 100000" only shows entries where column E contains a value greater
than 100000.

If one condition is not sufficient for formulating your filters, you can set up to three filter conditions by filling
out the sections 2nd condition and 3rd condition as well.

Using "wildcard characters": In conditions, the characters * and ? can be used as "wildcards": * represents any
number of arbitrary characters, and ? represents a single arbitrary character. For example, "M*er" would call
out "Mister", "Miller", "Mary's mother", etc., whereas "?ouse" would call out "mouse", "house", "rouse", etc.

Options of the dialog box

The dialog box for the special filter offers the following options:

§ Range contains headings 

If the first row and/or column of the selected cell range contains headings, enable this option. PlanMaker
will ignore this line or column while filtering.



103Editing worksheets

§ Case sensitive 

If this option is enabled, PlanMaker will distinguish between uppercase and lowercase letters in conditions.
For a condition such as "COLUMN A equals Smith", the condition will match only if the cell contains the
text "Smith". "SMITH" and "smith" will not be included in the filtering results.

§ Mode 

Determines whether rows or columns will be filtered.

Selecting Filter row by row, all rows will be filtered out that do not satisfy the filter condition.

Selecting Filter column by column, all columns will be filtered out that do not satisfy the filter condition.

§ Results 

Determines whether the filter will be applied to the actual data or a copy of it:

Filter at current position – Select this option and the original data will be filtered. Rows/columns that do
not satisfy the filter condition will be hidden at exactly that point where you set the filter.

Copy to position – If you select this option instead, PlanMaker creates a copy of the original cells at a cell
address you specify. This copy contains only the filtered data and the original data remains unchanged in its
place.

In the latter case, enter the cell address of the destination cell in the input field. You can either specify a
single cell address (which will be the starting point of the output range) or a cell range where the copy of the
data shall be placed. Copying to other worksheets is also possible. Caution: If the copy of the data is larger
than the cell range entered, cells will be cut off (exception: you enter a single cell address as the starting
point).

Making all filtered rows visible again

If you want all rows hidden by filter to become visible again, choose the ribbon command Data | group Filter |
Show all.
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Analyzing sheets
PlanMaker provides several tools for analyzing cell contents and formulas in a table. These can be very useful
for detecting errors.

For this purpose, the following tools are available:

§ Displaying formulas instead of results 

If the ribbon command View | Show formulas is enabled, cells containing a calculation will display the
formula rather than the result.

§ Syntax highlighting 

If the ribbon command View | Syntax highlighting is enabled, cells will be colorized according to their
content. For example, cells containing an error are displayed in red; cells containing a formula are displayed
in green, etc.

§ Watch window for cell content 

With the ribbon command Formula | Show watch list you can display a watch window for cell contents at
any time. It allows you to observe the current values in the specified cells.

§ Formula auditing 

The commands of the ribbon tab Formula | group Traces provide tools for displaying the relationships
between cells graphically. For example, if the current cell contains a formula that refers to other cells, you
can let PlanMaker display arrows pointing to these cells.

Apart from that, you can find errors in your table easily or to mark all invalid data with red circles.

For more information on these functions, see the following pages.

Displaying formulas instead of results

If you enable Show formulas, cells containing a calculation will display the formula rather than the result. This
can be useful when analyzing the formulas in a table and for detecting errors.

Enabling and disabling "Show formulas"

To enable the "Show formulas" tool, choose the ribbon command View | Show formulas  (in the View
group).

If you click on this command again, the "Show formulas" tool will be disabled.
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Syntax highlighting

If Syntax highlighting is enabled, cells will be colorized according to their content. For example, cells
containing an error are displayed in red; cells containing a formula are displayed in green, etc.

This is useful for visualizing which cells contain formulas, fixed values, etc., and where errors occur.

Enabling and disabling syntax highlighting

To enable syntax highlighting, choose the ribbon command View | Syntax highlighting  (in the View
group).

If you click on this command again, it will be disabled.

What the foreground color indicates

When syntax highlighting is enabled, cell contents are displayed in the following foreground colors:

Cell content Foreground color

Error value Red

Formula Green

Fixed positive number Dark blue

Fixed negative number Light blue

Fixed logical value Brown

Fixed text string Black

What the background color indicates

Cells containing an error are displayed in red foreground color and shaded in one of the following background
colors: The background color indicates the error type:

Foreground color Error type

White Formula returns an error value. The calculation in this cell returns an error value (caused, for
example, by a division by zero).

Tip: If you click the cell, an error message is displayed in the status bar (see Error values). Correct
the formula accordingly. 

Cyan Syntax error in formula. The calculation in this cell has a syntax error (caused, for example, by a
missing parenthesis or missing arguments).
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Tip: If you click the cell, an error message is displayed in the status bar. Correct the formula
accordingly. If you don't correct the formula, it will be replaced by the text string #NULL! when the
document is saved!

Light gray Function not exportable. The calculation in this cell uses an arithmetic function that cannot be
saved in the currently chosen file format.

Tip: Replace the function by a function that is compatible with the chosen file format. For more
information, see the corresponding function description in this manual.

Magenta Function possibly imported erroneously. The calculation in this cell uses a PlanMaker 97
arithmetic function whose syntax or function might be incompatible with recent versions of
PlanMaker. This error only occurs for time functions when importing documents created with
PlanMaker 97.

Tip: See corresponding function description in this manual.

Yellow Function unknown. The calculation in this cell uses an arithmetic function unknown to PlanMaker.
This error might occur when importing documents created with other applications (e.g. Microsoft
Excel).

Tip: Replace the function with a corresponding PlanMaker function. For a list of all PlanMaker
functions, see Functions from A to Z.

Watch window for cell content

PlanMaker has an option to display a watch window for cell contents. It allows you to observe the current
values in the specified cells.

Activating and deactivating the watch window

To display the watch window, choose the command Show watch list  on the ribbon tab Formula | group
Watch.

If you choose this command again, the window will disappear.
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Adding cells to the watch window

To keep track of the value in a cell, add it to the watch window as follows:

1. In the watch window, click on the Add cell button.

2. Enter the address of the desired cell and confirm with OK.

Tip: You can also enter an entire cell range here. For example, if you enter A1:A3, the cells A1, A2 and A3
will be added.

The content of the specified cells is now displayed in the watch window. Whenever the table is recalculated, the
watch window will be updated as well.

Removing cells from the watch window

To remove a cell from the watch window, select it in the watch window and click on the Remove cell button.

To remove all cells at once, use the Remove all button.

Formula auditing

The command group Formula | Traces and the command group Review | Input validation provides tools for
displaying the relationships between cells graphically.

For example, if the current cell contains a formula that refers to other cells, you can let PlanMaker display
arrows pointing to these cells. Apart from that, you can find errors in your table easily or to mark all invalid
data with red circles.

The command group Formula | Traces contains functions for the following topics:

§ Displaying the relationships between cells 

Commands that display the relationships between cells graphically. For example, PlanMaker can display
arrows to all cells that the calculation in the current cell refers to. Thus, if a cell contains the formula
=A1*A2, arrows to the cells A1 and A2 will appear.

There are also commands that allow you to select all cells the calculation in the current cell refers to. Or,
vice versa, all cells that depend on the current cell.

§ Detecting errors in calculations 

Furthermore, you can jump to the previous or next cell that contains an error value, and display arrows to the
sources of the error.
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You can use the command group Review | Input validation to use the following functions:

§ Detecting invalid data in cells 

Here you can find all cells whose content violates the input validation settings for the cell.

The following pages provide detailed information on these topics.

Displaying the relationships between cells

The command group Formula | Traces provides, amongst others, commands that can be used to display the
relationships between cells graphically.

To do this, select the cell you want to analyze and then choose one of the following commands from the
command group Formula | Traces:

Note: The commands Trace to error, Previous error, Next error are described later, see Detecting errors in calculations.

§  Trace predecessors 

This command displays an arrow to each cell that the calculation in the current cell refers to.

Example: If the current cell contains the formula =A1*A2, this command will display arrows pointing to the
cells A1 and A2.
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§  Trace predecessors  | Select predecessors 

This command selects all cells that the calculation in the current cell refers to.

Example: If the current cell contains the formula =A1*A2, this command will select the cells A1 and A2.

§  Remove all traces  | Remove traces to predecessors 

Hides all arrows that were added with the command Trace predecessors for the current cell.

§  Trace successors 

Displays an arrow to each cell that refers to the current cell.

Example: If a cell contains the formula =B5*2, this command will display an arrow pointing to this cell
when you choose the command in cell B5.

§  Trace successors  | Select successors 

Selects all cells that refer to the current cell.

Example: If any cell contains e.g. the formula =B5*2, this cell will be selected when you choose the
command in cell B5.

§  Remove all traces  | Remove traces to successors 

Hides all arrows that were added with the command Trace successors for the current cell.

§  Remove all traces 

Removes all arrows added with the commands Trace predecessors or Trace successors for the entire
workbook.

Click directly on the icon itself or use the icon's arrow and choose Remove all tracesin the dropdown menu.

Notes and tips

§ If desired, you can choose the commands Trace predecessors and Trace successors multiple times in a
cell. Another level of relationships will be displayed every time you do that. 

§ The tracer arrows displayed by the above commands are clickable. When you click such an arrow,
PlanMaker jumps to the cell at the other end of the arrow.

§ If the current cell is referring to a cell located on a different worksheet, just a small arrow will be displayed
in the top left corner of the cell. Again, you can click this arrow to jump to the related cell.

§ All tracer arrows pointing to a cell will be removed when you edit, move or delete the cell.

§ Tracer arrows also appear in the printout.

§ However, the arrows are not stored in the document. Thus, when you save a document, close it and open it
again, all arrows are removed. 
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Detecting errors in calculations

The command group Formula | Traces provides, amongst others, commands to find and analyze cells that
return an error value.

Note: A cell returns an error value when the calculation it performs gives an illegal result. For example, if a
cell tries to perform a division by zero, the error value #DIV/0 will be displayed in the cell. (For more
information on error values, see Error values.)

To find and analyze such errors, use the following commands in the command group Formula | Traces:

Note: The commands Trace predecessors, Trace successors and Remove all traces are described in the previous section, see
Displaying the relationships between cells.

§  Trace to error 

If the current cell contains an error value, this command will display arrows to the cells that cause the error
(if applicable).

Example: If a cell returns a #DIV/0 error value and you choose this command in this cell, arrows to the cells
that perform the division by zero will appear.

§  Previous error 

Jumps to the previous cell that contains an error value.

§  Next error 

Jumps to the next cell that contains an error value.

Detecting invalid data in cells

The command group Review | Input validation provides, amongst others, commands that can be used to detect
cells that contain invalid data.

Note: A cell contains invalid data if the command Input validation  has been used to specify which values
should be allowed in the cell, and the current cell content violates any of these rules. For more information, see
Input validation.

To find such errors, use the following commands in the command group Review | Input validation:
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§  Mark invalid data 

This command paints a red circle around each cell (on the current worksheet) that contains an invalid value.

§  Remove (invalid data) marks 

Removes all red circles (from the current worksheet) added with the above command.

§  Previous invalid cell 

Jumps to the previous cell that contains an invalid value.

§  Next invalid cell 

Jumps to the next cell that contains an invalid value.

Notes

§ The marks for invalid data also appear in the printout. 

§ However, the marks are not stored in the document. Thus, when you save a document, close it and open it
again, all circles are removed. 

Updating sheets
The calculations in a document are kept up-to-date automatically. Whenever you change the content of a cell,
PlanMaker recalculates the entire workbook.

So usually you don't have to care about this.

Deactivating automatic updating

As needed, you can disable the automatic updating of calculations. This can be useful when, for example, you
want to edit a complex workbook on a slow device.

For this purpose, change the setting of the Recalculation option in the document properties accordingly. See
Document properties, Calculate tab.

When automatic updating is disabled, the calculations in the table have to be updated manually. You can use
the following shortcut keys or ribbon commands for this:

§ To update the calculations on all worksheets, press the F9 key or choose the ribbon command Formula |
group Update | Update data | Update calculations. 
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§ To update the calculations only on the current worksheet, press the key combination Shift+F9.

Note: The latter can return outdated results in case the current worksheet contains calculations that refer
to cells on other worksheets.

Updating external cell references

Please note that external cell references are not updated when a workbook is recalculated.

(External cell references are cell references that refer to cells located in a different workbook – for example
='C:\My Folder\[My Workbook.pmdx]Sheet1'!A1.)

Such cell references are updated automatically only once, when you open the document that contains them.
Apart from that, you can update them manually whenever needed.

For more information on working with external references, see External cell references.
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Using comments
With the command group Comments on the ribbon tab Review you can add a comment to the current cell – for
example: "Here you still have to enter the data from the previous year!"

Follow these steps to work with comments:

Adding comments to cells

1. Click on the desired cell to which you want to add a comment.

2. Then choose the ribbon command Review | group Comments | Add .(Alternatively: Insert | Comment,
or even faster with the key combination Shift+F2).

Note: Comments appear with your name if you have specified it in the "Name" field for the User info (see
Settings, General tab). If nothing is entered here, PlanMaker will now ask you for the current document
once.

Tip: You can edit the displayed name in the comment window just like any other content in this window.

3. A yellow box will appear allowing you to type in the applicable comment. When done typing, click outside
the yellow box or press the Esc key.

Comments are stored in the document and will be saved with the worksheet data.

Viewing comments

Cells with an attached comment have a red triangle  in their top-right corner. When you point with the
mouse to such a cell, the comment will be displayed. To make it disappear, move the mouse outside the cell.

Editing comments

To change a comment, select the cell that contains the comment.

Then choose the ribbon command Review | group Comments | Edit  and make the desired changes in the
yellow comment window.

Tip: Alternatively, double-click the red triangle in the cell or press the key combination Shift+F2 to edit a
comment.

When you are finished with the changes, click anywhere outside the comment or press Esc.
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Deleting comments

To remove comments from cells, select the relevant cells (you can also select several cells at the same time).

Then choose the ribbon command Review | group Comments | Delete . The comments are then deleted.

Alternatively, you can also use the command Home | group Contents | Delete  | Comments.

Find comments

The command group Review | Comments contains two commands that you can use to jump back and forth
between all comments in the document:

§ Previous comment  jumps to the previous comment 

§ Next comment  jumps to the next comment

Adjust comment window visually

§ Resize: To resize the comment window, use the round "handles" on the frame of the comment box. When
you drag one of these handles with the mouse, the size of the object is changed accordingly. 

§ Change position: To move the comment window, click with the mouse on the frame of the comment window
and drag it to the desired position while holding down the mouse button.

Tip: The comment window can be customized like any other object with different colors, shades, etc. If you
click on the frame of the comment window, it can be edited similar to a text frame by using the contextual
ribbon tab Object or the Object properties dialog box (see section Text frames).

Comment visibility

Usually you will only see the comment window when you point to the relevant cell.

Therefore, use the Comment visibility  button on the ribbon tab Review | group Comments if you want to
display comments permanently.

Note: The comment visibility has no influence on the appearance of comments in the printout. This option
can be found in the dialog box of the command File | group Print | Page setup on the Options tab. See
Setting page format options

The following commands are available in the dropdown menu of the button Comment visibility:

§ Displays all comments 

If you have added comments to several cells, all comment windows will be displayed (as well as on other
worksheets in the document). If you click on the command again, they are hidden again.

§ Show this comment 

Only the comment of the selected cell is shown or hidden.

The Comment visibility button also has the following command:
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§ Restore all comment positions 

If the position of one or more comment windows has been moved (by moving them with the mouse or by
rearranging the cells), you can use this command to reset the comment windows to their original position. To
do this, select the cells whose comment windows you want to move back to their original position.

Goal seek

The ribbon command Data | group Analyze | Goal seek  can help you to determine what value a certain
component of a calculation must meet to extract a predefined result from the calculation.

Note: This is done by mathematical approximation, and as with all approximation methods, the result cannot
be guaranteed completely accurate.

Before executing this command, navigate to the cell that contains the calculation.

Upon executing the command, a dialog box appears. This is operated as follows:

§ In Formula cell, enter the address of the cell that contains the formula. (Generally this is preset by
PlanMaker.) 

§ In Target value, enter the desired result of the calculation.

§ In Variable cell, enter the cell address of the cell in which PlanMaker will test different values until the
formula cell returns the desired result.

§ In Accuracy, you can specify how close the result must match the desired target value. PlanMaker will
attempt to approximate values until the difference to the target value is smaller than Accuracy. 

If PlanMaker is unable to find a sufficiently close result after some seconds, it will determine that the value
cannot be calculated through approximation and will abort the search.
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An example

In the worksheet shown below, the SUM function has been used in cell A5 to add the numbers 1, 2 and 3 in the
cells A2, A3 and A4. The result in cell A5 is 6. The intent is to determine to which value cell A3 must be
changed so that the result of the addition is 7.

For this purpose, move the cell frame to the cell with the calculation whose result is to be modified – in this
case, cell A5 with the SUM formula – and apply the goal seek.

Notice in the figure how to fill in the values in the dialog box. When you click OK, PlanMaker starts the
approximation process and displays the result 3 in a dialog box.

This means that the content of cell A3 must be changed from 2 to 3 so that the calculation has the result 7. If
you click the Use button, the found result will be copied into cell A3.
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Scenarios

iOS: The command is not freely available in this version.

The ribbon command Data | group Analyze | Scenario manager allows you to create and display "scenarios".

Scenarios can be used to observe how the calculations in a worksheet change when the values in specific cells
are altered. This enables you to perform all kinds of "what-if" analysis.

Example: What effect on the total costs of a loan will it have when the duration is varied between 24, 36 and 96
months?

In this section you will learn everything you need to know about scenarios. The following topics are covered:

§ Creating scenarios 

§ Showing scenarios

§ Managing scenarios

§ Merging scenarios

§ Creating a scenario summary

See the following pages for more information.

Creating scenarios

To create scenarios, first create a worksheet with the calculations that you want to analyze.

Then proceed as follows:

1. Choose the ribbon command Data | group Analyze | Scenario manager .

2. Click Add in the opened dialog box.

3. Under Scenario name, enter a name that describes the purpose of the scenario.

4. Under Changing cells, enter the address of the cell whose content is to be altered in the scenario.

You can also specify multiple cells. Separate the cell addresses with a comma – for example: A2,A4,A10.
Cell ranges (like B5:B10) are allowed as well.

5. Click the Next button to continue.

6. Another dialog box appears. There, enter the value that is to be inserted into the "changing cell" in this
scenario.

If multiple changing cells are defined in the scenario, the dialog box displays a list of these cells. Click on
each list entry and enter the desired value for it.
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7. Click the Finish button to finalize this scenario.

8. Repeat the steps 2. through 7. for all further scenarios that you want to add.

9. When done, close the dialog box with the Close button.

The scenarios have now been created. To learn how to display them, see the next section.

Options of the dialog box

In the dialog box for adding scenarios, the following additional options are available:

§ Comment 

Allows you to enter a comment for the scenario.

§ Prevent changes 

When this option is enabled, the scenario can no longer be modified or deleted when you activate worksheet
protection.

§ Hide 

When this option is enabled, the scenario is no longer displayed in the list of scenarios when you activate
worksheet protection.

Tip: For general information on working with worksheet protection, see Sheet protection.

Showing scenarios

When you have created scenarios, as described in the previous section, you can display them at any time:

To do so, proceed as follows:

1. Choose the ribbon command Data | group Analyze | Scenario manager .

2. In the dialog box, select the scenario to be displayed from the list Scenarios.

3. Click on the Show button.

Tip: You can do so even quicker if you simply double-click on the scenario in the list.

The chosen scenario will now be displayed.

By switching between the different scenarios that you have created, you can watch how the changes to the cells
specified in the scenario affect the calculations referring to those cells.

Note: When you display a scenario, the values in the given "changing cells" are physically replaced by the
values specified in the scenario. The old cell contents will be lost.
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Managing scenarios

The command Data | group Analyze | Scenario manager  can also be used to manage the scenarios defined
in the current worksheet.

For that purpose, the following buttons are available in the dialog box for this command:

§ Add 

Adds a new scenario.

For more information, see Creating scenarios.

§ Delete 

Deletes the scenario selected in the list.

§ Edit 

Opens a dialog box where you can edit the selected scenario. When you click on Next, another dialog box
appears where you can edit the values for the changing cells.

§ Merge 

Merges scenarios that have been defined on other worksheets (or workbooks) into the current worksheet.

For more information, see Merging scenarios.

§ Summary 

Creates a scenario summary for all scenarios, where you can directly compare the values in the changing
cells as well as any "result cells" you define.

For more information, see Creating a scenario summary.

Merging scenarios

The command Data | group Analyze | Scenario manager can also be used to merge scenarios that have been
defined on other worksheets (or even other workbooks) into the current worksheet.

Note: When using this function, make sure that all workbooks whose scenarios are to be merged have
exactly the same layout and use the same changing cells in their scenarios.

To merge scenarios, proceed as follows:

1. Open the workbooks that contain the scenarios to be merged.

2. Switch to the workbook and worksheet into which you want to merge the scenarios.



120Editing worksheets

3. Choose the ribbon command Data | group Analyze | Scenario manager .

4. Click Merge in the dialog box.

5. Select the workbook and worksheet that contains the scenario(s) to be merged.

6. Confirm with OK.

7. Repeat the steps 4. through 6. for all further scenarios that you want to merge.

The selected scenarios are now available in the current worksheet.

Creating a scenario summary

The command Data | group Analyze | Scenario manager can also be used to create a scenario summary for all
scenarios defined in the current worksheet.

A scenario summary is a table listing all scenarios well arranged side by side. For each scenario, the "changing
cells" are displayed alongside with any "result cells" that you specify (containing the calculations to be
observed).

Scenario summaries allow you to compare the changing values and the results of scenarios at a glance.

To create a scenario summary, proceed as follows.

1. Create the desired scenarios (as described in the section Creating scenarios).

2. Choose the ribbon command Data | group Analyze | Scenario manager .

3. Click on Summary.

4. Enter the address of the desired result cell. That is the cell that contains the calculation that you want to
observe in your scenarios.

You can also specify multiple cells. Separate the cell addresses with a comma – for example: A2,A4,A10.
Cell ranges (like B5:B10) are allowed as well.

5. Confirm with OK.

PlanMaker will now create a new worksheet and generate the scenario summary on it.

Note: Scenario summaries are not updated automatically when cell contents or scenario settings are changed.
To update a scenario summary manually, delete the worksheet containing the summary and create the
summary once again.
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Consolidating data

iOS: The command is not freely available in this version.

You can use the ribbon command Data | group Analyze | Data consolidation  to evaluate data from one or
more cell ranges, for example, in order to calculate their total sums.

To do so, first you specify one or more "source ranges" for the consolidation. This can be any cell ranges
containing the data to evaluate. They can be located in just one worksheets altogether or be spread over
multiple worksheets or even multiple files. For the evaluation, several statistical functions are available to
choose from: sum, minimum, average, etc.

The results of the consolidation are inserted – as fixed values – into the "target range" (which can be any cell
range). Note: The results will not be updated when you modify the values in any of the source ranges. This
command's main purpose is to evaluate the current state of data, not regarding any changes made to them later
(useful e.g. for monthly reports).

In this section, you will learn everything you need to know about working with consolidations. The following
topics are covered:

§ Consolidating data by position 

In the simplest case, data is consolidated by its position. This works as follows:

You have entered the data into e.g. three source ranges, which should be identical in size and structure. In all
three of them, each piece of data should have the same (relative) position.

When you let PlanMaker consolidate these cell ranges, it begins with calculating the sum of the first cell
(top left) in the first range, second range and third range. The result appears as the first cell in the target
range. Then, the same is done with all other cells in each of the cell ranges.
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§ Consolidating data by labels 

Alternatively, this command can consolidate data by its labels. This works as follows:

You have entered the data into one or more source ranges, all of them have one thing in common: a label has
been added to each value – for example in the cell left of the value.

When you start a consolidation with such source ranges and enable the option Labels in left column,
PlanMaker calculates the sum of all values that have the same label on their left.

It doesn't matter in which order and how often each label appears within the source ranges. The size of the
source ranges is irrelevant as well. PlanMaker solely uses the labels to determine which values to sum up.

§ Editing and updating consolidations 

Whenever you perform a consolidation using the ribbon command Data | group Analyze | Data
consolidation, PlanMaker remembers each setting that you made in the "Consolidate" dialog (separately for
each worksheet).

This allows you to use this command again anytime, change some settings if required, and run the
consolidation again.

For more information on these topics in the above order, see the following pages.

Consolidating data by position

As mentioned in the introduction of the section Consolidating data, the command Data consolidation allows
you to consolidate data from one or more cell ranges, for example, in order to calculate their total sums.

In the simplest case, data is consolidated by its position. This works as follows:

You have entered the data into e.g. three "source ranges". They should be identical in size and structure. In all
three of them, each piece of data should have the same (relative) position.

When you let PlanMaker consolidate these cell ranges, it begins with calculating the sum of the first cell (top
left) in the first range, second range and third range. The result appears as the first cell in the "target range".
Then, the same is done with all other cells in each of the cell ranges.

Example

The daily revenues of two fruit shops are to be consolidated by means of a sum function, divided according to
fruit varieties.
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For this purpose, the revenues of the two shops were entered into a table. In the figure, this data is shown in the
cell areas C3:C5 and C8:C10.

Then the command Data consolidation was executed and these two areas were added as source ranges. The
target range was set to C13:C15 (selected in the figure) and consolidation was started.

Result: In the target range, the sums of the daily revenues appear (again per fruit variety, just as in the source
ranges).

Performing a consolidation by position

To consolidate data by position, proceed as follows:

1. Enter the data to evaluate into one or more cell ranges of exactly the same size and structure. The order of
the individual pieces of data must be identical in each range.

The cell ranges can be located in just one worksheet altogether or be spread over multiple worksheets or
even multiple files.

2. Choose the ribbon command Data | group Analyze | Data consolidation .

3. Click into the edit field below Source ranges. There, enter the address of the first cell range containing the
data to evaluate. (See also notes below.)

Tip: Alternatively, with the dialog box still open, simply click into the table and select the cell range with
your mouse.

4. Click on the Add button.

5. To add additional source ranges, repeat the steps 3. through 4.

6. At Target range, enter the address of the cell range where you want the results of the consolidation to be
inserted.

Tip: It is sufficient to specify just the address of the cell in the top left corner of the target range. PlanMaker
will then determine its size automatically.
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Tip: You can simply click on the desired cell in the table to transfer its address into the dialog box.

7. At Function, choose the arithmetic function to be used for the consolidation.

8. The options Labels in ... must be disabled for this kind of consolidation. (For more information, see
Consolidating data by labels.)

9. Click on Apply to start the consolidation.

The data from the source ranges is now consolidated using the chosen arithmetic function. The result is inserted
in the target range.

Note: The result of a consolidation is inserted into the table as fixed numbers. These numbers will not be
updated when you modify the values in any of the source ranges.

Accordingly, this command's main purpose is to evaluate the current state of data, not regarding any changes
made to them later (useful e.g. for monthly reports). See also Editing and updating consolidations.

Notes on specifying the source ranges

In the dialog box described above, the Source ranges control can be used to add a source range in the following
ways:

§ Source range from the current worksheet 

To add a cell range that is located in the current worksheet to the source ranges, simply enter its address or
name.

Example: D2:G5

Tip: Alternatively, with the dialog box still open, you can click into the table and select the cell range with
your mouse.

§ Source range from a different worksheet 

To add a cell range that is located in a different worksheet, enter its address preceded with the other
worksheet's name and an exclamation mark.

Example: Table3!D2:G5

Tip: You can also select the cell range directly in the table with your mouse. Make sure that you have
clicked on the desired worksheet in the worksheet register first.

§ Source range from a different document 

To add a cell range that is located in a different document, enter its address the same way that external
references are entered (see External cell references).

Example: 'C:\My Folder\[My Workbook.pmdx]Sheet3'!D2:G5

Tip: You don't have to enter the first part of the address (folder and file name) manually. When you click on
the Browse button in the dialog box, a file dialog appears, allowing you to choose the desired file.

Don't forget to click on the Add button every time you have completed entering the address of a source range.
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Consolidating data by labels

As mentioned in the introduction of the section Consolidating data, the Data consolidation command allows
you to consolidate data from one or more cell ranges, for example, in order to calculate their total sums.

Apart from consolidating data by position (see previous section), data can also be consolidated by its labels.
This works as follows:

The data to be evaluated can be stored in any number of "source ranges" – all of them have one thing in
common: a label has been added to each value (for example, into the cell left of the value).

When you start a consolidation with such source ranges and enable the option Labels in left column,
PlanMaker calculates the sum of all values that have the same label on their left.

It doesn't matter in which order and how often each label appears within the source ranges. The size of the
individual source ranges and the order of the data within them is irrelevant. PlanMaker solely uses the labels to
determine which values to sum up.

Example

A fruit shop offers different fruit varieties. Each individual sale during the course of a day is recorded in a table.
Now it should be calculated how much of each fruit variety was sold in total.

The individual fruit varieties appear in a completely random order, of course, but this does not interfere the
consolidate command at all:

Simply choose the Data consolidation command. Add the cell range with the individual sales as source range
(here B3:C11) Note: This must contain the numbers and their labels! Then select any target range for the result
(in Figure B14:C16) and confirm.
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Result: In the target range, the totals of the sales of the individual fruit varieties appear.

Performing a consolidation by labels

To consolidate data by its labels, proceed as follows:

1. Enter the data into one or more cell ranges. Size and structure of these cell ranges don't matter. However,
each of the values to be consolidated should have a label – either in the column left of them or in the row on
top of them.

The cell ranges can be located in just one worksheet altogether, or be spread over multiple worksheets or
even multiple files.

2. Choose the ribbon command Data | group Analyze | Data consolidation .

3. Click into the edit field below Source ranges. There, enter the address of the first cell range containing the
data to evaluate. (See also notes at the end of the previous section.)

Tip: Alternatively, with the dialog box still open, simply click into the table and select the cell range with
your mouse.

Important: Each source range must contain both the values themselves and their labels. The labels must
be placed in the leftmost column or in the top row.

4. Click on the Add button.

5. To add additional source ranges, repeat the steps 3. through 4.

6. At Target range, enter the address of the cell range where you want the results of the consolidation to be
inserted.

Tip: It is sufficient to specify just the address of the cell in the top left corner of the target range. PlanMaker
will then determine its size automatically.

Tip: You can simply click on the desired cell in the table to transfer its address into the dialog box.

7. At Function, choose the arithmetic function to be used for the consolidation.

8. Under Options, specify the position of the labels in the source ranges:

Labels in left column: The labels are stored in the leftmost column of each source range. (In that case, the
corresponding values must be stored directly at the right of the labels.)

Labels in top row: The labels are stored in the top row of each source range. (In that case, the
corresponding values must be stored directly below the labels.)

You can also check both options, in case you want to evaluate source ranges that have labels in their
leftmost column and in their top row.

When you enable the Sort labels option, the results of the consolidation in the target range will be sorted
according to the labels.

9. Click on Apply to start the consolidation.

The data from the source ranges is now consolidated using the chosen arithmetic function. The result is inserted
in the target range.
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Note: The result of a consolidation is inserted into the table as fixed numbers. These numbers will not be
updated when you modify the values in any of the source ranges.

Accordingly, this command's main purpose is to evaluate the current state of data, not regarding any changes
made to them later (useful e.g. for monthly reports). See also Editing and updating consolidations.

Editing and updating consolidations

Whenever you perform a consolidation using the command Data consolidation, PlanMaker remembers each
setting that you made in the "Consolidate" dialog (separately for each worksheet).

This allows you to use this command again anytime, change some settings if required, and run the consolidation
again.

Tip: The settings are even saved in the document, so PlanMaker will remember them the next time you open
the document. (Little restriction: The target range is not saved in xls files, since this file format does not
support it. But it works for xlsx files, pmd files and pmdx files.)

Changing the settings of a consolidation and executing it again

To change the settings of a consolidation and then insert its updated results again, proceed as follows:

1. Choose the ribbon command Data | group Analyze | Data consolidation .

2. Change the settings of the consolidation at will. You can even add new source ranges or remove existing
ones.

3. Click on Apply to confirm your changes and update the results.

The consolidation in the current worksheet is now performed again, and its updated results are inserted into the
target range. Existing data will be overwritten.

Updating the results of a consolidation

If you just want to update the results of a consolidation (without changing any settings), proceed as follows:

1. Choose the ribbon command Data | group Analyze | Data consolidation .

2. Click on Apply to confirm your changes and update the results.

The consolidation in the current worksheet is now performed again, with the same settings as before.
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Tables in worksheets

The ribbon command Insert | Table  allows you to create "tables" in a worksheet.

Note: The fact that this feature is named "table" may be a bit confusing, since the term "table" is often used
to represent the content of a worksheet in general. However, since Microsoft has called this feature a "table"
in Excel, we decided to keep this term in PlanMaker for compatibility reasons.

So, how exactly does this feature work?

When you select a cell range and choose the ribbon command Insert | Table, PlanMaker will create a "table"
from it.

This has the following effects on the cell range:

§ Automatic formatting with a "table style" 

The selected cell range is reformatted automatically with a so-called table style. The default table style
changes the background color of the table's rows to blue/white color. However, you can also use a different
template or change the template later and thus change the formatting of the entire "table" at the touch of a
button.

§ AutoFilter applied automatically 

Apart from that, an AutoFilter is applied to the cell range that was used to create the "table". The AutoFilter
adds little arrows to the right of each of the column headings in the table. When you click on one of these
arrows, a menu opens, allowing you to set a filter on the cell contents of the corresponding column.

§ Total row 

In "tables", you can easily activate a total row displayed below the table. The total row can display
calculations summing up the values contained in the table (e.g. the sum of each column).

§ Special cell references 

When you have created a "table" in a worksheet, you can make use of special types of cell references. For
example, the cells in a certain table column can be addressed via its column heading – as in:

=SUM(Table3[Spring])
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The following pages contain everything you need to know about the "table" feature. Topics covered:

§ Creating tables in worksheets 

§ Ribbon tab "Table" 

§ Removing tables from worksheets

§ Editing tables in worksheets

§ Formatting tables in worksheets

§ Using the total row of tables in worksheets

§ Tables in worksheets and cell references

Creating tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to have "Tables in worksheets". Below you will learn how to create such a table.

To create a "Table in a worksheet", proceed as follows:

1. Optional: In a range of adjacent cells, enter the data that you want to create a table from.

Tip: It is recommended to add column headings for each column in the first row of that cell range. (If
there are no column headings, PlanMaker will generate automatic headings named Column1, Column2,
etc.)

2. Select the cell range (including the column headings).

3. Choose the ribbon command Insert | Table  (click directly on the icon itself).

Tip: If you click on the icon's arrow rather than directly on the icon itself, a list of predefined templates will
open, which can be applied directly.

4. The program displays a dialog box with the following options:

Source range: The cell range that the table is created from. The currently selected cells are suggested by
default. So, unless you want to specify a different cell range, all you have to do is confirm this.

Source range contains titles: Here you can specify if the first row in the source range contains column
headings, as recommended above. When you disable this option, PlanMaker will generate automatic column
headings named Column1, Column2, etc.

As soon as you confirm your selection in the dialog box, a "table" is created for the source area. In detail, the
following actions are performed:

§ No changes are made to the table cells and their contents 

Nothing special happens to the cells inside the source range. They remain ordinary table cells after creating
the table – you can edit them, format them, etc. just like before.
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§ Automatic formatting with a "table style" 

However, it is immediately noticeable that the cells in the source range have been automatically reformatted:
By default, the first row (containing the column headings) is shaded in a medium blue, the rows below are
shaded alternately in light blue and white (unless you have selected a different template, see tip from step
3.).

A so-called table style is responsible for this. Whenever you create a table, it is automatically reformatted
with the default table style. Alternatively, numerous other table templates with different colors and styles are
available. On the contextual ribbon tab Table, you can switch to another style at any time using the
commands Table style or Properties.

§ AutoFilter applied automatically 

To the right of each column heading in the first table row is a small arrow . These arrows indicate the
presence of an AutoFilter that has been added to the table cells automatically.

By default, the filter is disabled and all data in the table is shown. When you click on one of the little
arrows, the menu of the AutoFilter for the current column opens. In this menu, you can apply different kinds
of filters – and even sort the table data.

For more information on AutoFilters, see AutoFilter.

Ribbon tab "Table"

As soon as you have created a "table in worksheets" using the ribbon command Insert | Table you can switch
to the contextual ribbon tab Table for editing.

This ribbon tab always appears automatically when you place the cursor in the created table.

The contextual ribbon tab "Table"

The ribbon tab has the following buttons, from left to right:

§ Range: Here, you can change the cell range that the table includes. See Editing tables in worksheets 

§ Properties: This command opens a dialog box, where you can format inserted tables and change other
properties of the table. See Formatting tables in worksheets

§ Summarize as a pivot table: Create a pivot table directly from your table data. See Pivot tables

§ Convert to range: Convert the table back to a "normal" cell range. See Removing tables from worksheets

§ Delete table: Delete the table and all its contents completely. See Removing tables from worksheets

§ Select rows, columns, table: Select complete rows, columns or all cells of an inserted table. See Editing tables
in worksheets
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§ Insert above, below, left, right Insert a new row or column inside a table (and only inside this table). See
Editing tables in worksheets

§ Delete rows, columns: Delete rows or columns inside a table (and only inside this table). See Editing tables in
worksheets

§ Table styles (and all other commands in the "Style" group): Apply formatting options to inserted tables. See
Formatting tables in worksheets

On the following pages you will find detailed descriptions of the commands of the ribbon tab Table.

Removing tables from worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to create "Tables in Worksheets". Below you will learn how to remove such a table.

There are two options for this:

A) Converting a table back to a normal cell range

To convert a table back to an "ordinary" cell range, move the cell frame to any cell within the table.

Then choose the command Convert to range  on the contextual ribbon tab Table | group Table.
(Alternatively via the context menu by right-clicking in the table)

In the following dialog box, click on the checkbox Remove all formatting from the cells.

This will remove the "magic" of the table features from all cells that were part of the table – including the
automatic formatting and the AutoFilter.

B) Deleting a table with its entire content

To completely delete a table including all its contents, move the cell frame to any cell within the table.

Then choose the command Delete table  on the contextual ribbon tab Table | group Table. (Alternatively
via the context menu by right-clicking in the table)

This will delete the entire table, including the content of all cells that were part of it.

Editing tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to create "Tables in Worksheets". Below you will learn how to edit such a table.

The following procedures can be performed:
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Adding another row or column

"Tables in worksheets" can easily be extended by another row or column, as follows:

§ When you enter a value into a cell that is located directly to the right of a table, the table is extended by
another column automatically. 

§ When you enter a value into a cell that is located directly below a table, the table is extended by another row
automatically.

(Note: This only works when the Total row for the table is disabled.)

Tip: The above two methods for expanding tables can be disabled in case they are not wanted. To do so,
disable the option Expand tables automatically in the dialog box of the ribbon command File | Options

, on the Edit tab.

§ When you press the Tab key in the last cell of a table (i.e. the cell at its bottom right), another row is added
to the table automatically. This works here even if the "Total row" is enabled, it is automatically moved by
one row. 

Changing the size of a table

The size of a table can be changed in either of the following ways:

§ A little arrow is displayed in the bottom right corner of tables. When you drag this arrow around with your
mouse, the table is resized accordingly. 

§ When you choose the command Range  on the contextual ribbon tab Table, a dialog box opens, allowing
you to edit the cell range covered by the table.

§ You can also use the context menu by right-clicking in the table and selecting the entry Modify table area
to edit the cell range.

Inserting rows or columns

To insert a new row in a table (and only this table), proceed as follows:

1. Move the cell frame to a cell within the table.

2. Then choose Insert above  or Insert below  on the contextual ribbon tab Table | group Edit.

Alternatively: Right-click in the table to open the context menu, here via Insert.

This will add a new row above – or below – the current table cell.

Note: The new row will be added only inside the table – the cells outside the table are not affected.

Inserting new columns works accordingly with the commands Insert left  or Insert right .
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Deleting rows or columns

To delete a row inside (and only inside) a table, proceed as follows:

1. Move the cell frame to any cell within the table row to be deleted.

2. On the contextual ribbon tab Table, choose the command Delete rows .

Alternatively: Right-click in the table to open the context menu, here via Delete.

This will delete the row (including its content) from the table.

Note: The row will be deleted only inside the table – the cells outside the table are not affected.

Deleting columns works accordingly with the command Delete columns .

Selecting cells in a table

Cells in a table can be selected like all other cells, using either keyboard or mouse.

Apart from that, additional helpers for selecting inside tables are provided on the contextual ribbon tab Table |
group Selection. The following commands are available here:

§  Select rows: Selects the current table row. 

§  Select columns: Selects the current table column.

§  Select table: Selects the entire table.

There is another command which is not available on the ribbon by default, but you can easily access it by right-
clicking on the table via the context menu:

§ Select  Select column data: Selects only those cells in the current column that contain data. Column
headings or cells in the total row will not be included in the selection. 

Alternatively, you can also find the command in the classic menu interface at: Worksheet > Table > Select
> Select column data

Tip: You can add this command as a separate button to a ribbon tab (ideally to the ribbon tab "Table"). To do so, use the ribbon
command File | Customize | Customize ribbon to open the dialog box for customizing the user interface and search there for the
"Select data" command. Then proceed as described in Customizing icons and groups in the ribbon.

Formatting tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to create "Tables in Worksheets". Below you will learn how to change the formatting and other properties
of such a table.

First of all, the cells in a table can be formatted just like any other cell, using the entire palette of commands
and options that PlanMaker provides for this.
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In addition, there is the ribbon command Table | Properties especially for tables. This provides formatting
options that are only applicable to tables.

You can use this command as follows:

1. Move the cell frame to any cell within the table that you want to format.

2. Choose the command Properties  on the contextual ribbon tab Table.

Alternatively: Right-click on the table to open the context menu and select the entry Table settings

3. A dialog box with the options described below opens. Make the desired changes and confirm with OK.

The following settings can be made in this dialog box:

Applying a different table style

Tip: You can also apply this option directly via the Table styles  icon on the ribbon tab Table | group
Style.

The first tab of the dialog box contains the Style listbox. Here, you can choose a table style for the table.

Applying a different table style changes the entire appearance of a table. Primarily, table styles modify the
background colors of the table's rows and columns. The little preview images shown in the list give you an
impression which colors each of the styles will apply.

Showing/hiding header row and total row

Tip: You can also apply these options using directly the commands on the ribbon tab Table | group Style.

Below the Style list, there are more options for customizing the appearance of a table. The first two options
have the following function:

§ Header row 

This option enables/disables the header row (displayed above the table). The header row displays a column
title for each of the columns.

In the header row, you can also see a small arrow displayed to the right of each of the column titles. These
arrows indicate the presence of the AutoFilter that is applied automatically to each table. To filter data,
click on one of these little arrows. A menu opens, allowing you to choose from different kinds of filters for
the values in the corresponding column.

For more information on AutoFilters, see AutoFilter.

§ Total row 

This option enables/disable the total row (displayed below the table). The total row displays calculations
summing up the values contained in the table columns.

By default, the total row calculates just the sum of the values in the rightmost column of the table. However,
when you click on one of the cells in the total row, a little arrow appears to its right. This arrow opens a
menu where you can choose which kind of calculation the cell should perform. This allows you to calculate
the sum, average and other calculations for any given table column.

For more information, see Using the total row of tables in worksheets.



135Editing worksheets

Additional formatting options for table styles

Tip: You can also apply these options using directly the commands on the ribbon tab Table | group Style.

The other options on the Style tab have the following purpose:

§ Banded rows and Banded columns 

This option enables/disables alternating background colors for the table's rows and columns. Their color is
defined in the table style, which you can also set in this dialog box (as described above).

§ First column and Last column 

If you enable this option, the first and/or the last column in the table will be highlighted.

For most table styles, this is done by using boldface for the text in the respective column. However, some
table styles additionally change the background color – this depends on the table style definition.

Extended properties on the "Properties" tab

The Properties tab in the dialog box contains extended properties for tables, as follows:

§ Name 

Here you can change the name of the table.

The name of a table can be used in cell references (see Tables in worksheets and cell references).

Please note that the following rules apply for table names:

1. Table names must be unique.

2. Table names must always begin with a letter or an underscore.

3. Table names must not contain blank spaces or other invalid characters. (For maximum compatibility, it is
recommended to use solely letters, numbers and underscores.)

4. Table names must not be structured like cell references (e.g. A1).

§ Title and Description 

Here you can specify a title and a short description for the table.

This makes it easier to process your worksheet for people who are blind or have low vision and therefore use
tools like a screen reader.

Using the total row of tables in worksheets

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to create "Tables in Worksheets". Below you will learn how to make use of the "Total row" in tables.

Tables are able to display a so-called Total row below its content. It displays calculations summing up the
values contained in the table columns. The total row can be enabled/disabled anytime.
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By default, the total row displays the text "Total" and the sum of the values in the right-most column. However,
you can always edit the total row in order to perform different/additional calculations, as described below.

Enabling/disabling the total row

Tip: The total row can also be enabled directly on the ribbon tab Table | group Style.

To enable the total row for a table via the dialog box, proceed as follows:

1. Move the cell frame to any cell within the table.

2. Choose the command Properties  on the contextual ribbon tab Table.

Alternatively: Right-click on the table to open the context menu and select the entry Table settings

3. Activate the option Total row on the Style tab and confirm with OK.

The total row is now displayed below the table.

If you do not want the total row to be displayed, disable this option again.

Customizing total rows

By default, the total row displays the text "Total" and the sum of the values in the right-most column.

However, you can adjust this at will. The cells in the total row can be edited – just like any other cell – so you
can enter your own formulas or text here at any time.

A little helper is available for adding calculations that total the values in a column: When you move the cell

frame to any cell in the total row, a little arrow  appears to its right. Clicking on this arrow opens a menu
offering different types of statistical functions (sum, average, etc.). When you pick e.g. the "Sum" entry,
PlanMaker inserts a formula that calculates the sum of the corresponding column. For information on the
formula used, see SUBTOTAL.

Tables in worksheets and cell references

As described in the introduction of the section Tables in worksheets, the ribbon command Insert | Table allows
you to create "Tables in Worksheets". Below you will learn more about the special types of cell references that
are available for cells in such a table.

Namely, apart from the usual types of cell references, the cells inside a table can also be addressed using names
and special specifiers, as detailed below:



137Editing worksheets

Using names

Names can be used in cell references to cells in a table as follows:

§ Addressing tables by their name 

When you use the name of a table in a cell reference, it represents the entire table (with all of its cells,
except for the header row and the total row).

Example:

=SUM(Table3) returns the sum of all cells in the table named "Table3".

Tip: The name of a table can be changed via the dialog box of the command Properties  on the
contextual ribbon tab Table.

§ Addressing table columns by their column heading 

To address a single table column in a cell reference, enter the name of the table, followed by the column
heading enclosed in brackets.

Example:

=SUM(Table3[Spring]) returns the sum of all cells in the column with a column heading "Spring" in a table
named "Table3".

§ Addressing adjacent table columns 

You can also address a series of adjacent table columns. To do so, use the notation [[FirstColumn]:
[LastColumn]].

Example:

=SUM(Table3[[Spring]:[Autumn]]) returns the sum of all cells in the columns "Spring" through "Autumn"
in the table.

§ Addressing non-adjacent table columns 

To address multiple non-adjacent table columns, separate them with a comma instead of a colon.

Example:

=SUM(Table3[Summer],Table3[Winter]) returns the sum of the columns "Summer" and "Winter".

Note that in this case the name of the table has to be specified for each column.

Using specifiers

Apart from names, special specifiers that represent a certain component of a table can be used in cell references
with tables.

Specifiers must be entered behind the table name, enclosed in brackets.

For example, the cell reference Table3[#Totals] represents all cells in the total row of the table named
"Table3".

The following specifiers are available:
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§ #All: 

Represents the entire table including header row and total row, for example Table3[#All].

§ #Data: 

Represents all cells in the table that contain the actual data. These are all cells except header row and the
total row.

§ #Headers: 

Represents the cells in the header row of the table (the row containing the column headers).

§ #Totals:

Represents the cells in the total row of the table. (Note: If the total row is disabled, the cell reference will
return a #REF! error value.)

§ @[ColumnName]:

Represents the cell that is in the same row of the specified column. This is useful especially for calculations
within a table.

For example, a cell reference like [@Spring] used in a table stands for the cell that is located in the same
row of the column with the title "Spring".

Example:

=SUM([@[Spring]:[Winter]]) returns the sum of those values in the columns "Spring" through "Winter"
that are in the same row as the cell where this calculation was entered.

Note: PlanMaker does not distinguish between uppercase and lowercase letters in specifiers.
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Pivot tables
Besides the normal tables (see chapter Tables in worksheets), there are also Pivot tables. You can create a pivot
table using the ribbon command Insert | Pivot table based on your existing source data.

What exactly is a pivot table?

A pivot table is an optimal tool for displaying large amounts of data in a meaningful form. The generated pivot
data can be structured, summarized, filtered and analyzed according to different perspectives. The source data
remains unaffected.

Reports using pivot tables are particularly suitable for data sets with many different elements and criteria,
which are predominantly similar and interdependent, such as sales reporting.

What is the advantage of pivot tables compared to "normal" tables?
In addition to clarity, pivot tables are much better suited for data analysis than "normal" tables. If you would
like to ask complex questions about extensive data, e.g. "How many sales did an employee make for which
articles at what time," it will be quite laborious if you would extract this information directly from a normal
table. You would have to sort the data records first, then filter them, use commands and finally prepare them.
Pivot tables save you many work steps and give you a much better presentation of the desired information.

Data resources can be edited both directly from your PlanMaker worksheet and also via import from external
PlanMaker and Microsoft Excel files.

Pivot tables illustrated by an example

The modes of operation of pivot tables are illustrated here with a simplified example, which is used throughout
the chapter for description purposes.

Here you can see sample data records in PlanMaker from which a pivot table has to be created. The company
employees had various expenses for their breakroom supplies throughout the year. Some employees, as well as
some orders, appear several times in the respective columns.

Source data for the pivot table
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Note: Number formatting of the source data is not applied to pivot tables. For more information on
formatting values in the created pivot table, see Value settings (Values area).

Following an example for a pivot table: Here, the Employees are clearly listed with the sums of their orders and
the Grand total of all expenses.

Variant 1 of a pivot table (view of the employees)

But this pivot table can also be created: Here the Orders are arranged in a totaled overview.

Variant 2 of a pivot table (view of the orders)

Above all, the possibility of grouped arrangement shows the great advantages of pivot tables: Here, Employees
and Orders are displayed together and nested in one overview.

Variant 3 of a pivot table (view of employees with grouped orders)

It can be seen from these examples that, depending on the question addressed to the existing data, different
statements can be made with pivot tables.

The following sections clarify how to get different perspectives on pivot data and what settings you can make to
obtain a suitable presentation of your results:

§ Creating a new pivot table 

§ Starting with the pivot table field list
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§ Configuring pivot tables with the field list

§ Sorting and filtering pivot tables

§ Grouping pivot tables

§ Updating pivot tables and changing data range

§ Deleting, copying, moving pivot tables

Creating a new pivot table

iOS: Creating new pivot tables is not freely available in this version.

To create a pivot table, you must have data records to which a pivot table can be applied.

Using the ribbon command Insert | group Tables | Pivot table , you can create a pivot table from existing
source data.

Please note a few important rules for the existing source data. Some of the requirements are not mandatory, but
they are helpful for practical use:

Requirements for source data

§ The columns of the source data must have headings. 

§ Headings must appear in one single row, not one under the other. 

§ Headings must be unique, duplicate names for the headings must not occur. 

§ There must be no empty rows or columns and no merged cells in the source data. 

§ The data under the respective column headings must be of the same data type (number, text or date – not
mixed). 

§ If possible, the data should be available in its raw form; no formulas, summarizations, subtotals or other
prepared data should have been applied to them previously. 

You can either use existing records in the current workbook as source data or import data records from another
file (possible formats: PlanMaker and Excel).

Please read the next two sections:

§ Creating a pivot table with existing data 

§ Creating a pivot table with imported data 

Tip: Pivot tables can also be generated from Tables in worksheets. To do so, select a cell in the table and use
the command Summarize as pivot (in the group Table) on the contextual ribbon tab Table. Alternatively,
right-click on the table to open the context menu and select the same entry. After that, proceed with the next
steps to create a pivot table as described in the next section.
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Creating a pivot table with existing data

If the source data is already in the current workbook, proceed as follows:

1. Select the entire data range. You can also select only one cell from the source data. PlanMaker automatically
extends the selection to the entire corresponding area.

2. Choose the ribbon command Insert | group Tables | Pivot table .

The following dialog box opens:

3. Source range: The cell area with the existing data from which the pivot table has to be generated. Here, the
source range is already defined by your previous selection and can therefore be adopted. If you still want to
change the source range, you can enter the correct cell range in the input field or simply select the correct
cell range directly in the worksheet with the mouse.

Tip: If you have previously given the data range a name (see Naming cell ranges), you can simply enter
this name in the input field. An advantage of this procedure is that you only have to customize the named
range if the source data changes.
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With the Browse... button you can also import external data. For more information, see Creating a Pivot
table with imported data.

4. Target range: Here you can decide where the pivot table should be created. Now choose between the
following options:

New worksheet: The pivot table will be created in a new worksheet that is automatically generated by
PlanMaker. You can adjust the proposed target in the lower input field.

Existing worksheet: The pivot table will be created in an existing worksheet. This can be the worksheet
containing the source data or another existing worksheet. Please make sure that you first select the radio
button Existing worksheet and then click with the mouse on a cell in a free area in the desired worksheet. Or
type the target range into the lower input field.

Tip: For pivot tables with large amounts of data, it is recommended to use a new worksheet rather than the
worksheet with the source data, as it can quickly lead to a lack of space. If there is only a small amount of
data – as in our example – it is useful to display the pivot table in the same worksheet next to or below the
source data.

5. Confirm with the Insert button to create the pivot table.

If you created the pivot table in the same worksheet as the source data, the result should look like this:

On the left side you can still see the Source data, next to it on the right the (still blank) Pivot table report, and
rightmost in the sidebar the so-called Pivot table field list or just Field list. It is the central control of the pivot
table. By selecting the elements from the field list, you fill the blank pivot table with content according to your
requirements.

For more information about the structure and handling of the field list, see Starting with the pivot table field
list.
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Creating a pivot table with imported data

You can also import data records from other PlanMaker files or Microsoft Excel files to create a pivot table. To
do so, proceed as follows:

1. Choose the ribbon command Insert | group Tables | Pivot table .

The following dialog box opens:

2. Source range

In the file browser, locate the file with your source data and confirm with Open.

The input field below Source range displays the file path with the file name and a proposed worksheet with
a cell area. Here you have to adjust the desired cell range precisely. PlanMaker does not automatically
extend the cell range to corresponding data records when importing from external files.

Example: Your source data is in the file Pivot.pmdx in the worksheet Sheet1, and the cell range of your
source data records is from A1 to D11.

The syntax in the input field is then: 'filepath\[Pivot.pmdx]Sheet1'!$A$1:$D$11

Tip: If you have previously named the range of source data in your external file (see Naming cell ranges),
you can avoid entering the cell range exactly. A further advantage of this procedure is that you have to
adjust the named range only when making changes to the data records. Choose the name of the named
range in the input field using the following syntax: 'filepath\[filename]'!name

3. Target range: Here you can decide where the pivot table should be created:

New worksheet: The pivot table will be created in a new worksheet that is automatically generated by
PlanMaker. You can adjust the proposed target in the lower input field.

Existing worksheet: The pivot table will be created in an existing worksheet. This can be the worksheet
containing the source data or another existing worksheet. Please make sure that you first select the radio
button Existing worksheet and then click with the mouse on a cell in a free area in the desired worksheet. Or
type the target range into the lower input field.

4. Confirm with the Insert button to create the pivot table.
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You should now see a (still blank) Pivot table report in the worksheet and the so-called Pivot table field list
or just Field list on the right in the sidebar. It is the dialog and the central control of the pivot table. By
selecting the elements from the field list, you fill the blank pivot table with content according to your
requirements.

The following sections explain the structure and handling of the pivot table field list.

Starting with the pivot table field list

Once you have created a pivot table, the Field list appears on the right side of the sidebar with the upper Fields
section and the lower Areas section. It is the central element of a pivot table because here you control which
data is displayed in the target range of the pivot table (the Pivot table report) and how the data is arranged.

Note: The field list is displayed only when you place the mouse cursor in the pivot table report.

Structure of the field list

On the left the still blank pivot table report; on the right the field list with the "Fields section" above and the "Areas section" below.
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Fields section: In the upper part of the field list, the headings from the columns of the source data are grouped
in their original sort order. The order of the columns from left to right in the source data corresponds to the
order from top to bottom in the fields section. These elements are not called "Columns" here, but "Fields".

Areas section: In the lower part of the field list, you can drag the fields from the upper fields section.
Depending on how these fields are arranged, you can define the structure of the pivot table. As soon as you
have placed at least one field in one of the 4 areas of the areas section, results appear in the pivot table report.

The areas section is divided into the following 4 individual areas:

§ Row labels 

If you drag a field into this area, the data from this field is grouped by rows in the pivot table report. In this
context, grouping means that identical elements from a column of the source table appear only once and are
totaled. You can also drag several fields into this area; the added fields then also form further subgroups line
by line. The field that appears at the top of the row labels is the higher-level sort criterion. Fields further
down are treated as lower-level and are displayed in the pivot table report according to this structure.

§ Column labels 

Same procedure as for row labels, but grouping is by columns.

§ Values 

This is the most important area: The data records of the field dragged here are summarized in the pivot table
report, for example, amount totals. This is why fields with numbers usually appear here.

§ Report filter 

Allows you to show and hide selected data records in the pivot table report, based on the field that is
inserted in the report filter (see also Sorting and filtering pivot tables).

Tips to display the field list in the sidebar:

Adjust the Field list width as needed by dragging the mouse cursor along the inner edge of the sidebar.

To show or hide the field list, click on the narrow vertical button with the small arrow on the edge of the sidebar.

Use the ribbon command View | group Windows | Pivot table sidebar | Show at left or Show at right to choose at which side of the
document the field list should be displayed.

In the next sections you will find practical information on how to use the field list.

Exercises using the field list

You have already created a pivot table using the ribbon command Insert | group Tables | Pivot table . The
field list with the upper field section and the lower areas section is on the right-hand side, but the target range of
the pivot table (the pivot table report) is still blank.

This section explains step-by-step how to drag items from the fields section to the areas section in the field list,
in order to display significant results with different characteristics in the pivot table report.

If you are already familiar with the structure of a pivot table, you can skip this section.
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Tip 1: You can drag the fields to the desired area with the mouse. It is also possible to place a check mark in
front of the relevant field in the fields section. PlanMaker then automatically assigns the field to an area in
the areas section. Fields with numbers are placed in the values area; all other formats, such as text and date,
are placed in the row labels area.

Tip 2: Fields can be dragged back and forth not only between the fields section and the areas section, but
also between the individual areas of the areas section and within the areas themselves, so you can easily
swap the position of the fields.

Exercise 1: Adding a field to the "Values" area

In the fields section, place a check mark in front of the Amount field or drag the field with the left mouse button
down directly to the Values area of the areas section.

On the left the unchanged source data, in the middle the result of the pivot table, and on the right the field list with the selection of the fields for
Exercise 1

§ The field element "Sum of Amount" appears in the Values area of the field list. 

§ In the pivot table report, the value field with the header "Sum of Amount" now appears instead of the blank
report.

§ All items from the Values field are summed up to a grand total in the pivot table report.

Exercise 2: Adding a field to the "Row labels" area

Now place an additional check mark in front of the Employee field in the fields section or drag the field with
the left mouse button down directly to the Row labels area.
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On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 2

§ The field element "Employee" appears in the Row labels area of the field list. 

§ In the pivot table report, a row field with the header "Row labels" is displayed and the employees are
arranged by rows. Each name appears only once here.

§ The value field with the header "Sum of Amount" in the pivot table report displays the expenses summed up
and broken down by employee.

Exercise 3: Adding a field to the "Column labels" area

You can also display the result by columns instead of by rows. To do this, drag the same Employee field to the
Column labels area.

On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 3

§ The field element "Employee" appears in the Column labels area of the field list. 
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§ In the pivot table report, a column field with the header "Column labels" is displayed and the employees are
arranged by columns. Each name appears only once.

§ The expenses are summed in the pivot table report in the value field "Sum of Amount" and broken down by
employee.

Exercise 4: Adding a second field to the "Row labels" area

Drag the Employee field back into the Row labels area, and now place an additional check mark in front of the
Order field.

On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 4

§ In the pivot table report, employees are grouped with their totaled order types under "Row labels". Since the
Employee field is at the top of the row labels area, it is the primary criterion and is therefore displayed as the
higher-level field in the pivot table report.

§ The amounts for purchased orders are broken down by employee in the "Sum of Amount" value field in the
pivot table report and partial results are displayed as subtotals per employee.

Note: It could be that the orders in the pivot table report are grouped as an indented column to the right of
the employees. The structure of the results shown here is based on the PlanMaker default settings. See
section Configuring pivot tables: Field settings to find useful information on how to customize the form.

Exercise 5: Using "Column labels" and "Row labels" together

Drag the Order field to the Column labels area, the Employee field remains in the Row labels area.
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On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 5

§ You will see the same results as in Exercise 4, but shown as a cross-classified table. The intersecting fields
without existing values (e.g. Anna did not buy sweetener) are displayed as empty cells.

Exercise 6: Using "Column labels" and "Row labels" together with multiple fields

Now also drag the Date field to the Row labels area below the Employee field.

On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 6

§ The date of the orders purchased by employees is also displayed in the pivot table report, in this example
grouped directly below the employees. A grouping of the orders as an indented column to the right of the
employees could also appear, depending on the settings in PlanMaker. 

Note 1: You can drag multiple fields into the row and/or column labels for reporting purposes, but you
will also quickly reach the limits of clarity.
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Note 2: If there are several fields in one area, the order of the fields determines the structure of the outline
levels displayed in the pivot table report. You can change this order at any time by dragging the field up or
down within the area.

Exercise 7: Adding a field to the "Report filter" area

Drag the Date field from the Row labels area to the Report filter area and the Order field back to the Row
labels area.

On the left the result of the pivot table, and on the right the field list with the selected fields for Exercise 7

§ A Report filter has been added for the Date field, which is integrated as a new row above the pivot report.

§ Above the pivot report you can open a dropdown menu to the right of (All items)  and filter by date values
displayed in the list. Initially, all date values are selected, indicated by the check mark in front of them. You
can filter out the date items from the pivot report that you do not want to be displayed by removing the
check marks.

Working with the field list: Fields section

The fields section in the upper part of the field list displays the headings of the columns of your source data.
You can make the following changes to the fields section:

§ Display field names alphabetically in the fields section 

The field names are first automatically sorted according to the order of the columns from your source data.
You can also display the fields in alphabetical order to find specific field names more quickly. To do so,
click the Pivot table settings button below the areas section. On the Filter tab, section Field list, select the
option Sort A to Z and confirm with OK.
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Note: The alphabetical order you enter here does not affect the appearance in the pivot table report. To
sort the elements alphabetically directly in the pivot table report, see Sorting and filtering pivot tables.

§ Rename field names in the fields section

Open the dropdown menu  to the right of the field name and select the Field settings. In the associated
dialog box you can assign a Custom name.

You can also rename a field if it is in the values area or row labels/column labels area of the areas section.
For more information, see Working with the field list: Areas section.

§ Move fields from the fields section to the areas section

To move a field from the fields section to the areas section, you have the following options:

A. Enable the checkbox to the left of the field name in the fields section. PlanMaker automatically assigns
the field to an area of the areas section according to its format: Numbers are placed in the Values area,
text and date formats in the Row labels area.

B. Drag the field with the left mouse button to the desired area below.

C. Click the dropdown menu  to the right of the field name. Here you can select the area in which you
want to move the field directly.

Working with the field list: Areas section

After creating a pivot table, you will see first of all a blank pivot table report in your worksheet and the field list
in the sidebar on the right. By adding the fields from the upper fields section to the 4 individual areas of the
lower areas section, you can observe how the assignments in the field list affect the previously blank pivot
report.

Tip: It is best to first drag the field with the amounts into the values area of the areas section. This way you
can best follow the further steps in structuring the pivot table.

Adding, moving, removing fields

Adding fields to the areas section

To move a field from the fields section to the areas section, you have the following options:

A.Place the check mark to the left of the field name in the fields section. PlanMaker automatically assigns the
field to an area of the areas section according to its format: Numbers are placed in the values area, text and
date in the row labels area.

B. Drag the field with the left mouse button to the desired area below.

C. Click the dropdown menu  to the right of the field name. Here you can select the area in which you want
to move the field directly.
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Moving fields within the areas section

To move fields from one area to another area within the areas section, you have the following options:

A.Drag the field from one area to another with the left mouse button.

B. Click the dropdown menu  to the right of the field name (either in the fields section above or in the areas
section below). Here you can select the area you want to move the field directly into.

C. Use the left mouse button to drag the field again from the upper fields section to the desired new area of the
areas section. This will automatically remove it from the previous area (except for the values area, where
copies of a field are possible).

Removing fields from the areas section

To remove fields from the areas section at any time, you have the following options:

A.Use the left mouse button to drag the field back up into the fields section.

B. Remove the check mark to the left of the field name in the fields section.

C. To the right of the field name, click the dropdown menu  (either in the fields section above or in the areas
section below) and select Remove field.

Note: Removing fields from the areas section or moving fields between the areas will undo any changes
made to the field (exception: renaming in the row labels/column labels area).

Tips and rules for using the areas section

Using fields more than once in the areas section

§ To the Row labels, Column labels and Report filter areas the following applies: A field can be dragged only
once into one of these areas. If you also want to insert it into another area, it is removed from the area where
it was before. 

§ This does not apply to the Values area: here you can drop a field again, even if it already exists in another
area. The same field can even be inserted several times as a copy. What could this be good for? You can
display a field item both as a sum and a second time in a different format (e.g. average). An additional
element  Values appears automatically in the column labels, which you can also move to the row labels
area (the format is retained), but not to the report filter area.

Note: If you drag the field  Values back into the fields section, all fields in the values area will be
automatically removed and all changes made to these fields will be discarded.

Changing the order of the fields within an area of the areas section

§ The order of the fields within an area can be changed by using the mouse to drag the field to the correct
position within the area.

§ Alternatively, click the dropdown menu  to the right of the field name. Here you can select where you
want to move the field (up, down, to the beginning or to the end).
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Renaming a field name in the areas section

A field name can be renamed in the areas section so that it appears in the pivot table with a different name.

§ Custom name in the Row labels or Column labels area: 

If the field is in the row labels or column labels area, click the dropdown menu  to the right of the field
name and select Field settings. In the Field tab, enter a custom name.

§ Custom name in the Values area:

If the field is in the values area, select Value settings from the dropdown menu  to the right of the field
and enter a custom name in the Summarize values tab.

Note: For renaming in the values area, the following applies: The new name is discarded when the field is
removed from its area. However, you can also rename the field in the fields section above (see Working
with the field list: Fields section); the renaming made here remains. In the values area, however, the
addition "Sum/Count of..." is still displayed.

§ In the Report filter area it is not possible to rename fields. However, you can also rename the field at the
fields section. 

Further options in the field list

In the field list you will find further control elements not described here. These are explained more closely in
the following sections:

§ Pivot table settings button: 
Section Pivot table settings

§ Refresh data button: 
Section Updating pivot tables and changing data range

§ Defer layout update along with the Update button:
Section Defer layout update

§ Field settings (via dropdown menu  of fields in the row labels/column labels area):
Section Field settings (Row/column labels area)

§ Filter labels (via dropdown menu  of fields in the row labels/column labels area):
Section Sorting and filtering pivot tables

§ Filter values (via dropdown menu  of fields in the report filter area):
Section Sorting and filtering pivot tables

§ Value settings (via dropdown menu  of fields in the value area):
Section Value settings (Values area)
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Configuring pivot tables with the field list

In the field list, you have various options to change the structure and appearance of your pivot table, which are
explained in this section:

§ Field settings 

The Field settings can be found in the areas section of the field list in the Row labels or Column labels

areas; use the dropdown menu  to the right of each field. In the field settings, you can define if and how
partial results are displayed and in which form the layout appears (outline form or tabular form); you can
also change the field name here.

§ Value settings 

Fields in the values area have different setting components from the field settings in the row/column labels.

They can also be opened via the dropdown menu  of the respective field and are called Value settings
here. In the value settings you will find a selection of summary functions and calculations as well as the
required number format for the displayed results. The field name can also be renamed here.

§ Pivot table settings 

In the Pivot table settings, you can make advanced layout adjustments, define filter methods, select styles,
set data usage and assign a name to the pivot table. You will find the pivot table settings located as a button
below the areas section.

§ Defer layout update 

You will find the Defer layout update option along with the Update button at the bottom of the field list. It
allows you to "freeze" the continuous recalculation. You can rearrange the fields between the areas without
time-consuming calculation.

Please note: Changes to Field settings and Value settings are discarded when a field is removed from its
area (back to the fields section or to another area of the areas section). Changes to Pivot table settings are
retained.
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Field settings (Row/column labels area)

If you open the dropdown menu  to the right of a field in the Row labels or Column labels areas in the lower
areas section of the filed list, you will find the Field settings option. Alternatively, you will find this option via
the context menu by right-clicking directly in the Pivot table report (select a cell of the desired field below the
headers Row labels/Column labels).

This section describes the adjustments you can make with the field settings.

This is illustrated based on the known example data shown in the figure below: The Amount field is dragged
into the Value area of the areas section, and the Employee and Order fields are dragged into the Row labels
area.

The pivot table report at default values for field settings. Highlighted in blue: selecting the field settings for the "Employee" field

Note: For the sake of simplicity, the descriptions given in this section refer to the arrangement of the fields in
the Row labels area. If you drag the fields to the Column labels area instead, the results are basically the
same. But they are displayed transposed (from left to right instead of top to bottom).

Field settings, "Subtotals" tab

If you have arranged several fields in a row labels or column labels area, you get partial results for the higher-
level field item (Employee) in the pivot table report, as shown in the figure above (for Anna, Maria, Toni).
These subtotals are automatically calculated as sums if a number field has been identified in the values area. In
the Subtotals tab you can also change the display of the subtotals to other summary functions (e.g. count,
average, etc. instead of sums) or hide the display of subtotals completely.

Important: The field settings have an effect for the pivot table only on the field selected in the row/column
labels area.

Click on the dropdown menu  to the right of the field (Employee) in the Row labels area (areas section of the
field list) and select the Field settings. In the open dialog box, choose the Subtotals tab.
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Here you have the following options:

§ Auto (default): Sums are displayed for the subtotals (Employee, as in the figure above). If the value field
(Amount) does not contain numbers, but values with other formats, the Count function is automatically used
for the subtotals. 

§ None: The subtotals (Employee) are not displayed. 

The Pivot table report without subtotals

§ Custom

You can choose from various summary functions for displaying subtotals using the Custom option:

Sum: The subtotals are displayed as the sum of the single values.

Count: Returns the number of single values that occur. Works the same as the COUNTA function.

Average: Returns the average value of the occurring single values.

Maximum: Returns the largest occurring single value.

Minimum: Returns the smallest occurring single value.

Product: Returns the multiplied value of the occurring single values.

Count numbers: Returns the count of values that are numbers. Works the same as the COUNT function.

Standard deviation (sample): Returns the estimated value for the standard deviation of a population based
on a sample. Works the same as the STDEV.S function.

Standard deviation (population): Returns the standard deviation of a population. Works the same as the
STDEV.P function.

Variance (sample): Returns the estimated value for the variance of a population based on a sample. Works
the same as the VAR.S function.

Variance (population): Returns the variance of a base population. Works the same as the VAR.P function.

Tip 1: It is also possible to combine several custom functions. Each of them is then displayed as a separate
row for the subtotal.

Tip 2: If you want to change not only the subtotals but also the other values to a certain display, you can
make the required changes in the Values area with the value settings option; see the section Value settings
(Values area). If, on the other hand, you want to show or hide the Grand totals for columns/rows, you will
find the options available under Pivot table settings.
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Field settings, "Form" tab

In the example figure at the beginning of the section, you can see the pivot table report displayed in the outline
view. You can use the Form options to customize this view.

Note: The displayed Form can only be customized for fields in the Row labels area. For fields in the Column
labels area, the structure formats cannot be set.

In the Row labels area (in the areas section of the field list), click the dropdown menu  to the right of the
Employee field and select Field settings. In the open dialog box, choose the Form tab.

The Field settings dialog box with the default values in the "Form" tab

Form section

Here you can select between the view in Outline form or in Tabular form:

§ In the Outline form – with additionally enabled Compact form – several fields are displayed together in
one column, and the lower-level elements are indented into the column. You can also select here whether the
subtotals should appear above or below the grouping.

The following figures illustrate the different presentation variants, depending on the enabled options:
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Outline form: Compact form enabled; Subtotals at top enabled

Outline form: Compact form disabled; Subtotals at top enabled

Outline form: Compact form disabled; Subtotals at top disabled
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§ The Tabular form generally displays a separate column for each field, with the respective field heading:

Further options in the "Form" tab

There are three more options in the lower section of the form tab that you can use as needed to give the pivot
table report a better structure.

Please note: The options Repeat item labels and Insert blank lines after subtotals affect only higher-level
field items (Employee). The option Show items without data, however, affect only lower-level field items
(Order).

§ Repeat item labels 

The item labels of the elements are displayed repeatedly in each row. This option only works for the Tabular
form and for the Outline form only if you disable the compact form.

Enabled option "Repeat item labels" for Tabular form

§ Insert blank lines after subtotals 

It can be helpful for the clarity of the pivot table report if a blank line appears after each group of subtotals.
Enable the option for this purpose (not available for fields in the column labels area).
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§ Show items without data 

Enable this option to also display those elements that did not contain associated data.

Example: Toni did not buy any Coffee. Enabling this option, however will display that item with an empty
cell in "Sum of Amount".

Field settings, "Field" tab

You can give the field a Custom name here so that it appears in the pivot table with a different name. Enable
the checkbox and type the new name into the input field (see also Working with the field list: Areas section).

Value settings (Values area)

If you open the dropdown menu  to the right of a field in the Values area in the lower areas section of the
field list, you will find the Value Settings option. Alternatively, you will find this option via the context menu
by right-clicking directly in the Pivot table report (select a cell below the header title Sum of...).

The value settings dialog box contains the tabs Summarize values and Show values as, which give you
various summary functions and calculation options to choose from.

Value settings, "Summarize values" tab

The results in the pivot table report are automatically displayed as a sum if a number field was identified in the
Values area. If the field has values other than numbers, the results are calculated as a count.

You can customize the display of the results. The specified selection applies to the subtotals of the higher-level
field and also to the subgrouped fields.

To do this, click the dropdown menu  to the right of the desired field in the Values area (in the areas section)
and select the Value settings option. In the dialog box that then opens, choose the Summarize values tab.

In the upper section of the tab, you will find "Summarize values by" with the following options for displaying
the values:

§ Sum: The subtotals are displayed as the sum of the single values. 

§ Count: Returns the number of single values that occur. Works the same as the COUNTA function.

§ Average: Returns the average value of the occurring single values.

§ Maximum: Returns the largest occurring single value.

§ Minimum: Returns the smallest occurring single value.

§ Product: Returns the multiplied value of the occurring single values.

§ Count numbers: Returns the count of values that are numbers. Works the same as the COUNT function.

§ Standard deviation (sample): Returns the estimated value for the standard deviation of a population based
on a sample. Works the same as the STDEV.S function.
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§ Standard deviation (population): Returns the standard deviation of a population. Works the same as the
STDEV.P function.

§ Variance (sample): Returns the estimated value for the variance of a population based on a sample. Works
the same as the VAR.S function.

§ Variance (population): Returns the variance of a base population. Works the same as the VAR.P function.

Tip: If you only want to change the subtotals to a certain display, you can make the required changes in the
Row/Column labels area with the Field settings option, see previous section Field settings (Row/column
labels area). If, on the other hand, you want to show or hide the Grand totals for columns/rows, you will find
the options available under Pivot table settings.

Furthermore, you will find the Custom name option in the tab. Here you can rename the field so that it appears
in the pivot table with a different name. See also section Working with the field list: Areas section.

Value settings, "Show values as" tab

In the Show values as tab you will find various options how to display the results of the pivot table, for
example, as percentage values.

Tip: You can also drag the same field several times into the Values area. If you then apply different output
settings to the copy of the field using Show values as (e.g. for one field standard values and for the other
field percentage values), you can clearly compare the different output values in the pivot report.

In the upper section of the dialog box you will find the section Show values as with choices for calculating the
values. Depending on the calculation type, additional entries appear in the Base field and Base item lists below.

§ Standard (no calculation): Displays the value as usual. 

§ % of grand total: Each item is displayed as a percentage of the grand total.

§ % of column total: For each column, the total is set as a 100% reference, and each item in the column is
shown as a percentage of that total.

§ % of row total: For each row, the total is set as a 100% reference, and each item in the row is shown as a
percentage of that total.

§ % of: A column or row field is set as a 100% reference, and all other values are displayed as a percentage of
this reference value. The required entries must be selected from the base field list and base item list.

§ % of parent row total: Displays the percentage of an item relative to the higher-level item (= parent) in the
row structure.

§ % of parent column total: Displays the percentage of an item relative to the higher-level item (= parent) in
the column structure.

§ % of parent total: Displays the percentage of an item relative to any (selectable) higher-level item in the
structure. The required entry must be selected from the base field list.

§ Difference from: Displays the absolute difference of the values from the selected reference value. The
required entries must be selected from the base field list and base item list.
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§ % difference from: Displays the percentage difference of the values from the selected reference value. The
required entries must be selected from the base field list and base item list.

§ Running total in: Displays the cumulative absolute values of the successive items. The required entry must
be selected from the base field list.

§ % running total in: Displays the cumulative percentage values of the successive items. The required entry
must be selected from the base field list.

§ Rank smallest to largest: Displays the rank of selected values in a specific field. The smallest item in the
field is ranked 1. The required entry must be selected from the base field list.

§ Rank largest to smallest: As above, but the largest element in the field is ranked 1.

§ Index: Displays the weighting of the values in relation to the grand row total and grand column total. The
higher the index value, the greater the weighting of the value on the grand row/column total. For the index
value, this formula applies:

value in cell x grand total of the pivot table
 grand row total x grand column total

You can use the Number format button in the tab to permanently adjust the display of the desired number
format. For details on the various number formats, see the List of all number formats.

Note: The changes to the number format that you make here are permanently applied. If you change the
number format using the cell formatting only, the changes are discarded when the data is refreshed. The
number formatting of the source range also is not adopted in the pivot table.

Pivot table settings

In the field list below the areas section with the 4 areas, you will find the Pivot table settings button. You can
also access the command via the context menu by right-clicking directly in the pivot table report.

You can make further adjustments to the structure of your pivot table here, which you cannot find in the field
settings or value settings, since pivot table settings are of a general nature. Unlike the field and value settings,
the changed options in the pivot table settings will remain in effect when you remove the fields from the areas
section.

Layout tab

§ Show totals for rows/columns: Shows or hides grand totals for rows/columns. 

§ Indent row labels...characters: If you have arranged several fields in the row labels area and the outline
form with compact format is set in the Field settings, the field of the lower-level is displayed indented below
it. Here you can now define the extent of the indentation from the left edge of the column (default is 1
character).

§ Autofit column width: If this option is enabled, the column width of the pivot table automatically fits to the
text of the columns so that the text is not cut off by the next column. This has advantages, but the downside
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is that manually made column width adjustments may be discarded when changes are made to the fields.
Disable this option to keep the column width you set manually.

§ Preserve cell formatting: If this option is enabled, the formatting you made manually in the pivot table
(e.g. a different font, shading, borders) will be retained. If the option is disabled, such formatting changes
will be discarded as soon as you update the pivot table or reopen the workbook.

Note: The number formatting needs to be set using the Number format button (in the Value settings on
the Show values as tab) so that it is permanently retained.

§ Classic pivot table format: If you are confused about the headers "Row labels" and "Column labels" in the
pivot table report and prefer to see the real names of the fields instead, enable this option for a classic
appearance (known from older versions of Microsoft Excel up to 2003).

§ Show the values row: Enable the checkbox to insert an additional row with the heading "Values" above the
pivot table report. Note: The value row is displayed only if there are at least two fields in the values area and
cannot be enabled for the classic pivot table format.

Filter tab

§ Report filter section: You can combine the following options Display fields and Fields per row to rearrange
the placement of report filters in the pivot table report.

Display fields – If there are at least two fields in the report filter area, you use this option to specify how the
fields in the report filter area are arranged in the pivot table report. You can select between First down, then
right or First right, then down.

Fields per row – Here you can also specify for the report filters of the pivot table report how many fields
are displayed per column before a new column starts.

§ Field list section:

Sort A-Z/Sort in data source order – The field names in the field list are sorted according to the order of
the columns from your source data. You can also display the fields in alphabetical order to find specific field
names in the fields section more quickly.

Note: The order specified here does not affect the display in the pivot table report. To sort the elements
alphabetically directly in the pivot table report, see Sorting and filtering pivot tables.

§ Display section

Show field captions and filter dropdowns – The field names and filter symbols for row labels and column
labels are displayed/hidden in the pivot table report.

Style tab

You can adjust the visual appearance of the pivot table report in various ways, just as you do with normal table
styles. Select a style source (Excel 2007, Excel 2003, Excel 97) from the upper left list in the Style section and
choose one of the pivot styles with different formatting from the list below. For the Excel 2007 style templates,
the selection light/dark/medium is also available in the upper right list.
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The options Banded rows, Banded columns, Row headers and Column headers are displayed automatically
adapted to the style template. For the Excel 2007 style templates, you can manually modify these options to
your preferences.

Enabling the option Banded rows/Banded columns causes alternating background colors of the rows/columns,
enabling the option Row headers/Column headers emphasizes the first row/column of the pivot table.

The change of the design is displayed directly in the pivot table report as a preview and has to be confirmed
with OK for finally applying it.

Data tab

§ Special values section:

For error values show – Cells with incorrect calculations return the known error values also in the pivot
table report (for example, #N/A; see the section Error values). Enable this option and enter an individual text
in the right input field to display self-defined output values representing the error values.

For empty cells show – If no data can be assigned to an item (this usually occurs with combinations of row
and column labels for cross-classified tables), an empty cell is displayed in the pivot table report. If you
disable the checkbox, a 0 is displayed instead of empty cells. If the checkbox is enabled, you can also enter
an individual text in the input field next to it to display a self-defined output value instead of an empty cell
or the 0.

§ Pivot table data section:

Save source data with file – If this option is enabled, the source data is stored in an internal cache and is
available from the cache for the pivot table independently of your source data. In a way, a copy of the source
table is created. This is particularly useful for external source data: If it no longer exists, you can still work
on your pivot table with the data from the pivot cache.

If you disable this option, your data will not be stored in the pivot cache. When you re-open the file, you
have to click the Refresh data button (see Updating pivot tables and changing data range) to initialize the
pivot cache for the pivot table with the source data. For external source data, if they no longer exist, your
pivot table can also not be updated.

Refresh when opening the file – If this option is enabled, the pivot table data is automatically updated to
current source data when you open the file. If you disable this option, you can continue working with your
old pivot data until you trigger the Refresh data button (see Updating pivot tables and changing data range).

Please note: Updating the data with the Refresh when opening the file option or with the Refresh data
button will replace the pivot cache with updated source data, overwriting the previous data in your pivot
table.

Text tab

In the Text tab you can enter a custom Name, a Title and a Description for your pivot table. The name is
automatically generated by PlanMaker in sequence (Pivot table 1, Pivot table 2, etc.) and is shown as a heading
in the blank pivot table report. An entry is also created in Named ranges, but it cannot be renamed there.
Moreover, the assigned Name cannot be used to identify the pivot table from the GETPIVOTDATA function;
therefore, you must explicitly create a new entry for the pivot table in the Named ranges.
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Apart from that, the entries from the Text tab do not appear anywhere in the pivot table. Title and Description
can be useful as internal information. To rename the fields that effectively appear in the pivot table, please read
the section Working with the field list: Fields section.

Defer layout update

At the bottom of the field list you will find the option Defer layout update. It is combined with the Update
button on the right, but is not related to the Refresh data option (see Updating pivot tables and changing data
range).

When you are repositioning fields in the field list, for example, add/remove/move fields in the areas section, the
pivot table report is recalculated each time. This can take quite some time with large reports. Therefore, if you
want to temporarily disable continuous recalculation, please proceed as follows:

1. Place a check mark in the Defer layout update checkbox. You can then rearrange the fields of your pivot
table, but you will not see the resulting changes in the pivot table report. In addition, all other editing options
for this state are disabled.

2. Once you have finished repositioning the fields, click the Update button to see the result of the change.

3. Remove the check mark from the Defer layout update checkbox.

Note: If you disable the Defer layout update option again without pressing Update, all arrangements of the
fields that you have made since the option was enabled will be discarded.
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Sorting and filtering pivot tables

Too much data makes it difficult to see the relevant content. Therefore, there are various options for sorting and
filtering table fields in pivot tables:

§ Sorting field items alphabetically in the pivot table report via the dropdown menu  

§ Filtering in the areas section with the Filter labels (Filter values) option

§ Filtering by adding Report filters

§ Set additional special filters directly in the pivot table report via the dropdown menu 

Please note: For all presented options of sorting and filtering, the changes will be discarded as soon as you
have removed the field from the areas section or moved it from one to another area.

Sorting field items alphabetically in the pivot table report

You can sort the field elements of a pivot table report alphabetically by opening the dropdown menu  in the
report itself at the header Row labels/Column labels and choosing from the list:

§ Sort from A to Z (alphabetical order) 

§ Sort from Z-A (reverse alphabetical order)

If there are several fields in the row/column labels area (as in the figure above), you can sort each field
separately. If you move the mouse in the dropdown menu  to the desired field, a submenu with the sorting
options of this field opens.
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Note: For the alphabetical display of the fields only in the field list, please read the section Working with the
field list: Fields section.

Filtering in the areas section with the option Filter labels (Filter values)

In the Row labels/Column labels areas of the field list, go to the desired field whose items you want to filter.

Open the dropdown menu  to the right of the field and choose the Filter labels option (for fields in the
Report filter area, do the same, but here the option is called Filter values). You can also select the option
directly from the pivot table report by right-clicking on the desired field opening the context menu.

You can select from the Filter dialog box that appears:

§ Select single list items that you want to show/hide by placing/removing a check mark in front of them. 

§ The Show all button selects all items. 

§ The Hide all button deselects all items.

Confirm your selection by pressing OK.

In the pivot table report, the black dropdown arrow  next to the header changes to a red arrow, indicating that
a filter is active. The filtered out values are no longer displayed in the pivot table report.

Filtering by adding report filters

The Report filter is located in the lower areas section of the field list and offers you a particularly simple and
clear option for filtering data.

Drag the fields you want to filter by to the report filter area. A cell with the field name is then inserted above
the pivot table report and another cell (All items) with a dropdown arrow  is integrated to the right of it. The
items of the field can be filtered via this dropdown menu. You can select single list items here or
select/deselect the complete list of items with Show all/Hide all.

The red dropdown arrow to the right of the cell indicates that a filter is active. The filtered out values are no
longer displayed in the pivot table report.

You can drag several fields from the field list to the report filter area and filter any combinations of single items
from the various fields for the pivot table report.

Tip: Changing the positioning of the report filter fields in the pivot table report is possible using the Pivot
table settings, Filter tab.

Set additional special filters directly in the pivot table report

In the pivot table report, open the dropdown menu  right to the Row labels/Column labels header. If there is
only one field in the Row labels/Column labels area, the filter choice is displayed directly for the selected field.

If there are several fields in the row/column labels area, separate filters can be applied for each field in the pivot
table report. If you move the mouse to the desired field in the dropdown menu  of the header, a submenu
opens with the filter selection of the field.

§ You can select single list items or select/deselect the entire list of items with Show all/Hide all. 
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Note: If the list has too many entries, the entry More appears at the end of the list. Clicking on this entry
takes you to the Filter dialog box with the complete list of all items.

Furthermore, additional special filter conditions are available in the dropdown list (you can find detailed
descriptions of the individual filter conditions in the section AutoFilter):

§ Label filter or Date filter: Depending on whether you have selected a field with numbers/text or date
values, one of the two filters is automatically offered. According to the filter, you will find certain filter
conditions for numbers/text or date values. 

§ Result filter: The result filter has special filter conditions that you can use to narrow down the amounts in
the value fields.

Note: Please pay attention when applying filters to several fields in which order you set the filters. The
next filter that is applied refers only to the remaining results of the previously set filter.

§ Multiple filters: The filters in pivot table reports can be applied additively, that is, you can place another
filter on the currently effective filter of the same field. To do this, however, you must activate the Multiple
filters option to combine filters for single list items, label/date filters and result filters for the same field. If
this Multiple filters option is not enabled, a newly applied filter replaces the old one. 

§ Clear filter: If you want to remove the used filters from the label filter/date filter or result filter, choose
Clear filter from the dropdown list of the relevant filter.

Tip: If you want to remove all filters at once, disable the Multiple filters entry. In the following dialog
box Reset all filters? confirm with OK to undo all filters.

In the pivot table report, the red dropdown arrow next to the header indicates that a filter is set. The filtered out
values are no longer displayed in the pivot table report.

Grouping pivot tables

You can use the Group function to display data even more clearly. For example, group the dates in your pivot
table report by years, quarters, or months to make time periods more meaningful.

You can find the command for this in the pivot table sidebar at the bottom with the Group... button.

An example:

You have created a pivot table from the known sample data (see Creating a new pivot table).

Then, proceed as follows:

1. In the pivot table sidebar, drag the Date field to the Row labels area and the Amount field to the Values
area.

2. In the pivot table report, select a cell with a date value.

Note: Only one cell may be selected at a time.
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3. Click on the Group... button in the pivot table sidebar.

4. In the dialog box that now appears, select the entry Quarters from the list, for example.

5. In the dialog box, confirm with Group.

The pivot table report then shows the following result: The amounts are summed up quarterly.

The "Group..." function in detail:

Depending on the contents of a selected cell, you will group date values, numeric values, or text. Multiple
groupings in the same pivot table are possible, both for Row labels and Column labels.

After you have selected a cell in the pivot table and clicked on the Group... button, one of the following dialog
boxes opens, each with different options:

§ The dialog box Group by dates appears if the selected cell contains date values: 

With the Automatic options enabled, the date values are preset to a range with the first and last date of all
data records, and grouped for this period. If you want to customize the time period, clear the Automatic
check box in front of the input fields Starting at or Ending at and type in the desired values there.

In the list below, select the time unit (Months, Quarters , etc.) by which you want to group. Click with the
mouse on the relevant entry from the list, it is then highlighted in blue and thus selected. To deselect, click
again on the entry highlighted in blue. Tip: You can also select multiple time units, just click on another
entry. For example, it may make sense to select Quarters as well as Days. The days are then shown in the
pivot table for the relevant quarter.

Once you have made your choice, press Group in the dialog box.

Note: The input field Number of days is only available if you have specifiedDays only as a time unit in the list above. This option
causes the pivot table to display the specified number of days as a time interval from...to and is especially useful for displaying the
results of calendar weeks. To do so, enter the number 7 and disable the two Auto check boxes above. Now choose for Starting at the
Monday before the oldest date of your source data (in the example above, this would be 01/08/2018) and for Ending at the Sunday
after the most recent date (in the example 11/18/2018).

§ The dialog box Group by numbers appears if the selected cell contains numeric values: 

With the Auto check boxes enabled, the numerical values are preset to a range with the smallest and largest
numerical value of all data records. Therefore, the numerical values belonging to this range are grouped. If
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you want to customize the range, disable the Auto check box in front of the input fields Starting at or
Ending at and enter the desired values there.

With the By option below you determine in which intervals the numerical values are to be grouped. You
therefore receive a summarization to value classes. For example, if you enter 0 for Starting at, 40 for
Ending at, and 10 for By, you will get the classes 0-19, 10-19, 20-29, 30-39 by which your records will be
grouped.

Finally, press Group in the dialog box.

§ The dialog box Group text appears if the selected cell contains text: 

In the Labels list on the left, select the items you want to group by clicking on them with the mouse. The
entry now appears highlighted in blue. To deselect an item, simply click on it again.

Important: In the input field Group name, type a name first. After this, you can use the New group button
to create a grouping for the selected items. You can then add more groups in the same way by selecting
items from the left list again and entering a group name (be sure to confirm with New group).

In the right list Groups you see the result of the created group(s): At the top is the group name and below are
the contained items.

If you want to rename a group, select the corresponding group in the Groups list on the right. Important: In
the Group name field, type the new name first, and after this click on the Rename group button.

Use the buttons  and  to add or remove items from the groups. To do this, select the desired group in
the Groups list on the right and then select the item you want to add (from the left list) or remove (from the
right list).

Finally, click on OK in the dialog box.

Ungrouping

To reset grouped data, select a cell of the grouping in your pivot table report. Click on the Ungroup button in
the pivot table sidebar. Only the grouping of the field to which the selected cell belongs is reset.

Alternatively, you can click the Group... button to open the dialog box again and click there on the Ungroup
button.

Only for cells with text: If you have created several groups for a field with text, you can remove a single group
via the dialog box by selecting there a group in the dropdown list on the right and using the Ungroup button.
The Ungroup all button, on the other hand, ungroups all groupings for that field (corresponds to the Ungroup
button in the sidebar).
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Updating pivot tables and changing data range

The following generally applies to pivot tables: If you subsequently add new data to the source table, this
initially has no effect on the pivot table. Due to PlanMaker's default values for pivot table settings (see Pivot
table settings, Data tab), the data of the original source table is stored in an internal pivot cache after creating
the initial pivot table. The pivot table accesses the data from this cache.

Only when you Refresh data, the pivot cache will be overwritten and the pivot table will be updated.

In the Pivot table settings, Data tab, you can find the option Refresh when opening the file. If you enable
this option, the pivot cache is regularly overwritten with the current data of the source range when you open the
file. If you want to continue working with your old pivot data after opening the file, leave this option disabled.

You can manually update your pivot table at any time by clicking the Refresh data button.

Please note: By updating the data with Refresh data button or with Refresh when opening the file option, the
pivot cache will be replaced by updated source data and the previous data in your pivot table will be
overwritten.

"Refresh data" button

You will find the Refresh data button below the areas section in the field list.

Depending on the way you added new data to the source data range, this will affect the pivot table differently
when it is updated:

§ If you overwrite data within the source data range, the changed data is used in the refreshed pivot table. 

§ When you insert a new row or column within the source data range, the data range is not automatically
extended. Therefore, the updated pivot table will only reflect the data that is in the previous source data
range. Thus, you must re-adjust the source data range (see below "Changing the source data range").

The same applies if you add a new row or column to the end of the source data range.

Refresh all pivot tables

If you want to update all existing pivot tables – even with different source ranges – use the ribbon command
Formula | group Update | Update data | Update pivot tables.

Changing the source data range

iOS: The command to change the source data range is not freely available in this version.

If your source data has changed in such a way that it no longer is in accordance with the original source range
of the pivot table (new records have been inserted/added or the file with imported data has been moved), the
referenced data range for the source data must be changed.

To do so, proceed as follows:
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1. Place the mouse cursor in the pivot table report.

2. Choose the ribbon command Insert | group Tables | Pivot table  again.

Alternatively: On the ribbon tab Data | group Analyze | Pivot table or simply by right-clicking in the Pivot
table report with the Modify pivot table areas command from the context menu.

3. A dialog box opens that is similar to the one for creating a new pivot table, with one difference: The Insert
button is called Change here. In addition, the originally referenced source range is marked in blue color
directly in the worksheet with the source data.

4. In the dialog box, enter the new data range in the input field (source range); the previous source range is
offered by default. Alternatively, it is possible to mark the desired source range with the mouse if you have
the worksheet with the source data in front of you. Use the left mouse button to grab the blue mark at the
bottom right corner.

Note: For external data, the adjustment is possible only in the input field (source range).

5. Confirm with the Change button. Before you do this, you can enter in the lower input field whether you also
want to move the target range to another position; the previous target range is offered by default.

Deleting, copying, moving pivot tables

You can also delete, copy and move your created pivot tables. The following paragraphs explain exactly how to
do this.

Tip: To delete, copy or move, it is always necessary to precisely mark the entire area of the pivot table
report. The easiest way to do this is to place the mouse in a cell of the report and use the key combination
Ctrl+A to select it. Or use the ribbon command Home | group Selection | Select all.

Deleting pivot tables

Deleting pivot tables works similarly to the standard procedures for deleting. Note, however, that the pivot table
report must be selected as a whole; individual cells cannot be deleted separately.

So, select the entire pivot table report and use one of the following methods to delete:

§ Press the Del key on the keyboard 

§ Use the ribbon command Home | group Contents | Delete  or open the context menu by right-clicking
with the mouse on the pivot table report and selecting Delete special.

In the submenu of these commands, you can use All or Contents to completely delete the pivot table. Select
the entry Formats if you only want to remove the applied formats from the pivot table.

Copying pivot tables

You can copy pivot tables anytime and duplicate them in the same worksheet to a different position or in a new
worksheet. The copied pivot table will have the same values as the original. Even after you click the Refresh
data button, the copied pivot table adopts changed data from the source table.



174Editing worksheets

In the copied pivot table, however, you still have the opportunity to configure it independently of the copied
original with regard to field arrangement, formatting, etc. This gives you different views of the reports for the
same source data.

Select the entire pivot table report to copy it and proceed according to one of the following methods:

§ Use the ribbon command Home | Copy  and then Home | Paste 

§ Right-click on the pivot table report to open the context menu and select Copy and subsequently Paste

§ Drag the pivot table report with the mouse to the desired position and press the Ctrl key to drop it before
releasing the mouse.

§ Or simply use the key combination Ctrl+C and Ctrl+V

You can now decide which report you want to work on by clicking in the respective pivot table report. The field
list appears corresponding to the selected report.

Moving pivot tables

Select the entire pivot table report and use the left mouse button to drag the selected range to a free position on
the worksheet. Make sure that you do not overlap the source data range.

If you want to move the pivot table report to another worksheet, use one of these options:

§ Choose the ribbon command Insert | group Tables | Pivot table . Alternatively, right click in the pivot
table to open the context menu and select the command Modify pivot table areas. In the dialog box, enter
the target range and the desired worksheet (see Updating pivot tables and changing data range) 

§ Copy the pivot table report as described above, switch to the desired worksheet in an empty space and paste
the copy from the clipboard. Then remove the remaining pivot table report from the former place.

Some restrictive notes on copying and moving source/target range

Copying and moving data ranges – both the source range and the target range (the pivot table report) – is not
fully possible in the same way as you are familiar with from normal tables. The following rules should be
considered:

§ Copy & paste of source range/target range: It is possible to first copy the source range of your data and
paste it to another position, but the pivot table is still referenced to the position of the original source range
and not to the new position. This means that the former cell range is still addressed when the data is
refreshed, and if it has been removed, an error message appears. This restriction also applies if you copy and
paste the source range together with the target range. Copying and pasting only the target range to another
position is possible without any problems.

§ Drag & drop the source range/target range: If you drag the selected source range to another position with
the mouse, the restriction described above does not apply. The pivot data will be referenced to the new cell
range and will be correct addressed when updating the data. Dragging and dropping only the target range or
together with the source range is also possible without any problems.

§ Cut & paste the source range/target range: Cutting is neither possible for the source range nor for the target
range. An error message appears when using this command.

In the following table you can see the options once again clearly summarized:
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Action Source range Target range

Copy & paste û ü

Drag & drop ü ü

Cut & paste û û
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Freezing rows and columns

With the ribbon command View | group Windows | Freeze cells  you can fix the first rows and/or columns
of a table on the screen. As a result, that they no longer move when scrolling through the worksheet, but
permanently stay in place.

This is particularly useful if you have put headings into rows or columns of a worksheet, and want these
headers to stay visible all the time.

Activating freezing

To freeze rows or columns, you can use the following options:

§ Only freeze the top row: Use the small arrow of the icon Freeze cells, and select the entry Freeze top row. It
does not matter which cell you have selected before. 

§ Only freeze the first column: Use the small arrow of the icon Freeze cells, and select the entry Freeze first
column. It does not matter which cell you have selected before.

§ Freeze the top row and first column: Choose the two commands of above one after the other to combine
freezing the top row and the first column.

§ Freeze any number of lines: If you want to freeze the first rows (without freezing columns), proceed as
follows:

In the row header on the far left, select the row directly below the rows you want to fix. Then click directly
on the icon Freeze cells.

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

§ Freeze any number of columns: If you want to freeze the first columns (without freeze rows), proceed as
follows: 

In the column header at the top, select the column to the right of the columns that you want to fix. Then
click directly on the icon Freeze cells.

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

§ Freeze any number of rows and columns: If you want to freeze several first rows and columns, place the cell
frame in the cell right below the area you want to freeze. Then click directly on the icon Freeze cells. 

Alternatively: Use the icon's small arrow and select the entry Freeze at current position.

The rows and/or columns are now frozen. They remain in their original location when you scroll through the
worksheet.

Tip: You can also use the icon  in the bottom-right corner of the document window to freeze rows or
columns. Simply click this icon and then drag it to the desired location.
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Disabling freezing

If you have fixed rows or columns, the icon Freeze cells  is shaded darker to indicate that freezing is
enabled. To disable it, click again directly on the icon itself – the rows/columns are no longer fixed.

Alternatively: Use the icon's small arrow and select the entry Unfreeze cells.

Tip: A single mouse click on the icon  in the bottom-right corner of the document window will also
disable freezing.

An example

Assume you have the following worksheet:

Note that both the columns and the rows are labeled. To freeze the labels, proceed as follows:

§ The column labels (High, Low, etc.) are in the first row of the table. 

To freeze them, select the second row by clicking its row header (the button left of the row, labeled with
"2").

Then select the ribbon command View | Freeze cells.

§ The row labels (10/24, 10/25, etc.) are in the first column of the worksheet. 

To freeze them, select the second column (column B) by clicking on its column header (the button above the
column, labeled with "B").

Then select the ribbon command View | Freeze cells.

§ To freeze both rows and columns, click cell B2 and select the ribbon command View | Freeze cells. 

Tip: Since it is the top row and first column in this example, you might as well use the commands Freeze top
row and Freeze first column by clicking the on the arrow of the icon Freeze cells.

If you want to unfreeze, click on the icon Freeze cells again.
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Inserting special characters
Some characters, such as the copyright sign, the degree sign and the accented characters used in some
languages, cannot be entered into text directly with the keyboard. With PlanMaker, you can easily insert these
special characters via the built-in character table.

To do so, proceed as follows:

1. Open the dialog box via the ribbon command Insert | Symbol  (in the group Text) by clicking directly
on the icon.

Tip: If you click on the icon's arrow rather than directly on the icon itself, a small selection of the last used special characters will
open for quick use. If you click on More, you will open the dialog box again.

2. The dialog box displays all characters available in the currently selected font. You can select a different font
from the dropdown list Font if necessary.

3. You can use the dropdown list Set to jump to a specific section of the character set. For example, you can
select Cyrillic to view the Cyrillic characters (provided the selected font contains such characters).

Note: Many fonts contain only a few of the available character sets. A particularly large reservoir of
characters is available in the standard fonts supplied with your operating system. In Windows, for example,
these include such fonts as Arial, Tahoma and Times New Roman.

4. Select the character to insert with the arrow keys and press Enter¿ or double-click on the character to insert
it into the text.

5. You can now insert more characters in the same way or exit the dialog box with the Close button.

Tip for Windows users: Most versions of Windows include two icon fonts named Symbol and Wingdings.
These fonts contain numerous useful symbols (phone symbols, bullets, etc.).

Using shortcut keys

If you need to insert a special character frequently, you can always give it a shortcut key. The advantage of
doing so is that you can then apply the character very quickly with one press of a key.

To assign a shortcut key to a special character, proceed as follows:

1. Choose the ribbon command Insert | Symbol  to open the dialog box.

2. Select the special character to which you want to assign a shortcut key.

3. Click on the Change button next to the option Shortcut key.

4. Another dialog box appears. In the Press new shortcut key input field, press the desired key combination
(starting with Ctrl or Alt).

We recommend that you always use key combinations that include the keys Ctrl and Shift since they are not
usually assigned. If you press a key combination that is already assigned, its current assignment will be
displayed just below the Press new shortcut key input field. You should then press the Backspace keyÕ
to delete your shortcut key and use a different key combination. Otherwise, you will overwrite the key
combination of another PlanMaker command.
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5. Don't forget: Click on Add to assign this shortcut to the character.

6. Confirm with OK and exit the main dialog box with Close.

From now on, you can insert this special character by pressing the relevant key combination.

Note: The shortcut key only remembers the selected character, but not the selected font.

Inserting special characters via their character code

There is another method for inserting special characters: by typing in its hexadecimal character code (Unicode)
and then pressing the key combination Ctrl+Alt+Shift+X.

If, for example, you type 20AC and then press this key combination, you will get a euro sign € because it has
the character code 20AC in the Unicode character table.

Note: The Unicode value is displayed in the dialog box described above when you click on a special character.

Inserting special characters via Alt + numeric keypad

Here is yet another method for inserting a special character, via its ASCII code: Press and hold down the Alt
key and enter the respective sequence of numbers (only possible via the numeric keypad!). Please also ensure
that the numeric keypad is enabled by pressing the Num key.

If, for example, you type Alt+0128, you will obtain a euro sign € as soon as you release the Alt key.

Note: You can display the ASCII code of a special character in Windows via the search term "Character map".

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work.

Applying selected formatting and special characters via the "Character" icon

The ribbon command Insert | Character  (in the group Text) opens a dropdown menu with some special
formatting and special characters, such as:

§ Soft hyphen / non-breaking hyphen 

§ Non-breaking space

§ En dashes and spaces of different widths and some useful special characters.

Tip: If you click on the icon  on the far right of the character in the dropdown menu, you can assign your
own shortcut key to the character.

For more information on changing the keyboard mapping, see Customizing shortcut keys. You can edit the
shortcut keys for special characters described in this section by selecting the "Characters" entry in the upper left
list Categories in the dialog box.
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Formatting worksheets
You can apply a variety of fonts, colors, shades, borders and other format options to improve the appearance
and readability of worksheets.

In this chapter you will learn everything about designing attractive worksheets. It covers the following topics:

§ Cell size 

To change the cell size, either use the commands of the ribbon tab Layout | group Cells. Alternatively,
simply drag the row header (or column header) using the mouse.

§ Number format 

PlanMaker can display numbers in many different number formats: as plain numbers, rounded to 2 decimal
places, as a percentage, with a currency symbol, as a date or time, in a user-defined format, etc. Use the
commands of the ribbon tab Home | group Number to select the appropriate number format.

§ Borders 

With the ribbon command Home | group Format | Borders you can add borders and lines to cells.

§ Shading 

The background of cells can be shaded. The ribbon command Home | group Format | Shading lets you
apply a variety of colors, shading and patterns to the background of cells.

§ Alignment 

With the commands of the ribbon tab Home | group Alignment you can align cell contents (left-aligned,
right-aligned, etc.) and rotate them.

§ Protection 

Furthermore, you can use the dialog box of the ribbon tab Home | group Alignment  (Protection tab) to
protect cells against changes. See also Sheet protection.

§ Character format 

The commands of the ribbon tab Home | group Character let you specify the character format of cells or
individual characters. This includes settings such as the font, font styles (bold, italics, etc.) and the font
color.

§ Paragraph format (text frames only) 

If you have inserted text frames in the worksheet, you can change the paragraph format (line spacing,
indents, etc.) of the included text. This can be done using the dialog box Paragraph of the ribbon tab Home
| group Alignment  (only available in text frames).

§ Character styles 

You can create character styles that store your favorite character formats. Character styles can be applied to
cells at the push of a button.
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§ Cell styles 

Additionally, you can create cell styles. Both the character format (font, etc.) and the cell format (number
format, borders, shading, alignment and cell protection) can be saved in these cell styles.

§ Document templates 

PlanMaker even lets you create your own document templates. Document templates can include your own
character styles, your own cell styles and any kind of content.

§ AutoFormat 

The command AutoFormat allows you to format a range of cells by applying predefined format schemes.

Note: The command Insert | Table is even more powerful for applying different table styles. See Tables in
worksheets.

§ Conditional formatting 

You can also apply conditional formatting to cells. Conditional formatting will only be applied when a
certain condition is met. This way you can automatically change the appearance of a cell, for example, a cell
is displayed in red color whenever its content is greater than 1000.

§ Input validation 

When you add input validation to cells, only the specified types of values (e.g. only numbers) within the
specified limits (e.g. only values between 10 and 20) will be considered valid in these cells.

§ Format painter 

With the ribbon command Home | group Edit | Format painter you can transfer the formatting of one cell
to other cells quickly using a "brush".

§ Page setup 

The page setup command allows the user to set print options. It includes settings such as paper size and
orientation, margins, headers, footers and other options. Use the ribbon command File | group Print | Page
setup to change these settings.

For more information on these topics in the above order, see the following pages.

Cell size
On the next pages you will learn how to change the size of cells.

Important: If a cell displays hashes (e.g., ########) instead of the cell content, the column is too narrow to
display the cell content. If this happens, simply widen the corresponding column.
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Changing cell sizes via the mouse

Across the top of the table are buttons labeled A, B, C, etc. To the left of the table are buttons labeled 1, 2, 3,
etc.

These so-called column headers and row headers allow you to change the column width or row height using the
mouse:

§ To change the column width, move the mouse cursor to the right border of the corresponding column header.
The mouse cursor will change to a double arrow. Press and hold down the left mouse button and move the
mouse to change the column width. 

§ To change the row height, use the row headers in the same manner.

Changing cell sizes via commands

On the ribbon tab Layout | group Cells you can change the column widths and row heights of your worksheet
via commands.

The command group Cells contains the following entries:

Cell size (width and height)

With the lower field you can define the width of the column. To do this, enter the desired value in the input
field. Alternatively you can use the small arrow keys to increase or decrease the value.

With the field above you can set the height of the row accordingly.

Optimum width (or optimum height)

The Optimum width button sets the width of a column automatically, corresponding to the space required by
the cell contents.

The command can be used in different ways:

§ When you select an entire column and choose this command, the width of the column will be adjusted to the
cell that needs the most space. 
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Tip: The same can be achieved much faster: by simply double-clicking on the column header.

§ When you select some cells within a row and choose this command, only these cells will be used for the
calculation of the optimum column width. 

§ When you select some cells within a column and then choose this command, only these cells will be used for
the calculation of the optimum column width.

§ If a single cell is selected and you choose this command, the column width will be adjusted to the contents
of that current cell.

The height of rows can be changed the same way, using the Optimum height button.

Showing and hiding rows/columns

You can hide rows/columns, so they become invisible. This is useful if their content is not needed at the
moment or should remain hidden.

Tip: If sheet protection is enabled for a worksheet, users will not be able to unhide hidden row/columns in
the worksheet. See also Sheet protection.

You can hide rows/columns as follows:

Using the row header to hide rows

The quickest way to hide rows is using their row header. Row headers are the buttons labeled with the row
number, located left of the worksheet.

For example, to hide row 14, drag the lower border of their row header upwards with the mouse until the row
disappears completely.

The row is now hidden. Instead of its row header, a small triangle is displayed:

To make row 14 visible again, click this triangle.

Alternatively: Right-click on the row header for the context menu. Here you will find the commands Hide and
Show.

Hiding rows using the "Home | Visibility" button

Alternatively, rows can be shown/hidden as follows:

Select the rows to be hidden and choose the ribbon command Home | group Cells | Visibility | Hide rows.
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The selected rows will be hidden.

To make them reappear, select any cell range that the hidden rows and choose Home | group Cells | Visibility |
Show rows.

Hiding columns

Hiding and showing columns works the same way. But instead you use the column headers and the ribbon
commands Home | group Cells | Visibility | Hide columns and Show columns.

Number format
On the ribbon tab Home | group Number you can change the number format of cells.

The number format determines how numbers are represented in these cells. For example, if you enter 12.3456
in a cell and then apply one of the "Currency" number formats to it, it will be displayed with the chosen
currency symbol and rounded to two decimal places (for example, as $12.35).

Note: When you apply a number format that has a fixed number of decimal places, the number will only be
displayed as a rounded value, but still keeps all of its decimal places. To actually round numbers, use
arithmetic functions like the ROUND function.

To change number formats of cells, you can either simply use directly the buttons of the command group
Number or open the dialog box of the command group Number  for additional options.

Applying common number formats directly: Via the buttons of the command group "Number"

Common number formats can be used via the buttons of the ribbon tab Home | group Number.

Here, you have the following options:

§ In the upper expandable list you will find different categories of number formats such as Default, Currency,
Accounting etc. You can apply these directly with a mouse click. For detailed descriptions of the individual
formats, see List of all number formats. 

If you would like to change additional settings, select More in this list to open the dialog box with
additional options (see below).

§ With the icon  you can display a number directly as a percentage (multiplied by 100). Click on this icon
again to return to the default value. 
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§ With the icon  you can quickly convert a number into a currency value, e.g. Dollar. Click again on the
icon for the default value.

§ With the two icons  and  you can easily increase or decrease the number of decimal places (the
numbers will only be displayed rounded, but they actually keep all of their decimal places).

Additional options: Via the dialog box of the command group "Number"

For advanced options (e.g. custom number formats) use the dialog box. To do this, click on the group arrow  in
the bottom right corner of the ribbon tab Home | group Number.

Alternatively: Right click to open the context menu and select the entry  Cell.

In the following dialog box, switch to the Number format tab.

The following settings are available in the dialog box:

§ Category 

Here you can select the desired type of number format. For more information on the individual formats, see
List of all number formats.

§ Format 

Some number formats also have several subtypes to choose from. Select the desired subtype in this list.
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§ Decimal places 

Some formats allow you to specify the number of decimal places to be displayed.

Note: Numbers will only be displayed rounded, but actually are not rounded. However, it still keeps all of its
decimal places.

§ Thousands separator 

Some formats allow you to specify if numbers should be displayed with thousands separators (e.g.,
5,000,000) or without (e.g., 5000000).

§ Negative numbers in red 

Some formats allow you to specify if negative numbers should be displayed in red color.

§ Suppress minus sign 

Some formats allow you to specify if the minus sign of negative numbers should be suppressed.

§ Don't show zero 

Some formats allow you to specify if the content of cells containing the number zero should be suppressed.

When you confirm with OK, the numbers in the selected cells will be displayed in the chosen formatting.

List of all number formats

As described in the previous section, you can use the direct commands of the command group Number on the
ribbon tab Home to choose the number format of a cell, allowing you to specify exactly how numbers entered
in this cell should be displayed. For advanced options, you can also open the dialog box by clicking the group
arrow  in the bottom right corner of the command group Number.

The following number formats are available:

Default

Displays the number just the way it was entered.

More precisely: The number is displayed right-aligned. Apart from that, no further reformatting takes places.
Right of the decimal point, all decimal places that have been entered are shown (with a maximum of five
decimal places).

Example: 42

Real Number

Same as the Default number format, except that you can specify several formatting options (see previous
section, options of the dialog box). For example, you can set the number of decimal places to be displayed.

Example: 42.00
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Note: The number will only be displayed rounded, but actually is not rounded. However, it still keeps all of
its decimal places. To actually round the number, use arithmetic functions like the ROUND function.

Currency

Displays the number with a currency symbol and two decimal places.

Only available via the dialog box: You can select the desired currency from the Currency list box.

Example: 42.00 €

Note: Depending on the country settings of your system, the display may differ.

Accounting

Same as the Currency number format (see above), except that numbers are displayed in accounting format.

The difference to the currency format is that negative amounts have the minus sign in the left cell margin,
separated from the number. Currency symbols are also aligned flush with each other.

Example: -      42.00 €

Note: Depending on the country settings of your system, the display may differ.

Date/Time

Displays the number as date and/or time.

Only available via the dialog box: In the Format list box, various different date and time formats are offered,
depending on your system's regional settings.

Directly via the dropdown list of the command group Number:

§ Short date: The date is displayed in the 11/22/2018 format 

§ Long date: The date is displayed in the Thursday, November 22, 2018 format

§ Time: The time is displayed in the 22:30:00 format

Percentage

Displays the number as a percentage.

Apart from adding a percent sign (%) to the number, the number will also be displayed multiplied by 100. For
example, 0.5 will be displayed as 50%.

Example: 4200%

Scientific

Displays the number in scientific notation.
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Examples: 5E+03 (equals 5 * 10^3, which is 5000)

4.2E-01 (equals 4.2 * 10^-1, which is 0.42)

Fraction

Displays the number as a fraction.

Only available via the dialog box: The format of the fraction can be selected in the Format list box.

Note: The number will be displayed as a rounded value, if necessary. For example, if you choose the format
As halves and enter the number 2.3, it will be displayed as 2 1/2.

Examples: 2 1/2

5 9/10

Boolean

Displays the number as a Boolean value (logical value).

If the number is zero, FALSE will be displayed. If it is any other value, TRUE will be displayed.

Examples: TRUE

FALSE

Text

This number format presents a special case: It forces PlanMaker to treat a number as text – not as a number.

The number will be left-aligned and displayed exactly the way it was entered. As opposed to any other number
format, numbers will not be reformatted on input by any means. Leading zeros will not be removed; dates will
not be reformatted automatically, etc.

This can be useful, for example, when entering numbers with leading zeros (e.g. serial numbers). Normally,
when you enter a number like "00043682" into a cell, PlanMaker will automatically remove the three leading
zeros. If you apply the Text number format to the cell, the leading zeros will persist.

Warning: For compatibility reasons, this number format has been implemented exactly the same way as in
Microsoft Excel. Therefore, it will lead to the same unexpected results in calculations:
When you apply this format e.g. to the cells A1 and A2, the result of the calculation A1+A2 will be the sum
of these two cells. However, the calculation SUM (A1:A2) will return zero. The reason is that, for most
arithmetic functions, text always has the "value" zero!

Custom

Only via the dialog box: Displays the number in a user-defined number format.

For more information, see the next section.
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Working with custom number formats

Whenever required, you can also define and apply your own number formats in the dialog box of the command
group Number on the ribbon tab Home.

Defining and applying a new number format

To create a new user-defined number format, proceed as follows:

1. Select the table cells that you want to apply the new number format to.

2. On the ribbon tab Home | group Number, click on the group arrow  in the bottom right corner to open the
dialog box, and switch to the Number format tab.

3. In the Category list, choose Custom.

4. Click into the edit control below Format.

5. Enter a text string that specifies the desired number format.

For a list of available format codes, see Structure of a custom number format.

6. Confirm with OK.

The number format is created (and also applied to the currently selected cells).

Tip: If you want to create a new number format that is similar to one of the built-in number formats, the
following tip can save you a lot of work: After opening the dialog box, first click on the desired built-in number
format in the Categories list. This will transfer the corresponding format codes into the edit control for the
format codes (step 5.). All you have to do is make your desired changes, and you're done.

Applying a user-defined number format

Once created, a user-defined number format can be applied to as many other cells as you like. Proceed as
follows:

1. Select the desired table cells.

2. Open the dialog box on the ribbon tab Home | group Number  and switch to the Number format tab.

3. In the Category list, choose Custom.

4. In the Format list, all user-defined number formats for the current document are displayed. Choose the
desired format.

5. Confirm with OK.

The number format will now be applied to the selected cells.

Deleting a user-defined number format

If there's a number format that you don't want to keep anymore, you can delete it anytime. Proceed as follows:
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1. Open the dialog box on the ribbon tab Home | group Number  and switch to the Number format tab.

2. In the Category list, choose Custom.

3. In the Format list, choose the format to be deleted.

4. Click on the Delete button.

5. Close the dialog box (preferably using the Cancel button, since clicking OK would apply the currently
selected format to the current cell).

Note: The Delete button is available only for user-defined number formats. You cannot delete any of the built-
in number formats.

Structure of a custom number format

When you create a new number format (as described in the previous section), you have to enter a text string
containing format codes. These codes specify how numbers are displayed.

An example:

#.00

These codes will cause numbers to be displayed as follows: All digits left of the decimal point, then a decimal
point, then exactly two digits right of the decimal point.

In detail, the following format codes are available:

Format codes for numbers and text

For formatting numbers and text, the following format codes can be used:

Code Result

# Display a single digit of the number. Or display nothing in case there is no digit at this position.

Example: #.## applied to the number 1.2 returns 1.2.

0 Display a single digit of the number. Or display a zero in case there is no digit at this position.

Example: #.00 applied to the number 1.2 returns 1.20.

? Display a single digit of the number. Or display a blank in case there is no digit at this position.

Example: #.?? applied to the number 1.2 returns 1.2  (with a blank behind the 2).

Important: If any of the above codes is placed to the left of the decimal point, all digits left of the
decimal point will be displayed. Example: 0.00 applied to the number 123.456 will not return 3.46,
but 123.46.

. (period) Display a decimal separator at this position.

Note: If your system utilizes a decimal separator other than a period (e.g. a comma), use the
corresponding character instead of a period.
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, (comma) Display the number with thousands separators. This code can be placed at an arbitrary position in the
format string: ,0.00 applied to the number 5000000 returns 5,000,000.00.

Note: If your system utilizes a thousands separator other than a comma, use the corresponding
character instead of a comma.

% Display a percent sign at this position and multiply the number by 100.

Example: 0% applied to the number 0.5 returns 50%.

E+ or e+ Display the number in scientific notation.

Example: 0E+00 applied to the number 50000 returns 5E+04.

Tip: Engineering notation (using only exponents that can be divided by 3) is also available. For
example, #00E+00 applied to the number 50000 does not return 5E+04 but 50E+03.

E- or e- Same as E+, except that the exponent's sign is only displayed if it is negative. Example 1: 0E-00
applied to the number 5000 returns 5E03.

Example 2: 0E-00 applied to the number 0.005 returns 5E-03.

General Placeholder for the entire cell content (formatted with the number format "Default").

@ Placeholder for the entire cell content as text.

\ Do not try to interpret the following character, just display it.

Example: To output a # character, use the code \# (since the # sign is a valid format code).

"Text" Do not interpret the text between the quotation marks, just display it.

Example: "MyText"

* (asterisk) Repeat the following character. For example, *x fills the entire cell with the character "x".

Example: The format codes "Total:"* 0.00 display the text "Total:" at the left of the cell and the
number (with two decimal places) at the right. The space in-between is filled with blanks.

_ (underscore) Display a blank space that is as wide as the following character.

Example: _- returns a blank space that is exactly as wide as a minus sign.

[Red] Display the cell content in red color. Other color codes available:

[Black] [White] [Red] [Green] [Blue] [Cyan] [Magenta] [Yellow]

Format codes for dates and times

For dates/times, only the following format codes are valid:

Note: The format codes listed below are case-sensitive!

Code Result

D Day (1-31)

DD Day, with 2 digits (01-31)
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DDD Name of day, abbreviated ("Su" to "Mo")

DDDD Name of day ("Sunday" to "Monday")

M Month (1-12)

MM Month, with 2 digits (01-12)

MMM Name of month, abbreviated ("Jan" to "Dec")

MMMM Name of month ("January" to "December")

MMMMM Name of month, first letter only ("J" for January to "D" for December)

YY Year, with 2 digits (e.g., 18)

YYYY Year, with 4 digits (e.g., 2018)

Q Quarter (1-4)

QQ The word "quarter" in the language set in the system's regional settings

h Hour (0-23)

hh Hour, with 2 digits (00-23)

m Minute (0-59)

mm Minute, with 2 digits (00-59)

s Second (0-59)

ss Second, with 2 digits (00-59)

0 Tenths of a second (e.g., hh:mm:ss.0)

00 Hundredths of a second (e.g., hh:mm:ss.00)

000 Thousandths of a second (e.g., hh:mm:ss.000)

AM/PM Display times in 12-hour format (with AM or PM). Has to be placed at the end of the format codes!

Example: h:mm:ss AM/PM

am/pm Same as AM/PM, but with am or pm (lower case)

a/p Same as AM/PM, but with a or p

[h] Number of hours in "endless" time format*

[m] Number of minutes in "endless" time format*

[mm] Same as [m], but with 2 digits*



193Formatting worksheets

[s] Number of seconds in "endless" time format*

[ss] Same as [s], but with 2 digits*

[$-n] Optional: Allows you to specify the regional code of the language to be used for day and month
names. If no regional code is given, PlanMaker uses the system's default language. Example: [$-409]
represents English (US).

* The "endless" time format distinguishes itself from other time formats by its feature of not setting the time back to 0:00 after 24 hours. This is useful
for calculations with times. For example, when you add 20:00 and 5:00, the result would normally be 1:00. But if you format this calculation as
[h]:mm, the result will be 25:00.

The endless time format also supports negative time values. For example, 7:00 - 10:00 does not result in 21:00, but in -3:00.

The same applies to minutes and seconds, which are also not reset after 60 minutes/seconds. You can even use the endless time format to convert times
to minutes or seconds. For example, when you format 02:00:00 as [mm]:ss, 120:00 will be displayed. When you format it as [s], 7200 (the number of
seconds) will be displayed.

Defining separate sections for positive numbers, negative numbers, zero and text

You can split the text string that defines a number format into up to four sections (separated by semicolons).
This allows you to define different formats for positive numbers, negative numbers, the number zero and text –
as follows:

Positive; Negative; Zero; Text

The number of sections that you include has the following effect:

Number of sections Effect

Just 1 section: The format codes apply to all values.

2 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

3 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

The codes in the 3rd section apply to the number zero.

4 sections: The codes in the 1st section apply to positive values.

The codes in the 2nd section apply to negative values.

The codes in the 3rd section apply to the number zero.

The codes in the 4th section apply to text.

Example (with two sections):

0.00; -0.00[Red]

This number format has the following effect:

1st section: 0.00 causes positive numbers to be displayed with two digits after the decimal point.
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2nd section: -0.00[Red] causes negative numbers to be displayed with two digits after the decimal point as well.
A minus sign is displayed in front of the number (see note!). Additionally, the number is colored in red.

Note: When you define a number format with two (or more) sections and you want negative values to be
displayed with a minus sign, you must include a minus sign in the section for negative numbers.

The reason is that, as opposed to number formats with just one section, minus signs will not be displayed
automatically for number formats with multiple sections.

Defining separate sections using conditions

Alternatively, you can split the text string that defines a number format into multiple sections by specifying a
condition for each section.

The individual sections must by separated by semicolons. To specify the condition for a section, simply type in
the desired comparison, enclosed in square brackets – for example comparisons like [>0] or [>=100] or [=42].

You can define up to two sections that contain a condition. After these sections, an additional section that
defines the number format for those values that don't match the condition should be specified.

An example:

[<=0][Blue]0.00; [>30][Red]0.00; 0.00

These format codes display all values smaller than or equal to zero in blue – and values larger than 30 are
displayed in red. Values not matching any of these two criteria are not colorized; they are displayed in black.

Tip: "Conditional formatting" provides a much more convenient and powerful way to perform such tasks.
See Conditional formatting.
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Borders
With the ribbon command Home | group Format | Borders you can completely surround cells with borders or
add single lines to cells. Gridlines (the lines between the cells) can also be applied here.

Common border lines: Via the icon of the command group "Format"

A selection of common border lines can be found via the icon Borders  under Home | group Format.

Proceed as follows:

1. Select the desired cells.

2. Click on the icon's arrow for the dropdown menu and select an entry with the desired properties by clicking
on it.

Note: You can also combine individual lines to your liking by reopening the dropdown menu of the Borders
icon and adding another attribute, for example, first positioning a line at the top and then an additional line
at the bottom.

The table cells are now provided with the relevant lines.

Tip: If you then want to add exactly the same type of border to other cells, simply select them and click on the icon itself (not the arrow).
PlanMaker will then reapply the most recently selected type of border.

Removing border lines: Click on None in the dropdown menu. All border lines will then be completely
removed.

If you want to edit/remove individual border lines or define additional properties for borders and lines, click on
Borders in the dropdown menu. A dialog box opens with other options (see below).

Other options: Via the dialog box

For additional options, such as the color or different thickness of lines, there are various options available in the
dialog box.

You open the dialog box by clicking on the arrow of the icon  and selecting Borders in the dropdown
menu.

Alternatively: On the ribbon tab Home | group Alignment, click on the group arrow  and switch to the
Borders tab.
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Essentially, you use this dialog box as follows:

1. First, you specify what type of border line you want to apply (line style, thickness, color).

2. Then specify where this type of border line should be placed. To do so, simply click on the desired lines (or
their buttons) in the right half of the dialog box.

Let's take a closer look at the individual steps:

For example, to add border lines to cells, proceed as follows:

1. Select the desired cells.

2. On the ribbon tab Home | group Alignment, click on the group arrow  for the dialog box and switch to the
Borders tab.

3. First, specify what type of border line you want to apply. You have the following options:

Line style (single, double or dashed lines)

Thickness of the line

Color of the line

Note: In addition to the colors offered here, you can define new colors at any time. For more information, see Document properties,
Colors tab.

4. Then specify where you want to apply this type of border line (top, bottom, left, right, etc.).
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For this purpose, a preview box surrounded by a set of buttons is available in the right half of the dialog box.
Use it as follows:

A. In the preview in the right half of the dialog box, simply click directly on all lines to which a border line
is to be applied. 

B. Alternatively, you can use the buttons that are displayed to the left and below the preview for this
purpose. Each button represents a specific line (see icon on the button).

C. The buttons above the preview are useful shortcuts:

The Outline button applies the currently set border line to all outer borders.

The Inside button does the same for all inner lines (the "gridlines" between the cells).

The None button removes all lines at once.

5. Add as many lines as you like by simply repeating step 4.

Of course, you can always change the line style, thickness or color (step 3) before applying it (step 4).

6. When everything is as required, confirm with OK.

The table cells are now provided with the relevant lines.

Editing or removing existing border lines in the dialog box

You can change the style, thickness or color of existing border lines or also remove them at any time. To do so,
open the dialog box again and proceed as follows:

§ Changing: To change the appearance of a line, first select the desired settings (style, thickness, color). Then,
in the preview, click on the line (or its button) to which you want to apply these settings. 

§ Removing: To remove a border line, click on that line (or its button) twice in the preview. Clicking once
applies the border line, while clicking it again removes it. 

Tip: The None button displayed above the preview removes all lines at once.

Shading
With the ribbon command Home | group Format | Shading you can apply a colored shade or fill pattern to
cells.

Applying directly via the icon of the command group "Format"

If you click on the small arrow next to the icon  Shading, the program will open a dropdown menu with
Standard colors and Color variations. You can apply these directly to the selected cells by hovering over the
colors with the mouse cursor (you can see the effect on the cell in the preview) and then clicking on the desired
color.

Tip: The last selected color is displayed in the icon as a small horizontal bar. If you want to apply the same color to other cells, simply
select them and click on the icon itself (not the arrow). PlanMaker will then reapply the last selected color.
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This also applies to other shading settings, such as Patterns or Shades, which you can only find in the dialog box. You open the dialog
box by clicking on the icon's arrow and choosing More. Detailed information on the options of the dialog box can be found below.

Removing shading: Click on Transparent in the dropdown menu to remove existing shading.

Other options: Via the dialog box

The dialog box contains additional shading options. The option Shades allows you to mix colors individually,
and you can also apply different Patterns in the dialog box.

You open the dialog box by clicking on the arrow of the icon  and choosing More in the dropdown
menu.

Alternatively: On the ribbon tab Home | group Alignment, click on the group arrow  and switch to the
Shading tab.

Proceed as follows in the dialog box:

1. Select the desired cells.

2. On the ribbon tab Home | group Alignment, click on the group arrow  for the dialog box and switch to the
Shading tab.

3. Apply the desired shading (see below).

4. Confirm with OK.

You can choose between the following types of shading:
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§ Adding a shade 

A shade is a color shading that is mixed from the selected foreground color and background color.

To add a shade, set the Type to Shading and then make the desired settings:

First, set the desired Foreground and Background colors. (The background color is set to white by
default.)

In the section Shades, different mixtures of these two colors are now offered. Select one of these
suggestions. Alternatively, you can enter an exact percentage for the shade in the input field under Shading.
Values between 0 (100% background color) and 100 (100% foreground color) are allowed.

§ Adding a pattern 

To add a pattern, click on one of the patterns in the section Patterns.

You can also select a different Foreground and Background color for the pattern.

§ Removing a shade or pattern 

If you want to remove existing shades or patterns, select None for Type.

Then confirm with OK.

Alignment
On the ribbon tab Home | group Alignment you can specify the alignment of the cell contents within the cell.

Before you execute the commands, you must first select the desired cells. To change a single cell, simply
navigate to it.

Then, proceed as follows:

Aligning directly via the icons of the command group "Alignment"

Most of the options for aligning cell contents can be applied directly via the icons on the ribbon tab Home |
group Alignment.

The following functions are available here:

Icon Function

Top vertical alignment: Align the cell content to the top edge of the cell.
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Centered vertical alignment: Align the cell content vertically to the center.

Bottom vertical alignment: Align the cell content to the bottom edge of the cell.

Justified vertical alignment: The cell content is evenly distributed between the top and bottom cell border (only
affects cells that contain multiple lines of content and have the option Wrap text enabled).

Rotate: Here you can rotate the entire cell (including its contents) by the selected angle. The command Stacked
corresponds to the option Vertical text in the dialog box (see below): The cell contents are not read from left to
right, but from top to bottom (to disable it, click Stacked again).

Wrap text: The cell content will automatically be wrapped to the next line if it does not fit into a single line.

Merge cells: Lets you merge a cell with its neighboring cells. Merged cells are treated by PlanMaker as if they
were one single cell. To do so, select the cell and any number of directly adjacent cells and click on the icon itself
to merge the cells.

Note: Whenever you merge cells, the content of all selected cells is automatically deleted – except for the cell in
the upper left corner of the selected range.

To disconnect merged cells, click on the icon again.

If you click on the icon's arrow, you can choose from various options of merging cells:

Merge cells: Corresponds to clicking on the icon itself, all cells are merged normally.

Merge and center: The selected cells are merged and the cell content is centered horizontally over several
columns (vertically at the bottom).

Merge and turn on line wrap: Cells are merged while wrapping the cell contents in the created merged cell.

If you selected cells across several columns, you can choose between the commands Merge by line or Merge by
column to merge the selected cells to only one column or only one row.

In addition, you can also disconnect merged cells from here using the Split cells entry.

Default horizontal alignment: Text is left-aligned, numbers are right-aligned. Logical values and error values are
centered.

Left horizontal alignment: Align the cell content to the left edge of the cell

Centered horizontal alignment: Align the cell content centered

Right horizontal alignment: Align the cell content to the right edge of the cell

Justified horizontal alignment: The cell content is evenly distributed between the left and right cell border (only
affects cells that contain multiple lines of content and have the option Wrap text enabled)

Most of these options can also be found in the dialog box of the command group Alignment (see below). In
addition, the options enabled via the direct ribbon commands are displayed in the dialog box as both enabled.
For example, if the ribbon command Wrap text is enabled for a cell, a check mark also appears in the dialog box
in front of the option Wrap text.
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Shortcut keys

There are also shortcut keys for horizontal alignment:

Command Windows/Linux Mac

Left align Ctrl+L Cmd+L

Center Ctrl+E Cmd+E

Right align Ctrl+R Cmd+R

Justify Ctrl+J Cmd+J

Aligning via the dialog box of the command group "Alignment"

You open the dialog box on the ribbon tab Home by clicking on the group arrow  in the bottom right corner of
the command group Alignment. In the dialog box you will find additional options that cannot be set directly via
the icons of the command group Alignment as described above (e.g. Inner margins).

The dialog box provides the following options on the "Alignment" tab:
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Horizontal alignment

Determines the horizontal alignment of the cell content within the cell boundaries:

Default: Text left-aligned, numbers right-aligned, and logical values and error values centered

Left: Align the cell content to the left edge of the cell

Centered: Align the cell content centered

Right: Align the cell content to the right edge of the cell

Justified: The cell content is evenly distributed between the left and right cell border (only affects cells that
contain multiple lines of content and have the option Wrap text enabled)

Center across columns: The content of one cell is centered across multiple columns. Select the cell with the
content and an arbitrary number of cells right of it beforehand (these cells have to be empty!). Then select the
Center across columns alignment.

Vertical alignment

Determines the vertical alignment of the cell content within the cell boundaries:

Bottom: Align the cell content to the bottom edge of the cell

Centered: Align the cell content vertically to the center

Top: Align the cell content to the top edge of the cell

Justified: The cell content is evenly distributed between the top and bottom cell border (only affects cells that
contain multiple lines of content and have the option Wrap text enabled).

Rotate by ...

Here you can rotate the entire cell (including its contents) by the selected angle.

Text direction

For text in Arabic script, you can change the text direction of the cell to right-to-left here. If you choose the
default setting Context sensitive, PlanMaker determines the correct writing direction automatically.

For more information, see also Working with Arabic text.

Inner margins

Lets you modify the inner margins of cells.

Line break

If this option is enabled, the cell content will automatically be wrapped to multiple lines, if it does not fit into a
single line.

By default, this option is disabled.
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Tip 1: You will also find this option via the context menu by right-clicking on a selected cell.

Tip 2: You can use the key combination Ctrl+¿ to wrap to the next line manually.

Vertical text

If this option is enabled, the cell content will be displayed vertically (top to bottom instead of left to right).

Merge cells

Lets you merge a cell with neighboring cells. To do so, select the cell and any number of directly adjacent cells
and activate this option.

Merged cells are treated by PlanMaker as if they were one single cell.

Note: Whenever you merge cells, the content of all selected cells is automatically deleted – except for the
cell in the upper left corner of the selected range.

To disconnect merged cells, select them again and disable this option.

Protection
On the Protection tab of the dialog box Cell you can prevent cells from being changed, to hide the cell content
or formula, or to disable printing.

Open the dialog box by clicking on the group arrow  in the bottom right corner of the ribbon tab Home | group
Alignment (or group Number). Switch to the Protection tab.

Alternatively, open the dialog box by right-clicking on the selected cells for the context menu and select the
Cell entry.

For more information, see Sheet protection.

Character format
With the commands on the ribbon tab Home | group Character you can change the character format (such as
font, font size, font color, text styles, etc.).

Before choosing one of these commands, you can select the text that you want to change, as follows:

§ To change the character format of a single table cell, simply navigate to it – without selecting. 

§ To change multiple cells, select them before executing this command.
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§ If you press F2 and select just parts of the cell content, only the selected characters will be changed.

Common commands: Via the icons of the command group "Character"

Frequently used settings can be made directly via the icons of the command group:

§ Font and font size 

§ Text styles (bold, italic, underlined)

§ Font color

Additional options: In the dialog box of the command group "Character"

If you click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character, the
program opens a dialog box in which you will find additional options for character formatting.

The displayed dialog box has three tabs that you can switch between by clicking on one of the tab headers.
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The following format options are available on the tabs:

§ Font tab 

For selecting properties like Font and font size, Text styles (bold, italic, underlined, etc.), Font color (and
background color)

§ Spacing tab 

For changing properties like Superscripts and subscripts, Letter spacing and character pitch, and
enabling/disabling Kerning

§ Hyperlink tab 

For inserting and editing hyperlinks (for example, to web pages). For more information about this topic, see
Working with links.

See the following pages for detailed information on formatting.

Font and font size

To change the font or font size, see the commands on the ribbon tab Home | group Character. Proceed as
follows:

Via the buttons of the command group "Character"

1. Select the cells or the text segment to be modified.

Android/iOS: If you are using these versions, please note that selecting cell contents there works slightly
differently. For more information, see Selecting cells and cell content.

2. Click on the small arrow to the right of Font or Font size.

3. Set the desired font and font size:

Font: Select the desired font from the dropdown list via a mouse click.

Font size: The dropdown list offers the most common font sizes, which you can select via a mouse click.
However, you can enter a different size manually at any time. Font sizes can be entered with a precision of a
tenth of a point – thus font sizes such as 12.7 are also allowed.
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Tip: The icons  in the group Character can be used to increase or decrease the font size by one
level.

In the dialog box of the command group "Character"

If you only want to change the font and font size, these options in the dialog box are exactly the same as the
buttons described above. Thus, it is only advisable to use the dialog box if you also want to use other character
formatting options that are not available as buttons.

On the ribbon tab Home | group Character, you open the dialog box via the group arrow  in the lower right
corner and select the Font tab in the dialog box.

Text styles

Text styles are character formatting options such as bold, italics, etc.

PlanMaker offers the following text styles:

§ Italic: A slanted variant of the font. 

§ Bold: A stronger ("more pronounced") variant of the font.

§ Underline: The text is underlined (single, double, words only single, words only double, etc.).

§ SMALL CAPS: Smaller uppercase letters are used instead of lowercase letters.

§ ALL CAPS: All letters are output as uppercase letters.

§ Strikethrough: The text is struck through.

§ Superscripts and subscripts: for example, r2 and H2O. For more information, see Superscripts and

subscripts.

Note: The 4 latter options are only available via the dialog box of the command group "Character" and not directly via the icons of
the command group.

Common commands: Via the icons of the command group "Character"

The most common text styles can be applied on the ribbon tab Home | group Character directly via the icons
of the group.

To apply text styles, proceed as follows:

1. Select the desired text.
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2. Click on the icon for the text style you would like to enable oder disable: The B stands for bold, the I for
italics and the U for simple underlining.

Text styles can be combined (almost) as desired.

Other options: Via the dialog box of the command group "Character"

For additional text styles that you cannot find via the buttons (e.g. SMALL CAPS), open the dialog box.

On the ribbon tab Home | group Character, click on the group arrow  in the bottom right corner and switch to
the Font tab in the dialog box.

§ In the area Styles, you will find small caps, all caps and strikethroughs. These can be enabled or disabled
there via a simple mouse click. 

§ In the area Underline, you can use the dropdown list to select between different options for underlined text.

§ To enable bold and/or italics, open the dropdown list Style (to the right of font size) and select the desired
entry: Regular, Italic, Bold or Bold Italic. 

Shortcut keys

There are also shortcut keys for some text styles:

Command Windows/Linux Mac

Bold Ctrl+B Cmd+B

Italic Ctrl+I Cmd+I

Underline Ctrl+U Cmd+U

Font color

You can change the color of the text itself or highlight its background.

The commands for this can be found on the ribbon tab Home | group Character.

Font color: Via the icon of the command group "Paragraph"

For the Font color , proceed as follows:
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1. Select the desired cells or the desired text and click on the small arrow to the right of the icon (i.e. not on the
icon itself).

2. Select the desired color from the dropdown menu.

Tip: To format more text in the same color, select the text and then click on the icon itself because the last
color used will be applied again.

The Font color can be found both as a direct button in the command group and in the dialog box. The
Background color, however, you can only change via the dialog box (see below).

Background color: In the dialog box of the command group "Character"

As far as only the font color is concerned, the selection in the dialog box corresponds exactly to the button
described above. However, in addition to the font color, you can also change the background color in the
dialog box.

Proceed as follows:

1. Select the cells or the text segment to be modified.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character. In the
dialog box, switch to the Font tab.

3. Open the dropdown list Background color and select a different color instead of the default Transparent.

The text is highlighted with this color.

Tip: If you change the background color this way, it only affects the single characters within the cell. If you
want to color the entire cell, you should use the ribbon command Home | group Format | Shading instead.

Notes

Color lists only offer a few standard colors, but you can always compose your own colors. To do so, click on
the entry Define color... at the end of the dropdown list. (For more information, see also Document properties,
Colors tab.)

Superscripts and subscripts

You can also superscript characters (e.g. r2) or subscript characters (e.g. H2O). The commands for this can be

found in the dialog box of the ribbon tab Home | group Character.

Proceed as follows:

1. Select the cells or the text segment to be modified.

If you press F2 and select just parts of the cell content, only the selected characters are changed.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Character.
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3. In the dialog box, switch to the Spacing tab.

Enable the Superscript or the Subscript checkbox.

If desired, you can specify the amount of offset above or below the baseline by entering a percentage in the
Position edit box. You can also use a percentage in the field Size to determine how much the font size should
be reduced. For example, enter 100 percent if you do not want the font to be reduced.

Letter spacing and character pitch

In PlanMaker, you can even change the spacing and character pitch.

Letter spacing is the horizontal distance between characters. If values are less than 100%, the characters are
closer together. For values greater than 100%, the characters are further apart.

Changing the character pitch changes the width of the characters themselves rather than the distance between
them, thus the characters are distorted.

To change these settings, click on the group arrow  in the bottom right corner of the ribbon tab Home | group
Character. In the dialog box, switch to the Spacing tab and enter the required values for Letter spacing or
Character pitch.

Note: Some printers do not support changing the character pitch for internal printer fonts. The font then
appears wider or narrower on the screen, but not on the printout.

Kerning

Certain pairs of letters look better when the spacing between these letters is reduced or increased a bit. Such
adjusting is known as kerning.

The following figure illustrates what is meant by kerning:

Above: without kerning. Below: with kerning

The upper text (without kerning) shows that the letters "V" and "A" are usually too far apart. This was
corrected for the lower text (with kerning).

This adjusting occurs fully automatically. All you have to do is enable kerning:
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1. Select the cells or the text segment to be modified.

2. On the ribbon tab Home | group Character click on the group arrow  to open the dialog box and switch to
the Spacing tab.

3. Enable the option the Use kerning.

PlanMaker now automatically adjusts the spacing between all letters where this would improve the text
appearance.

Note: Not all fonts provide kerning information in their font data, which is required to determine which letter
pairs to adjust and how. Almost all font collections published by SoftMaker include extensive kerning
information.

Resetting the character formatting

PlanMaker allows you to remove character formatting at any time. To do so, proceed as follows:

1. Select the cells or the text segment to be modified.

2. On the ribbon tab Home | group Contents | Delete , choose the command Reset character formatting.

PlanMaker now removes any character formatting that you have applied via the dialog box or the buttons on the
ribbon tab Home | group Character.

Note: In the dialog box of the ribbon tab Home | group Character , you will also find a Reset button on each
tab. However, the use of this button differs from the above function: You can only use it to undo all changes
made in the open dialog box provided that you have not yet confirmed them with OK.

If the changes have already been confirmed with OK, they can only be undone via the Reset character
formatting icon described above.

Paragraph format (text frames only)
If you have inserted text frames in the worksheet, you can change the paragraph format (line spacing, indents,
etc.) of the included text. For this purpose, use the commands of the ribbon tab Home | group Alignment.

Note: The "Paragraph" dialog box, which appears by clicking on the group arrow  on the ribbon tab Home |
group Alignment, is only available in text frames. For general information on working with text frames, see
Text Frame.

Paragraph formats include the following options:

§ Paragraph indents 

§ Line spacing
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§ Paragraph alignment

§ Spacing above/below a paragraph

§ Hyphenation frequency (see Hyphenation)

For more information on these topics in the above order, see the following pages.

Paragraph indents (text frames only)

Note: Paragraph indents can be applied only to text placed in a text frame. To indent text in table cells, you
can use the option Inner margins on the Alignment tab when you open the dialog box of the ribbon tab
Home | group Alignment . Please note: a different dialog box will open depending on whether you are in a
text frame or in a table cell.

You can use indents to change the left and right margins of paragraphs in text frames to move text in or out.
The indent for the first line of a paragraph can be specified separately.

To use indents, select the desired paragraphs in the text frame. Then open the dialog box by clicking on the
group arrow  of the ribbon tab Home | group Alignment.

Alternatively, open the dialog box by right-clicking on the selected text, and select the entry Paragraph.

In the section Indents you can set the Left indent, the Right indent and the First Line indent of a paragraph.
Enter the desired values here. The First line indent can be either positive or negative.

Line spacing (text frames only)

Note: Line spacing can be applied only to text placed in a text frame.

Line spacing determines the spacing between the individual lines of a paragraph in a text frame.

To change the line spacing, proceed as follows:

1. Place the text cursor in the desired paragraph of the text frame (or select several paragraphs).

2. Open the dialog box by clicking on the group arrow  of the ribbon tab Home | group Alignment.

You will find the options for changing the line spacing in the section Line spacing:

3. First, use the dropdown list to select the method you want to use to specify the line spacing (see below).

4. Then enter the spacing in the edit box to its right.

When you confirm with OK, the line spacing will be changed according to your settings.
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Methods of specifying the line spacing

In the dropdown list Line spacing, you can choose which method to use to define the line spacing.

The list has the following entries:

§ Single: Automatic single line spacing 

Here, the optimum line spacing is determined automatically:

If you increase the font size in the paragraph, the line spacing will be increased accordingly.

If you decrease the font size, however, the line spacing will be decreased automatically.

§ Multiple: Multiple automatic line spacing 

This corresponds to the option Single and thus also provides automatic line spacing. However, you can
simply increase or decrease line spacing if necessary by specifying the desired number of lines in the input
field to the right of this option.

Some examples:

Enter "1.5" for lines to obtain one and a half times the automatic line spacing.

Enter "2" to get twice the automatic line spacing.

Enter "1" to get automatic single line spacing (corresponds to selecting the option Single).

§ Exactly: Exact line spacing 

Here, you can set the line spacing to an exact value in points. Here, the line spacing will not be
automatically adjusted to the font size.

§ At least: Automatic line spacing with a given minimum 

This setting corresponds to the option Single, but prevents any reduction below the specified minimum
value.

Thus if you enter 12 points as the minimum value, the program uses automatic single line spacing by default.
If the automatic line spacing is less than 12 points (because you are using a very small font size), an exact
line spacing of 12 points is used instead.

By default, the line spacing is set to Single.

Paragraph alignment (text frames only)

On the ribbon tab Home | group  Alignment, you can also change the alignment of text paragraphs inserted into
a text frame.

The following ways of paragraph alignment are available:

§ Left align 
§ Center
§ Right align
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§ Justified (evenly distributed between left and right margin)

You can adjust the paragraph alignment directly using the icons under Home | group Alignment:

Or you can use the path via the dialog box by clicking on the group arrow  under Home | group Alignment. In
the open dialog box, you will find the corresponding commands in the Alignment list.

Changing the text direction (for Arabic script)

For text in Arabic script, there is an additional option called Text direction, which allows you to change the
text direction of the paragraph to right-to-left. For more information, see also Working with Arabic text.

Spacing above/below a paragraph (text frames only)

Note: Paragraph spacing can be modified only for text placed in a text frame. To change the spacing between
cells, simply change their row height.

In addition to line spacing, you can also define for text in text frames how much space should be kept above the
first line and below the last line of a paragraph.

To do so, open the dialog box by clicking on the group arrow  of the ribbon tab Home | group Alignment. The
following options are available in the Paragraph spacing section:

Option Function

Before Here, you can set the spacing that is to be kept free to the last line of the previous paragraph.

After Here you can set the spacing that PlanMaker should kept free to the beginning of the next paragraph.

Note: These values do not affect the amount of space between lines within a paragraph (see Line spacing).
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Character styles
You can use the command Character style, which can be accessed via the context menu, to create and modify
"character styles".

In a character style, you can save a frequently needed character format (font, font size, text styles, etc.) and
then apply it repeatedly to any characters or entire cells you like.

If, for example, you want to print small print sections in a different font and smaller size regularly, simply
create an appropriate character style – lets call it "Small print" – and apply the style to those sections.

Note: In PlanMaker you can also apply cell styles (see Cell styles). The difference to character styles is that
character styles store the character format only, whereas cell styles store both character format and cell format
(number format, alignment, borders, etc.). Furthermore, character styles are also applicable to individual
characters within a cell, while cell styles are applicable only to entire cells.

For more information, see the following pages.

Creating character styles

To create a new character style, proceed as follows:

1. Double-click on a cell (alternatively: press F2).

2. Right-click to open the context menu and select the entry Character style.

3. A dialog box opens. In the list on the left side, select the style on which you want your new character style to
be based. In the event of doubt, use the "Normal" style.

Note: The style of the character in which the text cursor was located before choosing the command Character style is always
preselected here in the dialog box. For more information, see "Based on" character styles.

4. Then click on the New button.

5. Give the character style whatever name you like and confirm with OK.

6. A dialog box will be displayed, which is very similar to the dialog box from the ribbon tab Home | group
Character . Here, you can specify the desired character format for this style (see Character format).

7. When all the desired settings have been made, click on OK to define the style.

8. Exit the dialog box "Character style" with Close.

The new character style is now defined and ready for use. To learn how to apply character styles, see the next
section.
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Using shortcut keys

If you need a style frequently, you can assign it a shortcut key at any time. The advantage of this is that you can
then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, proceed as follows:

Perform steps 1. to 5. as described above. In the dialog box on the Style tab, position the text cursor in the
Shortcut key input field and press the desired key combination (starting with Ctrl or Alt).

Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even one
of PlanMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since these are not
usually assigned.

Applying character styles

To apply a character style, proceed as follows:

1. Double-click on the cell and select the desired characters within the cell.

2. Right-click to open the context menu and select the entry Character style.

3. In the dialog box, select the desired style.

4. Click on Apply.

The formatting of the selected characters immediately changes to that which you specified in the character
style.

Tip 2: If you have assigned a shortcut key to the style, you can apply the style even faster: Select the desired
cell contents and press the assigned key combination.

Changing character styles

Of course, you can change character styles at any time.

Important: When you change the formats stored in a character style, all cells using this style are changed
accordingly. However, this automatic reformatting is limited to characters where you manually changed the
formatting after assigning the style (see next section).
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To change a character style, proceed as follows:

1. Double-click on a cell.

2. Right-click to open the context menu and select the entry Character style.

3. Click on the Edit button in the dialog box.

4. Make the desired changes to the style.

5. Click on OK.

6. Exit the dialog box with Close.

Deleting or renaming character styles

The Delete button in the dialog box of the command Character style, deletes the selected style in the current
document. To give a style a new name, click on Rename and type the new name. This also affects only the
current document.

Note: After you delete a character style, the formatted characters retain their formatting. These characters are now directly assigned the
character style on which the deleted style was based. For more information, see "Based on" character styles. Those formatting options
that were explicitly set in the deleted style and now remain to the characters of the document are treated as if the characters were
formatted manually – and are thus retained even if the style was changed.

Deleting or renaming character styles in a document template

To delete or rename the styles in a document template, open the document template, make the changes there
and save the template.

Scope of character styles

Did you change a character style and nothing happened in some places that were assigned this style? This
happens because these sections of text were subsequently reformatted manually.

An example:

Let's assume that you define a style with the Arial font and apply it. If, for example, you now change the style's
font to Times New Roman, all characters that are formatted in this style will change accordingly.

However: If you subsequently selected a completely different font for some of these characters via the
command group Home | Character, the change to the character style no longer affects these characters. That is
to say, manually applied character formatting takes precedence over styles.

If you want the affected characters to be "freed" from their manual formatting, choose the command Reset
character formatting on the ribbon tab Home | group Contents | Delete. The characters now have the
formatting specified in the character style again.



217Formatting worksheets

"Normal" character style

The character style called "Normal" is present by default in every document and has a special significance: it is
the default style for all cell contents. When you start typing something in a new document, the "Normal"
character style is automatically used for it.

If you change the "Normal" character style – for example, the font – the font for all cells will be changed
(except for cells that you have formatted manually in a different font via the command group Home |
Character). Furthermore, subsequent entries will appear in this default font which you have redefined as the
"Normal" character style for the document.

"Based on" character styles

When you create a new character style, as described at the beginning of this chapter, it is usually based on the
"Normal" character style. This means that the new character style is based on the formatting of the "Normal"
style. Changes to the formatting of the "Normal" style thus affect all other styles.

If you have already created character styles and used them in the document, the following happens when you
choose the command Character style: In the list on the left side of the dialog box, the style of the currently
selected character is selected – this may be the "Normal" character style or another one – and is thus also preset
as the basis for a new style. In the list, change the style that you want to use as the basis for a new character
style, if necessary, before clicking the New button.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

If, for example, you select a new font for the "Normal" style, the font will also change in all other character
styles – unless a different font was explicitly selected there.

In addition, you can reassign the style basis to a character style at any time with the option Based on.

To have a character style based on a style other than the one you previously selected, proceed as follows:

1. Double-click on a cell.

2. Right-click to open the context menu and select the entry Character style.

3. In the list on the left side of the dialog box, select the character style whose basis you want to change and
click on the Edit button.

4. In the following dialog box, switch to the Style tab.

5. Important: In the dropdown list Based on, select the style basis to which the selected character style is to be
linked.

6. You can now also change the desired formatting of the character style, etc.
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Relative font size

If you have one style based on another, you can even specify the relative font size if you want. For example,
you can specify that the font size of style X should always be 80% of the font size of style Y.

To do so, proceed as follows:

Perform steps 1. to 4. as described above and enable the option Scale on the Style tab. Enter the desired factor
as a percentage – for example 80 – and confirm with OK.

The font size of a style edited in this manner will always be 80% of the size specified for the style on which it is
based.
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Cell styles

You can use the ribbon command Home | group Format | Cell styles  to apply "Cell styles".

Cell styles are a combination of cell attributes (number format, orientation, borders, etc.) as well as the
character format (font, etc.) that you can save. Once saved, all the attributes stored in that style are applied to
the selected cells at once.

For example, if you want to frequently format cells with the number format "Percent", red background and bold
font, simply create a corresponding cell style and apply it to as many cells as desired.

Note: In PlanMaker you can also apply character styles (see Character styles). The difference to cell styles is
that character styles store the character format (font, etc.) only, whereas cell styles store both character format
and cell format. Furthermore, character styles are also applicable to individual characters within a cell, while
cell styles are applicable only to entire cells.

For more information, see the following pages.

Applying cell styles

To apply a cell style, navigate to the cell you want to format. Alternatively, you can select multiple cells to
change them altogether.

Then, proceed as follows:

Applying directly via the dropdown menu of the icon

If you click on the Cell styles  icon on the ribbon tab Home | group Format, a dropdown menu with various
predefined styles (and, if existing, custom styles) opens. Here you can directly select and apply a suitable cell
style.

Further down in this dropdown menu, you can use the option Styles in use to display the styles already used in
the current document by selecting the checkbox.

For advanced options, click on the entry Manage cell styles in this dropdown menu to open the dialog box (see
below and the following pages).

Advanced options: Via the dialog box

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and choose Manage cell styles  in
the dropdown menu.

The program displays a dialog box with the list of all cell styles.

Tip: You can use the Show option to determine whether all available styles should be displayed in the list –
or only those already used in the current document.

3. Select the desired style in the Styles list.
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4. Click on Apply.

Immediately, the format of the selected cells will be changed to the format defined in the cell style.

In detail, a cell style can contain the following formatting options:

§ Number format 

§ Font (font and font size, text styles, etc.)

§ Cell alignment

§ Shading

§ Borders

§ Cell protection

In the section Format includes of the above dialog box, you can (optionally) specify exactly which of these
formatting options should be used when you apply the selected cell style (see also next section).

Creating cell styles

To create a custom cell style, proceed as follows:

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and choose Manage cell styles  in
the dropdown menu.

The dialog box Cell style opens.

2. Optional: In the Styles list in this dialog box, select the cell style on which your new style should be based
(see also "Based on" below). Or simply select the default style "Normal".

Tip: You can use the Show option to determine whether all available styles should be displayed in the list –
or only those already used in the current document.

3. Click on the New button.

4. Give the cell style whatever name you like and confirm with OK.

5. The new cell style has now been created, and you can modify it individually as follows:

To change the character format, click on the Character button. A dialog box will be displayed, which is
very similar to the dialog box from the ribbon tab Home | group Character  (see Character format).

To change the cell format, click on the Cell button. A dialog box will be displayed, which is very similar to
the dialog box from the ribbon tab Home | group Number  (see Number format and the following section).

6. Click on Close to exit the dialog box (or on Apply first if you want to see the result of the cell style directly
for the selected cells).

The style is now defined and ready for use via the ribbon command Home | Cell styles .

You can create a different set of cell styles for each document; the styles are stored inside the document.



221Formatting worksheets

The selection "Based on"

When you create a new cell style, it is usually based on the "Normal" cell style. This means that the new cell
style is based on the formatting of the "Normal" style. Changes to the formatting of the "Normal" style thus
affect all other styles.

If you have already created cell styles and used them in the document, the following happens when you choose
the Manage cell styles command: In the list on the left side of the dialog box, the style of the currently selected
cell is selected as the basis. This may be the "Normal" cell style or another one. In the left list, change the style
that you want to use as the basis for a new cell style, if necessary, before clicking the New button.

With the selection Based on, you can change the assignment of the style basis for the created cell styles at any
time:

To do so, first select the style to which another style base is to be assigned from the left list in the dialog box.
The Based on list shows you the base on which the selected style is currently based. You can change the style
basis here.

Note: If you want to change the assignment of a cell style to Based on and you have not yet created a custom cell style, then this option
cannot be selected at first because only the standard styles are available. These have unchangeably the style "Normal" as their base.
Only after you have defined your custom new style and then selected it from the left styles list, the option Based on is freely available for
you.

Please note: Subsequent changes to the formatting of the style basis will also change all styles based on it.
Only the formatting that you have already customized there will remain unchanged.

The "Format includes" section

In the Format includes section of the dialog box, you can specify exactly which of the formatting options to
include when you apply the cell style.

For example, cell styles such as "Currency" should solely provide the cells with the number format "Currency"
– and nothing else. That's why all options except for "Number format" are disabled in this style.

The setting in this section can be made for each style individually.

Note: For the default style "Normal" , these options cannot be changed.

Using shortcut keys

If you need a cell style frequently, you can assign it a shortcut key at any time. The advantage of this is that you
can then enable the style very swiftly with one press of a key.

To assign a shortcut key to a style, use the Cell styles  icon to open the Manage cell styles entry. In the
opened dialog box, select the desired style from the list. Then click in the Shortcut key input field and press
the desired key combination (starting with Ctrl or Alt).
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Note: If you press a key combination that is already assigned, the current assignment is displayed below the
input field Shortcut key. You should then press the Backspace keyÕ to delete your shortcut key and use a
different key combination. Otherwise, you will overwrite the key combination for another style or even one
of PlanMaker's commands.

We recommend that you always use key combinations that include the keys Ctrl and Shift since these are not
usually assigned.

Changing cell styles

Of course, you can change cell styles at any time.

Important: When you change the formatting options stored in a cell style, all cells using this style are
changed accordingly.

To change a cell style, proceed as follows:

1. On the ribbon tab Home | group Format, click on the Cell styles  icon and choose Manage cell styles  in
the dropdown menu.

2. The dialog box Cell style opens. Select the style you want to change.

3. To change the cell format, click on the Cell button. To change the character format, click on the Character
button.

4. When done, close the dialog box with the Close button.

Deleting or renaming cell styles

The Delete button in the dialog box of the command Cell styles, deletes the selected style in the current
document.

To give a style a new name, click on Rename and type the new name. This also affects only the current
document.

Note: Some of the cell styles are predefined and cannot be deleted or renamed.

"Normal" cell style

The cell style called "Normal" is present by default in every document and has a special significance: it is the
default style for all cells. As long as you do not apply other cell styles, every cell in a document uses the "Nor-
mal" cell style.

If you change the "Normal" cell style – for example, the number format – the number format for all cells will be
changed (except for cells that you have formatted manually in a different number format via the command
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group Home | Number). Furthermore, subsequent entries will appear in this number format which you have
defined in this manner as the new default format in the "Normal" cell style for the document.

If you want to apply a different cell style to certain cells instead of the default "Normal" style, select the cells
and follow the instructions in Applying cell styles.
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Document templates
As you learned in the previous two sections, character styles and cell styles are always saved in the document in
which they were created. If you want to use such styles in other documents as well, you should save them in a
document template .

Each time you choose the ribbon command File | New , PlanMaker allows you to select a document template
as the basis for the new document. If, at this point, you select a document template that you have created, the
new document will have the same character and cell styles that you saved in the template.

Note: Document templates can not only contain your favorite character and cell styles, but also text, values,
calculations, etc. This enables you to create a set of templates for invoices, annual reports, balance sheets or
other frequently used documents.

Simply choose the command File | New, select the template and complete the worksheet.

For more information, see the following pages.

Creating document templates

To create a new document template, proceed as follows:

1. Start a new document or open a document or document template that you want to use as the basis for the
new template.

2. Create the desired character and cell styles (and text, values, calculations, etc.) to be stored within the
template.

3. Choose the ribbon command File | Save as.

4. Select the entry PlanMaker template from the dropdown list Save as type.

5. At this point, PlanMaker switches automatically to the folder where the document templates are located.

Android/iOS: This step is not supported here. Navigate manually to the folder "SoftMaker/PlanMaker 2021 templates".

6. Type a name for the template in the File name input field.

7. Confirm that you want to save it.

The new template will now be stored.



225Formatting worksheets

Using document templates

To use a document template, simply start a new document with the ribbon command File | New. You can
specify on which document template this is to be based.

Proceed as follows:

1. Choose the ribbon command File | New  to open the dialog box. (Click directly on the icon itself.)

2. You can select the required document template in the dialog box.

3. Confirm with OK.

The system now creates a new document for which all character and cell styles saved in the document template
become available. If the document template also contains filled cells, these are displayed accordingly and can
be edited normally.

Changing document templates

Changing a document template is no different from editing a normal document. You open the template, make
your changes and save the document template.

Important: Of course, changing a document template will affect all documents that are subsequently created
on the basis of this template.

To change a document template, proceed as follows:

1. Choose the ribbon command File | Open (click directly on the icon itself).

2. Select PlanMaker templates from the dropdown list of file types.

3. Select the template to be changed and confirm that it has been opened.

4. Modify the content and/or the styles of the template as desired.

5. Choose the ribbon command File | Save to save the changed template.

Of course, you could also save the template under a different name via the ribbon command File | Save as if
you did not want to overwrite the original template.
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"Normal.pmvx" document template

The Normal.pmvx document template is the default template for new documents. If you choose the command
File | New, this template will always be set. It is completely empty and contains only the default "Normal"
character style as well as the default "Normal" cell style.

Accordingly, the Normal.pmvx template is a suitable basis for creating a completely new template from
scratch.

Important: You should not usually change the Normal.pmvx default template. If you want to do this
anyway, you should be aware that these changes will affect all documents that are subsequently created
based on this template.

For example, if you want to change the page format for all documents that will be created in the future based on
the template Normal.pmvx, open this template, change the page format and save the template.

You can also choose a different default template for new files:

To do so, choose the ribbon command File | New  (click directly on the icon itself), select the desired
template in the dialog box and click on Set as default. From now on, PlanMaker will always offer this template
as the default template when you create a new document.

AutoFormat
The AutoFormat command lets you apply a predefined scheme of formattings to an entire cell range.

Tip: By inserting "Tables in worksheets" using the ribbon command Insert | Table, you can apply different
table styles much better. You will find a wider range of styles, additional features and better handling
through this function. Then you can further customize the table style on the ribbon tab Table | group Style.
For more information, see Tables in worksheets.

Note: The AutoFormat command is not available on the ribbon by default. However, you can add this command as a separate button on a
ribbon tab. To do this, choose the ribbon command File | Customize | Customize ribbon and then proceed as described in Customizing
icons and groups in the ribbon.

You can still find the menu command in the classic menu interface: Format > AutoFormat:
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The dialog box for this command shows a list of predefined "AutoFormat styles", whose appearance can be
previewed in the Sample field. To apply an AutoFormat style, simply select a cell range in the worksheet,
choose the above command, select the desired style and click OK.

The options in the Apply section of the dialog box let you choose which formatting options to apply. For
example, if you deselect all options except Borders, only the border lines will be applied; all other formatting
options will remain unchanged.

Conditional formatting
The ribbon command Home | group Format | Conditional formatting  allows you to apply conditional
formatting to cells. Conditional formatting will only be applied when a certain condition is met. This way you
can automatically change the appearance of a cell, for example, a cell is displayed in red color whenever its
content is greater than 1000.

On the next pages you will find out everything you need to know about it. The following topics are covered:

§ Creating new formatting rules 

To apply conditional formatting to cells, you select those cells and create a so-called formatting rule for
them. Example: "If the cell content is greater than 1000, display it in red color."

You can create as many formatting rules for a cell (or cell range) as you like. For example, you can add a
second rule that formats the cell in boldface if it contains a value below zero etc. etc.

§ Types of conditional formatting 

This section details the different types of formatting rules available.

§ Managing formatting rules 

The Manage rules command gives you access to a dialog box where you can manage all conditional
formatting in a document. For example, you can edit conditional formatting rules, delete rules, etc.
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§ Removing conditional formatting 

The last section covers the removal of conditional formatting.

Creating new formatting rules

To add conditional formatting to cells, you select those cells and create a so-called formatting rule for them.
Formatting rules always consist of two parts:

§ a condition 

§ ... and the formatting to be applied when this condition is met

Example: "If the cell content is greater than 1000, display it in red color."

Application example

To define (and apply) a formatting rule like this, proceed as follows:

1. Navigate to the desired cell. Of course, you can also select multiple cells to apply conditional formatting to
them together.

2. On the ribbon tab Home | group Format | Conditional formatting  (in the icon's dropdown menu) select
New rule to open the dialog box.

Tip: For quick use of common formatting rules, you can also bypass the dialog box by applying certain
options directly from the dropdown menu of the command Conditional formatting (see "Tip: Applying
formatting rules directly from the dropdown menu" below).

3. In the dialog box, first select for Type, which type of condition should be used.

In our example, you would select Format only cells that contain. (For detailed information on each type of
condition, see Types of conditional formatting).

4. Next, specify the desired condition.

In our example, this would be the condition "cell value is larger than 1000". Accordingly, select the options
Cell value and greater than. In the edit control at the right, type in the value 1000.

5. In the last step, click on the Format button and specify the formatting options to be applied whenever the
condition is met.

In our example, switch to the Font tab, set the font color to Red and confirm with OK.

6. All necessary settings are now completed. Click on OK to confirm and create the new rule.

The new formatting rule is now created – and at the same time applied to the selected cells. This has the
following effect:

§ If the cell content is smaller than or equal to 1000, the cell will be displayed in its original format. 

§ If the cell content is greater than 1000, the cell will be displayed in the conditional format, that is, in red
color.
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Note: You can create as many formatting rules for a cell (or cell range) as you like. For example, you can
add a second rule that formats the cell in boldface if it contains a value below zero etc. etc.

Tip: Applying formatting rules directly from the dropdown menu

If you choose the ribbon command Home | group Format | Conditional formatting , you can apply certain
frequently used formatting rules directly from the dropdown menu.

The following types of formatting rules are available in the upper area of the dropdown menu:

§ Highlight cells: see description in the next section "Types of conditional formatting", paragraph Format only
cells that contain ...

§ Highest/lowest values: see description in next section "Types of conditional formatting", paragraph Format
only upper or lower values

§ Data bars, Color scales, Icon sets: see description in next section "Types of conditional formatting", paragraph
Format all cells based on their values

In the submenus, click on More rules to open the dialog box with even more differentiable setting options, if
required.

Types of conditional formatting

The previous section described how to apply conditional formatting to cells. In the dialog box that appears, you
can choose between the following types of formatting rules:
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Format all cells based on their values

This type of conditional formatting rule actually does not utilize a condition at all. It rather reformats all of the
selected cells – based on the values they contain.

For example, if you choose a 2-color scale from red to green, the lowest value will be highlighted in red color,
and the highest value in green color. The colors for the values in-between will be calculated automatically. The
result is a color gradient like e.g. the following:

There are several sub-types available for this type of formatting rule. They can be selected using the Format
style control. This control contains the following entries:

§ 2-color scale 

As described in the example above.

§ 3-color scale 

Same as the 2-color scale, with an additional option to specify the color of the medium value.

§ Data bars 

Displays a bar in the background of each cell, representing the relative size of the value – similar to a bar
chart:

§ Icons sets 

Displays an icon in each cell, indicating the size of the respective value – for example a red signal light for
the lower third of the values, a yellow one for the medium third and a green light for the upper third:
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Format only cells that contain ...

This type of rule reformats only those cells within the current selection that meet the specified condition.

Proceed as follows: First, specify the desired condition, using the controls and input boxes in the dialog box.

Then, click on the Format button and specify the formatting options to be applied for all cells that meet the
condition.

An example can be found in the previous section – where we created a formatting rule that paints the cell
content in red color if it is larger than 1000.

Format only upper and lower values

This type of rule reformats only those cells that contain the highest or lowest values within the current
selection.

First, specify which values to reformat – for example, the top 3 values or the top 10% of the values.

Then, click on the Format button and specify the formatting options to be applied for the corresponding cells.

Format values above or below average

This type of rule reformats only those cells that contain values above or below the average of the current
selection.

First, specify which values to reformat – for example, all values above the average.

Then, click on the Format button and specify the formatting options to be applied for the corresponding cells.

Format unique or double values

This type of rule reformats all unique values (or double values) within the currently selected cells.

First, specify which values to reformat:

§ all unique values (values that occur just once) 

§ or all duplicate values (values that occur twice or more often)

Then, click on the Format button and specify the formatting options to be applied for the corresponding cells.
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Use a formula to determine which cells to format

This type of rule reformats only those cells within the selection where the specified formula returns TRUE.

First, enter the desired formula in the dialog box. Note that only formulas that return a logical value (i.e. TRUE
or FALSE) are allowed. See also notes below.

Then, click on the Format button and specify the formatting options to be applied for the corresponding cells.

Some notes:

§ Creating suitable formulas 

You can enter any kind of formula. You only have to ensure that the result of the formula is a logical value
(i.e. TRUE or FALSE).

Examples:

If you enter the formula "SUM($A$1:$C$3) > 42", the conditional format will be applied if the sum of the
cells A1:C3 is greater than 42.

If you enter the formula "ISEVEN(ROW())", the conditional format will be applied if the current cell is
located in a row with an even row number.

§ Using absolute and relative cell addresses 

Notice that not only absolute cell references (as above) can be used, but also relative cell references: These
are treated as follows:

Absolute cell addresses like $A$1 always refer to the cell A1.

Relative cell addresses like A1 refer to the cell in the upper left corner of the selection. That means:

If you have not selected a cell range, A1 refers to the current cell.

If you have selected a cell range, A1 refers to the cell in the upper left corner of that range, A2 to the cell
below it, etc.

Managing formatting rules

On the ribbon tab Home | group Format | Conditional formatting , you can use the command Manage
rules to manage the conditional formatting in a document, including editing and deleting it.

Use this command as follows:

1. Navigate to the cell whose formatting rules you want to edit. Of course, you can also select multiple cells.

2. Choose the ribbon command Home | group Format | Conditional formatting | Manage rules.

3. A dialog box appears.
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Note: By default, this dialog box displays only the rules for the current cell (or selection). If you want to see
all rules created in the entire worksheet instead, set the Source option to Current worksheet. (See below
for details.)

4. Edit the formatting rules to your liking. (See below for details.)

5. Close the dialog box by clicking on OK.

Operating the dialog box

The dialog box for this command has the following controls:

§ Source 

Here you can choose which formatting rules should be shown in the dialog box:

Only selected cells: Show only rules that affect the currently selected cells (or, if no cells are selected,
the current cell)

Current worksheet: Show all rules for the current worksheet

Sheet <name>: Show all rules for a different worksheet (if available)

§ Rules list 

The Rules list displays all rules for the current selection or the entire worksheet (depending on what you
have chosen at the Source option).

Rules that affect the currently selected cells are displayed in boldface.

Stop: The checkboxes in the Stop column are something you normally don't have to care about. They are
needed only for compatibility reasons with older documents. (Background info: In older versions of
PlanMaker and Excel, conditional formatting for a cell that had multiple formatting rules was "stopped" as
soon as and any of these rules applied. All further rules for this cell were then ignored. With current versions
of PlanMaker and Excel, this is no longer the case: Here, all rules defined for a cell are respected.)

§ Arrow buttons next to the Rules list 

The arrow buttons next to the Rules list allow you to modify the ranking order of the formatting rules in the
list.

To change the ranking of a rule, select it in the list and then click on the up button (=increase ranking) or
down button (=decrease ranking).

This may be necessary if a cell range has been assigned competing formatting rules. Simple example: A rule
wants to color the cell green, but another rule wants to color it red.

The higher a rule is placed in the list, the higher its ranking is.

Note: Please note that the list does not reflect the order in which the rules are processed – on the contrary:
The list is processed from bottom to top, so that the rules with the highest ranking are applied last.

§ Apply to 

Here you can change the target range for a rule.

To do so, select the rule in the Rules list and enter the desired cell range here.
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§  New button 

Creates a new conditional formatting rule for the cells currently selected in the worksheet, just like the
ribbon command Home | group Format | Conditional formatting | New rule.

Again, the dialog box appears, that lets you create rules and that was described in Creating new formatting
rules.

§ Edit button 

Lets you edit the conditional formatting rule currently selected in the Rules list.

Note: Changes on a rule will affect all cells it was defined for (no matter which cells currently are selected
in the worksheet).

Again, the dialog box appears, that lets you create rules and that was described in Creating new formatting
rules.

§ Delete button 

Deletes the rule currently selected in the Rules list.

Note: This will remove the rule from all cells it was defined for (no matter which cells currently are selected
in the worksheet).

For more information on the topic Removing conditional formatting, see the next section.

§ Go to button 

Closes the dialog box and jumps to the target area for the rule currently selected in the Rules list.

Removing conditional formatting

Conditional formatting can be removed in two different ways:

A) Deleting formatting rules

When you delete a conditional formatting rule, it will be removed from all cells it was defined for – no matter if
you have currently selected cells in the worksheet or not.

Proceed as follows:

1. Choose the ribbon command Home | group Format | Conditional formatting | Manage rules.

2. A dialog box appears.

Note: By default, this dialog box displays only the rules for the current cell (or selection). If you want to see
all rules created in the entire worksheet instead, set the Source option to Current worksheet.

3. Select the rule to be deleted in the Rules list.

4. Click on the Delete button.

This will delete the rule – and accordingly remove it from all cells it was defined for.
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B) Removing all conditional formatting from a cell range

There's another method for removing conditional formatting, which removes all conditional formatting from a
particular cell range.

Proceed as follows:

1. Select the cells from which you want to remove all conditional formatting.

2. Choose the ribbon command Home | group Format | Conditional formatting | Delete rules in selected
cells.

(Alternatively, under Home | group Contents | Delete , use the command Conditional formatting,
which does exactly the same thing.)

This will "free" the selected cells from any conditional formatting rules applied to them.

Formatting rules that become superfluous because of that will be deleted automatically.

Input validation
When you apply input validation to a cell, you can achieve the following:

§ Ensure that only certain types of values (for example, numbers) within certain bounds (for example, between
10 and 20) are considered valid in this cell. 

§ Display an informational text whenever the user goes to this cell (for example, "Please enter only numbers
between 10 and 20.").

§ Display an error, warning or informational message window when the user tries to input values that do not
pass validation.

This is useful when you are creating tables that will be filled out by other people and you want to prevent
invalid values from being entered.

Apply input validation (example)

For instance, if you would like to limit the input of a certain cell to numeric values between 10 and 20, you
would proceed as follows:

1. Select the desired cells.

2. Choose the ribbon command Review | Input validation .

3. On the Settings tab, you can specify which types of values are permitted as well as their bounds.

For our example, you would choose the following:

Allow: "Decimal Numbers"

With Values: "between"
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Minimum: 10

Maximum: 20

4. On the Input message tab, you can enter informational text that is displayed whenever the user goes to the
cell.

For our example, enter here, "Please enter only numbers between 10 and 20." Of course, you can also leave
the input message blank.

5. On the Error message tab, you can enter text that is displayed in a message box when the user attempts to
input invalid data into the cell.

The icons in the Type area allow you to choose the type of error window that is shown. (See explanation
below.)

Important: The type of the error window also determines whether the user is actually allowed to enter
invalid values. PlanMaker strictly rejects invalid data only when the type Error message (first icon) is
selected!

Furthermore, you can enter the actual text of the message. If nothing is entered, a standard message is given.

For our example, set the type to Error message by clicking the first icon and enter the desired message
(e.g., the title "Invalid entry" and the text "Only numbers between 10 and 20 are allowed here.")

6. Confirm with OK.

Now, only values between 10 and 20 will be permitted in the selected cells. Should the user input something
else, an error message is displayed.

Note: Input validation is only active when the user enters values by typing them in. Should the user paste
invalid values into the cell through a copy and paste operation (for example, with the ribbon command File |
Paste), input validation will not intervene!

For detailed information on the options of the dialog box Input validation, see the next section Settings for
input validation.

Deactivate input validation again

If you want to deactivate the input validation again, select the desired cells and proceed as follows

On the ribbon tab Home | group Contents | Delete , choose the command Input validation from the
dropdown menu.

Alternatively, you can use the ribbon command Review | Input validation  again. Select "All values" again
in the dialog box on the Settings tab under Allow:
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Settings for input validation

As described in the previous section, you can limit the allowed values using the dialog box from the Review |
Input validation ribbon command. The following options are available here:

"Preferences" tab

§ Allow: 

With these options you can specify which types of values are allowed:

Option Explanation

All values Allow all types of values (effectively deactivate the input validation)

Integer numbers Allow only integer numbers

Decimal numbers Allow only decimal numbers

List entries Allow only values from a predefined list of permissible values.

When you use this option, enter a comma-separated list of the allowed values in the
Source field – for example, dog,cat,mouse or 1,2,3,4,5,6.

Alternatively, you can enter an equal sign followed by a range of cells which contains
a list of permissible values. For example, if the cells C1 through C3 hold the values
"dog", "cat" and "mouse" and you enter =C1:C3 in Source, only those three values
will be allowed.

Additional settings are displayed when the Options button is clicked.

Date Allow only date values

Time Allow only time values

Text length Allow only entries whose length falls within the bounds specified here.

Custom Allow only entries which satisfy the specified condition. Enter the condition in the
Formula field. (For more information on this, see the end of this section.)

§ With values 

Here you can further narrow the bounds for allowable values. For instance, if you choose the Between
option, you can specify minimum and maximum values, which the input value must lie between.

§ Minimum, Maximum etc. 

Here you can specify the bounds of the entries. If you enter 10 as the Minimum and 20 as the Maximum,
only values within 10 and 20 are accepted.

You may also use calculations here. If you enter C1 as the Minimum, the contents of the cell must be
greater than or equal to the cell contents of cell C1. Should you enter SUM(D2:D8), the contents of the cell
must be greater than or equal to the sum of cells D2 through D8.
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§ Use dropdown 

Only available when List entries is selected under Allow. When this option is selected, an arrow appears on
the right edge of the cell when the user goes to it. When clicked, a dropdown list appears, which contains all
available values for that cell, and from which the user can choose.

§ Ignore empty cells 

If this option is enabled, input validation is ignored for empty cells. If the user deletes the contents of a cell,
the cell does not run any input validation until the user enters another value.

"Input message" tab

On this tab, you can enter informational text that pertains to the cell being filled out – for example, "Please
enter only numbers between 10 and 20." This information is displayed when the user goes to the cell.

This tab has the following options:

§ Show input message when cell is selected 

Determines whether the input message should be shown or not.

§ Title 

Here you can specify the title of the message.

§ Message 

Here you can enter the text of the message.

"Error message" tab

On this tab, you can specify the error, warning or informational message, which appears when the user input
does not pass validation.

This tab has the following options:

§ Show error message after invalid data is entered 

Determines whether the message should be shown or not.

Note: Normally, you should leave this option checked, since input validation is of little use if the user isn't
immediately notified of an invalid entry.

§ Type 

Here you can specify the type of the message. Simply click the desired icon.

Important: The type of the error window also determines whether the user is actually allowed to enter
invalid values. PlanMaker strictly rejects invalid data only when the type Error message (first icon) is
selected!

The following types of messages are available:

Error message (first icon): PlanMaker displays an error message. The user is forced to enter a valid value;
invalid values will not be accepted.
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Warning message (second icon): PlanMaker displays a warning message. The user can decide whether
they proceed with the invalid entry anyway.

Information message (third icon): PlanMaker only displays an information message. The user must only
acknowledge this message and the invalid data is accepted (as long as the user does not click Cancel).

§ Title 

Here you can specify the title of the message.

If you enter nothing here, a standard text is used as the title.

§ Message 

Here you can enter the text of the message.

If you enter nothing here, a standard text is used as the title.

Tip: If you would like to have the specified minimum and maximum values displayed in the message,
simply use the placeholders %min and %max. Example: "Error – Only values between %min and %max
are allowed here."

Examples

Finally, some examples of use:

§ Allow only values within the specified range 

On the Settings tab choose first the desired type of value. If only dates are to be allowed, set the option
Allow to "Date". If only numbers are to be allowed, set the option to "Decimal numbers", etc.

After that, you can set the bounds using the With values option. For instance, if only values greater than one
should be allowed, choose the "greater than" option and enter 1 as the Minimum.

§ Allow only values with a certain length 

If you would like to prevent the user from entering values with lengths greater than 40, choose the following
options:

Allow: "Text length"

With values: "smaller or equal"

Maximum: 40.

Note: Characters such as numerals, periods, commas, symbols, etc. count here just as much as characters
such as letters.

§ Using your own formula for input validation 

Advanced users can also choose "User defined" under Allow, and then give a formula for use in the input
validation.

To do this, use a formula that returns a logical value (i.e., TRUE or FALSE). If the result of the formula is
TRUE, the input is treated as valid; if not, it is treated as invalid.

An Example: If you use the formula SUM($A$1:$C$3) > 42, the inputted data is only treated as valid if the
sum of A1:C3 is greater than 42.

Note: Notice that not only absolute cell references, as above, can be used, but also relative cell references:
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Absolute cell references, like $A$1, always refer to the cell A1.

Relative cell references, like A1, on the other hand, refer to the cell in the upper left corner of the selected
cells. If you use input validation on only one cell, A1 refers to this cell. If, beforehand, you had marked a
range of cells, A1 refers to the cell in the upper left corner, A2 to the cell below this cell, etc.

Detect invalid data

On the ribbon tab Review | group Input validation, you will find commands that can be used to detect cells
that contain a invalid data.

Note: A cell contains invalid data if the command Input validation  has been used to specify which values
should be allowed in the cell, and the current cell content violates any of these rules.

To find and analyze such errors, use the following commands in the command group:

§  Input validation 

Opens the dialog box Input validation for defining allowed values. See previous sections.

§  Mark invalid data 

This command paints a red circle around each cell (on the current worksheet) that contains an invalid value.

§  Remove (invalid data) marks 

Removes all red circles (from the current worksheet) added with the above command.

§  Previous invalid cell 

Jumps to the previous cell that contains an invalid value.

§  Next invalid cell 

Jumps to the next cell that contains an invalid value.

Notes

§ The marks for invalid data also appear in the printout. 

§ However, the marks are not stored in the document. Thus, when you save a document, close it and open it
again, all circles are removed. 
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Format painter
You can use the command Home | Format painter to instantly transfer the cell format from one cell to other
cells.

To do so, proceed as follows:

1. Click the cell whose format you want to transfer to other cells.

2. Click on the Format painter icon  on the ribbon tab Home| group Edit.

The mouse cursor will now change into crosshairs with a little brush: 

3. Drag the mouse (with the mouse button held down) over the cell ranges to which the format is to be
transferred. You can apply this function to any number of cell ranges or individual cells (simply click on
individual cells).

4. When you are finished, click on the Format painter icon again or simply press the Esc key.

The character format (font, text styles, etc.) and cell format (number format, alignment, etc.) will be applied to
the selected cells.

Transferring the format of entire cell ranges

You can also transfer the format of entire cell ranges to other cells. To do this, proceed as described above, but
in step 1. select the cell range whose format you want to transfer.

For example, if you select three cells that are formatted with red, green, and blue backgrounds and transfer their
formatting to another cell range, that range will be formatted alternately with red, green, and blue backgrounds.
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Page setup
In this section you will learn about the options available for formatting a worksheet for printing.

The following topics are covered:

§ Set page format 

On the ribbon tab Layout | group Page setup, you can, among other things, set the page format for the
current worksheet. Here you can set such things as paper size, page orientation (portrait or landscape), and
page margins.

§ Setting page format options 

In the dialog box of the ribbon tab Layout | group Page setup , you will find various settings on the
Options tab for page numbers, print order, etc. and you can specify which parts of the worksheet should be
printed.

§ Setting up headers and footers 

Using the Header and footer command on the ribbon tab Layout | group Page setup, you can add a header
and/or footer to the document, which will be printed at the beginning or end of each printed page of the
worksheet.

§ Adjusting page breaks manually 

Page formatting also includes the possibility to manually control the automatic page break if required. This
can be done with the command Page break on the ribbon tab Layout | group Page setup.

See the following pages for more information.

Set page format

On the ribbon tab Layout | group Page setup, you can, among other things, define the page format of a
worksheet. This includes settings such as paper size and orientation (portrait or landscape).

Note: You can set up a different page format for each worksheet in a document. For example, within one
document, the page orientation can be set to portrait in one worksheet, and landscape in another.

Applying via the dialog box of the command group "Page setup"

On the ribbon tab Layout | group Page setup, click on the group arrow  in the bottom right corner to open the
dialog box and switch to the Page format tab.
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Then make the desired settings:

§ Orientation 

Here, you can specify the Orientation of the document on the printed page: Portrait or Landscape.

§ Paper size 

Here, you specify the format of the paper size. The dropdown list Paper size contains all paper sizes that are
supported by the current printer. If you want to specify a size that is not listed, you can do so by manually
specifying values in the fields Width and Height.

§ Margins 

You can set the page margins here

§ Distance to edge 

Lets you modify the distance between headers/footers and the top/bottom edge of the page.

Note: Headers/footers are printed inside the top/bottom margins. If they do not appear on the printout, check
if a) the Distance to edge is too large, or b) the top/bottom margin is too small.
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§ Paper trays 

Only available in Windows version: If your printer has multiple paper trays, you can set the tray which the
printer should use. If you have selected the default setting Use printer setting, PlanMaker does not affect
the paper feed. If, for example, you want the first page of your document to be printed on paper from tray 1
and the remaining pages on page from tray 2, you should change this setting accordingly.

Tip: If you right-click at the bottom on a worksheet tab, you can use the Copy page setup context menu
command to copy all made page settings from one worksheet to another. See also the Managing worksheets.

Applying via the icons of the command group "Page setup"

Common settings of the dialog box can also be found via the icons on the ribbon tab Layout | group Page
setup. Click on the black arrow of the respective icon to open the corresponding dropdown menu.

Margins (corresponds to the options for Margins in the above dialog box):
You will find a selection of predefined values here. If required, select More in the dropdown menu to access the
dialog box for customizations.

Page orientation (corresponds to the options for Orientation in the above dialog box):
portrait or landscape

Page size (corresponds to the options for Paper size in the above dialog):
Here you will find a selection of predefined values. If required, select More at the bottom of the dropdown menu or
click on the icon itself to perform customizations via the dialog box.

Setting page format options

On the Options tab of the dialog box Page setup you can make settings that affect the printout of the current
worksheet.

To do so, open the dialog box on the ribbon tab Layout | group Page setup with the group arrow  in the
bottom right corner and switch to the Options tab.

Alternatively you can open the dialog box with the ribbon command File | group Print | Page setup.



245Formatting worksheets

You will find the following settings here:

Repeated rows/Repeated columns

If the worksheet contains row labels or column labels, and you want them to be repeated on all printed pages,
enter them here.

Use the following notation: FirstRow:LastRow (or FirstColumn:LastColumn, respectively)

For example, if you have created a table containing a large list of data, with a heading placed in the first row,
enter 1:1 in the Repeated rows box to have this row repeated on every page of the printout.

If, on the other hand, you want columns A to C to be repeated on each page, enter A:C in Repeated columns.

Print

Check any of these options to include the following table components in the printout:

§ Row and column headers (row headers are located left of the table and labeled 1, 2, 3, etc. Column headers
are located above the table and labeled A, B, C, etc.) 

§ Grid (the gray gridlines between the cells)
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§ Comments (comments applied to cells with the ribbon command Insert | Comment)

Additionally, you can use the Colors option to specify if the printout should be rendered in color:

§ Original colors: The printout is rendered in its original colors. 

§ Grayscale: Colored text is rendered in black/white, colored objects (pictures, charts, etc.) are converted to
shades of gray.

§ Outlines only: Colored text is rendered in black/white, colored objects are reduced to their outline in
black/white.

Centering options

If Center horizontally is enabled, the worksheet's content will be horizontally centered on the page when
printed.

If Center vertically is enabled, the worksheet's content will be vertically centered on the page when printed.

Page number

Allows you to modify the starting number for page numbers:

Auto: Pages are numbered starting with 1.

Value: Pages are numbered starting with the specified value.

Tip: To add page numbers to a worksheet, insert a Page number field into the header or footer (see next
section).

Print order

Lets you specify in which order worksheets larger than a page will be printed:

§ Left to right 

Print from left to right, then from top to bottom.

§ Top to bottom 

Print from top to bottom, then from left to right.

Print range

Here you can define a print range for the current worksheet.

When a print range is defined, only the cells inside this cell range will appear when the worksheet is output on a
printer. The rest of the sheet will be omitted.

By default, this input field is empty, meaning that no print range is defined – so the entire worksheet will be
printed. When you type in a cell range (or the name of a named cell range), from now on only this range will
appear in the output when you print the worksheet.

A print range can be defined individually for each worksheet of the document.
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Important: When you save a document, this setting will be stored in the document permanently. Thus, when
you open and print this document once more in the future, the output will still be restricted to the specified
print range. To have the entire worksheet printed, simply empty the Print range input field in this dialog.
This will remove the print range.

Tip for working with print ranges:

Alternatively, there is a slightly more convenient method: You can also define a print range for a worksheet by
selecting the desired cell range and then choosing the Define print range command directly from the ribbon
tab Layout | group Page setup.

To do this, either click on the icon itself – or click on the icon's small arrow and select the Define print range
command from the dropdown menu. If you select Remove print range here, you can remove the print range
again.

Note: To ensure that only the defined print range is printed, the option Ignore print range must be disabled
in the dialog box of the command File | Print (this is the default setting, see Printing a document).

Tip for checking the print range:

To visually check the selected print range, you can use the option Page break preview on the ribbon tab View.
The selected print range is indicated by the white area and can be further adjusted by dragging the wrap lines
with the mouse. For more information, see Adjusting page breaks manually.

Scaling options

These options enable you to scale printouts of the document up or down.

By default, a fixed scaling factor of 100% is set (i.e. the original size is used).

To change the scaling, first select a Scaling mode, then set the desired value, as follows:

§ Use fixed scaling factor: Here you can set the scaling factor manually (in percent). Only values between 20
and 200 percent are valid. For example, if you set the scaling factor to 50%, the printout will be scaled down
to half its original size. If you set it to 200%, the printout will be doubled in size. 

In the other 4 scaling modes, the scaling factor is calculated automatically according to your settings:

§ Specify height in pages: Here you specify the desired height of the printout (in pages). PlanMaker will
determine the suitable scaling factor automatically. 

§ Specify width in pages: Here you specify the desired width of the printout.

§ Specify height and width in pages: Here you specify the maximum height and width of the printout.

§ Specify number of pages in total: Here you specify how many pages the printout should have in total. 

Note: PlanMaker does not allow the automatically determined scaling factor to fall below a value of 20%.
If this limit is under-run, PlanMaker uses a scaling factor of 20%. The same goes for the maximum value
of 200%.
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Setting up headers and footers

If desired, you can add headers and/or footers to a worksheet. Headers/footers are repeated on the top/bottom of
each printed page of a worksheet. You can also insert useful fields here, such as page number, file name, print
date, etc.

Note: Each worksheet of a document can have its own headers/footers.

To modify, for example, the header of the current worksheet, proceed as follows:

1. On the ribbon tab Layout | group Page setup, choose the command Header and footer.

Alternatively open the dialog box on the ribbon tab Layout | group Page setup via the group arrow  in the
bottom right corner.

2. To apply one of the predefined headers, choose it from the dropdown list box in the upper half of the dialog
box.
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To modify the header individually, click the Edit button (see also section "Editing headers and footers"
below).

To change the format of the header, click the Format button (see also section "Formatting headers and
footers" below).

3. Confirm with OK.

The header has now been changed accordingly.

Editing footers can be performed in the same manner as headers (using the controls in the lower half of the
dialog box).

Tip: Headers/footers are not displayed in the worksheet on the screen – they appear in the printout only.
However, you can always use the ribbon command File | group Print | Print preview to view the appearance
of the header and footer.

Editing headers and footers

When you click on the Edit button in the dialog box described above, you can modify the worksheet's headers
and footers as desired.

Some notes:

§ Headers/footers can contain up to three sections 

The input fields in this dialog box are split into three parts. This is due to the fact that headers/footers can
consist of up to three sections: a left section (left-aligned), a middle section (centered) and a right section
(right-aligned). This allows you to display, for example, the date on the left, the filename in the middle and
the page number in the right section of the header/footer.

Of course, you can alternatively fill out only one of the three sections, in case you want to have e.g. only the
filename displayed on the left.
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§ Using fields for page numbers, file name, etc. 

To insert fields into headers/footers, click the Fields button.

Fields are placeholders that symbolize a specific piece of information. For example, if you insert a field for
the page number, the placeholder {\PAGE NUMBER} is in the input field. When printing, this information
is then automatically replaced by the page number.

Fields available:

Field name Output

Document name File name of the document (e.g. "My Table.pmdx")

Document name and path File name and path of the document (e.g. "C:\Tables\My Table.pmdx")

Worksheet name Name of the current worksheet

Page number Page number

Number of pages Total number of pages

Print date Current date (date of printing)

Print time Current time (time of printing)

Date last changed Date the document was last changed (and saved)

Creation date Date the document was created

To insert one of these fields, click the Fields button, then click a field.

§ Changing the character format 

To change the character format (font, font size, etc.) of text in the header/footer, use the controls located at
the top of the dialog box.

Note: Please note that you have to select the text that you want to format beforehand.

Formatting headers and footers

Apart from changing the character format of headers/footers (see above) you can also apply border lines and
shades or change the alignment and margins. To do so, click on the Format button in the main dialog box of
the ribbon command Layout | Header and footer.

The program displays another dialog box containing the following tabs:

§ Shading tab 

Lets you add a colored shade or a pattern to the headers/footers. The controls in this dialog box are identical
to those described in section Shading.
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§ Borders tab 

Lets you add a border or single border lines to the headers/footers. The controls in this dialog box are
identical to those described in section Borders.

§ Alignment tab 

Lets you modify the inner margins and the vertical alignment of the headers/footers.

Tip: The distance between headers/footers and the top/bottom edge of the page cannot be changed here, but
in the main dialog "Page setup" on the Page format tab.

Disabling headers/footers temporarily

If you want to print a document occasionally without its headers or footers, choose the command Layout |
Header and footer and disable the Print option in the dialog box. The headers or footers will then no longer
appear in printouts.

If you want the headers/footers to be printed again, simply re-enable the Print option.

Adjusting page breaks manually

Page formatting also includes the possibility to manually control the automatic page break if required.

Normally, PlanMaker does the page break without further action: It automatically inserts a page break as soon
as the end of a printed page is reached (depending on the page format you have set, see Set page format). If you
take a closer look at a worksheet, you will notice that some of the gridlines between cells are darker. These
lines indicate where PlanMaker has inserted automatic page breaks. 

Note: On the ribbon tab View | group View, enable the option Show page breaks if the dark gridlines for
page breaks are not displayed.

Inserting a manual page break

If necessary, you have the option to insert "hard" page breaks. Hard page breaks override PlanMaker's
automatic page breaks. To do this, choose the ribbon command Layout | group Page setup | Page break. In the
dropdown menu of this command, you will find the following options:

For horizontal page break

§ Insert before row inserts a horizontal page break above the current row. 

§ Delete before row deletes such a page break. Navigate to a cell located directly below the page break before
selecting this command.

§ With the options Move break one row up/down you can change the position of the page break by one row
at a time. Navigate to a cell located directly below the page break before selecting this command. (Note:
These options are enabled only after you have manually inserted a horizontal page break)
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For vertical page break

§ Insert before column inserts a vertical page break left of the current column.

§ Delete before column deletes such a page break. Navigate to a cell located directly to the right of the page
break before selecting this command.

§ With the options Move break one column left/right you can change the position of the page break by one
column at a time. Navigate to a cell located directly to the right of the page break before selecting this
command. (Note: These options are enabled only after you have manually inserted a vertical page break)

The command Delete all page breaks removes all manually inserted page breaks again.

Tip: Using the "Page break preview"

To visually control the page breaks, you can enable the option Page break preview on the ribbon tab View |
group View. You will then see printout pages with their page numbers (displayed as "watermarks", these marks
are not printed) clearly arranged with page breaks.

The area that is filled with data is automatically marked in white by PlanMaker and therefore – without further
adjustments – leads to the displayed printout pages.

Adjusting manual page break with the mouse

You can manually adjust the vertical/horizontal page breaks in the Page break view by dragging a page break
(recognizable by the green dashed line) while holding down the left mouse button. The page break line will
change to a red line, indicating that the automatic page break will change to a manual one. The page numbers
are recalculated in the process.

The manual page break adjusted in this way does the following:

§ For example, by moving a page break with the mouse, you can now enlarge the range that will be on a page
for the printout. 

§ In the Page setup dialog box (see Setting page format options), the Scaling mode is automatically set to the
option Use fixed scaling factor and the value for Scaling (%) is adjusted to the changed page ranges.

Explanation: The value for Scaling (%) is never scaled up by moving the page breaks with the mouse. However, you can enter a
higher scaling value here so that a small page range is displayed enlarged on a printed page.

§ Above this (in the same dialog box), a Print range is defined automatically, provided that you have moved
the outer edges of the white shaded area with the mouse. 

Resetting manual page breaks

To reset the page breaks (that you have changed with the mouse) to their original state, you can proceed as
follows:

Open the Page setup dialog box (see Setting page format options). Here, set the value for Scaling (%) back to
100% and, if necessary, remove the newly created Print range in the input field above.
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Searching and replacing
This chapter covers information on searching (and replacing) in tables:

§ Search and replace 

Use PlanMaker's search commands to search for a specific term – and, as needed, replace it with another
value.

§ Jumping to specific cell addresses 

Use the Go to … command to jump to a specific cell, cell range or named cell range.

§ Jumping to specific elements of a table 

Use the three buttons in the lower right corner of the document window to jump to a specific content of a
table (for example, to the next cell with an error value or a comment)

See the following pages for detailed information.

Search
You can search a document for a specific term using the ribbon command Home | Search .
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Proceed as follows:

1. If you want to limit the search to a specific cell range, select the cell range first. If nothing is selected, the
entire worksheet will be searched.

2. Choose the ribbon command Home | Search .

3. Under Search for:, enter the search term.

4. Enable the desired search options (see Advanced search options) if required.

5. Click on the Search button to start the search.

PlanMaker scans the document for the search term and highlights the first cell that contains it.

You now have the following options:

A.You can click on Search again to proceed to the next occurrence of the search text.

B. You can close the dialog box by choosing Close.

Replace
Sometimes, you want to do more than just find a search term, but you also want to replace it with another term.
The ribbon command Home | Replace (in the Search group) is used for this purpose.

Proceed as follows:

1. If you want to limit the search to a specific cell range, select the cell range first. If nothing is selected, the
entire worksheet will be searched.

2. Choose the ribbon command Home | Replace .

3. Under Search for:, enter the search term.

4. Under Replace with, enter the term that is to replace the search term.

5. Enable the desired search options (see Advanced search options) if required.

6. Click on the Search button to start the search.

PlanMaker scans the document for the search term and highlights the first cell that contains it.

You now have the following options:

A.You can click on Replace, whereupon the search term is replaced with the replacement term and PlanMaker
jumps to the next occurrence of the search term.

B. You can click on Search again, whereupon PlanMaker jumps to the next occurrence of the search term –
without replacing the term.

C. You can click on Replace all, whereupon PlanMaker replaces all occurrences of the search term.

D.You can close the dialog box by choosing Close.
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Repeating a search/replace
To repeat a search or replace operation or to continue it after canceling, choose the ribbon command Home |

Search again  or simply press the F3 key.

PlanMaker continues the search and displays the next occurrence of the search term.

Advanced search options

If you click on the Enlarge button in the dialog box of the ribbon command Home | Search  or Home |

Replace , the dialog box expands to offer additional options.

Clicking on Reduce makes the dialog box smaller again. Thus you can specify the appearance of the dialog box
according to your preference for having the most options at your disposal or for having as much of the
worksheet as possible visible while you are searching.

The enlarged search/replace dialog box offers the following additional options:

"Search in" section

Here, you can specify how to scan the document:

§ Search in 

Use this dropdown list to choose which parts of the table to scan: Cells, Comments or Frames (text frames
and drawings containing text).

§ Formulas 

Scan formulas as if they were just text strings.

For example, when you search for "sum", all cells using the SUM function will be found.

§ Results 

Scan the results of formulas.

For example, when you search for "4", cells containing the calculation =2+2 will also be found.

(Only available for the search command, not for the replace command.)

§ Values 

Scan all fixed values (e.g., numbers and text strings typed in manually).
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§ Whole document 

If this option is enabled, all worksheets in the document will be scanned.

If it is disabled, only the current worksheet will be scanned (or, respectively, all worksheets that are
currently selected in the worksheet register.)

§ Search by column 

If this option is enabled, the table will be scanned column by column.

If it is disabled, the table is scanned row by row.

"Options" section

Here, you can specify the following options for searching:

§ Case sensitive 

The case of letters in the search term is ignored by default. Thus, if you search for "house", not only
"house", but also "House", "HOUSE", "HouSe", etc. will be found.

If you enable this option, however, the program will only find those occurrences of the search term where
the cases of the letters correspond exactly to the cases of the letters in the search term. Thus, if you search
for "house", only "house" will be found.

§ Whole cell match 

By default, PlanMaker finds all cells that contain the search text at any position. If you enter "win" in the
Search for box, PlanMaker will also find cells containing "windows" or "sales, winter 2018".

However, if you enable this option, the entire cell content must match the search term. When searching for
"win", only cells with the exact content "win" will be found.

"Special" button

The Special button allows you to use the following wildcard characters in your search terms:

§ Single arbitrary character (^?) – this placeholder represents a single arbitrary character. For example,
when you search for "fo^?d", PlanMaker finds occurrences of "fold", "fond", "food", etc. 

§ Multiple arbitrary characters (^*) – this placeholder represents any number of arbitrary characters. For
example, when you search for "f^*r", PlanMaker finds occurrences of "fair", "flyer", "freighter", etc. 

§ Caret (^^) – searches for the character "^" (caret). 

§ Line break (^a) – searches for manual line breaks (inserted with Ctrl+¿).

To insert such a wildcard into the search term, click on the Special button and then select the desired
placeholder by clicking on it.

You can repeat and combine these wildcards at will within the same search term. Furthermore, you can use
them in combination with normal text.
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"Search all" button

You can click the Search all button to receive a list of all occurrences of the search term. When you click one
of its entries, PlanMaker jumps to the corresponding occurrence in the document.

Note: This button is only available when the Search in option is set to Cells.

Jumping to specific cell addresses

The command Home | Go to  (in the Search group) is used to set the cell frame to a specific cell in the table.

A dialog box appears where you can type in the desired cell address. Both a single cell address (for example
D2) and a cell range (for example D2:D4) are permitted.

In the list below the input field, all areas of the table named with the ribbon command Formula | Named area |
Edit names are also listed so that these can also be accessed immediately.

Confirm with OK to jump to the specified cell(s).

Tip: A faster method

There is also a faster method: In the edit toolbar (above the table window) there is an expandable list on the left,
which normally shows in which cell the cell frame is currently located.

Here you can enter the address of a cell or cell range – just like in the dialog box from the Home | Go to
command. When you press the Enter key¿, PlanMaker highlights the corresponding cell(s).

And: Clicking on the small arrow right of the control opens a dropdown list of all named ranges. Clicking on
one of these names will highlight the corresponding cell range.

Jumping to specific elements of a table
Use the three buttons in the lower right corner of the document window to jump to a specific content of a table
(for example, to the next cell with an error value or a comment)
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You use these buttons as follows:

§ If you click on the button with the red dot, a small menu will appear. Then select the type of Go to operation
you want to perform from the menu (see below). 

§ If you click on the button with the up arrow, PlanMaker will jump to the previous position. If, for example,
you selected "Error value" in the menu, the previous cell with an error value will be displayed.

§ If you click on the button with the down arrow, PlanMaker will jump to the next position, for example, to
the next cell with an error value.

You can therefore determine what to search for by using the menu that opens after clicking on the red dot. The
menu has the following items:

Menu item Explanation

Formula Jump to cells that contain a formula

Array formula Jump to cells that contain an array formula

Constant Jump to cells that contain a fixed value

Error value Jump to cells that contain an error value (see the section Error values)

Faulty cell Jump to cells that have been imported incorrectly – for example, cells using an Excel
arithmetic function that PlanMaker doesn't support.

Comment Jump to cells that contain a comment

Conditional formatting Jump to cells that use conditional formatting

Input validation Jump to cells that use input validation

Search all worksheets If this option is enabled, PlanMaker searches all worksheets instead of just the current
one.
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Objects
You can insert different types of objects into your documents – such as charts, pictures, text frames, drawings,
etc.

In the following chapter, you will learn everything you need to know about the general use of objects:

§ Objects – basic procedures 

Here, you will learn about basic functions such as inserting, selecting and editing objects. You will also
learn about more unusual options, such as how to hide objects, group them, etc. The other settings that you
will find in the dialog box Object properties will also be explained in a separate section.

There will then be a detailed presentation of the individual types of objects:

§ Text frames 

§ Pictures

§ OLE objects

§ Drawings

§ Charts (see chapter Charts)

§ Forms (see Form objects in detail)

Objects – basic procedures
In these sections, you will find basic functions for working with objects:

§ Inserting objects 

§ Selecting objects

§ Object mode

§ Changing position and size of objects

§ Rotating and flipping objects

§ Changing the order of objects

§ Duplicating objects

§ Changing the names of objects

Other less frequently used features for working with objects will be covered in the following sections:
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§ Aligning and distributing objects 

§ Grouping objects

§ Hiding objects

§ Changing the AutoShape of objects

§ Combining shapes

§ Editing shapes retroactively

The options of the dialog box Object properties will then be explained:

§ Changing object properties via the dialog box

Inserting objects

In order to insert an object (e.g., a picture), proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture frame is now inserted.

You can then move or resize the frame:

To move it, click on the frame with the mouse, and then drag it to the desired location (while still holding
down the mouse button).

To adjust its size, drag one of the round handles surrounding the frame.

The process for inserting other types of objects is similar.

Note: As soon as you have inserted an object, an additional contextual ribbon tab Object (or picture, chart,
etc.) will appear on the far right and will enable you to conveniently edit the object properties via the
corresponding buttons.

For information on the different types of objects and how to adjust their properties, see Text frames, Pictures,
Charts, etc.

Selecting objects

If you want to edit an object, you must first select it. To do so, simply click on the desired object. A frame will
then appear around the object to indicate that it is now selected.
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Note: This does not work with text frames and other objects that have transparent fills. To select such an
object, click on its border or switch to object mode (see the next section), where all kinds of objects can be
easily selected by clicking on them.

Once an object has been selected, you can no longer enter anything in the table cells, but only edit the selected
object. If you want to edit table cells again, simply click with the mouse in the desired cell. This will deselect
the object.

Object mode

Object mode provides the easiest way to work with objects.

Normally, you work with PlanMaker in edit mode. In this mode, you can enter data or calculations in table
cells, edit them, format them, etc.

If you switch to object mode, you will no longer be able to edit table cells. However, this mode offers many
functions that make working with objects easier. In object mode, for example, you can select all types of
objects with a click of the mouse.

Note: As long as you are in object mode, you only have functions for creating and editing objects. You can
no longer edit cells, and most of the commands are unavailable.

Switching between edit mode and object mode

There are several ways to switch between edit mode and object mode:

§ Choose the ribbon command View | Object mode  to access object mode. Choose the command again to
return to edit mode. 

§ Click on the icon  in the Quick access toolbar to switch between edit and object mode.

§ You can also right-click anywhere in the document. This will open a context menu in which you can choose
the command Object mode or Exit object mode. 

§ The quickest method is to hover over any free position within the document and double-click on it with the
right mouse button to switch between edit and object mode.

§ You can also return to edit mode from object mode at any time by double-clicking anywhere in the text
where no object is located.

Selecting objects in object mode

In object mode, you can select any type of object simply by clicking on it with the mouse.

This is especially useful for objects with transparent fills (for example, text frames) because such objects can
only be selected in edit mode by a targeted mouse click on the margin of the object. In object mode, however,
you can simply click on such objects anywhere to select them.
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To select several objects at once, use the mouse to draw a frame around the desired objects. Alternatively, you
can click successively on several objects while holding down the Shift keyñ to select them together.

Tip: Use the ribbon command Home | Select all  to select all objects.

Jumping from object to object

In object mode, you can also "jump back and forth" between objects. Use the following buttons:

Key Function

Tab Select next object

Shift+Tab Select previous object

Changing position and size of objects

To change the position or size of an object, proceed as follows:

Changing the position of objects

To change the position of an object, click on it to select it. You can now either drag it with the mouse to the
desired position or move it with the arrow keys on the keyboard.

You will also find such a handle  on all objects for moving the object with the mouse. This makes it easier
for you to handle small objects.

Note: By default, objects are anchored to the cell beneath their upper left corner. You can move objects at
will, but when an object is dropped at its new position, it will again automatically be anchored to the cell
beneath its upper left corner.

This means that an object will move down if additional rows are inserted above it, and move up, if rows above
are deleted. The same happens if you change the height of rows above the object, for example.

If necessary, you can change this behavior by right-clicking on the object's frame to open the context menu and
selecting the last entry Properties, whereupon a corresponding dialog box appears. Switch to the Format tab
and change the option Position. For example, if you choose Independent of cell position and size, the object
will no longer move down when you insert new rows above. For more information, see Object properties,
Format tab.

Changing the size of objects

The size of an object can be changed as follows:
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§ Dragging the handles on the selection frame 

Click on the object to select it. The object will then be surrounded by a blue selection frame which also
contains some round "handles". When you drag one of these handles with the mouse, the size of the object is
changed accordingly.

§ Using the dialog box 

You can also resize objects via the dialog box. Right-click on the object to open the context menu and select
the last entry Properties. On the Format tab, these settings can be specified exactly in numeric values. For
more information on this dialog box, see Object properties, Format tab.

§ Via the ribbon tab 

If you have selected an object, you will also find input fields for the Width and Height in the group Resize
on the far right of the object-specific ribbon tab. Type the desired values here or increase/reduce the values
with the small arrow keys next to the input field.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

For OLE objects, an additional option named Keep scaling is available. If it is enabled, any changes made
to the object's size within its source application will automatically affect the object in PlanMaker. If it is
disabled, the object will always remain the same size in PlanMaker. (Note: Not all OLE source applications
support this feature.)

Preventing changes to the position and size of objects

By locking an object, you can prevent it from being moved or resized with the mouse or the arrow keys on the
keyboard.

Select the object, right-click on it to access the context menu and then select the last entry Properties to open
the dialog box. On the Properties tab, enable the option Locked.

Now the object can no longer be moved with the mouse, and it cannot be resized by dragging its boundary lines.
The object also cannot be moved with the arrow keys of the keyboard. The position and size can only be
changed by entering values in the dialog box.

If you disable the option Locked again, the position and size of the object can also be changed with the mouse.

Rotating and flipping objects

Note: Only drawings and pictures can be rotated and flipped; this is not possible for other types of objects.

When you select an object that can be rotated, an additional green handle will appear on one of its borders. If
you drag this handle with the mouse, the object will rotate.

Tip: If you hold down the Shift keyñ, the rotation occurs at exactly 22.5° angles.
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Furthermore, there are the following ways in which you can also flip (mirror) drawings and pictures in addition
to rotating them:

§ You can use the Rotate object button  on the object-specific ribbon tab. 

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

§ You can do so via the context menu (right-click on the object) by selecting the entry Rotate or flip.

§ You can also set the desired rotation angle manually in the dialog box. Right-click on the object to open the
context menu and select the last entry Properties. In the dialog box, switch to the Format tab and enter the
angle in the Rotation section. In the Flip section, you can flip the object vertically or horizontally.

Changing the order of objects

If several objects overlap, you can determine the display order of these objects (which object is in the
foreground, which is in the background, etc.).

To do so, proceed as follows:

1. Right-click on the desired object.

2. Choose the command Order from the context menu. The program opens a submenu with the following
commands:

Bring to front: This option brings the object in front of all other objects.

Send to back: This option sends the object behind all other objects.

Bring forward one level: This option brings the object forward by one level.

Send backward one level: This option sends the object back by one level.

Tip: You can also execute these commands on the object-specific ribbon tab on the far right via the Bring to
front and Send to back buttons (in the group Position).



265Objects

Duplicating objects

To obtain a duplicate of an object, you can copy it to the clipboard in the usual way and then paste it back from
there.

Alternatively, you can also use the Duplicate button  on the object-specific ribbon tab. This command
immediately creates a copy of the selected object.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

Tip: Duplicating an object is even faster with the mouse: If you drag an object while holding down the Ctrl
key, you immediately obtain a duplicate of that object.

Changing the names of objects

Every object in a document must have a unique name.

Normally, you do not have to worry about these names as they are automatically assigned by PlanMaker: If you
insert a rectangle into an empty document, it is automatically called "Rectangle1". If you insert a picture, it is
called "Picture1", the next picture is called "Picture2", etc.

Tip: The name of the currently selected object is displayed on the left in the status bar.

However, you can change the names of objects at any time. If, for example, you have created a form that
contains a list for entering the place of residence, you would naturally name this list "residence". To do so,
right-click on the object to access the context menu and select the last entry Properties to open the dialog box.
Switch to the Properties tab and change the entry in the Name field.

Remember that names must be unique. If you attempt to assign a name to an object that is already in use for
another object, PlanMaker will reject it and display an error message.

Note: Newly inserted "Tables in worksheets" are also given a unique name, which can be changed via the
Table properties. See Formatting tables in worksheets.

Aligning and distributing objects

To align or evenly distribute two or more objects, select them and click on the Align objects  button on the
object-specific ribbon tab.

Note: An object-specific ribbon tab appears on the far right as an additional tab when you select an object.

In the displayed dropdown menu of Align objects, select the desired alignment or distribution:
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§ Align left: This option aligns objects to the left edge of the object placed furthest left. 

§ Align center: This option aligns the objects horizontally centered to each other.

§ Align right: This option aligns the objects to the right edge of the object placed furthest right.

§ Align top: This option aligns the objects to the top edge of the top object.

§ Align middle: This option aligns the objects vertically centered to each other.

§ Align bottom: This option aligns the objects to the bottom edge of the bottom object.

§ Distribute horizontally: This option distributes objects evenly between the left edge of the object furthest
left and the right edge of the object furthest right.

§ Distribute vertically: This option distributes objects evenly between the top edge of the top object and the
bottom edge of the bottom object.

The last two commands only work if at least three objects are selected.

Tip: You will also find the commands for aligning and distributing objects in the context menu by right-
clicking on the selected objects and selecting the entry Align or distribute.

Grouping objects

When you group several objects, you combine them into a unit that can be selected and manipulated like a
single object.

In practice, this means the following:

If you select an object that belongs to a group, the entire group is selected. If you move this object, all objects in
the group are also moved.

Grouping also prevents related objects from being inadvertently moved against each other with the mouse.

To group objects, proceed as follows:

1. Select the objects to be grouped.

To do so, click on the objects successively while holding down the Shift keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Click on the Group icon  (in the group Objects) on the object-specific ribbon tab, or right-click on the
selected objects to open the context menu and choose the command Group to group the objects.

Ungrouping objects

To ungroup objects, proceed as follows:

1. Select the group by clicking on one of the objects in it.
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2. Click on the Group icon  again or choose the command Ungroup via the context menu.

Hiding objects

If necessary, you can hide an object so that it will not appear on the screen and/or on a printout.

Select the desired object and right-click to open the context menu. Select the last entry Properties to open the
dialog box, switch to the Properties tab and proceed as follows:

§ If you disable the option Visible, the object will no longer be displayed on the screen. 

§ If you disable the option Printable, the object will no longer appear in the printout.

Tip: If you have inadvertently made an object invisible, you can always choose the ribbon command File |
Properties and enable the option Show hidden objects on the Options tab. Now all hidden objects are
displayed again. Thus, you can now select the object and enable the option Visible to make it visible again.

Changing the AutoShape of objects

Objects can be replaced afterwards with another shape using the ribbon command Change AutoShape ,
while retaining the existing formatting.

Tip: For more options for changing the shape of objects, see Combining shapes and Editing shapes
retroactively.

Replacing the shape of drawings and text frames

To replace the shape of drawings (AutoShapes, lines, curves, TextArt objects) or text frames with another
shape, proceed as follows:

1. Select the desired object.

2. Click on the Change AutoShape button  on the contextual ribbon tab Object | group Edit.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the last entry
Properties. In the dialog box, switch to the "AutoShapes" tab.

3. Select the desired new shape in the list.

The contours of the object will then change to the selected shape.

Replacing the shape of pictures

To replace the shape of pictures with another shape, proceed as follows:
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1. Select the desired object.

2. Click on the small arrow of the Cropping icon  on the contextual ribbon tab Picture | group Size and
select the entry Change shape in the dropdown menu that appears.

Alternatively via the dialog box: Right-click on the object to open the context menu and select the entry
Change shape there.

3. Select the desired new shape from the list.

The contours of the picture frame will then change to the selected shape.

Tip: The command Photo frame  on the contextual ribbon tab Picture | group Format provides another
method of changing the shape of pictures. Here, you can choose from different variants. Some of these variants

display handles  that enable you to further adjust certain parameters of the shape by dragging them. You can
also use the small square  in the center to display the shadow with a varying offset.

Combining shapes

Note: This option is only available for drawings and text frames; it is not possible for other types of objects.

In PlanMaker, you can combine two or more shapes into one overall shape using the command Combine

objects , and different variants of the merge can be selected. This allows you to quickly create individual
drawing objects.

Important: The new overall shape always assumes the formatting of the first selected object.

Proceed as follows:

1. Select two or more objects (drawings/text frames) that you want to combine.

To do so, click on the objects successively while holding down the Shift keyñ.

Alternatively: Switch to Object mode  and drag a rectangle around all objects to be selected while
holding down the mouse button.

2. Choose the command Combine objects  (in the group Edit) on the contextual ribbon tab Object.

Alternatively, you will find the command in the context menu after right-clicking on the selected objects.

3. In the dropdown menu, select the desired variant for combining the objects (see below).

Variants of the command "Combine objects"

As mentioned at the start, the first selected object is the reference object whose formatting will be applied to the
new overall shape when each variant of the command Combine objects is chosen. This is the fill color, for
example, in the following illustrations.

The following variants are available:

§ Union 

This option creates a new common shape with a consistent outer contour of all selected shapes:
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§ Combine 

The non-overlapping parts of the shapes are preserved, while the overlapping areas become transparent:

§ Fragment 

New separate shapes are formed along the intersecting lines of overlapping shapes. These can then be moved
individually – as shown on the far right in the following figure:

§ Intersect 

This is the counterpart to Combine. Only the overlapping area is preserved, and the non-overlapping areas
disappear:

§ Subtract 

The overlapping areas are removed from the first selected shape, and the following selected shapes
themselves disappear:
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You can move the new shape like a "normal" object, resize it, add text to it, etc. There are also black corners or
vertices that allow you to customize the contours of the shape. For more information, see the next section
Editing shapes retroactively).

Editing shapes retroactively

There are several methods of retroactively adjusting the shape of objects:

§ Drawings/text frames can be given a different AutoShape via the ribbon command Change AutoShape 
(in the group Edit). For more information, see Changing the AutoShape of objects. 

§ You can also use the command Combine objects  (in the group Edit) to combine two or more shapes
into one overall shape. For more information, see Combining shapes.

§ Additional handles  are displayed for some types of AutoShapes. If you drag one of these handles, a
parameter controlling the shape of the object is changed. For stars, for example, the length of the points can
be changed, and for rounded rectangles, the rounding of the corners can be changed.

For pictures whose shape has been changed via the ribbon command Photo frame  (in the group
Format), these handles also appear for some variants.

In this section, the command Edit points  is used to describe a very individual method of customizing
certain objects (drawings, text frames or pictures) to your liking – by editing points of the object via the "Bezier
tools". Technically, you use this command to convert an AutoShape into a curve.

To do so, proceed as follows:

1. Select the object and choose the command Edit points  on the contextual ribbon tab Object | group Edit.

Tip: For pictures, you will find the command only via the context menu. (Right-click on the object.)

After switching to "Bezier Mode" via the command Edit points, you will see small black corners or vertices
on the object's contour line (Note: Bezier mode remains constantly for the object once enabled).

2. Drag the black points via the mouse to change the shape.

3. Optional: For shapes with curves, a blue line (tangent) with a small square (handle) also appears when you
left-click on one of the black points. Use the mouse to take hold of the blue square in order to change the
angle of inclination and length of the curve. See also the next section "Other options via the context menu".

Note: If you ensure that you are positioned exactly on the points (or the line segments, see below) with the
mouse, the mouse cursor will change to crosshairs .

Other options via the context menu

You will find additional editing options in the context menu by right-clicking on one of the small black points
or on a line segment of the object.

For points, you can choose between the following options in the context menu:
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§ Auto point 

The angle and length of the tangent are set to a default value for automatic smoothing. No tangent for
adjusting the angle and length appears accordingly for this option.

§ Straight point

A blue tangent appears. Both tangent halves are firmly connected, by angle and length. If one handle is
moved, the other handle changes analogously in terms of angle and length.

§ Smooth point

A blue tangent appears. Only the angle of the two tangent halves is connected, but not the length. If one
handle is moved, the other handle changes analogously in terms of angle. The length (and thus the gradient
of the curve) can be set independently.

§ Corner point

A blue tangent appears. Both tangent halves can be moved independently, both by angle and length.

§ Delete point

This option removes the selected point from the contour line.

For line segments, the context menu provides the following options:

§ Straight segment

The selected line segment between two points is straightened.

§ Curved segment

The selected line segment between two points becomes a curved line.

§ Add point

This option adds another editing point to the selected line segment.

§ Open curve/Close curve

You use Open curve to remove the line segment between two points. The option Close curve closes an
open shape and inserts a new line segment between the open ends.

The entry Curve properties opens a dialog box where you can edit the properties of the created shape (fill, line
color, etc.) as with any other object. For more information, see Changing object properties via the dialog box.
Many of these options can also be found directly on the contextual ribbon tab Object (or Picture).
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Changing object properties via the dialog box

The properties of an object include, for example, its size, fill color, borders, etc. These properties can be edited
centrally using the dialog box Object properties.

Note: Many object properties can also be conveniently edited directly via the icons of the contextual ribbon tab
Object (or Picture, Chart, etc.). Information about these ribbon tabs can be found in the respective section of
the corresponding object. However, some other options can only be set via the dialog box.

To change the properties of an object via the dialog box, right-click on the object frame to open the context
menu and select the last entry Properties. A corresponding dialog box appears.

Tip: For most types of objects, double-clicking on the object provides a quick alternative way to open this
dialog box.

The dialog box has several tabs that you can switch between by clicking on one of the tab headers at the top.

You will find detailed information on each tab and the options it contains on the following pages.

Object properties, Format tab

You can use the Format tab to make settings with respect to the format of the object, such as resizing it.

Available options:

§ Size and Scaling sections 

You can resize the object here. To do so, enter the desired Width and Height. Alternatively, you can change
an object's size by specifying the width as a percentage of the original width in Horz. scaling and the height
as a percentage of the original height in Vert. scaling.

If the option Keep aspect ratio is enabled, changes in height automatically have a proportional effect on
width (and vice versa).

There is an additional option named Keep scaling for OLE objects. If it is enabled, any changes made to the
object's size within its source application will automatically affect the object in PlanMaker. If it is disabled,
the object will always remain the same size in PlanMaker. (Note: Not all OLE source applications support
this feature.)

§ Position section 

Here you can choose to what extent the object's position and size is dependent on the cells it covers. Options
available:

Depends on cell position and size: The object behaves like its upper left corner was anchored to the cell
beneath. For example, when you insert additional rows above this cell, the object moves down accordingly.
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Furthermore, the object's size depends on the height and width of the cells it covers. For example, if you
increase the width of some of these cells, the object grows accordingly.

Depends only on cell position: The object behaves like its upper left corner was anchored to the cell
beneath as well. However, it does not change its size, when you change the size of the cells it covers.

Independent of cell position and size: The object always keeps its original position and size, independent
of the cells it covers.

§ Rotation section 

This option is only available for drawings and pictures.

Here, you can rotate the object. To do so, enter the angle at which you want to rotate the object clockwise.

§ Flip section 

This option is only available for drawings and pictures.

Here, you can flip the object vertically or horizontally.

Object properties, Fill tab

Note: This tab is only available for certain types of objects. For pictures, changes to the fill affect only the
transparent parts of the picture.

You can use the Fill tab to specify with what the object should be filled.

First, select the desired type of fill in the dropdown list Fill type. You can then make various settings for each
fill type.

The following fill types and settings are available:

Tip: You can also apply some of these options directly on the object-specific ribbon tab via the command
Fill color in the group Format.

§ No fill 

If you select the first fill type in the list, the object is not filled and thus remains transparent.

§ Solid color 

This fill type fills the object with a uniform color shade. Select the desired color in the list Colors.

Tip: Color lists only offer a few standard colors, but you can always compose your own colors. To do so,
click on More colors and then proceed as described in Document properties, Colors tab.

If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency). If, for example, you set the
transparency value to 25, the fill will have 25% transparency.

§ Pattern 

This fill type fills the object with a pattern. In the list Patterns, select the type of pattern and then set the
desired color for the foreground and background.
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If desired, you can also use the option Transparency to change the transparency of the fill. You can enter
any value between 0% (no transparency) and 100% (full transparency).

§ Picture 

This fill type fills the object with a picture file. You can use the Open button to determine the picture file
which you want to use for the fill. The most recently used picture files are displayed in the list Pictures and
can be selected there by clicking on them with the mouse.

Additional options:

Rotate with object: If you enable this option, the picture will also be rotated whenever you rotate the object
to be filled.

Mirror type: This option allows you to mirror the picture horizontally or vertically.

Transparency: If desired, you can use this option to change the transparency of the fill. You can enter any
value between 0% (no transparency) and 100% (full transparency).

Tile as texture: If this option is enabled, the picture is repeated in the object like a tile pattern.

You can then use the settings in the Tile options section to change the size and position of the tiles: X scale
and Y scale change the size (in percent), while X offset and Y offset change the position. The option
Alignment can be used to determine to which edge of the object the tiles should be aligned.

If the option Tile as texture is disabled, only Offsets (relative to the edges of the object) can be set for the
picture.

Save: You can use this button to export the currently selected picture, that is, to save a copy of it under any
name on your hard disk.

§ Linear gradient, Rectangular gradient, etc. 

The bottom five fill types are different types of color gradients. First, select the desired type of gradient in
the dropdown list Fill type and then select one of the subtypes in the list Variants.

In the Options section, you can specify the appearance of the gradient even more precisely:

X offset and Y offset enable you to move the center of the gradient. The Angle option allows you to set the
angle of rotation.

Tip: You can also change these settings by using the mouse to move or rotate the cross-hair displayed in
the Sample field.

If you enable the option Double gradient, for example, a black-white gradient will become a black-white-
black gradient.

In the Colors section, you can change the colors for the gradient as follows:

To change a color, first click on one of the small triangles below the bar representing the gradient. The left
triangle stands for the initial color, while the right triangle stands for the final color:

Then select the desired color from the dropdown list Color below.

You can use the option Transparency to change the transparency of the selected color if desired. You can
enter any value between 0% (no transparency) and 100% (full transparency).
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Additional colors can be added to the gradient by double-clicking on the desired position in the bar and
selecting a color. In the same way, namely by double-clicking on the triangle, additional colors can also be
deleted from the gradient.

Object properties, Lines tab

Note: This tab is only available for certain types of objects.

Use the Lines tab to specify the type of lines to use for the object. For drawings, this applies to the lines used to
draw the object; for all other objects, it applies to the lines that border the object.

Available options:

Tip: Many of these options can also be found directly on the object-specific ribbon tab in the command
group Format.

§ Variants 

Here, you can select the desired line style.

The entries in this list are merely default variants. If required, you can specify the appearance of the lines
more precisely via the options of the dialog box.

§ Color 

This option lets you specify the color of the lines.

§ Dashed 

Here, you can specify whether solid or dashed lines should be used.

§ Thickness 

Here, you can specify the exact thickness of the lines (in points).

§ Transparency 

If desired, you can use the option Transparency to change the transparency of the lines. You can enter any
value between 0% (no transparency) and 100% (full transparency).

§ Start point and End point (only available for lines, curves and connectors) 

Here, you can specify whether an icon should be drawn at the start point or end point of the line. If, for
example, you select an arrow icon for the end point, the line will look like an arrow. If necessary, you can
also change the Width and the Height of the icon.

Object properties, Shadow tab

Note: This tab is only available for certain types of objects.
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Use the Shadow tab to add a shadow to the object.

Available options:

Tip: You can also apply many of these options directly on the object-specific ribbon tab via the command
AutoShape effects in the group Format.

§ Variants 

Here, you can select the desired type of shadow.

The entries in this list are only default variants; the other options in the dialog box allow you to specify the
appearance of the shadow even more precisely if necessary.

§ Scaling 

Here, you can change the size of the shadow (relative to the size of the object).

§ Offset 

Here, you can change the position of the shadow (relative to the object).

§ Perspective 

Here, you can change the Skew angle of the shadow.

For certain variants of the "Perspective Shadows" type, the Horizon can also be changed, which distorts the
shadow in perspective. If Horizon is a positive value, the shadow is in front of the object; if it is negative,
the shadow is behind the object.

§ Color 

Here, you can change the color of the shadow.

§ Blur 

If you enter a value greater than zero here, a blur effect is added to the shadow. The larger the value, the
softer the edges of the shadow are drawn.

§ Transparency 

Here, you can change the transparency of the shadow. You can enter any value between 0% (no
transparency) and 100% (full transparency). If, for example, you set the transparency value to 25, the
shadow will have 25% transparency.

Object properties, 3D tab

Note: This tab is only available for text frames and drawings.

Use the 3D tab to add a three-dimensional effect to the object.

Select the desired type of 3D effect in the Variants section. The entries in this list are only default variants; the
other options on the 3D tab allow you to specify the appearance of the effect even more precisely if required.
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In the preview field Sample, you can follow the result of your adjustments and finally confirm with OK if you
want to apply the settings.

Object properties, Effects tab

Note: This tab is only available for certain types of objects.

On the Effects tab, you can add various effects to the object.

The following effects and options are available:

§ Reflection 

If you enable the option Use reflection effect, the object is displayed as if it was located on a reflective
surface. The following variations are possible:

Visible part of object: This option specifies how much of the object should be visible in the reflection (in
percent).

Starting transparency: The reflection is softly faded out downwards. This value determines how
transparent the reflection should be at the top (in percent).

Y offset: This option moves the reflection upwards or downwards.

§ Soft edges

If you enable the option Use soft edges effect, the borders of the object will be given a blur effect. The
following variations are possible:

Width: This option specifies the width of the blur effect.

§ Glow 

If you enable the option Use glow effect, the borders of the object will be surrounded by a glow effect. The
following variations are possible:

Width: This option specifies the width of the glow effect.

Color: This option specifies the color of the glow effect.

Object properties, Properties tab

On the Properties tab, you can change the general settings for an object.

Available options:

§ Name 

PlanMaker automatically assigns a unique name to every object in a document. For example, rectangles are
called rectangle1, ...2, ...3, etc. If desired, you can enter another name here.
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Tip: The name of the currently selected object is displayed on the left in the status bar.

For more information on using names for objects, see Changing the names of objects.

§ Visible 

This option is enabled by default. It causes the object to be displayed on the screen. (For more information,
see also Hiding objects.)

If you disable this option, the object becomes invisible.

§ Printable 

This option is enabled by default. It causes the object to appear in the printout when you print the worksheet.
(For more information, see also Hiding objects).

§ Locked 

This option is enabled by default. If enabled, the size of the object and its position, or any other object
property cannot be changed, when worksheet protection is enabled. See also Sheet protection.

§ Text locked 

This option is only available for text frames and drawings that contain text.

This option is enabled by default. If enabled, the text contained in the object cannot be changed, when
worksheet protection is enabled. See also Sheet protection.

§ Link 

Here, you can enter a hyperlink – to a website, for example. To do so, click on the Select button, select the
type of link and specify the desired target. The target is opened when the user clicks on the object.

In the case of pictures, the file name of the picture is displayed at the bottom of the dialog box, while some
information about the picture that was used (resolution, color depth, etc.) is shown in the right half of the dialog
box.

Object properties, AutoShapes tab

Note: This tab is only available for pictures, text frames and AutoShape drawings.

On the AutoShapes tab, you can assign an AutoShape to the object. Thus you can turn a rectangle into a speech
balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.

Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon tab
Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.
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Additional tabs

There are additional tabs with more options for some object types. For information on these tabs, see the
section on the relevant object.

Changing the default settings for objects

You can change the default settings for objects (drawings, pictures, etc.) at any time. This is particularly
relevant for drawings (AutoShapes and lines). For certain other objects, there are restrictions on applying the
default settings.

If, for example, you don't like the default line thickness for drawings, simply set it to a different value. You can
also alter other default settings – for example, the default fill for drawings as well as the settings for shadows
and 3D effects.

Note: Changes to the default settings for objects only affect objects that you insert afterwards. Existing
objects remain untouched.

To change the default settings for objects, use the Set as default button in the dialog box Object properties.

For example, the default line thickness for drawings can be changed as follows:

1. Insert a new drawing (or click on an existing drawing).

2. Right-click on the object to access the context menu and select the last entry Properties to open the dialog
box.

3. Make the desired settings. To change the default setting for the line thickness, for example, switch to the
Lines tab and simply set the desired line thickness.

4. Important: Click on the Set as default button and not on OK.

5. The program displays another dialog box in which you can also limit which default settings should be
changed if necessary. As a rule, there is no need to change anything in this dialog box.

6. If you confirm with OK, the settings currently made in the dialog box will be set as the default settings for
new drawings.

7. Confirm again with OK to exit the dialog box completely.

All drawings that you insert from now on will use the line thickness set in this way by default.

Note: The default settings for objects can be set separately for each document.

This concludes the general description of objects. The following sections present the various types of objects in
detail:

§ Text frames 
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§ Pictures

§ OLE objects

§ Drawings

§ Charts (see chapter Charts)

§ Forms (see Form objects in detail)
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Text frames
You can use text frames, to insert text boxes into a document. You can enter, edit and format text as desired in a
text frame.

Note: Text frames, by the way, are just AutoShapes (in this case, simple rectangles) to which text has been
added.

In this section, you will learn everything you need to know about working with text frames. The information
covers the following topics:

§ Inserting text frames 

§ Changing text frame properties via the ribbon tab

§ Changing text frame properties via the dialog box

§ Changing the text area

See the following pages for more information.

Inserting text frames

To insert a text frame, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Text frame .

2. The text frame is now inserted.

You can then move or resize the text frame:

Important: Click with the mouse on the border of the text frame in order to move it. While still holding the
mouse button down, drag the text frame to the desired position.

To adjust its size, drag one of the round handles surrounding the frame.

The text frame is now created, and you can start entering text in it immediately.

When you have finished entering text, click on any table cell to leave the frame. Now you can edit table cells
again. Conversely, you move from the body text back to the text frame by clicking into the frame.

Changing text frame properties via the ribbon tab

Numerous properties of text frames can be changed directly via the buttons of the contextual ribbon tab Object.
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The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a text frame by clicking on its border. It contains the
following buttons (from left to right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates: This option allows you to apply various predefined color formats to the text field.

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit borders for the text field or
the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape: This option allows you to assign a different AutoShape to the text frame (formatting is
retained). For more information, see Changing the AutoShape of objects.

§ Edit points: This option allows you to give the text frame an individual shape with the "Bezier tools". For
more information, see Editing shapes retroactively.

§ Combine objects: This option allows you to combine two or more shapes from different variants into one
overall shape. For more information, see Combining shapes.

§ Text rotation: This option allows you to rotate the inner text by the specified angle.

§ Vertical alignment: This option determines how the inner text should be aligned between the top and bottom
edges of the frame.

§ Change text area: This option allows you to adjust the size of the inner text area. For more information, see
Changing the text area.
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§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option is not available for text frames. 

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.

Changing text frame properties via the dialog box

To edit the properties of a text frame via the dialog box, first select it. To do so, click on the border surrounding
the text frame or simply click on it in object mode (View | Object mode). Then right-click to open the context
menu and select Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: If you are using object mode, you can also access this dialog box instantly by double-clicking on the
text frame.

The following settings can be made in the dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: on this tab, you can change the size and positioning of the object. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.
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§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

In the case of text frames, there are two additional tabs with further options:

Inner text tab

You can use this tab to change settings for the text in the text frame.

Available options:

§ Inner margins section 

Here, you can change the margins between the text frame and the text it contains. If you enable the option
Automatic, PlanMaker will automatically determine suitable margins.

§ Overlapping objects section 

This setting determines what should happen if the text frame overlaps with another frame.

If the default setting Ignore object is enabled, PlanMaker will do nothing. In the area of overlap, the
contents of both frames will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, PlanMaker will automatically wrap the text in this
frame so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the frame:

Option Explanation

Top The text is aligned to the top edge of the frame. (This is the default setting.)

Centered The text is centered between the top and bottom edges of the frame.

Bottom The text is aligned to the bottom edge of the frame.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the frame and ends exactly at the bottom edge.

AutoShapes tab

A text frame is actually an AutoShape that has been filled with text. AutoShapes are predefined shapes (such as
rectangles, ellipses, arrows, speech bubbles, etc.).

By default, a simple rectangle is used as an AutoShape for text frames. However, you can assign a different
AutoShape to the text frame at any time. Simply select the desired shape from the AutoShapes tab.
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For more information on AutoShapes, see Drawings.

Changing the text area

For text frames, and also for drawings to which text has been added (see Drawings), you can resize the text area
for the inner text in PlanMaker.

To do so, proceed as follows:

1. Click on the frame of the object to select it.

2. Choose the command Change text area  on the contextual ribbon tab Object | group Inner text (or via
the context menu by right-clicking on the text frame).

Note: For drawings (AutoShapes, curves, etc.), you must first add text to the shape so that you can use the commands for the inner
text.

3. The frame of the inner text is now selected and some round navy "handles" appear. Drag one of these
handles via the mouse to resize the text area.

When your adjustments are complete, choose the command Change text area again or simply click anywhere
in the document.
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Pictures
In this section, you will learn everything you need to know about working with pictures. The information covers
the following topics:

§ Inserting pictures 

§ Scanning pictures

§ Inserting pictures from the gallery/camera (Android and iOS)

§ Changing picture properties via the ribbon tab

§ Changing picture properties via the dialog box

See the following pages for more information.

Inserting pictures

To insert a picture, proceed as follows:

1. Choose the ribbon command Insert | group Objects | Picture frame .

(To do so, click directly on the icon itself or use the icon's arrow and select the entry From file.)

2. A dialog box appears. Select the desired picture file in it and confirm it.

3. The picture is now inserted.

If you want, you can then move or resize the picture:

To move it, click on the picture with the mouse, and then drag it to the desired location (while still holding
down the mouse button).

To adjust its size, drag one of the round handles surrounding the picture.

Options of the dialog box

The options in the above dialog box mean the following:

§ Save within document 

If this option is enabled, PlanMaker saves a copy of the picture in the document and uses this copy instead
of the original.

If it is disabled, PlanMaker saves only a reference to the original picture file in the document.
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§ Copy to document's folder 

If this option is enabled, PlanMaker creates a copy of the picture file in the folder where the document is
located and uses this copy instead of the original.

This option is available only if the document has already been saved.

Scanning pictures

Note: Scanning pictures directly into a document is possible only with the Windows version of PlanMaker.

With PlanMaker for Windows, you can scan originals directly into a document. You must have connected a
scanner to your computer and installed the corresponding software.

To scan something into the current document, proceed as follows:

1. Turn on the scanner and insert the original that is to be scanned.

2. On the ribbon tab Insert | group Objects | Picture frame , click on the arrow of the icon and select the
entry From scanner from the dropdown menu.

PlanMaker now enables your scanner's software. Make the desired settings (see scanner manual) and start the
scanning process. When this is complete, the scanned result will appear as a picture in the PlanMaker
document.

Selecting another source

If several scanners are connected to your PC, you can use the command Insert | Picture frame  | Select
source to decide from which of these sources you want to scan when you use the command Insert | Picture

frame  | From scanner.

Inserting pictures from the gallery/camera (Android and iOS)

Note: This function is available only in the Android and iOS version.

With the Android/iOS version, you can also insert pictures via the Gallery or Camera application on your
device.

To do so, proceed as follows:

Inserting a picture from the gallery

1. Position the text cursor where you want to insert the graphic.
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2. Choose the command Insert | group Objects | Picture frame  | From gallery.

3. Your Android/iOS device automatically opens its Gallery app. Select the desired picture by tapping on it.

The picture is now inserted.

Inserting a picture from the camera

1. Position the text cursor where you want to insert the picture.

2. Choose the command Insert | group Objects | Picture frame  | From camera.

3. Your Android/iOS device automatically opens its Camera app. Take a picture.

The picture is now inserted.

Changing picture properties via the ribbon tab

Numerous properties of pictures can be changed directly via the buttons of the contextual ribbon tab Picture.

The contextual ribbon tab "Picture", left section

The contextual ribbon tab "Picture", right section

This ribbon tab appears automatically when you select a picture. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the picture. Drag these handles with the mouse to crop the picture accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).
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§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the picture. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the picture – for example, other color
modes (grayscale, black/white, etc.) and variations where the image was colored. For more information, see
also the next section ("Picture tab").

§ Change source: Replace the picture with another one (formatting is retained).
This corresponds to the File button in the dialog box. For more information, see the next section ("Picture
tab").

§ Reset: Reset the image-specific changes made to the picture, such as brightness, shading, rotate object, etc.,
to their default values. The non-image-specific settings are not reset, for example, line thickness and photo
frame.

§ Photo frame: This option allows you to apply a photo frame effect to a picture.

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see the next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Rotate object: This option allows you to rotate a picture in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option allows you to create an immediate copy of the selected picture.

§ Width, Height: These options change the size of the picture. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties. You open the dialog box by double-clicking on the picture. For more information, see the next
section.

Changing picture properties via the dialog box

The properties of an object can be edited centrally via the Object properties dialog box. An object's properties
include, for example, its size, margins and numerous other settings options.
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To edit the properties of a picture, right-click on the picture to open the context menu and select the entry
Picture: Properties, which opens the corresponding dialog box.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the ribbon tab
Picture.

Tip: You can also open this dialog box by double-clicking on the picture.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: on this tab, you can change the size and positioning of the object. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. It is only visible for pictures with transparent areas. For more
information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply 3D effects. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. It also displays information about the picture
you are using. For more information, see Object properties, Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the picture. For more information,
see Object properties, AutoShapes tab.

For pictures, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that are specific to pictures:

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Picture |
group Adjust.

§ Variants 

This list offers some predefined variations of the picture – for example, different color modes (grayscale,
black & white, etc.) as well as colored variants of the image.

Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

Tip: You will also find these variants via the command Recolor picture directly on the contextual ribbon tab Picture.
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§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with the following additional options:

If you enable the option Mix with color and select a color below, the picture will be colored accordingly.

The options in the Cropping section can be used to crop the picture. This is useful if you only need part of
the picture. If, for example, the upper quarter of the picture is to be truncated, first select Use relative
values and enter the number "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the picture will not be truncated, but will be extended
with a frame.

Tip: You will also find a corresponding command Cropping directly on the contextual ribbon tab Picture. For more information,
see the previous section Changing picture properties via the ribbon tab.

§ Transparency section 

Here, you can make settings for the transparency of the picture:

Use picture settings: PlanMaker reads from the picture file which parts of the picture have been marked as
transparent and displays the picture accordingly. Note: Only pictures in GIF or PNG format contain such
transparency information.

No transparency: The picture will not be displayed transparently, even if it is a picture file with
transparency information.

Color: This option lets you select the color to be displayed transparently. If, for example, you select white,
all white areas of the picture will become transparent.

§ Sample 

In the small toolbar below the sample, you will find the option Pick transparent color (the pipette icon).
You can use it to make certain colored parts of the picture transparent, for example, to remove a distracting
background from the picture. To do so, use the pipette icon to click on an area of the thumbnail that you
want to make transparent.

The other toolbar buttons help you to fine-tune the picture (Zoom in, Zoom out, Pan picture), but they do
not affect the appearance of the picture in the document.

Note: You must first select a tool in the toolbar by clicking on it with the mouse. You can then work on the
thumbnail with the enabled tool.

§ File button 

You can use this button to replace the picture with another one and the formatting will be retained.

Tip: This corresponds to the command Change source on the contextual ribbon tab Picture.

§ Export button 

This option is available only for pictures that are saved in the document. You can use this button to export
the picture, that is, to save a copy of it on your hard disk under any name. The dialog box "Save as" appears
for this purpose.

If you enable the option Create a link to file here, PlanMaker also replaces the picture saved in the
document with a reference to the destination file. Thus, the picture is no longer saved within the document.
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OLE objects

Note: The use of OLE objects is only possible with the Windows version of PlanMaker.

With PlanMaker for Windows, you can embed objects created with other applications (drawings, pictures, etc.)
in your document.

Example: You can use the ribbon command Insert | OLE object frame (click directly on the icon itself) to
start the Windows Paint program from PlanMaker and draw something in it. If you exit Paint, the drawing will
appear in the PlanMaker document. It is now embedded in the document.

Advantage: You only have to double-click the drawing in the PlanMaker document and Paint will then be
restarted automatically. If you now edit the drawing in it and exit Paint again, your changes will be imported by
PlanMaker.

For this to work, the application that you choose must support OLE. OLE stands for Object Linking and
Embedding. The object that is imported from the other application into PlanMaker is called an OLE object.

In this section, you will learn everything you need to know about OLE objects. The information covers the
following topics:

§ Inserting OLE objects 

§ Editing OLE objects

§ Editing links to OLE objects

§ Changing OLE object properties via the ribbon tab

§ Changing OLE object properties via the dialog box

§ Using the SoftMaker Equation Editor

See the following pages for more information.

Inserting OLE objects

Note: The use of OLE objects is only possible with the Windows version of PlanMaker.

By choosing the ribbon command Insert | OLE object frame  (click directly on the icon itself), you embed
an object into a PlanMaker document, which you created with another application. After embedding such an
object, you can still edit it with the application that you originally used to create it.

The command opens a dialog box with a list of all applications that can provide OLE objects. The entries which
are displayed here depend on the OLE-enabled programs that are installed on your system.
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If you select "Paintbrush Picture", for example, a window from Window’s Paint program (called Paintbrush in
some versions of Windows) will open. Create a picture in it and then exit Paint. The picture is now embedded
in your document. It can be edited again at any time – simply double-click on the picture in the document.

To insert an OLE object into a document, proceed as follows:

1. Choose the ribbon command Insert | group Objects | OLE object frame . To do so, click directly on the
icon itself.

2. A dialog box appears. From the list Object Type, select the source application from which you want
PlanMaker to receive the OLE object.

3. When you confirm with OK, PlanMaker will start the application that corresponds to the selected object
type.

4. Create the object in the application.

5. Exit the application.

6. The application may now ask if you want to update the object in the PlanMaker document. Confirm this with
"Yes".

7. The OLE object created in the other application is now created in the PlanMaker document.

You can then move or resize the object:

To move it, click on the object and then drag it to the desired position (while still holding the mouse button
down).

To adjust its size, drag one of the round handles surrounding the object.

Tip: If you click on the icon's arrow under Insert | OLE object frame instead of on the icon itself, you will
find a small selection of useful applications for quick access: TextMaker object and Presentations object. For
other applications, select More to access the dialog box described above.

Creating an OLE object from a file

If you don't want to create a new OLE object, but want to embed an existing file from another application as an
OLE object, you still choose the ribbon command Insert | OLE object frame, but you select the option Create
from File in this case.

The appearance of the dialog box changes: Instead of the list Object Type, the File input field is displayed.
Here, enter the full file name or click on the Browse button to open a dialog box that will enable you to search
your hard disk for the file.

If you specify a file and confirm with OK, the file will be inserted as an OLE object.

In doing so, Windows checks the file name extension to see if it is associated with a program that can be started
and it responds accordingly. If the file name extension is not registered, only an icon will appear for the
embedded file. If, on the other hand, Windows can associate the name extension with an OLE-enabled program,
the content of the embedded file will be displayed.
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Creating a link to the original file

For the option Create from File in the aforementioned dialog box, you can also select whether the file to be
inserted should be embedded or linked. If you leave the option Link disabled, PlanMaker will insert a copy of
the file into the document as an OLE object and save this copy in the document – thus the object will be
embedded in the usual way.

If, on the other hand, you enable the option Link, PlanMaker will insert the OLE object in the form of a link to
the original file. This does not change anything in terms of use. If you subsequently change the original file of
the OLE object with another program and reopen the PlanMaker document, however, the OLE object will have
also changed accordingly – the OLE object will thus be linked to the original file.

Editing OLE objects

Existing OLE objects can be edited as follows:

Select the OLE object and click on the OLE object icon  on the contextual ribbon tab OLE object. Select
Edit from the dropdown menu.

Tip: Alternatively, simply double-click on the OLE object to edit it. The object will be opened immediately
in the associated application, where it can be edited.

Another alternative: You can also use the context menu to edit an OLE object.

Proceed as follows:

1. Click on the OLE object to select it.

2. Right-click on the OLE object to open the context menu and select the menu item with the object name (for
example, Bitmap object). Selecting this menu item opens a submenu containing all OLE commands that are
available for this object. There is a command Edit for editing the object. Choose this command.

3. The source application associated with the OLE object will now start. Make the desired changes.

To return to PlanMaker, simply exit the object's source application. When exiting some applications, you will
be asked if you want to update the object in the PlanMaker document. Answer "Yes" – your changes will be
discarded otherwise.

Editing links to OLE objects

If you have created an OLE object from a file and enabled the option Link, you can edit this link to the source
file. To do so, right-click on the OLE object to open the context menu and choose the command Link.

Alternatively, simply click on the Edit link icon  on the contextual ribbon tab OLE object.
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The program will display a dialog box which lists all links in the current document. When you select a link, the
file name and type of the associated source file are displayed in the lower part of the dialog box.

The buttons of the dialog box allow you to perform the following actions:

Button Function

Update now This button updates the OLE object. Use this button if the source file has been changed by
another program and the changes are not visible in the PlanMaker document.

Open source This button starts the application associated with the OLE object and lets you edit the object in
it. Tip: Double-clicking on the object has the same effect.

Change source This button lets you select a different file as the source for the OLE object.

Break link/
Remove

This severs the link to the source file. The object is then embedded permanently in the
PlanMaker document. Changes to the source file no longer have any effect on the document.
However, the object can still be edited by double-clicking on it.

Update:
Automatic or
Manual

If you have selected the option Automatic, changes that you make to the source file using the
Open Source button are always updated automatically for the OLE object. If Manual is
selected, changes to the source file are not updated for the OLE object until you click on the
Update Now button

Changing OLE object properties via the ribbon tab

Numerous properties of OLE objects can be changed directly via the buttons of the contextual ribbon tab OLE
object.

The contextual ribbon tab "OLE object", left section

The contextual ribbon tab "OLE object", right section

This ribbon tab appears automatically when you select an OLE object. It contains the following buttons (from
left to right):
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§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ OLE object: You can Edit, Open or permanently Convert the selected object here.

§ Edit link: If you have created an OLE object from a file and enabled the option Link, you can edit this link to
the source file. For more information, see Editing links to OLE objects.

§ Cropping: You can enable/disable crop mode via this button. In this mode, additional handles appear on the
borders of the object. Drag these handles with the mouse to crop the object accordingly. To exit the mode,
click on the button again. You can also use the button's small arrow to select a cropping from different
shapes or to remove the cropping.

See also the next section ("Picture tab" in the dialog box).

§ Brightness, Contrast, Saturation: Drag the slider or click on    and   to change the respective values for
the object. For more information, see also the next section ("Picture tab").

§ Recolor picture: This option provides a list of predefined variations of the object – for example, other color
modes (grayscale, black/white, etc.) and variations where the object was colored. For more information, see
also the next section ("Picture tab").

§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab. However, this
function is not supported by all OLE applications. 

§ Line color, Line thickness: These options allow you to apply border lines. For more information, see Object
properties, Lines tab.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects. 

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing OLE object properties via the dialog box

The properties of an object can be edited centrally using the Object properties dialog box. An object's
properties include, for example, its size, margins and numerous other settings options.

To edit the properties of an OLE object, first click on it to select it. Then open the dialog box by clicking on the
group arrow  in the bottom right corner of any command group on the contextual ribbon tab OLE object.

Alternatively: Right-click on the OLE object to open the context menu and select the entry OLE object
properties.

The following settings can be made in this dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the object. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. However, this function is not supported by all OLE
applications. For more information, see Object properties, Fill tab.

§ Lines: This option allows you to apply border lines. For more information, see Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

§ AutoShapes: Here, you can assign a different shape from AutoShapes to the object. For more information,
see Object properties, AutoShapes tab. 

In the case of OLE objects, there is an additional tab with further options:

Picture tab

On the Picture tab, you can make settings that affect the graphical representation of the OLE object.

Note: Depending on the type of OLE object, some of these options may not have a function.

Available options:

§ Variants 

This list offers some predefined variations – for example, different color modes (grayscale, black & white,
etc.) as well as colored variants of the object.
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Simply click on the desired variant. The options in the dialog box are then automatically set to the
corresponding settings.

§ Options section 

Here, you can change brightness, contrast, saturation and gamma (an alternative way to change brightness).

§ More button 

This button opens a dialog box with additional settings:

If you enable the option Mix with color and select a color below it, the object will be colored accordingly.

The options in the Cropping section can be used to crop the object. This is useful if you only need a section
of the object. If, for example, you want the upper quarter of the object to be truncated, first select Use
relative values and enter "25" (percent) for Top.

If you select Use absolute values, the entries will be truncated in absolute units of length rather than as a
percentage. If you enter negative values, the areas of the object will not be truncated, but will be extended
with a frame instead.

Using the SoftMaker Equation Editor

Note: The SoftMaker Equation Editor is available only for Windows and is not included in all versions of
PlanMaker.

The SoftMaker Equation Editor allows you to graphically display mathematical and technical equations.

PlanMaker communicates with the Equation Editor via OLE, as described in the previous sections. In order to
add a graphical representation of an equation to your document, insert an OLE object that uses the Equation
Editor as the source application.

To do so, proceed as follows:

1. In PlanMaker, choose the ribbon command Insert | OLE object frame. To do so, click directly on the icon
itself.

2. In the list Object Type of the dialog box, select SoftMaker Equation Editor.

3. Confirm with OK to start the Equation Editor.

Tip: You can insert an equation even faster via the ribbon command Insert | Equation Editor object .

4. Create the desired equation.

5. When the equation is complete, simply exit the Equation Editor.

The equation is now embedded in the PlanMaker document as an OLE object.

You can subsequently edit objects created with the Equation Editor at any time by double-clicking on them.
The Equation Editor is then restarted and opens the equation. Make the desired changes and then simply exit
the Equation Editor again.
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You can also change the properties of the Equation Editor object by right-clicking on the Equation Editor
object, opening the context menu, and choosing the command OLE object properties.

Information from the creators of the Equation Editor

The SoftMaker Equation Editor is a special version of the MathType program from Design Science. If you frequently use equations in your documents,
you might find that MathType itself is even better suited to your needs than the SoftMaker Equation Editor. While just as easy to use as the Equation
Editor, MathType has a number of additional functions that can help you to become more productive and create more complex equations.

MathType is available in English, German and other languages. For information about how to purchase MathType, contact your software vendor or
Design Science directly.

Design Science, Inc.
140 Pine Avenue, 4th Floor
Long Beach, CA 90802
USA

Phone (USA): +1 (562) 432-2920 (for international customers)
+1 (800) 827-0685 (for customers within the USA and Canada)

Fax (USA): +1 (562) 432-2857

E-mail (English): sales@dessci.com
Website: www.dessci.com
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Drawings
PlanMaker provides several tools for creating drawings. You can insert the following types of drawing objects
into your documents:

§ Lines and curves (lines, arrows, connectors, curves) 
§ AutoShapes (various types of predefined shapes) 
§ TextArt objects (lettering with effects) 

In this section, you will learn everything you need to know about working with drawings. The information
covers the following topics:

§ Inserting drawings 

§ Adding text to AutoShapes

§ Changing drawing properties via the ribbon tab

§ Changing drawing properties via the dialog box

See the following pages for more information.

Inserting drawings

To insert a drawing, for example, a rectangle, proceed as follows:

1. Choose the ribbon command Insert | group Objects | AutoShape . Select the desired AutoShape – a
rectangle in this case.

2. Hold down the left mouse button and draw a frame of the desired size in the document.

3. The rectangle is now inserted.

You can then move or resize the rectangle:

To move the rectangle, click on it and (while still holding the mouse button down) drag it to the desired
position.

To adjust its size, drag one of the round handles surrounding the rectangle.

The application of drawings differs somewhat depending on the drawing tool used. The following is a list of all
available drawing objects and information on how to handle them:

Note: You can adjust the shape of drawings retroactively at any time. For more information, see Editing
shapes retroactively.
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AutoShape

You can insert AutoShapes using the AutoShape  tool. These are predefined shapes for various purposes –
standard shapes such as rectangles, but also symbols for flowcharts, stars, speech bubbles and many more.

As soon as you have selected an AutoShape, simply drag a frame of the desired size in the document while
holding down the left mouse button. If you want, you can then move the AutoShape with the mouse or resize it
by dragging one of the round handles at its corners.

Note: Additional handles  are displayed in some types of AutoShapes when they are selected. If you drag one
of these handles, a parameter controlling the shape of the object is changed. For stars, for example, the length of
the points can be changed, and for rounded rectangles, the rounding of the corners can be changed.

Tip: You can even enter text in an AutoShape – just like you can in a text frame. For more information, see
Adding text to AutoShapes.

Lines and curves

Use the Lines tool  on the ribbon tab Insert to draw lines and curves.

When you click on this icon, a list of available line and curve tools opens. Select the desired tool and then use it
as follows:

§ Lines 

You can use the tools at the top of the list to draw simple lines and arrows. After clicking on the desired
tool, simply draw a line in the document while holding down the mouse button.

Tip: If you hold down the Shift keyñ, the line is limited to 45° angles.

Note: Arrows are nothing more than ordinary lines for which an arrowhead was selected in the object
properties (Lines tab) by selecting the option Start point and/or End point.

§ Connectors (straight, elbow and curved) 

You can use these tools to drag connectors between two objects. The difference between the three types of
connectors can be seen in the following figure:

To do so, select one of these tools, and then drag the mouse cursor from one object to another while holding
down the mouse button. When you move the mouse cursor over an object, small blue rectangles will appear
at various points on the object. These show where the line can "dock" to the object. You can influence the

course of curved and angled connectors by dragging the diamond handle  via the mouse.
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Tip: You can change the type of connectors retroactively at any time. Right-click on the line to open the
context menu and choose between a straight, elbow or curved connector. Also available in the context menu:
The option Create new connector causes the shortest connection between two objects.

§ Curves 

The tools at the bottom of the list are used to draw curves:

You can use the Curve tool  to draw Bezier curves.

To do so, click on the starting point and then on any number of other positions. The curve "follows" your
mouse clicks automatically.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

You can use the Freehand form tool  to draw curves in the same manner as if you were using a pencil.

To draw freehand, move the mouse to the desired starting point, press and hold the left mouse button and
then start drawing as if using a pencil. Alternatively, you can release the mouse button and click on
another location where a straight line will be drawn.

If you let the curve end at its starting point, the drawing automatically becomes a closed curve. If, on the
other hand, you want to obtain an open curve, you must end the drawing by double-clicking on it.

Note: The small black points on the contour line of curves enable you to further adjust the shape. Use the
mouse to drag such a point to another position. Further options can be found in the context menu by right-
clicking on the curve. For more information, see Editing shapes retroactively.

TextArt

You can insert TextArt objects using the TextArt object tool  on the ribbon tab Insert. TextArt objects are
used to create text effects.

If you enable this tool, a dialog box appears. Enter your text in the dialog box and then click on Variants to
select one of the predefined effects to be applied to the text. Then confirm with OK.

For information on the other options for TextArt objects, see Text tab.

Adding text to AutoShapes

You can add text to an AutoShape if desired. This text is then displayed within the AutoShape – exactly as it
would be in a text frame.

To do so, proceed as follows:

1. Select the desired AutoShape.

2. Right-click on it to open its context menu.

3. Choose the command Add text.
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The cursor flashes in the AutoShape. Thus, you can now type text inside the AutoShape.

Tip: There is another faster way to add text to an AutoShape: Select the AutoShape and just start typing.

You can use the commands of the ribbon tab Home | group Character and group Alignment to format the text
according to your needs..

When you have finished adding text, click anywhere outside the object. If you want to edit the text again later,
select the AutoShape again and choose the command Edit text from the context menu.

Note: By the way, the text frames presented at the beginning of this chapter are nothing more than AutoShapes
(simple rectangles in this case) to which text has been added. Thus, all information in Text frames applies
equally to AutoShapes to which text has been added.

Changing drawing properties via the ribbon tab

Numerous properties of drawings can be changed directly via the buttons of the contextual ribbon tab Object.

The contextual ribbon tab "Object", left section

The contextual ribbon tab "Object", right section

This ribbon tab appears automatically when you select a drawing. It contains the following buttons (from left to
right):

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ AutoShape templates: This option allows you to apply various predefined color formats to the drawing.
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§ AutoShape effects: Here, you can apply effects such as shadows, reflections, etc. This option largely
corresponds to the options of the tabs Shadow, 3D and Effects of the dialog box "Object properties". For
more information, see next section.

§ Fill color: The fill can be changed here. For more information, see Object properties, Fill tab.

§ Line color, Line style, Line thickness, Line endings: These options allow you to edit border lines for the drawing
or the inserted lines. For more information, see Object properties, Lines tab.

§ Change AutoShape: This option allows you to assign a different AutoShape to the drawing (formatting is
retained). For more information, see Changing the AutoShape of objects.

§ Edit points: This option allows you to give the drawing an individual shape with the "Bezier tools". For more
information, see Editing shapes retroactively.

§ Combine objects: This option allows you to combine two or more shapes from different variants into one
overall shape. For more information, see Combining shapes.

§ Command group Inner text: The commands of this group are only possible for shapes to which text has been
added. For more information, see Adding text to AutoShapes.

Text rotation: This option allows you to rotate the inner text by the specified angle.

Vertical alignment: This option enables you to determine how the inner text should be aligned between the
top and bottom edges of the frame.

Change text area: This option allows you to adjust the size of the inner text area. For more information,
see Changing the text area.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects. 

§ Rotate object: This option allows you to rotate a drawing in 90° increments or flip it vertically/horizontally.
For more information, see Rotating and flipping objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.

Many (but not all) of these functions and some additional options can be found in the dialog box Object
properties, which you can access, for example, via the context menu. For more information, see the next
section.
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Changing drawing properties via the dialog box

To edit the properties of a drawing via the dialog box, first select it by clicking on it. Then right-click to open
the context menu and select the last entry Properties, whereupon a corresponding dialog box appears.

Also possible: Click on the group arrow  in the bottom right corner of any command group of the contextual
ribbon tab Object.

Tip: This dialog box can also be opened by double-clicking on the drawing.

The following settings can be made in the dialog box:

Format, Fill, Lines tabs, etc.

These tabs are available for almost all object types. They allow you to change the following settings:

§ Format: On this tab, you can change the size and positioning of the object. For more information, see Object
properties, Format tab. 

§ Fill: This option allows you to change the fill. For more information, see Object properties, Fill tab.

§ Lines: Here, you can change the line style of the lines used to draw the object. For more information, see
Object properties, Lines tab.

§ Shadow: This option allows you to apply a shadow. For more information, see Object properties, Shadow
tab.

§ 3D: This option allows you to apply a 3D effect. For more information, see Object properties, 3D tab.

§ Effects: This option allows you to apply different effects. For more information, see Object properties,
Effects tab.

§ Properties: This option allows you to change general settings. For more information, see Object properties,
Properties tab.

Furthermore, some types of drawings have additional tabs with additional options. (For more information, see
the following pages.)

AutoShapes tab (available only for AutoShapes)

This tab appears for drawing objects only for AutoShapes.

On the AutoShapes tab, you can assign a different AutoShape to the object. Thus you can turn a rectangle into
a speech balloon or any other shape you like, for example.

To change the shape, simply click on the desired AutoShape in the list.
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Tip: You will also find this option as the command Change AutoShape directly on the contextual ribbon tab
Object. For more information, see Changing the AutoShape of objects.

For more information on AutoShapes, see Inserting drawings.

Inner text tab (available for AutoShapes with text added)

This tab appears only for AutoShapes to which text has been added (see Add text to AutoShapes) and for Text
frames.

You can use this tab to change settings for the text in the text frame.

Tip: Some of these options can also be found directly as commands on the contextual ribbon tab Object |
group Inner text.

Available options:

§ Inner margins section 

Here, you can change the inner margins for the text. If you enable the option Automatic, PlanMaker will
automatically determine suitable margins.

§ Overlapping objects section 

This setting determines what should happen if the object overlaps with another object.

If the default setting Ignore object is enabled, PlanMaker will do nothing. In the area of overlap, the
contents of both objects will thus be printed on top of each other.

If, on the other hand, you enable the option Wrap text, PlanMaker will automatically wrap the text in this
object so that it flows around the area of overlap.

§ Rotate by... section 

Here, you can rotate the text by the specified angle.

§ Vertical alignment section 

This setting determines how the inner text should be aligned between the top and bottom edges of the
drawing:

Option Explanation

Top The text is aligned to the top edge of the object. (This is the default setting.)

Centered The text is centered between the top and bottom edges.

Bottom The text is aligned to the bottom edge of the object.

Justified The lines of text are vertically justified and are thus evenly distributed so that the text starts exactly
at the top edge of the object and ends exactly at the bottom edge.
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Text tab (available only for TextArt objects)

This tab appears only for TextArt objects. You can use this tab to select the desired TextArt effect as well as to
enter and format the text to be displayed.

Available options:

§ Text 

Here, you can type the text to be displayed.

§ Variants 

In this list, you can select the effect with which the text should be displayed.

§ Font section 

Here you can change the font and enable/disable the text styles Bold and Italic.

If you enable the option Same height, all letters (including lowercase letters) will be stretched to a uniform
height.

§ Spacing section 

The Characters option changes the spacing between characters. If values are less than 100%, the characters
are closer together. For values greater than 100%, the characters are further apart.

The option Lines changes the line spacing. This setting only affects text that consists of multiple lines.

§ Alignment section 

Here, you can change the alignment of the text. This setting only affects text that consists of multiple lines.

§ Vertical text 

If you enable this option, the letters of the text will be rotated by 90 degrees.

Transformation tab (available only for TextArt objects)

This tab appears only for TextArt objects.

You can use this tab to specify the type of shaping effect to be applied to the text. To do so, click on the desired
type of transformation.
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Charts
In spreadsheets containing nothing but long columns of numbers, it is often hard to interpret their meaning.
PlanMaker offers easy ways to turn raw numbers into charts that get the point across.

In this chapter, you will learn everything you need to know about charts. The following topics are covered:

§ Inserting charts 

First, you will learn how to create a chart: Select the cells containing the data to be displayed, choose the
ribbon command Insert | Chart frame and select a chart type.

§ Editing charts 

This section contains all the information you need to edit charts. You will learn how to change the chart type
and the arrangement of the data series, how to work with the individual chart elements (data series, axes,
legend etc.) and how to change the general chart properties.

§ Updating charts 

By default, charts are automatically updated when you change the content of any of the cells they are based
on. So if values in these cells change, the chart is updated immediately. If desired, you can disable automatic
updating.

§ Moving charts to another worksheet 

The ribbon command Chart | Chart location allows you to move a chart to another worksheet or even
create a separate chart worksheet for it. A chart worksheet contains no table cells but solely the chart in its
full size.
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§ Saving charts as pictures 

The ribbon command Chart | Save chart as a picture allows you to save an image of a chart in a picture
file.

Inserting charts

With the ribbon command Insert | group Objects | Chart frame  you can insert new charts into the
document.

To do so, proceed as follows:

1. Select the cells containing the values to be displayed in a chart.

Tip: If the selection contains row and/or column headings, these headings can be used to automatically label
the axes and the legend.

2. Choose the ribbon command Insert | group Objects | Chart frame  to open the dialog box. (Click on the
icon itself.)

Alternatively, you can click on the small arrow of the icon to list a dropdown menu with various chart types
that you can insert directly by clicking on them. If you choose More here, the dialog box will be shown
again.

3. In the dialog box, you can specify which type of chart you want to insert. To do so, select the required
Chart type and Subtype.

For more information about chart types, see Changing the chart type.

4. Confirm with OK.

5. The chart is now inserted.

You can then move or resize the chart:

To move the chart, click on it and (with the left mouse button still held down) drag it to the desired position.

To resize it, drag one of the round handles surrounding the chart.

Editing charts
You will learn how to edit charts in the next sections. The information covers the following topics:

§ Changing the chart type 

Use the ribbon command Chart | Chart type to determine the form in which the data will be represented in
the chart – for example, as bars, lines or in the form of a pie chart, etc.

§ Changing the arrangement of data series 
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On the ribbon tab Chart you can specify whether you want to evaluate the data series to be displayed as
Series in columns or Series in rows.

§ Showing/hiding chart elements 

A chart contains various elements, such as data series, axes, a legend, etc. You can use the ribbon command
Chart | Add chart element to show or hide certain elements of the chart if necessary.

§ Editing chart elements 

You can select the elements of a chart by clicking on them and then edit them. You will learn how to do this
in this section.

§ Changing chart properties via the dialog box 

In addition to the properties of individual chart elements, there are also common chart properties that you
can change. These include various layout options, the chart type, settings for the data series, etc. You can
change these options on the contextual ribbon tab Chart (see below) or in the Properties dialog box
(accessible via the context menu).

For basic information on working with objects, see Objects.

Using the ribbon tab "Chart"

When you select a chart, the contextual ribbon tab Chart appears automatically.

The contextual ribbon tab "Chart", left section

The contextual ribbon tab "Chart", right section

This ribbon tab contains icons for the most important functions for editing charts:

§ New object: This option allows you to insert a new object into the document, and different object types are
available. 

§ Chart type/Chart subtype: This option allows you to select a chart type. (A subtype is only available for some
chart types.) For more information, see Changing the chart type.

§ Series in columns/rows: Specify whether the data to be displayed is to be evaluated column by column or row
by row, see Changing the arrangement of data series.

§ Chart colors: This option allows you to change the color scheme of the chart.
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§ Add element: This option allows you to show or hide chart elements such as axis titles, gridlines, legends,
etc. For more information, see Showing/hiding chart elements.

§ List of all chart elements contained in the chart. If you click on an element in the list, it will be selected in the
chart – if you select an element in the chart, it will be displayed in the list.

§ Edit properties: You click on this option to edit the selected chart element and the corresponding dialog box
opens. For more information, see Editing chart elements.

§ Fill color, Line color, Line style, Line thickness: You can use these options to change the fill and border lines of
the selected chart elements. For more information, see Editing chart elements.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Chart location: For more information, see Moving charts to another worksheet.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option allows you to create an immediate copy of the selected chart.

§ Save chart as a picture: Save an image of a chart as a picture file, see Saving charts as pictures.

§ Width, Height: These options change the size of the chart. For more information, see Changing position and
size of objects.

Using the dialog box

Many (but not all) of these functions and some additional options can be found in the Object properties dialog
box that you open via the context menu (entry Chart: Properties).

Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner of any
command group of the ribbon tab Chart.

All options of the dialog box are explained in Changing chart properties via the dialog box.

Changing the chart type

The chart type determines how data will be displayed in a chart – for example, as columns, bars, lines, etc.

To change the chart type, proceed as follows:

Directly via the icons of the command group "Type"

Many chart types can be used directly via the icons of the command group Type on the contextual ribbon tab
Chart:

1. Select the chart by clicking on it.
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2. Click on the Chart type icon  on the ribbon tab Chart | group Type.

3. Select the desired Chart type from the dropdown menu (see below for explanations of the different chart
types). You may use the icon below it to select a Chart subtype (only available for certain chart types).

Additional options via the dialog box of the command group "Type"

You will find some more options via the dialog box of the command group Type on the contextual ribbon tab
Chart. Here, you can also survey the possible appearance of the chart in a preview.

1. Select the chart by clicking on it.

2. On the ribbon tab Chart | group Type, click on the group arrow  in the bottom right corner.

3. In the dialog box, switch to the ribbon tab Chart type.

4. Select the desired Chart type and Subtype.

Tip: A small preview of the currently selected chart will be shown in the right half of the dialog box. You
can enable or disable this preview at any time using the >> button or the << button.

The following chart types are available:

   Column chart

Column charts are a good way to compare values. Each value is represented by a correspondingly high
column.

   Bar chart

Bar charts correspond to column charts; however, the values are displayed horizontally rather than vertically.

   Line chart

Line charts display values as points and/or connecting lines.

   Area chart

Area charts are line charts where the space between the X axis and the individual lines is filled with color.
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   XY scatter chart

XY scatter charts display values as points and/or lines. Unlike line charts, the data area must contain both the
X and Y coordinates of the data points.

   Bubble chart

Bubble charts display values as filled circles ("bubbles"). Bubble charts are usually based on data series
containing three values: X coordinate, Y coordinate, and bubble size.

   Radar chart

Radar charts display values in a web. The zero point is in the center of the web.

   Surface chart

Surface charts display values as a three-dimensional shape. Areas plotted in the same color indicate that they
contain similar values.

The values to be displayed should have the following structure:

(Z values determine the height.)

   Pie chart

Pie charts are well suited to displaying the percentage of individual values of the total value. The size of each
"pie slice" shows the ratio of the value to the total and to the other values.

Tip: You can highlight values by extracting the related slice of the pie from the pie. Select the slice of the pie
and extract it via the mouse.
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   Doughnut chart

Doughnut charts, like pie charts, show the percentage of individual values of the total value. Unlike pie charts,
however, they can display any number of data series (rings) and not just a single series.

       Cylinder, Cone and Pyramid charts

Cylinder, Cone and Pyramid charts correspond to column and bar charts. However, they use cylinders, cones
or pyramids instead of columns/bars to display the values.

   Stock chart

Stock charts (also known as general high-low charts) are suitable for displaying the development of stock
prices, among other things. They enable the highest price, lowest price and closing price to be seen at a glance,
for example.

The following subtypes are available:

§ Stock chart (High, Low, Close) 

This type of chart displays the following values: highest price, lowest price, closing price.

It requires 3 data series in the above order.

An example of the possible structure of the data (with the date added in column A):

§ Stock chart (Open, High, Low, Close) 

This type of chart displays the following values: opening price, highest price, lowest price, closing price.

It requires 4 data series in the above order.

§ Stock chart (Volume, High, Low, Close) 

This type of chart displays the following values: trading volume, highest price, lowest price, closing price.

It requires 4 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.
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§ Stock chart (Volume, Open, High, Low, Close) 

This type of chart displays the following values: trading volume, opening price, highest price, lowest price,
closing price.

It requires 5 data series in the above order.

The trading volume is displayed as an additional column with its own value axis.

   Box plot chart

Box plots (or box and whisker plots) are useful for data analysis in statistics. Detailed explanations relating to
the application of box plots would go beyond the scope of this manual. You can find further information on
them via your preferred Internet search engine.

There are two subtypes: Horizontal and Vertical.

Depending on the number of data series passed to the chart, different variants of box plots will be rendered:

Note: You can display any type of value in a box plot. The following lists show examples only.

§ 3-point box plot 

This box plot displays, for example, the following values:

Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)

This box plot requires exactly 3 data series in the above order.

§ 5-point box plot 

This box plot displays, for example, the following values:

Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)

This box plot requires exactly 5 data series in the above order.

§ 7-point box plot 

This box plot displays, for example, the following values:

Minimum (as a single marker)
Lower whisker (line below the box)
Lower quartile (lower border of the box)
Median (position of the line within the box)
Upper quartile (upper border of the box)
Upper whisker (line above the box)
Maximum (as a single marker)

This box plot requires exactly 7 data series in the above order.
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Changing the arrangement of data series

With the two icons  Series in columns and  Series in rows on the contextual ribbon tab Chart | group
Data, you can determine whether the data to be displayed is to be evaluated column by column or row by row:

§ By columns 

By default, the first icon is selected, meaning that the data is evaluated column by column. The values in the
first column will be the first data series, the values in the second column will be the second data series, etc.

§ By rows 

If you click the second icon, the data will be evaluated row by row. The values in the first row will be the
first data series, the values in the second row will be the second data series, etc.

Alternatively, you can also find this setting in the dialog box of the ribbon tab Chart | group Data (click on the
group arrow ) and switch to the Data source tab.

Showing/hiding chart elements

Certain elements of the chart can be shown or hidden if necessary. Some of them are shown automatically when
you create the chart, for example, the axes and the legend.

Tip: See Editing chart elements for an illustration of the most important chart elements.

The following elements can be shown/hidden:

§ Axes and axis titles 

§ Chart title

§ Data_labels

§ Error bars

§ Gridlines

§ Legend

§ Lines

§ Trendline

§ Up/down bars

For more information, see the following sections.
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Showing/hiding axes and axis titles

The horizontal X axis of a chart is also known as the category axis.

The vertical Y axis of a chart is also known as the value axis.

The Z axis of a chart is also known as the series axis. It is only available for certain three-dimensional chart
types.

Note: The X axis and Y axis are shown automatically when the chart is created.

To show or hide an axis, proceed as follows:

Via the "Add chart element" icon

You can use the Add chart element icon  on the contextual ribbon tab Chart to show or hide the X axis
and/or Y axis (the Z axis only in the dialog box, see below).

To do so, select the chart and use the ribbon command Add chart element  to select the entry Axis. In the
following submenu, you can use the entry Primary horizontal to show or hide the X axis and Primary vertical
to show or hide the Y axis.

The entry More takes you to a dialog box with additional options (see below).

Axis title: To add, change or remove axis titles, proceed as follows:

§ Adding axis title 

If you want to add an axis title to the axis, choose the ribbon command Add chart element and then select
the entry Axis title. Primary horizontal shows an axis title for the X axis, while Primary vertical shows it
for the Y axis.

The entry More also takes you to the dialog box here (see below).

§ Changing an axis title 

To rename an axis, double-click on the axis title and switch to the Text tab in the following dialog box.
Enter the desired text here.

§ Removing an axis title 

To remove an axis title, hide it again via the command Add chart element or select it directly in the chart
and press the Del key.

Via the dialog box

For additional axis options (for example, the Z axis or secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.
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2. Use the ribbon command Chart | Add chart element  to choose the entry Axis (or Axis title) and select
More in the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. Switch to the Elements tab.

Axes: The checkbox in front of each axis can be used to enable/disable the display of the relevant axis.

Axis title: To the right of the axis, you can give it a name. This will then be displayed below/next to the
axis.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

Editing axes and axis titles

For more information on editing the properties of axes, see Category axis (X axis), Value axis (Y axis) and
Series axis (Z axis).

For information on editing the properties of the axis title, see Axis title.

Showing/hiding chart titles

You can show or hide a chart title for the chart. The title will then be displayed above the chart.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Chart title. In
the following submenu, select Above chart to add a chart title. If you select None, the chart title will be
removed.

If you select More, you will be taken to the dialog box (see below) where you can rename the chart title.

Alternatively: Double-click on the chart title and you can then rename the title on the Text tab.

To remove a chart title, select it and press the Del key.

Via the dialog box

To show or hide the chart title via the dialog box, proceed as follows:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Chart title and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. On the Elements tab, you will find an input field for the Chart title at the top. Type the desired title here.



319Charts

To delete the chart title, simply remove the text from this input field.

For more information on the options of the "Elements" tab, see Chart properties, Elements tab.

For information on editing the properties of the chart title, see Chart title.

Showing/hiding data labels

The data points of a chart can be labeled. This allows you to display the exact value of the data points in the
chart.

To show or hide data labels, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Data labels.
In the following submenu, you can choose between different options for positioning the data label (left,
centered, above, etc.). A check mark in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

Tip: To remove a single label, select it and press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options for data labeling, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Data labels and select More
in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Data labels tab and make the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Data labels" tab.
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Showing/hiding error bars

Note: This chart element is only available for certain two-dimensional chart types, such as column, bar and
line charts.

You can draw error bars for the data points of a data series. Error bars display the possible/tolerable error of
the values in the form of a line with a short dash at the end.

To show or hide error bars, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Error bars.
In the following submenu, you can choose from a predefined selection for displaying the values. A check mark
in front of it indicates the setting which is currently enabled.

If you choose the entry None, the data labels will be removed.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

Additional options for error bars can be found via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Error bars and select More in
the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Error bar tab and select the desired settings here.

For more information on the options of the dialog box, see Data series and data points, "Error bar" tab.

Showing/hiding gridlines

Showing gridlines in a chart can improve the legibility of its values. Gridlines are a network of lines that extend
across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.
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You can enable gridlines separately for each axis.

To show or hide gridlines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Gridlines. In
the following submenu, you can enable or disable horizontal (for the Y axis) and vertical (for the X axis) major
gridlines and minor gridlines for the primary axis. A check mark in front of them indicates the gridlines which
are currently enabled.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options (for example, gridlines for secondary axes), choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Gridlines and select More in
the following submenu to open the dialog box.

Alternatively: Right-click to open the context menu and select the entry Chart: Properties.

3. Switch to the Elements tab and enable the option Major grid and/or Minor grid for the desired axes.

For more information on editing gridlines, see Gridlines.

Showing/hiding the legend

If desired, you can show (or hide) a legend in the chart. A legend is a small box that shows which data series
are displayed in which color/pattern.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Legend. In
the following submenu, you can specify where to position the legend. A check mark in front of it indicates the
option which is currently enabled.

You can hide the legend by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:
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1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Legend and select More in the
following submenu to open the dialog box.

Alternatively: Select the legend and right-click to open the context menu and select the entry Legend:
Properties.

3. On the Legend tab, specify where the legend should be positioned. If you select the option Custom, the
legend can be moved to any position (using the mouse). If you select the option None, the legend will not be
displayed.

Tip: If you choose the entry Chart: Properties via the context menu, the main dialog box for charts
opens. You will find the option Legend here also on the Elements tab.

For more information on editing the properties of a legend, see Legend.

Showing/hiding lines

Note: This option can only be used for line charts and area charts.

You can use the options for lines, for example, to illustrate the spacing between the individual data series in a
line chart.

The following types of lines are available:

§ Drop lines are lines displayed from the data points to the horizontal axis. 

§ High-low lines are lines displayed between the highest and lowest data points (for two or more data series). 

To show/hide drop lines or high-low lines, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element  to choose the entry Lines. In the
following submenu, you can choose between Drop lines and High-low lines. A check mark in front of it
indicates the option which is currently enabled.

You can hide the lines by selecting the entry None.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

For additional options, choose the path via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Lines and select More in the
following submenu to open the dialog box.
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Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Series: Properties.

3. Switch to the Options tab and enable the desired settings.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.

Showing/hiding the trendline

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Other limitation: They are not available for stacked chart types.

If desired, you can add trendlines to the data series of a chart.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

To show/hide trendlines, proceed as follows:

Via the "Add chart element" icon

Select the desired data series to which you want to add a trendline.

Use the ribbon command Chart | Add chart element  to choose the entry Add trendline. In the following
submenu, select one of the predefined trendline types.

The entry Remove all removes all trendlines (select the chart for this purpose). To remove individual
trendlines, select the desired trendline and then choose Remove all or simply press the Del key.

The entry More takes you to the dialog box with additional options (see below).

Via the dialog box

You will find more trendline types and additional options via the dialog box:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Add trendline and select
More in the following submenu to open the dialog box.

Alternatively: Select the desired data series and right-click to open the context menu and select the entry
Add trendline.

3. Switch to the Trend tab and enable the desired settings.

For more information on the options of the dialog box, see Trendlines.
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Showing/hiding up/down bars

Note: This option can only be used for line charts.

You can use the option Up/down bars to display bars between the first and last data series, for example, in a
line chart with two or more data series.

To do so, proceed as follows:

Via the "Add chart element" icon

Select the chart and use the ribbon command Chart | Add chart element   to choose the entry Up/down
bars. In the following submenu, select the same entry.

You can use the entry None to remove the up/down bars.

The entry More takes you to the dialog box (see below) where you can also set the spacing between the bars.

Via the dialog box

Choose the path via the dialog box to make further settings:

1. Select the chart by clicking on it.

2. Use the ribbon command Chart | Add chart element  to choose the entry Up/down bars and select
More in the following submenu to open the dialog box.

Alternatively: Select any data series and right-click to open the context menu and select the entry Series:
Properties.

3. Switch to the Options tab and enable the checkbox in front of Show up/down bars with gap. In the input
field below, you can set the gap between the bars.

For more information on the options of the dialog box, see Data series and data points, "Options" tab.
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Editing chart elements

Charts consist of several components. In addition to the data series themselves, for example, there are axes, a
legend, etc. These individual components of a chart are called the chart elements.

The following figure shows the most important chart elements:

Series 1, Series 2, etc. represent the chart's data series.

Three-dimensional chart types contain some additional chart elements (floor, walls, etc.), which will also be
described on the following pages.

Each of these chart elements can be selected at the click of a mouse and then edited.

Selecting chart elements

To select a chart element, first click on the chart itself to select it and then click on the desired chart element.
To select a data series, for example, click on any value within this series.

Note: To select a single value within a data series, first click on the data series and then click on the desired
single value.

Tip: Alternatively, you can select chart elements by expanding the list of elements on the ribbon tab Chart |
group Chart elements and selecting the desired element from it. Here, you can always see which chart
element is currently selected.
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Changing the position and size of chart elements

The position and size of some chart elements (for example, the legend) can be changed. To move an element,
select it and then drag it to the desired position. To change its size, drag one of the round handles surrounding
the element.

Changing the fill and borders of chart elements

The fill color and border lines of chart elements can be applied directly with the buttons of the command group
Chart elements on the ribbon tab Chart. To do so, select a chart element and make the desired adjustments
using the buttons Fill color, Line color, Line style and Line thickness.

Note: In the case of the buttons Fill color and Line color, the last color that you used will be applied again when you click directly on the
icon itself. By clicking on the icon's arrow, you open the color palette.

Only for the Fill color button: If you click on the icon's arrow, you can use the entry More Fills to also apply more complex fills. For
more information, see Object properties, Fill tab. By clicking on the entry More colors, you reach a dialog box with color definitions,
which you use according to the descriptions of the section Document properties, Colors tab.

You will also find fill and border settings via the dialog box of the chart elements (see next paragraph). You can
also change other properties here, depending on the type of chart element.

Changing properties of chart elements

In addition to changing the properties of the chart itself, as described later in Changing chart properties via the
dialog box, you can also edit the properties of individual chart elements.

To change the properties of a chart's legend, for example, proceed as follows:

1. Select the chart by clicking on it.

2. Right-click on the legend to open its context menu.

Android/iOS: In these versions, you can also open the context menu with your finger: Just tap on the screen
and hold your finger there for about a second.

3. In the context menu, choose the command Legend: Properties (not the command Chart: Properties).

A dialog box will now appear in which you can make the desired settings.

Tip: Alternatively, you open the dialog box via the ribbon command Edit properties .
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Even faster: Open the dialog box by double-clicking on the desired element.

The properties that you can change in this dialog box depend on the type of chart element for which you opened
it. The following sections provide more information about all available chart elements and their respective
properties:

§ Chart area 

§ Plot area

§ Walls (three-dimensional charts only)

§ Floor (three-dimensional charts only)

§ Corners (three-dimensional charts only)

§ Data series and data points

§ Trendlines

§ Category axis (X axis)

§ Value axis (Y axis)

§ Series axis (Z axis)

§ Axis title

§ Chart title

§ Gridlines

§ Legend

Chart area

The chart area is the entire area of a chart frame.

Edit properties: To change the properties of the chart area, select it, right-click to open the context menu and
choose the command Chart area: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the chart area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the entire chart. Auto gives the chart a thin gray standard line as a border.
None removes the border. The option Custom lets you customize the line style.

If you enable the option Shadow, the chart frame will also be highlighted with a shadow. The Adjust button
opens additional settings for the appearance of the shadow effect.
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§ Fill section 

Here, you can change the fill of the chart area. Auto gives the chart area a white fill area. The fill will be
transparent if you use the option None. You can use the option Color to customize the color for the fill.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

Here, you can change the text formatting for all chart elements.

To do so, select the desired font, font size, alignment, etc.

Important: Changes will affect all chart elements, even if they were previously formatted in a different font.

Plot area

The plot area of a chart is the area where the data series, axes and gridlines are drawn.

Changing properties: To change the properties of the plot area, select it, right-click it and choose the command
Plot area: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the plot area.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the plot area. To do so, use the option Custom to select the desired line style.
The option None removes the border.

§ Fill section 

Here, you can change the fill of the plot area. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Walls (three-dimensional charts only)

 Walls are the back walls of charts that use a three-dimensional chart type.

Changing properties: To change the properties of the walls, select one of the walls, right-click it and choose the
command Walls: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the walls.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the walls. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the walls. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Floor (three-dimensional charts only)

Floors are only present in three-dimensional chart types.

Changing properties: To change the properties of the floor, select it, right-click it and choose the command
Floor: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the floor.

You can make the following settings:
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Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can add a border to the floor. To do so, use the option Custom to select the desired line style. The
option None removes the border.

§ Fill section 

Here, you can change the fill of the floor. To do so, use the option Color to select the desired fill color. The
fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Corners (three-dimensional charts only)

Corners are only present in three-dimensional chart types.

Changing properties: To change the properties of the corners, select one of them, right-click it and choose the
command Corners: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements.

You can make the following settings:

3D view tab

Here, you can set the 3D effect for the entire chart. For more information, see Chart properties, 3D view tab.

Data series and data points

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, pie segments, etc., depending on the chart type selected.

A data series is the graphical representation of a column or row of cell values on which the chart is based. Each
data series, in turn, consists of multiple data points, thus the individual cell values.
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Changing properties: To change the properties of data series or single data points, proceed as follows:

§ If you click on any of the data points of a data series, the entire data series will be selected. You can now
edit the properties of this data series by right-clicking on it to open the context menu and then choosing the
command Series: Properties. 

§ If you click on the same data point once again, only this single data point will be selected. The command in
the context menu is then called Point: Properties.

Tip: Alternatively, you can choose these commands via the Edit properties icon  on the ribbon tab
Chart | group Chart elements after you have selected the data series (or the data point).

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section (or Line section) 

Here, you can change the line style used to draw the graph. To do so, use the option Custom to select the
desired line style. The option None removes the line.

If you enable the option Shadow, the graph will also be highlighted with a shadow. You can use the Adjust
button to make other settings for the appearance of the shadow effect. (For some chart types, the option
Smooth line appears here instead, which enables you to give the graph a smoother gradient.)

§ Fill section 

Here, you can change the fill of the data series/data points. Auto gives the fill area a standard color. The fill
will be transparent if you use the option None. You can use the option Color to customize the color for the
fill. The color for negative values can be assigned a different color for certain chart types.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

§ Marker section (available only for certain chart types) 

Some chart types (for example, certain types of line charts) draw markers for each data point. Here, you can
customize the appearance of such markers.

3D format tab

Note: The options on this tab are available only for certain chart types.

Use this tab to add a light effect or bevels to the data points to be displayed.

§ Material 

Here, you can select the material that should be simulated to display the data points.
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§ Light 

Here, you can select the type of light that should be simulated.

§ Angle 

Here, you can change the angle of the light source.

Tip: The above effects usually look better if you also use the following option to add bevels to the data
points.

§ Bevels section 

Here, you can add a bevel effect to the graphical representation of the data points. If you apply these options
to a bar chart, for example, the edges of the bars will be rounded. The larger the value, the rounder the edges
will be displayed.

Data labels tab

Use this tab to add labels to the selected data points. This is useful, for example, if you want to have the exact
values displayed for each data point.

§ Display section 

Here, you can specify the type of label to be displayed. The default option is Don't show, thus no label is
displayed. If, for example, you select the option Show value, the value of the relevant data point will be
displayed, while the option Show data point will display its name, etc.

§ Display legend key in label 

If you enable this option, the legend keys of the relevant data points will be displayed before the labels. The
legend key is a small square in the same color as the data point.

§ Placement section 

Here, you specify where the label should be placed (relative to the respective data point).

Note: If you label data points, you can also click on these labels in the chart. Thus, you can change their
properties by selecting a different font or changing the text you want to display, for example.

The following program response also applies here: Clicking once selects all labels of a data series, while
clicking again selects a single label.

Error bar Y tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to add error bars to the data points of the selected data series. Error bars display the
possible/tolerable error of the values in the form of a line with a short dash at the end.



333Charts

Chart with "Plus" and "Minus" error bars

To add error bars, select the desired type of error bar in the Display section: Plus only displays a positive error
bar, Minus only displays a negative error bar, Plus and minus displays both error bars.

The option Show as lets you determine the appearance of the error bars: with or without short dashes at the
ends.

In the Value section, you can change the length of the indicator line. If, for example, you select the option
Fixed, the line will always have the specified length, while if you select the option Percent, the length will
correspond to the specified percentage of the respective Y value, etc.

Error bar X tab

Note: This tab is only available for XY scatter charts and bubble charts.

This tab is identical to the Error bar Y tab (see above), except that it displays error bars for the X values instead
of the Y values.

Helper lines tab

Note: This tab is available only for certain two-dimensional chart types (including column, bar and line
charts).

You can use this tab to display various guides in the chart. If, for example, you enable the option Average, a
dashed line indicating the average value of the selected data series will be displayed in the chart.

You can enable guides for Average, Minimum/maximum, Standard deviation, and Linear approximation
(linear trend).

Tip: You can use the ribbon command Chart | Add chart element  | Add trendline to show other types of
trendlines in the chart if necessary. For more information, see Trendlines.

Options tab

This tab shows different settings for displaying the data series/data points, depending on the chart type, for
greater clarification of the results.

For a line chart, for example, you will find the following settings:
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Note: For other chart types, you will find different settings on the Options tab.

§ Displaying drop lines 

If you enable this option, lines will be drawn from the data points to the horizontal axis.

§ Displaying high-low lines 

If you enable this option, lines will be displayed between the highest and lowest data points (for two or more
data series).

§ Up/down bars with gap 

You can use this option to display bars between the first and last data series, for example, in a line chart with
two or more data series. In the input field below, you can also set the gap between the bars.

For the above options, you can choose between different settings of the display in the section Empty cells are
... in case individual data points are missing.

If you select the option Vary color for each data point, the data points will be automatically colored with
different colors (not available if there are multiple data series).

Tip: You can also format these chart elements, if enabled, by selecting them and right-clicking to open the
context menu where you choose the relevant entry (Drop lines, High-low lines, Up/down bars):
Properties.

Trendlines

Note: Trendlines are available only for certain chart types (including two-dimensional column, bar, and line
charts). Furthermore, they should not be stacked.

If desired, you can have a trendline shown for each data series of the chart. For more information, see
Showing/hiding the trendline.

Trendlines can be used to graphically display the trend of a data series (i.e., to what extent the data series
rises/falls on average). Trendlines can also be extended beyond the given data points, so that they display a
forecast for future values.

A statistical technique called regression analysis is used to calculate trendlines.

Changing properties: To change the properties of a trendline, select it, right-click it and choose the command
Trendline: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the trendline.

You can make the following settings:
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Format tab

§ Line section 

Here, you can change the appearance of the trendline. Auto uses a thick black standard line. None removes
the line. The option Custom lets you customize the line style.

Trendline tab

§ Type section 

Here, you can select the type of trendline to be displayed. In addition to linear trendlines (i.e. simple best-fit
lines), trendlines such as exponential or polynomial trendlines can also be displayed.

The available types of trendlines are based on the following formulas:

Linear: y = ax + b

Polynomial: y = b + c1x + c2x
2 + c3x

3 + ... + c6x
6

Exponential: y = cebx   (e = Euler's number)

Logarithmic: y = c ln(x) + b

Potential: y = cxb

Moving average: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n

§ Based on series 

Here, you can specify the data series for which the trendline is to be displayed.

§ Forecast section 

Here, you can extend the trendline beyond the existing data points.

If, for example, there are 3 data points (for example, the sales results for the 1st, 2nd and 3rd year), you can
enter a 1 for Forward. The line is then extended by an additional period (1 data point), thus displaying a
forecast for sales in the 4th year.

§ Crossing point 

Here, you can force the trendline to intersect the Y axis at a specific Y coordinate. This option is available
only for certain types of trendlines.

§ Show formula in chart 

If this option is enabled, the formula used to calculate the trendline will be displayed in the chart.

§ Show correlation in chart 

If this option is enabled, the correlation coefficient R2 of the data series will be displayed in the chart.
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§ Name section 

Here, you can change the name of the trendline if desired. This name is displayed in the legend. To do so,
select the option Custom and enter the desired name.

Category axis (X axis)

The X axis of a chart is also called the category axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the category axis, select it, right-click it and choose the
command Category axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to simply double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

Note: If the category axis contains date values, other settings appear here that are similar to the scaling
options of the value axis (Y axis). For more information, see the descriptions in the next section Value axis
(Y axis), "Scale tab".

§ Axis ends... section 

This option allows you to determine where to end the visible part of the axis: In categories or Between
categories.
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Explanation: The first, second, third, etc., data point of all data series is called the category of a chart.

§ Number of categories between... section 

By default, PlanMaker makes a tick mark on the axis for each category and labels it. You can change these
intervals via the following options:

The option Tick marks determines which categories are marked with a tick mark. Enter 1, and a tick mark
is set for every category. Enter 2, and a tick mark is set for every second category, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark is labeled. Enter 2,
and every second tick mark is labeled, etc.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis): At low end (where the category axis begins), At high end (where the category axis ends) or at the
specified category number.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. The order of the categories is also reversed
accordingly; the chart thus starts with the last category and ends with the first category.

Font tab

Use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Value axis (Y axis)

The Y axis of a chart is also called the value axis.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the value axis, select it, right-click it and choose the command
Value axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.
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§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether axis labels should be displayed and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Lowest value and Highest value sections 

These options determine where the visible part of the axis should begin and where it should end. Select
either the option Auto, which results in PlanMaker automatically determining the most appropriate values,
or select Custom and enter the desired value yourself.

§ Intersection between X and Y axis section 

You can use this option to determine where the X axis (category axis) should intersect the Y axis (value
axis):

If Auto is selected, PlanMaker automatically determines the most appropriate value, and if Maximum value
is selected, the X axis is positioned at the end of the Y axis. You specify your own Y value if you select
Custom value.

§ Major step value section 

Here, you can set the interval for the tick marks and labels on the axis. If you select the option Auto,
PlanMaker automatically determines the most appropriate values.

§ Minor step value section 

Here, you can set the interval between minor tick marks on the axis. If you select the option Auto,
PlanMaker automatically determines the most appropriate values.

§ Invert axis direction 

If this option is enabled, the direction of the axis is reversed. In a column chart, for example, the columns are
no longer drawn from bottom to top, but from top to bottom.

§ Logarithmic scale 

If this option is enabled, the axis will use a logarithmic scale (for example, 10, 100, 1000, etc.) rather than a
linear scale.

Font tab

You can use this tab to change the formatting of the axis labels.
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In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Series axis (Z axis)

The Z axis of a chart is also called the series axis. It is only available for certain three-dimensional chart types.

Tip: For more information on showing or hiding axes, see Showing/hiding axes and axis titles.

Changing properties: To change the properties of the series axis, select it, right-click it and choose the command
Series Axis: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis.

You can make the following settings:

Format tab

Tip: Lines can also be conveniently adjusted directly via the buttons of the ribbon tab Chart | group Chart
elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the axis. Auto uses a thin gray standard line. None removes
the line. The option Custom lets you customize the line style.

§ Major ticks and Minor ticks sections 

Here, you can determine whether small tick marks should be displayed to divide the axis and specify their
appearance.

§ Tick labels section 

Here, you can determine whether labels should be displayed for the tick marks and where to place them.

Scale tab

You can use this tab to change the scale of the axis.

§ Number of series between... section 

By default, PlanMaker makes a tick mark on the axis for each data series and labels it. You can change these
intervals via the following options:

The option Tick marks determines which data series are marked with a tick mark. Enter 1, and a tick mark
will be set for every data series. Enter 2, and a tick mark will be set for every second data series, etc.

The option Tick labels determines which tick marks to label. Enter 1, and each tick mark will be labeled.
Enter 2, and every second tick mark will be labeled, etc.
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§ Invert axis direction 

If this option is enabled, the direction of the axis will be reversed. The order of the data series will also be
reversed accordingly; the chart will thus start with the last series and end with the first series.

Font tab

You can use this tab to change the formatting of the axis labels.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Axis title

You can name each axis. This will then be displayed below/next to the axis. For more information, see
Showing/hiding axes and axis titles.

Edit properties: To change the properties of the axis title, select it and right-click to open the context menu and
choose the command (Category/Value) axis title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the axis title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the axis title. To do so, use the option Custom to select
the desired line style. The option None removes the border.

If you enable the option Shadow, the axis title will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the axis title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Text tab

Here, enter the desired axis title. If you delete the text completely from the input field, the axis title, as a chart
element, will be removed.

Font tab

On this tab, you can change the formatting of the axis title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Chart title

Here, you can enter a title for the chart. This is then displayed above the chart. For more information, see
Showing/hiding chart titles.

Edit properties: To change the properties of the chart title, select it and right-click to open the context menu and
choose the command Chart title: Properties.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the chart title.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style for the border of the chart title. To do so, use the option Custom to
select the desired line style. The option None removes the border.

If you enable the option Shadow, you can also highlight the chart title with a shadow.

§ Fill section 

Here, you can change the fill of the chart title. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.
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Text tab

Here, enter the desired title of the chart. If you delete the text completely from the input field, the chart title, as
a chart element, will be removed.

Font tab

On this tab, you can change the formatting of the chart title.

In addition to font, font size, and text styles, you can also set the alignment, rotate the labels and change the
numeric format.

Gridlines

You can show gridlines to make the values in a chart easier to read. (For more information, see Showing/hiding
gridlines.)

Gridlines are a network of lines that extend across the plot area, starting from one of the axes of the chart.

The following types of gridlines are available:

§ Major gridlines are indicated at every major tick mark on the axis. 

§ Minor gridlines subdivide the major grid into an even finer grid if necessary.

Changing properties: To change the properties of the major grid of the value axis, for example, select one of its
gridlines, right-click on it and choose the command Value axis major gridlines: Properties from the context
menu.

Tip: Alternatively, you can chose this command via the Edit properties icon  on the ribbon tab Chart.

You can make the following settings:

Format tab

Tip: The appearance of the lines can also be conveniently adjusted directly via the buttons of the ribbon tab
Chart | group Chart elements. For more information, see Editing chart elements.

§ Line section 

Here, you can change the line style used to draw the gridlines. Auto uses thin gray standard lines. None
removes the lines. The option Custom lets you customize the line style.

Changing the scale of gridlines

To change the distances between the gridlines, select the corresponding axis, choose its properties and make the
desired changes on the Scale tab.
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Legend

If desired, you can show a legend in the chart. For more information, see Showing/hiding the legend.

A legend is a small box that shows which data series are displayed in which color/pattern.

Changing properties: To change the properties of the legend, select it, right-click it and choose the command
Legend: Properties from the context menu.

Tip: Alternatively, you can choose this command via the Edit properties icon  on the ribbon tab Chart |
group Chart elements. The other alternative is to double-click on the legend.

Note: If you only want to edit a single legend entry (you can also apply a formatting to it that differs from that of the legend as a whole),
then click again in the area of the desired legend entry after selecting the legend. You can now choose the command Legend entry:
Properties via the context menu.

You can make the following settings:

Format tab

Tip: Borders and fill can also be conveniently adjusted directly via the buttons of the ribbon tab Chart |
group Chart elements. For more information, see Editing chart elements.

§ Border section 

Here, you can change the line style of the legend's border. To do so, use the option Custom to select the
desired line style. The option None removes the border.

If you enable the option Shadow, the legend will also be highlighted with a shadow.

§ Fill section 

Here, you can change the fill of the legend. To do so, use the option Color to select the desired fill color.
The fill will be transparent if you use the option None.

If you select the fill type Effects and click on the Customize button, the program will display a dialog box
that will allow you to also apply more complex fills (such as a color gradient). The use of this dialog box is
described in Object properties, Fill tab.

Font tab

You can use this tab to change the character format (font, font size, text styles, etc.) of the legend.

Legend tab

Here, you can specify where the legend should be displayed.

If you select the option Custom, the legend can be moved to any position (using the mouse).

If you select None, the legend will be hidden.
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Changing chart properties via the dialog box

The previous sections discussed how to edit the properties of specific chart elements. This section discusses the
properties of the chart itself.

To change the properties of a chart, click to select the chart and right-click to open the context menu. Select the
entry Chart: Properties.

Tip: Alternatively, you can open the dialog box by clicking on the group arrow  in the bottom right corner
of any command group of the ribbon tab Chart.

The settings that can be made here are described on the following pages.

Chart properties, Format tab

On the Format tab, you can change the size and positioning of the chart.

For more information, see Object properties, Format tab.

Chart properties, Properties tab

On the Properties tab, you can change the general settings of the chart.

For more information, see Object properties, Properties tab.

Chart properties, Chart type tab

On the Chart type tab, you can change the chart type:

First, select the desired Chart type on the left and then the desired Subtype on the right. For more information
on the available chart types, see Changing the chart type.

Color palette: You can change the color scheme of the chart here.

Reset all settings in chart: This option restores any changes you made to the properties of the chart back to
their original state.

On the right side of the dialog box, a Preview shows the result of your customizations. If necessary, use the

button  to open the preview.
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Chart properties, Data source tab

Use the Data source tab to modify settings related to the chart's data source area (i.e., the cells containing the
data the chart is based on).

§ Data source area 

Lets you specify the cell range containing the data the chart is based on. By default, the cells selected when
the chart was created are used. Normally you do not have to change anything here.

§ Data series are in section 

Lets you specify how the data source area will be arranged in the chart: by columns or by rows. For more
information, see Changing the arrangement of data series.

§ Data source area contains section 

Lets you specify what kind of data the data source area consists of.

Tip: If the first row of the data source area contains headings for the data listed below, check the Names
option. PlanMaker will automatically label the data series with the corresponding headings.

§ Include hidden cells 

If the data source area contains cells that have been hidden (see Showing and hiding rows/columns)), these
are normally not displayed in the chart. Enable this option if you want hidden cells to be displayed as well.

Chart properties, Series tab

Data series are the most important chart elements. They represent the data to be evaluated – in the form of
columns, bars, lines, etc., depending on the chart type selected.

The Series tab allows you to make settings for each data series of a chart.

In the Series list, first select the series whose settings you want to change. Then make the desired settings:

§ Series 

The Series list contains a list of all data series currently included in the chart.

You can use the arrow buttons to the right of the list to change the order of the data series.

Use the Add and Delete buttons to add or remove data series.

§ Data sources section 

Here, you can specify which data should represent the selected data series.

The fields in this section are filled in automatically (using the cells selected when the chart was created).
There is usually no need to change them.

The following fields can be found here:
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Name: Here you can specify the name of the data series. Either enter the cell containing the name or type in
a text string directly. This field can also be left empty, whereupon the data series receives an automatically
generated name ("Series 1", "Series 2", etc.).

Y-values: Here you can determine the cell range from which the data series should obtain the Y-values for
the data points.

Explanation: For most chart types, the Y values are the values that should be displayed in the chart. For example, the Y values
determine the height of the columns in a column chart.

X-Values: Analogous to the Y-Values option, you can determine here from which cell range the X-values
for the data series should come.

Explanation: For most chart types, the X values are irrelevant and are set to "Auto" (i.e. automatic) because they are only used to
label the category axis (X axis). XY scatter charts and bubble charts are the exception, however, as the X and Y values determine
the coordinates of the data points in these charts.

Bubble sizes: For bubble charts, there is a third parameter in addition to X and Y values: the size of the
bubbles for each data point. To do this, enter a cell range for the bubble sizes of the data points. If omitted,
all bubbles will have the same size.

§ Display this series as section 

Here, you can specify how the selected data series is displayed in the chart. If, for example, you have
selected a column chart as the chart type, but want a particular series to appear as a line chart, you select the
option Lines for this data series.

§ Use secondary axis for this series 

If you enable this option, a secondary value axis (Y axis) will be added to the chart for this data series.
Secondary value axes can have a different scale to primary value axes.

Explanation: It is useful to represent specific data series on a secondary axis if these data series require an axis with a completely
different scale because they contain significantly larger values than the other data series.

Chart properties, Elements tab

On the Elements tab, you can show/hide and label the various chart elements:

§ Chart title 

Here, you can enter a title for the chart. The title will then be displayed above the chart.

§ Primary axes section 

Here, you can make settings for the primary axes:

You can use the checkbox in front of each axis to enable/disable the display of this axis.

To the right of the checkbox, you can give the axis a name. This will be displayed below/next to the axis as
an axis title.

The Major grid and Minor grid options determine whether gridlines should be displayed in the background
of the chart. These grids make it easier to read the values. For more information, see Gridlines.

§ Secondary axes section 

If the chart has secondary axes, you can configure them here, similar to the primary axes (see above).
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§ Legend 

Here, you can specify the position of the legend. A legend is a small box that shows which data series are
displayed in which color/pattern. For more information, see Legend.

Chart properties, 3D view tab

Note: This tab is only available for three-dimensional chart types.

On the 3D view tab, you can change the 3D effect for the chart (for three-dimensional chart types).

§ Rotation angle and Elevation angle 

Here, you can set the viewing angle (in degrees) from which the viewer sees the chart. Rotation angle
rotates the chart around the vertical axis, while Elevation angle rotates the chart around the horizontal axis.

§ Perspective 

If this option is enabled, the chart will be distorted in perspective. You can also specify the amount of
distortion (from 0 to 100%).

§ Height  and Depth 

Here, you can change the height and depth of the chart (as a percentage of its original size).

Chart properties, Radar tab

Note: This tab is only available for radar charts.

On the Radar tab, you can make additional settings for displaying the chart (for radar charts).

§ Starting angle 

This option allows you to rotate the chart by the specified angle.

§ Orientation 

This option specifies whether the values should be arranged clockwise or counterclockwise.

§ Round radar chart 

If this option is enabled, pie segments are drawn between the axes instead of lines.

§ Polar coordinates 

If this option is enabled, polar coordinates are used instead of Cartesian coordinates. The polar coordinates
are only available if Round radar chart is enabled.

If Angle between axes is set to x, an axis will be plotted every x degrees.
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If Angle between axis descriptions is set to x, an axis label will be plotted every x degrees.

§ Limit plot area to radar 

If this option is enabled, only the area inside the radar will be filled. If it is disabled, the entire rectangle
surrounding the radar will also be filled.

Updating charts
A chart always gets the values to be displayed from the cells that were selected when the chart was created. If
values in these cells change, the chart is automatically updated and immediately shows the changed values.

Disabling automatic update

If desired, you can disable this automatic updating. To do so, choose the ribbon command File | group File
management | Properties, switch to the Calculate tab and disable the option Update automatically in the
Charts section.

If this option is disabled, the charts in the current document will only be updated when you initiate this
manually via the ribbon command Formula | group Update | Update data | Update charts.

Moving charts to another worksheet
When you create a new chart, it will always be inserted into the current worksheet. Of course you can change
its position whenever needed:

To move a chart to another place within the current worksheet, just select it with a mouse click and drag to the
desired location.

In case you want to move a chart to a different worksheet, proceed as follows:

1. Click to select the relevant chart.

2. Choose the command Chart location  on the contextual ribbon tab Chart | group Position.

3. Choose the desired option in the opened dialog box (see below) and confirm with OK.

The chart is moved accordingly.

Available options:

§ As new sheet 

When you choose this option, the chart will be transferred to its own chart sheet. PlanMaker removes the
chart from the current sheet, creates a new chart sheet for it and places the chart there.
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A "chart sheet" is a special type of worksheet: It doesn't contain any table cells, but solely the chart in its full
size. On such sheets, only commands related to editing charts are available.

§ As object in ... 

When you choose this option, the chart is placed as an object in the specified worksheet, as usual.

Saving charts as pictures
You can save an image of a chart as a picture file at any time. This makes it easier to share the chart with others
or to insert it into a web page or any other document.

To do so, proceed as follows:

1. Click to select the desired chart.

2. Choose the ribbon command Save chart as a picture  on the contextual ribbon tab Chart | group
Export.

3. In the Save as type list, select the desired picture format.

Tip: The PNG format is always a good choice here since it offers good and completely lossless compression.

4. Enter the file name under which you want to save the picture and confirm with OK.

5. Another dialog box appears. Select the desired resolution for the picture or manually enter your own values
for the width and height. Then confirm with OK.

PlanMaker now creates a corresponding picture file with an image of the chart.
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Forms
You can insert form objects into your tables and, in this way, create forms.

The following types of form objects are available:

§ Checkboxes for checking 

§ Radio buttons for selection among multiple alternatives

§ Dropdowns for selection from an expanding list

§ Listboxes for selection from a list

§ Pushbuttons for clicking

§ Spinners for increasing/decreasing values by mouse click

§ Scrollbars for increasing/decreasing values by mouse click

§ Labels for static descriptions

§ Groupboxes for visually grouping related items
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Form objects always have a Result cell. This is the cell, which holds the value that the form object returns.
Each form object can be assigned to a different result cell.

If, for instance, you insert a listbox with several entries in it, 1 is displayed in the result cell when the first entry
is clicked, 2 when the second entry is clicked, etc.

In this chapter, you will find detailed information on working with forms. It consists of the following sections:

§ Working with form objects 

The first section covers general information on working with form objects. You will learn how to insert,
edit, operate and evaluate form objects.

§ Form objects in detail 

The second section contains detailed information on each individual type of form object.

§ Options of the contextual ribbon tab "Object" 

The last section explains the commands of the contextual ribbon tab Objects. This always appears
automatically when you select a form object.

Working with form objects
In the following sections, you will find general information regarding the use and application of form objects:

§ Inserting form objects 

§ Editing form objects

§ Using and evaluating form objects

§ Form objects and Excel macros and scripts

Then, in the section Form Objects in Detail, we will cover the individual types of form objects in detail.

Inserting form objects

Inserting form objects is not much different from inserting other kinds of objects. For more information about
that, see Objects.

To insert a form object, proceed as follows:

1. Choose the ribbon command Insert | Form object  (in the group Objects).

2. Select the desired type of object from the dropdown menu.

The object is now inserted.
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Along with this, a contextual ribbon tab Object will automatically appear, where you can apply general settings
for objects (see Options of the contextual ribbon tab "Object").

For more information on the individual types of form objects, see Form objects in detail.

Editing form objects

Editing form objects is not very different from editing other types of objects (see Objects).

There is, however, one important difference:

Important: Form objects cannot be selected with a left-click by the mouse. To select a form object, click on
it with the right mouse button. 

Alternatively, you can also use the View | Object mode  ribbon command to switch to Object mode, in
which form objects can also be selected by left-clicking.

Once you have selected a form object, you can edit it like any other type of object – for example, move it with
the mouse, change its size, etc.

By right-clicking the mouse on the form object, you can modify its properties with the entry Form object:
Properties in the context menu .

For more information about the properties of form objects, see Form objects in detail.

Using and evaluating form objects

Using form objects is very much like using control elements in dialog boxes. For instance, checkboxes can by
checked or unchecked with a mouse click. A listbox entry can be selected by clicking on it, etc.

Evaluation of form objects

Form objects are evaluated through the result cell of the object. This is the cell, which holds the value that the
form object returns.

The location of the result cell can be determined individually for each form object: To do this, select the form
object, right-click with the mouse to open the context menu and select Form object: Properties. In the dialog
box, switch to the Form object tab and enter the desired cell address in the Result cell field.

For example: You have given a list the result cell D4. If you click the first entry in the list, 1 will be displayed
in D4. If you click the fifth entry, 5 will be displayed, etc.

The relationship between a form object and its result cell is also two-way: If you enter 3 into the result cell, the
third entry in the list is selected.
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Form objects and Excel macros and scripts

Microsoft Excel files can contain macros and VBA scripts that can be used by form objects. In PlanMaker, this
isn't possible, however:

Important: If you open an Excel file that has macros or scripts, you won't be able to run them; however, they
do remain in the file. So, if you open and edit such an Excel file in PlanMaker and then save it, the macros
and scripts will not be lost.

Form objects in detail
In this section, the individual types of form objects are described in detail.

The following objects are covered:

§ Checkboxes 

§ Radio buttons

§ Dropdown lists

§ Listboxes

§ Pushbuttons

§ Spinners

§ Scrollbars

§ Labels and groupboxes

Checkboxes

You can use the ribbon command Insert | group Objects | Form object | Checkbox to insert a checkbox.

Checkboxes can be used in Forms for Yes/No entries. If the box is checked, it stands for Yes; if it is unchecked,
it means No.

Using checkboxes

Simply click on the box to give it a check mark – in other words: to check it. If you click on it again, the check
mark is removed.
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Changing the properties of checkboxes

To change the properties of a checkbox, select it (e.g. by clicking with the right mouse button) and select Form
object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the checkbox itself:

§ Text 

Here, you can enter the text that is to be displayed to the right of the checkbox.

§ Value 

Here, you can specify whether or not the checkbox should be checked. This corresponds to checking the
checkbox directly in the document.

§ Result cell 

Here you specify to which cell the result of the checkbox should be returned.

One of the following values will appear in this cell:

TRUE, when the checkbox is checked.

FALSE, when the checkbox is unchecked.

The error value #N/A, when the state of the checkbox is ambiguous.

§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the checkbox is drawn with a 3D effect.
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Radio buttons

You can use the ribbon command Insert | group Objects | Form object | Radio button to insert a radio button.

Radio buttons can be used in forms to select a single option from multiple options.

Using groupboxes to combine radio buttons

Important: Radio buttons must always be used in groups of at least two.

To indicate that a group of radio buttons belongs together, enclose them in a groupbox.

First insert the related radio buttons into the document (e.g. one below the other) and then use the ribbon
command Insert | group Objects | Form object | Groupbox to wrap a group box around them.

Using radio buttons

Click one of the radio buttons to select it. Only one radio button within a group can be selected at a time.

Changing the properties of radio buttons

To change the properties of a radio button, select it (e.g. by clicking with the right mouse button) and select
Form object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.
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Form object tab

On this tab, you can make settings for the checkbox itself:

§ Text 

Here you can enter the text that is to be displayed in the radio button.

§ Value 

Here, you can specify whether or not the radio button should be checked. This corresponds to checking radio
button directly in the document.

§ Result cell 

Here you specify to which cell the result of the radio button should be returned.

As mentioned previously, radio buttons must always be used in groups of at least two. The result cell
displays which among the radio buttons is selected. When the first is selected, 1 is displayed, when the
second is selected, 2 is displayed, etc.

§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the radio button is drawn with a 3D effect.

Dropdown lists

You can use the ribbon command Insert | group Objects | Form object | Dropdown to insert a dropdown list.

You encounter dropdown lists in many dialog boxes. When you expand a dropdown, a list of available options
is shown. Such lists are ideal for forms because they reduce the required amount of typing when filling in forms
and prevent typing errors.

Using dropdown lists

Click on the arrow to the right of the list to open the list. You can now select an entry by clicking on it.

Changing the properties of dropdown lists

To change the properties of a dropdown list, select it (e.g. by clicking with the right mouse button) and select
Form object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.
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The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the list itself:

§ Lines (max.) 

Here you can specify the maximum number of lines to be displayed when the list is opened.

§ List area 

Here you specify the cell range that contains the items to be displayed in the dropdown list.

If, for example, you fill the cells F5 through F7 with the values "dog", "cat" and "mouse" and enter F5:F7 in
the list area, those three values will appear in the list.

§ Result cell 

Here you specify to which cell the result of the dropdown list should be returned.

The result cell displays which entry in the list is selected. When the first entry is selected, 1 appears. When
the second entry is selected, 2 appears, etc.

§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the dropdown list is drawn with a 3D effect.

Listboxes

You can use the ribbon command Insert | group Objects | Form object | Listbox to insert a listbox.

You encounter listboxes in many dialog boxes. They display several entries which the user can choose by
clicking on them. Such lists are ideal for forms because they reduce the required amount of typing when filling
in forms and prevent typing errors.
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Changing the properties of listboxes

To change the properties of a listbox, select it (e.g. by clicking with the right mouse button) and select Form
object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the list itself:

§ Selection type 

You should always use the Single option here.

The other options Multi and Extended allow multiple items to be selected in the list box, but return nothing
to the result cell. They are only offered for compatibility with Excel.

§ List area 

Here you specify the cell range that contains the items to be displayed in the listbox.

If, for example, you fill the cells F5 through F7 with the values "dog", "cat" and "mouse" and enter F5:F7 in
the list area, those three values will appear in the list.

§ Result cell 

Here you specify to which cell the result of the listbox should be returned.

The result cell displays which entry in the list is selected. When the first entry is selected, 1 appears. When
the second entry is selected, 2 appears, etc.

§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

If you enable this option, the list will be drawn with a 3D effect.
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Pushbuttons

You can use the ribbon command Insert | group Objects | Form object | Pushbutton to insert a pushbutton.

Note: In PlanMaker, pushbuttons cannot be used to execute macros or VBA scripts; they are merely present for
compatibility with Excel.

Changing the properties of pushbuttons

To change the properties of a pushbutton, select it (e.g. by clicking with the right mouse button) and select
Form object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the pushbutton itself:

§ Text 

Here you can specify the text that should appear on the button.

§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

Spinners

You can use the ribbon command Insert | group Objects | Form object | Spinner to insert a spinner.

Spinners allow you to increment or decrement a value by mouse click. Clicking the upward pointing arrow
increments the value, clicking on the downward pointing arrow decrements it.
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Changing the properties of spinners

To change the properties of a spinner, select it (e.g. by clicking with the right mouse button) and select Form
object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the spinner itself:

§ Parameters section 

Here you can specify the following parameters:

Current value: The current value (corresponding to the value in the result cell).

Minimum value: The lowest value allowed.

Maximum value: The highest value allowed.

Incremental change: The value that will be added/subtracted to the current value when one of the two
arrows is clicked.

§ Result cell 

Here you specify to which cell the result of the form object should be returned.

§ 3D effect 

If you enable this option, the spinner is drawn with a 3D effect.

Scrollbars

You can use the ribbon command Insert | group Objects | Form object | Scrollbar to insert a scrollbar.
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With scrollbars, values can be incremented or decremented by mouse click. Clicking the upward pointing arrow
increments the value by the specified incremental value, while clicking the downward pointing arrow
decrements it.

Furthermore, you can make larger changes by moving the slider on the scrollbar with the mouse.

Changing the properties of scrollbars

To change the properties of a scroll bar, select it (e.g. by clicking with the right mouse button) and select Form
object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change some general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the scrollbar itself:

§ Parameters section 

Here you can specify the following parameters:

Current value: The current value (corresponding to the value in the result cell).

Minimum value: The lowest value allowed.

Maximum value: The highest value allowed.

Incremental change: The value that will be added/subtracted to the current value when you click on one of
the two arrows in the scrollbar.

Page change: The value that will be added/subtracted when you click somewhere between the scrollbar's
slider and one of the arrow buttons.

§ Result cell 

Here you specify to which cell the result of the form object should be returned.

§ 3D effect 

If you enable this option, the scrollbar is drawn with a 3D effect.
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Labels and groupboxes

In addition to the form objects described above, there are two types of form objects that cannot be filled in and
are only intended for applying labels:

§ Labels 

Labels: Here, you can enter any labels that should be displayed in the form.

§ Groupboxes 

Groupboxes are rectangles that can be labeled in the top left corner. They can be used for the visual
grouping of related parts of a form.

To insert a label or a groupbox, choose the ribbon command Insert | group Objects | Form object | Label or
Group box.

The corresponding form object is then inserted. Now move it with the mouse to the desired position. You can
also resize it by dragging one of the round handles that surround the object.

Changing the properties of labels and groupboxes

To change the properties of a label or group field, select it (e.g. by clicking with the right mouse button) and
select Form object: Properties from the context menu.

Alternatively: On the contextual ribbon tab Object, click on the group arrow  in the bottom right corner of any
command group.

The program displays a dialog box with the following options:

Format tab

On this tab, you can change the size and positioning of the object. For more information, see Object properties,
Format tab.

Properties tab

On this tab, you can change general settings. For more information, see Object properties, Properties tab.

Form object tab

On this tab, you can make settings for the text that you want the label or group field to display:

§ Text section 

Here, you can enter the text to be displayed.
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§ Appearance section 

Here you can specify the character format (font, size, color, etc.) for the text.

§ 3D effect 

This option is only available for groupboxes. If you enable this option, the groupbox is drawn with a 3D
effect.

Options of the contextual ribbon tab "Object"
If you click to select a form object, the contextual ribbon tab Object appears automatically.

However, you can only apply some general options for objects here:

§ New object: This option allows you to insert a new object into the document and different object types are
available. 

§ AutoShape: This option allows you to insert a new AutoShape into the document.

§ Lines: This option allows you to insert simple lines, curves and also connectors (which you can "dock" to the
text frame) into the document.

§ Bring to front, Send to back: These options allow you to arrange the order of overlapping object frames. For
more information, see Changing the order of objects.

§ Align objects: This option allows you to align or evenly distribute two or more object frames. For more
information, see Aligning and distributing objects.

§ Group: This option allows you to combine several selected objects into one unit, which can then be treated
like a single object. For more information, see Grouping objects.

§ Duplicate: This option creates an immediate copy of the selected object.

§ Width, Height: These options change the size of the object. For more information, see Changing position and
size of objects.
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Language tools
PlanMaker has a powerful spell check. This allows you to have the spelling of text checked and corrected.
Additionally, multiline text can be hyphenated automatically.

This chapter provides information on working with this tool. It consists of the following sections:

§ Setting the language 

With the ribbon command File | Options  (Language tab), the language for spell check and hyphenation
can be set.

§ Spell check 

The spell check checks a document's text for typos and suggests corrections in the event of errors.

§ Hyphenation 

Automatic hyphenation hyphenates long words at the end of lines. By default, it is active only in text frames,
but you can also activate hyphenation for multiline text in table cells.

§ Research 

Only available in SoftMaker Office Professional and NX Universal: Look up terms on online research
platforms (Wikipedia, Oxford dictionary, Cambridge dictionary, etc.) directly from the document.

§ SmartText 

You can use SmartText to automatically correct your "favorite typos" and define abbreviations for frequently
used phrases – for example, "sd" for "sales department".

Setting the language
If you have installed more than one language, you can change the language for the spell check and hyphenation
at any time.

To do so, proceed as follows:

1. Choose the ribbon command File | Options .

Alternatively: Choose the ribbon command Review | Spell check  | Settings.

2. Switch to the Language tab.

3. Select the desired language from the list Language.

Note: Please note that there are two entries in this list for German:
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§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ “German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check
The spell check checks a document's text for typos and suggests corrections in the event of errors.

This section describes the different spell check tools in detail. The information covers the following topics:

§ Manual spell check 

The manual spell check lets you check and correct possible spelling errors of the current worksheet.

§ Check spelling as you type 

The Check spelling as you type checks each word you type immediately. When a typing mistake is detected,
a dialog box that lets you correct the word pops up.

§ Editing user dictionaries 

When you teach the spell check new words, they are added to your user dictionary. You can edit this
dictionary at any time, for example, to delete incorrect entries.

For more information on these topics in the above order, see the following pages.

Manual spell check

Note: Cells containing calculations are skipped by the spell check.

You choose the ribbon command Review | Spell check  to start the subsequent spell check. (Tip: You can
also choose this command with the F7 key.)

This checks the current worksheet word for word for spelling errors. If the spell check encounters an unfamiliar
word, it stops and displays the word in a dialog box.
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You can then choose to correct the word, add it to the dictionary or simply ignore the supposed error. The list
under Change to will also contain some suggestions for the correct spelling of the word (if any are found).

Use the buttons in the dialog box to specify what to do with the unfamiliar word:

Button Explanation

Change This option lets you correct the misspelled word. Before you use this button, type the correct
spelling in the Change to input field or select one of the suggested words from the list.

Change all This option works like the Change button, but changes all further instances of the word in the
entire document.

Ignore This option instructs PlanMaker to ignore this spelling error and continue with the spell check.

Ignore all This option instructs PlanMaker to ignore all further instances of this word.

Note: PlanMaker only remembers the list of ignored words temporarily. When you exit
PlanMaker, it forgets it. If you want PlanMaker to learn words permanently, use the command
Add instead.

Add This option instructs PlanMaker to add the word to the user dictionary and thus increase its
vocabulary.

Use this option for correctly spelled words that PlanMaker does not yet know. PlanMaker
remembers these words permanently, even after a restart.

If you want to exit the spell check before it reaches the end of the worksheet, click on Close.
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Check spelling as you type

If the option Check spelling as you type is enabled, spelling is checked as the text is typed, and the spell check
dialog box will open automatically when an unknown word is typed.

Note: When you enter a calculation into a cell, its spelling will not be checked. This would not make sense
with calculation formulas.

To enable this on-the-fly spell checking, choose the command File | Options , switch to the Language tab
and activate the option Check spelling as you type.

Now, every time you type a word, PlanMaker quickly looks up that word in its dictionaries. As long as you type
words that the spell check knows, nothing visible happens. But if you type an unknown word, the spell check
displays a dialog box.

This dialog box is similar to the dialog box for the manual spell check, presented in the previous section. You
can read there about how to use this dialog box.

You will notice that there is also a SmartText button in the dialog box. This is for creating a SmartText entry
from the word. You will learn more about this feature in the section SmartText.

Editing user dictionaries

When you teach the spell check new words, they are added to your user dictionary. You can edit this dictionary
at any time, for example, to delete incorrect entries.

To do so, click on the small arrow of the icon on the ribbon tab Review | Spell check  and select Edit user
dictionaries from the dropdown menu. The program displays a dialog box with the following buttons and
options:

§ Language 

There is a separate user dictionary for each language. You can select the user dictionary to be edited from
the dropdown list Language.

Note: Note that there are two entries for each German in this list: "German (Germany)" stands for the new
spelling and "German (Germany, old)" for the old spelling. The same applies to "German (Austria)" and
"German (Switzerland)".

§ Entries 

This list contains all words that have been added to your user dictionary (for the selected language).

§ "Close" button 

This option closes the dialog box.
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§ "Add" button 

This button enables you to manually add a word to your user dictionary. To do so, type the desired word into
the dialog box that appears after you press this button.

Words added in this way are treated exactly the same as words that were added using the Add button in the
spell check.

§ "Change" button 

Use this button to edit the word that is currently selected in the list. This is useful for misspelled words that
you have added to your user dictionary accidentally. By clicking on the button, you open a dialog box where
you can correct the spelling of the word.

§ "Delete" button 

This button deletes the word currently selected in the list from your user dictionary.

The spell check will therefore regard this word as misspelled again in the future.

Hyphenation
Automatic hyphenation hyphenates long words at the end of lines. This works fully automatically as you type.

However, the hyphenator is available only in the following cases:

§ Hyphenation in text frames 

In text frames, automatic hyphenation is enabled by default.

§ Hyphenation in table cells 

In table cells, automatic hyphenation is not active by default. However, for cells that contain multiline text,
you can enable this, if desired.

For more information, see the following pages.

Important: Of course, hyphenation only provides correct results if you have set the correct language in the

program settings. To set the language, choose the command File | Options , switch to the Language tab
and select the language from the dropdown list Default language.

Hyphenation in text frames

Whenever you enter text in a text frame, PlanMaker will automatically hyphenate it. This is performed fully
automatically in the background, as you type.

All you have to do is to make sure that the correct language is set in PlanMaker's settings (see Setting the
language).
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Setting the hyphenation frequency

If desired, you can specify how often you want the hyphenation function to separate words – or disable
hyphenation completely. This setting can be set separately for each paragraph in a text frame.

To do so, select the relevant paragraphs in the text frame, click the group arrow  on the ribbon tab Home |
group Alignment and select the desired setting for Hyphenation in the dialog box.

Alternatively, you can open the dialog box with a right-click in the text frame and select Paragraph from the
context menu.

The following options are available:

Setting Result

None No hyphenation is performed.

Always Any amount of consecutive hyphenation is attempted. This is the default setting.

Every 2 lines Hyphenation is attempted only in every second line.

Every 3 lines Hyphenation is attempted only in every third line.

If you select None, you disable hyphenation for the selected paragraphs completely, whereas if you select
Always, the program tries to hyphenate any line of a paragraph.

When do you use the other two options? It is not always a good idea to hyphenate at every point possible. For
text in narrow columns, for example, this may lead to words being split at the end of almost every line and thus
to a reduction in the document's legibility. Thus, you may want to use the option Every 2 lines or Every 3 lines
to instruct PlanMaker to attempt hyphenation only in every second or third line.

Hyphenation in table cells

In table cells, automatic hyphenation is not active by default, but it can be enabled by the user. When you do so,
hyphenation will also be performed in table cells – but only in cells that contain multiple lines of text.

Accordingly, in order to get text in table cells hyphenated, two steps are required:

Step 1: Enabling hyphenation in cells

In order for hyphenations to be performed in cells at all, you must first enable hyphenation for cells (it is
disabled by default). To enable it, proceed as follows:

1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Options tab.

3. Enable the option Hyphenation.

From now on, automatic hyphenation will also be performed in table cells.
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Note: This option is a document option, so you can enable or disable it for each document individually.

Step 2: Enabling the Wrap Text option for cells

Hyphenations will be performed only in table cells that have the Wrap text option enabled. When you enable
this option, the cell content will automatically be wrapped to multiple lines if it doesn't fit into a single line.

To enable the option Wrap text proceed as follows:

1. Select the relevant cells.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Number.

Alternatively: Right-click to open the context menu and select the entry Cell.

3. Switch to the Alignment tab.

4. Enable the option Wrap text.

Text entered in these cells will from now on be wrapped to multiple lines automatically, and automatic
hyphenation will be performed where necessary.

Research

Note: This feature is only available in SoftMaker Office Professional and NX Universal.

You can use the Research function to look up the meaning of the terms you selected in PlanMaker directly in
online dictionaries and encyclopedias. PlanMaker suggests various online research platforms (Wikipedia,
Oxford dictionary, Cambridge dictionary, etc.) that you can open interactively for your search.

To do so, proceed as follows:

1. Select one or more terms in your document.

2. Choose the ribbon command Review | group Spelling | Research .

3. In the dropdown menu, click on the desired platform on which you want to look up your research term.

The selected online platform will then be opened directly with the results for your selected term.

Available categories

In the open dropdown menu of the Research icon , you can choose from the following categories:

§ Recently used 

The platforms most recently used by the research function are displayed here for quick access again (the last
3 searches).
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§ English (depending on the selected language)

General reference books are displayed here in the language you selected in the settings (see "More" below).

§ German - English (depending on the selected languages)

If you have selected multiple languages in the settings (see "More" below), this category will appear with
translation platforms corresponding to the selected languages.

§ More

You use the entry More to open a dialog box with the settings. Here, you specify the languages for which
PlanMaker should suggest research platforms to you. Enable the desired language(s) by clicking on the
respective checkbox.

This results in the menu of the Research icon displaying the general reference books and translation
platforms for all languages you selected, insofar as they are available in these languages.

SmartText
PlanMaker's SmartText function can save you a lot of work: You can create SmartText entries for frequently
used phrases and then insert them instantly in the text.

For example, create a SmartText entry called "sd" with the content "sales department". You can now retrieve
this SmartText entry at any time. To do so, simply type "sd" and then press the space bar, the Enter key¿ or a
punctuation mark. "Sales department" immediately replaces "sd".

In this way, you can create your personal "computer steno" with PlanMaker and save a lot of time when typing.

In this section, you will learn about working with SmartText entries:

§ Creating SmartText entries 

New SmartText entries can be created in a dialog-box-controlled manner with the ribbon command Insert |
group Text | SmartText or via the spell check. A name (for example, "sd") and the desired content must be
specified (for example, "sales department") for each text module.

§ Inserting SmartText entries 

If the option Expand SmartText entries is enabled in the program settings, SmartText entries can be
inserted very easily: To do so, type the name of the SmartText entry and then press the space bar, Enter
key¿ or a punctuation mark. The name will be immediately replaced by the content of the SmartText entry.

Alternatively, entries can be inserted manually with the ribbon command Insert | group Text | SmartText.

§ Editing SmartText entries 

Not only can you create new SmartText entries with the ribbon command Insert | group Text | SmartText,
but you can also edit, rename or delete existing ones.

For more information, see the following pages.
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Creating SmartText entries

You can choose to create SmartText entries a) in a dialog-box-controlled manner or b) using Check spelling as
you type:

A) With the command Insert | SmartText

To create a SmartText entry with the name "sd" and the content "sales department", for example, proceed as
follows:

1. Choose the ribbon command Insert | group Text | SmartText .

2. Click on the New button to create a new SmartText entry.

3. Give the SmartText entry a name ("sd" in our example).

The SmartText entry can be retrieved later by its name.

4. Confirm with OK.

5. Now, type the text for the SmartText entry in the large input field on the right (in our example: "sales
department").

6. Click on Save to save your new SmartText entry.

7. Exit the dialog box with Close.

The SmartText entry has now been created. You will find out how to insert it in the next section (Inserting
SmartText entries).

B) Via the option "Check spelling as you type"

If you have enabled Check spelling as you type, you can also create SmartText entries as follows:

1. In the dialog box of the ribbon command File | Options  (on the Language tab), make sure that the
option Check spelling as you type is enabled.

2. Type the two letters "sd" and press the space bar.

3. The on-the-fly spell check displays a dialog box indicating that the word "sd" is unknown.

4. Click on the SmartText button.

5. In the open dialog box, type "sales department" into the large input field on the right.

6. Confirm with OK.

The result is the same: The SmartText entry "sd" has now been created.

For more information on the option Check spelling as you type, see Check spelling as you type.
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Inserting SmartText entries

You can now insert the SmartText entry created in the previous section at any time.

This is very simple: Type the name of the SmartText entry in a cell or in a text frame – "sd" in our example –
and then a space, a punctuation mark or Enter¿. PlanMaker immediately replaces "sd" with the content of the
SmartText entry: "sales department".

Note: If this does not work, the option Expand SmartText entries is disabled. Choose the command File |
Options and enable this option again on the Edit tab (or in the dialog box of the command Insert | group
Text | SmartText).

Alternatively, you can access the defined SmartText entries via the dialog box by choosing the ribbon command
Insert | group Text | SmartText, selecting the desired SmartText entry on the left side of the dialog box, and
then clicking on the Insert button.

Tip: Do not expand SmartText entries

If you do not want a defined SmartText entry to be inserted when you type in the text, then use the key
combination Alt+. (period) in the place directly behind the SmartText entry. In this case, the specified addition
is then suppressed.

Editing SmartText entries

By choosing the ribbon command Insert | group Text | SmartText , you can still edit the already created
SmartText entries via the dialog box:

§ Creating a new SmartText entry 

Click on the New button to create a new SmartText entry in the dialog box. For more information, see
Creating SmartText entries.

§ Deleting a SmartText entry 

To delete a SmartText entry, select it in the list SmartText entries on the left of the dialog box and then
click on the Delete button.

§ Renaming a SmartText entry 

To change the name of a SmartText entry, select it in the list on the left, and click on the Rename button.
The program displays a dialog box in which you can enter the new name.

§ Editing a SmartText entry 

To edit an entry, select it in the list on the left and then click in the large input field on the right of the dialog
box. You can now change the content of the SmartText entry.
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When you have made the desired changes, click on the Save button.

§ Inserting a SmartText entry 

To insert a SmartText entry into the text, select it in the list on the left of the dialog box and click on the
Insert button. For more information, see also Inserting SmartText entries).

You can finally exit the dialog box with the Close button. If the enabled SmartText entry has been changed but
not yet saved, PlanMaker will ask automatically if it should save the changes.
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Document management
PlanMaker has functions that make it easier for you to manage and access your documents faster:

§ Quick paths 

You can create quick paths in PlanMaker in order to quickly switch to frequently used folders when opening
or saving files.

§ Document summary 

Every document can have some additional info that you can display and edit using the Summary tab in the
dialog box of the ribbon command File | Properties. You can enter the title, subject and author of the
document, specify keywords for the file manager's search function and write a brief summary of the content.

§ File manager 

You can use the integrated file manager to easily access your documents. It allows you to see the names and
the document infos on the Summary tab for all documents at a glance. You can view, open, print or delete
documents at the touch of a button.

The Search function of the file manager not only lets you search for your documents by file name, but it
also allows you to search by topic, title, author, etc.

§ Backup copies (file versions) 

If desired, PlanMaker creates a backup copy of the document each time the document is saved. You can even
instruct the program to automatically take "snapshots" of the document at regular intervals while you're
working on it.

The following pages provide detailed information on these functions.

Quick paths
PlanMaker allows you to create up to twenty quick paths via which you can quickly switch to a specific folder
when opening or saving files.

A quick path is a symbolic specification, such as "Taxes", which represents a specific folder on the hard disk
(for example, the folder C:\Accounting\Taxes).

If you want to open a file from this folder, you must first choose the ribbon command File | Open and then
simply click on the Quick path button in the dialog box to select the created quick path. The dialog box then
switches immediately to the C:\Accounting\Taxes folder.

Quick paths are not only available in the dialog box of the command Open, but they are also in all other dialog
boxes that are used to open or save files.
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Creating quick paths

To create a new quick path, proceed as follows:

1. Open any file dialog box, for example, with the ribbon command File | Open. (Click directly on the icon
itself to open the file dialog box.)

2. Click on the Quick path button in the file dialog box.

3. A menu opens below the button. Choose the command Create new quick path from it.

4. Enter any name for the quick path in Name of quick path – for example, "Taxes".

5. Enter the desired folder under Path – for example, "C:\Accounting\Taxes".

Tip: Alternatively, click on the button with the three dots next to this input field. This opens a file dialog
box in which you can easily select the desired folder.

6. Confirm with OK.

PlanMaker now knows that the quick path "Taxes" should switch to the folder C:\Accounting\Taxes.

Opening quick paths

Quick paths are available in all file dialog boxes – for example in the dialog boxes of the ribbon commands File
| Open or Insert | Picture frame. (Click on the icon itself to open the file dialog boxes.)

To use a quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu of all the previously created quick paths opens. Select the desired quick path.

PlanMaker now switches to the folder specified for the quick path.

Editing and deleting quick paths

To edit or delete an existing quick path, proceed as follows:

1. Click on the Quick path button in a file dialog box.

2. A menu opens. Choose the command Change quick paths in it.

3. A dialog box appears. Select the desired quick path in it.

4. Click on Change to edit the name or path, or click on Delete to remove the quick path.
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Document summary

The ribbon command File | group File management | Properties  not only enables you to make document-
specific settings but also to enter some document info on the Summary tab.

You can enter additional information (such as subject, author, keywords, etc.) about a document here. To view
or edit such information, choose the command File | Properties and switch to the Summary tab.

Make the desired changes and confirm with OK.

Tip: You can use the file manager (see next section) to search for documents by their document info, for
example, to find all documents on a specific topic.

Automatic prompt for summary information when saving: You can have PlanMaker prompt you to fill in the
document summary whenever you save a new document.

To do so, choose the ribbon command File | Options , switch to the Files tab and enable the option Prompt
for summary information when saving. The dialog box for entering the document info on the summary tab
will now appear every time you save a new document for the first time.
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File manager

Android/iOS: The File manager is not available in these versions.

The file manager displays a list of documents from one or more folders and lets you open, print, delete or view
any document by clicking on it.

You start the file manager with the ribbon command File | File manager .

You can use the mouse to move or resize the file manager window at any time. You can also change the column
widths by dragging the separator lines between the column headings.

By clicking on one of the column headings, you can specify the column according to which the files are to be
sorted.

You can use the Search button to select a different folder and also use the Search function to start searching for
files. Furthermore, you can search for a specific title, subject, author, keyword, etc., within the Document
summary located on the Summary tab.

To perform an action with a file, select the file and then click on one of the buttons. The individual buttons
have the following functions:

§ Open 

If you click on this button, PlanMaker opens the selected file.

Tip: You can also double-click on a file name to open the file.

§ Close 

Clicking on this button will close the file manager.
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§ Search 

Click on this button to search for specific files or simply to select the folder you want to display in the file
manager. For more information on searching with the file manager, see the next section.

§ Output 

Use this button to output the selected file. When you click on the button, a menu opens with the following
functions (depending on the operating system):

E-mail: Send the document by e-mail

Print: Print the document

§ Delete 

If you click on this button, the selected file will be deleted (after confirmation).

§ Preview 

Click on this button to open a preview window where you can view the selected document without having to
open it.

To actually open this document, click on the Open button in the preview. To exit the preview window, click
on the Cancel button.

§ Rename 

If you click on this button, you can rename the selected file.

Searching with the file manager

Android/iOS: The File manager is not available in these versions.

You can use the Search button in the file manager to have PlanMaker search for specific files or simply choose
the folder to be displayed in the file manager.
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You can search for files that meet the following criteria: file name, folder, file type and the document info (title,
subject, author, keywords) on the Summary tab.

Several search criteria can also be combined. If, for example, you specify a specific folder in the dialog box,
PlanMaker will display all documents in this folder. If you also enter a search term in the Title field, however,
PlanMaker will find only those documents that are both in the selected folder and contain the specified search
term in the Title field on the Summary tab.

With the dialog box shown above, you control the search function:

§ File name 

You can use this input field to search for specific files.

If you do not enter anything here (thus accept the default setting), the search function will find all
documents of the selected file type in the selected folder.

If you specify a unique filename like MyReport.pmdx, only documents with the exact same name will be
found.

If you specify an ambiguous file name like My*.pmdx, the search will find all PlanMaker documents whose
file name begins with "My".

§ File type 

You can use this list to select the type of the files to be targeted in the search. If, for example, you want to
search for files in Excel Format, select this format from the list File type.

§ Title, Subject, Author, etc. 

By entering content in these fields, the file manager will search the document info of your documents (see
Document summary).

If you fill in several fields, the file manager will search for documents that meet all of your specified
conditions. If, for example, you enter "court" in the Keywords field and "Smith" in the Author field, only
documents whose document info contain corresponding entries for both fields will be found.

You can also specify only part of the term for which you are searching. If, for example, you entered "court"
as the search term in the Keywords field, your search would return all documents that contained the word
"court" – thus terms like "courthouse", and "district court" would be found.
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Case is of no significance for search terms. If the search term is entered as "court", the search will also find
documents whose keywords contain "Court".

§ Folders 

Here, you can select the folder in which the file manager should perform the search.

§ Include subfolders 

If this option is enabled, the file manager not only searches the selected folder but also all folders that are
subordinate to it.

§ New list button 

If you click on this button, you start a new search with the current settings.

§ Add to list button 

Clicking on this button also starts a new search; however, any previous search results remain in the list
instead of being cleared from the list.
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Backup copies (file versions)

Android/iOS: In these versions the functions are not available in this form. Only simple backups can be
made on Android/iOS, and this setting can be found on the Files tab.

If desired, PlanMaker creates a backup copy of the previous version of the document each time the document is
saved. You can even instruct the program to automatically take "snapshots" of the document at regular intervals
while you're working on it (similar to the common Auto-Recover function). You can also access these snapshot
versions later even if you have not saved the document manually using the command File | Save.

The settings for this can be found on the Backup tab in the dialog box of the command File | Options .
Select here whether and how file backups are to be created:

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is selected, the command File | Versions  (in the group File management) is also
available and can be used to easily return to a previous file version of the document that is currently open
(see below).

Use the Number of versions to keep field to specify the maximum number of versions of backups
(generations) to be kept per document.

§ Automatically created file versions ("snapshots")

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

In the dropdown field below, enter the maximum number of snapshots you want to save.

§ Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

§ "Clean up" button

This button provides the following two commands for deleting backups:

Delete orphaned file versions removes all file backups for which the corresponding original document
no longer exists.

Delete file versions of all documents removes all file backups in the folder for file versions.

How do I use the command "File | Versions"?

If you enable the creation of file backups (see above), all backups end up in a special Backup folder. This
folder is managed automatically by the program. We do not recommend that you manually move or rename the
files in this folder.
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To return to a previous version of a document, you don't need to be interested in this folder at all – as there is a
separate command for it: File | Versions.

You can use this command to revert to a previous version of a document as follows:

1. Open the desired document (if it is not already open).

2. Choose the ribbon command File | group File management | Versions . (Click directly on the icon itself
to open the version manager.)

Tip: You can proceed even faster by clicking on the icon's arrow for the dropdown menu instead of on the
icon itself. The available backups are listed here. Restore the desired version by clicking on the version
entry – this will open the version in a new document window.
However, the icon  to the right of it will open the version in the current document window. (Warning:
This will overwrite the currently open document with an older version.)

If you click on the small black arrow of the Versions icon and select the entry File versions in the menu that
appears, you will reach the version manager, which will provide you with additional details for a better
overview. For more information, see the following steps 3. and 4.

3. Version manager: The program displays a dialog box that lists all available backups for the current
document. Use the dates and times to find and select the version that you want to restore. You can use the
Preview button to display a preview of the selected version.

The version manager list shows that a backup for the Test.pmdx file might be called
Test.pmdx.135.pmbak, for example. Thus, a sequential number and the extension .pmbak are always
appended to the file name (and an "s" is also inserted into the sequential number for snapshots).

4. If you click on the Restore button, the selected previous version of the document will be restored in the
current window.

Warning: The currently open document is now replaced by the selected previous version. So if you save it
now, you're overwriting the current version with an older version!

Alternatively, you can also click on the Open as copy button. This opens the selected file version in a new
document window (instead of replacing the document in the current window). This is useful if you want to
compare the current version with an older version.

What should I do if I lose the original file?

The aforementioned procedure only works if the original document is still available. What should you do if the
original file has been lost, for example, because it was accidentally deleted?

Even in this case, you can still access the backup copies of this document (unless they have been deleted as
well). Simply open the backup copy itself.

You can see where the backups are in the dialog box of File | Options . On the Backup tab, the file path is
displayed below in the Folder for file versions field. By default, this is a folder called Backup within the
SoftMaker folder.

When you open a backup from this folder in your file browser, PlanMaker immediately starts to open the file.
The procedure is as follows:
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1. In your file browser (for example, Windows Explorer), navigate to the Backup folder.

2. In this folder, search for files whose name starts with the name of the original file. A backup for the
Test.pmdx file might be called Test.pmdx.135.prbak, for example. Thus, a sequential number and the
extension .pmbak are always appended to the file name (and an "s" is also inserted into the sequential
number for snapshots).

Tip: The higher the sequential number in the file name, the more recent the file version.

3. In the file browser, double-click on the file version that you want to open.

4. PlanMaker detects that you are trying to open a backup and asks you what you would like to do now. It
displays a dialog box with the following options:

Open the backup file: This option opens the selected file version.

Invoke the version manager: This option opens the version manager like the command File | group File
management | Versions. This then offers all available earlier versions of the original document for
selection. For more information on using this command, see above.

Open the original file: This option opens the original file for this file backup. (Of course, this only works if the
original file still exists.)

5. Make your choice, and then click on OK.

Once again, please note that PlanMaker automatically creates and manages the files in the Backup folder.
Thus, you should not make any manual changes to these files, such as renaming or moving the files.

If you need more space on the disk, you can delete all files in this folder at any time, but then you will lose all
file backups as a result.
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Outlines
The Outliner allows you to create an outline for a worksheet. In outlined worksheets, you can easily decide
whether just the summarized data should be displayed or the detail data should appear as well.

The process of creating an outline is about grouping consecutive cell rows that contain related detail data. For
example, if a table contains sales figures for the last few years, with the monthly sales listed below each year,
group each list of monthly figures. After that, you can hide/unhide (or, collapse/expand) the monthly sales for
each year with a single mouse click.

Outlines can contain various outline levels, allowing you to nest the data to be displayed as desired.

Using the Outline pane

In worksheets containing an outline, a pane named Outline pane is displayed to the left of the document
window.

Use the Outline pane to hide/unhide grouped cells:

§ Click the Plus  and Minus  signs to hide/unhide groups of cells. 

§ Click the  buttons on top of the Outline pane to determine which outline levels to display. For
example, if you click the "2" button, all cells with an outline level between 1 and 2 will be displayed.

Note: Worksheets can be outlined by row or by column. In a column outline, columns are grouped instead of
rows. In this case, Outline pane is displayed above the table.
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Using the command group "Outline"

You will find the commands for grouping cells on the ribbon tab Data | group Outliner.

This command group provides the most important icons for working with outlines:

§ Group the selected cells 

§ Ungroup the selected cells

§ Clear outline of the selected cells

§ Show details (equivalent to clicking on the Plus icon in the Outline pane)

§ Hide details (equivalent to clicking on the Minus icon in the Outline pane)

The following pages contain detailed information on working with outlines.

Grouping cells
To create an outline, group the rows (or columns) containing detail data. After that, you can hide/unhide such
groups with a single click.

To group cells:

1. Select the rows (or columns) to be grouped.

2. Choose the ribbon command Data | group Outliner | Group .

The cells are now grouped.

Note: Ungrouped cells have an outline level of 1. When you group cells, their outline level is set to 2. You can
even group a subset of cells within a group of cells, thereby increasing the outline level to 3, etc. Outlines can
contain up to 8 outline levels.

Ungrouping grouped cells

You can ungroup cells at any time.

To do so, proceed as follows:

1. Select the rows (or columns) to be ungrouped.

2. Choose the ribbon command Data | group Outliner | Ungroup .
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The cells are now ungrouped. To be precise, their outline level is reduced by 1. This means, that if you ungroup
cells with an outline level of 3, they will not be completely ungrouped, but their outline level will be reduced to
2.

Completely removing the outline of grouped cells

If you want to completely remove the outline of cells, proceed as follows:

1. Select the rows (or columns) whose outline you want to remove. Note: If you do not select any cells, the
outline of the entire worksheet will be removed.

2. Choose the ribbon command Data | group Outliner | Remove all groups .

The outline is removed; all cells now have outline level 1.

Showing/hiding grouped cells
If you have created an outline for a worksheet (as described in the previous section), you can hide/unhide detail
data (i.e., grouped cells) at any time as required.

To hide/unhide grouped cells, use the Outline pane:

§ A bar with a minus sign  is displayed next to grouped cells in the outline pane. To hide the grouped cells,
click the minus sign. 

§ A plus sign  indicates grouped cells that are currently hidden. To unhide the grouped cells, click the plus
sign.

§ Click the  buttons on top of the Outline pane to determine which outline levels to display. For
example, if you click the "2" button, all cells with an outline level between 1 and 2 will be displayed.

For rows, the commands Show details  and Hide details  on the ribbon tab Data | group Outliner can also
be used to hide or unhide the grouped cells (corresponds to the plus and minus signs in the outline pane, see
above).

Note: When you hide cells, the cells are not only hidden on the screen, but also ignored by charts evaluating
these cells.

Changing outline settings
You can change outline settings via the dialog box Outliner options. To open this dialog box, click on the group
arrow  in the bottom right corner of the ribbon tab Data | group Outliner.

Here you can make the following settings for the structure of the current worksheet:
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§ Title below group rows 

A title line is a row directly above or below grouped cells.

This option basically only determines whether the plus and minus signs should be displayed above or below
the bar for grouped cells in the outline pane.

Enable this option if you want this title bar to be located below the grouped cells. Disable it if you want the
title bar to be above the grouped cells.

§ Title right of the group columns 

Similar to above, except this option only affects worksheets with a column outline. You can use it to
determine whether the title is located to the left or right of the grouped cells.

§ Automatically show Outline pane 

This option determines whether the outline pane should be displayed automatically if the worksheet contains
grouped cells.

If this option is enabled, this pane appears automatically as soon as the worksheet contains at least one group
of cells. If disabled, the Outline pane will not be displayed.

§ Protect outline 

If this option is enabled, the outline will be protected if sheet protection is enabled for the worksheet (see
Sheet protection).

The current state of the outline will then be frozen. Users will not be able to group/ungroup cells or
hide/unhide grouped cells.
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Internet functions
This chapter provides information on PlanMaker's most important Internet functions:

§ Using hyperlinks 

You can create hyperlinks in PlanMaker documents (e.g., to an Internet address or to another PlanMaker
document).

§ Saving documents in HTML format 

PlanMaker documents can also be saved in HTML format. To do so, choose the ribbon command File | Save
as and select the HTML format from the dropdown list Save as type.

For more information, see the following pages.

Using hyperlinks
With the ribbon command Insert | group Links | Hyperlink you can add a hyperlink to cell contents or
complete cells at any time. Hyperlinks are links to e.g. websites or other documents, which can then be opened
simply by clicking on the link.

If, for example, you link a cell to a web page, the web browser will automatically start when you click on this
link and will access this page in it.

By the way, the file path of another document is also allowed as a destination for hyperlinks. This is then
opened automatically when you click on the link.

Tip: It is also possible to use an e-mail address as a destination by placing "mailto:" in front of it.

Creating a hyperlink

To create a hyperlink, proceed as follows:

1. Select the cell or cell contents to which you want to attach a hyperlink.

2. Choose the ribbon command Insert | group Links | Hyperlink .

3. For URL or file name, specify the destination for the hyperlink: Enter the path and name of the Internet
resource or file to which you want the selected text to refer.

For links to web pages, "http://" and the address of the page should be entered – for example,
"http://www.example.com".

For links to an e-mail address, enter "mailto:" and the recipient's address – for example,
"mailto:xy@example.com".

For links to a file, the Browse button can be used.
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4. In the Jump target field, you have the option of specifying the target position (a bookmark or a cell
address) in the document to be opened (see below). However, this field is usually left empty.

5. Confirm with OK.

Note: The Reset button allows you to undo all changes made in the open dialog box provided that you have not yet confirmed them with OK.

The hyperlink is now created. You recognize this by a change in the color of the text, which indicates the
presence of a link.

Tip: Alternatively, hyperlinks can also be added using the HYPERLINK function (which is much more
flexible)

Jumping to specific bookmarks or cell references

The aforementioned dialog box also gives you the option of specifying the jump target in the document to be
opened, if necessary. For Jump target, enter the bookmark (for HTML documents) or the cell address (for
PlanMaker documents) to which you want to jump.

For example: If you set URL or file name to "Sales.pmdx" and under Jump target you enter "D42", the link
will open the file Sales.pmdx and jump to cell D42.

Using placeholders in links

Tip: In hyperlinks, you can use an asterisk (*) as a placeholder for the cell content.

Example:

If the cell is still empty, choose the ribbon command Insert | group Links | Hyperlink and enter http://* in the
URL or file name box. After that, if you enter e.g. www.example.com in that cell, the link will point to the
Internet address http://www.example.com.

This also works with other protocols – for example mailto:* can be used to create a link to the e-mail address in
a cell.

Opening hyperlinks

To open a hyperlink, simply click on the cell or text containing the hyperlink with the mouse. PlanMaker then
opens the linked document.

Editing or removing a hyperlink

Existing hyperlinks can be edited as follows:

§ Changing destination 

To change the destination of a hyperlink, select the cell(s) or text passage with the link and then choose the
ribbon command again Insert | group Links | Hyperlink. The program again displays the dialog box in
which you can edit the destination for the link.

To remove a hyperlink, proceed as follows:
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§ Removing a hyperlink by deleting the link text/cell 

If you delete a cell or text passage that contains a hyperlink, the link is also removed.

§ Removing only the hyperlink 

If you only want to remove the hyperlink, but retain the associated cell or text passage, select it and choose
the ribbon command Home | group Contents | Delete | Remove link.

Saving documents in HTML format
To save a document in HTML format, proceed as follows:

1. Choose the ribbon command File | Save as.

2. Select the HTML format from the dropdown list Save as type.

3. For File name, enter the name under which the file is to be saved and confirm saving.

The document is now saved in HTML format.

All formatting not supported in HTML format is automatically removed. Among other things this means:

§ Formatting that the HTML format does not recognize is not saved. 

§ Furthermore, HTML files are not able to perform calculations on their own. Therefore, when saving in
HTML format, PlanMaker calculates the entire worksheet and replaces all calculation formulas with their
results.

Tip: After saving, open the document with your web browser to check its final appearance.
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Outputting documents

Android/iOS: In these versions the commands are not freely available. By clicking on the command icon,
users of SoftMaker Office NX Home and NX Universal can unlock the features free of charge via their
product key or otherwise via Google Play/Apple App Store (subject to a fee).

This chapter provides information on how to output documents via PlanMaker.

The chapter contains the following sections:

§ Print preview 

The first section deals with the command File | Print preview. This displays the document on the screen
exactly as it will appear on the printout, thus saving unnecessary test prints.

§ Printing a document 

To actually print the current document on the printer, choose the command File | Print.

§ Exporting a document as a PDF file 

You can also export a document to a PDF file by choosing the command File | PDF export.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there.
All formatting and objects of the document are retained exactly as in the original file.

§ Sending a document by e-mail 

Finally, documents can also be sent by e-mail. The command File | Send is responsible for this process.

See the following pages for more detailed information on these functions.

Print preview

Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

The print preview displays a document on the screen exactly as it will look in the printout. This feature enables
you to avoid wasting paper on test prints.

To start the print preview, choose the ribbon command File | Print preview .

To exit it again, click on the Close button in the preview module or press the Esc key.



393Outputting documents

The icons of the print preview module

The print preview appears in a separate window. This print preview module has the following functions:

Use these controls to jump from page to page. The leftmost/rightmost buttons jump to the first/last page. The
two inner buttons scroll to the previous/next page.

The edit field in the middle lets you jump to a specific page. Type in the page number here and press the Enter
key¿.

The next three buttons have the following functions:

§ The left button corresponds to the ribbon command File | Page setup, with which you can define the page
format (paper size, orientation, headers and footers, etc.). See also Set page format. 

§ The middle button corresponds to the ribbon command File | Print, which you can use to print the
document. For more information, see also Printing a document.

§ The right button corresponds to the ribbon command File | PDF export with which you can create a PDF
file from the document. For more information, see also Exporting a document to a PDF file.

These controls can be used to change the zoom level. Enter the desired percentage value in the input field and
press the Enter key¿. Or use the three buttons at the right to switch to a predefined zoom level:

§ Actual size of document (zoom level 100%) 

§ Fit page in window

§ Fit margins in window

To close the print preview window, click the Close button.

Printing a document

Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

To print the current document, choose the ribbon command File | Print .
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The program will display a dialog box in which the following settings can be made:

Printer

Here, select which of the installed printers should print the printout.

The Setup button opens a window for setting up and configuring the printer. For more information, see your
printer manual.

Linux users can also specify here the command to be used to initiate the printing process.

Print

Lets you choose which parts of the document to print:

§ Whole document 

Print the entire document (all worksheets).

§ Only selected cells 

Print only those cells that are currently selected on the current worksheet.
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§ Current worksheet 

Print only the current worksheet.

§ Only selected worksheets 

Print only those worksheets that are currently selected in the worksheet register.

§ Only the following worksheets 

Print only the selected worksheets. To specify which sheets to print, check the desired worksheets in the list
displayed below this option.

Ignore print range

When you activate this option, any print ranges defined in the document will be ignored.

Background information: You can define a print range for each worksheet in a document. When a print range is
defined, only the cells inside this cell range will appear in printouts. The rest of the sheet will be omitted.

You can temporarily disable this feature anytime by activating this option.

For more information on print ranges, see Setting page format options.

Pages

Specify here the pages of the document to be printed:

§ All 

Print all pages of the document.

§ Pages: 

Print only the specified pages. You must enter the desired page numbers, for example:

12 Print page 12 only

12-15 Print pages 12 to 15

12- Print page 12 and all of the following pages

-12 Print pages 1 to 12

You can also enter more than one such page number by separating them with commas:

2-5, 12 Print pages 2 to 5 and page 12

etc.

§ You can also use the option Pages to print to specify whether all selected pages or only the pages with a
even or odd page number should be printed. 
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§ For Pages per sheet, you can specify how many pages to print on a sheet of paper. PlanMaker usually prints
only one page per sheet. However, you can instruct the program to output four pages (scaled down
accordingly) per sheet at a time.

Options

This section of the dialog box contains additional printing options:

§ Copies 

Here, you can specify the number of copies of the document to be printed.

§ Collate copies 

This option specifies whether to sort the print output by page number when printing multiple copies of a
document.

If you enable this option and print multiple copies of a document with, for example, three pages, the pages
will be output in the following order: 1-2-3, 1-2-3, 1-2-3, and so on.

If it is not enabled, the order will be: 1-1-1..., 2-2-2..., 3-3-3...

Note: Some printers do not support this function.

§ Print to file 

This option redirects the print output to a file instead of a physical printer.

§ Drop pictures 

This option skips all pictures and drawings when printing (useful for fast test printouts).

§ Reverse order 

This option prints the pages from last to first.

To start printing, click on OK.

Tip: Before actually printing a document, you can preview the printout via the ribbon command File | Print
preview. This feature enables you to avoid wasting paper on test prints.

Exporting a document as a PDF file

Android/iOS: This command is not freely available in these versions. For more information, see the
beginning of this chapter.

You can also export documents to a PDF file.

PDF files can be viewed on virtually any computer, provided that a suitable PDF viewer is installed there (for
example, Adobe Reader). All formatting and objects (pictures, drawings, etc.) of the document are retained
exactly as in the original file.
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To export a document to a PDF file, proceed as follows:

1. Choose the ribbon command File | PDF export .

2. A dialog box appears. Make the desired settings there (see below) and confirm with OK.

3. Now another dialog box appears. Enter a file name under which you want to save the PDF file and confirm
with OK.

The PDF file will then be created. To view it, open the PDF file in a PDF viewer of your choice.

Tip: If you do not have a PDF document viewer installed on your device, simply use your web browser to
search for "PDF viewer". You will find many suitable programs, many of which are free.

In the dialog box of the above command, you can make the following settings for the PDF export:

General tab

On this tab, you can specify whether to output only parts of the document and make other settings. The options
are similar to the command File | Print described in Printing a document.

In addition, the following options are also available:

§ Create a bookmark for each worksheet 

If this option is enabled, PlanMaker automatically creates a bookmark in the PDF file for each worksheet
that your document contains.

Your PDF viewer will then display these bookmarks in a pane to the left of the document. You can use this
pane like an interactive table of contents: Just click on one of the bookmarks to instantly jump to the
corresponding worksheet in the PDF file.

Tip: If your PDF viewer does not display this pane, search for a command for displaying bookmarks in it
and enable it.

§ Create tagged PDF 

If this option is enabled, information about the logical structure of the document will also be saved in the
PDF file.

This information ensures that your PDF files are accessible for the disabled and can also be used, for
example, with PDF viewers that reproduce or read aloud the document content in Braille.

§ Reset (see "Reset" button at the end of this section) 

Preferences tab

On the this tab, you can make settings for the output quality:

§ AutoShape options 

Here, you can set the quality level (i.e., resolution) in which AutoShapes and all other types of drawings are
exported. The higher the quality level, the larger the generated PDF file.
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§ Picture options 

Here, you can specify whether to save images with Lossless compression or lossy JPEG compression. If
you opt for JPEG compression, you can set the quality level of the compression.

Tip: Normally, you should choose lossless compression here because it ensures perfect image quality. If
your document contains a large number of images (especially photographs), however, the resulting PDF
file may be very large. In this case, we recommend that you use JPEG compression, which provides a
much higher compression ratio for photographs.

The option Use alpha channel for transparencies determines whether an alpha channel should be used to
represent transparency in pictures and drawings. Usually, they look best when this option is enabled.
However, some PDF viewers represent alpha channels incorrectly, thus you can also disable this option.

§ Other options 

Include PlanMaker document: This option saves a copy of your PlanMaker document inside the PDF file.
You can then open this PDF file directly in PlanMaker, whereupon the program will extract the original
PlanMaker document from the PDF file and display it.

Open the file in a PDF viewer after exporting: This option launches your PDF viewer automatically and
displays the PDF file after it has been created (provided that you have a PDF viewer installed on your
computer).

Use relative paths for file links: This option automatically converts the file path from hyperlinks (links) to
files into a relative path (rather than an absolute path). If, for example, you have inserted a link to the file C:
\Documents\Lists\Test.txt and export the PDF document to the folder C:\Documents, this link will
be automatically converted into "Lists\Test.txt".

§ Font options 

The option Font embedding allows you to specify whether the fonts used in the document should be
embedded in the PDF file.

If font embedding is enabled, the resulting PDF file can be viewed in its original fonts on any computer –
even if the relevant computer does not have the fonts installed. If, on the other hand, the option is disabled,
the PDF file will be displayed with automatically selected replacement fonts.

The option Embed only used characters determines whether all characters of a font or only the characters
actually present in the document should be embedded when embedding fonts. The advantage of enabling this
option is that the resulting PDF file is smaller in size.

§ Archiving 

This option enables you to select from various variants in the standard PDF/A to create standard-compliant
PDF files. This standardized format allows the long-term archiving of documents and is considered a
prerequisite when documents must be stored in a non-editable manner and in an identical format to the
original documents.

§ Reset (see "Reset" button at the end of this section) 

View tab

This tab contains advanced options for displaying the PDF file in a PDF viewer:
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§ Navigation pane 

Use this option to specify what should be displayed in the navigation pane of the PDF viewer. (The
navigation pane is a bar displayed to the left of the PDF document.)

Available options:

Default: Use the PDF viewer's default setting.

Empty: Do not display anything in the navigation pane.

Bookmarks: Display the document's bookmarks in the navigation pane.

Page thumbnails: Display thumbnails of the document's pages in the navigation pane.

§ Zoom 

This option specifies the zoom level at which the PDF file should be displayed:

Default: Use the PDF viewer's default setting.

Full page: Select the zoom level at which the entire page fits in the window.

Fit width: Select the zoom level at which the page width fits in the window.

Fit height: Select the zoom level at which the page height fits in the window.

Custom: Set the zoom level to a custom value (in percent).

§ Page layout 

This option specifies the layout with which the pages should be displayed:

Default: Use the PDF viewer's default setting.

Single pages: Display as single pages.

Two pages - odd pages left: Display as two facing pages (odd pages on the left).

Two pages - odd pages right: Display as two facing pages (odd pages on the right).

§ Additional options 

This section provides the following additional options:

Display document title: Display the document's title in the title bar of the PDF viewer (instead of its file
name). Tip: You can enter the title of a document on the Summary tab in the dialog box of the command
File | Properties.

Center viewer on screen: This option automatically centers the program window of the PDF viewer on the
screen when the PDF file is opened.

Full-screen mode: This option automatically switches the PDF viewer to full-screen mode when the PDF
file is opened.

Hide menu bar: This option hides the menu bar of the PDF viewer.

Hide toolbars: This option hides all toolbars of the PDF viewer.

Hide navigation pane controls: This option hides all controls of the navigation pane.

§ Reset (see "Reset" button at the end of this section) 
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Protection tab

This tab provides options that enable you to encrypt the resulting PDF file and to use passwords to protect the
file from being opened or changed.

§ Encryption type 

Here, you can specify whether the PDF file should be encrypted. You can choose between 40 bit encryption
(low level of security) and 128 bit encryption (high level of security).

Note: The other options in this dialog box are not available until you have selected an encryption type.

§ Password to open the document 

If you enter a password here, the PDF viewer will ask for this password when users try to open the PDF file.
If an incorrect password is entered, the user cannot open the file.

If you leave this field empty, any user can open the file without having to enter a password.

§ Password to set permissions 

You can also restrict the permissions for the PDF file. To do so, enter a password to change the permissions.
Then use the options in the Permissions section of the dialog box to specify which permissions should be
granted to users.

Background information: Some PDF viewers have a command for changing the permissions. If a user
chooses this command, they can only continue if they enter the password that you have set here.

§ Permissions 

Here, you can specify which permissions users should have with respect to the PDF file when they open it in
a PDF viewer. (This is only available if you have entered a password above for setting permissions.)

§ Reset ("Reset" button below) 

"Reset" button

All changes to the PDF export options are retained as global settings in PlanMaker and are thus applied to the
next export of a PDF document. You can restore the original default settings by clicking on the Reset button in
the lower left corner of the dialog box.

You can click on this button on any tab of the dialog box PDF Export, thereby resetting the options of all tabs
at once.

Sending a document by e-mail

Android/iOS: This command is not freely available in these version. For more information, see the
beginning of this chapter.
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If you have a suitable e-mail program installed on your device, you can send documents by e-mail directly from
PlanMaker.

To do so, proceed as follows:

1. Create or open the document that is to be e-mailed.

2. In PlanMaker, choose the ribbon command File | Send .

(Android/iOS: Here the command is called Share and allows sharing via several channels).

3. Select the format in which the document is to be sent.
Note: If you select the PlanMaker document format here, the recipient will receive an e-mail with the PlanMaker file as an attachment. In order to
open this attachment, the recipient must also have PlanMaker installed.

PlanMaker now generates an e-mail with the document as an attachment and passes it to your e-mail program.
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Protecting cells and documents
PlanMaker provides options for protecting documents or specific document contents. For example, cells can be
protected from unintentional changes, or entire documents can be password-protected.

The following options are available:

§ Sheet protection 

Use sheet protection to protect individual cells against changes. If sheet protection is enabled, cells can no
longer be changed and/or their content is hidden on screen or printouts.

§ Workbook protection 

Use workbook protection to prevent users from adding, deleting or hiding/unhiding worksheets.

§ Document protection 

Use document protection to password-protect the current document against reading and/or writing. If read
protection is enabled, PlanMaker will additionally encrypt the document.

See the following pages for detailed information.

Sheet protection
Use sheet protection to protect individual cells against changes, and/or to hide their content on screen or in
printouts. When sheet protection is enabled, all cells on the current worksheet are protected that are marked
accordingly. Furthermore, many commands are greyed out (i.e. no longer selectable) and objects cannot be
inserted.

However, before you enable sheet protection, you must first define which cells are to be protected and how
extensive the protection is to be.

Protecting cells requires two steps:

§ Step 1: Setting up protection settings for cells 

§ Step 2: Enabling sheet protection

See the following pages for more information.
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Step 1: Setting up protection settings for cells

To protect cells, you first define which cells are to be protected and how extensive the protection is to be.

To do so, proceed as follows:

1. Select the cells whose protection settings you want to change.

2. Click on the group arrow  in the bottom right corner of the ribbon tab Home | group Number to open the
dialog box.

Alternatively: Right-click to open the context menu and select the entry Cell.

3. Switch to the Protection tab.

4. Choose the desired protection settings (see below).

5. Confirm with OK.

Protection settings available:

Tip: The options Protect cell and Hide cell can also be found directly on the ribbon tab Review | group
Protection (here as options Cell protection and Hide cell).

§ Protect cell 

Protect cell against changes, if sheet protection is enabled.

Use this option to prevent users from changing the content or the format of the cell.

Important: By default, this option is enabled for all cells in the worksheet. To allow users to alter specific
cells when sheet protection is enabled, select those cells and disable the Protect cell option.

§ Hide formula 

Do not display the formula used to calculate the cell content, but only show the result, if sheet protection is
enabled.

When sheet protection is enabled, it is therefore no longer possible to find out which calculation this cell
contains.

§ Hide cell 

Hide the cell content on screen, if sheet protection is enabled.

When the sheet protection is enabled, the cell becomes invisible. However, it still appears in the printout
(see next option).

§ Do not print cell 

Hide the cell content in printouts,

if sheet protection is enabled.
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Step 2: Enabling sheet protection

The second step in protecting cells is to enable sheet protection for the current worksheet.

This is because if you have changed the protection settings of cells (as described in the first step "Setting up
protection settings for cells"), this does not yet affect the document. You must first enable Sheet protection for
these settings to take effect.

Note: Enabling sheet protection affects the current worksheet only.

To enable sheet protection, proceed as follows:

1. Choose the ribbon command Review | group Protection | Sheet protection .

2. If desired, enter a password required to disable sheet protection.

Leave blank if you do not want to assign a password.

3. Confirm with OK.

The sheet protection is now enabled; the protection settings of the cells are now effective.

After that, only cells not flagged with the Protect cell option can be modified. These cells are displayed with a
green triangle in their lower right corner. This allows you to see immediately which cells can still be changed
when the sheet protection is enabled.

Tip: If sheet protection is enabled, only editable cells can be accessed when moving around in the table with
the Tab key. Protected cells are skipped.

In addition, if sheet protection is enabled, the following restrictions apply:

§ Most commands for editing the worksheet are unavailable. 

§ Size, position and all other properties of objects cannot be changed anymore (except for objects where you
have disabled the Locked property)

§ Text in text frames cannot be changed anymore (except for objects where you have disabled the Text locked
property)

§ New objects can no longer be inserted into the worksheet.

Disabling sheet protection

If you enabled sheet protection, you can remove it at any time.

To do so, choose the ribbon command Review | group Protection | Sheet protection  again (you can
recognize an active sheet protection by the fact that the icon appears darker).
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The sheet protection is then disabled again.

The protection settings defined in the dialog box of the ribbon tab Home | group Number  are now ineffective
again. But PlanMaker still remembers them. So when you re-enable the sheet protection, the same protection
settings will become active again.

Tip: The current state of sheet protection is saved within the document. If a password has been assigned,
users will be required to enter the password to disable sheet protection. This way you can protect documents
against changes by unauthorized persons.

Workbook protection
If you enable workbook protection for a document, from now on no more changes to the worksheet register can
be made in the document. Also the commands of the Insert | group Tables | Sheet button are no longer
available.

This has the following effect:

§ Users can't add worksheets anymore. 

§ Users can't copy, delete or rename worksheets anymore.

§ Users can't hide/unhide worksheets anymore.

Choose the command Review | group Protection | Workbook protection  to enable the workbook
protection. To disable it, choose the same command once more.

For more information, see the next pages.

Enabling workbook protection

To enable workbook protection for the current document:

1. Choose the ribbon command Review | group Protection | Workbook protection .

2. If desired, enter a password that must be entered by the user to disable workbook protection.

Leave blank if you do not want to assign a password.

3. Confirm with OK.

Workbook protection is now enabled. Users are no longer able to add, delete, rename or hide/unhide
worksheets, etc.

In addition, most of the options in the dialog box of the command File | Properties are unavailable.
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Disabling workbook protection

If workbook protection has been enabled in the current document, you can disable it at any time.

To do so, choose the ribbon command Review | group Protection | Workbook protection  again (you can
recognize an active workbook protection by the fact that the icon appears darker).

As a result, users will be allowed to add, delete, rename and hide/unhide worksheets again.

Tip: The current state of workbook protection is saved within the document. And: If a password has been
assigned, users will be required to enter the password to disable workbook protection.

Document protection
You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

To protect a document, choose the ribbon command File | Properties, switch to the Protection tab in the
dialog box and select the type of document protection. Also enter the desired read and/or write password.

The following types of protection are available:

§ No protection (this is the default setting whereby the document is not protected) 

§ Write protection (the document can be opened, but saving is only possible with the password)

§ Read protection (the document can be opened only with the password)

§ Protection depending on password (a combination of read and write protection)

For more information on enabling and disabling document protection, see the following pages.

Enabling document protection

You can protect your documents from being read or saved by unauthorized persons by applying document
protection – or more specifically, read and/or write protection. For example, you can require the entry of a
password to open or save a protected document.

Read protection also encrypts the document so that it cannot be viewed with programs other than PlanMaker.

To protect a document, proceed as follows:
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1. Choose the ribbon command File | group File management | Properties .

2. Switch to the Protection tab.

3. Select the desired type of document protection (see below).

4. Unlike sheet protection and workbook protection, you must always assign a password for document
protection. Enter the read and/or write password (at least 4, and no more than 15 characters).

Important: If you forget a password, you can no longer open or save the document. It is thus advisable to
make a note of the password. Pay close attention to uppercase/lowercase!

5. Confirm with OK.

6. The program displays a dialog box in which you are required to verify the read and/or write password by re-
entering it.

7. Confirm with OK.

8. Exit the dialog box with OK.

9. Save the document in order for the changes to take effect.

From now on, anyone who attempts to open this document will be asked automatically for the password. If the
correct password is entered, the protection is temporarily overridden.

Types of document protection

You can choose between the following types of document protection in the above dialog box:

§ No protection 

The document is not protected. This is the default setting.

§ Write protection 

When the document is opened, the user is prompted to enter the write password. The document can only be
saved if the correct write password has been entered here.

However, it is still possible to open the document as read-only, even even if the user does not have the
password. However, it cannot be saved – not even under a different name.

§ Read protection 

If you try to open the document, you are prompted to enter the read password. If you enter an incorrect
password, you will not be able to open the document.

The document is saved in an encrypted form so that it cannot be viewed with programs other than
PlanMaker.

§ Protection depending on password 

Here, two dialog boxes prompting for a password appear in succession when the document is opened. The
first dialog box asks for the read password, while the second one asks for the write password.

If the user enters the read password, he is permitted to open the document but not to save it.

If he also enters the write password, he has full access and can thus save the document.

If he enters an incorrect password or nothing at all, access to the document is completely denied.
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Encryption method: "Most compatible" or "Most secure"?

For documents with Read protection or Protection depending on password, you can also select the desired
Encryption method.

Note: This setting primarily affects newly created documents. When you open an existing encrypted
document, the encryption method used in it is automatically determined and this option is set accordingly.

Choosing an encryption method is especially important for documents in Microsoft Excel file format (.xls and
.xlsx). Some old versions of Microsoft Office may not be able to open documents encrypted with the new
"Most secure" encryption method.

Available options:

§ Most compatible 

When you save the document, an old encryption method is used that can be read by all versions of Microsoft
Office. However, this method is less secure than the other method.

§ Most secure 

Here, a more modern and more secure encryption method is used. However, some old versions of Microsoft
Office may not be able to read documents encrypted with this method.

Detailed information about the currently selected encryption method is displayed at the bottom of the dialog
box.

Disabling document protection

When you succeed in opening a read-protected or write-protected document by entering the correct password,
protection is disabled – but only temporarily. If you close this document, the protection will be enabled again;
the next time you open it, the password prompt will appear again.

To permanently remove the protection on a document, proceed as follows:

1. Open the document.

2. Choose ribbon command File | group File management | Properties .

3. Switch to the Protection tab.

4. Select the option No protection.

5. Confirm with OK.

6. Save the document in order for the change to take effect.

Document protection is now permanently disabled.

The next time someone opens the document, no password prompt will appear. All users can now open and save
it.
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Working with other file formats
PlanMaker normally saves documents in its "in-house" file format called PlanMaker document. PlanMaker
documents can be recognized easily by the name extension .pmdx. If, for example, you save a document under
the name "Taxes", its complete file name will be Taxes.pmdx.

You can also instruct PlanMaker to save files in another file format. This is necessary, for example, if you want
to edit a PlanMaker document with another program. You can also open documents in PlanMaker, which have
been created with other spreadsheet applications.

In this chapter, you will learn everything you need to know about working with other file formats. It is divided
into the following sections:

§ Saving and opening files in other file formats 

The first section explains how to save or open documents in a different file format: Simply choose the
ribbon command File | Save as or File | Open and select the desired format from the dropdown list of file
types.

§ Notes on the text format 

When you open or save plain text files, a dialog box providing additional options appears. This section
contains information on these options.

§ Notes on the Excel format 

The last section provides information on working with Microsoft Excel files. In this section you will learn
everything you need to know about data exchange between PlanMaker and Excel.

See the following pages for more information.

Saving and opening files in other file formats
This section provides information on saving and opening documents in another file format.

Saving a document in another file format

To save the current document in another file format, choose the ribbon command File | Save as and open the
dropdown list Save as type. Select the desired format, enter a different file name if required and confirm
saving.
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Opening a document in another file format

To open a document in another file format, use the ribbon command File | Open (click directly on the icon
itself) to open the file dialog box, open the dropdown list of file types and select the format in which the file is
available. Then select the desired file, and confirm that you want to open it.

Supported file formats

In the dialog boxes for opening and saving documents, the list of file types includes the following file formats:

§ PlanMaker document 

The in-house format for PlanMaker documents in which you usually save documents (name
extension: .pmdx).

§ PlanMaker template 

Document template for PlanMaker documents (name extension: .pmvx). For more information, see
Document templates.

§ Microsoft Excel document 

You can also open and save documents in Microsoft Excel file format. The program supports .xls files
(Excel 5.0 to 2003) as well as .xlsx files (Excel 2007 or higher).

For more information on this format, see Notes on the Excel format.

§ Microsoft Excel template 

Document template for Microsoft Excel documents.

§ PlanMaker 2012 document 

Documents are saved in the file format of PlanMaker 2012, an older version of PlanMaker (name
extension: .pmd).

§ TextMaker document (export only) 

For exporting PlanMaker files to SoftMaker's word processor TextMaker.

§ dBASE 

dBase database file format, either with DOS, Windows or Unicode character set. Before opening/saving the
database, a dialog box appears in which you can select the character set.
Note: Most dBASE databases are stored in dBASE/DOS file format – not in dBASE/Windows file format.
Even Windows database programs usually use the DOS format.

Tip: In the preview window of the dialog box, you can use the column header to adjust the data type, if
necessary. Click on the respective head of a column to open a corresponding dropdown menu.

§ Text file 

Plain text file format, for example, with the cell values separated by tabs or commas. For more information,
see Working with text files.



411Working with other file formats

Notes on the text format
As mentioned in the previous section, you can also open and save plain text files (including e.g. CSV files) with
PlanMaker:

§ To open a text file, use the ribbon command File | Open (click directly on the icon itself) to open the file
dialog box, simply select the desired file and confirm the opening. 

§ To save a document as a text file, select the ribbon command File | Save as, select Text file in the Save as
type list, enter the desired file name and confirm the saving.

In both cases, a dialog box appears where you can specify the format of the text file.

The dialog box provides the following options:

Options available when saving text files

When you save a document as a text file, the following settings can be made in the dialog box:

§ Character set 

Here you can specify which character set to use when the text file is saved.

Note: PlanMaker suggests a suitable character set automatically. Usually, there is no need to change this
setting.

§ Data format 

Here you can specify in which way the cell contents should be stored in the text file. The following options
are available:

Separators between fields: If you choose this option, the cell contents will be separated by a certain
character (for example, a semicolon or a tab).

Example:

Peter;Miller;24;Main Street

Elizabeth;Jones-Nightingdale;1733;University Drive

Fixed field widths: If you choose this option, the cell contents will be distributed over columns with a fixed
width. Gaps will be filled with spaces.

Example:

Peter      Miller              24    Main Street

Elizabeth  Jones-Nightingdale  1733  University Drive

§ Separator 

Here you can choose which character should be used to separate the individual cell contents from each other
(e.g., semicolons or tabs).
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Note: The separator must not occur within cell contents; if it does, PlanMaker will of course treat it as
such would split such cells into two entries.

§ Text marker 

If desired, PlanMaker can surround the content of all cells that contain text with a certain character (e.g.
quotation marks).

If you want this, choose the desired character here.

With the option Auto, no text marker is set in principle. Unless there is a line break or a quotation mark
already occurring in a cell. Then additional quotation marks are set for these cells as a text marker.

§ Encoding of newlines 

Here, you can select the control characters to insert at the end of each line (to indicate the beginning of a
new line).

Note: PlanMaker suggests suitable control characters automatically. Usually, there is no need to change this
setting.

Available options:

CR+LF: This is the recommended setting for Windows.

LF: This is the recommended setting for Linux and Mac.

CR: This control character was common on older Apple Mac systems (before macOS).

Options available when opening text files

When you open a text file, most of the same options are available as when saving. Use these options as
described above to specify the format of the text file you want to open.

There are some additional options when opening files:

§ Number of header lines 

If the first few lines of your text file contain headings (or, lines with some explanatory text, etc.), enter the
number of these lines here. This will instruct PlanMaker not to split these lines into columns like the rest of
the data. The header lines will be left unchanged and stored into just one cell per line.

The default value is 0 (i.e., no header lines).

§ Separators (several can be selected at the same time)

To facilitate the separation of text in more complex text files, it is possible to select different separators at
the same time.

§ Change data type in the preview window

In the preview window, the data type can be adjusted for each column by clicking on the header.

For example, change the data type of a column to text so that numbers with leading zeros (as in telephone
area codes) are retained.
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Notes on the Excel format
If you were using the Microsoft Excel spreadsheet before PlanMaker, you will be pleased to know that
PlanMaker can open virtually any Excel file without any problems. Conversely, PlanMaker also allows you to
save documents in Excel format.

The following pages provide information on working with Microsoft Excel files in PlanMaker.

Opening and saving Excel files

As mentioned in the section Saving and opening files in other file formats, PlanMaker is able to open and save
documents in Microsoft Excel format.

This works smoothly in almost all cases. However, some arithmetic functions are either incompatible or not
supported by PlanMaker or Excel.

This section provides help resolving these issues:

Warning message issued when opening an Excel file

When you open an Excel file containing arithmetic functions that are not compatible with PlanMaker, the
following warning message is displayed:

To resolve, proceed as follows:

1. Choose the ribbon command View | Syntax highlighting  to enable syntax highlighting.

2. All cells containing formulas where the conversion failed will be highlighted with a colored background.
These cells must be revised individually.

Compare its contents with the contents of the corresponding cell in the Excel document. Try to replace the
incompatible arithmetic functions with PlanMaker functions. For detailed descriptions of all arithmetic
functions supported by PlanMaker, see Functions from A to Z.

3. When all cells are revised, disable syntax highlighting.

Save the document (in PlanMaker format) to finalize changes.
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Warning message issued when saving a document in Excel format

When you save a PlanMaker document in Excel format, if the document contains formulas that are not Excel-
compatible, the following warning message is displayed:

To resolve, proceed as follows:

1. Choose the ribbon command View | Syntax highlighting  to enable syntax highlighting.

2. All cells containing formulas that are not Excel-compatible will be highlighted with a colored background
and must be revised manually. Try to replace all Excel incompatible arithmetic functions with Excel
functions. For help, see function description of the affected function in this manual.

3. When all cells are revised, disable syntax highlighting.

Save the document in Excel format again. If no further warning messages are displayed, all incompatibilities
have been eliminated.

Differences between PlanMaker and Excel

This section provides a list of the most significant differences between PlanMaker and Excel:

General

§ PlanMaker is not able to execute macros and VBA scripts stored in Excel documents. When an Excel file is
opened that contains macros or scripts, they will be ignored. However, PlanMaker will not remove them – if
the file is saved in Excel format, the macros and scripts will remain functional. 

Arithmetic functions

§ Some of PlanMaker's arithmetic functions are not supported by Excel (and vice versa). If you open or save
a document in Excel format, a warning message will be displayed if the file contains incompatible arithmetic
functions. For more information, see Opening and saving Excel files. 
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Working with Arabic text
In this chapter, you will learn everything you need to know about editing text in Arabic text in your PlanMaker
documents. It is divided into the following sections:

§ Enabling extended support for Arabic text 

§ Changing the text direction in table cells

§ Changing the text direction in text frames

§ Changing the direction of worksheets

For more information, see the following pages.

Important: The functions described in this chapter are only available if you have enabled the option
Extended support for Arabic text in the program settings. For more information, see the next section. 

Enabling extended support for Arabic text
PlanMaker has "extended support for Arabic text", which provides some additional functions for editing text in
Arabic font.

To enable this option, proceed as follows:

1. Choose the ribbon command File | Options .

2. In the dialog box, switch to the General tab.

3. Enable the option Extended support for Arabic text.

Important: The functions described in this chapter are only available if this option is enabled.

Changing the text direction in table cells

If the option Extended support for Arabic text is enabled in Options , you can switch the text direction
between left-to-right and right-to-left in a table cell at any time.

To do so, proceed as follows:

1. Right-click on the desired cell to open the context menu and select the entry Cell.
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2. In the dialog box, switch to the Alignment tab.

3. Under Text direction, select the desired option: context sensitive, left-to-right or right-to-left.

Tip: With the default setting Context sensitive, PlanMaker automatically chooses the appropriate text
direction: When you enter text in Arabic into a cell, the text direction is set to right-to-left, otherwise, it is set to
left-to-right.

Changing the text direction in text frames
In text frames, if the option Extended support for Arabic text is enabled, you can change the text direction of
a paragraph whenever needed.

To do so, proceed as follows:

1. Place the text cursor in the desired paragraph within the text frame.

2. Right-click to open the context menu and select the entry Paragraph.

3. Switch to the Paragraph tab.

4. Under Text direction, enable the option Right to left to change the direction to right-to-left.

To set the text direction to left-to-right, disable the option.

Tip: Using the keyboard

You can change the text direction of a paragraph in a text frame much quicker with the following shortcut keys:

§ If you press Ctrl and the left Shift keyñ at the same time, the text direction is set to left-to-right. 

§ If you press Ctrl and the right Shift keyñ at the same time, the text direction is set to right-to-left.

Mac/Linux: On some systems (including macOS and several Linux distributions), these shortcut keys do not
work. Alternatively, you can use the shortcut keys Ctrl+Shift+A (for left-to-right) and Ctrl+Shift+D (for right-
to-left).

Changing the direction of worksheets

If the option Extended support for Arabic text is enabled in Options , you can change the text direction of
a worksheet at any time.

To do so, proceed as follows:

1. Choose the ribbon command Insert | group Tables | Sheet | Properties in the desired worksheet.

Alternatively: Right-click on the worksheet in the worksheet register, select Properties.
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2. Under Sheet direction, enable the option Right to left to change the direction to right-to-left.

The direction of the worksheet then changes accordingly.

Thus, if you change the direction of a worksheet to right-to-left, the column on the far right becomes the first
column (instead of the column on the far left).

This means that the table is mirrored horizontally, as shown in the following figure:

Left: Table with sheet direction set to left-to-right
Right: Table with sheet direction set to right-to-left

Note: The text direction of each individual table cell can still be defined individually, of course (as described in
Changing the text direction in table cells).
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Scripts (BasicMaker)

Note: BasicMaker is only available for Windows and is not included in all versions of SoftMaker Office.

You can use the BasicMaker program to write and run scripts written in the programming language SoftMaker
Basic. SoftMaker Basic is based on Visual Basic for Applications (VBA), the programming language of
Microsoft Office.

Scripts can be used to automate workflows in the word processing application TextMaker and the spreadsheet
application PlanMaker.

Starting BasicMaker

To start BasicMaker or to run a BasicMaker script, use one of the following procedures:

§ Starting BasicMaker via the Start menu 

You can start BasicMaker by clicking on the Start menu (the Windows logo button) in the lower left corner
of the screen and choosing SoftMaker Office > BasicMaker.

§ Starting BasicMaker from within TextMaker/PlanMaker 

You can also start BasicMaker from within TextMaker or PlanMaker.

To do so, choose the ribbon command File | Edit script  in TextMaker/PlanMaker.

§ Running a script directly from within TextMaker/PlanMaker 

In TextMaker/PlanMaker, choose the ribbon command File | Run script  to run a script. A file dialog
appears. Select the script to be run, and confirm with OK.

All further information about BasicMaker and how to "program" TextMaker and PlanMaker can be found in the
online help of BasicMaker, which can be accessed via the Help menu in BasicMaker.
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Working with multiple documents

Android/iOS: This function is not available for smartphones. For tablets, multiple documents can be opened
in the same program window.

You can have multiple documents open at any time – to compare them, edit them at the same time, exchange
data between them, etc.

You work with multiple documents as follows:

§ Opening multiple documents in the same program window 

You can open any number of documents at the same time in the current program window.

There are many ways to switch between these documents, including a bar that contains tabs for each
currently open document (displayed above the current document):

  

§ Opening files in a new program window 

You can also open documents in a new program window.

To do so, select the option New program window in the dialog box of the command File | New or of the
command File | Open when you create/open the document.

Note: To open the dialog box of the commands File | New or File | Open, click directly on their actual
icons and not on their small arrow.

The methods can be combined as desired. You can open as many program windows as you like and open any
number of documents as tabs in each of these windows. You can also open all documents in just one program
window. Alternatively, you can ensure that each document appears in its own program window. It is entirely
your choice.

In this chapter, you will learn everything you need to know about working with multiple documents at the same
time. For more information, see the following pages.
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Creating or opening a document
To create a new document or to open a document, proceed as follows:

§ To create a new document, choose the ribbon command File | New . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, the document templates used so
far will be displayed for quick access.

§ To open an existing document, use the ribbon command File | Open . 

Note: The option "New program window" (see below) can only be accessed via the dialog box: To do so,
click on the icon itself. If you click on the small arrow of the icon, however, you can choose from the most
recently opened files.

These two commands New and Open are described in detail in Basics.

Option "New program window"

The option New program window in the dialog box of these two commands has the following significance:
When it is enabled, the document appears in a new program window. If it is disabled, the document will be
opened with a new tab in the existing program window.

This setting is also saved and is applied each time a document is opened, both when new documents are created
and when existing documents are opened.

(Note: In the Android/iOS version for smartphones, a separate program window is always opened, while in the
version for tablets, a new tab is always opened in the same program window.)

Switching between open documents

Android/iOS: This function is not available for smartphones. For tablets, you can switch between
documents within the program window.

If you have multiple documents open at the same time, you can switch to a specific document and thus make it
the active document:

§ Ribbon interface: "Windows" icon 

In the ribbon, you will find an icon called Windows  on the ribbon tab View. If you click on it, a list of
all open documents appears. Click on the desired document.

§ Classic menu interface: "Window" menu item 

For classic menus, you will find a list of all currently open documents in the Window menu. Select the entry
for the document to which you want to switch.
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§ Toolbar interface (Android/iOS only): "Window" menu item 

You will find a list of all currently open documents for tablets via the hamburger menu  in the Window
menu. Select the entry for the document to which you want to switch.

§ Mouse: Clicking on a document tab 

Above the document, you will find a bar with tabs for all currently open documents. Click on the tab for the
document to which you want to switch.

 

§ Mouse: Clicking into the program window containing the document 

Of course, if you have documents open in multiple program windows (see previous section), you can also
simply click into the program window with the desired document to make this document the active
document.

§ Keyboard: Ctrl+F6 

You can also use the keyboard to switch between the currently open documents: Ctrl+F6 switches to the
next document and Ctrl+Shift+F6 switches to the previous one.

Mac: On a Mac, you have to use the key combinations Cmd+F6 or Cmd+Shift+F6 to switch between
documents.

Arranging documents on the screen

Android/iOS: This function is not available for smartphones. For tablets, document tabs can be moved
within the program window.

 If you have multiple documents open, you can arrange them as follows:

§ The document tabs (the tabs in the bar above the document) can be moved within the bar and thus arranged
in any order. 

You can even drag a document tab out of the program window with the mouse in order to have a separate
program window for this document.

Alternatively, you can drag a document tab from one program window to another. The document will then
be integrated into the tab bar of the other program window.

§ If documents are open in different program windows, you can move the individual program windows
manually and resize them, of course – just as you can with all types of program windows.

§ If you choose the ribbon command View | Windows  | View side by side (in the classic menu interface:
Window > View side by side), you can display the current document side by side with another open
document on the screen. If more than two documents are currently open, the program first asks which of
them is to be used in the other window.
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Closing a document

Android/iOS: Not all of the listed methods are available in these versions.

If you want to stop working on a document, you can close it at any time. If the document has been modified
since it was last saved, the program automatically asks you if you want to save the document first.

To close a file, you have the following options:

In the ribbon interface

The ribbon tab File contains a Close icon  which closes the current document.

Tip: Use the ribbon command View | Windows  | Close all to close all currently open documents at once.

In the classic menu interface

Choose the menu command File > Close to close the current document.

Tip: Use the menu command Window > Close all to close all currently open documents at once.

In the toolbar interface (Android/iOS only)

In the group File , choose the command Close .

Tip: For tablets, you can close all currently open documents at once via the hamburger menu  by choosing
the menu command Window > Close all.

Tabs for documents

Above the document, you will find a bar with tabs for all currently open documents. If you click on one of these
tabs with the middle mouse button, the corresponding document is closed.

Alternatively, left-click on the x icon displayed on the far right of each tab to close it.

Furthermore: If you right-click on a tab, a small menu appears with commands for closing the current document
(Close tab) or all other open documents (Close all other tabs).

Via the keyboard

You can also use the shortcut key Ctrl+F4 or alternatively Ctrl+W to close the current document.

Mac: On a Mac, you have to use the key combination Cmd+F4 or Cmd+W for this purpose.
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Customizing PlanMaker
PlanMaker lets you determine a variety of program settings so that you can customize the program to suit your
personal work style.

In this chapter, you will learn everything you need to know about it. It is divided into the following sections:

§ Changing PlanMaker settings 

You can use the ribbon command File | Options to change the program settings. These settings apply to the
program as a whole and thus to all documents.

§ Changing document properties 

The document properties, on the other hand, are settings that only affect the current document and are also
saved in this document. They can be changed with the command File | Properties.

§ Changing worksheet properties 

Finally, the worksheet properties are settings that can be set differently for each worksheet in a document.
They can be changed with the ribbon command Insert | group Tables | Sheet | Properties.

§ Customizing the document display 

This section describes how to customize the appearance of the document on the screen. Most of the required
commands can be found on the ribbon tab View.

§ Customizing the ribbon 

Only for "Ribbon": This section is relevant only for users who have selected in the settings that they want
to operate the program with the "ribbon".

Here, you will learn how to configure and customize the ribbon.

§ Customizing toolbars 

Only for "Classic menus with toolbars": This section is relevant only for users who have selected in the
settings that they would prefer to operate the program with "Classic menus with toolbars".

Here, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the menu
command View > Toolbars and how to customize them to your liking with Tools > Customize.

§ Creating user-defined icons 

You can create user-defined icons at any time and add them to the ribbon or to a toolbar. Such icons can be
used to start any program.

§ Customizing shortcut keys 

You can also customize the shortcut keys for choosing frequently used commands. The ribbon command
File | Customize is responsible for this purpose.
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§ Editing lists for automatic filling 

In the dialog box of the ribbon command Home | group Contents | Fill | Series you can create your own
lists for the Fill function.

§ Installing additional dictionaries 

In this section, you will learn how to install additional dictionaries (such as Hunspell) if required.

For more information on these topics, see the following pages.

Changing PlanMaker settings

General settings can be changed with the ribbon command File | Options . These settings apply to all
documents.

The options in the dialog box of this command are distributed by topic across multiple tabs. If you click on the
Files tab header, for example, you can make settings for opening and saving files.

The following pages contain detailed information on all available settings.

Settings, View tab

On the View tab in the dialog box of the ribbon command File | Options  you can make some settings for
the appearance of documents on the screen:

Markers

The options in this section allow you to modify the appearance of the little triangles that are displayed in cells
that contain a comment and cells that are protected.

§ Color of comment markers 

Here you can change the color of the little triangle that is displayed inside cells that contain a comment.

§ Color of protection markers 

Here you can change the color of the little triangle that is displayed inside cells that are not protected (when
sheet protection is enabled).

§ Size 

This option allows you to change the size of these markers.
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Snapping

Allows you to configure the available aids for positioning objects (text frames, picture frames, etc.) with your
mouse:

§ Snap to cells 

Normally, this option is disabled. That means, you can move objects arbitrarily with the mouse.

When you enable this option and try to change the position of an object with your mouse, the object jumps
from one table cell to the next.

Enabling or disabling this function temporarily: When the option Snap to cells is enabled, you can temporarily
disable it at any time by pressing and holding down the Alt key while moving an object with the mouse. The
same works in the opposite manner: If the option is disabled, it can be temporarily enabled with the Alt key
while moving.

§ Snap to other objects 

When this option is enabled, the software automatically creates "magic" guides for the edges of each object
in the current worksheet. These guides make it a lot easier to position objects perfectly aligned and evenly
distributed.

These "magic" guides are usually invisible. They only become visible when you drag an object near such a
guide with the mouse. As soon as the guide appears, the object automatically snaps to it. Something similar
happens when you resize an object with your mouse.

Some examples of such guides:

If you drag an object to a position where it is roughly left-aligned with another object, a guide will
automatically appear representing the left edge of the other object. If you let your object snap to it, it will
be exactly left-aligned with the existing object.

The same applies to the right edge of objects.

If you drag an object to a position where it is roughly centered with another object, a guide will
automatically appear representing the center of the object. If you let your object snap to it, it will be
aligned exactly centered with the other object.

If you drag an object to a position below two other objects, you will also see a horizontal guide at the
position where this third object would have exactly the same relative distance as the other two objects.
(The three objects would then be distributed evenly.)

All of this works in both directions (horizontally and vertically) – for example, a magic guide is generated
for the top and bottom edges of each object.

Tip: If you hold down the Alt key while moving the object, you can temporarily disable the Snap to other
objects option that is generally enabled.

§ Snap tolerance 

Here you can specify the tolerance for the Snap to other objects option described above. The higher the
value, the earlier an object that you resize/move will snap to one of the "magical" guides for existing objects.

The default value is a distance of 8 pixels.
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Paint grid behind cells

When you enable this option, the gray gridlines displayed between the table cells are no longer painted in front
of the cells but behind the cells. As a result, the gridlines will no longer be visible for cell ranges that have a
colored background.

Cell marker

Here you can change the color and line width of the cell frame (the dark frame that indicates the currently
active cell in a worksheet).

Worksheet tabs

The worksheet register at the bottom of the document window displays tabs for each worksheet in the
document.

This option allows you to change the font size used to display the worksheet name on each tab.

Settings, General tab

On the General tab in the dialog box of the ribbon command File | Options , you can make general settings:

"User info" button

Here, you can enter your name, address and other contact information. To insert this information in documents,
use the USERFIELD function.

Furthermore, the data typed in the "Name" field will appear when comments are added.

Maximum number of undo steps

Here, you can set how many actions can be undone with the command Undo  (in the Quick access toolbar).
You can increase this number up to a maximum of 999 undo operations.

Note: On devices with little main memory, it is not recommended to increase this value.

For information on the command Undo, see Undoing changes.
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Extended support for Asian fonts

Note: This option affects only text frames. In table cells, only one font can be selected at a time.

If this option is enabled – for text in text frames only – three lists for selecting font, font size, font style and
language appear on the Font tab in the dialog box of the command group Home | Character :

§ For Latin scripts (for example, German, English) 
§ For East Asian scripts (Chinese, Japanese, Korean) 
§ For complex scripts (for example, Arabic)

Thus, you can make the settings for each type of script separately.

If, for example, you set the font to "Arial" for Latin scripts and the font to "SimHei" for Asian scripts, all Latin
scripts that you type will automatically appear in Arial, and all Asian scripts will appear in SimHei.

PlanMaker recognizes automatically whether the characters entered are Latin, Asian or complex (for example,
Arabic) scripts.

Extended support for Arabic text

If you enable this option, some additional features will become available for editing text in Arabic script. For
more information, see Working with Arabic text.

Use the insert key to control overwrite mode

This option is enabled by default and has the effect that you can toggle between Insert mode and Overwrite
mode with the Ins key (see also section Status bar).

If you remove the checkmark in front of this option, this typical function of the Ins key is disabled, when you
are working in PlanMaker. This prevents accidental switching to overwrite mode.

Show warning when loading OLE objects

Mac, Linux, Android/iOS only: If this option is enabled, the program displays a warning that OLE objects
cannot be displayed when you open a document containing such objects. (OLE objects can only be displayed on
Windows.)

Settings, Edit tab

On the Edit tab of the dialog box of the ribbon command File | Options , you can change settings for editing
table cells:
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After input, move selection ...

Determines where to move the cell frame (the dark frame that indicates the current cell on the screen) after the
user has entered data in a cell and pressed the Enter key¿.

In-cell editing

This option is enabled by default. This means that you can edit the contents of a cell directly in the worksheet
after pressing the F2 key. If you disable this option, the cell contents can only be edited in the Edit toolbar
(displayed above the spreadsheet) after pressing F2.

Automatic percent input

Determines how PlanMaker reacts when you type numbers into a cell that contains a percent value or that is
formatted with the "Percent" number format. If enabled, a percent sign is automatically added to your input.

Autocomplete cells

While you type text in a cell with this option enabled, PlanMaker automatically makes suggestions from the
existing text entries found in the cells above and below this cell.

Example: You have entered the values "New York", "Rio", and "Tokyo" in a column. If you now go to the cell
below these entries and type the letter "N", the program will automatically suggest "New York". If you type the
letter "T", "Tokyo" is suggested, etc.

To accept the suggestion, press the Enter key¿. To reject it, simply continue typing or press the Del key.

In case you do not want PlanMaker to make suggestions while you are typing, you can always disable this
option.

Left arrow key never exits cell editing

Use this option to specify what should happen when you navigate to a cell, type in a value and press the left
arrow key ß:

§ On: The text cursor is moved to the left (within your input). 

§ Off: The cell frame is moved to the left. In other words, your input is accepted, and the cell left of the
current cell is made the active cell.
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Warning if a formula contains errors

If you enter a formula that contains an error (e.g., missing a closing parenthesis), PlanMaker issues an error
message when you press Enter¿. If you do not want numbering, disable this option.

Note: Independent from this option, erroneous formulas are generally replaced by the text #NULL! when you
save the document.

Formula tooltip

If this option is enabled, whenever you enter an arithmetic function in a cell, a tooltip providing information
about the required function parameters appears below the cell.

Apply character formatting to entire words

Enabling this option has the following effect:

If the text cursor is inside a word and you change the character formatting (for example, select a different font
or enable bold), this will affect the entire word.

This allows you to quickly change the formatting of a single word without first having to select it.

Expand tables automatically

As described in the section Tables in worksheets, the ribbon command Insert | Table allows you to create
"Tables in worksheets".

This option has the following effect on such tables:

§ On: When you enter something into one of the cells directly to the right of the table, the table is
automatically expanded by another column. The same applies to rows: When you type something directly
below the table, another row is added automatically. 

§ Off: The table is not expanded automatically.

Middle mouse button

Mac and Linux only: Here, you can specify what should happen when you click somewhere using the middle
mouse button. Available options:

§ No function: The middle mouse button doesn't have any function. 

§ Paste selected content: If you click in the document with the middle mouse button, a copy of the currently
selected content is inserted at this point (for example, the currently selected text).

Expand SmartText entries

As described in SmartText, you can create SmartText entries with PlanMaker (for example, "sd" for "sales
department").
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If this option is enabled, your SmartText entries can be directly expanded as the text is entered. To do so,
simply type the abbreviation for the SmartText (for example, "sd") and then a space, Enter¿ or a punctuation
mark, and PlanMaker will automatically replace the abbreviation with the SmartText content.

If this option is disabled, however, SmartText entries can only be inserted via the dialog box of the ribbon
command Insert | group Text | SmartText.

Tip: The option "Expand SmartText entries" can also be enabled or disabled in this dialog box.

Insert frames and drawings immediately

This option determines what should happen if you insert a frame or a drawing into a document (text frame,
picture frame, AutoShape, etc.) – for example, with the ribbon command Insert | Text frame:

§ Always: The corresponding object is inserted immediately. Its position and size are fixed without further
action. 

(Of course, you can always change the object's position after insertion by simply dragging it to the desired
location with the mouse. You can also resize it by dragging one of the round handles that surround the
object.)

§ Never: Before the object is actually inserted, the mouse cursor changes to a crosshair. In order to proceed,
drag a rectangle in the document to specify the desired position and size. The object will then be inserted
exactly according to your specifications. 

§ Auto: This is a smart combination of the two aforementioned options that is already preset in PlanMaker for
each specific object type. Objects such as charts or picture frames are inserted directly (as with Always), for
example, while objects such as AutoShapes or text frames are inserted via the mouse cursor (as with Never).
 

Use left Alt as shortcut key

Mac only: This option determines which function the left Alt key on your keyboard should have:

§ Off: The left Alt key does the same as the right Alt key: It inserts icons into the text. 

Alt+E, for example, returns a euro sign €.

§ On: The left Alt key can be used to open menus in the classic menu. 

Note: This only works if you use the program with the classic menu interface instead of the ribbon interface.

Here, Alt+E no longer returns a euro sign, but opens the Edit menu instead.

Number separators

Here you can change which characters to use as decimal separator and as thousands separator for numbers.

Explanation: The decimal separator is the character that is placed in a number with decimal places (e.g. the
period in 17.50). The thousands separator is the character that can be used to group long digits (for example,
the commas in 1,000,000).

§ If you choose System default, PlanMaker determines the decimal separator and thousands separator from
your current system settings automatically. (This is the default setting.) 

§ If you switch to Custom, PlanMaker lets you to specify a custom decimal separator and thousands separator.
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Warning: If you specify custom settings that are incorrect, calculations may return invalid or wrong
results!

Calculation in status bar

When you select multiple cells, their sum is automatically displayed in the status bar. To have a different
calculation displayed there, select the desired type of calculation. You can also select several calculation
options, their results are then displayed next to each other in the status bar.

Tip: You can also set the options for "Calculation in status bar" directly in the status bar itself. To do so, click
with the left mouse button in the status bar – at the point where the information for the calculation is displayed.

Settings, Appearance tab

On the Appearance tab in the dialog box of the ribbon command File | Options , you can make settings that
affect the appearance of the PlanMaker user interface:

Dialog language

Here, you can select the language in which the user interface (ribbon, menus, dialog boxes, etc.) is to be
displayed.

User interface

If you click on the User interface button, the program displays a dialog box in which you can select the type of
user interface that the SoftMaker Office applications should use:

§ Ribbon (top row) 

If you select one of the styles from the top row, the programs use a "ribbon" as the user interface. The
differences between the individual styles are only in the color scheme used.

§ Classic menus with toolbars (bottom row) 

If you select one of the styles from the bottom row, the programs will use classic menus with toolbars. You
can also choose between different color variants here.

In the dialog box, you can also make the following settings:

§ Quick access toolbar (only in the ribbon interface) 

This option determines where the Quick access toolbar, which contains icons for some of the most
frequently used commands, should be displayed: to the left of the document tabs – or in a separate toolbar
directly below the ribbon.

§ Touch mode 

If you enable this option, all icons in the ribbon user interface or menu interface and toolbars will be slightly
enlarged. This is useful when operating the software with your finger (for example, on a tablet).
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Tip: Alternatively, you can also enable/disable touch mode with the following commands:

Ribbon user interface: Here, you choose the command Touch mode  in the Quick access toolbar.

Classic menu interface: Here, you choose the command View > Touch mode.

Android/iOS: If you are using these versions, select the user interface via the dropdown list. Here, you
have an additional option: Toolbars. For more information, see User interface on Android/iOS. The options
Quick access toolbar and Touch mode can be found separately elsewhere on this Appearance tab and work
as described above.

Prefer using larger controls

Windows only: This option is important when using 4k monitors. If the program's icons appear too small on
your screen (caused by a higher monitor scaling), enabling this option will enlarge the icons appropriately.

Show status bar in ribbon mode

This applies only to the ribbon interface: You can enable/disable the display of the status bar here. To change
this for the classic menu interface, see Showing and hiding toolbars.

Show fonts in font list

If this option is enabled, PlanMaker displays all font names in the respective font in font lists (for example, in
the font list of the command group Home | Character in the ribbon or in the Formatting toolbar in the classic
menu interface). This lets you see the actual appearance of each font at a glance.

Show tooltips

This option lets you specify whether or not tooltips should be displayed. These are short info texts that are
displayed next to the mouse cursor when you hover over a screen element (for example, a button in the ribbon
or in the Standard toolbar for the classic menu interface).

Beep on errors

If this option is enabled, PlanMaker emits a beep for error or warning messages.

Live preview

Here, you can enable/disable a live preview for the dropdown lists that are located, for example, in the
command group Home | Character.

If this is enabled, for example, you can select text, open the font list in the command group Home | Character
and then hover over the fonts in it. The document immediately shows how the selected text would look "live" in
the corresponding font.

To actually apply the font, simply click on it. To discard the change, click anywhere outside the font list or
press the Esc key.
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Use system menus

Mac only: This option determines whether or not the program should display its main menu in the menu bar at
the very top of the screen (as is customary for Mac applications).

Depending on the type of user interface you have selected ("Ribbon" or "Classic menus with toolbars"), this
option has the following effect:

§ Disabled: The main menu is not displayed in the menu bar at the top of the screen. 

Details:

Ribbon: If you have selected the "ribbon" user interface, only the "hamburger menu" (the icon  in the
Quick access toolbar) is now available to you if you still want to access the classic main menu.

Classic menus: In the case of the classic user interface, the main menu is no longer displayed at the top
of the screen, but in its own bar (below the title bar).

§ Enabled: The main menu is displayed in the menu bar at the top of the screen. 

Details:

Ribbon: Ribbon users now not only have access to the ribbon user interface, but can also use classic
menus in the menu bar.

Classic menus: The main menu is now displayed in the menu bar at the top of the screen – and not in its
own bar below the title bar.

Use system file dialogs

This option controls the type of dialog boxes that appear when you use commands for opening and saving files.
The options are:

§ Disabled: PlanMaker uses its own file dialogs. 

§ Enabled: The default file dialogs of the operating system appear, which you know from the majority of
applications.

The former are easier to use; the latter offer more options.

(In the iOS version, the operating system file dialogs are always used automatically.)

Smooth edges of screen fonts

If this option is enabled, PlanMaker uses a technology called "anti-aliasing" to smooth the edges of fonts and
improve their appearance on the screen.

Different options are available depending on the operating system.

Workspace color

This option allows you to change the background color of document windows (this option is especially useful
for TextMaker and Presentations, but also suitable for PlanMaker, e.g. for print previews).
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User interface size

Mac, Linux, Android/iOS only: This button opens a dialog box that allows you to reduce or enlarge the user
interface (menu, toolbars, dialog boxes, etc.).

If you select a lower setting here, all user interface elements will be reduced, which will allow you to see more
elements at a time. A higher setting, on the other hand, increases legibility.

The option Size of dialog elements changes the size of the user interface in large steps. The option Font size
adjustment also allows some fine-tuning in smaller steps.

The Sample field acts as a small tool to help you find a suitable setting: It gives you a preview of how a
checkbox in a dialog box will look after you have applied your changes.

Note: Inappropriate settings may cause the user interface to be far too small or too large, especially on
devices with a relatively low resolution. If this happens, you can always click on the Reset to default button
in the lower left of this dialog box to return to the default settings.

Document scaling (DPI)

Mac, Linux, Android/iOS only: You can scale the document higher or lower for a larger/smaller view. To do
so, select Custom and enter the desired value.

Unit of measure

Mac, Linux, Android/iOS only: Here, you can specify the units of measure which PlanMaker should use by
default: Metric (centimeter) or U.S. (inch).

(On Windows, this option is not required because the program automatically uses the setting that was selected
in the options "Region and Language" of the Windows Control Panel.)

Tip: You can always override this setting and enter a value into dialog boxes in another unit of measure by
typing one of the following unit of measures after the value:

Unit Explanation

cm Centimeter

in Inch – 1 in equals 2.54 cm.

pt Point – 72 pt equal 1 in.

pi Pica (character) – 1 pi equals 12 pt

If, for example, you type "5.08 cm" for the left margin, PlanMaker sets it to 2 inches (5.08 cm).

Tablet mode

Android/iOS only: If you are using a tablet, you should enable this option to optimize the display of the
application. If you are using the application on your smartphone, leave this option disabled.
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Use ribbon animations

Android/iOS only: The command groups of the ribbon tabs can be collapsed and expanded when you tap on
them with your finger (only in ribbon mode). If you enable this option, expanding and collapsing will be
performed in animated mode.

Settings, Language tab

On the Language tab in the dialog box of the ribbon command File | Options , you can make settings for
PlanMaker's spell check and hyphenation:

Language

Here, you can select the language to be used for spell check and hyphenation. To do so, open the dropdown list
and select the desired language from the available options.

Note: Please note that there are two entries in this list for German:

§ "German (Germany)" stands for the new spelling (according to the 1996 German spelling reform in its last
revision in 2006). 

§ "German (Germany, old)", on the other hand, stands for the old spelling.

The same applies to "German (Austria)" and "German (Switzerland)".

Spell check

Here, you can make the following settings for the spell-check:

§ Check spelling as you type 

If you enable this option, PlanMaker will check the spelling of text as you type. As soon as you make a
mistake, a dialog box will appear to facilitate a correction. For more information, see Check spelling as you
type.

Note: If this option is disabled, you don't have to do without a spell check – you can always start it manually
with the ribbon command Review | Spell check. For more information, see Manual spell check.

§ Beep on errors 

When this option is enabled, PlanMaker issues a warning tone when it encounters an unknown word while
Check spelling as you type.

§ Ignore words that start with a number 

If you enable this option, the spell check ignores all words that start with a number (for example, "1980s").
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§ Hunspell dictionaries 

As an alternative to its own dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries.
These dictionaries are available as free downloads. Most of them were created by private users or non-profit
organizations.

The Hunspell dictionaries button allows you to install downloaded Hunspell dictionaries and also set the
languages for which Hunspell dictionaries are to be used.

For more information, see Installing additional dictionaries.

Settings, Files tab

On the Files tab in the dialog box of the ribbon command File | Options , you can make settings for opening
and saving files:

Template folder

Here, you can specify the folder in which the templates for PlanMaker documents are stored.

The dialog box that appears when you choose the ribbon command File | New to let you select a document
template displays all templates that are in this folder.

Note: Normally, this setting should not be changed. Change it only in the event that you have actually moved
the template folder to another place.

Default file format

Here, you can select the file format in which PlanMaker should save newly created documents by default.

If you create a new document with the ribbon command File | New and then save it for the first time, the Save
dialog box always suggests the file format set here as default.

You can choose between the PlanMaker format and the Microsoft Excel format in several versions.

Important: Note that the Excel format do not know all of PlanMaker's features. If you save a PlanMaker
document in Excel format, certain formatting options and other features could be lost. We thus recommend
that you use the default setting "PlanMaker" here.

Saving section

In the Saving section, you can make settings for saving documents:

§ Prompt for summary information when saving 

If you enable this option, a dialog box will appear automatically the first time you save a new document to
enable you to enter some additional information about it. For more information, see Document summary.
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Opening section

In the Opening section, you can make settings for opening documents:

§ Recently used files in File menu 

If you click on the small arrow on the ribbon command File | Open , PlanMaker displays a list of the most
recently opened files. If you select one of these entries, the corresponding file will be opened immediately.
Here, you can specify the number of files to be displayed in the list.

Android/iOS only: Backup section

The Android/iOS version does not contain a "Backup" tab and its settings, which are described in the next
section. Instead, you have to choose either No backup or Simple backup in the dropdown list on the "Files" tab.

§ No backup 

If you select this option, no backups will be created when documents are saved. (This option is not
recommended.)

§ Simple backup 

This makes one backup per document. It contains the previous version of the document. It has the name
extension .bak and is in the same folder as the document itself.

In the Android/iOS-Version there is also the following option for the above Opening section:

§ Auto recovery: Save state every ... minutes 

When this option is enabled, PlanMaker automatically makes a temporary backup copy of every open
document on a periodic basis. You can enter a period of 1 to 100 minutes.

Note: These temporary backup copies work completely independently of the Simple/No backup copies
option described above.

When you exit PlanMaker in the normal manner, these temporary backup copies are automatically deleted.
However, if PlanMaker is abruptly shut down by a power failure, for example, while you are working on
open documents, these copies become available when the program is restarted. PlanMaker recognizes that
there has been a failure and offers to open the automatic backup copies of all documents that had been
modified but not saved just prior to the failure.

You can then check each of the restored documents to determine if any of the most recently made changes
have actually been lost, and then save them.

Settings, Backup tab

Android/iOS: This tab is not available in the Android/iOS version. However, simple backups can be made
here. This setting can be found on the Files tab.
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On the Backup tab in the dialog box of the ribbon command File | Options , you can make settings for
creating backup copies:

"When you save a file manually..." section

§ Keep older versions of the document (if you save a file manually) 

Several generations of file backups are created for each document. All of these copies are stored in a special
Backup folder.

Tip: If this option is enabled, the command File | Versions  (in the group File management) is also
available, which allows you to easily return to a previous file version of the currently open document.

§ Number of versions to keep 

Here, you specify the maximum number of versions of backups (generations) to be kept per document.

"Automatically created file versions (snapshots)" section

§ Save unsaved changes every ... minutes 

If you want automatic "snapshots" to be created as an additional backup while the document is being edited,
enable the checkbox here. In the dropdown field to the right, you specify the interval at which the snapshots
are to be taken regularly.

§ Number of snapshots to keep

In this dropdown field, you specify the maximum number of snapshots you want to keep.

Folder for file versions

Here, you can change the path for the Backup folder in which all backups are stored.

"Clean up" button

This button provides the following two commands for deleting backups:

§ Delete orphaned file versions

This option removes all file backups where the corresponding original document no longer exists.

§ Delete file versions of all documents

This option removes all file backups in the folder for file versions.

For more information on using file backups, see Backup copies (file versions).

Settings, System tab

On the System tab in the dialog box of the ribbon command File | Options , you can make the following
system settings:
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Smooth edges of pictures

If this option is enabled, PlanMaker uses anti-aliasing to smooth edges and lines in pictures. Advantage: The
display quality of scaled pictures is improved. Disadvantage: This procedure consumes some CPU time when
displaying pictures, of course.

Enable OpenGL AutoShapes

If this option is enabled, PlanMaker uses the OpenGL graphics engine to display AutoShapes optimally. If you
disable this option, 3D effects used for AutoShapes may no longer be displayed correctly. Thus, you should
usually leave this option enabled.

Check for updates

Windows, Mac and Linux only: Here, you can specify how often you want the software to check whether
there are updates for SoftMaker Office. Updates provide bug fixes and feature improvements.

Note: Checking for updates only works if your device can access the Internet.

You can also disable the automatic update check (not recommended) by selecting Never from the dropdown
list. Checking for updates can then only be done manually (by clicking on the Check now button).

Tip: Subscribe to our free newsletter at www.softmaker.com to automatically receive an e-mail whenever
updates are available. The newsletter will also provide you with other useful information and special offers
with respect to SoftMaker Office on a regular basis.

Android/iOS: For applications installed from the Google Play/Apple App Store, your device will automatically
notify you of updates (unless disabled in the settings of the respective store).

Associate file types

Windows only: This button opens a dialog box where you can associate certain file types with PlanMaker. This
will make PlanMaker the default application for the corresponding file types.

If, for example, you link the file type "Microsoft Excel documents" with PlanMaker , files of this type will
always be opened in PlanMaker when you double-click on such a file in Windows Explorer.

Show/hide keyboard automatically

Android/iOS only: If this option is enabled, the on-screen keyboard opens automatically when you can type
something (for example, if you double-tap on a cell or tap into an input field in a dialog box).

Change keyboard layout automatically

Android/iOS only: If this option is enabled, the layout of the on-screen keyboard will automatically adapt to
the current situation. If, for example, you type into an input field in a dialog box which only accepts numbers,
the keyboard will automatically be switched to numeric mode.

Additionally, when you enter data into table cells, PlanMaker will lock the current input mode of the keyboard
when this option is enabled. If it is disabled, the keyboard will be reset to its standard mode (alpha-numeric)
with every cell you enter.

http://www.softmaker.com/
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Use OpenGL engine

Linux only: If this option is enabled, the program uses the OpenGL graphics engine. This speeds up the screen
display. Thus, this option should usually be enabled.

Note: On systems with a very outdated or faulty OpenGL installation, display errors may occur within the
application. This depends on your individual system configuration and especially on the graphics driver you are
using. In this case, disable this option and restart the application.

Furthermore: If the program detects problems with the installed OpenGL engine at startup, it will automatically
disable this option.

Use SHM extensions

Linux only: This option is only available if the option Use OpenGL engine is disabled (not recommended).

If the SHM extensions are enabled, the program uses shared memory (if available), which can speed up the
responsiveness of the display.

Use XIM

Linux only: If this option is enabled, PlanMaker supports the composition of accented characters (à, ô, é etc.)
using "XIM".

On a German keyboard, for example, the character "ô" can be created by first pressing the ^ key and then the O
key.

If you disable this option, you can no longer compose characters in this way.

Note: On some systems, disabling this option improves the responsiveness of the display when you are typing
text quickly.

Show hidden files and folders

Mac, Linux only: If this option is enabled, hidden files and folders are also displayed in file dialogs (for
example, those of the ribbon command File | Open).

Mouse wheel

Mac, Linux only: If your mouse has a mouse wheel, you can set the scrolling increment for a turn of the wheel
either by page (one complete page) or by a certain number of lines.

External applications

Mac, Linux only: This button opens a dialog box where you can specify the external programs that start
automatically for specific events. When a PDF file is created, for example, the application specified in the PDF
viewer field will be launched to display the result.

Note: You don't have to fill in these fields. For all fields that you leave empty, your system's default application
will be automatically used for this action. Make changes to this dialog box only if you want an application other
than the default application to be used. To do so, simply enter the file name of the corresponding executable file
(including the entire file path, if necessary).
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User-defined font paths

Mac, Linux, Android/iOS only: Here, you can specify paths for additional fonts that PlanMaker should use.
To do so, enter the subdirectory in which the font files are located. If you want to enter multiple directories,
separate them with a colon.

PlanMaker can then use these fonts in addition to the fonts available in your system.

Note: Changes to this setting only become effective after the program is restarted.

Settings, Fonts tab

On the Fonts tab in the dialog box of the ribbon command File | Options , you can specify which fonts are
to be displayed in font lists (for example, the font list on the ribbon command Home | group Character).

The tab presents a list of all fonts installed on your system. To enable or disable a font in the list, click on the
checkbox in front of its name. All fonts for which you have removed the check mark are no longer displayed in
font lists.

Background information: The fonts installed on your system by default include several fonts that you will
probably never need – for example, fonts that only contain scripts for foreign languages that you don't use. If
you like, you can hide such fonts as described above.

Use font filtering of the operating system

Windows only: Windows users will also find the option Use font filtering of the operating system on this
tab. If this option is enabled, Windows will automatically hide all fonts that only contain scripts for foreign
languages in font lists.

"Manage" button

In the dialog box of the ribbon command File | Options , you will find the Manage button on each tab. You
can use it to save the settings of the program and, for example, transfer them to a new version.

See the next section for more detailed information.
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Export/import settings
You can save your individual settings that you have configured in the SoftMaker Office applications. In the first
step, export the settings data – for example, before you install a new version. Then, in the second step, import
this data into the newly installed version.

For both steps, use the Manage button in the File | Options dialog box .

Which settings you can exactly export/import, you will find below.

Note: Export and import of settings data is only possible for version 2021 and later.

What reasons could there be to export/import settings?

The following reasons could be considered for exporting/importing your settings:

§ You want to apply the settings from the old version to a new version of SoftMaker Office that you install on
the same computer. 

§ You have also installed the current version of SoftMaker Office on another computer and would like to use
the same settings there.

§ You want to apply the settings of an old version of SoftMaker Office to another computer on which you
have installed the new version of SoftMaker Office.

Which files are saved?

For the export PlanMaker accesses the settings files (...config.ini, ...tools.dat etc.) that are stored in the
SoftMaker > Settings folder on your device. Depending on your operating system, these files are located
in the following directory:

§ Windows: In the SoftMaker\Settings folder of your Documents folder. 

§ macOS: In the SoftMaker/Settings folder of your Documents folder.

§ Linux: In the SoftMaker/Settings folder of your Home-directory.

§ Android: In the SoftMaker/Settings folder of your SD card.

§ iOS: In the SoftMaker/Settings folder of your App folder.

Note: The above information is for illustrative purposes only and you usually don't need to do anything here.
PlanMaker will automatically replace these files for you if you follow the steps described below for
exporting/importing the settings.
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Step 1: Export the settings

To export, choose the command File | Options  to open the dialog box "Settings". Here, click on the
Manage button located at the bottom left of each tab of this dialog box.

Another dialog box "Manage Settings" will open. Here, choose from the following options which settings you
want to save:

Tip: You can also just export all of them, but later when importing you must make sure that you only select
the options you really want.

§ Configuration files 

This option saves all the settings you have made in the dialog box of the File | Options command. Some of
these settings are also located directly on the ribbon tabs (or in the toolbars).

§ Customized ribbon/toolbars

If you have changed the arrangement on the ribbon, in the Quick access bar or in toolbars (see section
Customizing the Ribbon), you can save your individual arrangement with this option.

Please note for the import of settings from an old to a new version of SoftMaker Office: If this option is enabled, command icons
that have been newly added in the more recent version will then not be displayed there. So if you prefer the new icons to be displayed
instead of keeping your old arrangement, you should disable this option. Or you can import your old arrangement anyway and pick
out by yourself afterwards the new icons relevant for you by using the command File | Customize (see section Customizing icons
and groups in the ribbon).

§ Keyboard shortcuts

This option allows you to import keyboard shortcuts that you have assigned yourself (see section
Customizing shortcuts keys).

§ User dictionaries

This option allows you to save the words you have added to your user dictionaries (see section Editing user
dictionaries).

§ Other (SmartText, Labels, ...)

Enable this option if you want to apply all other settings that can be saved in SoftMaker Office (for example,
SmartText).

When you finally click on Export, a Zip file is created with the options you selected. Save this file to any
location that you can easily access for later import.

Note: The settings of all SoftMaker Office applications will be exported in this process (TextMaker,
PlanMaker, Presentations, BasicMaker). The same applies to the import in the following step. In the iOS
version, the steps has to be performed separately for each application.

Step 2: Import the settings

To import the settings to another installation of the program, choose the command File | Options there. In the
"Settings" dialog box, click on the Manage button.
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In the following dialog box "Manage settings", place a check mark in front of the settings you want to import.
(Details about the options are described above in step 1).

Now click the Import button and select the Zip file you created in step 1. The imported settings will take effect
in the current PlanMaker application when you restart the program.

"Reset" button

The Reset button resets all the program's settings to their delivery state.

Note: This action resets the settings for all SoftMaker Office applications (TextMaker, PlanMaker,
Presentations, BasicMaker) of this version. For iOS users, resetting applies to each application separately.
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Changing document properties

You can use the ribbon command File | group File management | Properties  to change settings that only
affect the current document and are saved with it. These settings are called document properties.

The available document properties are distributed by topic across multiple tabs. If you click on the Summary
tab, for example, you can edit the document info.

The following pages provide detailed explanations of all available document properties.

Document properties, Summary tab

On the Summary tab in the dialog box of the ribbon command File | Properties , you can enter some
additional info for the current document.

This can include explanatory information about the current document (subject, author, keywords, etc.) that the
file manager can use in searches.

For more information, see Document summary.

Document properties, Colors tab

On the Colors tab in the dialog box of the ribbon command File | Properties , you can edit the color palette
of the current document.

When you open a color list – for example, the color list for the font color – you see only a small selection of the
up to 16 million colors available. This selection is called the color palette of the document.

You can modify this color palette at any time. You can add new colors and change colors that you have added.
However, the first 24 colors in the palette are default colors that cannot be changed.

Important: Changes to the color palette are saved in the document. This means that you can create a separate
color palette for each document.

Adding a color

To add a color to the palette of the current document, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.
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Tip: Alternatively, this color palette can be accessed via any button that contains a color list (for example,
font color). To do so, select the entry Define color... in the color list (the last entry).

2. Set the desired color. For more information, see "Working with the color controls" section below.

3. Click on the New button.

4. Give the new color whatever name you like and confirm with OK.

5. Exit the dialog box with OK.

PlanMaker now adds the new color to the document's color palette. From now on, the color will be available in
all dialog boxes where a color can be selected.

Changing a color

Note: You can only change colors that you have added. The first 24 colors in the color palette are default
colors that cannot be changed.

To change a color, proceed as follows:

1. Choose the command File | Properties  and switch to the Colors tab.

Alternatively: You can also select the entry Define color... in any color list (for example, font color) to open
this dialog box.

2. Select the color to be changed from the Color palette list.

3. Make the desired changes. For more information, see "Working with the color controls" section below.

4. Click on Change.

The color has now been changed for the current document.

Renaming a color

You can change the name of self-defined colors at any time. To do so, open the color dialog, select a color from
the dropdown list Color palette and click on the Rename button.

Working with the color controls

The controls in the above dialog box let you set colors in many ways. All these ways lead to the same result –
just select your preferred method:

§ Using the color field and luminance slider 

The easiest way to set colors is to use the large color field and the luminance slider to its right. The color
field presents all available hues in all available saturations, while the luminance slider next to it provides a
means of varying the luminance.

To set a color, first click on the desired color in the large color field. Then click on the desired luminance in
the luminance slider.
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§ Using the hue, saturation and luminance controls 

Alternatively, you can set colors with the controls labeled Hue, Sat (saturation) and Lum (luminance).
Values between 0 and 240 are allowed.

§ Using the Red, Green and Blue controls 

Colors can also be set via their red, green and blue components. The controls labeled Red, Green and Blue
are provided for this purpose. Values between 0 and 255 are allowed.

§ Typing the hex code for a color 

You can also specify a color by typing its hex code in the input field with the hash (pound) sign #.

Such hex codes are common in the HTML code of web pages, for example. The hex code consists of 3 two-
digit hexadecimal values for the colors red, green and blue (RRGGBB). For example, 00FF00 represents
pure green.

Document properties, Statistics tab

On the Statistics tab in the dialog box of the ribbon command File | Properties , you can retrieve statistical
information about the current document:

§ The Cells section displays how many cells are filled with text, numbers, formulas, etc. 

§ The General section displays the number of worksheets and the number of pages.

§ The Objects section displays the number of objects (charts, pictures, etc.) in the current documents.

§ The Actions section displays when the document has been created, saved, and printed.

Document properties, Options tab

On the Options tab in the dialog box of the ribbon command File | Properties , you can make general
settings for the current document:

"Text frames" section

§ Tab width 

Determines the tab width for text entered in text frames.

"Cell contents" section

§ Syntax highlighting 

If this option is enabled, cells will be colorized according to their content. Corresponds to the ribbon
command View | Syntax highlighting (see Syntax highlighting).
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§ Show formulas 

If this option is enabled, cells containing a calculation will display the formula instead of the result.
Corresponds to the ribbon command View | Show formulas (see Displaying formulas instead of results).

§ Protection indicator 

If this option is enabled, a green triangle will be displayed in all unprotected cells – when sheet protection is
enabled. This makes it easier to see which cells may still be edited. For more information, see also Sheet
protection.

§ Hyphenation 

If this option is enabled, automatic hyphenation is performed in all cells where the option Wrap text has
been enabled in the dialog box of the command group Home | Alignment . For more information, see also
Hyphenation.

"Comments" section

§ Show indicators 

If this option is enabled, a red triangle is displayed in all cells that contain a comment (inserted with the
command Insert | Comment). For more information, see also Using comments.

§ Always show comments 

Normally, comments are displayed only when you point with your mouse to a cell that contains a comment.
If you enable this option, all comments in the current document will be displayed permanently.

"Decimal point after input" section

§ Move by ... decimals 

If this option is enabled, numbers entered in cells will be shifted by the specified number of decimal places.

This is helpful if, for example, many numbers with two decimal places have to be entered. If this option is
set to 2 and the number 42 is entered, it will be converted to 0.42. If 234 is entered, it will be converted to
2.34. The decimal points do not have to be entered manually.

"Window" section

§ Vertical scrollbar 

If this option is enabled, a vertical scrollbar is displayed in the document window.

§ Horizontal scrollbar 

If this option is enabled, a horizontal scrollbar is displayed in the document window.

§ Sheet tabs 

If this option is enabled, the worksheet register with tabs for each worksheet is displayed below the
document. These tabs can be used for switching between worksheets and creating/managing worksheets.
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"Objects" section

§ Guidelines for text frames 

If this option is enabled, non-printing border lines are displayed around text frames. These lines make it
easier to determine and change the position/size of text frames.

§ Show hidden objects 

As described in the section Hiding objects, you can hide inserted objects on the screen, that is: make them
invisible.

However, if you enable the option Show hidden objects, any object for whose Visible property is disabled
become visible on the screen.

Default currency

Use this option to change the default currency of the current document.

Note: Normally, this option should be set to System default. This will cause PlanMaker to use the default
currency from your system's country settings.

Setting this option to a different currency has the following consequence:

Whenever PlanMaker automatically applies the Currency number format to a cell (for example, because it uses
an arithmetic function that returns a monetary value), the currency chosen here will be used instead of the
system's default currency.

Compatibility button

Here, you can make internal settings for compatibility with documents created in older versions of PlanMaker
or in Microsoft Excel. These options are set automatically when the document is opened and should not
normally be changed.

Document properties, Calculate tab

On the Calculate tab in the dialog box of the ribbon command File | Properties , you can change settings
for the calculations in the current document:

"Recalculation" section

Determines if the calculations in the current document should be kept up-to-date automatically:

§ Recalc automatically 

If this option is enabled, calculations are updated automatically when the content of a cell is changed.
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This is the default setting. It guarantees that all calculations are up-to-date.

§ Recalc only before ... 

If this option is enabled, calculations will be updated only when saving or printing the document, or when
copying (or cutting) cells. If all of the above options are disabled, calculations will no longer be updated.

However, you can have the calculations updated manually at any time: To do this, choose the ribbon
command Formula | group Update| Update data | Update calculations or press the F9 key.

See also Updating sheets.

"External references" section

These options are related to external cell references (i.e. cell references that refer to cells in a different file). For
more information, see External cell references.

Available options:

§ Update data on opening 

Lets you choose if all external cell references in a document should be updated (once) when the document is
opened:

Always: When the document is opened, update its external references.

Never: When the document is opened, do not update its external references.

Ask user: When the document is opened, ask the user if external references should be updated.

§ Save external data in document 

If this option is enabled, PlanMaker saves a copy of all values returned by external cell references in the
document. If the file for an external reference is missing when the external reference is updated, the value
last stored will still be displayed.

If you disable this option, PlanMaker instead displays an error value when you update an external reference
while the corresponding file cannot be accessed.

"Rounding" section

Enabling these options increases the accuracy of calculations. Since computers use a different numeral system
than humans, some calculations may, in very rare cases, lead to very small rounding errors. This issue is not
PlanMaker-specific but affects practically all computer applications.

However, PlanMaker has two options that, when enabled, almost eliminate such rounding problems:

§ If Round final result is enabled, PlanMaker automatically rounds the final result of each calculation to 15
decimal places. 

§ If Round intermediate results is enabled, PlanMaker also rounds any intermediate result within a
calculation to 15 places.

The first option reduces the probability of receiving a rounding error significantly; the second option
reduces it even more. However, the disadvantage of enabling these options is that the time required to
recalculate the document increases.

A classical example for such rounding errors:
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If these options are disabled, the formula (0.1+0.2-0.3)=0 returns FALSE, though TRUE would be the
correct result. If both options are enabled, the calculation returns the correct result.

§ A third option is Precision as displayed: If you enable this option, all values are taken over exactly as they
are displayed to you after rounding to decimal places. The entered values are therefore truncated to the
decimal places that are set in the cell options for the number format. 

An example for explanation:

You have the sum of 2.3 + 2.4. The exact result is 4.7. However, you decide not to display the decimal
places after the decimal point. Therefore, you set the decimal places in the cell options to 0. The table
shows 2 + 2 now.

Without enabling the option Precision as displayed: You get the result 5 (because the values 2.3 + 2.4
still exist in the background and are rounded to 5). You can also continue to calculate with the exact
result 4.7.

By enabling the option Precision as displayed: You get the result 4 (because only the values 2 + 2 exist,
exactly as they are displayed in the cell). However, the exact result 4.7 has been lost for further
calculation.

Note on the Precision as displayed option: For longer decimal numbers than the decimal places that you
have set for the number format in the cell options, the original, more accurate values are permanently lost.
You should therefore be sure that you want to use this option in your calculation.

"Charts" section

Like calculations, charts are updated automatically when the content of any cell changes.

If you don't want this, disable the option Update automatically in the Charts section.

Charts must then be updated manually, if necessary. To do so, choose the ribbon command Formula | group
Update | Update data | Update charts.

"Iterations" section

This option affects only cells containing a circular reference. For example, if cell A1 contains the formula
=A1*2, this is called a circular reference, because the calculation in cell A1 refers to cell A1 itself.

If the Use iterations option is enabled, such calculations are repeated until a) the number of Maximum
iterations is exceeded, or b) the difference between the current result and the previous result of the iteration is
less than Maximum change.

By default, this option is not enabled.

Note: Unless you actually use circular references in calculations on purpose, this option should not be
enabled, since it significantly increases the time required to recalculate the document.



452Customizing PlanMaker

Document properties, Protection tab

On the Protection tab in the dialog box of the ribbon command File | Properties , you can provide
document protection to the current document.

You can ensure that opening or saving a protected document is only possible after entering the correct
password. Documents with read protection are also encrypted, so that they cannot be viewed with programs
other than PlanMaker.

For information on this topic, see Document Protection.

Document properties, Fonts tab

A list of all fonts used in the current document is displayed on the Fonts tab in the dialog box of the ribbon

command File | Properties .

The list is divided into fonts that are available on the current device and fonts that are not available (i.e., not
installed).

Changing worksheet properties
Using the ribbon command Insert | group Tables | Sheet  | Properties , you can define settings that only
affect the current worksheet.

If a document consists of several worksheets, you can change these settings separately for each sheet. To do so,
switch to the desired worksheet and then choose the above command.

Tip: You will also find the command in the context menu by right-clicking on the worksheet tab.

The program displays a dialog box with the following options:

§ Row header 

Determines whether row headers are displayed in the worksheet. Row headers are buttons labeled with the
row number, displayed to the left of the worksheet.

§ Column header 

Determines whether column headers are displayed in the worksheet. Column headers are buttons labeled
with the column number, displayed above the worksheet.

Tip: You can also use the ribbon command View | Row and column headers  to enable/disable the row
and column headers at once.
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§ Page breaks 

Determines whether dark gray lines indicating the location of page breaks are displayed in the spreadsheet.

Tip: This option can also be found directly on the ribbon tab View as Show page breaks.

§ Show zero values 

A cell contains a zero value when it contains either the number 0 (zero) or a calculation that returns zero.

If this option is enabled, the number "0" will be displayed in such cells as usual. If you disable it, nothing
will be displayed there.

Tip: This option can also be found directly on the ribbon tab View as Show zero values.

§ Gridlines 

Determines whether gridlines are displayed between cells on-screen. Also, you can change the color of these
lines as desired.

Tip: This option can also be found directly on the ribbon tab View as Show sheet grid.

By default, gridlines do not appear in printouts. To include gridlines in a printout, choose the ribbon
command File | group Print | Page setup, switch to the Options tab and enable the Grid option.

§ Sheet tab 

The worksheet register at the bottom of the document window displays tabs for each worksheet in the
document.

With this option, you can change the color of the tab for the current worksheet.

§ Background 

When you enable the option Alternating shade, alternating shading is applied to the lines of the table: Odd
lines are shaded as specified with the Shading 1 button, even lines are shaded as specified with the Shading
2 button.

§ Sheet direction 

For tables in Arabic script, you can change the direction of the worksheet to right-to-left here.

Doing this will reverse the horizontal direction of the worksheet – so that the cell A1 is no longer in the top
left corner but in the top right corner.

For more information, see also Working with Arabic text.

Customizing the document display
In this section, you will learn how to customize the appearance of the document on the screen. The required
commands can be found on the ribbon tab View.

The section covers the following topics:
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§ Zoom level 

The ribbon commands View | Actual size and View | Set zoom in the command group Zoom allow you to
set the zoom level of the worksheet.

§ Full screen view 

The ribbon command View | Full screen in the command group Windows maximizes the program window
and hides most parts of the user interface in order to display as much of the document as possible.

See the following pages for more information.

Zoom level

With the commands of the ribbon tab View in the group Zoom you can, among other things, select the zoom
level for the current document.

The command group "Zoom" on the ribbon tab View

§ The command Actual size always sets the document to a zoom level to 100%. 

§ The command Fit to selection automatically selects the zoom level at which the currently selected cells fit
exactly into the main window.

§ For an exact selection of the desired zoom, select the command Set zoom. The program displays a dialog
box with the following options:

Zoom level Explanation

Fit to selection Zooms in to the current selection as far as possible, see above.

Previous zoom level Restores the previous zoom level

50%, 75%, etc. Sets the zoom level to the desired level

Alternatively, custom values can be entered into the input box (50 to 400 percent).

Using the zoom slider

You can also use the zoom slider in the bottom right corner of the screen to change the zoom level:

To change the zoom level, either drag the slider with your mouse or click on the plus or minus icon.
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If you click on the percentage to the right of the zoom slider, you open the dialog box of the aforementioned
command View | group Zoom | Set zoom.

Tip: Also note the key combination Ctrl+middle mouse wheel for continuous zooming.

Full screen view

With the ribbon command View | group Windows | Full screen , you can switch to the full screen view in
which the program uses the entire screen to display the document. PlanMaker enlarges its program window to
the full screen size. (In the classic menu interface, all other toolbars are then hidden.)

To exit this view mode, press the Esc key or choose the ribbon command View | Full screen again.

Using the toolbar of the full screen view

When you enable full screen mode, an additional mini toolbar appears on the screen.

The mini toolbar "Full screen mode"

The icons in this toolbar have the following functions (from left to right):

§ Show/hide ribbon 

§ Show/hide pivot table sidebar

§ Enable/disable "Drag sheet" mode

If you enable "Drag sheet" mode, you can scroll your document using the mouse. Simply click into the
document and drag the mouse cursor in the desired direction (with the mouse button still held down).

Note: Selecting cells, text or objects is no longer possible in this mode.

To exit "Drag sheet" mode, click on this icon again.

§ Clicking on the Close button exits full screen mode. 
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Customizing the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section you will learn how to configure the ribbon and add additional icons.

The "Ribbon" and the Quick access toolbar (below)

The information covers the following topics:

§ Showing and hiding the ribbon 

§ Customizing icons and groups in the ribbon

§ Changing the position of the Quick access toolbar

§ Customizing icons on the Quick access toolbar

For more information, see the following pages.



457Customizing PlanMaker

Showing and hiding the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The ribbon is usually fully visible:

The "Ribbon" and the Quick access toolbar (below)

However, you can hide the ribbon at any time by minimizing it. This is useful if you want to have as much
screen space as possible to display the document.

Proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Also possible: Right-click anywhere on the ribbon.

2. A menu opens. There, you will find the option Minimized ribbon, which can be enabled or disabled by
clicking on it (a check mark appears in front of the option if it is currently enabled).

After you enable this option, the ribbon will be minimized. Only the ribbon tabs can then be seen.

Tip: Alternatively, you can use the icon  in the upper right corner of the program window next to the ?
icon to minimize the ribbon. If you click on the icon again, the ribbon is restored to its full size.

In addition, you can use the key combination Ctrl+F1 (Mac: Cmd+F1) to enable/disable minimization of the
ribbon.

Working with a minimized ribbon

You work with a minimized ribbon as follows:

§ When you click on one of the ribbon tabs of the minimized ribbon, the ribbon becomes completely visible
again temporarily and displays the corresponding ribbon tab. As soon as you trigger a command (for
example, click on the icon for a command), however, the ribbon will be automatically minimized again. 

§ If you double-click on one of the ribbon tabs, the ribbon will be permanently visible again, thus removing
the minimization. 

§ As mentioned above as a tip, you can also use the icon  in the upper right corner of the program window
to enable/disable the minimization of the ribbon.
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Customizing icons and groups in the ribbon

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The command Customize ribbon  allows you to customize the ribbon to a certain extent. The main purpose
of this command is to add additional icons, command groups or even complete ribbon tabs to the ribbon.

Important: The icons in the predefined command groups on the ribbon cannot be changed. This means that
you cannot add, remove, or change the order of icons in the existing command groups. Additional icons can
only be inserted in new command groups at the end of a ribbon tab (or optionally in a completely new ribbon
tab).

To customize the ribbon, proceed as follows:

1. Choose the command Customize ribbon under File | group Settings | Customize  to open the dialog box.
Alternatively: Right-click anywhere on the ribbon with the mouse button.

Tip: The dialog box can be opened even faster by double-clicking on any empty area of the ribbon.

2. Use one of the procedures described below to edit the ribbon tabs.

Basic structure of the dialog box

The dialog box of the command Customize ribbon contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected ribbon tab 

The right list displays the icons contained in the currently selected ribbon tab.

You define the ribbon tab to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:
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Adding an icon

Note: You can only add icons to command groups that you have added yourself (or to completely new ribbon
tabs). You cannot insert an icon into the predefined groups.

To add an icon to a specific ribbon tab, perform the following steps in the dialog box of the command File |
group Settings | Customize | Customize ribbon:

1. In the dropdown list Customize (top right), select the ribbon tab to which you want to add an icon.

The right list now displays all icons that are currently on the selected ribbon tab.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the ribbon tab. If you have not yet created a new group here, the program
automatically creates a new command group for the icon at the end of the ribbon tab.

Removing an icon

Note: You can only remove icons that you added to the ribbon yourself. You cannot delete any of the
predefined icons.

To remove one of the icons you added from a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be removed.

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.

The icon is now removed from the ribbon tab.

Moving an icon

Note: You can only move icons that you added to the ribbon yourself. You cannot change the position of any
of the predefined icons.

To move an icon in a ribbon tab, perform the following steps in the dialog box:

1. In the dropdown list Customize, select the ribbon tab on which the icon is located.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the ribbon tab.

Note: If you want to move an icon to a different ribbon tab, you must first remove it from its current ribbon
tab and then add it to the other ribbon tab.
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Adding a new command group

Note: New command groups can only be added after the default command groups. You cannot insert a user-
defined group between the predefined command groups.

To add a new command group (a new section) to a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Click on the New group button (displayed below the right list).

The new command group is now created (at the end of the ribbon tab).

Renaming a command group

Note: Only user-defined command groups can be renamed. You cannot rename any of the predefined
command groups.

To rename a user-defined command group in a ribbon tab, perform the following steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the Rename button (displayed below the right list).

4. Type in the new name and confirm it.

The command group will now be renamed accordingly.

Removing a command group

Note: Only user-defined command groups can be removed. You cannot delete any of the predefined
command groups.

To remove a user-defined command group from a ribbon tab, follow these steps in the dialog box:

1. Select the desired ribbon tab from the dropdown list Customize.

2. Select the desired command group from the right list below it.

3. Click on the button . (Any icons must have been removed from the group.)

Even faster: Simply double-click on the command group in the right list.

The command group is now removed from the ribbon tab.

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.
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Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

"Edit" button

The Edit button is only enabled if you have selected a user-defined icon in the list on the left side of the dialog
box. For more information see Creating user-defined icons.

Buttons for managing the ribbon tabs (right side)

Above and below the list on the right side of the dialog box, there are buttons for managing the ribbon tabs.
Some of these buttons have already been mentioned in this section. To ensure that users understand them better,
all buttons and their functions are clearly listed again below.

Above the list on the right:

§ New 

This button creates a new, empty ribbon tab. You can then customize this ribbon tab by adding icons and
command groups.

§ Rename

Use this button to rename the ribbon tab selected in the dropdown list Customize (only available for user-
defined ribbon tabs).

§ Reset

This button resets the ribbon tab selected in the dropdown list Customize back to its delivery state.

§ Delete

This button deletes the ribbon tab selected in the dropdown list Customize (only available for user-defined
ribbon tabs).

Below the list on the right:

§ New group 

This button adds a new command group to the ribbon tab selected in the dropdown list Customize.

§ Rename

Use this button to rename a command group (only available for user-defined command groups). First, select
the desired command group in the list on the right of the dialog box.

§ Reset all

This button resets all ribbon tabs back to their delivery state.

The Close button closes the dialog box and all changes are applied.
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Changing the position of the Quick access toolbar

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.

The "Ribbon" and the Quick access toolbar (below)

The Quick access toolbar can either share the space with the document tabs – or it is located in its own toolbar.
To change this, proceed as follows:

1. Choose the ribbon command File | group Settings | Customize .

Alternatively, right-click anywhere on the ribbon.

2. The program opens a menu that contains one of the following two commands:

Show Quick access toolbar as separate toolbar: By default, the Quick access toolbar is displayed in the
toolbar that also contains the document tabs. When you choose this command, the Quick access toolbar
moves to its own toolbar instead.

Show Quick access toolbar beside the document tabs: This command does exactly the opposite: If the
Quick access toolbar is currently displayed as a separate toolbar, choosing this command will cause the
Quick access toolbar to be moved back to the toolbar that also contains the document tabs.

Tip: You can also click on the double arrow button  directly in the Quick access toolbar itself. There, you
can use the entry Position to find the corresponding options for displaying the Quick access toolbar: Beside the
document tabs or Below the ribbon.

Customizing icons on the Quick access toolbar

"Ribbon" only: This section is relevant only for users who have configured the program to use the ribbon
interface. (For information on customizing the classic menu interface, see Customizing toolbars.)

The Quick access toolbar is displayed below the ribbon. It provides a selection of frequently used commands.
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The "Ribbon" and the Quick access toolbar (below)

If desired, you can customize the icons on the Quick access toolbar at any time, for example, you can add,
remove and reposition icons.

To do so, choose File | group Settings | Customize  | Customize Quick access toolbar (or click on the icon
 in the Quick access toolbar and select Customize there). In the following dialog box, you can edit the Quick

access toolbar according to the descriptions in Customizing toolbar icons – except for the passage "Managing
toolbars".

Tip: Alternatively, you can simply drag a command from the dialog box into the Quick access toolbar with
the mouse. Even quicker (without opening the dialog box): Hold down the Alt key and drag a command icon
directly from the ribbon to the Quick access toolbar. To remove it, drag the icon back into the ribbon while
holding down the Alt key.
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Customizing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Tip: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

In this section, you will learn how to configure the toolbars (Standard toolbar, Formatting toolbar, etc.) with the
menu command View > Toolbars and how to customize them with Tools > Customize.

A toolbar (here: the Standard toolbar)

The following topics are covered:

§ Showing and hiding toolbars 

§ Positioning toolbars on the screen

§ Managing toolbars (creating, deleting, renaming, resetting toolbars)

§ Customizing toolbar icons (adding, removing, moving icons)

§ Using the toolbar menu (for extra quick access to the above functions)

For more information, see the following pages.

Showing and hiding toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can enable or disable the available toolbars at any time to make them visible or to hide them.

To do so, proceed as follows:

1. Choose the menu command View > Toolbars.

Alternatively, click on the double arrow  at the end of a toolbar and select Toolbars.

2. Click on the checkbox in front of the desired toolbar to enable or disable it. When the toolbar is enabled, a
check mark appears in the box.
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3. Exit the dialog box with Close.

The corresponding toolbar has now been enabled or disabled.

Tip: There is a faster way to do this: If you right-click on any toolbar, a list of all available toolbars is
displayed. If you click on one of these menu items, the corresponding bar will be enabled or disabled.

Visible in mode...

Some toolbars are visible only in particular situations. The Picture toolbar, for example, appears only when you
select a picture.

This is due to the option Visible in mode, which determines when a toolbar should be visible. Some examples:

Option Explanation

All modes The selected toolbar is always visible (unless it has been disabled). Example: the Standard toolbar

Edit mode The bar is only visible in normal editing mode but not in object mode. For more information, see
also Object mode. Example: the Formatting toolbar

Object The bar is only visible in object mode but not in normal editing mode. For more information, see
also Object mode. Example: the Object toolbar

Chart The bar only appears if a chart is selected in the document.
Example: the Chart toolbar

Outline The bar only appears if the current worksheet contains an outline (see also Outlines). Example: the
Outline toolbar

Picture The bar only appears if a picture is selected in the document.
Example: the Picture toolbar

Table The bar only appears if you are in a cell of a newly inserted table (see also Tables in worksheets).

AutoShape The bar only appears if a drawing or text frame is selected in the document.

To change this setting for one of the toolbars, choose the menu command View > Toolbars, select the toolbar
in the list Toolbars and select the desired option for Visible in mode.

Note: Changing this setting in the default toolbars (Standard toolbar, Formatting toolbar, etc.) is usually not
recommended. This option is primarily intended for user-defined toolbars.
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Positioning toolbars on the screen

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can position each toolbar as desired on the screen. To do so, use one of the following procedures:

Changing the position with the command View > Toolbars

You can change the position of a toolbar at any time with the menu command View > Toolbars. To do so,
proceed as follows:

1. Choose the menu command View > Toolbars.

2. Select the desired toolbar by clicking on it in the list.

3. Select the desired position for the toolbar in the list Position.

Note: If you select the option Floating, the toolbar icons are displayed in a window that can be freely moved or
resized just like an application window.

Changing the position with the toolbar menu

Each toolbar has a button with a double arrow  at its right edge. Select the entry Position for the desired
toolbar. The following submenu provides a dropdown list of possible positions for the toolbar.

Note: If you have selected the option Floating, you can also use this button  to integrate the toolbar back into
a desired fixed position via the entry Position entry.

For more information on the toolbar menu options, see Using the toolbar menu.

Changing the position with the mouse

Some toolbars can also be repositioned with the mouse. To do so, proceed as follows:

1. Position the mouse cursor over an empty area of the toolbar.

2. Press the left mouse button and hold it down.

3. While still holding the mouse button down, drag the toolbar to the desired position.

4. Release the mouse button to place the toolbar in the new position.

Note: By default, most toolbars are locked to prevent unintentional movement with the mouse. However, you
can release this lock at any time: To do so, choose the menu command View > Toolbars, select the toolbar
and disable the option Locked. From now on, this bar can also be moved with the mouse.
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By the way, a positioning aid is enabled while dragging a toolbar: If you drag the toolbar near one of the edges
of the program window, it automatically jumps to the corresponding edge. If, for example, you release the bar at
the top edge, this corresponds to selecting the Top position in the dialog box of the menu command View >
Toolbars.

Managing toolbars

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

You can create new toolbars at any time and delete or rename existing toolbars, etc. To do so, use the buttons in
the dialog box of the menu command View > Toolbars.

Creating new toolbars

The program lets you create your own toolbars at any time.

If, for example, you frequently need to use commands of the Window menu that are not present in the Standard
toolbar, it might be worth your while to create your own toolbar for them.

You create a new toolbar as follows:

1. Click on the New button (in the dialog box of the menu command View > Toolbars).

2. The program displays a dialog box in which you enter a name for the new toolbar – for example, "My
toolbar". Then confirm with OK.

3. The new toolbar has been created. Close the dialog box or click on the Customize button to add icons to the
toolbar. For more information, see Customizing toolbar icons.

Customizing toolbar icons

You can edit the icons on toolbars with the Customize button. For more information, see the next section.

Deleting toolbars

The Delete button allows you to delete a user-defined toolbar as follows:

1. Select the toolbar to be deleted from the list.

2. Click on the Delete button.

Note: You can only delete user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be removed.

However, you can disable a default toolbar at any time if you don't need it by removing the check mark in front
of it. For more information, see Showing and hiding toolbars.
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Renaming toolbars

The Rename button can be used to rename a user-defined toolbar as follows:

1. Select the desired toolbar from the list.

2. Click on the Rename button.

3. Type in the new name and confirm it with OK.

Note: You can only rename user-defined toolbars. The default toolbars (Standard toolbar, Formatting toolbar,
etc.) cannot be renamed.

Resetting toolbars

You can undo any changes you have made to one of the default toolbars by clicking on the Reset button:

1. Select the desired toolbar from the list.

2. Click on the Reset button.

The toolbar now contains the default icons again. In addition, the default settings for the options Visible in
mode and Position are restored.

Note: This command only applies to the default toolbars (Standard toolbar, Formatting toolbar, etc.) but not to
user-defined toolbars.

Resetting all toolbars

To reset all toolbars at once, click on the Reset all button.

Note: This command only resets the default toolbars. User-defined toolbars remain unchanged.

Customizing toolbar icons

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

The menu command Tools > Customize allows you to customize the icons as desired on a toolbar. You can add
icons and remove or reposition existing icons, among other things.

Proceed as follows:

1. Choose the menu command Tools > Customize to open the dialog box. Alternatively: Click on the button

 at the end of a toolbar and select the entry Customize here.

Even faster: Double-click on an empty area in any toolbar.

2. Use one of the procedures described below to add, remove or reposition icons.
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Basic structure of the dialog box

The dialog box of the menu command Tools > Customize contains two lists:

§ Left list: all available commands 

The left list shows all commands available in the program.

Tip: You can use the option Categories (above the left list) to filter the list by a specific category (for
example, all commands of the "File" category).

You can also search the list by typing something in the Quick search field.

§ Right list: icons of the currently selected toolbar 

The right list displays the icons contained in the currently selected toolbar.

You define the toolbar to be displayed here via the dropdown list Customize (top right).

In this dialog box, you can perform the following actions:

Adding an icon

To add an icon to a specific toolbar, perform the following steps in the dialog box of the command Tools >
Customize:

1. In the dropdown list Customize (top right), select the toolbar to which you want to add an icon.

The right list now displays all icons that are currently in the selected toolbar.

Optional: In the right list, select the icon behind which the new icon is to be inserted.

2. In the left list, select the icon that you want to add.

3. Click on the button .

Even faster: Simply double-click on the icon in the left list.

The icon is now added to the toolbar.

Tip: Alternatively, you can add an icon to any toolbar as follows: Choose the command Tools > Customize.
Then simply drag the icon out of the dialog box with the mouse and drop it at the desired position in the
toolbar. (Do this in the toolbar itself and not in the dialog box!) Of course, this procedure only works when
the toolbar is currently visible on the screen.

Removing an icon

To remove an icon from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize (top right).

2. In the right list below it, select the icon to be removed.

3. Click on the button .

Even faster: Simply double-click on the icon in the right list.



470Customizing PlanMaker

The icon is now removed from the toolbar.

Tip: Alternatively, you can remove an icon from a toolbar as follows: Choose the command Tools >
Customize. Then simply drag the icon out of the toolbar with your mouse and drop it somewhere outside the
toolbar, for example, in the document. (Do this in the toolbar itself and not in the dialog box!)

Moving an icon

To move a toolbar icon to a different position, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list below it, select the icon to be moved.

3. Use the up  and down  arrow buttons to move the icon within the toolbar.

Note: If you want to move an icon to a different toolbar, you must first remove it from its current toolbar and
then add it to the other toolbar.

Tip 1: Alternatively, you can also move an icon as follows: Choose the command Tools > Customize. Then
drag the icon directly in the toolbar to the desired position (in the toolbar itself and not in the dialog box!).
This method also allows you to move an icon directly from one toolbar to another.

Tip 2: Moving icons works even if this dialog box is not open: When you hold down the Alt key, you can
move a toolbar icon by clicking on it and then dragging it to the desired position (while still holding down
the mouse button).

Inserting a separator

To insert a separator in front of an icon in a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar from the dropdown list Customize.

2. In the right list, select the icon in front of which the separator is to be inserted.

3. Click on the New separator button (displayed below the right list).

The separator is now inserted.

Tip: Alternatively, you can proceed as follows: Choose the command Tools > Customize. To insert a
separator to the left of an icon in any toolbar, simply drag the icon slightly to the right (in the toolbar itself
and not in the dialog box!).

Removing a separator

To remove a separator from a toolbar, perform the following steps in the dialog box:

1. Select the desired toolbar in the dropdown list Customize.

2. In the right list below it, select the separator to be removed.

3. Click on the button .
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Even faster: Simply double-click on the separator.

The separator is now removed from the toolbar.

Tip: Alternatively, you can also use the following procedure: Choose the command Tools > Customize. If
you now drag the icon that is to the immediate right of the separator a little bit to the left, the separator will
be removed. (Do this in the toolbar itself and not in the dialog box!)

Assigning shortcut keys

If you click on the Shortcut keys button in the dialog box, the dialog box will expand to include an additional
area called Shortcut keys, which can be used to edit shortcut keys for commands.

Summary: You can assign a shortcut key of your choice to any command here: Select the command in either of
the two lists, click on the Press new shortcut key field and then press the key combination with which you
want to choose this command in future.

For more information, see Customizing shortcut keys.

Managing toolbars

The dialog box of the command Tools > Customize also has buttons for managing toolbars:

§ New 

This button creates a new, empty toolbar.

§ Rename 

This button renames the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset 

This button resets the toolbar selected in the dropdown list Customize back to its delivery state.

§ Delete 

This button deletes the toolbar selected in the dropdown list Customize (only available for user-defined
toolbars).

§ Reset all (displayed below the right list) 

This button resets all toolbars back to their delivery state.

Further options for managing and configuring toolbars are available in the dialog box of the menu command
View > Toolbars. For more information, see Managing toolbars.
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Using the toolbar menu

Only for "classic menus with toolbars": This section is relevant only for users who have configured the
program to use the classic menus interface. For information on customizing the ribbon, see Customizing
the ribbon.

Some toolbars end on the right with a double arrow , as shown in the following figure:

If you click on this double arrow, the toolbar menu will open for this toolbar.

This menu gives you quick access to all toolbar-related commands described in the previous sections. The
toolbar menu contains the following commands:

§ Add/remove buttons 

This command displays a list of all icons available for a toolbar. If you click on one of the entries, the
corresponding icon in the bar will immediately be enabled or disabled.

(Note: This command is only meant for quickly enabling or disabling icons. For information on customizing
the icons in a toolbar, see Customizing toolbar icons.)

§ Position 

You can use this command to change the position of a toolbar. The available options include top, bottom,
left, right or floating (in a little window that can be moved and resized with the mouse).

§ Toolbars 

This option chooses the menu command View > Toolbars that allows you to enable or disable, configure
and manage toolbars.

For more information, see Customizing toolbars.

§ Customize 

This option chooses the menu command Tools > Customize that allows you to edit the icons on a toolbar
(add, remove, reposition icons).

For more information, see Customizing toolbar icons.

§ Reset this toolbar 

This option resets the toolbar. The bar then displays its default icons again. In addition, all settings made for
the bar are discarded.
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Creating user-defined icons
You can create user-defined icons at any time and then add them to the ribbon or a toolbar. Such icons can be
used to start other desired programs.

To create a user-defined icon – for example, an icon to start the Windows Editor – proceed as follows:

1. Choose the following command in the ribbon or menu:

Ribbon: File | group Settings | Customize  | Customize ribbon

Menu: Tools > Customize

2. In the dropdown list Categories, select the User category.

3. Select one of the icons from the list Commands.

The first three icons are pre-assigned (as examples) to the Windows Calculator, the Windows Character
Map and the Windows Control Panel. Select the fourth icon, for example.

4. Click on the Edit button displayed below the list. Another dialog box appears.

5. Enter a short description of the program to be started in the Description field – for example, "Notepad".

6. Enter the complete path and file name for the program to be started in the Command line field, for example,
C:\Windows\notepad.exe.

7. Optional: If you want the program to display an icon other than its default icon, enter the path and file name
of the desired icon file in the Icon file field.

Note that icons in toolbars are slightly smaller than the usual Windows icons.

As soon as you confirm with OK, the user-defined icon is created.

If you now want to add the user-defined icon to the ribbon or toolbar, proceed as described in the following
sections:

§ Ribbon: Customizing icons and groups in the ribbon 

§ Toolbars: Customizing toolbar icons 

Customizing shortcut keys
Commands that are frequently used in a program can also be chosen via shortcut keys. For example, the
command for saving the current document can be chosen very quickly by pressing the key combination Ctrl+S.

The predefined shortcut keys can be customized at any time in the dialog box of the ribbon command File |
Customize | Customize ribbon. You can assign a shortcut key to any command and change or remove existing
shortcut keys.
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To do so, proceed as follows:

Adding shortcut keys

To assign a shortcut key to a command, perform the following steps:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command to which you want to assign a shortcut key.

The left list shows all commands available in the program. (You can use the option Categories to filter this
list by a specific category and perform a search using the Quick search field.)

The right list displays only the icons that are in the currently selected ribbon tab or toolbar.

4. Once you have selected the desired command, click into the Press new shortcut key field and press the
intended key combination (starting with Ctrl or Alt).

Tip: If you make a typing mistake, you can always press the BackspaceÕ key to delete the shortcut key you
entered.

5. Do not forget: Click on Add to assign this shortcut to the command now.

6. Exit the dialog box with Close.

From now on, you can execute the selected command with the specified shortcut key.

Editing shortcut keys (removing, changing, etc.)

You can also edit existing shortcut keys for commands (for example, delete or change them) at any time.
Proceed as follows:

1. Choose the following command in the ribbon or in the classic menu interface:

Ribbon: File | group Settings | Customize  | Customize ribbon

Classic menus: Tools > Customize

2. In the dialog box that appears, click on the Shortcut keys button.

The dialog box now expands to include an additional section called Shortcut keys, which can be used to
edit the shortcut keys for commands.

3. In the left or right list, select the command whose shortcut keys you want to edit.

4. In the Shortcut keys section, perform one of the following actions:

Remove shortcut keys: The list Current shortcut keys displays all shortcut keys currently assigned to the
selected command. To remove a shortcut key, select it from the list and click on Remove.
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Change shortcut keys: To change the shortcut key for a command, first remove it (as described above) and
then assign it a new shortcut key (as described at the beginning of this section).

Reset shortcut keys: To reset all shortcut keys for the entire program to their default values, click on the
Reset all shortcut keys button and confirm the confirmation prompt. Any changes you have made to
shortcut keys will then be discarded.

Display a list of all shortcut keys: When you click on the Export button, a table listing all currently assigned
shortcut keys is displayed. The buttons next to the table allow you to copy it to the clipboard, for example.

5. Exit the dialog box with Close.

Available shortcut keys

Note that some of the key combinations that are possible on your keyboard are not allowed for shortcut keys.

As a rule, you should use alphabetic keys, numeric keys or function keys for shortcut keys. You can combine
them with Ctrl, Alt and/or the Shift keyñ.

You can easily check whether the desired key combination is allowed. Click in the Press new shortcut key
field in the dialog box described above, and then enter the key combination. If it does not appear in the field, it
is not allowed.

Some examples of valid shortcut keys include:

§ Ctrl+A 

§ Alt+A (However, key combinations with the Alt key are not recommended – Alt+A, for example, is
responsible for opening the View menu!)

§ Ctrl+Alt+A

§ Ctrl+Shift+A

§ Ctrl+Alt+Shift+A

§ Ctrl+F2

§ etc.

Note: Letters on their own are, of course, not allowed. Thus, you can't use A or Shift+A as shortcut keys.

Shortcut key already assigned: If you press a shortcut key that is already assigned, the current assignment will be
shown just below the input field. You should then press the Backspace keyÕ to delete your shortcut key and
try a different shortcut key. Otherwise, you will overwrite the existing assignment of this shortcut key.

Two-part shortcut keys: You can also use two-part shortcut keys (according to the WordStar standard) – for
example, Ctrl+K+X. However, only shortcut keys according to the scheme "Ctrl + letter + letter" are allowed
here.
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Editing lists for automatic filling
As described in Filling cells automatically, you can use the command Home | Fill to fill a cell range with a
repeating value or a sequence of values.

If you choose the Series entry from the ribbon command Home | group Contents | Fill , a dialog box opens.
Using the Edit lists button here, you can also create your own lists for the Fill function.

If, for example, you create a list with the content "Red", "Green" and "Blue", and later start a fill operation from
a cell that contains the text "Red", PlanMaker will continue the series and fill with Green, Blue, Red, Green,
Blue, etc.

Note: You can also add your own Edit lists button to a ribbon tab. To do so, use the ribbon command File |
Customize | Customize ribbon to select the dialog box for customizing the user interface, and search there
for the command "Edit lists". Then proceed as described in Customizing icons and groups in the ribbon.

You can also find the command directly via the  "Hamburger Menu": Tools > Edit lists

The dialog box of the command Edit lists provides buttons with the following functions:

§ "New" button: create a new list 

§ "Edit" button: edit the list created

§ "Delete"button: delete the list created

§ "Import" button: create a list from the currently selected cells

See the following pages for more information.

Creating a new AutoFill list ("New" button)

Proceed as follows to create a new AutoFill list for the Fill feature:

1. Choose the command  Edit lists.

2. Click on the New button in the following dialog box.

3. Another dialog box appears. Use it to enter the desired list entries. Please note that each line may only
contain one entry. Press the Enter key¿ after each entry to start a new line.

4. Then click on the OK button.

The new list has now been created.

Editing an AutoFill list ("Edit" button)

To edit a user-defined AutoFill list created with the Fill feature, proceed as follows:

1. Choose the command  Edit lists.
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2. In the following dialog box, select the list to be edited by clicking on it with the mouse.

Note: The predefined sample lists cannot be edited.

3. Click on the Edit button.

4. Another dialog box appears with the list entries. Edit them as desired. Please note that each line may only
contain one entry. Press the Enter key¿ after each entry to start a new line.

5. Then click on the OK button.

The list has now been changed accordingly.

Deleting an AutoFill list ("Delete" button)

To delete a user-defined AutoFill list created with the Fill feature, proceed as follows:

1. Choose the command  Edit lists.

2. In the following dialog box, select the list to be deleted by clicking on it with the mouse.

Note: The predefined sample lists cannot be deleted.

3. Click on the Delete button.

The list has now been removed.

Importing an AutoFill list from cells ("Import" button)

If a PlanMaker document contains a cell range whose contents you want to save as an AutoFill list, proceed as
follows:

1. Select the desired cells.

2. Choose the command  Edit lists.

3. In the following dialog box, click on the Import button.

PlanMaker reads the contents of the selected cells and creates a new AutoFill list from them. Each cell becomes
a list entry.

If you have selected multiple rows and columns, PlanMaker creates multiple lists accordingly. Before this, a
query appears asking whether you want to import the data row by row or column by column. Choose Row by
rowif you want each row to become a list, or Column by column if you want each column to become a list.
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Installing additional dictionaries
You can install additional dictionaries for the spell check as required. For information on how to install these
dictionaries, see the following sections:

§ Installing additional SoftMaker dictionaries 

This section explains how to add additional SoftMaker dictionaries to your installation.

Note: This is only relevant for the Android and iOS version. When you install SoftMaker Office for
Windows, Mac or Linux, all available SoftMaker dictionaries are already included.

§ Installing Hunspell dictionaries 

In addition to SoftMaker dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. Read
this section to learn more.

§ Choosing a different dictionary for a language 

If you have multiple dictionaries installed for a language (for example, one from SoftMaker and one from
Hunspell), you can also specify which of these dictionaries to use. Read this section for details.

For more information on these topics, see the following pages.

Installing additional SoftMaker dictionaries

SoftMaker Office comes with premium dictionaries for numerous languages. In this section, you will learn how
to install dictionaries that are not currently installed:

Windows, Mac and Linux

When you install SoftMaker Office for Windows, Mac or Linux, all available SoftMaker dictionaries are
already included – so there is no need to subsequently install additional SoftMaker dictionaries.

Android and iOS

The situation is different with SoftMaker Office for Android and iOS: SoftMaker dictionaries that were not yet
installed can be downloaded free of charge from our server at any time and can be installed automatically.

To do so, proceed as follows:

1. Launch any of the apps (TextMaker, PlanMaker or Presentations) on your Android/iOS device.

2. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

3. Click on the Get more dictionaries button.
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4. The program opens a dialog box with a list of all available languages. To download a language, tap on the
download icon to the right of it.

Once the download is complete, the dictionary is automatically installed and will be available from now on in
all SoftMaker Office applications.

Installing Hunspell dictionaries

In addition to SoftMaker dictionaries, SoftMaker Office also supports the use of Hunspell dictionaries. These
dictionaries are available as free downloads. Most of them were created by private users or non-profit
organizations.

Hunspell dictionaries are available for numerous languages. If you can't find a dictionary for a language in
SoftMaker Office, it's worth checking if a Hunspell dictionary is available for it.

A list of all Hunspell dictionaries available for SoftMaker Office can be found in the "Downloads" section of
our website www.softmaker.com. There, you can also download the dictionaries free of charge.

To download and install a Hunspell dictionary, proceed as follows:

1. Use your web browser to navigate to our website www.softmaker.com

2. Select "Downloads" from the website menu, and then click on "Dictionaries".

3. Your browser now displays a page with a list of all Hunspell dictionaries supported by SoftMaker Office.
Download the desired dictionary.

4. Launch any SoftMaker Office application (TextMaker, PlanMaker or Presentations).

5. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

6. Click on the Hunspell dictionaries button.

7. The program displays a dialog box with a list of all installed languages/dictionaries. Click on the Add
Hunspell dictionary button.

8. A file dialog appears. Use it to navigate to the folder where the downloaded dictionary has been stored.

9. Select the dictionary file from the file list and click on Open.

The dictionary is now installed and will be available from now on in any SoftMaker Office application.

Choosing a different dictionary for a language

If you have multiple dictionaries installed for a language (for example, a SoftMaker dictionary and a Hunspell
dictionary), you can always choose which of these dictionaries to use for that language.

To do so, proceed as follows:

1. Choose the ribbon command File | Options  for the dialog box and switch to the Language tab.

http://www.softmaker.com/
http://www.softmaker.com/
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2. Click on the Hunspell dictionaries button.

The program displays a dialog box with the list of all installed languages. On the right side of the list, you
can see what type of dictionary the respective language is currently using.

3. Select the desired language from this list.

4. Then specify the dictionary to be used for the selected language in the dropdown list Dictionary.

Depending on which dictionaries are installed, the list may have the following entries:

SoftMaker: The SoftMaker dictionary included in SoftMaker Office

Hunspell: Freely downloadable Hunspell dictionary, see previous section

5. Confirm with OK.

From now on, the spell check will use the selected dictionary for the specified language.
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Formulas and functions
This chapter provides instructions on working with formulas, including comprehensive descriptions of
PlanMaker's arithmetic functions:

The chapter consists of the following sections:

§ Formula basics 

The first section provides basic information on formulas.

§ Entering formulas 

This section provides information on entering formulas in cells.

§ Relative versus absolute cell references 

This section explains the difference between relative cell references (like =A1) and absolute cell references
(like =$A$1) in formulas.

§ External cell references 

The next section is about external cell references in formulas. These are cell references that refer to cells in
a different file.

§ Error values 

If a formula results in an error, an error value is displayed instead of the result. This section provides
information on error values.

§ Working with arrays 

This section provides instructions on working with arrays and array formulas.

§ Working with database functions 

This section provides information on database functions such as DCount, DSum, etc.

§ Functions from A to Z 

This section contains comprehensive descriptions of PlanMaker's arithmetic functions.

Tip: A short introduction to working with formulas is also provided in chapter The PlanMaker tour.
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Formula basics
If you want to perform a calculation in PlanMaker, first place the cell frame on the cell where the result should
appear. Then type the desired calculation into this cell.

Important When typing a formula, you must always start with an equals sign =, otherwise PlanMaker will
consider your input as text or numerical values.

Formulas can be composed of the following components:

§ Fixed values (e.g., numbers or text) 
§ Cell references (e.g., A1 or D2:D3)
§ Arrays (see also Working with arrays)
§ Arithmetic operators (e.g., + or -, see also Operators in formulas)
§ Arithmetic functions (e.g., SUM)

The result of a calculation can represent both a final value and an intermediate result, because each cell that
contains the result of a calculation can be reused in another cell.

For example, a valid formula can look like this:

= 67 + (A3 * Sum(B1:C5))

Operators in formulas

Formulas can contain any of the operators listed below.

Please note that operators follow a strict order of precedence, which defines the evaluation order of expressions
containing operators: Operators with higher precedence are evaluated before operators with lower precedence.

Parentheses can be used to override the order of precedence and force parts of a formula to be evaluated before
other parts.

For example, 1+2*2 returns 5, since multiplication has precedence over addition. If the formula (1+2)*2 is used
instead, the result will be 6, since the parentheses override the order of precedence.

Operators available, listed in order of precedence (top = highest):

1st Space Intersection (see also INTERSECTION function)

2nd % Percentage

3rd + Positive sign (not addition!)

– Negative sign (negation)* (not subtraction!)

4th ^ Exponentiation*
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5th x Multiplication

/ Division

6th + Addition

– Subtraction

7th & Concatenation (For example, "Plan" & "Maker" returns "PlanMaker")

8th = Is equal

<> Is not equal

< Is less

> Is greater

<= Is less or equal

>= Is greater or equal

* Note: To ensure compatibility with Microsoft Excel, the order of precedence for the exponentiation operator (^) and the negation operator (-) is
changed, but mathematically incorrect. For example, the correct mathematical order (first exponentiation, then sign) for the formula -2^2 would lead to
the mathematically correct result -4. However, the actual result in PlanMaker (and in Excel) is 4.

Entering formulas
There are several ways to enter a calculation formula in a cell. These can be combined at will.

Tip: A short introduction to entering formulas is also provided in chapter The PlanMaker tour.

Entering formulas manually

You can easily enter formulas in the desired table cell manually.

Important: When you enter formulas directly in a table cell, you must always type the equal sign (=) first, so
PlanMaker knows that a formula follows, and not text.

When you have entered the formula, press the Enter key¿ to confirm your entry – or Esc to cancel it.

Alternatively, use the following buttons of the Edit toolbar:

§ To accept the input, click on the   button. 

§ To cancel the input, click on the   button.

To edit a formula later, navigate to the cell containing the formula and press the F2 key. Alternatively, double-
click the cell.
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Using the mouse to enter formulas

When entering a formula, you can use the mouse to paste cell ranges or single cells into the formula. Simply
drag a rectangle in the table or click on the desired cell.

An example:

You want to enter the formula =SUM(B2:D4) in a cell. You can do this as follows:

1. Enter =SUM(

2. Select cells B2 to D4 with the mouse. To do this, hold down the left mouse button and drag a rectangle that
starts in cell B2 and ends in cell D4.

3. When you release the mouse button, the cell address is automatically pasted into the formula. The formula
now displays: =SUM(B2:D4

4. Enter the closing parenthesis ) and press the Enter key¿ to complete the formula.

The cell will now contain the formula =SUM(B2:D4).

The command Formula | Function

If you want to use arithmetic functions in formulas, you can simply type them in.

Or you can use the ribbon command Formula | Function . This allows you to conveniently select formulas
with the mouse.

The dialog box for this command has the following components:
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§ Formula input box 

Lets you edit the formula.

§ Category 

Determines which type of functions to display in the Function list box.

In the Named ranges category at the end of the list, you can access your existing named cell ranges to insert
them into formulas (see Using named ranges).

§ Function 

Displays all functions of the selected category. To copy a function to the Formula input box, double-click
it.

Tip: If you select a function, a short description is automatically displayed in the lower part of the dialog
box. In the Windows version of PlanMaker, you can also open a help page for each function by clicking
on it and then pressing the F1 key.

§ Operator 

Contains buttons for common arithmetic operators. To copy an operator to the Formula input box, click the
corresponding button.

§ Insert button 

Pastes the contents of the Formula input box into the current cell and closes the dialog box.

§ Close button 

Close the dialog box without inserting the formula.

Relative versus absolute cell references
Cell references in calculations can be entered either as relative cell references (like =A1) or as absolute cell
references (like =$A$1).

This section explains the difference between relative and absolute cell addressing:

Relative cell references

When you enter a reference to another cell into a formula, normally relative cell addressing is used.

An example: You enter the following formula in cell B3:

=B1+B2

PlanMaker does not interpret this as "Add B1 and B2", but rather as "Add the values in the two cells that are
directly above cell B3".

You will notice this when you copy or move cell B3 to C3. PlanMaker then adapts the formula immediately:
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=C1+C2

Absolute cell references

If you do not want formulas to automatically adapt when they are copied or moved, use absolute cell addressing
instead of relative cell addressing. To make a relative cell reference absolute, type a dollar sign ($) in front of
the column number and/or row number. Optionally, you can classify complete cell addresses as absolute (e.g.
$B$1) or just one component of it (e.g., $B1 or B$1).

An absolute cell reference always refers to the original cell address, no matter where you move the cell with the
formula afterwards.

For example:  =$B$1 + $B$2

If you enter this formula in cell B3 and move this cell to C3, PlanMaker will still refer to cells B1 and B2.

Tip: Using the F4 key to change cell addressing

When you enter a cell reference in a formula, you can use the F4 key to switch the type of addressing.

For example, after having typed =A4,

=$A4 will be displayed, when you press F4,

=A$4 will be displayed, when you press F4 once again,

=$A$4 will be displayed, when you press F4 once again.

If you press F4 once again, the old entry =A4 will be displayed again.

External cell references
In calculations, you can use cell references that refer to cells located in a different PlanMaker or Excel
document. Such references are called external cell references.

In this section, you will learn everything you need to know about this. The following topics are covered:

§ Entering external cell references 

§ Updating and managing external cell references

See the following pages for more information.

Entering external cell references

Cell references that refer to cells in a different document have to be entered in calculations as follows:
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='C:\My Folder\[My Workbook.pmdx]Sheet1'!A1

This example returns a cell reference to the cell A1 in the worksheet "Sheet1" in the PlanMaker document "My
Workbook.pmdx" in the folder "C:\My Folder".

As you can see, external cell references must consist of the following components:

§ Quotation mark 

External cell references should always start with a quotation mark. You can use either single quotes (') or
double quotes (").

§ Folder 

Next, enter the entire path to the folder where the external file is located. For example: C:\My folder\

Tip: If the external file is in the same folder as your document, you can omit the path.

§ File name in square brackets 

Next comes the file name, enclosed in square brackets. Only PlanMaker and Excel files are allowed.

§ Sheet name 

The next component is the name of the worksheet that holds the desired cell.

§ Quotation mark 

Next comes another quotation mark.

§ Exclamation mark 

Then an exclamation mark.

§ Cell reference 

The last component is the address of the cell that you want to refer to. Cell ranges are also permitted, of
course.

To complete your input, press the Enter key¿. PlanMaker will now read the content of the cell in the specified
external file.

For information on updating and managing external cell references, see the next section.

Notes

§ If PlanMaker is unable to find the specified file, a dialog box where you can select the file will appear when
you press the Enter key. 

Tip: If you don't want to type in the entire path and file name manually, you can use the following trick: In
the cell reference, simply enter [x.pmdx] instead of the path and file name – for example: =[x.pmdx]
Sheet1!A1. This will "force" PlanMaker to display a file dialog after pressing Enter, where you can
comfortably choose the file you want to refer to.

§ If PlanMaker is unable to find the specified worksheet, a dialog box where you can select the worksheet
from the specified file will appear when you press Enter. 
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§ Normally, PlanMaker remembers the entire (absolute) path of the external file. However, if the external file
is located in the same folder as your document (or one of its subfolders), PlanMaker stores only the relative
path. 

This means in practice: If your document and the external file reside in the same folder, references to this
external file will stay intact even when you move both files to a different folder.

Tip: Quickly insert a reference via "Insert content"

There's an alternative way to create external references, where you don't have to type in anything manually:

1. Open the document containing the cell you want to refer to.

2. Copy this cell to the clipboard.

3. Switch back to the current document.

4. Navigate to the cell where you want the reference to be inserted.

5. Click on the arrow of the Insert icon  (on the ribbon tab Home |  group Edit) and choose the command
Paste special from the dropdown menu.

Alternatively: Right-click to open the context menu and select Paste special or simply use Ctrl+Alt+V.

6. In the following dialog box, click on the Paste references button.

PlanMaker now creates an external reference to this cell.

Updating and managing external cell references

Use the ribbon command Data | group Edit | External references  to update and manage the external
references in a document.

Choosing this command opens a dialog box that lists all files the current document refers to.

The buttons in this dialog box allow you to perform the following actions:

§ Update 

Updates only those external cell references that refer to the file currently selected in the list. (See also
"Notes on updating external cell references" below)

§ Update all 

Updates all external references in the entire document.

Tip: Alternatively, you can trigger Update all via the ribbon command Formula | group Update | Update
data | Update external references.

§ Open 

Opens the external file currently selected in the list.
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§ Change 

Lets you choose a different file for the external file currently selected in the list. All references to this file in
your document will be adopted accordingly.

§ Previous 

Jumps to the previous cell that contains a reference to the file selected in the list.

§ Next 

Jumps to the next cell that contains a reference to the file selected in the list.

Click on the Close button to exit the dialog box.

Notes on updating external cell references

Important: The values returned by external cell references are not updated automatically every time the
worksheet is recalculated.

External cell references are updated only in the following cases:

§ When you open a document, all external cell references it contains are updated automatically (once). 

You can disable this automatic update – see the options described below.

§ After that, you can update external references manually whenever needed. 

To do so, choose the ribbon command Data | group Edit | External references  and use the Update or
Update all button in the dialog box as described above.

Alternatively: Use the ribbon command Formula | group Update | Update data | Update external
references which does the same as the Update all button.

Options for updating external cell references

There are some options related to updating external references in the document properties.

To change these, choose the ribbon command File | group File management | Properties  and switch to the
Calculate tab.

There, the following options are available in the External references section:

§ Update data on opening 

Lets you choose if all external cell references in a document should be updated (once) when the document is
opened:

Always: When the document is opened, update its external references.

Never: When the document is opened, do not update its external references.

Ask user: When the document is opened, ask the user if its external references should be updated.
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§ Save external data in document 

If this option is enabled, PlanMaker saves a copy of all values returned by external cell references in the
document. If the file for an external reference is missing when the external reference is updated, the value
last stored will still be displayed.

If you disable this option, PlanMaker instead displays an error value when you update an external reference
while the corresponding file cannot be accessed.

Note: The above options aren't global settings but document properties. This means that you can set them up
individually for each document.

Error values
If a formula results in an error, an error value is displayed instead of the result.

An example: A division is to be performed in a cell by the content of another cell. This other cell contains a
value of 0. PlanMaker cannot perform this division by zero, which is not allowed in mathematics. The error
value #DIV/0! will now be displayed in the cell, indicating that a division by zero is being performed.

The following error values exist:

Error value Explanation

#REF! Invalid cell reference. Displayed when the formula contains a cell reference that is invalid or
nonexistent after deleting cells (e.g. with the ribbon command Home | group Cells | Delete).

#DIV/0! Division by zero. Displayed when a formula contains a division by zero (which is undefined for any
number).

#NULL! Invalid formula. Displayed when a formula contains syntax errors (for example, a missing parenthesis
or missing arguments).

#NAME? Invalid name. Displayed when a formula refers to a table name or named range that is nonexistent.

#N/A Not available. Displayed when a cell contains a) a #N/A error value, or b) a formula referring to a cell
containing a #N/A error value. See NA (error value #N/A) for details.

#VALUE! Invalid value. Displayed when a function is used with an inappropriate parameter type (for example, if
a number is passed to a function that is expecting a text string).

#NUM! Invalid number. Displayed when a function is used with a number that is out of range (for example,
too large, or negative instead of positive)

Tip: To test if a cell returns an error value, use the functions ISERROR and ISERR

Tip: Additionally, you can also use the formula auditing from the command group Traces on the ribbon tab
Formula to find and analyze cells that contain an error value. For more information, see Analyzing sheets.
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Working with arrays
PlanMaker allows you to enter arrays (also known as matrices) in spreadsheets and perform calculations with
them. An array is a rectangular table of numbers, structured as follows:

The entries a11 through amn are called the elements of array A. These are divided into m rows and n columns.

This is why it is called an m by n array (or m x n array).

Entering arrays into cells

To enter an array in PlanMaker, distribute the array's rows and columns over the spreadsheet's rows and
columns.

For example, the following array ...

... has to be entered as follows:

As you can see, each (rectangular) cell range can also be seen as a matrix – and vice versa. Accordingly, for
arithmetic functions that expect a matrix as an argument, you can always specify a cell range that contains the
elements of the matrix.

Entering array formulas

PlanMaker provides array functions that allow you to perform calculations with arrays. A formula containing
an array function is called an array formula.
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Since most array formulas return an entire array of values rather than a single value, entering array formulas
differs from entering other formulas. Let's take a look at an example of this:

You want to determine the inverse of the 3x3 matrix shown above. To do so, proceed as follows:

1. Select a cell range for the resulting array

Before entering the formula, you have to select the cell range where the resulting array should be placed.
The inverse of a 3x3 array also has 3x3 elements. Therefore, you have to select a range of 3 by 3 cells – for
example E10:G12.

2. Enter the array formula

Now enter the desired array formula. In our example this would be the formula =MINVERSE(E6:G8).

3. Ctrl+Shift+Enter

Important: To finalize the formula, do not press just Enter¿, but press the key combination Ctrl+Shift+¿.

The cells E10:G12 now contain the resulting array, i.e., the inverse of the array in E6:G8:

Notes:

§ If you have selected a cell range larger than the resulting array, the error value #N/A ("not available") will
be displayed in the superfluous cells. Important: If the selected cell range is too small, parts of the array will
not be displayed. 

§ To edit an existing array formula: Select all cells covered by the resulting array, edit the formula and press
Ctrl+Shift+¿. If you press just the Enter¿ key instead, PlanMaker issues a warning and asks you if you
want to overwrite the array.

§ Tip: To select all cells covered by an array formula, click any of the involved cells and press Ctrl+7.

Entering array constants in formulas

If desired, arrays can be entered as constants instead of cell references. For this purpose, surround the array by
braces { }. Additionally, separate columns by commas and rows by semicolons.

For example, the following array ...
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... can be entered as follows:

={1,2,3;3,-1,1;2,2,4}

Notes:

§ The notation described above is suitable for fixed values only; formulas and cell references are not allowed. 

§ You can also enter vectors in the notation described above. For a horizontal vector enter, e.g., {1,2,3}; for a
vertical vector enter {1;2;3}.

Working with database functions
PlanMaker provides database functions that allow you to query and evaluate a cell range that is structured like a
database.

Database functions expect the following syntax:

FUNCTION_NAME(DatabaseArea, Column, CriteriaArea)

For example, the DSUM function returns the sum of all cells in the DatabaseArea cell range that are in the
specified Column and match the conditions defined in the CriteriaArea cell range.

To utilize database functions, proceed as follows:

Creating a database area

A database area can be any cell range containing data to evaluate. It has to be structured as follows:

§ Its first row must contain labels for the database columns (e.g., Amount, Price, etc.). 

§ The data has to be arranged row by row (one row for each record).

The rows of the database area represent what is called a record in database applications, with the cells being the
fields of the database.

Creating a criteria area

The criteria area is a cell range containing conditions that the database records have to match.

It has to be structured as follows:

§ Important: The criteria area has to be located above the database area. The criteria area must not overlap the
database area. 
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§ The first row must also contain column labels. For example, if you want to define criteria for the columns
that you have given the labels Amount and Price in the database area, you must also enter Amount and Price
here.

§ Below the labels, conditions can be entered. You can enter either single values or comparisons like ">42" or
"<=10".

§ If multiple conditions have been entered in the same row, the database contents have to match the conditions
in column 1 and column 2 and column 3, etc.

§ If multiple rows with conditions have been entered, the database contents have to match the conditions in
row 1 or row 2 or row 3, etc.

Utilizing database functions

After having filled out database area and criteria area, you are ready to apply database functions.

Some examples, assuming that the following spreadsheet has been created:

In this spreadsheet, for example, the following calculations can be performed:

DCOUNT(A11:C16, , A2:A3) returns 2. This formula counts the number of records matching the condition
Color = blue.

DCOUNT(A11:C16, , A6:B7) returns 3. This formula counts the number of records matching the condition
(Amount > 25 and Amount < 75).

DCOUNT(A11:C16, , A6:C8) returns 4. This formula counts the number of records matching the condition
(Amount > 25 and Amount < 75) or (Color = red).

DSUM(A11:C16, "Amount", A2:A3) returns 150. This formula calculates the sum of the values in the
"Amount" column for all records matching the condition Color = blue.
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DSUM(A11:C16, 1, A2:A3) returns 150. Same as above, except that the column was specified by its relative
number instead of its label.

Functions from A to Z
This section provides an alphabetical list of PlanMaker's arithmetic functions, including comprehensive
descriptions of each function.

ABS (absolute value)

Syntax:

ABS(Number)

Description:

Returns the absolute value of a number, i.e., removes its sign.

Example:

ABS(42) returns 42

ABS(0) returns 0

ABS(-42) returns 42

See also:

SIGN, NEG

ACOS (arccosine)

Syntax:

ACOS(Number)
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Description:

Returns the arccosine of Number, i.e., the angle whose cosine is Number.

Number must be > -1 and < 1.

The result is expressed in radians.

Example:

ACOS(1) returns 0

ACOS(COS(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

COS, ASIN, ATAN

ACOSH (inverse hyperbolic cosine)

Syntax:

ACOSH(Number)

Description:

Returns the inverse hyperbolic cosine of Number, i.e., the value whose hyperbolic cosine is Number.

Example:

ACOSH(1.1) returns 0.44357

ACOSH(COSH(0.1234)) returns 0.1234

See also:

COSH
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ACOT (arccotangent)

Syntax:

ACOT(Number)

Description:

Returns the arccotangent of Number, i.e., the angle whose cotangent is Number.

The result is expressed in radians.

Example:

ACOT(1) returns 0.7854 (45°)

ACOT(COT(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

COT

ACOTH (inverse hyperbolic cotangent)

Syntax:

ACOTH(Number)

Description:

Returns the inverse hyperbolic cotangent of Number, i.e., the value whose hyperbolic tangent is Number.
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Example:

ACOTH(2) returns 0.54931

ACOTH(COTH(0.1234)) returns 0.1234

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

COTH

ADDRESS (cell address as text)

Syntax:

ADDRESS(Row, Column [, Abs] [, Mode] [, SheetName])

Description:

Returns a text string containing the address of a cell.

For row and column, the row number and column number of the cell must be specified.

The optional argument Abs specifies the type of reference to be returned:

1 or omitted: Absolute row and column

2: Absolute row, relative column

3: Relative row, absolute column

4: Relative row and column

The optional argument Mode specifies the format of the cell address returned:

TRUE or omitted: Normal cell address (e.g. A1)

FALSE: Cell address in R1C1 format (an alternative type of cell addressing, supported by Microsoft Excel
only)

The optional argument SheetName lets you specify a worksheet name. If specified, it will be placed before the
resulting cell reference In other words: 

If it is not specified, only the cell address will be returned.

If it is specified, SheetName!Address will be returned (see example).
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Example:

ADDRESS(1, 5) returns $E$1

ADDRESS(1, 5, 4) returns E1

ADDRESS(1, 5, 4, , "MySheet1") returns MySheet1!E1

See also:

INDIRECT, OFFSET, COLUMN, ROW

AND (logical AND function)

Syntax:

AND(Value1 [, Value2, Value3 ...])

Description:

Returns the logical value TRUE if all of the given arguments are TRUE, otherwise returns FALSE.

You can use it to evaluate, for example, if several conditions are fulfilled all together.

Example:

AND(TRUE, TRUE) returns TRUE

AND(TRUE, FALSE) returns FALSE

AND(FALSE, FALSE) returns FALSE

AND(A1>0, A1<1) returns TRUE, if A1 is greater than zero and less than one.

See also:

OR, XOR, NOT
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AREAS (number of areas)

Syntax:

AREAS(reference)

Description:

Determines how many cell ranges the specified cell reference contains.

Example:

AREAS(A1:B2) returns 1

AREAS((A1:B2, E5:G7)) returns 2

See also:

INDEX, COLUMNS, ROWS

ASIN (arcsine)

Syntax:

ASIN(Number)

Description:

Returns the arcsine of Number, i.e., the angle whose sine is Number.

Number must be > -1 and < 1.

The result is expressed in radians.

Example:

ASIN(1) returns 1.5708... (corresponds to PI()/2, thus 90°)

ASIN(SIN(0.1234)) returns 0.1234
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Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

SIN, ACOS, ATAN

ASINH (inverse hyperbolic sine)

Syntax:

ASINH(Number)

Description:

Returns the inverse hyperbolic sine of Number, i.e., the value whose hyperbolic sine is Number.

Example:

ASINH(1.1) returns 0.9503

ASINH(SINH(0.1234)) returns 0.1234

See also:

SINH

ATAN (arctangent)

Syntax:

ATAN(Number)

Description:

Returns the arctangent of Number, i.e., the angle whose tangent is Number.

The result is expressed in radians.
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Example:

ATAN(1) returns 0.7854 (45°)

ATAN(TAN(0.1234)) returns 0.1234

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

ATAN2, TAN, ACOS, ASIN

ATAN2 (arctangent 2)

Syntax:

ATAN2(x, y)

Description:

Returns the arctangent of the given coordinates, i.e., the angle between the x axis and a line from the origin (0,
0) to a point with the coordinates (x, y).

The x- and y- coordinate of this point must be given as arguments.

The result is expressed in radians.

Example:

ATAN2(1, 1) returns 0.7854 (45°)

Tip:

You can use the DEGREES function to convert the result from radians to degrees.

See also:

ATAN, TAN
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ATANH (inverse hyperbolic tangent)

Syntax:

ATANH(Number)

Description:

Returns the inverse hyperbolic tangent of Number, i.e., the value whose hyperbolic tangent is Number.

Number must be > -1 and < 1.

Example:

ATANH(0.5) returns 0.54931

ATANH(TANH(0.1234)) returns 0.1234

See also:

TANH

AVEDEV (average deviation)

Syntax:

AVEDEV(Number1 [, Number2, Number3 ...])

Description:

Returns the average deviation of the given numbers from their mean.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Example:

AVEDEV(2, 2, 2, 2) returns 0

AVEDEV(2, 2, 2, 3) returns 0.375
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See also:

DEVSQ, STDEV.S/STDEV, VAR.S/VAR

AVERAGE (arithmetic mean)

Syntax:

AVERAGE(Number1 [, Number2, Number3 ...])

Description:

Returns the arithmetic mean of the given numbers.

This is calculated by dividing their sum by their number.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Example:

AVERAGE(1, 2, 6) equals (1+2+6) / 3, which is 3.

If cells A1 to A4 contain the values 0, 1, 2 and the logical value TRUE, the following applies:

AVERAGE(A1:A4) equals (0+1+2) / 3, thus returns 1. The cell with the logical value is not considered here –
not even when determining the number of values.

AVERAGE(A1:A4, TRUE) equals (0+1+2+1) / 4, thus returns 1. Since the entered value TRUE is evaluated as
1, FALSE accordingly as 0.

See also:

AVERAGEA, GEOMEAN, HARMEAN, TRIMMEAN, MEDIAN

AVERAGEA (arithmetic mean)

Syntax:

AVERAGEA(Value1 [, Value2, Value3 ...])
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Description:

The AVERAGEA function is almost identical to the AVERAGE function (see note). It returns the arithmetic
mean of the given values.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

Note:

Unlike the AVERAGE function, AVERAGEA also evaluates logical values and text: FALSE evaluates as 0.
TRUE evaluates as 1. Text evaluates as 0.

Empty cells, however, are also ignored here.

Example:

AVERAGEA(1, 2, 6) equals (1+2+6) / 3, which is 3.

If the cells A1:A4 contain the values 0, 1, 4 and TRUE:

AVERAGEA(A1:A4) equals (0+1+4+1) / 4, which is 1.5. The logical value TRUE is interpreted as 1 here.

For comparison:

AVERAGE(A1:A4) equals (0+1+4) / 3, thus returns 1.66667. The logical value is ignored here.

See also:

AVERAGE

AVERAGEIF (average if condition is true)

Syntax:

AVERAGEIF(Range, Criterion [, AverageRange])

Description:

Returns the arithmetic mean of those values in a cell range that fulfill the specified criterion.

Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

Use numbers or text (like "42" or "bolts") to obtain the average of all cells that contain that value.

Use conditions (like ">10" or "<=5") to obtain the average of all cells that match the specified condition.

Note: Criteria always have to be surrounded by double quotation marks (").
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AverageRange (optional) lets you specify the cell range containing the values to be used for calculating the
average. If omitted, the values in Range will be used.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced by their last result as a fixed value.

Accordingly, if you use this function, you should not save your document in the "Microsoft Excel 97-2003
(.xls)" file format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

The cells A1:A5 contain the values 1, 2, 3, 2, 1. The following applies:

AVERAGEIF(A1:A5, "2") returns 2

AVERAGEIF(A1:A5, ">=2") returns (2+3+2)/3, which gives 2.33333

See also:

AVERAGE, AVERAGEIFS, SUMIF, SUMIFS, COUNTIF, COUNTIFS

AVERAGEIFS (average if conditions are true)

Syntax:

AVERAGEIFS(AverageRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

Returns the arithmetic mean of those values in a cell range that fulfill all of the specified criteria.

This function is similar to the AVERAGEIF function, but allows you to specify more than just one
range/criterion to be searched.

Apart from that, the order of the parameters is different: In AVERAGEIF, AverageRange is the last parameter
– in AVERAGEIFS, it is the first.

AverageRange is the cell range containing the values to be used for calculating the average.

Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as AverageRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:
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Use numbers or text (like "42" or "bolts") to obtain the average of all cells that contain that value.

Use conditions (like ">10" or "<=5") to obtain the average of all cells that match the specified condition.

Note: Criteria always have to be surrounded by double quotation marks (").

Unlike the AVERAGEIF function, AVERAGEIFS allows you to specify more than just one cell range and
criterion to be checked. If you do so, only occurrences where all criteria are fulfilled are included in the
calculation of the average.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced by their last result as a fixed value.

Accordingly, if you use this function, you should not save your document in the "Microsoft Excel 97-2003
(.xls)" file format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

AVERAGEIFS(A1:A10, C1:C10, ">1", C1:C10, "<2")

This formula returns the average of only those cells in the cell range A1:A10 where the corresponding cell in
the range C1:C10 is greater than 1 and less than 2.

See also:

AVERAGE, AVERAGEIF, SUMIF, SUMIFS, COUNTIF, COUNTIFS

B (compatibility function)

Syntax:

B(n, p, k1 [, k2])

where:

n is the number of independent trial runs.

p is the probability of a success for each trial run (0 to 100%). Must be > 0 and < 1.

k1 is the lower limit for the number of successes.

k2 (optional) is the upper limit for the number of successes.
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Description:

Returns the probability to get a) exactly k1 successes, or b) between k1 and k2 successes in a binomial
experiment with n independent trials.

Note:

This function was retained only for compatibility with PlanMaker 97. Use of the following Excel-compatible
function is recommended instead:

B(n, p, k1) equals BINOMDIST(k1, n, p, FALSE) or BINOM.DIST(k1, n, p, FALSE)

B(n, p, k1, k2) equals BINOM.DIST.RANGE(n, p, k1, k2)

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

In Excel 2013, a function identical to the B function was introduced: BINOM.DIST.RANGE. PlanMaker
supports this function as well. However, please keep in mind that older versions of Excel (and PlanMaker) do
not know this function.

See also:

BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST

BASE (convert decimal number into another base)

Syntax:

BASE(Number, Base [, Digits])

Description:

Converts the given decimal number (base 10) to a number with a different base – for example a binary number
(base 2) or a hexadecimal number (base 16).

Note: Please note that the result of this function is a text string – not a number.

Number is the number to be converted. Only positive numbers are allowed.

Base is the target base. Only integers between 2 and 36 are allowed.

The optional argument Digits lets you specify the minimum number of places to be displayed. If omitted,
PlanMaker determines the number of required places automatically. Digits must be a positive integer.
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Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

BASE(42, 2) returns 101010 (decimal number 42 displayed as binary number)

BASE(42, 2, 8) returns 00101010 (ditto, with the minimum places set to 8)

See also:

DECIMAL, DEC2BIN, DEC2HEX, DEC2OCT

BESSELI (modified Bessel function In(x))

Syntax:

BESSELI(x, n)

Description:

Returns the modified Bessel function In(x).

x is the value to be evaluated.

n 
decimal point are ignored.

See also:

BESSELJ, BESSELK, BESSELY

BESSELJ (Bessel function Jn(x))

Syntax:

BESSELJ(x, n)



510Formulas and functions

Description:

Returns the Bessel function Jn(x).

x is the value to be evaluated.

n 
decimal point are ignored.

See also:

BESSELI, BESSELK, BESSELY

BESSELK (modified Bessel function Kn(x))

Syntax:

BESSELK(x, n)

Description:

Returns the modified Bessel function Kn(x).

x is the value to be evaluated.

n 
decimal point are ignored.

See also:

BESSELI, BESSELJ, BESSELY

BESSELY (Bessel function Yn(x))

Syntax:

BESSELY(x, n)

Description:

Returns the Bessel function Yn(x) (also known as the Weber function or the Neumann function).
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x is the value to be evaluated.

n 
decimal point are ignored.

See also:

BESSELI, BESSELJ, BESSELK

BETADIST (beta distribution)

Note: BETADIST is supplemented by the new function BETA.DIST with additional functionality, which is
available in newer versions of Microsoft Excel (2010 or later).

Syntax:

BETADIST(X, Alpha, Beta [, A, B])

Description:

Returns the beta cumulative distribution function.

X is the value to be evaluated.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) are the lower and upper bound to the interval. If they are omitted, A is set to 0 and B is set
to 1 (thus leading to a normal distribution).

X must be in the range A to B.

See also:

BETA.DIST, BETA.INV/BETAINV

BETA.DIST (beta distribution)

Syntax:

BETA.DIST(X, Alpha, Beta, Cumulative [, A, B])
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Description:

Returns the (cumulative) beta distribution function.

X is the value to be evaluated.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the beta distribution is calculated. By entering the value FALSE, the density function of
the beta distribution is calculated.

A and B (optional) are the lower and upper bound to the interval. If they are omitted, A is set to 0 and B is set
to 1 (thus leading to a normal distribution).

X must be in the range A to B.

Note:

The BETA.DIST function supplements the previous BETADIST function with the additional argument
Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

The inverse function is BETA.INV

See also:

BETADIST, BETA.INV/BETAINV

BETAINV (percentiles of the beta distribution)

Note: BETAINV is supplemented by the new identical function BETA.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

BETAINV(Probability, Alpha, Beta [, A, B])
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Description:

Returns the inverse of the beta distribution function (i.e., percentiles of this distribution).

Probability 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) are the lower and upper bound to the interval. If they are omitted, A is set to 0 and B is set
to 1 (thus leading to a normal distribution).

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

See also:

BETA.INV, BETA.DIST/BETADIST

BETA.INV (percentiles of the beta distribution)

Syntax:

BETA.INV(Probability, Alpha, Beta [, A, B])

Description:

Returns the inverse of the beta distribution function (i.e., percentiles of this distribution).

Probability 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

A and B (optional) are the lower and upper bound to the interval. If they are omitted, A is set to 0 and B is set
to 1 (thus leading to a normal distribution).

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

BETA.INV is the inverse function of BETA.DIST

See also:

BETAINV, BETA.DIST/BETADIST

BIN2DEC (binary number to decimal number)

Syntax:

BIN2DEC(Number)

Description:

Converts the given binary number (base 2) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

Number must not contain more than 32 places, so the permissible value range is:

Number 

Example:

BIN2DEC("101010") returns 42

BIN2DEC("00101010") returns 42 as well

BIN2DEC("11111111111111111111111111010110") returns -42

See also:

DEC2BIN, BIN2HEX, BIN2OCT, DECIMAL
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BIN2HEX (binary number to hexadecimal number)

Syntax:

BIN2HEX(Number [, Digits])

Description:

Converts the given binary number (base 2) to a hexadecimal number (base 16).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

Number must not contain more than 32 places, so the permissible value range is:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

BIN2HEX("101010") returns 2A

BIN2HEX("00101010") returns 2A as well

BIN2HEX("101010", 1) results in the error value #NUM!, because this number can only be represented with at
least 2 digits

BIN2HEX("11111111111111111111111111010110") returns FFFFFFD6 (negative value)

See also:

HEX2BIN, BIN2DEC, BIN2OCT
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BIN2OCT (binary number to octal number)

Syntax:

BIN2OCT(Number [, Digits])

Description:

Converts the given binary number (base 2) to an octal number (base 8).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

Number must not contain more than 32 places, so the permissible value range is:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

BIN2OCT("101010") returns 52

BIN2OCT("00101010") returns 52 as well

BIN2OCT("101010", 1) results in the error value #NUM!, because this number can only be represented with at
least 2 digits

BIN2OCT("11111111111111111111111111010110") returns 37777777726 (negative value)

See also:

OCT2BIN, BIN2DEC, BIN2HEX
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BINOMDIST (binomial distribution)

Note: BINOMDIST is supplemented by the new identical function BINOM.DIST and the completely new
function BINOM.DIST.RANGE which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

BINOMDIST(k, n, p, Cumulative)

Description:

Returns the binomial distribution function.

The binomial distribution can be used to determine the probability to get k successes in an experiment with n
independent trials with only two possible outcomes (success or failure) with a fixed probability of p for each
trial.

For example, a coin flip experiment is a binomial experiment (see example below).

k is the number of successes. Must be in the range 0 to n.

n is the number of independent trial runs.

n and k should be integers. Digits right of the decimal point are ignored by PlanMaker.

p is the probability of a success for each trial run.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned. BINOMDIST thus determines the probability of having
exactly k successes.

TRUE: The cumulative distribution function is returned. BINOMDIST thus determines the probability that
there are at most k successes.

Example:

Let us take the above example:

When you flip a coin 10 times (n=10), what is the probability that it lands on "heads" (p=50%) exactly 4 times?

BINOMDIST(4, 10, 50%, FALSE) returns 0.20508 =20.5%

What is the probability that it lands on "heads" at most 4 times?

Here, instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

BINOMDIST(4, 10, 50%, TRUE) returns 0.37695 =37.7%
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See also:

BINOM.DIST/BINOM.DIST.RANGE, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.DIST (binomial distribution)

Syntax:

BINOM.DIST(k, n, p, Cumulative)

Description:

Returns the binomial distribution function.

The binomial distribution can be used to determine the probability to get k successes in an experiment with n
independent trials with only two possible outcomes (success or failure) with a fixed probability of p for each
trial.

For example, a coin flip experiment is a binomial experiment (see example below).

k is the number of successes. Must be in the range 0 to n.

n is the number of independent trial runs.

n and k should be integers. Digits right of the decimal point are ignored by PlanMaker.

p is the probability of a success for each trial run.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned. So BINOM.DIST determines the probability that there are
exactly k successes.

TRUE: The cumulative distribution function is returned. BINOM.DIST therefore determines the probability
that there are at most k successes.

Example:

Let us take the above example:

When you flip a coin 10 times (n=10), what is the probability that it lands on "heads" (p=50%) exactly 4 times?

BINOM.DIST(4, 10, 50%, FALSE) returns 0.20508 =20.5%

What is the probability that it lands on "heads" at most 4 times?

Here, instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):
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BINOM.DIST(4, 10, 50%, TRUE) returns 0.37695 =37.7%

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

BINOMDIST/BINOM.DIST.RANGE, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.DIST.RANGE (binomial distribution)

Syntax:

BINOM.DIST.RANGE(n, p, k1 [,k2])

Description:

Returns the probability of success for a number of trials using a binomial distribution.

n 

p is the probability of a success for each trial run. Must be in the range 0 to 1. (0 corresponds to 0% ; 1
corresponds to 100%)

k1 is the number of successes. Must be in the range 0 to n.

k2 is optional and returns the probability that the number of successes will fall between k1 and k2. k2 Must be
in the range k1 to n.

n and k1,k2 should be integers, digits right of the decimal point were ignored by PlanMaker.

Annotation:

If the optional argument k2 is omitted, the probability of the exact number of successes is calculated.

Example:

When you flip a coin 10 times (n=10), what is the probability that it lands on "heads" (p=50%) exactly 4 times?

BINOM.DIST.RANGE(10, 50%, 4) returns 0.20508 =20.5%

What is the probability that it lands on "heads" between 4 and 8 times?

BINOM.DIST.RANGE(10, 50%, 4, 8) returns 0.81738 =81.7%



520Formulas and functions

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

BINOMDIST/BINOM.DIST, BINOM.INV/CRITBINOM, B, COMBIN,
NEGBINOM.DIST/NEGBINOMDIST, POISSON.DIST/POISSON

BINOM.INV (binomial distribution)

Syntax:

BINOM.INV(n, p, Alpha)

Description:

Returns the smallest value for which the cumulative binomial distribution is greater than or equal to the
criterion value Alpha.

It is thus calculated how many times a certain event with probability p may occur at most when performing a
sample with n repetitions before its cumulative probabilities assume a value greater than or equal to the error
probability Alpha.

This function is applicable for binomial distributions only (see also BINOM.DIST/BINOMDIST function);
therefore, the drawings must be independent with only two possible outcomes: success (event occurs) or failure
(event does not occur).

n is the number of independent trial runs.

p is the probability of a success for each trial run. Must be in the range 0 to 1.

Alpha is the criterion value that must be not exceeded. Must be in the range 0 to 1.

Example:

You know from previous deliveries that normally 7% of a certain electronic component is defective. To check
this statement, you carry out a sample of 100 components for a new delivery. What is the maximum number of
defects that may be present if the error probability is not to exceed 1%?

BINOM.INV(100, 7%, 1%) returns 2

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

CRITBINOM, BINOM.DIST/BINOM.DIST.RANGE/BINOMDIST

CEILING (round up to a multiple of base)

Syntax:

CEILING(Number, Base)

Description:

Rounds Number up (away from zero) to the nearest multiple of Base.

Positive numbers are rounded to the nearest multiple of Base that is larger than Number.

Negative numbers are rounded to the nearest multiple of Base that is smaller than Number.

Number and Base must have the same sign, otherwise the function returns a #NUM! error value.

Example:

CEILING(42.5, 1) returns 43

CEILING(-42.5, -1) returns -43

CEILING(21, 5) returns 25

CEILING(12.3456, 0.01) returns 12.35

See also:

FLOOR, MROUND, ROUND, TRUNC

CELL (information about a cell)

Syntax:

CELL(Type [, Reference])
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Description:

Returns various types of information about a cell.

Type specifies the type of information to return. Type can be one of the following text strings:

Type Explanation

"address" Returns the address of the cell (as a text string).

"width" (Not supported. Returns a #N/A error value.)

"filename" Returns the full path and filename of the document that contains the cell.

"color" Returns 1 if the cell uses the number format option Negative numbers in red, or 0 if not.

"format" (Not supported. Returns a #N/A error value.)

"contents" Returns the value stored in the cell.

"parentheses" (Not supported. Returns a #N/A error value.)

"prefix" Returns one of the following text strings:

' if the cell contains left-aligned text

^ if the cell contains centered text

" if the cell contains right-aligned text

\ if the cell contains fill-aligned text

"" if the cell contains anything else

"protect" Returns 1 if the cell is protected, or 0 if not.

"col" Returns the column number of the cell (as a number).

"type" Returns one of the following text strings:

b (for blank) if the cell is empty

l (for label) if the cell contains text

v (for value) if the cell contains anything else

"row" Returns the row number of the cell.

Reference (optional) is the address of the cell to be evaluated.

If Reference is a range of cells, only the top left cell will be evaluated.

If Reference is omitted, the current cell will be evaluated. (Excel behaves differently, see the note below.)

Compatibility notes:

This function is not fully identical to Microsoft Excel's CELL function. The following restrictions apply:
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1. Some types of information are not supported by PlanMaker (see the table above).

2. When the parameter Reference is omitted, PlanMaker evaluates the current cell, whereas Excel evaluates the
cell that was last changed.

Example:

=CELL("row", B5) returns the row number of the cell B5, i.e. 5.

See also:

FILENAME, COLUMN, ROW

CHAR (character from ANSI code)

Syntax:

CHAR(Number)

Description:

Returns a single character with the specified ANSI code.

Number must be at least 10.

Example:

CHAR(65) returns A

CHAR(32) returns a blank

CHAR(CODE("X") returns X

See also:

CODE

CHIDIST (chi-square distribution)

Note: CHIDIST is supplemented by the new identical function CHISQ.DIST.RT, which is available in newer
versions of Microsoft Excel (2010 or later).
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Syntax:

CHIDIST(X, DegreesFreedom)

Description:

Returns the right-tailed probability of the chi-square distribution.

X 

DegreesFreedom 
expected. Digits to the right of the decimal point are ignored.

See also:

CHISQ.DIST.RT, CHISQ.INV.RT/CHIINV, CHISQ.TEST/CHITEST

CHIINV (percentiles of the chi-square distribution)

Note: CHIINV is supplemented by the new identical function CHISQ.INV.RT, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CHIINV(Probability, DegreesFreedom)

Description:

Returns the inverse of the right-tailed probability of the chi-square distribution function (i.e., percentiles of
this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom 
expected. Digits to the right of the decimal point are ignored.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

See also:

CHISQ.INV.RT, CHISQ.TEST/CHITEST, CHISQ.DIST.RT/CHIDIST
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CHISQ.DIST.RT (chi-square distribution)

Syntax:

CHISQ.DIST.RT(X, DegreesFreedom)

Description:

Returns the right-tailed probability of the chi-square distribution.

X 

DegreesFreedom 
expected. Digits to the right of the decimal point are ignored.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

CHIDIST, CHISQ.INV.RT/CHIINV, CHISQ.TEST/CHITEST

CHISQ.INV.RT (percentiles of the chi-square distribution)

Syntax:

CHISQ.INV.RT(Probability, DegreesFreedom)

Description:

Returns the inverse of the right-tailed probability of the chi-square distribution function (i.e., percentiles of
this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom 
expected. Digits to the right of the decimal point are ignored.
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Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

CHIINV, CHISQ.TEST/CHITEST, CHISQ.DIST.RT/CHIDIST

CHISQ.TEST (chi-square test for independence)

Syntax:

CHISQ.TEST(ObservedValues, ExpectedValues)

Description:

Returns the chi-square test for independence.

A chi-square test provides a general criterion for the conformity of a population with a sample.

ObservedValues are the observed values to be tested against the expected values. ExpectedValues are the
expected values.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

CHITEST, CHISQ.INV.RT/CHIINV, CHISQ.DIST.RT/CHIDIST
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CHITEST (chi-square test for independence)

Note: CHITEST is supplemented by the new identical function CHISQ.TEST, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CHITEST(ObservedValues, ExpectedValues)

Description:

Returns the chi-square test for independence.

A chi-square test provides a general criterion for the conformity of a population with a sample.

ObservedValues are the observed values to be tested against the expected values. ExpectedValues are the
expected values.

See also:

CHISQ.TEST, CHISQ.INV.RT/CHIINV, CHISQ.DIST.RT/CHIDIST

CHOICE (x>0, x=0, x<0?)

Syntax:

CHOICE(Number, IfGreater [, IfZero, IfLess])

Description:

Returns one of the following values:

IfGreater, if Number is greater than zero.

IfZero, if Number equals zero.

IfLess, if Number is less than zero.

The last two arguments are optional.
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Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

CHOICE(42, "Greater", "Zero", "Smaller") returns Greater

CHOICE(0, "Greater", "Zero", "Smaller") returns Zero

CHOICE(-42, "Greater", "Zero", "Smaller") returns Smaller

See also:

IF

CHOOSE (choose value from list)

Syntax:

CHOOSE(Index, Value1 [, Value2, Value3 ...])

Description:

Returns the value with the specified Index from a list of values.

Index specifies the position in the list of arguments. If Index is 1, the first value will be returned, if Index is 2,
the second value will be returned, etc.

If Index is smaller than 1 or greater than the total number of values, the function returns a #VALUE! error
value.

Example:

CHOOSE(2, "One", "Two", "Three") returns Two

See also:

SWITCH, INDEX, VLOOKUP, HLOOKUP
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CLEAN (remove non-printable characters)

Syntax:

CLEAN(Text)

Description:

Removes all unprintable characters (characters with an ANSI code below 32) from the specified text string.

See also:

TRIM

CODE (ANSI code of a character)

Syntax:

CODE(Text)

Description:

Returns the ANSI code of the first character in the specified text string.

Example:

CODE("A") returns 65

CODE("Arthur") returns 65 as well

CODE(CHAR(123)) returns 123

CODE("") returns 0

See also:

CHAR
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COLUMN (column number of cells)

Syntax:

COLUMN([Reference])

Description:

Returns the column number(s) of a cell or cell reference:

If Reference is a single cell, the column number of this cell is returned.

If Reference is a range of cells, their column numbers are returned as a horizontal array. Note: In this case, the
formula has to be entered as an array formula (see Working with arrays).

If Reference is omitted, the column number of the cell that contains this function is returned.

Example:

COLUMN(D2) returns 4

COLUMN(D2:F4) returns {4,5,6}

COLUMN() returns 3 when you use this calculation in cell C5

See also:

COLUMNS, ROW, CELL, ADDRESS, OFFSET, INDIRECT

COLUMNS (number of columns in a range)

Syntax:

COLUMNS(Range)

Description:

Returns the number of columns in the specified cell range.

Example:

COLUMNS(A1:D5) returns 4
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See also:

ROWS, COLUMN, AREAS

COMBIN (combinations)

Syntax:

COMBIN(n, k)

Description:

Returns the number of combinations of size k in a population of size n.

In plain language: A total of n elements are available. From these a subset of exactly k elements is to be drawn.
This function calculates how many different subsets there can be.

n is the total number of items. Must be > k.

k is the number of items in each combination. Must be > 0 and < n.

n and k should be integers. Digits right of the decimal point are ignored by PlanMaker.

Example:

In a lottery called "6 out of 49", 6 balls are picked out of 49 numbered balls.

How many combinations are possible?

COMBIN(49, 6) returns 13983816

There are therefore 13,983,816 possible combinations.

See also:

PERMUT, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST

COMPLEX (create complex number)

Syntax:

COMPLEX(Real, Imag [, Suffix])
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Description:

Creates a complex number in the form x+yi or x+yj from the specified Real and Imag.

With Suffix (optional) you can determine which letter should be used for the imaginary unit: either "i" or
"j" (lower case!). If Suffix is not specified, "i" is automatically used.

Tip:

To enter complex numbers in cells, you can either make use of the COMPLEX function or simply type them in.
For example, the complex number 2+4i can be entered either as =COMPLEX(2, 4) or simply as 2+4i.

The same applies for formulas – except for the fact that complex numbers have to be surrounded by double
quotation marks ("). For example, instead of typing =IMPOWER(COMPLEX(2, 4)), you could also type
=IMPOWER("2+4i").

Example:

COMPLEX(2, 4) returns 2+4i

COMPLEX(2, 4, "i") returns 2+4i as well

COMPLEX(2, 4, "j") returns 2+4j

See also:

IMAGINARY, IMREAL

CONCAT (concatenate strings from list)

Syntax:

CONCAT(String1 [, String2, String3 ...])

Description:

Combines two or more text strings into one text string. Unlike the CONCATENATE function, you can use
CONCAT to select complete cell ranges and do not have to specify individual cells.

Example:

CONCAT("Good ", "Morning") returns Good Morning

CONCAT(2, " slices", " of ", "bread") returns 2 slices of bread
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There is no difference so far to the function CONCATENATE. The advantage of CONCAT can be explained
with the following example:

The function CONCATENATE(A2, B2, C2, D2, E2) returns MrPeterSmithMiami33133

The function CONCAT(A2:E2) also returns MrPeterSmithMiami33133

Conclusion: With the new CONCAT function you can save the effort of entering each cell individually.

For separators between the strings, however, you would have to enter the cells individually again and separate
them with " ": CONCAT(A2, " ", B2, " ", C2, " ", D2, " ", E2).

In this case, the new function TEXTJOIN can make a better job.

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

See also:

TEXTJOIN, CONCATENATE

CONCATENATE (concatenate text strings)

Note: CONCATENATE is supplemented by the new function CONCAT with additional functionality, which
is available in newer versions of Microsoft Excel (2019 or later).

Syntax:

CONCATENATE(Text1 [, Text2, Text3 ...])

Description:

Combines two or more text strings into one text string.

Annotation:

The & operator does exactly the same: CONCATENATE("Text1", "Text2") is equivalent to "Text1" &
"Text2".
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Example:

CONCATENATE("Good ", "Morning") returns Good Morning

CONCATENATE(2, " slices", " of ", "bread") returns 2 slices of bread

See also:

CONCAT, TEXTJOIN

CONFIDENCE (confidence interval)

Note: CONFIDENCE is supplemented by the new identical function CONFIDENCE.NORM, which is
available in newer versions of Microsoft Excel (2010 or later).

Syntax:

CONFIDENCE(Alpha, Sigma, n)

Description:

Returns a value that allows you to determine the 1-alpha confidence interval for the population mean of a
distribution.

The 1-alpha confidence interval is a range of values around the sample mean x covering the interval from (x -
CONFIDENCE) to (x + CONFIDENCE). The probability that this interval contains the population mean is 1-
Alpha.

Alpha is the significance level to compute the confidence level. Must be in the range 0 to 1.

For example, if Alpha is 5%, the probability that the population mean is outside the confidence interval is 5%.
The probability that it is inside is 1-Alpha, i.e., 95%. Therefore, 1-alpha is also called the "confidence level".

Sigma is the population standard deviation. Must be > 0.

n is the size of the sample. Must be > 0.

Example:

The average weight of 1000 piglets is to be determined in a pig farm. For this purpose, a sample (with
replacement) of the size n=65 is taken. The average weight determined is 30 kg. The standard deviation is 1,6
kg.

The 95% confidence interval (alpha is therefore 0.05 here) is now to be determined. So you would calculate:

CONFIDENCE(0.05, 1.6, 65) returns 0.38897 (kg)
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The average weight of the population (= of all 1000 piglets) is therefore with a probability of 95% between 30-
0.38897 kg and 30+0.38897 kg.

See also:

CONFIDENCE.NORM

CONFIDENCE.NORM (confidence interval)

Syntax:

CONFIDENCE.NORM(Alpha, Sigma, n)

Description:

Returns a value that allows you to determine the 1-alpha confidence interval for the population mean of a
distribution.

The 1-alpha confidence interval is a range of values around the sample mean x covering the interval from (x -
CONFIDENCE) to (x + CONFIDENCE). The probability that this interval contains the population mean is 1-
Alpha.

Alpha is the significance level to compute the confidence level. Must be in the range 0 to 1.

For example, if Alpha is 5%, the probability that the population mean is outside the confidence interval is 5%.
The probability that it is inside is 1-Alpha, i.e., 95%. Therefore, 1-alpha is also called the "confidence level".

Sigma is the population standard deviation. Must be > 0.

n is the size of the sample. Must be > 0.

Example:

The average weight of 1000 piglets is to be determined in a pig farm. For this purpose, a sample (with
replacement) of the size n=65 is taken. The average weight determined is 30 kg. The standard deviation is 1,6
kg.

The 95% confidence interval (alpha is therefore 0.05 here) is now to be determined. So you would calculate:

CONFIDENCE.NORM(0.05, 1.6, 65) returns 0.38897 (kg)

The average weight of the population (= of all 1000 piglets) is therefore with a probability of 95% between 30-
0.38897 kg and 30+0.38897 kg.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

CONFIDENCE

CONVERT (unit conversion)

Syntax:

CONVERT(Number, From, To)

Description:

Converts a Number between different measurement systems.

From and To are codes representing the source and the target unit (see table below).

Both units have to be in the same category. For example, you can convert meters to miles, but of course not to
minutes.

A #N/A error value is displayed if a) From and To are not from the same category, or b) invalid unit codes.

Note: Unit codes are case-sensitive!

The following unit codes are available:

Mass Code

Gram g

Slug sg

Pound* (avoirdupois) lbm

u (atom mass) u

Ounce (avoirdupois) ozm

* Does not correspond to the pound still partly used in
German-speaking countries (½ Kilo)

Distance Code

Meter m

Statute mile mi

Nautical mile Nmi

Inch in

Foot ft
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Yard yd

Ångström ang

Pica Pica

Light year* ly

Parsec (parallax second)* parsec

* These units are not supported by Microsoft Excel.

Time Code

Second sec

Minute mn

Hour hr

Day day

Year** yr

Fortnight* ftn

* These units are not supported by Microsoft Excel.

** Based on a year with 365.25 days

Liquid measure Code

Liter l (lower case "L")

Teaspoon tsp

Tablespoon tbs

Fluid Ounce oz

Cup cup

Pint (U.S.) pt

Pint (U.K.) uk_pt

Quart qt

Gallon gal

Force Code

Newton N

Dyne dyn

Pound-force lbf
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Power Code

Watt W

HP (Horsepower) HP

Magnetism Code

Tesla T

Gauss ga

Energy Code

Joule J

Erg e

Thermodynamic calorie c

IT calorie cal

Electron volt eV

Horsepower-hour HPh

Watt-hour Wh

Foot-pound force flb

BTU (British Thermal Unit) BTU

Pressure Code

Pascal Pa

Atmosphere atm

mm of Mercury mmHg

Temperature Code

Degree Fahrenheit F

Degree Celsius C

Degree Kelvin K

Additionally, prefixes can be added to metric units, "mg", for instance, stands for milligrams.

Please pay attention to the capitalization here as well!

The following prefixes are available:

Prefix (and factor) Code
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Exa (10^18) E

Peta (10^15) P

Tera (10^12) T

Giga (10^9) G

Mega (10^6) M

Kilo (1000) k

Hecto (100) h

Deka (10) e

Deci (0.1) d

Centi (0.01) c

Milli (0.001) m

Micro (10^-6) u

Nano (10^-9) n

Pico (10^-12) p

Femto (10^-15) f

Atto (10^-18) a

Example:

CONVERT(1, "day", "sec") returns 86400 (days -> seconds)

CONVERT(1, "mi", "km") returns 1.60934 (miles -> kilometers)

CONVERT(100, "kW", "HP") returns 134.10201 (100 kW -> HP)

CONVERT(1, "aparsec", "cm") returns 3.08568 (Attoparsec -> cm)

CORREL (correlation coefficient)

Syntax:

CORREL(Range1, Range2)

Description:

Returns the correlation coefficient of two data sets.

The correlation coefficient is a measure of the relationship between two data sets.
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Range1 and Range2 are cell references to the two data sets. Empty cells, text and logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4:

CORREL(A1:A3, B1:B3) returns 0.99718

See also:

FISHER, FISHERINV, COVARIANCE.P/COVARIANCE.S/COVAR

COS (cosine)

Syntax:

COS(Number)

Description:

Returns the cosine of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Example:

COS(PI()) returns -1

COS(RADIANS(180)) returns -1

See also:

ACOS, SIN, TAN
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COSH (hyperbolic cosine)

Syntax:

COSH(Number)

Description:

The function COSH returns the hyperbolic cosine of a number.

Example:

COSH(0.1) returns 1.005

See also:

ACOSH, SINH, TANH

COT (cotangent)

Syntax:

COT(Number)

Description:

Returns the cotangent of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.
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Example:

COT(PI()/4) returns 1

COT(RADIANS(45)) returns 1

See also:

TAN, ACOT

COTH (hyperbolic cotangent)

Syntax:

COTH(Number)

Description:

The function COTH returns the hyperbolic cotangent of a number.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

COTH(0.45) returns 2.37024

See also:

ACOTH, TANH

COUNT (number of cells filled with numbers)

Syntax:

COUNT(Range1 [, Range2, Range3 ...])
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Description:

Counts the number of cells containing numbers. This functions counts only cells with numbers (including dates)
and text representing a number.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNT(A1:A4) returns 1

For comparison: COUNTA(A1:A4) returns 3

Annotation:

The function COUNTA works similar, but it counts cells with any content

See also:

COUNTA, COUNTBLANK, COUNTP, FREQUENCY, ISBLANK, ISNUMBER, COUNTIF, COUNTIFS

COUNTA (number of cells filled)

Syntax:

COUNTA(Range1 [, Range2, Range3 ...])

Description:

Counts the number of cells containing any kind of value (i.e., cells that are not empty).

The cells may contain any numbers, text strings, logical values or error values.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNTA(A1:A4) returns 3

For comparison: COUNT(A1:A4) returns 1

Annotation:

The COUNT function works similarly, but only counts cells with numbers.
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See also:

COUNT, ISBLANK

COUNTBLANK (number of blank cells)

Syntax:

COUNTBLANK(Range)

Description:

Counts the number of cells in a cell range that are empty.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty. The following applies:

COUNTBLANK(A1:A4) returns 1

See also:

ISBLANK, COUNT

COUNTIF (count if condition is true)

Syntax:

COUNTIF(Range, Criterion)

Description:

Counts those cells in a cell range that fulfill the specified criterion.

Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

Use numbers or text (like "42" or "bolts") to count all cells that contain that value.

Tip: To count all non-empty cells, use "*" as criterion. For example COUNTIF(D2:D4, "*") counts all cells in
the specified area that are not empty.
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Use conditions (like ">10" or "<=5") to count all cells that match the specified condition.

Note: Criteria always have to be surrounded by double quotation marks (").

Example:

If the cells A1:A5 contain the values 1, 2, 3, 2, 1: The following applies:

COUNTIF(A1:A5, "2") returns 2

COUNTIF(A1:A5, ">=2") returns 3

Tip: A modification of the formula is required if a cell reference instead of a constant is entered for the search
criterion. Here's an example:

Cells A1 to A5 contain the above example values. In addition, cell C1 contains the value 2.
You now want to find out how many values in the range A1:A5 are greater than the value in cell C1.

Then the formula is COUNTIF(A1:A5, ">"&C1) and returns 1

See also:

COUNT, AVERAGEIF, AVERAGEIFS, SUMIF, SUMIFS, COUNTIFS

COUNTIFS (count if conditions are true)

Syntax:

COUNTIFS(Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

Applies criteria to the cells in the specified cell ranges and counts how often all of these criteria are fulfilled.

This function is similar to the COUNTIF function, but allows you to specify more than just one range/criterion
to be searched.

Range1 is the first cell range to be checked for the specified criterion. Please note that all of the cell ranges
specified must have the same dimensions.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:

Use numbers or text (like "42" or "bolts") to check if the cell contains a certain value.

Use conditions (like ">10" or "<=5") to check if the cell matches a certain condition.

Note: Criteria always have to be surrounded by double quotation marks (").
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Unlike the COUNTIF function, COUNTIFS allows you to specify more than just one cell range and criterion to
be checked. If you do so, the function counts only occurrences where all criteria are fulfilled. See examples
below.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced by their last result as a fixed value.

Accordingly, if you use this function, you should not save your document in the "Microsoft Excel 97-2003
(.xls)" file format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

COUNTIFS(C1:C10, ">1", C1:C10, "<2")

This formula counts how many cells in the cell range C1:C10 are greater than 1 and less than 2.

COUNTIFS(A1:D4, "tuna", G10:K14, ">500")

This formula counts how often the following conditions are met: The cell in A1:D4 contains "tuna" and the
corresponding cell in G10:K14 contains a value greater than 500.

Tip: A modification of the formula is required if a cell reference instead of a constant is entered for the search
criterion. Here's an example:

The cells A1:A5 contain the values 1, 2, 3, 4, 5. In addition, cell C1 contains the value 2.
You now want to find out how many values in the range A1:A5 are greater than the value in cell C1.

Then the formula is COUNTIF(A1:A5, ">"&C1) and returns 3

See also:

COUNT, AVERAGEIF, AVERAGEIFS, SUMIF, SUMIFS, COUNTIF

COUNTP (PlanMaker 97 compatibility function)

Syntax:

COUNTP(Range1 [, Range2, Range3 ...])

Description:

Counts the number of cells containing numbers or logical values.
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Note:

This function was retained only for compatibility with PlanMaker 97. Using the Excel-compatible functions
COUNT or COUNTA is recommended instead.

The difference between these three functions is:

COUNTA counts all cells that are not empty (regardless of their content).

COUNT counts only cells that contain numbers.

COUNTP counts only cells that contain numbers or logical values.

Example:

If the cells A1:A3 contain 42, "Test" and TRUE and cell A4 is empty: The following applies:

COUNTA(A1:A4) returns 3

COUNT(A1:A4) returns 1

COUNTP(A1:A4) returns 2

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

COUNT, COUNTA

COVAR (population covariance)

Note: COVAR is supplemented by the new identical function COVARIANCE.P (population covariance) and
the completely new function COVARIANCE.S (sample covariance), which are available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

COVAR(Range1, Range2)

Description:

Returns the population covariance of two data sets.
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The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain whole numbers. Empty cells,
text and logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4:

COVAR(A1:A3, B1:B3) returns 2.55556

See also:

COVARIANCE.P/COVARIANCE.S, FISHER, FISHERINV, CORREL

COVARIANCE.P (population covariance)

Syntax:

COVARIANCE.P(Range1, Range2)

Description:

Returns the population covariance of two data sets.

The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain whole numbers. Empty cells,
text and logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4:

COVARIANCE.P(A1:A3, B1:B3) returns 2.55556

Note:

The COVARIANCE.P function supplements together with COVARIANCE.S the previous COVAR function,
whereby COVARIANCE.P, just like COVAR, returns the population covariance and COVARIANCE.S the
sample covariance.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

COVARIANCE.S/COVAR, FISHER, FISHERINV, CORREL

COVARIANCE.S (sample covariance)

Syntax:

COVARIANCE.S(Range1, Range2)

Description:

Returns the sample covariance of two data sets.

The covariance is the average of the products of the deviations for each pair of values. It can be used to
determine the extent to which two data sets vary ("co-vary").

Range1 and Range2 are cell references to the two data sets. These must contain whole numbers. Empty cells,
text and logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4:

COVARIANCE.S(A1:A3, B1:B3) returns 3.83333

Note:

The COVARIANCE.S function supplements together with COVARIANCE.P the previous COVAR function,
whereby COVARIANCE.S returns the sample covariance and COVARIANCE.P, just like COVAR, the
population covariance.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

COVARIANCE.P/COVAR, FISHER, FISHERINV, CORREL
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CREATEDATE (date the document was created)

Syntax:

CREATEDATE()

Description:

Returns the date/time the current document was created.

Example:

In a document created on the 24th of August, 2018 at 9:03 AM:

CREATEDATE() returns 08/24/18 9:03 AM

Tip: By selecting a suitable date format in the dialog box of the ribbon tab Home | group Number , you can
determine whether only the date, only the time or both should be displayed.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

NOW, TODAY

CRITBINOM (binomial distribution)

Note: CRITBINOM is supplemented by the new identical function BINOM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

CRITBINOM(n, p, Alpha)

Description:

Returns the smallest value for which the cumulative binomial distribution is greater than or equal to the
criterion value Alpha.
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It is thus calculated how many times a certain event with probability p may occur at most when performing a
sample with n repetitions before its cumulative probabilities assume a value greater than or equal to the error
probability Alpha.

This function is applicable for binomial distributions only (see also BINOM.DIST/BINOMDIST function);
therefore, the drawings must be independent with only two possible outcomes: success (event occurs) or failure
(event does not occur).

n is the number of independent trial runs.

p is the probability of a success for each trial run. Must be in the range 0 to 1.

Alpha is the criterion value that must be not exceeded. Must be in the range 0 to 1.

Example:

You know from previous deliveries that normally 7% of a certain electronic component is defective. To check
this statement, you carry out a sample of 100 components for a new delivery. What is the maximum number of
defects that may be present if the error probability is not to exceed 1%?

CRITBINOM(100, 7%, 1%) returns 2

See also:

BINOM.INV, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST

CUMIPMT (cumulative interest)

Syntax:

CUMIPMT(Rate, NPer, PV, P1, P2, Type)

Description:

Returns the cumulative interest payments between period P1 and period P2. This function is applicable to loans
with periodic constant payments and a constant interest rate.

You can use this function, for example, to calculate how large the principal due of annuities is in the specified
periods for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period).

NPer is the total number of payment periods.

PV is the present value.
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P1 and P2 define the time interval to be evaluated. P1 is the first period, and P2 is the last. (The periods are
numbered consecutively, starting with 1.)

Type is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly, at the end of each month

Duration: 6 years

How much interest portion has to be paid in the periods (= months) 24 through 36?

CUMIPMT(10%/12, 6*12, 100000, 24, 36, 0) returns -7219.88.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Therefore, in the above formula, the yearly interest rate had to be divided by 12 to get the monthly interest rate.

Annotation:

The CUMPRINC function is the counterpart of CUMIPMT: It returns the total of the principal portions.

See also:

CUMPRINC, PPMT, IPMT, PMT

CUMPRINC (cumulative principal)

Syntax:

CUMPRINC(Rate, NPer, PV, P1, P2, Type)

Description:

Returns the cumulative principal payments between period P1 and period P2. This function is applicable to
loans with periodic constant payments and a constant interest rate.

You can use this function, for example, to calculate how large the principal due of annuities is in the specified
periods for a loan.
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"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period).

NPer is the total number of payment periods.

PV is the present value (the loan amount).

P1 and P2 define the time interval to be evaluated. P1 is the first period, and P2 is the last. (The periods are
numbered consecutively, starting with 1)

Type is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly, at the end of each month

Duration: 6 years

How much principal has to be paid in the periods (= months) 24 through 36?

CUMPRINC(10%/12, 6*12, 100000, 24, 36, 0) returns -16863.71.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Therefore, in the above formula, the yearly interest rate had to be divided by 12 to get the monthly interest rate.

Annotation:

The CUMIPMT function is the counterpart of CUMPRINC: It returns the sum of the interest portions.

See also:

CUMIPMT, PPMT, IPMT, PMT

CURRENCY (format number as currency)

Syntax:

CURRENCY(Number [, n])
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Description:

Converts a number to a text string. The text string contains the number, rounded to n decimal places and
formatted as a currency.

The currency symbol applied depends on your computer's country settings. For example, in the U.S. a dollar
sign $ is applied, in Germany, a euro sign € is applied, etc.

Number is the number to be converted.

n (optional) is the number of decimal places. If n is omitted, Number is rounded to the nearest integer.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of hundred (see last example).

Note:

Please keep in mind that the result of this function is a text string. To round a number without converting it to a
text string, use one of the round functions (e.g., ROUND) instead.

To display only a number rounded and formatted as currency, you can also change its number format using the
commands of the ribbon tab Home | group Number.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

CURRENCY(123.456) returns the text string $123.46

CURRENCY(123.456, 2) returns the text string $123.46

CURRENCY(123.456, -2) returns the text string $100

DATE (create a date value)

Syntax:

DATE(Year, Month, Day)

Description:

Returns a date created out of the specified Year, Month and Day.
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Example:

DATE(2018, 9, 25) returns 43368

However, PlanMaker automatically formats this date value in the number format "Date/Time", so that the cell
reads: 09/25/2018.

See also:

DATEVALUE, TIME, TIMEVALUE

DATEDIF (date difference)

Syntax:

DATEDIF(StartDate, EndDate, Mode)

Description:

Returns the number of days, months or years between two dates.

StartDate and EndDate are the two dates to be evaluated. StartDate must be less (i.e., earlier) than EndDate.

Mode lets you specify the kind of value to be returned:

"y" Number of years between StartDate and EndDate

"m" Number of months between StartDate and EndDate

"d" Number of days between StartDate and EndDate

"ym" Number of months, excluding years (as if StartDate and EndDate were in the same year)

"yd" Number of days, excluding years (as if StartDate and EndDate were in the same year)

"md" Number of months, excluding month and years (as if StartDate and EndDate were in the same month and year)

Note:

This function is an undocumented Excel function. It still exists in Microsoft Excel, but has been removed from
Excel's help file and therefore seems to be no longer officially supported.

Example:

To calculate the age of a person, enter the date of birth in cell A1 (e.g. 4/3/1970). In A2, enter the current date
(e.g. 6/8/2012).
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Then, use any of the following calculations:

Age in years:
DATEDIF(A1, A2, "y") returns 42 (years)

Age in months:
DATEDIF(A1, A2, "m") returns 506 (months)

Age in days:
DATEDIF(A1, A2, "d") returns 15407 (days)

Age in years, months and days:
DATEDIF(A1, A2, "y") returns 42 (years)
DATEDIF(A1, A2, "ym") returns 2 (months)
DATEDIF(A1, A2, "md") returns 5 (days)
(Accordingly, the person's age is 42 years, 2 months and 5 days.)

See also:

NOW, NETWORKDAYS, DAYS/DAYSP

DATEVALUE (convert text into date value)

Syntax:

DATEVALUE(Text)

Description:

Converts a text string representing a date to a serial date value.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert text representing a date
to a serial date value, where necessary.

Example:

DATEVALUE("09/25/2018") returns 43368.

If you now format this using the options of the ribbon tab Home | group Number  in one of the date/time
formats (for example M/D/YYYY), the cell will display the date behind this value: the 9/25/2018.

See also:

TIMEVALUE, DATE, TIME
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DAVERAGE (database function)

Syntax:

DAVERAGE(DatabaseArea, Column, CriteriaArea)

Description:

Returns the average of those values in a column of a database area that match the conditions specified in the
criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

AVERAGE, DPRODUCT, DSUM

DAY (day of a date)

Syntax:

DAY(Date)

Description:

Returns the day of a date.

Example:

DAY("09/25/2018") returns 25

DAY("17. August") returns 17

If cell A1 contains the date value 9/25/2018: DAY(A1) returns 25
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See also:

WEEKDAY, ISOWEEKNUM, ISOWEEEK, WEEKNUM, MONTH, YEAR

DAYS (days between two dates)

Syntax:

DAYS(EndDate, StartDate)

Description:

Returns the number of days between two dates.

Please note the order of the parameters: The end date has to be specified first, the start date second.

Note:

This function was revised in PlanMaker 2016: The order of its two parameters was swapped.

Background info: The DAYS function has been available in PlanMaker for a long time. Excel did not have this
function until Excel 2013. In Excel 2013, a function with the same name was added. It returns exactly the same
results – however, the order of its parameters is different: first the end date, then the start date. In order to be
compatible with Excel, the parameter order was swapped in PlanMaker 2016.

The previous version of the function was renamed to DAYSP. Thus, the functions DAYS and DAYSP are
identical, only the order of their parameters differs:

DAYS(EndDate, StartDate) equals

DAYSP(StartDate, EndDate)

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

DAYS("01/14/2018", "01/01/2018") returns 13

If cell A1 contains the date value 01/14/2018 and cell A2 contains the date value 01/01/2018:

DAYS(A1, A2) returns 13

See also:

DAYSP, DATEDIF, NETWORKDAYS, DAYS360, TIMEDIFF
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DAYS360 (days between two dates)

Syntax:

DAYS360(StartDate, EndDate [, Mode])

Description:

Returns the number of days between two dates – based on a year with 360 days (12 months with 30 days each).

StartDate and EndDate are the two dates to be evaluated.

Mode (optional) is a logical value that lets you specify how dates occurring on the 31st of a month should be
evaluated:

FALSE or omitted: The U.S. (NASD) method is used: If StartDate is the 31st of a month, the 30th of the same
month will be used instead. If EndDate is the 31st of a month, the 1st of the following month will be used
instead. Exception: If StartDate and EndDate are the 31st of a month, the 30th of the same month will be used
instead (for both dates).

TRUE: The European method is used: If StartDate or EndDate is the 31st of a month, the 30th of the same
month will be used.

Note:

Therefore, if you do not want to calculate according to the U.S. (NASD) method, the Mode argument must be
specified with TRUE.

Example:

DAYS360("01/01/2018", "02/01/2018") returns 30

DAYS360("02/01/2018", "03/01/2018") returns 30

DAYS360("01/01/2012", "01/01/2013") returns 360

See also:

DATEDIF, NETWORKDAYS, DAYS/DAYSP, TIMEDIFF
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DAYSP (compatibility function)

Syntax:

DAYSP(StartDate, EndDate)

Description:

Compatibility function for older PlanMaker documents.

This function has been replaced by the DAYS function. (Please note that DAYS expects its parameters in
reversed order.)

See the notes below.

Note:

DAYSP is merely a compatibility function. When you open a document created with PlanMaker 2012 or
earlier, all occurrences of the DAYS function are automatically converted into DAYSP. Reason: In PlanMaker
2016, the parameter order of the DAYS function was swapped.

For new documents, it is recommended to use the Excel 2013 compatible function DAYS instead, which is
identical – except for the order of its parameters:

DAYS(EndDate, StartDate) equals

DAYSP(StartDate, EndDate)

For more information, see DAYS.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

DAYSP("01/01/2018", "01/14/2018") returns 13

If cell A1 contains the date value 01/01/2018 and cell A2 contains the date value 01/14/2018:

DAYSP(A1, A2) returns 13

See also:

DAYS, DATEDIF, NETWORKDAYS, DAYS360, TIMEDIFF
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DAYSPERMONTH (days per month)

Syntax:

DAYSPERMONTH(Date)

Description:

Returns the number of days in the specified month.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

DAYSPERMONTH("09/25/2018") returns 30 (days)

DAYSPERMONTH("10/25/2018") returns 31 (days)

If cell A1 contains the date value 09/25/2018: DAYSPERMONTH(A1) returns 30 (days)

See also:

DAYSPERYEAR, YEAR, DAYS/DAYSP, DAYS360

DAYSPERYEAR (days per year)

Syntax:

DAYSPERYEAR(Date)

Description:

Returns the number of days in the specified year.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.
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Example:

DAYSPERYEAR("01/01/2012") returns 366 (2012 was a leap year)

DAYSPERYEAR("01/01/2013") returns 365 (2013 was not a leap year)

If cell A1 contains the date value 1/1/2012 then DAYSPERYEAR(A1) retrurns 366

See also:

YEAR, DAYSPERMONTH, DAYS/DAYSP, DAYS360

DB (fixed-declining balance depreciation)

Syntax:

DB(Cost, Salvage, Life, Per [, Months])

Description:

Returns the depreciation of an asset for the specified period, using the fixed-declining balance method.

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Months (optional) = Number of Months in the first year (12 if omitted)

Example:

For a machine purchased for € 200,000 that is used for 6 years and then has a salvage value of € 10,000, the
following annual depreciation amount must be applied for the first year, broken down into 7 months:

DB(200000, 10000, 6, 1, 7) returns 45850

See also:

DDB, SYD, SLN
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DCOUNT (database function)

Syntax:

DCOUNT(DatabaseArea, Column, CriteriaArea)

Description:

Returns the number of those values in a column of a database area that match the conditions specified in the
criteria area.

Only cells containing numbers (including dates) are counted, cells with text or logical values are ignored.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

If the Column argument is not empty, the function only considers cells from the corresponding column. You
can specify Column by its relative column number or by its column label in double quotation marks (e.g.,
"Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

DCOUNTA

DCOUNTA (database function)

Syntax:

DCOUNTA(DatabaseArea, Column, CriteriaArea)

Description:

Returns the number of those values in a column of a database area that match the conditions specified in the
criteria area.

Unlike the DCOUNT function, DCOUNTA not only counts cells containing numbers but also counts cells with
text or logical values.

For more information on the use of database related functions, see Working with database functions.
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DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

If the Column argument is not empty, the function only considers cells from the corresponding column. You
can specify Column by its relative column number or by its column label in double quotation marks (e.g.,
"Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

DCOUNT

DDB (double-declining balance depreciation)

Syntax:

DDB(Cost, Salvage, Life, Per [, Factor])

Description:

Returns the depreciation of an asset for the specified period, using the double-declining balance method (or a
variable-declining balance method, if Factor is specified).

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Factor (optional) = Rate at which the balance declines (2 if omitted)

Example:

For a machine purchased for € 200,000 that is used for 10 years and then has a salvage value of € 10,000, the
following annual depreciation amount must be applied for the first year:

DDB(200000, 10000, 10, 1) returns 40000

For the second year:

DDB(200000, 10000, 10, 2) returns 32000

etc.
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See also:

DB, SYD, SLN

DEC2BIN (decimal number to binary number)

Syntax:

DEC2BIN(Number [, Digits])

Description:

Converts the given decimal number (base 10) to a binary number (base 2).

Note: Please note that the result of this function is a text string – not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2BIN(42) returns 101010

DEC2BIN(42, 8) returns 00101010

DEC2BIN(42, 4) returns the error value #NUM! because the number 42 cannot be represented with fewer than
6 binary digits

DEC2BIN(-42) returns 11111111111111111111111111010110
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See also:

BIN2DEC, DEC2HEX, DEC2OCT, BASE

DEC2HEX (decimal number to hexadecimal number)

Syntax:

DEC2HEX(Number [, Digits])

Description:

Converts the given decimal number (base 10) to a hexadecimal number (base 16).

Note: Please note that the result of this function is a text string – not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2HEX(42) returns 2A

DEC2HEX(42, 8) returns 0000002A

DEC2HEX(42, 1) returns the error value #NUM! because the number 42 cannot be represented with fewer than
2 hexadecimal digits

DEC2HEX(-42) returns FFFFFFD6
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See also:

HEX2DEC, DEC2BIN, DEC2OCT, BASE

DEC2OCT (decimal number to octal number)

Syntax:

DEC2OCT(Number [, Digits])

Description:

Converts the given decimal number (base 10) to an octal number (base 8).

Note: Please note that the result of this function is a text string – not a number.

Number is the number to be converted.

The permissible value range for Number is:

Number 

That is equivalent to:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case (see last example).

Example:

DEC2OCT(42) returns 52

DEC2OCT(42, 8) returns 00000052

DEC2OCT(42, 1) returns the error value #NUM! because the number 42 cannot be represented with fewer than
2 octal digits

DEC2OCT(-42) returns 37777777726
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See also:

OCT2DEC, DEC2BIN, DEC2HEX, BASE

DECIBEL (decibel value of two quantities)

Syntax:

DECIBEL(P2 [, P1])

Description:

Returns the decibel value (dB) for the ratio of two quantities.

The calculation is based on the following formula:

DECIBEL(P2, P1) = 10 * LOG10(P2/P1)

Note the order of the two parameters: The dividend P2 of the quotient has to be specified first, the divisor P1
second – not vice versa.

P2 and P1 have to be numbers. Their quotient has to be greater than zero.

The parameter P1 is optional. If it is not specified, PlanMaker sets it to 1 (one) automatically.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

DECIBEL(1000, 10) returns 20

DECIMAL (convert number from any base into decimal)

Syntax:

DECIMAL(Number, Base)
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Description:

Converts a number from any base to decimal (base 10) – for example a binary number (base 2) or a
hexadecimal number (base 16).

Number is the number to be converted.

Base is the base of the number. Only integers between 2 and 36 are allowed.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

DECIMAL("00101010", 2) returns 42

DECIMAL("FF", 16) returns 255

See also:

BASE, BIN2DEC, HEX2DEC, OCT2DEC

DECIMALS (fractional part of a number)

Syntax:

DECIMALS(Number)

Description:

Returns the fractional part of the given number (i.e., the digits to the right of the decimal point).

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

DECIMALS(5.779) returns 0.779

Annotation:

To obtain the places before the decimal point use the TRUNC function.
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See also:

TRUNC

DEGREES (convert radians to degrees)

Syntax:

DEGREES(Number)

Description:

Converts radians into degrees.

The following conversion formula is used:

DEGREES(x) = x * 180 / PI()

Example:

DEGREES(PI()) returns 180

See also:

RADIANS

DELTA (test for equality)

Syntax:

DELTA(Number1, Number2)

Description:

Tests if two values are equal. If they are, 1 is returned, otherwise 0 is returned.

Number1 and Number2 must be numbers, otherwise a #VALUE! error value is returned. Text strings
representing numbers are also allowed.
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Example:

DELTA(1, 2) returns 0

DELTA(2, 2) returns 1

DELTA(2, "2") returns 1

DELTA("Text", "Text") returns a #VALUE! error value

See also:

EXACT

DEVSQ (average square deviation)

Syntax:

DEVSQ(Number1 [, Number2, Number3 ...])

Description:

Returns the sum of squares of deviations of the specified numbers from their sample mean.

Empty cells, text strings, and logical values are ignored.

Example:

DEVSQ(2, 2, 2, 3) returns 0.75

See also:

AVEDEV, STDEV.S/STDEV, SUM, VAR.S/VAR

DGET (database function)

Syntax:

DGET(DatabaseArea, Column, CriteriaArea)
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Description:

Returns the value in a column of a database area that matches the given criteria.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

Note:

If more than one value matches the specified criteria, the function returns a #NUM! error value.

DMAX (database function)

Syntax:

DMAX(DatabaseArea, Column, CriteriaArea)

Description:

Returns the largest of those values in a column of a database area that match the conditions specified in the
criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

MAX, DMIN
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DMIN (database function)

Syntax:

DMIN(DatabaseArea, Column, CriteriaArea)

Description:

Returns the smallest of those values in a column of a database area that match the conditions specified in the
criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

MIN, DMAX

DOLLARDE (convert to dollar price decimal)

Syntax:

DOLLARDE(Value, Divisor)

Description:

Converts a dollar price, expressed as a fraction, into a decimal dollar price.

(In the USA it is common practice for some types of financial transactions to represent monetary amounts as
fractions – for example 27 4/8 instead of 27.50)

Value is the number to be converted.

Divisor is the denominator of the fraction. It must be greater than or equal to 1. Divisor should be an integer.
Digits right of the decimal point are ignored.



574Formulas and functions

Example:

DOLLARDE(27.4, 8) converts the fraction 27 4/8 into the decimal value 27.5.

See also:

DOLLARFR

DOLLARFR (convert to dollar price fraction)

Syntax:

DOLLARFR(Value, Divisor)

Description:

Converts a decimal dollar price into a dollar price expressed as a fraction.

(In the USA it is common practice for some types of financial transactions to represent monetary amounts as
fractions – for example 27 4/8 instead of 27.50)

Value is the number to be converted.

Divisor is the denominator of the fraction. It must be greater than or equal to 1. Divisor should be an integer.
Digits right of the decimal point are ignored.

Example:

DOLLARFR(27.5, 8) returns 27.4 (since 27.5 equals the fraction 27 4/8)

See also:

DOLLARDE

DPRODUCT (database function)

Syntax:

DPRODUCT(DatabaseArea, Column, CriteriaArea)
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Description:

Returns the product of those values in a column of a database area that match the conditions specified in the
criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

PRODUCT, DAVERAGE, DSUM

DSTDEV (database function)

Syntax:

DSTDEV(DatabaseArea, Column, CriteriaArea)

Description:

Estimates the standard deviation of a population based on a sample, using those values in a column of a
database area that match the conditions specified in the criteria area.

The function assumes that the values determined represent a sample from the population. On this basis, the
standard deviation is estimated.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

STDEV.S/STDEV, DSTDEVP
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DSTDEVP (database function)

Syntax:

DSTDEVP(DatabaseArea, Column, CriteriaArea)

Description:

Calculates the standard deviation of a population based on the entire population using those values in a column
of a database area that match the conditions specified in the criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

STDEV.P/STDEVP, DSTDEV

DSUM (database function)

Syntax:

DSUM(DatabaseArea, Column, CriteriaArea)

Description:

Returns the sum of those values in a column of a database area that match the conditions specified in the criteria
area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).
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CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

SUM, DAVERAGE

DVAR (database function)

Syntax:

DVAR(DatabaseArea, Column, CriteriaArea)

Description:

Estimates the variance of a population based on a sample, using those values in a column of a database area
that match the conditions specified in the criteria area.

The function assumes that the values determined represent a sample from the population. On this basis, the
variance is estimated.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

VAR.S/VAR, DVARP

DVARP (database function)

Syntax:

DVARP(DatabaseArea, Column, CriteriaArea)
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Description:

Calculates the variance of a population based on the entire population, using those values in a column of a
database area that match the conditions specified in the criteria area.

For more information on the use of database related functions, see Working with database functions.

DatabaseArea is a cell range containing the database to be evaluated. The first row of DatabaseArea must
contain labels for the database columns (e.g., Amount, Price, etc.).

Column is the desired column of the database area. You can specify Column by its relative column number or
by its column label in double quotation marks (e.g., "Amount", "Price", etc.).

CriteriaArea is a cell range containing one or more conditions that have to be fulfilled. The first row of
CriteriaArea has to contain column labels (e.g., Amount, Price, etc.).

See also:

VAR.P/VARP, DVAR

EDATE (date before/after n months)

Syntax:

EDATE(StartDate, m)

Description:

Returns the date that is m months before/after StartDate. This enables you to determine appointments that fall
on the same day of another month.

m is the number of months.

If m is positive, a date in the future will be returned, with m months behind the StartDate.

If m is negative, a date in the past will be returned, with m months before the StartDate.

m should be an integer. Digits right of the decimal point are ignored.

Example:

EDATE("03/30/2018", 1) returns 04/30/2018

EDATE("03/31/2018", 1) returns 04/30/2018 as well, because April has just 30 days.

See also:

EOMONTH
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EFFECT (effective interest rate)

Syntax:

EFFECT(NomRate, NPerYear)

Description:

Returns the effective annual interest rate, given the nominal annual interest rate and the number of
compounding periods per year.

NomRate is the nominal annual interest rate.

NPerYear is the number of compounding periods per year (must be at least 1).

Note:

This function does not calculate the effective annual interest rate according to the regulations of some countries
(e.g. Germany: PAngV). It does not take into account any fees, commissions etc., but merely adds compound
interest to the nominal interest rate over the year.

Example:

To calculate the effective annual interest rate of an investment with a nominal annual interest rate of 5%,
compounded quarterly: How high is the annual percentage rate of charge?

EFFECT(5%, 4) returns approx. 5.09%

See also:

NOMINAL

EOMONTH (end of month in n months)

Syntax:

EOMONTH(StartDate, m)

Description:

Returns the last day of the month that is m months before/after StartDate.



580Formulas and functions

The StartDate argument must be a valid date value, otherwise the function returns the error value #VALUE!

m is the number of months.

If m is zero, the last day of the same month will be returned.

If m is positive, a date in the future will be returned.

If m is negative, a date in the past will be returned.

m should be an integer. Digits right of the decimal point are ignored.

Example:

EOMONTH("09/25/2018", 0) returns 09/30/2018

EOMONTH("09/25/2018", 1) returns 10/31/2018

EOMONTH("09/25/2018", -1) returns 08/31/2018

If cell A1 contains the date value 9/25/2018 then EOMONTH(A1, 0) returns 9/30/2018

See also:

EDATE

ERF (Gaussian error function)

Syntax:

ERF(LowerLimit [, UpperLimit])

Description:

Returns the Gaussian error function.

LowerLimit is the lower bound for the integral. UpperLimit (optional) is the upper bound for the integral. If
omitted, the integral between zero and LowerLimit will be returned.

See also:

ERFC
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ERFC (complement to Gaussian error function)

Syntax:

ERFC(LowerLimit)

Description:

Returns the complement to the Gaussian error function.

LowerLimit 

See also:

ERF

ERROR.TYPE (error type)

Syntax:

ERROR.TYPE(Reference)

Description:

Returns a number representing the type of error value in a cell.

Reference is a reference to a single cell.

Possible results of this function:

Error value in cell Result

No error value #N/A

#NULL! 1

#DIV/0! 2

#VALUE! 3

#REF! 4

#NAME? 5
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#NUM! 6

#N/A 7

For more information about error values, see Error values.

Example:

If A1 contains 1/0 and A2 contains 1/1. The following applies:

ERROR.TYPE(A1) returns 2 (so #DIV/0!)

ERROR.TYPE(A2) returns #N/A (i.e., no error)

The calculation below returns "Error!" if any kind of error occurs in cell A1, otherwise it returns the contents of
A1:

IF(ISNA(ERROR.TYPE(A1)), A1, "Error!")

See also:

ISERR, ISERROR, ISNA, NA(), IFERROR, IFNA, TYPE, section Error values

EUROCONVERT (convert EU currencies)

Syntax:

EUROCONVERT(Number, From, To)

Description:

This function can convert the old currencies of countries that are members of the EU (European Union) and
have adopted the European currency Euro.

This function can perform three types of conversions:

a) Convert a number from one of these currencies to Euros, e.g., French francs to Euros.

b) Convert a number from Euros to one of these currencies, e.g. Euros to French francs.

c) Convert a number from one of these currencies to another by first converting it to euros and then to the
other currency (a method called "triangulation"), e.g., French francs -> Euros -> Spanish pesetas. Note: This
method can lead to rounding errors of up to 0.01.

Number is the number to be converted.

From and To are codes representing the source and target currency (see table below). Use either PM codes or
ISO codes.
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Note: Microsoft Excel only supports ISO codes. If you want to keep your calculations Excel-compatible, make
sure you solely use ISO codes (right column) with this function.

Uppercase and lowercase letters can be mixed.

Country PM code ISO code

All euro countries (euro) € EUR

Belgium (franc) BF BEF

Germany (mark) DM DEM

Estonia (kroon) kr EEK

Finland (markka) mk FIM

France (franc) F FRF

Greece (drachma) Dr GRD

Ireland (pound) IR£ IEP

Italy (lira) L ITL

Latvia (lats) Ls LVL

Lithuania (litas) Lt LTL

Luxembourg (franc) LF LUF

Malta (lira) Lm MTL

Netherlands (guilder) fl NLG

Austria (schilling) öS ATS

Portugal (escudo) esc PTE

Slovakia (koruna) Sk SKK

Slovenia (tolar) SIT SIT

Spain (peseta) pts ESP

Example:

EUROCONVERT(100, "DM", "€") converts 100 German marks to Euros. The result is 51.13 (Euro).

EUROCONVERT(100, "DEM", "EUR") does the same, but uses ISO codes. The result is of course identical:
51.13 (Euro).

EUROCONVERT(100, "DEM", "ATS") returns 703.55 (Austrian schillings).
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EVEN (round up to next even number)

Syntax:

EVEN(Number)

Description:

Rounds Number up (away from zero) to the nearest even integer.

Example:

EVEN(42) returns 42

EVEN(43) returns 44

EVEN(-43) returns -44

See also:

ODD, ROUNDUP, ROUND, MROUND, FIXED, INT, TRUNC, CEILING, FLOOR

EXACT (compare texts)

Syntax:

EXACT(Text1, Text2)

Description:

Returns TRUE if Text1 and Text2 are exactly the same.

This function is case-sensitive.

Example:

EXACT("aaa", "aaa") returns TRUE

EXACT("aaa", "Aaa") returns FALSE

EXACT(UPPER("aaa"), UPPER("Aaa")) returns TRUE
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See also:

FIND, SEARCH, DELTA

EXP (power of e)

Syntax:

EXP(Number)

Description:

Returns e raised to the power of Number.

The constant e (2.71828...) is the base of the natural logarithm (LN).

Example:

EXP(5) returns 148.4132

EXP(LN(0.1234)) returns 0.1234

Annotation:

The inverse function is LN.

See also:

LN, LOG, LOG10, POWER

EXPONDIST (exponential distribution)

Note: EXPONDIST is supplemented by the new identical function EXPON.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

EXPONDIST(x, Lambda, Cumulative)
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Description:

Returns the probabilities of an exponentially distributed random number.

An exponential distribution can be used to model time intervals like the time between phone calls or the time
customers have to wait at a counter.

For example, if it is known that a customer arrives at a bank counter every three minutes on average, you can
use this function to calculate the probability that a customer will arrive after two minutes at the latest.

x 

Lambda (l) is the average number of successes per time interval. Must be > 0.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

See also:

EXPON.DIST, POISSON.DIST/POISSON, WEIBULL.DIST/WEIBULL

EXPON.DIST (exponential distribution)

Syntax:

EXPON.DIST(x, Lambda, Cumulative)

Description:

Returns the probabilities of an exponentially distributed random number.

An exponential distribution can be used to model time intervals like the time between phone calls or the time
customers have to wait at a counter.

For example, if it is known that a customer arrives at a bank counter every three minutes on average, you can
use this function to calculate the probability that a customer will arrive after two minutes at the latest.

x 

Lambda (l) is the average number of successes per time interval. Must be > 0.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

EXPONDIST, POISSON.DIST/POISSON, WEIBULL.DIST/WEIBULL

FACT (factorial)

Syntax:

FACT(Number)

Description:

Returns the factorial of the specified number.

The factorial of a number is the product of all positive integers in the range from 1 to Number, i.e.,
1*2*3*...*Number.

Number 

Example:

FACT(9) equals 1*2*3*4*5*6*7*8*9, which is 362880.

See also:

FACTDOUBLE, MULTINOMIAL, POLYNOMIAL

FACTDOUBLE (double factorial)

Syntax:

FACTDOUBLE(Number)

Description:

Returns the double factorial of the specified number.
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The double factorial is calculated as follows:

If Number is even, its double factorial is 2*4*6*...*Number.

If Number is odd, its double factorial is 1*3*5*...*Number.

Number 

Example:

FACTDOUBLE(10) equals 2*4*6*8*10, which equals 3840.

FACTDOUBLE(11) equals 1*3*5*7*9*11, which equals 10395.

See also:

FACT

FALSE (logical value FALSE)

Syntax:

FALSE()

Description:

Returns the logical value FALSE.

See also:

TRUE

FDIST (F distribution)

Note: FDIST is supplemented by the new identical function F.DIST.RT, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

FDIST(X, DegreesFreedom1, DegreesFreedom2)
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Description:

Returns the right-tailed F probability distribution function.

X 

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

decimal point are ignored.

See also:

F.DIST.RT, F.INV.RT/FINV, F.TEST/FTEST

F.DIST.RT (F distribution)

Syntax:

F.DIST.RT(X, DegreesFreedom1, DegreesFreedom2)

Description:

Returns the right-tailed F probability distribution function.

X 

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

decimal point are ignored.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

FDIST, F.INV.RT/FINV, F.TEST/FTEST
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FILENAME (file name of the document)

Syntax:

FILENAME([IncludePath])

Description:

Returns the file name of the current document.

IncludePath (optional) determines if the path (drive and folder) should be included:

FALSE or omitted: don't include path

TRUE: include path

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

If you save a document as Balance.pmdx in folder C:\Documents:

FILENAME() returns Balance.pmdx

FILENAME(TRUE) returns C:\Documents\Balance.pmdx

See also:

USERFIELD, SHEET, SHEETNAME, CELL

FIND (search for text)

Syntax:

FIND(SearchedText, Text [, StartPos])

Description:

Returns the position of the text string SearchedText within the text string Text.



591Formulas and functions

StartPos (optional) lets you specify the position (= character) at which to start the search. If omitted, the search
starts at the first character.

The FIND function is case-sensitive. To perform a non case-sensitive search, use the SEARCH function instead

Example:

FIND("a", "Banana") returns 2

FIND("A", "Banana") returns the error value #VALUE!, since the text string does not contain an upper case
"A".

FIND("a", "Banana", 3) returns 4

See also:

SEARCH, REPLACE, SUBSTITUTE, EXACT, MID

FINV (percentiles of the F distribution)

Note: FINV is supplemented by the new identical function F.INV.RT, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

FINV(Probability, DegreesFreedom1, DegreesFreedom2)

Description:

Returns the inverse of the right-tailed F probability distribution function (i.e., percentiles of this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

decimal point are ignored.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.
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See also:

F.INV.RT, F.TEST/FTEST, F.DIST.RT/FDIST

F.INV.RT (percentiles of the F distribution)

Syntax:

F.INV.RT(Probability, DegreesFreedom1, DegreesFreedom2)

Description:

Returns the inverse of the right-tailed F probability distribution function (i.e., percentiles of this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom1 is the numerator degrees of freedom.

DegreesFreedom2 is the denominator degrees of freedom.

decimal point are ignored.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

FINV, F.TEST/FTEST, F.DIST.RT/FDIST
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FISHER (Fisher transformation)

Syntax:

FISHER(Number)

Description:

Returns the Fisher transformation.

Number must be > -1 and < 1.

Annotation:

The inverse function is FISHERINV

See also:

FISHERINV, CORREL, COVARIANCE.P/COVARIANCE.S/COVAR

FISHERINV (inverse of the Fisher transformation)

Syntax:

FISHERINV(Number)

Description:

Returns the inverse of the Fisher transformation for the given number.

Annotation:

This function is the inverse of the FISHER transformation.

See also:

FISHER, CORREL, COVARIANCE.P/COVARIANCE.S/COVAR
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FIXED (format number as text with fixed decimals)

Syntax:

FIXED(Number [, n] [, NoThousandsSep])

Description:

Converts a number into a text string. The resulting text string is rounded to n decimal places.

Number is the number to be converted.

n (optional) is the number of decimal places. If n is omitted, Number is rounded to two places.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of hundred (see last example).

NoThousandsSep (optional) is a logical value that lets you specify if the resulting text string should contain
thousands separators:

FALSE or omitted: Add thousands separators

TRUE: Do not add thousands separators

Note:

Please keep in mind that the result of this function is a text string. To round a number without converting it to a
text string, use one of the round functions (see below) instead.

To display a number rounded without actually rounding it, you can also use the commands from the ribbon tab
Home | group Number.

Example:

FIXED(1234.5678, 2) returns the text string 1,234.57

FIXED(1234.5678, 2, TRUE) returns the text string 1234.57 (without thousands separators)

FIXED(1234.5678, -2) returns the text string 1,200

See also:

ROUND, ROUNDDOWN, ROUNDUP, TRUNC, TEXT, INT
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FLOOR (round down to a multiple of base)

Syntax:

FLOOR(Number, Base)

Description:

Rounds Number down (towards zero) to the nearest multiple of Base.

Positive numbers are rounded to the nearest multiple of Base that is smaller than Number.

Negative numbers are rounded to the nearest multiple of Base that is larger than Number.

Number and Base must have the same sign, otherwise the function returns a #NUM! error value.

Example:

FLOOR(42.5, 1) returns 42

FLOOR(-42.5, -1) returns -42

FLOOR(21, 5) returns 20

FLOOR(12.3456, 0.01) returns 12.34

See also:

CEILING, ROUNDDOWN, ROUNDUP, ROUND, MROUND, TRUNC

FORECAST (forecast using linear regression)

Syntax:

FORECAST(x, y_values, x_values)

Description:

Returns the y coordinate for the given x coordinate on a best-fit line based on the given values.

A best-fit line is the result of a linear regression, a statistical technique that adapts a line to a set of data points
(for example, the results of a series of measurements).
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The FORECAST function allows you to predict what value y (the dependent variable) will approximately have
at a certain value x (the independent variable).

This function can be used to predict, for example, the resistance of a temperature-sensitive resistor at a specific
temperature after having measured the resistance at several other temperatures.

x is the value x for which a prediction is desired.

For the y_values and x_values arguments, you usually specify a cell range.

y_values are the known y values (e.g., the resistance).

x_values are the known x values (e.g., the temperature).

Note:

Note that this function expects first the y_values and then the x_values as second and third arguments – not the
other way around.

Annotation:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-sensitive resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures measured: 8, 20, 25, 28

Cells B1:B4 contain the resistances measured: 261, 508, 608, 680

The following calculation returns an estimate for the resistance at 15 degrees:

FORECAST(15, B1:B4, A1:A4) returns 405.21805 (Ohm)

Annotation:

INTERCEPT(y_values, x_values) equals FORECAST(0, y_values, x_values).

See also:

INTERCEPT, SLOPE, SKEW, STEYX, TREND

FORMULATEXT (display formula contained in cell)

Syntax:

FORMULATEXT(Cell)
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Description:

Displays the formula that the specified cell contains.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

If the cell A1 contains the formula =SUM(D2:D4), then FORMULATEXT(A1) will return the text
"=SUM(D2:D4)".

See also:

ISFORMULA

FREQUENCY (frequency)

Syntax:

FREQUENCY(Values, Bounds)

Description:

Returns a frequency distribution for the given set of values. Use this function to count how many values are part
of the specified intervals.

The result of this function is a vertical array (see notes below).

Values is a cell range or an array containing the values to be evaluated. Blank cells and text strings are ignored.

Bounds is a cell range or an array containing the bounds for the intervals. For example, if Bounds is the array
{10; 15; 42}, the function returns an array with the following values:

4. The number of values that are > 42.

Both Values and Bounds have to be vertical arrays (i.e., must not consist of more than one column).
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Note:

Formulas using this function have to be entered as an array formula (see Working with arrays).

Please note that the array returned by this function contains one element more than the number of values in
Bounds.

See also:

COUNT

FTEST (F-test)

Note: FTEST is supplemented by the new identical function F.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

FTEST(Array1, Array2)

Description:

Returns the test statistics of an F-test.

An F-test can be used to check the consistency of the variances between two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

They both have to consist of at least 2 values; otherwise the function returns a #DIV/0! error value (division by
zero).

If the variance of Array1 or Array2 is zero, the function returns a #DIV/0! error value.

See also:

F.TEST, F.INV.RT/FINV, F.DIST.RT/FDIST

F.TEST (F-test)

Syntax:

F.TEST(Array1, Array2)
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Description:

Returns the test statistics of an F-test.

An F-test can be used to check the consistency of the variances between two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

They both have to consist of at least 2 values; otherwise the function returns a #DIV/0! error value (division by
zero).

If the variance of Array1 or Array2 is zero, the function returns a #DIV/0! error value.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

FTEST, F.INV.RT/FINV, F.DIST.RT/FDIST

FV (future value)

Syntax:

FV(Rate, NPer, Pmt [, PV] [, Type])

Description:

Returns the future value of an investment based on periodic constant payments and a constant interest rate.

You can use this function to calculate the future value (= terminal value) of a loan, for example.

The function expects the following arguments:

Rate is the interest rate (per payment period).

NPer is the total number of payment periods.

Pmt is the payment made for each period.

PV (optional) is the present value. If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.
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Example:

FV(6.5%/12, 10, -1000) returns 10,247.30

See also:

PV, PPMT, PMT, RATE, IPMT, FVSCHEDULE, NPER

FVSCHEDULE (future value)

Syntax:

FVSCHEDULE(PV, Rates)

Description:

Returns the future value of an initial principal after applying a series of variable compound interest rates.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

You can use this function to calculate the future value (= terminal value) of a loan, for example.

The function expects the following arguments:

PV is the present value.

Rates is a cell range or an array containing the different interest rates (in their actual order, namely, rate for the
first period, rate for the second period, etc.)

Example:

You have an investment of $10,000 that pays 5% interest in the first, 5.2% in the second, 5.5% in the third and
5.9% in the fourth year. To calculate the future value of this investment, you enter the four interest rates (in the
correct order) in cells A1 to A4, for example, and then employ the following formula:

FVSCHEDULE(10000, A1:A4) returns 12341.09

The different interest rates can also be entered directly using the following form:

FVSCHEDULE(10000, {5%, 5.2%, 5.5%, 5.9%})

See also:

FV
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GAMMA (gamma function)

Syntax:

GAMMA(Number)

Description:

Calculates the gamma function for the given number.

Number must be > 0.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

GAMMALN, GAMMA.DIST/GAMMADIST, GAMMA.INV/GAMMAINV

GAMMADIST (gamma distribution)

Note: GAMMADIST is supplemented by the new identical function GAMMA.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

GAMMADIST(X, Alpha, Beta, Cumulative)

Description:

Returns the probabilities of a gamma distributed random number.

X 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.
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See also:

GAMMA.DIST, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GAMMA.DIST (gamma distribution)

Syntax:

GAMMA.DIST(X, Alpha, Beta, Cumulative)

Description:

Returns the probabilities of a gamma distributed random number.

X 

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

The inverse function is GAMMA.INV

See also:

GAMMADIST, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GAMMAINV (percentiles of the gamma distribution)

Note: GAMMAINV is supplemented by the new identical function GAMMA.INV, which is available in
newer versions of Microsoft Excel (2010 or later).
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Syntax:

GAMMAINV(Probability, Alpha, Beta)

Description:

Returns the percentiles of the gamma distribution.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

See also:

GAMMA.INV, GAMMA.DIST/GAMMADIST, GAMMA, GAMMALN

GAMMA.INV (percentiles of the gamma distribution)

Syntax:

GAMMA.INV(Probability, Alpha, Beta)

Description:

Returns the percentiles of the gamma distribution.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Alpha and Beta are shape parameters of the function. They both have to be greater than zero.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

Annotation:

GAMMA.INV is the inverse function of GAMMA.DIST
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See also:

GAMMAINV, GAMMA.DIST/GAMMADIST, GAMMA, GAMMALN

GAMMALN (logarithm of the gamma function)

Syntax:

GAMMALN(Number)

Description:

Returns the natural logarithm of the gamma function.

Number must be > 0.

See also:

GAMMA, GAMMA.DIST/GAMMADIST, GAMMA.INV/GAMMAINV

GAUSS (standard normal distribution)

Syntax:

GAUSS(x)

Description:

Returns the integral of the PHI function (standard normal distribution) minus 0.5.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

It is therefore recommended to use the function NORMSDIST instead, since it is compatible with all versions
of Excel:

GAUSS(x) equals NORMSDIST(x) - 0.5
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See also:

PHI, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

GCD (greatest common divisor)

Syntax:

GCD(Number1 [, Number2, Number3 ...])

Description:

Returns the GCD (greatest common divisor) of the specified integers. The GCD is the largest integer that will
divide all of the given integers without a remainder.

You can specify numbers or cell references as arguments.

Number1, Number2, etc., are the numbers to be evaluated. All of them have to be greater than zero.
Additionally, all of them should be integers. Digits to the right of the decimal point are ignored.

Example:

GCD(25, 100, 250) returns 25

GCD(25, 105, 250) returns 5

If cells A1 to A3 contain the values 4, 8 and 6, respectively:

GCD(A1:A3) returns 2

See also:

LCM

GEOMEAN (geometric mean)

Syntax:

GEOMEAN(Number1 [, Number2, Number3...])
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Description:

Returns the geometric mean of the specified numbers.

The geometric mean is the n-th root of the product of the given values (n is the total number of values).

Number1, Number2, etc., are the numbers to be evaluated. All of them have to be greater than zero. The
values can be single values, cell ranges, or arrays containing the values to be summed.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Example:

GEOMEAN(1, 2, 6) returns 2.28943

See also:

HARMEAN, TRIMMEAN, AVERAGE

GESTEP (number greater or equal to threshold value?)

Syntax:

GESTEP(Number, Step)

Description:

Returns 1 if Number Step, else returns 0.

Example:

GESTEP(41, 42) returns 0

GESTEP(42, 42) returns 1

GESTEP(42.1, 42) returns 1

See also:

DELTA
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GETPIVOTDATA

Syntax:

GETPIVOTDATA(ValueField, PivotRange [, Field1, Label1, Field2, Label2,...])

Description:

Returns the values of an existing pivot table by retrieving certain fields from the pivot table structure.

Value field: The name of the field that you have placed in the Values area of the pivot table and whose data
you want to retrieve. The argument must be entered with double quotes.

PivotRange: The referenced pivot table. Just address any cell of the pivot table target range to specify it. The
argument is entered without quotes.

Field1, Label1, Field2, Label2,...: You can narrow the output of the values by retrieving a specific field in
conjunction with an element from this field. It is possible to add several combinations. The argument must be
entered with double quotes.

ValueField and PivotRange are required as arguments, Fields/Labels are optional.

Annotation:

For the PivotRange you can also enter a Named range here, but you first have to give the cell range of the pivot
table report a name. To do this, select a cell in the pivot table report (you do not have to select the entire range)
and follow the description in the Naming cell ranges section.

You cannot use the name automatically generated by PlanMaker (e.g. "Pivot table 1") as the Named range.
Only names that have been created via the ribbon command Formula | group Named areas | Edit names can
be assigned as names for the PivotRange.

Example:

Here are example data from the Pivot tables section. Assuming your pivot table report is in cell range F1:G12
and the "Amount" field is in the Values area, the "Employee" and "Order" fields are in the Row labels area:
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GETPIVOTDATA("AMOUNT", F1) returns 200, because the grand total for all values of Amount is displayed.

GETPIVOTDATA("AMOUNT", F1, "Employee", "Anna") returns 123, since the result of Amount is restricted
to the Employee field containing the item Anna.

GETPIVOTDATA("AMOUNT", F1, "Employee", "Anna", "Order", "Coffee") returns 75, since the result of
Amount is restricted to the field Employee/item Anna in combination with the field Order/item Coffee.

GROWTH (values of an exponential regression)

Syntax:

GROWTH(y_values [, x_values] [, New_x_values] [, Constant])

Description:

Returns the values of an exponential regression.

Exponential regression is a statistical technique that adapts an exponential curve to a set of data points (for
example, the results of a series of measurements).

The GROWTH function returns an array with the y values of a best-fit exponential curve based on the given y
values and x values.

In detail, the function expects the following arguments:

y_values: Here you specify the existing y-coordinates, that is, the dependent values. y_values can be either a
cell reference or an array. All of them must be positive, otherwise a #NUM! error value is returned.

x_values: Here you can optionally specify the x-coordinates, that is, the independent values. Also x_values can
be either a cell reference or an array. If x_values are omitted, the values 1, 2, 3, ... will be used automatically.
(according to the number of existing y_values).
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New_x_values (optional) are the x values for which you want to determine the corresponding y values on the
curve. If omitted, the values in x_values will be used. However, if required, you can specify other x-coordinates
with New_x_values. New_x_values can also be either a cell reference or an array.

Constant (optional) is a logical value that lets you specify if the constant b should be calculated automatically
or forced to equal 1:

TRUE or omitted: b will be calculated from the given data.

FALSE: b is forced to equal 1 (one), the m values are adjusted accordingly.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

See also:

LINEST, LOGEST, TREND

HARMEAN (harmonic mean)

Syntax:

HARMEAN(Number1 [, Number2, Number3 ...])

Description:

Returns the harmonic mean of the specified numbers.

This is defined as the reciprocal of the arithmetic mean of the reciprocal values of the individual values.

Number1, Number2, etc., are the numbers to be evaluated. All of them have to be greater than zero. The
values can be single values, cell ranges, or arrays containing the values to be summed.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Example:

HARMEAN(1, 2, 6) returns 1.8

See also:

GEOMEAN, TRIMMEAN, AVERAGE
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HEX2BIN (hexadecimal number to binary number)

Syntax:

HEX2BIN(Number [, Digits])

Description:

Converts the given hexadecimal number (base 16) to a binary number (base 2).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

HEX2BIN("2A") returns 101010

HEX2BIN("2A", 8) returns 00101010

HEX2BIN("2A", 2) returns the error value #NUM!, because this number cannot be represented with fewer than
5 binary digits

HEX2BIN("FFFFFFD6") returns 11111111111111111111111111010110 (negative value)

See also:

BIN2HEX, HEX2DEC, HEX2OCT
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HEX2DEC (hexadecimal number to decimal number)

Syntax:

HEX2DEC(Number)

Description:

Converts the given hexadecimal number (base 16) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation:

Number 

Example:

HEX2DEC("2A") returns 42

HEX2DEC("FFFFFFD6") returns -42

See also:

DEC2HEX, HEX2BIN, HEX2OCT, DECIMAL

HEX2OCT (hexadecimal number to octal number)

Syntax:

HEX2OCT(Number [, Digits])

Description:

Converts the given hexadecimal number (base 16) to an octal number (base 8).

Number is the number to be converted.
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Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in hexadecimal notation):

Number 

This corresponds in decimal notation:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

HEX2OCT("2A") returns 52

HEX2OCT("2A", 4) returns 0052

HEX2OCT("2A", 1) returns the error value #NUM!, because this number cannot be represented with fewer
than 2 octal digits

HEX2OCT("FFFFFFD6") returns 37777777726 (negative value)

See also:

OCT2HEX, HEX2BIN, HEX2DEC

HLOOKUP (look up row-wise)

Syntax:

HLOOKUP(Crit, Range, n [, Sorted])

Description:

Scans in the first row of range for the first occurrence of Crit. If found, the function returns the content of the
cell located in the same column and n-th row of Range.

Note: HLOOKUP can search horizontally only. To search vertically, use VLOOKUP instead.
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Crit is the value to be searched for. The search is case insensitive.

Range is the cell range or array to be evaluated. Its first row should contain the values to be scanned. These can
be text strings, numbers or logical values.

n is the relative row number in Range from which a value will be returned.

If n is less than 1, a #VALUE! error value is returned. If n is greater than the total number of rows in Range, a
#REF! error value is returned.

Sorted is a logical value determining whether the values in the first column of Range are in sorted order:

TRUE or omitted: Values have to be sorted in ascending order.

FALSE: Values do not have to be sorted.

Important: If you do not explicitly set Sorted to FALSE, these values must be in sorted order!

Note:

If HLOOKUP does not find a value that exactly matches the Crit, the next lower value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the error
value #N/A.

Example:

You sell flowers at different unit prices – depending on how many flowers the customer buys. To do this, you
have created a table with a discount scale:

Now you can use the HLOOKUP function to determine the price for a specific type of flower depending on the
number of pieces.

Use the following arguments:

For Crit, enter the name of the flower type (i.e. "roses", "carnations" or "tulips").

For Range you enter the cell range, which contains the names of the flower types in the first row and the prices
below – here B1:D4.

For n you enter the number of pieces plus one, because the first row (n=1) does not contain prices, but the
names of the flowers.

Some examples:

HLOOKUP("Roses", B1:D4, 2, FALSE) returns the price for one rose, i.e. € 5.50.
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HLOOKUP("Roses", B1:D4, 4, FALSE) returns the price for three roses, i.e. € 4.95.

HLOOKUP("Carnations", B1:D4, 4, FALSE) returns the price for three carnations, i.e. € 4,50.

HLOOKUP("Carnations", B1:D4, 5, FALSE) returns the error value #REF because n is greater than the row
number of Range.

HLOOKUP("Petunias", B1:D4, 4, FALSE) returns the error value #N/A, because "Petunias" does not appear in
the first row of Range.

See also:

VLOOKUP, LOOKUP, INDEX, MATCH, TRUE

HOLIDAY (dates of movable Christian holidays)

Syntax:

HOLIDAY(Year, Type)

Description:

Returns the date of the specified movable Christian holiday in the given year.

Year is an integer number that specifies the year to evaluate.

Type is an integer number that specifies which holiday to calculate, as follows:

0: Good Friday

1: Easter Sunday

2: Easter Monday

3: Ascension Day

4: Whitsunday (Pentecost)

5: Whitmonday

6: (Feast of) Corpus Christi

7: Ash Wednesday

8: Repentance Day (Germany)

9: 1st Sunday of Advent

Example:

HOLIDAY(2014, 1) returns 04/20/2014 (Easter Sunday in 2014)
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HOLIDAY(YEAR(TODAY(), 1) returns the date of Easter Sunday in the current year

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

WORKDAY, NETWORKDAYS

HOUR (hour)

Syntax:

HOUR(Time)

Description:

Returns the hour of a time value.

Example:

HOUR("12:34:56 AM") returns 12

HOUR("09/25/2018 10:30:56") returns 10

If cell A1 contains a date with the time 10:30:56 then HOUR(A1) returns 10

See also:

MINUTE, SECOND, MILLISECONDS

HYPERLINK (hyperlink)

Syntax:

HYPERLINK(TargetAddress [, Text])
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Description:

Displays a hyperlink to the specified target address in the cell. The text displayed is either the target address or
the text specified in the optional parameter Text.

For example, you can place a link to a web page in a cell. When the user clicks on it, the web browser starts and
presents the page.

Links to other PlanMaker documents are possible as well. When clicked, PlanMaker opens the specified
document. See examples below.

TargetAddress is the address you want the link to point to. You can use a fixed text string, a calculation, or a
reference to a cell that contains the target address. See examples below.

Text (optional) is the text to be displayed in the cell. If it is not specified, the target address will be displayed
instead.

Example:

=HYPERLINK("http://www.softmaker.com")

The above hyperlink opens the web page www.softmaker.com in the web browser.

=HYPERLINK("http://www.softmaker.com", "Our Homepage")

Ditto, but instead of the target address, the text "Our Homepage" is displayed as link text.

=HYPERLINK("http://www.softmaker.com#MyAnchor")

The above link opens the web page www.softmaker.com in the browser and jumps to the anchor (target) named
"MyAnchor". Alternatively, you could also use the syntax =HYPERLINK("[http://www.softmaker.com]
MyAnchor") for this.

=HYPERLINK("C:\My Folder\Filename.pmdx")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker.

Note: You can not only open PlanMaker files with this function, but practically any kind of document (provided
that it is associated with an application that will open it).

=HYPERLINK("[C:\My Folder\Filename.pmdx]Sheet1!A5")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker and jumps to the cell A5 on the
worksheet "Sheet1". Note: The entire file path and name has to be enclosed in brackets. Behind the file name,
add the name of the worksheet, an exclamation mark and the address of the target cell.

=HYPERLINK("[C:\My Folder\Filename.pmdx]Sheet1!MyRange")

The above link opens the file C:\My Folder\Filename.pmdx in PlanMaker and jumps to the top left corner of the
named range "MyRange" on the worksheet "Sheet1".

=HYPERLINK(E1, E2)

The above link opens the target address given in the cell E1. As a link text, the text given in cell E2 is
displayed.
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See also:

Links can also be created using the procedure described in section Working with links. However, the
HYPERLINK function is more flexible.

HYPGEOMDIST (hypergeometric distribution)

Note: HYPGEOMDIST is supplemented by the new function HYPGEOM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

HYPGEOMDIST(k, n, K, N)

Description:

Returns the hypergeometric distribution.

The hypergeometric distribution can be used to calculate the probability to, for example, obtain k red balls
when randomly drawing n balls (without replacement) from an urn containing N balls, with K of them red balls.

k is the number of successes in the sample (success = drawing a red ball).

n is the size of the sample (the number of balls to be drawn)

K is the total number of successes in the population (the total number of red balls).

N is the size of the population (the total number of balls).

All of these values should be integers. Digits right of the decimal point are ignored by PlanMaker.

Example:

An urn contains 10 balls (N=10) with 2 of them red (K=2). To determine the probability to obtain exactly 1 red
ball (k=1) when drawing 5 balls (n=5), use the following calculation:

HYPGEOMDIST(1, 5, 2, 10) returns 0.55556

See also:

HYPGEOM.DIST, NEGBINOM.DIST/NEGBINOMDIST
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HYPGEOM.DIST (hypergeometric distribution)

Syntax:

HYPGEOM.DIST(k, n, K, N, Cumulative)

Description:

Returns the hypergeometric distribution with the additional argument Cumulative.

The hypergeometric distribution can be used to calculate the probability to, for example, obtain k red balls
when randomly drawing n balls (without replacement) from an urn containing N balls, with K of them red balls.

k is the number of successes in the sample (success = drawing a red ball).

n is the size of the sample (the number of balls to be drawn)

K is the total number of successes in the population (the total number of red balls).

N is the size of the population (the total number of balls).

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the hypergeometric distribution is calculated. By entering the value FALSE, the density
function of the hypergeometric distribution is calculated.

All of these values should be integers. Digits right of the decimal point are ignored by PlanMaker.

Example:

An urn contains 10 balls (N=10) with 2 of them red (K=2). To determine the probability to obtain exactly or at
most 1 red ball (k=1) when drawing 5 balls (n=5), use the following calculation:

HYPGEOM.DIST(1, 5, 2, 10, FALSE) returns 0.55556

HYPGEOM.DIST(1, 5, 2, 10, TRUE) returns 0.77778

The probability of obtaining exactly 1 red ball is 55.6% (density function). The probability of obtaining at most
1 red ball is 77.8% (cumulative distribution function).

Note:

The HYPGEOM.DIST function supplements the previous HYPGEOMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

HYPGEOMDIST, NEGBINOM.DIST/NEGBINOMDIST

IF (if-then-else condition)

Syntax:

IF(Condition, IfTrue [, IfFalse])

Description:

Returns IfTrue, if the specified Condition is TRUE, else returns IfFalse (if given).

Condition can be any kind of value or expression that returns TRUE or FALSE.

IfTrue and IfFalse can be any kind of value or expression (including formulas).

Example:

returns the text string "ok".

See also:

CHOICE, IFERROR

IFS (first condition met)

Syntax:

IF(Condition1, Value1 [, Condition2, Value2 ...])

Description:

This function can test multiple conditions and returns the value of the first condition that is fulfilled. IFS allows
shorter formulas than with a nested formula construction using the similar IF function.

Condition1 is the first tested condition and can be any expression.

Value1 is the result if Condition1 is fulfilled.
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Condition2, Value2 (optional) is the second tested condition, etc.

As soon as the first fulfilled Condition is found, its corresponding Value is displayed as the result.

Note:

If none of the conditions is fulfilled, the #N/A error is returned.

Instead, you can use the condition TRUE at the end of the formula to specify a default value as the result, which
is returned if none of the conditions is fulfilled (see example 2 below).

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

Example 1:

You have entered a sales volume in cell A1 and want to distribute a bonus according to the sales volume using
the following distribution key:

Sales above 50000 = 2000 bonus; Sales above 25000 = 1000 bonus; Sales above 10000 = 500 bonus

The formula IFS(A1>50000, 2000, A1>25000, 1000, A1>10000, 500) then returns for example:

if the sales in cell A1 are 70000, the result is 2000 as a bonus.

if the sales in cell A1 are 30000, the result is 1000 as a bonus.

if the sales in cell A1 are 20000, the result is 500 as a bonus.

If cell A1 contains a sales volume of 9000, the formula returns the result #N/A, since none of the conditions is
fulfilled. You could of course also specify a condition for this. Or you can specify instead, which default value
the formula generally returns, if none of the conditions is fulfilled (see example 2).

Example 2:

You have the same initial situation as in example 1. At the end of the formula, use the condition TRUE to
specify a default value that appears if none of the conditions is fulfilled:

IFS(A1>50000, 2000, A1>25000, 1000, A1>10000, 500, TRUE, "check")

For example, if cell A1 contains 9000 or -1000 as sales volume, the result is "check".

See also:

IF, SWITCH, VLOOKUP
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IFEMPTY (return a value if cell is empty)

Syntax:

IFEMPTY(Cell, Value)

Description:

Normally returns the content of the Cell. However, if this cell is empty, the defined Value is returned instead.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

IFEMPTY(A1, "Cell is empty!") returns the content of cell A1 as long as it is not empty. For an empty cell,
however, the entered text string "Cell is empty!" is returned instead.

See also:

ISBLANK, IFERROR, IFNA

IFERROR (return a value upon encountering error)

Syntax:

IFERROR(Value, ValueIfError)

Description:

Normally returns Value. However, if Value contains any type of error value, the defined ValueIfError is
returned instead.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced by their last result as a fixed value.
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Accordingly, if you use this function, you should not save your document in the "Microsoft Excel 97-2003
(.xls)" file format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

IFERROR(A1, "Error!") returns the value in cell A1, as long as A1 doesn't contain an error value. If it does, the
text string "Error!" is returned instead.

See also:

IFNA, ISERR, ISERROR, ISNA, ERROR.TYPE, section Error values

IFNA (return defined value for #N/A)

Syntax:

IFNA(Cell, Value)

Description:

Normally returns the content of the Cell. However, if this cell is #N/A, the defined Value is returned instead.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

IFNA(A1, "not found!") returns the value in cell A1, as long as A1 doesn't contain the error value #N/A. If it
does contain the error value #N/A, the text string "not found!" is returned instead.

See also:

IFERROR, ISERR, ISERROR, ISNA, ERROR.TYPE, section Error values
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IMABS (absolute value of a complex number)

Syntax:

IMABS(ComplexNumber)

Description:

Returns the absolute value (modulus) of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMABS("2+4i") returns 4.47214

See also:

COMPLEX, IMARGUMENT, IMEXP, IMCONJUGATE

IMAGINARY (imaginary coefficient of a complex number)

Syntax:

IMAGINARY(ComplexNumber)

Description:

Returns the imaginary coefficient of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMAGINARY("2+4i") returns 4

See also:

COMPLEX, IMREAL
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IMARGUMENT (angle of a complex number)

Syntax:

IMARGUMENT(ComplexNumber)

Description:

Returns the angle (in radians) from the real axis to the representation of a complex number in polar coordinates.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMARGUMENT("2+4i") returns 1.10715

See also:

COMPLEX, IMABS, IMEXP, IMCONJUGATE

IMCONJUGATE (conjugate a complex number)

Syntax:

IMCONJUGATE(ComplexNumber)

Description:

Returns the complex conjugate of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMCONJUGATE("2+4i") returns 2-4i

See also:

COMPLEX, IMABS, IMARGUMENT, IMEXP
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IMCOS (cosine of a complex number)

Syntax:

IMCOS(ComplexNumber)

Description:

Returns the cosine of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMCOS("2+4i") returns -11.3642347064011 - 24.8146514856342i

See also:

COMPLEX, IMSIN

IMDIV (division of complex numbers)

Syntax:

IMDIV(ComplexNumber1, ComplexNumber2)

Description:

Returns the quotient of two complex numbers, i.e., divides ComplexNumber1 by ComplexNumber2.

ComplexNumber1 and ComplexNumber2 must be complex numbers in x+yi or x+yj format. Tip: Complex
numbers can be created with the COMPLEX function.

Example:

IMDIV("4+12i", "2+4i") returns 2.8+0.4i

See also:

COMPLEX, IMPRODUCT, IMSUB, IMSUM
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IMEXP (exponential of a complex number)

Syntax:

IMEXP(ComplexNumber)

Description:

Returns the exponential of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMEXP("2+4i") returns -4.82980938326939 - 5.59205609364098i

See also:

COMPLEX, IMABS, IMARGUMENT, IMCONJUGATE, IMLN

IMLN (natural logarithm of a complex number)

Syntax:

IMLN(ComplexNumber)

Description:

Returns the natural logarithm (base e) of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLN("2+4i") returns 1.497866136777 + 1.10714871779409i

See also:

COMPLEX, IMEXP, IMLOG10, IMLOG2
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IMLOG10 (base-10 logarithm of a complex number)

Syntax:

IMLOG10(ComplexNumber)

Description:

Returns the base-10 logarithm of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLOG10("2+4i") returns 0.650514997831991 + 0.480828578784234i

See also:

COMPLEX, IMLN, IMLOG2

IMLOG2 (base-2 logarithm of a complex number)

Syntax:

IMLOG2(ComplexNumber)

Description:

Returns the base-2 logarithm of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMLOG2("2+4i") returns 2.16096404744368 + 1.59727796468811i

See also:

COMPLEX, IMLN, IMLOG10
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IMNEG (negative value of a complex number)

Syntax:

IMNEG(ComplexNumber)

Description:

Returns the negative of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMNEG("2+4i") returns -2-4i

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Tip: As an alternative to IMNEG(A1) the following calculation can be used:

COMPLEX(-IMREAL(A1), -IMAGINARY(A1))

See also:

COMPLEX

IMPOWER (power of a complex number)

Syntax:

IMPOWER(ComplexNumber, Exponent)

Description:

Returns a complex number raised to a power.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.
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Example:

IMPOWER("2+4i", 2) returns -12+16i

See also:

COMPLEX, IMSQRT

IMPRODUCT (product of complex numbers)

Syntax:

IMPRODUCT(ComplexNum1 [, ComplexNum2, ComplexNum3 ...])

Description:

Returns the product of the given complex numbers.

ComplexNumber1 and ComplexNumber2 must be complex numbers in x+yi or x+yj format. Tip: Complex
numbers can be created with the COMPLEX function.

Example:

IMPRODUCT("2+4i", "1+2i") returns -6+8i

See also:

COMPLEX, IMDIV, IMSUB, IMSUM

IMREAL (real coefficient of a complex number)

Syntax:

IMREAL(ComplexNumber)

Description:

Returns the real coefficient of a complex number.
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ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMREAL("2+4i") returns 2

See also:

COMPLEX, IMAGINARY

IMSIN (sine of a complex number)

Syntax:

IMSIN(ComplexNumber)

Description:

Returns the sine of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMSIN("2+4i") returns 24.8313058489464 - 11.3566127112182i

See also:

COMPLEX, IMCOS

IMSQRT (square root of a complex number)

Syntax:

IMSQRT(ComplexNumber)
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Description:

Returns the square root of a complex number.

ComplexNumber must be a complex number in x+yi or x+yj format. Tip: Complex numbers can be created
with the COMPLEX function.

Example:

IMSQRT("2+4i") returns 1.79890743994787 + 1.11178594050284i

See also:

COMPLEX, IMPOWER

IMSUB (difference of complex numbers)

Syntax:

IMSUB(ComplexNumber1, ComplexNumber2)

Description:

Returns the difference of two complex numbers, i.e., subtracts ComplexNumber2 from ComplexNumber1.

ComplexNumber1 and ComplexNumber2 must be complex numbers in x+yi or x+yj format. Tip: Complex
numbers can be created with the COMPLEX function.

Example:

IMSUB("2+4i", "1+2i") returns 1+2i

See also:

COMPLEX, IMDIV, IMPRODUKT, IMSUM
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IMSUM (sum of complex numbers)

Syntax:

IMSUM(ComplexNum1 [, ComplexNum2, ComplexNum3 ...])

Description:

Returns the sum of the given complex numbers.

ComplexNumber1 and ComplexNumber2 must be complex numbers in x+yi or x+yj format. Tip: Complex
numbers can be created with the COMPLEX function.

Example:

IMSUM("2+4i", "1+2i") returns 3+6i

See also:

COMPLEX, IMDIV, IMPRODUKT, IMSUB

INDEX (cell in a particular row/column of a range)

Syntax:

INDEX(Range, Row, Column [, PartRange])

Description:

Returns a reference to the cell at the intersection of the specified Row and Column in Range.

Range is the cell range from which to return a reference.

Row is the relative number of the row in Range and Column is the relative number of the column in Range
(starting from the upper left corner of Range).

If Row or Column refers to a cell outside Range, a #REF! error value is returned.

The optional argument PartRange is just a placeholder (for compatibility with Microsoft Excel). It will not be
evaluated.
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Compatibility notes:

This function is not fully identical to Microsoft Excel's INDEX function. The following restrictions apply:

The argument Range must consist of exactly one contiguous cell range. Nonadjacent ranges are not supported.

The optional argument PartRange is ignored.

Example:

INDEX(B2:D4, 2, 2) returns a reference to cell C3

See also:

MATCH, VLOOKUP, HLOOKUP, LOOKUP, AREAS, CHOOSE

INDIRECT (create reference from text)

Syntax:

INDIRECT(Text [, Mode])

Description:

Returns a cell reference from the specified text string.

For example, the specified Text can contain a fixed cell address (e.g. "C1") or variable references that are
combined from the contents of one or more cells.

The optional argument Mode specifies the format of the cell address to be evaluated:

TRUE or not specified: Normal cell address in A1 style (columns are labeled alphabetically and rows
numerically)

FALSE: Cell address in the R1C1 style (columns and rows are labeled numerically; an alternative way of cell
addressing supported only by Microsoft Excel)

Some examples:

If cell C1 contains the text string Flower
INDIRECT("C1") returns a reference to cell C1 and the result: Flower

If cell C1 contains the text string E5
and cell E5 the text string Flower
INDIRECT(C1) returns a reference to cell E5 and the result: Flower

If cell C1 contains the text string E
and cell C2 the text string 5
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and cell E5 the text string Flower
INDIRECT(C1&C2) returns a reference to cell E5 and the result: Flower

If cell E5 contains the text string Flower
INDIRECT("E"&5") returns a reference to cell E5 and the result: Flower

If cell C1 contains the text string 5
and E5 the text string Flower
INDIRECT("E"&C1) returns a reference to cell E5 and the result: Flower

See also:

ADDRESS, OFFSET, COLUMN, ROW

INT (round down to nearest integer)

Syntax:

INT(Number)

Description:

Rounds Number down to the nearest integer.

Note:

When applying this function to negative numbers, note the difference between this function and other round
functions such as ROUNDDOWN:

ROUNDDOWN(-1.234, 0) returns -1, because here the amount of number is rounded down to the next smaller
integer.

INT(-1.234) results in -2, since here the negative number itself is rounded down to the next smaller integer.

Example:

INT(5.9) returns 5

INT(-5.1) returns -6

See also:

TRUNC, ROUNDDOWN, ROUNDUP, ROUND, MROUND, FIXED, EVEN, ODD, CEILING, FLOOR
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INTERCEPT (intercept point of a regression line)

Syntax:

INTERCEPT(y_values, x_values)

Description:

Returns the y coordinate of the point where a best-fit line based on the given values intersects the y axis.

A best-fit line is the result of a linear regression. This is a statistical technique that adapts a line to a set of data
points (for example, the results of a series of measurements).

With the INTERCEPT function, you can predict what y (the dependent variable) will be approximately when x
(the independent variable) is zero.

This function can be used to predict, for example, the resistance of a temperature-sensitive resistor at 0° after
having measured the resistance at several other temperatures.

For the y_values and x_values arguments, you usually specify a cell range.

y_values are the known y values (e.g., the resistance).

x_values are the known x values (e.g., the temperature).

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Annotation:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-sensitive resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures measured: 8, 20, 25, 28

Cells B1:B4 contain the resistances measured: 261, 508, 608, 680

With the following formula you can estimate which resistance will be delivered at 0°C:

INTERCEPT(B1:B4, A1:A4) equals 93.69817

So at 0° a resistance of 93.69817 (Ohm) would be expected.
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Annotation:

INTERCEPT(y_values, x_values) equals FORECAST(0, y_values, x_values).

See also:

FORECAST, SKEW, SLOPE, STEYX, PEARSON

INTERSECTION (intersection of two ranges)

Syntax:

INTERSECTION(Range1, Range2)

Description:

Returns a reference to the intersection of Range1 and Range2 (i.e. the cell range where Range1 and Range2
overlap).

Annotation:

Alternatively, you can use the spacebar operator to obtain the intersection of two ranges. For example:

SUM(INTERSECTION(A1:D4, C3:E6))

is identical to:

SUM(A1:D4 C3:E6).

Compatibility notes:

This function is not supported by Microsoft Excel. When you save a document in Excel format, PlanMaker will
automatically replace all occurrences of this function by spacebar operators (see annotation above).

Example:

INTERSECTION(A1:D4, C3:E6) returns a reference to the range C3:D4
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IPMT (interest payment)

Syntax:

IPMT(Rate, Per, NPer, PV [, FV] [, Type])

Description:

Returns the interest due in the specified period, based on an investment with periodic constant payments, and a
constant interest rate.

You can use this function, for example, to calculate how large the interest portion of the annuity is in a
particular period for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period).

Per is the payment period to be evaluated.

NPer is the total number of payment periods.

PV is the present value.

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%

Payments: monthly

Duration: 6 years

What is the interest portion of the payment (annuity) in month 32?

IPMT(10%/12, 32, 72, 100000) returns -534

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Therefore, in the above formula, the yearly interest rate had to be divided by 12 to get the monthly interest rate.
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Annotation:

The PPMT function is the counterpart to IPMT: It supplies the principle portion of the payment in this period.

The PMT function, on the other hand, returns the total amount of the payment (annuity) per period, that is, the
sum of the principal portion and the interest portion.

See also:

PV, ISPMT, PPMT, CUMPRINC, CUMIPMT, PMT, RATE, FV, NPER

IRR (internal rate of return)

Syntax:

IRR(Values [, Guess])

Description:

Returns an estimate for the internal rate of return for a series of cash flows. In contrast to the MIRR function,
no finance or reinvestment rates are taken into account.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, income as positive values. The cash flows do not have to be even but they must occur in
regular intervals (e.g., monthly).

The function expects the following arguments:

Values is a cell range or array containing the cash flows. At least one payment and one income have to be
given.

Guess (optional) lets you specify an estimate for the result (see note below).

Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try altering the Guess parameter.

See also:

MIRR, XIRR, RATE, NPV
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ISBLANK (is empty?)

Syntax:

ISBLANK(Reference)

Description:

Returns TRUE if the specified cell is empty.

Example:

If A1 contains any kind of value, C7 is empty:

ISBLANK(A1) returns FALSE

ISBLANK(C7) returns TRUE

See also:

ISNA, IFEMPTY, COUNT, COUNTA

ISERR (is an error value other than #N/A?)

Syntax:

ISERR(Reference)

Description:

Unlike the ISERROR function, ISERR only returns TRUE if the specified cell contains any kind of error value
except #N/A.

Example:

ISERR(A1) returns TRUE if A1 contains any kind of error value except #NA.

ISERR(A1) returns FALSE if A1 contains the error value #N/A or any kind of value that is not leading to an
error value.
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See also:

ISERROR, ISNA, NA(), ERRORTYPE, IFERROR, section Error values

ISERROR (is an error value?)

Syntax:

ISERROR(Reference)

Description:

Returns TRUE if the specified cell contains any kind of error value.

Example:

ISERROR(A1) returns TRUE if A1 contains any kind of error value.

See also:

ISERR, ISNA, NA(), ERRORTYPE, ISREF, IFERROR, section Error values

ISEVEN (is an even number?)

Syntax:

ISEVEN(Number)

Description:

Returns TRUE if the specified Number is even, FALSE if it is odd.

Note:

Number should be an integer. Digits right of the decimal point are ignored.

Example:

ISEVEN(2) returns TRUE
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ISEVEN(2.75) returns TRUE

ISEVEN(3) returns FALSE

ISEVEN(3.75) returns FALSE

See also:

ISODD

ISFORMULA (is a formula?)

Syntax:

ISFORMULA(Reference)

Description:

Returns TRUE if the specified cell contains a formula.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

If A1 contains a formula, and C7 contains a fixed number or text string, then:

ISFORMULA(A1) returns TRUE

ISFORMULA(C7) returns FALSE

See also:

ISREF, FORMULATEXT

ISLOGICAL (is a logical value?)

Syntax:

ISLOGICAL(Reference)
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Description:

Returns TRUE if the specified cell contains a logical value (i.e., TRUE or FALSE).

Example:

If A1 contains TRUE, and C7 contains a text string, then:

ISLOGICAL(A1) returns TRUE

ISLOGICAL(C7) returns FALSE

See also:

ISTEXT, ISNUMBER, ISREF, ISNONTEXT

ISNA (is not available?)

Syntax:

ISNA(Reference)

Description:

Returns TRUE if the specified cell contains a #N/A error value.

Cells contain a #N/A error value if they contain the formula =NA(), or a calculation resulting in a #N/A error.

More details about the usage of #N/A error values can be found in section NA (error value #N/A).

Example:

The function NV() was entered in cell A1 to indicate that a value is not yet available that is absolutely
necessary for another calculation.

Cell C7 performs a calculation with cell A1, for example A1*2. But since cell A1 returns the error value #N/A,
the result of this calculation is also the error value #N/A.

Therefore, the following applies:

ISNA(A1) returns TRUE

ISNA(C7) also returns TRUE

See also:

NA(), ERROR.TYPE, ISERR, ISERROR, IFERROR, IFNA, section Error values
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ISNONTEXT (is no text?)

Syntax:

ISNONTEXT(Value)

Description:

Returns TRUE if the specified value is not text.

Example:

If A1 contains a text string, C7 contains a number, then:

ISNONTEXT(A1) returns FALSE

ISNONTEXT(C7) returns TRUE

Note:

ISTEXT is the counterpart of this function: It returns TRUE if the cell contains a text string.

See also:

ISTEXT, ISLOGICAL, ISNUMBER

ISNUMBER (is numeric?)

Syntax:

ISNUMBER(Value)

Description:

Returns TRUE if the specified value is a number.

Dates are considered as numbers as well, whereas logical values are not.

Example:

If the cells A1 to A4 contain the values:
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"Text", 42, 09/25/2018 and TRUE

The following applies:

ISNUMBER(A1) returns FALSE

ISNUMBER(A2) returns TRUE

ISNUMBER(A3) returns TRUE

ISNUMBER(A4) returns FALSE

See also:

ISNUMBERP, ISLOGICAL, ISTEXT, ISNONTEXT, ISREF, COUNT

ISNUMBERP (PlanMaker 97 compatibility function)

Syntax:

ISNUMBERP(Value)

Description:

Returns TRUE if the specified value is a number or a logical value.

Dates are considered as numbers as well.

Note:

This function was retained only for compatibility with PlanMaker 97. Using the Excel-compatible function
ISNUMBER (without "P") is recommended instead.

The difference:

ISNUMBERP treats logical values as numbers, whereas ISNUMBER does not.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

If the cells A1 to A4 contain the values:

"Text", 42, 09/25/2018 and TRUE

The following applies:
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ISNUMBERP(A1) returns FALSE

ISNUMBERP(A2) returns TRUE

ISNUMBERP(A3) returns TRUE

ISNUMBERP(A4) returns TRUE (!)

For comparison: ISNUMBER(A4) returns FALSE

See also:

ISNUMBER

ISODD (is an odd number?)

Syntax:

ISODD(Number)

Description:

Returns TRUE if the specified Number is odd, FALSE if it is even.

Note:

Number should be an integer, digits right of the decimal point are ignored.

Example:

ISODD(1) returns TRUE

ISODD(1.75) returns TRUE

ISODD(2) returns FALSE

ISODD(2.75) returns FALSE

See also:

ISEVEN
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ISOWEEK (ISO week number)

Syntax:

ISOWEEK(Date [, ReturnYear])

Description:

Returns the ISO week number of a date (i.e. the week number according to the ISO 8601 standard).

Unlike the WEEKNUM function, this function does not use the calculation method commonly used in the USA
and many other parts of the world. Rather, it is based on the ISO standard 8601, which is binding in Germany,
Austria and Switzerland, among others. It specifies the following:

1. Weeks start on Monday (not Sunday).

2. The first week of a year is defined as the week that contains January 4th.

Note:

This may lead to situations where December 29, 30 and 31 are considered part of the first week of the next year
– or where January 1, 2 and 3 are considered part of the last week of the previous year.

For this reason, ISOWEEK has an additional parameter named ReturnYear which leads to the following
results:

If set to 0 or omitted, the function returns the week number.

If set to 1, the function instead returns the year to which the date belongs to (according to the ISO 8601
standard). See examples below.

Example:

ISOWEEK("01/01/2020") returns 1.

ISOWEEK("01/01/2017") returns 52 (since this day was a Sunday).

ISOWEEK("01/01/2017", 1) accordingly returns 2016 – not 2017.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Tip: There's an Excel-compatible alternative to this function: the ISOWEEKNUM function. It returns exactly
the same results, but does not have the optional parameter for displaying the year.
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See also:

ISOWEEKNUM, WEEKNUM, YEAR, MONTH, DAY, WEEKDAY

ISOWEEKNUM (ISO week number)

Syntax:

ISOWEEKNUM(Date)

Description:

Returns the ISO week number of a date (i.e. the week number according to the ISO 8601 standard).

Unlike the WEEKNUM function, this function does not use the calculation method commonly used in the USA
and many other parts of the world. Rather, it is based on the ISO standard 8601, which is binding in Germany,
Austria and Switzerland, among others. It specifies the following:

1. Weeks start on Monday (not Sunday).

2. The first week of a year is defined as the week that contains January 4th.

Note:

This may lead to situations where December 29, 30 and 31 are considered part of the first week of the next year
– or where January 1, 2 and 3 are considered part of the last week of the previous year. See examples below.

Tip: For this reason, PlanMaker provides an alternative (not Excel-compatible) function called ISOWEEK. This
returns exactly the same results, but can optionally return the year to which the date belongs to (according to
the ISO 8601 standard).

Example:

ISOWEEKNUM("01/01/2020") returns 1.

ISOWEEKNUM("01/01/2017") returns 52 (since this day was a Sunday).

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

ISOWEEK, WEEKNUM, YEAR, MONTH, DAY, WEEKDAY
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ISPMT (interest payment)

Syntax:

ISPMT(Rate, Per, NPer, PV)

Description:

Returns the interest due in the specified period of an investment.

The function expects the following arguments:

Rate is the interest rate (per payment period).

Per is the payment period to be evaluated.

NPer is the total number of payment periods.

PV is the present value.

See also:

PPMT, PMT, IPMT

ISREF (is a valid reference?)

Syntax:

ISREF(Reference)

Description:

Returns TRUE if the specified value is a valid reference.

Example:

ISREF(A1) returns TRUE

ISREF($A$1) returns TRUE

ISREF(A1:C7) returns TRUE

ISREF("some text") returns FALSE
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ISREF(FirstQuarter) returns FALSE, as long as the name "FirstQuarter" does not exist. As soon as you assign
the name "FirstQuarter" to a range of cells, the calculation will return TRUE.

See also:

ISFORMULA, ISERROR, ISLOGICAL, ISNUMBER, ISTEXT

ISTEXT (is text?)

Syntax:

ISTEXT(Value)

Description:

Returns TRUE if the specified value is text.

Example:

If A1 contains a text string, C7 contains a number, then:

ISTEXT(A1) returns TRUE

ISTEXT(C7) returns FALSE

Note:

ISNONTEXT is the counterpart of this function: It returns TRUE if there is no text string in the cell.

See also:

ISNONTEXT, ISLOGICAL, ISNUMBER, ISREF

KURT (kurtosis)

Syntax:

KURT(Number1, Number2, Number3, Number4 [, Number5 ...])

or

KURT(Range1 [, Range2, Range3 ...])
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Description:

Returns the kurtosis of a probability distribution.

The Kurtosis is a measure of the "peakedness" of a distribution compared a normal distribution.

For a steeper arched ("narrow-peaked") distribution the kurtosis is a positive value, for a flatter arched ("broad-
peaked") curve a negative value.

If the Kurtosis approaches zero, the distribution has a good approximation to a normal distribution (see
NORM.DIST/NORMDIST function)

Number1, Number2, Number3, etc. are the values to be evaluated. Empty cells, text and logical values are
ignored.

At least four values have to be given, otherwise, the function returns a #DIV/0! error value. (Division by zero.)

Note:

This function does not accept value pairs (x value and y value) as arguments, but only the values of the
distribution. If the same values appear multiple times, they must be repeated in the argument list accordingly
(see example).

Example:

Measuring the height of several test persons led to the following results: 1 x 1.60m, 2 x 1.65m, 4 x 1.70m, 2 x
1.75m and 1x1.80m.

To calculate the Kurtosis of this distribution, the following formula can be used:

KURT(1.60, 1.65, 1.65, 1.70, 1.70, 1.70, 1.70, 1.75, 1.75, 1.80) returns 0.08036.

See also:

SKEW, NORM.DIST/NORMDIST

LARGE (k-th largest number)

Syntax:

LARGE(Range, k)

Description:

Returns the k-th largest value in a data set. If k=1, the largest value will be returned, if k=2, the second largest
value will be returned, etc.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.



651Formulas and functions

k determines which number to return.

k must not be smaller than 1 or greater than the total number of values in Range. Otherwise, the function
returns a #NUM! error value.

Example:

If the cells A1:A5 are filled with the numbers 4, 2, 6, 5 and 9:

LARGE(A1:A5, 1) returns 9

LARGE(A1:A5, 2) returns 6

LARGE(A1:A5, 3) returns 5

etc.

See also:

SMALL, MAX, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, RANK.EQ/RANK.AVG/RANK

LASTPRINTED (date last printed)

Syntax:

LASTPRINTED()

Description:

Returns the date the current document was last printed.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

LASTSAVED
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LASTSAVED (date last saved)

Syntax:

LASTSAVED()

Description:

Returns the date the current document was last saved.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

LASTPRINTED

LCM (least common multiple)

Syntax:

LCM(Number1 [, Number2, Number3 ...])

Description:

Returns the LCM (least common multiple) of the specified integers. The LCM is the smallest positive integer
that is a multiple of the given integers.

You can specify numbers or cell references as arguments.

Number1, Number2
should be integers. Digits to the right of the decimal point are ignored.

Example:

LCM(5, 10, 15) returns 30

If cells A1 to A3 contain the values 4, 8 and 6:

LCM(A1:A3) returns 24
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See also:

GCD

LEN (length)

Syntax:

LEN(Value)

Description:

Returns the number of characters in a text string.

If the specified value is a number, a date or a logical value, it will be converted to a string automatically.

Note: For dates, the serial date number is converted to a string, not the formatted date itself (see last example).

Example:

LEN("Text") returns 4

LEN(42) returns 2

LEN(-42) returns 3

LEN(42.5) returns 4

LEN(42,50) also equals 4 (the superfluous zero is automatically removed!)

LEN(TRUE) returns 4

Please note when specifying dates: If cell A1 contains the date 09/25/2014 in any format, the following applies:

LEN(A1) returns 5

Reason: Date values are always stored as numbers in a spreadsheet – the date 09/25/2014, for example, as
41907. Thus, the result of the calculation is unexpected, but completely correct – because:

LEN(41907) also returns 5

See also:

LEFT, RIGHT, MID
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LEFT (left part of a text string)

Syntax:

LEFT(Text [, n])

Description:

Returns the first n characters of Text.

If n is omitted, only the first character is returned.

Example:

LEFT("peanut", 3) returns pea

LEFT("peanut") returns p

See also:

RIGHT, MID, REPLACE, LEN

LINEST (statistics of a linear regression)

Syntax:

LINEST(y_values [, x_values] [, Constant] [, Stats])

Description:

Returns statistics of a linear regression.

Linear regression is a statistical technique that adapts a line (called "trendline" or "best-fit line") to a set of data
points (for example, the results of a series of measurements).

The equation for trendlines is:

y = m*x + b

The LINEST function calculates a trendline from the given y values and x values, and then returns an array in
the form {m,b}. The coefficient m is the slope of the trendline, the constant b is the y-intercept point (the point
where the trendline intersects the y axis).

If more than one range of x-values is given, the equation is:
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y = (m1*x1) + (m2*x2) + ... + (mn*xn) + b

In this case, LINEST returns an array in the form {mn, mn-1, ... , m2, m1, b}.

Additionally, if the optional argument Stats is used, several statistics of the regression (standard error,
coefficient of determination, etc.) are appended to the resulting array.

The LINEST function expects the following arguments:

y_values: Here you specify the existing y-coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.

x_values: Here you can optionally specify the x-coordinates, that is, the independent values. Also x_values can
be either a cell reference or an array. If x_values are omitted, the values 1, 2, 3, ... will be used automatically.
(according to the number of existing y_values).

Constant (optional) is a logical value that lets you specify if the constant b (the y-intercept point) should be
calculated automatically or forced to equal zero:

TRUE or omitted: b will be calculated from the given data.

FALSE: b is forced to equal 0 (zero). This forces the trendline to run through the zero point. The m
coefficient(s) are adjusted accordingly.

Stats (optional) is a logical value that lets you specify if additional regression statistics should be returned:

FALSE or omitted: Do not return additional statistics.

TRUE: Return additional regression statistics. In this case, a matrix in the following form will be returned:

{mn, mn-1, ... , m2, m1, b; smn, smn-1, ... , sm2, sm1, sb; R2, sey; F. df; ssreg, ssresid}

A graphical representation of this array would look like this:

The abbreviations used in this illustration represent the following values:

Abbreviation Explanation

sm1, sm2, etc. Standard error for the coefficients m1, m2, etc.

sb Standard error for constant b

R2 Square of the Pearson product moment correlation coefficient

sey Standard error for y
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F F statistic

df Degrees of freedom

ssreg Regression sum of squares

ssresid Residual sum of squares

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Annotation:

The linear regression is performed with this function using the least squares method.

Example:

LINEST({4; 5; 6}) provides the matrix {1.3}. This indicates that the coefficient m equals 1 and the constant b
equals 3. (Since the x-values were not specified, the LINES function automatically uses the values 1, 2, 3, ...)

See also:

LOGEST, TREND, GROWTH

LN (natural logarithm)

Syntax:

LN(Number)

Description:

Returns the natural logarithm (base e) of Number.

Number must be > 0.

Example:

LN(0.7) returns -0.3567

LN(EXP(1.234)) returns 1.234
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Annotation:

The inverse function is EXP

See also:

EXP, LOG, LOG10, POWER

LOG (logarithm)

Syntax:

LOG(Number [, Base])

Description:

Returns the logarithm of Number to the specified base.

Number must be > 0.

If Base is omitted, base 10 is used.

Example:

LOG(100) equals log10 (100) and returns 2

LOG(10 ^ 0.1234) returns 0.1234

LOG(8, 2) equals log2 (8) and returns 3

See also:

LOG10, LN, EXP, POWER

LOG10 (base-10 logarithm)

Syntax:

LOG10(Number)
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Description:

Returns the base-10 logarithm of Number.

Number must be > 0.

Example:

LOG10(100) returns 2

LOG10(10 ^ 0.1234) returns 0.1234

See also:

LOG, LN, EXP

LOGEST (statistics of an exponential regression)

Syntax:

LOGEST(y_values [, x_values] [, Constant] [, Stats])

Description:

Returns statistics of an exponential regression.

Exponential regression is a statistical technique that adapts an exponential curve to a set of data points (for
example, the results of a series of measurements).

The equation for this exponential curve is:

y = b*m^x

If more than one range of x-values is given, the equation is:

y = b * (m1^x1) * (m2^x2) * ... * (mn^xn)

The LOGEST function calculates this exponential line from the given y values and x values, and then returns an
array in the form {mn, mn-1, ... , m2, m1, b}.

Additionally, if the optional argument Stats is used, several statistics of the regression (standard error,
coefficient of determination, etc.) are appended to the resulting array.

The RKP function expects the following arguments:

y_values: Here you specify the existing y-coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.
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x_values: Here you can optionally specify the x-coordinates, that is, the independent values. Also x_values can
be either a cell reference or an array. If x_values are omitted, the values 1, 2, 3, ... will be used automatically.
(according to the number of existing y_values).

Constant (optional) is a logical value that lets you specify if the constant b should be calculated automatically
or forced to equal 1 (one):

TRUE or omitted: b will be calculated from the given data.

FALSE: b is forced to equal 1 (one). The m coefficients are adjusted accordingly.

Stats (optional) is a logical value that lets you specify if additional regression statistics should be returned:

FALSE or omitted: Do not return additional statistics.

TRUE: Return additional regression statistics. In this case, a matrix in the following form will be returned:

{mn, mn-1, ... , m2, m1, b; smn, smn-1, ... , sm2, sm1, sb; R2, sey; F. df; ssreg, ssresid}

A graphical representation of this array would look like this:

The abbreviations used in this illustration represent the following values:

Abbreviation Explanation

sm1, sm2, etc. Standard error for the coefficients m1, m2, etc.

sb Standard error for constant b

R2 Square of the Pearson product moment correlation coefficient

sey Standard error for y

F F statistic

df Degrees of freedom

ssreg Regression sum of squares

ssresid Residual sum of squares
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Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

See also:

LINEST, TREND, GROWTH

LOGINV (percentiles of the lognormal distribution)

Note: LOGINV is supplemented by the new identical function LOGNORM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

LOGINV(Probability, Mean, StdDev)

Description:

Returns the inverse of the log-normal distribution function (i.e., percentiles of this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). Must be > 0.

See also:

LOGNORM.INV, LN, LOGNORM.DIST/LOGNORMDIST, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST

LOGNORMDIST (lognormal distribution)

Note: LOGNORMDIST is supplemented by the new function LOGNORM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).
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Syntax:

LOGNORMDIST(x, Mean, StdDev)

Description:

Returns the probabilities of a cumulative log-normal distributed random number.

With this function you can view probability distributions in which not the random number itself but its natural
logarithm is normally distributed.

x is the value to be evaluated. Must be > 0.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). Must be > 0.

See also:

LOGNORM.DIST, LN, LOGNORM.INV/LOGINV, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST

LOGNORM.DIST (lognormal distribution)

Syntax:

LOGNORM.DIST(x, Mean, StdDev, Cumulative)

Description:

Returns the probabilities of a (cumulative) log-normal distributed random number.

With this function you can view probability distributions in which not the random number itself but its natural
logarithm is normally distributed.

x is the value to be evaluated. Must be > 0.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). Must be > 0.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative normal
distribution function is calculated. By entering the value FALSE, the normal probability density function is
calculated.
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Note:

The LOGNORM.DIST function supplements the previous LOGNORMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

The inverse function is LOGNORM.INV

See also:

LOGNORMDIST, LN, LOGNORM.INV/LOGINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

LOGNORM.INV (percentiles of the lognormal distribution)

Syntax:

LOGNORM.INV(Probability, Mean, StdDev)

Description:

Returns the inverse of the log-normal distribution function (i.e., percentiles of this distribution).

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x). Must be > 0.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

LOGNORM.INV is the inverse function of LOGNORM.DIST

See also:

LOGINV, LN, LOGNORM.DIST/LOGNORMDIST, NORM.DIST/NORMDIST,
NORM.S.DIST/NORMSDIST
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LOOKUP (search cell range)

Annotation:

The LOOKUP function scans a cell range for the specified value and then returns another cell located at a
matching position (e.g., in the same row, but a different column).

Important: The data to be searched in has to be sorted in ascending order. Tip: There are two alternatives to
this function that can also search unsorted data and are more flexible in general: VLOOKUP and HLOOKUP

The LOOKUP function can be used in two different ways:

Usage with two one-dimensional ranges: Here, two vectors (i.e., one-dimensional ranges) are specified for
the function: Lookup Vector and ResultVector. If the function finds the search criterion in the Lookup Vector,
it returns the cell with the same position in the Result Vector as the result.

Usage with one two-dimensional range: Here, a two-dimensional range is specified for the function. If it finds
the search criterion in the first row (or column) of this range, it returns the cell with the same position in the last
row (or column) of this range as the result.

Usage with two one-dimensional ranges

Syntax:

LOOKUP(Crit, LookupVector, ResultVector)

Description:

This variant of LOOKUP scans LookupVector for the specified value in Crit. If found, the function returns the
content of the cell located in the same row (or column) of the ResultVector.

Crit is the value to be searched for. The search is case insensitive.

Lookup Vector is the cell range or array to search in. This can contain text strings, numbers or logical values.
It must be a vector, which is a range of either just one row or one column.

Important: The data in LookupVector must be sorted in ascending order. Otherwise this function might return
wrong results. If the values are not sorted, use VLOOKUP or HLOOKUP instead of LOOKUP.

ResultVector is the cell range or array with the values to pick the result from. It also has to be a vector.
Additionally, its size and its orientation (horizontal or vertical) must be identical to LookupVector.

Note:

If LOOKUP does not find a value that exactly matches the Crit, the next lower value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the error
value #N/A.
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Example:

In the following table ...

... LOOKUP returns the following results:

LOOKUP(1, A1:A3, B1:B3) returns Result_1

LOOKUP(2, A1:A3, B1:B3) returns Result_2

LOOKUP(3, A1:A3, B1:B3) returns Result_3

LOOKUP(2.5, A1:A3, B1:B3) returns Result_2 (because it is the next smallest value)

LOOKUP(10, A1:A3, B1:B3) returns Result_3 (because it is the next smallest value)

LOOKUP(0, A1:A3, B1:B3) returns #N/A

See also:

VLOOKUP, HLOOKUP, INDEX, MATCH

Usage with one two-dimensional range

Syntax:

LOOKUP(Crit, Range)

Description:

This variant of LOOKUP scans the first column (or row) of Range for the specified value in Crit. If found, the
function returns the content of the cell located at the same position in the last column (or row, respectively) of
Range.

Alternatively, this function can also search the range column by column. The search direction is determined by
the dimensions of the Range:

If Range contains more columns than rows, the function searches the first row and returns the value from the
last row.

If Range contains more rows than columns or is square, the function searches the first column and returns the
value from the last column.

Crit is the value to be searched for. The search is case insensitive.
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Range is the cell range or array to search in. It must contain in the first row (or column) the values to be
searched and in the last row (or column) the results to be returned. These can be text strings, numbers or logical
values. The range must be two-dimensional, that is, it must have at least two rows and two columns.

Important: The scanned data in the first row (or column) must be sorted in ascending order. Otherwise this
function might return wrong results. If the values are not sorted, use VLOOKUP or HLOOKUP instead of
LOOKUP.

Note:

If LOOKUP does not find a value that exactly matches the Crit, the next lower value is automatically taken.

If no smaller value exists because Crit is smaller than the smallest value available, the function returns the error
value #N/A.

Example:

In the following table ...

... LOOKUP returns the following results:

LOOKUP(1, A1:B3) returns Result_1

LOOKUP(2, A1:B3) returns Result_2

LOOKUP(3, A1:B3) returns Result_3

LOOKUP(2.5, A1:B3) returns Result_2 (because it is the next smallest value)

LOOKUP(10, A1:B3) returns Result_3 (because it is the next smallest value)

LOOKUP(0, A1:B3) returns #N/A

See also:

VLOOKUP, HLOOKUP, INDEX, MATCH
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LOWER (convert text to lower case)

Syntax:

LOWER(Text)

Description:

Converts all characters in a text string to lower case letters.

Example:

LOWER("PlanMaker") returns planmaker

See also:

UPPER, PROPER

MATCH (relative position in a range)

Syntax:

MATCH(Crit, Vector [, Mode])

Description:

Returns the relative position of Crit in Vector. For example, if Crit is the third element of Vector, the function
returns 3.

Crit is the value to be searched for. This can be any kind of value or a cell reference.

Vector is the cell range or array to be evaluated. This can contain either text strings, numbers or logical values.
Vector must be a vector, which is an array or a cell range of either just one row or one column.

Mode specifies the type of search to be performed:

1 or omitted: Find the largest value that is equal to or smaller than Crit. Important: In this mode, the elements
in Vector have to be sorted in ascending order. Otherwise, erroneous results might be returned.

0: Find the first value that is equal to Crit. In this mode, the elements in Vector do not have to be in sorted
order.
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-1: Find the smallest value that is equal to or larger than Crit. Important: In this mode, the elements in Vector
have to be sorted in descending order. Otherwise, erroneous results might be returned.

Tipp: If you use Mode 0 and you search for a text string, wildcard characters can be used in Crit: A question
mark (?) stands for any single character, an asterisk (*) stands for any sequence of characters.

Example:

MATCH("b", {"a";"b";"c";"d"}, 0) returns 2, because "b" is the second element of the given vector.

See also:

INDEX, LOOKUP, VLOOKUP, HLOOKUP

MAX (maximum)

Syntax:

MAX(Number1 [, Number2, Number3 ...])

Description:

Returns the largest value in the given numbers.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Example:

MAX(5, 7, 4, 9) returns 9

If the cells A1:A3 contain -1, -2 and TRUE:

MAX(A1:A3) returns -1 (the logical value TRUE is ignored)

MAX(A1:A3, TRUE) returns 1 (the entered value TRUE is evaluated as 1)

MAX(A1:A3, FALSE) returns 0 (the entered value FALSE is evaluated as 0)

See also:

MAXA, MIN, LARGE
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MAXA (maximum)

Syntax:

MAXA(Value1 [, Value2, Value3 ...])

Description:

The MAXA function is almost identical to the MAX function (see note). It returns the largest value in the given
values.

Number1, Number2, etc. are the numbers to be evaluated.

Note:

Unlike MAX, MAXA also evaluates logical values and text: FALSE evaluates as 0. TRUE evaluates as 1. Text
evaluates as 0.

Empty cells, however, are also ignored here.

Example:

MAXA(5, 7, 4, 9) returns 9

If the cells A1:A3 contain -1, -2 and TRUE:

MAXA(A1:A3) returns 1 (since TRUE evaluates as 1)

MAX(A1:A3) on the other hand results in -1 (because the logical value TRUE is ignored in the MAX function)

See also:

MAX

MAXIFS (conditional maximum)

Syntax:

MAXIFS(MaxRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This function determines the largest value in an area that is evaluated according to one or more conditions.
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MaxRange is the value range whose largest value is to be determined.

Range1 is the first cell range to be checked for Criterion1. This range must have the same dimensions as
MaxRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included.

Range2, Criterion2, etc. (optional) are further cell ranges that can be checked for a condition.

Note:

The search criterion can be a number, a text string or an expression, for example "42", "screws", "03/12/2020",
"TRUE", ">10" and always have to be surrounded by double quotation marks (").

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

Example:

You have the following table with people of different ages:

MAXIFS(B2:B8, C2:C8, "M") returns 53 for the oldest man.

MAXIFS(B2:B8, C2:C8, "F", D2:D8, "Miami") returns 42 for the oldest woman from Miami.

MAXIFS(B2:B8, B2:B8, "<30") returns 27 for the oldest person under 30

See also:

MINIFS, MAX, SUMIFS, AVERAGEIFS
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MDETERM (matrix determinant)

Syntax:

MDETERM(Array)

Description:

Returns the determinant of a square matrix.

Array is a cell range or array containing the matrix to be evaluated. It must contain numeric values only. Its
number of rows has to equal its number of columns.

Example:

MDETERM({9,8,8; 2,4,6; 1,2,1}) returns -40

See also:

Section Working with arrays, MINVERSE, MMULT, MSOLVE, TRANSPOSE

MEDIAN (Median)

Syntax:

MEDIAN(Number1 [, Number2, Number3 ...])

Description:

Returns the median of the given set of numbers.

The median is the number in the middle of a set of numbers. Half of the numbers are smaller than the median,
half of them are greater.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.

Note:

If the total number of values is odd, MEDIAN returns the number in the middle of the set of numbers.
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If the total number of values is even, MEDIAN returns the average of the two numbers in the middle (see
second example).

Example:

MEDIAN(1, 2, 3, 4, 5) returns 3

MEDIAN(1, 2, 3, 4, 5, 1000) returns 3.5

See also:

AVERAGE, MODE.SNGL/MODE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE

MID (part of a text string)

Syntax:

MID(Text, Start, Count)

Description:

Returns a section of a Text string.

The section starts at character Start and is Count characters long.

Example:

MID("peanut", 2, 3) returns ean

MID("peanut", 2, 5) returns eanut

MID("peanut", 2, 100) returns eanut as well

MID("peanut", 100, 100) returns an empty text string

See also:

LEFT, RIGHT, REPLACE, FIND, SEARCH, LEN
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MILLISECONDS (milliseconds)

Syntax:

MILLISECONDS(Time)

Description:

Returns the milliseconds of a time value.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Example:

MILLISECONDS("12:34:56.555") returns 555

MILLISECONDS ("09/25/2018 12:34:56.555") equals 555

If cell A1 contains a date with the time 12:34:56,555 then MILLISECONDS(A1) returns 555

See also:

HOUR, MINUTE, SECOND

MIN (minimum)

Syntax:

MIN(Number1 [, Number2, Number3 ...])

Description:

Returns the smallest value in the given numbers.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated.

If this function refers to empty cells, these are ignored. Also cells that contain text strings or logical values, but
these can be entered directly into the list of arguments and thus be taken into account.
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Example:

MIN(5, 7, 4, 9) returns 4

If the cells A1:A3 contain 5, 2 and TRUE:

MIN(A1:A3) returns 2 (the logical value TRUE is ignored)

MIN(A1:A3, TRUE) returns 1 (the entered value TRUE is evaluated as 1)

MIN(A1:A3, FALSE) returns 0 (the entered value FALSE is evaluated as 0)

See also:

MINA, MAX, SMALL

MINA (minimum)

Syntax:

MINA(Value1 [, Value2, Value3 ...])

Description:

The MINA function is almost identical to the MIN function (see note). It returns the smallest value in the given
values.

Number1, Number2, etc. are the numbers to be evaluated.

Note:

Unlike MIN, MINA also evaluates logical values and text: FALSE evaluates as 0. TRUE evaluates as 1. Text
evaluates as 0.

Empty cells, however, are also ignored here.

Example:

MINA(5, 7, 4, 9) returns 4

If the cells A1:A3 contain 5, 2 and TRUE:

MINA(A1:A3) returns 1 (since TRUE evaluates as 1)

MIN(A1:A3) returns 2 (the logical value TRUE is ignored)
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See also:

MIN

MINIFS (conditional minimum)

Syntax:

MINIFS(MinRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

This function determines the smallest value in an area that is evaluated according to one or more conditions.

MinRange is the value range whose smallest value is to be determined.

Range1 is the first cell range to be checked for Criterion1. This range must have the same dimensions as
MinRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included.

Range2, Criterion2, etc. (optional) are further cell ranges that can be checked for a condition.

Note:

The search criterion can be a number, a text string or an expression, for example "42", "screws", "03/12/2020",
"TRUE", ">10" and always have to be surrounded by double quotation marks (").

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

Example:

You have the following table with people of different ages:
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MINIFS(B2:B8, C2:C8, "M") returns 27 for the youngest man.

MINIFS(B2:B8, C2:C8, "F", D2:D8, "Miami") returns 26 for the youngest woman from Miami.

MINIFS(B2:B8, B2:B8, ">30") returns 42 for the youngest person over 30.

See also:

MAXIFS, MIN, SUMIFS, AVERAGEIFS

MINUTE (minute)

Syntax:

MINUTE(Time)

Description:

Returns the minutes of a time value.

Example:

MINUTE("12:34:56 AM") returns 34

MINUTE("09/25/2018 10:30:56 AM") returns 30

If cell A1 contains a date with the time 10:30:56 then MINUTE(A1) returns 30

See also:

HOUR, SECOND, MILLISECONDS

MINVERSE (inverse matrix)

Syntax:

MINVERSE(Array)

Description:

Returns the inverse of a square matrix.
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The inverse A-1 of a matrix A is the matrix that A has to be multiplied by to receive the identity matrix 1.

Array is a cell range or array containing the matrix to be evaluated. It must contain numeric values only. Its
number of rows has to equal its number of columns.

Annotation:

Matrices whose determinant is zero (singular matrices) cannot be inverted. In this case, the function returns a
#NUM! error value.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

MINVERSE({9,8,8;2,4,6;1,2,1}) returns:

{0.2,-0.2,-0.4;-0.1,-0.025,0.95;0,0.25,-0.5}

See also:

Section Working with arrays, MDETERM, MMULT, MSOLVE, TRANSPOSE

MIRR (modified internal rate of return)

Syntax:

MIRR(Values, FinanceRate, ReinvestRate)

Description:

Returns the modified internal rate of return for a series of cash flows. Unlike the IRR function, MIRR considers
the finance rate (for investments) and the reinvest rate (for reinvestments).

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, income as positive values. The cash flows do not have to be even but they must occur in
regular intervals (e.g., monthly).

The function expects the following arguments:

Values is a cell range or array containing the cash flows. At least one payment and one income have to be
given.

FinanceRate is the interest rate paid for investments.
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ReinvestRate is the interest rate received for reinvestments.

See also:

IRR, NPV, XIRR, RATE

MMULT (product of matrices)

Syntax:

MMULT(Array1, Array2)

Description:

Returns the product of two matrices.

Array1 and Array2 are cell ranges or arrays containing the matrices to be evaluated. They must contain
numeric values only.

Please note: The number of columns in Array1 must equal the number of rows in Array2, otherwise,
multiplication is not possible.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

MMULT({1,2;3,4}, {5,6;7,8}) returns {19,22;43,50}

See also:

Section Working with arrays, MDETERM, MINVERSE, MSOLVE, TRANSPOSE

MOD (remainder of a division, Excel method)

Syntax:

MOD(x, y)
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Description:

Returns the remainder of the division of x by y, using the erroneous "Excel method".

Important: This function returns FALSE results in some cases (see annotation below)!

Example:

MOD(5, 3) returns 2

MOD(5, 0) returns a #DIV/0! error value

MOD(5, -3) returns -1 (which is wrong – see below!)

Annotation:

Microsoft Excel returns wrong results when you use the MOD function with a negative numerator or
denominator.

PlanMaker also returns wrong results in this case (for compatibility reasons), but additionally offers a function
named MODP that returns correct results

The following table shows the differences between MOD and MODP (the results highlighted in green color are
wrong):

Compatibility notes:

Note: The MODP function is not supported by Microsoft Excel. If you save a document in Excel format, all
calculations using this function will be replaced by their last result as a fixed value.

See also:

MODP, QUOTIENT
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MODE (most frequently occurring value)

Note: MODE is supplemented by the new identical function MODE.SNGL, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

MODE(Number1 [, Number2, Number3 ...])

Description:

Returns the mode of a data set.

The mode is the value occurring most frequently in a set of numbers.

Number1, Number2, etc. are the numbers to be evaluated.

If the given numbers contain more than one mode, their smallest mode will be returned.

If the given numbers do not contain any value occurring more than once, a #N/A error value will be returned.

Example:

MODE(1, 2, 4, 4, 4, 2, 1) returns 4

MODE(1, 2, 4, 4, 2, 1) returns 1 (if there are multiple modes, the smallest one is returned)

MODE(1, 4, 2) returns #N/A because no value occurs more than once.

See also:

MODE.SNGL, MEDIAN, NORM.DIST/NORMDIST

MODE.SNGL (most frequently occurring value)

Syntax:

MODE.SNGL(Number1 [, Number2, Number3 ...])

Description:

Returns the mode of a data set.
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The mode is the value occurring most frequently in a set of numbers.

Number1, Number2, etc. are the numbers to be evaluated.

If the given numbers contain more than one mode, their smallest mode will be returned.

If the given numbers do not contain any value occurring more than once, a #N/A error value will be returned.

Example:

MODE.SNGL(1, 2, 4, 4, 4, 2, 1) returns 4

MODE.SNGL(1, 2, 4, 4, 2, 1) returns 1 (if there are multiple modes, the smallest one is returned)

MODE.SNGL(1, 4, 2) returns #N/A because no value occurs more than once.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

MODE, MEDIAN, NORM.DIST/NORMDIST

MODP (remainder of a division, PlanMaker method)

Syntax:

MODP(x, y)

Description:

Returns the remainder of the division of x by y, using the "PlanMaker method" (see annotation below).

Example:

MODP(5, 3) returns 2

MODP(5, 0) returns a #DIV/0! error value

MODP(5, -3) returns 2 (see below)

Annotation:

Microsoft Excel returns wrong results when you use the MOD function with a negative numerator or
denominator.
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If you want to get correct results, you should use the RESTP function described here instead of REST.

The following table shows the differences between MOD and MODP (the results highlighted in green color are
wrong):

Compatibility notes:

Note: The MODP function is not supported by Microsoft Excel. If you save a document in Excel format, all
calculations using this function will be replaced by their last result as a fixed value.

See also:

MOD, QUOTIENT

MONTH (month of a date)

Syntax:

MONTH(Date)

Description:

Returns the month of a date.

Example:

MONTH("09/25/2018") returns 9

MONTH("August 17") equals 8

If cell A1 contains the date value 9/25/2018 then MONTH(A1) returns 9

See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, YEAR, DAY, WEEKDAY
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MROUND (round to a multiple of base)

Syntax:

MROUND(Number, Base)

Description:

Rounds Number to the nearest multiple of Base.

Base must be > 0.

If the remainder of the division of Number by Base is smaller than half the value of Base, MROUND rounds
down. If it is greater than or equal to half the value of Base, MROUND rounds up (see examples below).

Example:

MROUND(1234.5678, 1) returns 1235

MROUND(1234.5678, 0.01) returns 1234.57

MROUND(22, 5) returns 20

MROUND(23, 5) returns 25

MROUND(22.5, 5) returns 25

See also:

FLOOR, CEILING, ROUNDDOWN, ROUNDUP, ROUND, TRUNC, INT

MSOLVE (solution of matrix equation Ax=B)

Syntax:

MSOLVE(ArrayA, VectorB)

Description:

Returns the solution to a linear system of equations by solving the matrix equation Ax=B.

ArrayA is the cell range or array containing matrix A. It must contain numeric values only. Its number of rows
has to equal its number of columns.
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The determinant of this matrix must not be zero, otherwise, the equation cannot be solved.

VectorB is the cell range or array containing vector B. VectorB must be a vector, which is an array or a cell
range of just one column.

The result of this function is a vector with the solutions.

Please note: The MSOLVE function only calculates correctly if the vector with the solutions is arranged as a
column. To arrange the vector with the solutions in a row, you also need to use the TRANSPOSE function with
the following syntax:

TRANSPOSE(MSOLVE(ArrayA, VectorB))

Annotation:

The result of this function is calculated using singular value decomposition. When applied to large matrices
(more than 10, 20 rows), significant rounding errors can occur.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

To solve the following linear system of equations ...

2x + 3y = 4
2x + 2y = 8

... use the following formula:

MSOLVE({2,3;2,2}, {4,8})

The result is the vector {8;-4}, which means that x=8 and y=-4.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

Section Working with arrays, MDETERM, MINVERSE, MMULT, TRANSPOSE
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MULTINOMIAL (multinomial coefficient)

Syntax:

MULTINOMIAL(Number1 [, Number2, Number3 ...])

Description:

Returns the multinomial coefficient ("polynomial coefficient") of a set of numbers.

Number1, Number2

Example:

MULTINOMIAL(1, 2, 3, 4, 5) returns 37837800

Note:

The functions MULTINOMIAL and POLYNOMIAL are completely identical.

See also:

POLYNOMIAL, FACT

N (convert value into number)

Syntax:

N(Value)

Description:

Converts a value to a number.

The specified value must be a number, a date value or a logical value, otherwise N returns zero.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert values into numbers,
where necessary.
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Example:

N("Text") returns 0

N("42") returns 0

N(42) returns 42

N(TRUE) returns 1

If A1 contains the date 09/25/2014, the following applies:

N(A1) returns 41907 (the serial number of that date)

See also:

T, VALUE, TEXT

NA (error value #N/A)

Syntax:

NA()

Description:

Returns the error value #N/A ("not available").

Entering =NA() in a cell indicates that the value in this cell is currently not available. Use this function in a cell
that is empty, but definitely has to be filled out later in order to receive correct results in calculations made with
this cell. As a result, all calculations referring to this cell will also return a #N/A error value (instead of an
incorrect result).

In this way, you can prevent calculations from being carried out with empty cells, although these cells would
necessarily have to be filled with values for a correct result to be returned.

Annotation:

Instead of entering =NA() into a cell you can also type #N/A, which will lead to the same result.

Example:

You would like to calculate your annual turnover using the sum of the four quarterly results. These are entered
in cells A1 to A4; the annual turnover could therefore be calculated using the formula SUM(A1:A4).

There is only one problem: the result for the fourth quarter is not yet available, so cell A4 is empty. The annual
turnover must therefore not yet be calculated.
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However, PlanMaker stubbornly calculates the sum from A1 to A4 – even if one of the values is missing. The
result: an apparently miserable annual result, shareholders screaming away.

It is much healthier to not simply leave cell A4 empty, but to enter NA() there. This marks the cell as "not
available". This means that the SUM formula no longer has a wrong numerical value as a result, but the error
value #N/A. This indicates that one of the quarterly results is not yet available, i.e. the annual turnover cannot
yet be calculated. Result: no shareholders running away screaming.

See also:

ISNA, ISERR, ISERROR, ERRORTYPE, section Error values

NEG (negative value)

Syntax:

NEG(Number)

Description:

Return the negative value of Number.

Example:

NEG(42) returns -42

NEG(-42) returns 42

NEG(0) returns 0

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Instead of using NEG, you can simply multiply the value by -1: NEG(x) equals (-1) * x.

See also:

ABS, SIGN
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NEGBINOMDIST (negative binomial distribution)

Note: NEGBINOMDIST is supplemented by the new function NEGBINOM.DIST with additional
functionality, which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

NEGBINOMDIST(k, r, p)

Description:

Returns the negative binomial distribution (also known as Pascal distribution).

The negative binomial distribution can be used to calculate the probability to receive k failures before the r-th
success in an experiment with independent trials and only two possible outcomes (success or failure) with a
fixed probability of p for each trial.

k 

r 

k and r should be integers. If this is not the case, digits right of the decimal point are ignored by PlanMaker.

p is the probability of a success for each trial run. Must be in the range 0 to 1.

Example:

In an urn there are 1 red and 5 black balls. What is the probability (with the balls being returned) to draw
exactly 10 black balls (=failures) before the 2nd red ball (=success) is drawn?

NEGBINOMDIST(10, 2, 1/6) returns 0.04935.

See also:

NEGBINOM.DIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, HYPGEOM.DIST/HYPGEOMDIST

NEGBINOM.DIST (negative binomial distribution)

Syntax:

NEGBINOM.DIST(k, r, p, Cumulative)
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Description:

Returns the negative binomial distribution (also known as Pascal distribution).

The negative binomial distribution can be used to calculate the probability to receive k failures before the r-th
success in an experiment with independent trials and only two possible outcomes (success or failure) with a
fixed probability of p for each trial.

k 

r 

k and r should be integers. If this is not the case, digits right of the decimal point are ignored by PlanMaker.

p is the probability of a success for each trial run. Must be in the range 0 to 1.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the negative binomial distribution is calculated. By entering the value FALSE, the
probability mass function of the negative binomial distribution is calculated.

Example:

In an urn there are 1 red and 5 black balls. What is the probability (with the balls being returned) to draw
exactly or at most 10 black balls (=failures) before the 2nd red ball (=success) is drawn?

NEGBINOM.DIST(10, 2, 1/6, FALSE) returns 0.04935

NEGBINOM.DIST(10, 2, 1/6, TRUE) returns 0.61867

The probability of having to draw exactly 10 black balls is 4.9% (probability mass function). The probability of
having to draw at most 10 black balls is 61.9% (cumulative distribution function).

Note:

The NEGBINOM.DIST function supplements the previous NEGBINOMDIST function with the additional
argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

NEGBINOMDIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, HYPGEOM.DIST/HYPGEOMDIST
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NETWORKDAYS (number of workdays)

Syntax:

NETWORKDAYS(StartDate, EndDate [, Holidays])

Description:

Returns the number of workdays between StartDate and EndDate.

This function counts workdays only, Saturdays and Sundays are skipped. Optionally, you can specify a list of
holidays to be skipped as well (see Holidays parameter).

StartDate and EndDate are the first and the last day of the time interval to be evaluated.

Holidays (optional) is a cell range or an array containing a list of dates to be skipped (e.g. holidays).

Example:

NETWORKDAYS("01/01/2010", "01/31/2010") returns 22.

January 2010 therefore had 22 working days (not including public holidays).

If you want to include the holidays on 1/1/2010 and 1/6/2010 (in most European countries), you can enter these
two dates in cells A1 and A2, for example, and then write them:

NETWORKDAYS("01/01/2010, "01/31/2010", A1:A2)

The result is 20, as these holidays both fell on weekdays in 2010, so 2 days are to be deducted.

See also:

WORKDAY, DAYS/DAYSP, DAYS360, DATEDIF, HOLIDAY

NOMINAL (nominal interest rate)

Syntax:

NOMINAL(EffRate, NPerYear)

Description:

Returns the nominal annual interest rate, given the effective annual interest rate and the number of
compounding periods per year.
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EffRate is the effective annual interest rate.

NPerYear is the number of compounding periods per year (must be at least 1).

Example:

An investment with an effective annual interest rate of 5%, compounded quarterly: How high is the nominal
annual interest rate?

NOMINAL(5%, 4) returns approx. 4.91%

See also:

EFFECT

NORMDIST (normal distribution)

Note: NORMDIST is supplemented by the new identical function NORM.DIST, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

NORMDIST(x, Mean, StdDev, Cumulative)

Description:

Returns the normal distribution (also known as Gaussian distribution).

The normal distribution is one of the most important distributions in statistics, since many distributions follow
it.

x is the value to be evaluated.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x).

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.
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Left: density function ("bell curve"), right: distribution function

Note:

The reverse function to this function is NORMINV

See also:

NORM.DIST, NORM.INV/NORMINV, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORM.DIST (normal distribution)

Syntax:

NORM.DIST(x, Mean, StdDev, Cumulative)

Description:

Returns the normal distribution (also known as Gaussian distribution).

The normal distribution is one of the most important distributions in statistics, since many distributions follow
it.

x is the value to be evaluated.

Mean is the mean of LN(x).

StdDev is the standard deviation of LN(x).

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.
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Left: density function ("bell curve"), right: distribution function

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

The reverse function to this function is NORM.INV

See also:

NORMDIST, NORM.INV/NORMINV, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORMINV (percentiles of the normal distribution)

Note: NORMINV is supplemented by the new identical function NORM.INV, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

NORMINV(Probability, Mean, StdDev)

Description:

Returns the inverse of the normal cumulative distribution function NORMDIST.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution. Must be > 0.
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Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

See also:

NORM.INV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV

NORM.INV (percentiles of the normal distribution)

Syntax:

NORM.INV(Probability, Mean, StdDev)

Description:

Returns the inverse of the normal cumulative distribution function NORM.DIST.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution. Must be > 0.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST, NORM.S.INV/NORMSINV
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NORMSDIST (standard normal distribution)

Note: NORMSDIST is supplemented by the new function NORM.S.DIST with additional functionality,
which is available in newer versions of Microsoft Excel (2010 or later).

Syntax:

NORMSDIST(x)

Description:

Returns the standard normal cumulative distribution function.

The standard normal distribution is a normal distribution (see NORM.DIST/NORMDIST function) with a mean
of zero and a standard deviation of 1.

x is the value to be evaluated.

Annotation:

The cumulative distribution function is returned.

The inverse function is NORMSINV

See also:

NORM.S.DIST, NORM.INV/NORMINV, NORM.S.INV/NORMSINV, STANDARDIZE, GAUSS,
LOGNORM.INV/LOGINV, LOGNORM.DIST/LOGNORMDIST

NORM.S.DIST (standard normal distribution)

Syntax:

NORM.S.DIST(x, cumulative)

Description:

Returns the standard normal (cumulative) distribution function.

The standard normal distribution is a normal distribution (see NORM.DIST/NORMDIST function) with a mean
of zero and a standard deviation of 1.
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x is the value to be evaluated.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the standard normal distribution is calculated. By entering the value FALSE, the density
function of the standard normal distribution is calculated.

Note:

The NORM.S.DIST function supplements the previous NORMSDIST function with the additional argument
Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

Annotation:

The inverse function is NORM.S.INV

See also:

NORMSDIST, NORM.INV/NORMINV, NORM.S.INV/NORMSINV, STANDARDIZE, GAUSS,
LOGNORM.INV/LOGINV, LOGNORM.DIST/LOGNORMDIST

NORMSINV (percentiles of the standard distribution)

Note: NORMSINV is supplemented by the new identical function NORM.S.INV, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

NORMSINV(Probability)

Description:

Returns the inverse of the standard normal distribution function NORMSDIST.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.
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See also:

NORM.S.INV, NORM.INV/NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

NORM.S.INV (percentiles of the standard distribution)

Syntax:

NORM.S.INV(Probability)

Description:

Returns the inverse of the standard normal cumulative distribution function NORM.S.DIST.

Probability is the probability to be evaluated. Must be in the range 0 to 1.

Note:

The result of this function is calculated using an iterative search technique. If PlanMaker does not find a result
after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value #N/A and
aborts the approximation.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

NORMSINV, NORM.INV/NORMINV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

NOT (logical NOT function)

Syntax:

NOT(Value)

Description:

Performs a logical negation. TRUE becomes FALSE and FALSE becomes TRUE.
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Value must be a logical value or a calculation returning a logical value.

Example:

NOT(TRUE) returns FALSE

NOT(FALSE) returns TRUE

NOT(A1=0) returns TRUE, if A1 contains a value different from zero.

See also:

OR, AND, XOR

NOW (current date and time)

Syntax:

NOW()

Description:

Returns the current date and time.

Note:

The result is a serial date number. PlanMaker automatically formats it in time format so that it will be displayed
as a time.

However, the result also contains the date. So if you format the cell using the dialog box of the ribbon tab
Home | group Number  for example to the number format MM/DD/YYYY hh:mm, the current date and time
will be displayed.

See also:

TODAY, CREATEDATE

NPER (number of periods)

Syntax:

NPER(Rate, Pmt, PV [, FV] [, Type])
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Description:

Returns the number of payment periods of an investment based on periodic constant payments and a constant
interest rate.

You can use this function, for example, to calculate how many periodic payments (annuities) must be made for
a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period).

Pmt is the payment made for each period.

PV is the present value.

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

See also:

PV, PPMT, PMT, RATE, IPMT, FV

NPV (net present value)

Syntax:

NPV(Rate, Value1 [, Value2, Value3 ...])

Description:

Returns the net present value of an investment based on regular cash flows and a fixed discount rate.

The function expects the following arguments:

Rate is the discount rate (per payment period).

Value1, Value2, etc. are the cash flows. You can specify either single values or a cell range. Important: All
cash flows have to occur at the end of each period.



699Formulas and functions

Payments have to be entered as negative values, incomes as positive values. The cash flows do not have to be
even but they must occur in regular intervals (at the end of each period) and be entered in their actual order,
namely, cash flow for the first period, cash flow for the second period, etc.

A zero has to be entered for periods where no cash flow occurred.

Differences to the PV function:

1. With NPV, cash flows of different amounts are possible, with PV they have to be even.

2. With NPV, cash flows must occur at the end of each period; with PV they can also be made at the beginning
of the period.

Example:

NPV(6.5%, 4000, 5000) returns 8164.16

See also:

PV, XNPV, IRR

NUMBERVALUE (convert text to a number, locale)

Syntax:

NUMBERVALUE(Text [, DecimalSeparator] [, GroupSeparator])

Description:

Converts a text string into a number. The arguments DecimalSeparator and GroupSeparator allow you to
format the text string in locale independent way.

Text is the value you want to convert to a number.

DecimalSeparator (optional) specifies which character is currently used to separate the decimal places in the
text string.

GroupSeparator (optional) specifies which character is currently used in the text string to form groups of
1000s.

The result is returned as default format: without group separator and the zeros after the decimal separator are
truncated.

Notes:

The following rules apply when using the NUMBERVALUE function:

§ If the arguments DecimalSeparator and GroupSeparator are not specified, the text string is returned
according to the current locale. 
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§ If multiple characters are specified in DecimalSeparator or GroupSeparator, only the first character is
used.

§ An empty Text string returns 0 as result.

§ Space characters within the Text string are ignored.

§ Multiple decimal separators in Text string returns the error value #VALUE!

§ If the decimal separator appears before the group separator in the Text string, this returns the error value
#VALUE!

§ If the Text string cannot be understood as a number, this returns the error value #VALUE!

§ The % sign at the end of the Text string is treated as a percentage (i.e. the number is divided by 100).
Multiple % signs cause the number to be divided several times by 100.

Example:

NUMBERVALUE("42") returns 42

NUMBERVALUE("42.44") returns 42.44

NUMBERVALUE("42,44") returns 4244

NUMBERVALUE("42,44",",",".") returns 42.44

NUMBERVALUE("42,000.44") returns 42000.44

NUMBERVALUE("42.000,44") returns #VALUE

NUMBERVALUE("42,000.44",",",".") returns #VALUE!!

NUMBERVALUE("42.000,44",",",".") returns 42000.44

NUMBERVALUE("42 0 0 0",",",".") returns 42000

NUMBERVALUE("42%") returns 0.42

NUMBERVALUE("42%%") returns 0.0042

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

VALUE



701Formulas and functions

OCT2BIN (octal number to binary number)

Syntax:

OCT2BIN(Number [, Digits])

Description:

Converts the given octal number (base 8) to a binary number (base 2).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in octal notation):

Number 

This corresponds in decimal notation:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

OCT2BIN("52") returns 101010

OCT2BIN("52", 8) returns 00101010

OCT2BIN("52", 2) returns the error value #NUM!, because this number cannot be represented with fewer than
6 binary digits

OCT2BIN("37777777726") returns 11111111111111111111111111010110 (negative value)

See also:

BIN2OCT, OCT2DEC, OCT2HEX
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OCT2DEC (octal number to decimal number)

Syntax:

OCT2DEC(Number)

Description:

Converts the given octal number (base 8) to a decimal number (base 10).

Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in octal notation)

Number 

This corresponds in decimal notation:

Number 

Example:

OCT2DEC("52") returns 42

OCT2DEC("0052") returns 42 as well

OCT2DEC("37777777726") returns -42

See also:

DEC2OCT, OCT2BIN, OCT2HEX, DECIMAL

OCT2HEX (octal number to hexadecimal number)

Syntax:

OCT2HEX(Number [, Digits])

Description:

Converts the given octal number (base 8) to a hexadecimal number (base 16).
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Number is the number to be converted.

Negative numbers have to be transformed to two's complement notation (see last example).

The permissible value range for Number is (in octal notation)

Number 

This corresponds in decimal notation:

Number 

The optional argument Digits lets you specify the number of places to be displayed. If omitted, PlanMaker
determines the number of required places automatically.

Digits must be greater than zero. Digits should be an integer. Digits to the right of the decimal point are
ignored.

If Digits is smaller than the minimum number of places required to display the number, the function returns a
#NUM error value.

If Number is negative, the result is represented in 32-bit two's complement; the Digits argument is ignored in
this case.

Example:

OCT2HEX("52") returns 2A

OCT2HEX("0052") returns 2A as well

OCT2HEX("52", 1) returns the error value #NUM!, because this number cannot be represented with fewer than
2 hexadecimal digits

OCT2HEX("37777777726") returns FFFFFFD6 (negative value)

See also:

HEX2OCT, OCT2BIN, OCT2DEC

ODD (round up to next odd number)

Syntax:

ODD(Number)

Description:

Rounds Number up (away from zero) to the nearest odd integer.
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Example:

ODD(41) returns 41

ODD(42) returns 43

ODD(-42) returns -43

See also:

EVEN, ROUNDDOWN, ROUNDUP, ROUND, MROUND

OFFSET (shifted reference)

Syntax:

OFFSET(Reference, Rows, Columns [, Height] [, Width])

Description:

Returns a cell reference shifted by the specified number of rows and columns. Optionally, the size of the
Reference can also be changed.

Note: This does not physically move table cells, nor does it move the selection. The function only returns a
shifted cell reference.

Reference is the cell reference to be evaluated. You can specify either a single cell or a cell range (in the
notation StartingCell:EndingCell).

Rows is the number of rows Reference will be shifted. Positive values shift downwards, negative values shift
upwards.

Columns is the number of columns Reference will be shifted. Positive values shift to the right, negative values
shift to the left.

Height (optional) changes the height of Reference to the specified number of rows. Height must be a positive
value.

Width (optional) changes the width of Reference to the specified number of columns. Width must be a
positive value.

Example:

OFFSET(A1, 2, 0) returns a reference to A3

OFFSET(A1:C3, 1, 1) returns a reference to B2:D4

OFFSET(A1:C3, 1, 1, 5, 3) returns a reference to B2:D6
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SUM(OFFSET(A1:C3, 1, 1, 5, 3)) returns the sum of the values in B2:D6

See also:

ADDRESS, INDIRECT, COLUMN, ROW

OR (logical OR function)

Syntax:

OR(Value1 [, Value2, Value3 ...])

Description:

Returns the logical value TRUE if at least one of the given arguments is TRUE, otherwise it returns FALSE.

You can use this function to verify that at least one of multiple conditions is fulfilled.

Example:

OR(TRUE, TRUE) returns TRUE

OR(TRUE, FALSE) returns TRUE

OR(FALSE, FALSE) returns FALSE

OR(A1=0, A1>10) returns TRUE, if A1 is either zero or greater than ten.

See also:

XOR, AND, NOT

PEARSON (Pearson correlation coefficient)

Syntax:

PEARSON(Range1, Range2)

Description:

Returns the Pearson product-moment correlation coefficient r.
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This coefficient is a measure of the strength of the linear relationship between two data sets.

The result of the PEARSON function is in the range -1 to 1: 1 indicates a perfect linear relationship. -1
indicates a perfect inverse linear relationship (the values in Range2 decrease as the values in Range1 increase).

Range1 and Range2 are cell references to the two data sets. The ranges should contain numbers. Empty cells,
text and logical values are ignored.

Range1 and Range2 must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 1, 2, 3 and B1:B3 contains 2, 3, 4:

PEARSON(A1:A3, B1:B3) returns 1

If A1:A3 contains the values 1, 2, 3 and B1:B3 contains 4, 3, 2:

PEARSON(A1:A3, B1:B3) returns -1

See also:

RSQ, SLOPE, INTERCEPT

PERCENTILE (percentiles of a data set)

Note: PERCENTILE is supplemented by the new identical function PERCENTILE.INC and the completely
new function PERCENTILE.EXC, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

PERCENTILE(Range, k)

Description:

Returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the percentile to be returned. Must be in the range 0 to 1 (inclusive) with 0=0% and 1=100%.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTILE(A1:A9, 0.75) returns 7



707Formulas and functions

See also:

PERCENTILE.INC/PERCENTILE.EXC, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK

PERCENTILE.EXC (percentiles of a data set)

Syntax:

PERCENTILE.EXC(Range, k)

Description:

Returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the percentile to be returned. Must be in the range 0 to 1 (exclusive) with 0=0% and 1=100%.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTILE.EXC(A1:A9, 0.75) returns 7.5

Note:

The PERCENTILE.EXC function supplements, together with PERCENTILE.INC, the previous PERCENTILE
function.

PERCENTILE.INC returns the same result as PERCENTILE (values 0 to 1 inclusive).

PERCENTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK
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PERCENTILE.INC (percentiles of a data set)

Syntax:

PERCENTILE.INC(Range, k)

Description:

Returns the k-th percentile of a data set.

For example, if k is 0.5, the 0.5 percentile (i.e., the median) will be returned.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k is the percentile to be returned. Must be in the range 0 to 1 (inclusive) with 0=0% and 1=100%.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTILE.INC(A1:A9, 0.75) returns 7

Note:

The PERCENTILE.INC function supplements together with PERCENTILE.EXC the previous PERCENTILE
function.

PERCENTILE.INC returns the same result as PERCENTILE (values 0 to 1 inclusive).

PERCENTILE.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

QUARTILE.EXC/QUARTILE.INC/QUARTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE,
RANK.EQ/RANK.AVG/RANK
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PERCENTRANK (percent rank in a data set)

Note: PERCENTRANK is supplemented by the new identical function PERCENTRANK.INC and the
completely new function PERCENTRANK.EXC, which are available in newer versions of Microsoft Excel
(2010 or later).

Syntax:

PERCENTRANK(Range, Number [, Digits])

Description:

Returns the percentile rank (between 0 and 1 inclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank you want to determine. If Number is not included in the given values,
interpolation will be used.

Digits (optional) is the number of significant digits for the returned value. To do this, enter the desired number
of decimal places. If omitted, 3 digits will be used.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTRANK(A1:A9, 5) returns 0.5(=50%) middle of the given values; median

PERCENTRANK(A1:A9, 1) returns 0 (=0%) minimum value

PERCENTRANK(A1:A9, 9) returns 1 (=100%) maximum value

See also:

PERCENTRANK.INC/PERCENTRANK.EXC, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
QUARTILE.EXC/QUARTILE.INC/QUARTILE, RANK.EQ/RANK.AVG/RANK

PERCENTRANK.EXC (percent rank in a data set)

Syntax:

PERCENTRANK.EXC(Range, Number [, Digits])
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Description:

Returns the percentile rank (between 0 and 1 exclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank you want to determine. If Number is not included in the given values,
interpolation will be used.

Digits (optional) is the number of significant digits for the returned value. To do this, enter the desired number
of decimal places. If omitted, 3 digits will be used.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTRANK.EXC(A1:A9, 5) returns 0.5 (=50%) middle of the given values; median

PERCENTRANK.EXC(A1:A9, 1) returns 0.1 (=10%) minimum value

PERCENTRANK.EXC(A1:A9, 9) returns 0.9 (=90%) maximum value

Note:

The PERCENTRANK.EXC function supplements together with PERCENTRANK.INC the previous
PERCENTRANK function.

PERCENTRANK.INC returns the same result as PERCENTRANK (values 0 to 1 inclusive).

PERCENTRANK.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
RANK.EQ/RANK.AVG/RANK

PERCENTRANK.INC (percent rank in a data set)

Syntax:

PERCENTRANK.INC(Range, Number [, Digits])
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Description:

Returns the percentile rank (between 0 and 1 inclusive) of a value in a data set.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

Number is the value whose rank you want to determine. If Number is not included in the given values,
interpolation will be used.

Digits (optional) is the number of significant digits for the returned value. To do this, enter the desired number
of decimal places. If omitted, 3 digits will be used.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

PERCENTRANK.INC(A1:A9, 5) returns 0.5 (=50%) middle of the given values; median

PERCENTRANK.INC(A1:A9, 1) returns 0 (=0%) minimum value

PERCENTRANK.INC(A1:A9, 9) returns 1 (=100%) maximum value

Note:

The PERCENTRANK.INC function supplements together with PERCENTRANK.EXC the previous
PERCENTRANK function.

PERCENTRANK.INC returns the same result as PERCENTRANK (values 0 to 1 inclusive).

PERCENTRANK.EXC (values 0 to 1 exclusive) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE, QUARTILE.EXC/QUARTILE.INC/QUARTILE,
RANK.EQ/RANK.AVG/RANK

PERIOD (duration of fixed-interest investments)

Syntax:

PERIOD(Rate, PV, FV)
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Description:

Returns the duration (i.e., the number of periods) required to obtain a specific future value in a fixed-interest
investment.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

The function expects the following arguments:

Rate is the interest rate (per payment period).

PV is the present value.

FV is the future value.

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Tip: You can perform calculations with the PERIOD function using Excel-compatible functions as follows:

PERIOD(Rate, PV, FV) is equivalent to NPER(Rate, 0, PV, -FV)

Note the minus sign in front of FV!

Example:

You would like to obtain a payout of €5000 with a fixed-interest investment of €3000. The yearly interest rate
is 6%. How many periods (= years) are required for this?

PERIOD(6%, 3000, 5000) returns 8.76669 periods (i.e., years)

See also:

RRI

PERMUT (permutations)

Syntax:

PERMUT(n, k)

Description:

Returns the number of permutations of size k in a population of size n.
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n is the total number of items. Must be > k.

k is the number of items in each combination. Must be > 0 and < n.

n and k should be integers. Digits right of the decimal point are ignored by PlanMaker.

Annotation:

Permutations are similar to combinations (see COMBIN function), except that the order of the objects is
important for permutations.

With PERMUT you can calculate, for example, how many possibilities there are for the first 3 places in a race
with 10 participants. With COMBIN, on the other hand, you can determine how many possibilities there are
when drawing 6 balls from 49.

The difference: While the order of the lottery numbers drawn can be changed at will (you could, for example,
sort them in ascending order afterwards), the runners would of course protest if you suddenly re-sort the places
1-3 according to the first letters of the surnames.

The arrangement plays a role in the variations, but not in the combinations.

Example:

Let us take up the example with the runners. You want to know how many variations there are for the first 3
places in a race with 10 runners. The formula for this is:

PERMUT(10, 3)

Result: There are 720 possible variations.

See also:

COMBIN

PHI (standard normal distribution)

Syntax:

PHI(x)

Description:

Returns the density function of the standard normal distribution.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.
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It is therefore recommended to use the function NORMDIST instead, since it is compatible with all versions of
Excel:

PHI(x) equals NORMDIST(x, 0, 1, FALSE)

See also:

NORM.DIST/NORMDIST, GAUSS

PI (pi)

Syntax:

PI()

Description:

Returns the mathematical constant p (pi), which expresses the ratio of a circle's circumference (2rp) to its
diameter (2r).

Example:

PI() returns 3.14159265...

PMT (payment)

Syntax:

PMT(Rate, NPer, PV [, FV] [, Type])

Description:

Returns the payment (principal plus interest) in the given period, applicable to loans with periodic constant
payments, and a constant interest rate.

You can use this function, for example, to calculate how large the (constant) payments are per period. These
payments ("annuities") always consist of a principal portion (see PPMT function) and an interest portion (see
IPMT function).

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.
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The function expects the following arguments:

Rate is the interest rate (per payment period).

NPer is the total number of payment periods.

PV is the present value.

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

PMT(6.5%, 10, 1000) returns -139.10

See also:

PV, ISPMT, PPMT, CUMPRINC, CUMIPMT, RATE, IPMT, FV, NPER

POISSON (Poisson distribution)

Note: POISSON is supplemented by the new identical function POISSON.DIST, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

POISSON(x, Lambda, Cumulative)

Description:

Returns the Poisson distribution.

The Poisson distribution describes the occurrence of independent, similar events of the same type in a given
period (for example, the arrival of customers at a counter or the receipt of telephone calls).

It is particularly suitable for probability distributions where there are a large number of results from a sample
and the probability that the evaluated event will occur is very small. Here the Poisson distribution can simulate
the binomial distribution (with Lambda = n*p). In contrast to the binomial distribution, however, Poisson
requires only one parameter (apart from x): the expected value Lambda (see example).

x x should be an integer. Digits to the right of the
decimal point are ignored.

Lambda (l) is the expected value (mean value) for x. Lambda 
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The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

In a multi-story building, an average of 4 light bulbs become defective per week.

To determine the probability that just 3 light bulbs become defective in one week:

If you want to calculate this with the binomial distribution (function BINOM.DIST/BINOMDIST), you would
have to write:

BINOMDIST(3, 100000, 4/100000, FALSE) returns 0.195368768

If, on the other hand, you use the Poisson distribution, you can do this without the parameters n and p and
simply write:

POISSON(3, 4, FALSE) returns 0,195366815

As expected, the two results are very similar (as described above).

Another example: What is the probability of a maximum of 3 damages?

Here, instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

POISSON(3, 4, TRUE) equals 0.43347

See also:

POISSON.DIST, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, EXPON.DIST/EXPONDIST

POISSON.DIST (Poisson distribution)

Syntax:

POISSON.DIST(x, Lambda, Cumulative)

Description:

Returns the Poisson distribution.

The Poisson distribution describes the occurrence of independent, similar events of the same type in a given
period (for example, the arrival of customers at a counter or the receipt of telephone calls).

It is particularly suitable for probability distributions where there are a large number of results from a sample
and the probability that the evaluated event will occur is very small. Here the Poisson distribution can simulate



717Formulas and functions

the binomial distribution (with Lambda = n*p). In contrast to the binomial distribution, however, Poisson
requires only one parameter (apart from x): the expected value Lambda (see example).

x x should be an integer. Digits to the right of the
decimal point are ignored.

Lambda (l) is the expected value (mean value) for x. Lambda 

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

In a multi-story building, an average of 4 light bulbs become defective per week.

To determine the probability that just 3 light bulbs become defective in one week:

If you want to calculate this with the binomial distribution (function BINOM.DIST/BINOMDIST), you would
have to write:

BINOM.DIST(3, 100000, 4/100000, FALSE) equals 0.195368768

If, on the other hand, you use the Poisson distribution, you can do this without the parameters n and p and
simply write:

POISSON.DIST(3, 4, FALSE) equals 0,195366815

As expected, the two results are very similar (as described above).

Another example: What is the probability of a maximum of 3 damages?

Here, instead of the density function, you use the distribution function (specify the Cumulative argument with
TRUE):

POISSON.DIST(3, 4, TRUE) returns 0.43347 (i.e., about 43.3%)

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

POISSON, BINOM.DIST.RANGE/BINOM.DIST/BINOMDIST, EXPON.DIST/EXPONDIST



718Formulas and functions

POLYNOMIAL (polynomial coefficient)

Syntax:

POLYNOMIAL(Number1 [, Number2, Number3 ...])

Description:

Returns the polynomial coefficient ("multinomial coefficient") of a set of numbers.

Number1, Number2

Example:

POLYNOMIAL(1, 2, 3, 4, 5) returns 37837800

Note:

The functions POLYNOMIAL and MULTINOMIAL are completely identical.

See also:

MULTINOMIAL, FACT

POWER (power)

Syntax:

POWER(x, y)

Description:

Returns x raised to the y-th power.

x is the base.

y is the exponent.

Annotation:

The ^ operator does exactly the same:
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POWER(x, y) is equivalent to x^y.

Example:

POWER(2, 4) is equivalent to 2^4, which equals 16

See also:

LOG, LN, EXP, SERIESSUM, SQRT, ROOTN, section Operators in formulas

PPMT (payment on the principal)

Syntax:

PPMT(Rate, Per, NPer, PV [, FV] [, Type])

Description:

Returns the principal due in the given period of an investment based on periodic constant payments, and a
constant interest rate.

You can use this function, for example, to calculate how large the principal portion of the annuity is in a
particular period for a loan.

"Period" means a payment period. For example, for a loan with monthly repayments, the third period is the
third month.

The function expects the following arguments:

Rate is the interest rate (per payment period).

Per is the payment period to be evaluated.

NPer is the total number of payment periods.

PV is the present value.

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

A loan of $100,000 is taken out under the following terms:

Annual interest rate: 10%
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Repayments: monthly

Duration: 6 years

How much is the principal portion in the 32nd period (i.e., the 32nd month)?

PPMT(10%/12, 32, 72, 100000) returns -1.318.

Note that all values have to use the same time unit, months in this case, since the payments are made monthly.

Therefore, in the above formula, the yearly interest rate had to be divided by 12 to get the monthly interest rate.

Annotation:

The IPMT function is the counterpart to PPMT: It supplies the interest portion of the payment in this period.

The PMT function, on the other hand, returns the total amount of the payment (annuity) per period, that is, the
sum of the principal portion and the interest portion.

See also:

PV, ISPMT, CUMPRINC, CUMIPMT, PMT, RATE, IPMT, FV, NPER

PROB (probability)

Syntax:

PROB(Values, Probabilities, k1 [, k2])

Description:

Returns the probability that a value is inside the specified interval of values, when the individual probabilities
for each value are given.

More simply: This function sums up the respective Probabilities of the Values in this interval.

Values are the given values.

Probabilities are the probabilities associated with these values.

All Probabilities have to be in the range 0 (0%) to 1 (100%). Their sum has to be 1.

Values and Probabilities must have the same number of values, otherwise the function returns a #N/A error
value.

k1 and k2 are the bounds of the interval whose cumulative probabilities you want to calculate. If k2 is omitted,
just the probability of k1 will be returned.
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Example:

Cells A1:A3 contain the values 1, 2, 3. Cells B1:B3 contain the probabilities associated with these values: 17%,
33%, 50%.

To calculate the probability that a value is between 2 and 3:

PROB(A1:A3, B1:B3, 2, 3) returns 33% + 50%, which equals 83%

PRODUCT (product)

Syntax:

PRODUCT(Number1 [, Number2, Number3 ...])

Description:

Returns the product of the given numbers. Number1, Number2, etc., are the numbers to be multiplied.

Annotation:

When you use this function with cell references or arrays, text strings and logical values are ignored. However,
the situation is different if you insert fixed values to it: Here, text strings containing numbers are counted.
Furthermore the logical value TRUE is treated as 1 and FALSE as 0. See examples.

Example:

PRODUCT(2, 3, 4) equals 2*3*4, which equals 24

When cells A1 to A3 are filled with the values 2, 3 and 4, the following applies

PRODUCT(A1:A3) equals 2*3*4, which equals 24

Note:

PRODUCT(2, "5", TRUE) equals 2*5*1, that is 10

But: If the cells A1 to A3 are filled with 2, "5" and TRUE, the formula PRODUCT(A1:A3) returns a different
result: It returns 2, because strings and truth values are only considered if they are specified as fixed values.

See also:

SUM
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PROPER (convert text to upper/lower case)

Syntax:

PROPER(Text)

Description:

Converts all characters in a text string as follows: The first letter of each word is converted to an uppercase
letter, all other letters are converted to lowercase letters.

Example:

PROPER("good morning") returns Good Morning

PROPER("Good Morning") returns Good Morning

PROPER("GoOd MoRnInG") returns Good Morning

See also:

UPPER, LOWER

PV (present value)

Syntax:

PV(Rate, NPer, Pmt [, FV] [, Type])

Description:

Returns the present value of an investment based on periodic constant payments, and a constant interest rate.

The function expects the following arguments:

Rate is the interest rate (per payment period).

NPer is the total number of payment periods.

Pmt is the annuity (payment made for each period).

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:



723Formulas and functions

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Example:

PV(6.5%/12, 12*10, 650) equals -57244.52

This formula calculates the cash value of a loan with an interest rate of 6.5% (per year, therefore the division by
12), a term of 10 years (=12*10 months) and an annuity of 650 Euro (per month).

See also:

PPMT, NPV, PMT, RATE, IPMT, FV, NPER

QUARTILE (quartiles of a data set)

Note: QUARTILE is supplemented by the new identical function QUARTILE.INC and the completely new
function QUARTILE.EXC, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

QUARTILE(Range, n)

Description:

Returns one of the quartiles of a data set, based on a percentile range between 0 to 1 (inclusive).

Range is a range with numerical data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile to return. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, a #NUM! error value will be returned.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:
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QUARTILE(A1:A9, 3) is equivalent to PERCENTILE(A1:A9, 0.75), which returns 7

See also:

QUARTILE.INC/QUARTILE.EXC, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUARTILE.EXC (quartiles of a data set)

Syntax:

QUARTILE.EXC(Range, n)

Description:

Returns one of the quartiles of a data set, based on a percentile range between 0 to 1 (exclusive).

Range is a range with numerical data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile to return. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, a #NUM! error value will be returned.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

QUARTILE.EXC(A1:A9, 3) is equivalent to PERCENTILE.EXC(A1:A9, 0.75), which returns 7.5

Note:

The QUARTILE.EXC function supplements together with QUARTILE.INC the previous QUARTILE function.

QUARTILE.INC returns the same result as QUARTILE (values 0 to 1 inclusive).

QUARTILE.EXC (values 0 to 1 exclusive) is completely new.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUARTILE.INC (quartiles of a data set)

Syntax:

QUARTILE.INC(Range, n)

Description:

Returns one of the quartiles of a data set, based on a percentile range between 0 to 1 (inclusive).

Range is a range with numerical data – usually a reference to a cell range in which numbers to be evaluated are
entered.

n determines which quartile to return. The following values are permissible:

0: The minimum

1: The 1st quartile (25th percentile)

2: The 2nd quartile (50th percentile or median)

3: The 3rd quartile (75th percentile)

4: The maximum

If n is < 0 or > 4, a #NUM! error value will be returned.

Example:

If A1:A9 contain the values 1, 2, 3, 4, 5, 6, 7, 8, 9:

QUARTILE.INC(A1:A9, 3) is equivalent to PERCENTILE.INC(A1:A9, 0.75), which returns 7

Note:

The QUARTILE.INC function supplements together with QUARTILE.EXC the previous QUARTILE function.

QUARTILE.INC returns the same result as QUARTILE (values 0 to 1 inclusive).

QUARTILE.EXC (values 0 to 1 exclusive) is completely new.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, MEDIAN, MODE.SNGL/MODE

QUOTIENT (quotient of a division)

Syntax:

QUOTIENT(x, y)

Description:

Returns the integer part of the division of x by y.

Example:

QUOTIENT(6, 4) returns 1

See also:

MOD, MODP

RADIANS (convert degrees to radians)

Syntax:

RADIANS(Number)

Description:

Converts degrees to radians.

The following conversion formula is used:

RADIANS(x) = x * PI() / 180



727Formulas and functions

Example:

RADIANS(180) returns 3.14159... (the value of the circle number Pi)

See also:

DEGREES

RAND (random value)

Syntax:

RAND()

Description:

A new random number will be generated every time the document is recalculated.

Tip: By using the ribbon command Formula | group Update| Update data | Update calculations you can
manually recalculate a document.

Example:

RAND() returns a random number.

The following formula returns a random integer number in the range of 1 to 6, thereby simulating a dice roll:

INT(RAND()*6+1)

Tip: This can be done more easily with RANDBETWEEN(16, 6).

See also:

RANDBETWEEN

RANDBETWEEN (random value)

Syntax:

RANDBETWEEN(LowerLimit, UpperLimit)
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Description:

Returns an integer random number x in the range LowerLimit x UpperLimit

A new random number will be generated every time the document is recalculated.

Tip: By using the ribbon command Formula | group Update| Update data | Update calculations you can
manually recalculate a document.

Example:

RANDBETWEEN(1, 6) returns a random integer number in the range of 1 to 6, thereby simulating a dice roll.

See also:

RAND

RANK (rank in a data set)

Note: RANK is supplemented by the new identical function RANK.EQ and the completely new function
RANK.AVG, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

RANK(Number, Range [, Ascending])

Description:

Returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is 2,
etc. If there are duplicate values in the list, these are given the higher rank.

Number is the number whose rank you want to determine. If Number does not occur in Range, a #N/A error
value is returned.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.

Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).

Example:

If the cells A1:A6 contain 3, 2, 7, 5, 9, 7:
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RANK(9, A1:A6) returns 1

RANK(9, A1:A6, TRUE) returns 6

RANK(5, A1:A6) returns 4

RANK(7, A1:A6) returns 2

See also:

RANK.EQ/RANK.AVG, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RANK.AVG (rank in a data set)

Syntax:

RANK.AVG(Number, Range [, Ascending])

Description:

Returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is 2,
etc. If there are duplicate values in the list, these are given the average rank.

Number is the number whose rank you want to determine. If Number does not occur in Range, a #N/A error
value is returned.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.

Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).

Example:

If the cells A1:A6 contain 3, 2, 7, 5, 9, 7:

RANK.AVG(9, A1:A6) returns 1

RANK.AVG(9, A1:A6, TRUE) returns 6

RANK.AVG(3, A1:A6) returns 5

RANK.AVG(7, A1:A6) returns 2.5
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Note:

The RANK.AVG function supplements together with RANK.EQ the previous RANK function.

RANK.EQ returns the same result as RANK (for duplicate values in the list higher rank).

The RANK.AVG (for duplicate values in the list average rank) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

RANK/RANK.EQ, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RANK.EQ (rank in a data set)

Syntax:

RANK.EQ(Number, Range [, Ascending])

Description:

Returns the rank of a number in a data set. The largest number's rank is 1, the 2nd largest number's rank is 2,
etc. If there are duplicate values in the list, these are given the higher rank.

Number is the number whose rank you want to determine. If Number does not occur in Range, a #N/A error
value is returned.

Range is a range with numeric data – usually a reference to a cell range in which the given numbers are
entered.

Ascending (optional) is a logical value that lets you specify whether to use ascending or descending order:

FALSE or omitted: Use descending order (the largest number's rank is 1).

TRUE: Use ascending order (the smallest number's rank is 1).

Example:

If the cells A1:A6 contain 3, 2, 7, 5, 9, 7:

RANK.EQ(9, A1:A6) returns 1

RANK.EQ(9, A1:A6, TRUE) returns 6
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RANK.EQ(5, A1:A6) returns 4

RANK.EQ(7, A1:A6) returns 2

Note:

The RANK.EQ function supplements together with RANK.AVG the previous RANK function.

RANK.EQ returns the same result as RANK (for duplicate values in the list higher rank).

The RANK.AVG (for duplicate values in the list average rank) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

RANK/RANK.AVG, SMALL, LARGE, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK

RATE (interest rate per period)

Syntax:

RATE(NPer, Pmt, PV [, FV] [, Type] [, Guess])

Description:

Returns an estimate for the interest rate per period of an annuity, based on an investment with periodic constant
payments and a constant interest rate.

The function expects the following arguments:

NPer is the total number of payment periods.

Pmt is the payment made for each period.

PV is the present value.

FV (optional) is the future value (the total value after the last payment). If omitted, it will be set to zero.

Type (optional) is the timing of the payments:

0 or omitted: Payment at the end of each period.

1: Payment at the beginning of each period.

Guess (optional) lets you specify an estimate for the result (see note below).
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Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try altering the Guess parameter.

Example:

RATE(12*10, -650, 60000) returns 0.455087%

This formula calculates the interest rate for a loan of € 60,000 with a term of 10 years (=12*10 months) and a
payment of € 650.00 (per month) by using an iterative search technique.

The result is the interest rate per month. To obtain the annual interest rate, it must therefore be multiplied by 12.

See also:

PV, PPMT, PMT, XIRR, IPMT, RRI, FV, NPER, IRR, MIRR

REPLACE (replace text in a text string)

Syntax:

REPLACE(Text, Start, Count, NewText)

Description:

Replaces the specified part of a text string with other text.

Text is the given text string.

Start is the position of the first character to be replaced.

Count is the number of characters to be replaced.

NewText is the replacement text.

Example:

REPLACE("aaaaaa", 3, 2, "bb") returns aabbaa

REPLACE("aaaaaa", 3, 4, "bb") returns aabb

REPLACE("cccccc", 3, 2, "dddddddd") returns ccddcc

REPLACE("cccccc", 3, 4, "dddddddd") returns ccdddd

REPLACE("cccccc", 3, 6, "dddddddd") returns ccdddddd
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See also:

FIND, SEARCH, MID, SUBSTITUTE, LEFT, RIGHT, REPT

REPT (repeat text string)

Syntax:

REPT(Text, n)

Description:

Repeats the specified text string n times.

With the argument n you specify the number of repetitions. n should be an integer. Digits to the right of the
decimal point are ignored.

Example:

REPT("Text", 3) returns TextTextText

See also:

REPLACE, SUBSTITUTE

RIGHT (right part of a text string)

Syntax:

RIGHT(Text [, n])

Description:

Returns the last n characters of Text.

If n is omitted, only the last character is returned.

Example:

RIGHT("peanut", 3) returns nut
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RIGHT("peanut") returns t

See also:

LEFT, MID, REPLACE, LEN

ROMAN (Roman numeral)

Syntax:

ROMAN(Number [, Format])

Description:

Converts an Arabic numeral into a Roman numeral (as a text string).

Number 

Number should be an integer, digits right of the decimal point are ignored.

If Number equals zero, an empty text string will be returned.

If the optional argument Format is used, PlanMaker tries to create a shorter form of the Roman numeral.
Format can be any integer from 0 (do not shorten) through 4 (shorten as much as possible).

Example:

ROMAN(1999) returns MCMXCIX

ROMAN(1999, 0) returns MCMXCIX as well

ROMAN(1999, 1) returns MLMIL

ROMAN(1999, 2) returns MXMIX

ROMAN(1999, 3) returns MVMIV

ROMAN(1999, 4) returns MIM

ROOTN (n-th root)

Syntax:

ROOTN(Number [, n])
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Description:

Returns the n-th root of a number. If n is omitted, the square root is returned (n=2).

n should be an integer. Digits to the right of the decimal point are ignored.

If n is even, Number 

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Tip: Alternatively, the n-th root of a number can be calculated using the following Excel compatible function:

ROOTN(Number, n) equals POWER(Number, 1/n)

Example:

ROOTN(25) returns 5

ROOTN(-25) returns a #NUM! error value

ROOTN(125, 3) returns 5

ROOTN(-125, 3) returns -5

See also:

SQRT, POWER

ROUND (round to n digits)

Syntax:

ROUND(Number, n)

Description:

Rounds Number to n decimal places.

n is the number of decimal places.

If n is omitted, Number is rounded to the nearest integer.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of hundred (see last example).
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Example:

ROUND(1.234, 2) returns 1.23

ROUND(1.235, 2) returns 1.24

ROUND(444.222, 0) returns 444

ROUND(444.222, -2) returns 400

See also:

ROUNDDOWN, ROUNDUP, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR

ROUNDDOWN (round down to n digits)

Syntax:

ROUNDDOWN(Number, n)

Description:

Rounds a number down (towards zero) to n decimal places.

n is the number of decimal places.

If n is omitted, Number is rounded to the nearest integer.

If n is a negative value, Number is rounded to the left of the decimal point. For example, if n is -2, Number is
rounded to the nearest multiple of hundred (see second last example).

Note:

Negative numbers are not rounded down, but up (see last example). This is not mathematically correct, but for
compatibility reasons it is implemented exactly as in Microsoft Excel.

Example:

ROUNDDOWN(1.234, 2) returns 1.23

ROUNDDOWN(1.235, 2) returns 1.23

ROUNDDOWN(888.999, 0) returns 888

ROUNDDOWN(888.999, -2) returns 800

ROUNDDOWN(-7.8, 0) returns -7
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See also:

ROUNDUP, ROUND, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR

ROUNDUP (round up to n digits)

Syntax:

ROUNDUP(Number, n)

Description:

Rounds Number up (away from zero) to n decimal places.

n is the number of decimal places.

If n is omitted, Number is rounded to the nearest integer.

If n is a negative value, Number is rounded up to the left of the decimal point. For example, if n is -2, Number
is rounded up to the nearest multiple of hundred (see second last example).

Note:

Negative numbers are not rounded up, but down (see last example). This is not mathematically correct, but for
compatibility reasons it is implemented exactly as in Microsoft Excel.

Example:

ROUNDUP(1.234, 2) returns 1.24

ROUNDUP(1.235, 2) returns 1.24

ROUNDUP(444.222, 0) returns 445

ROUNDUP(444.222, -2) returns 500

ROUNDUP(-7.3, 0) returns -8

See also:

ROUNDDOWN, ROUND, MROUND, TRUNC, FIXED, INT, EVEN, ODD, CEILING, FLOOR



738Formulas and functions

ROW (row number of cells)

Syntax:

ROW([Reference])

Description:

Returns the row number(s) of a cell reference:

If Reference is a single cell, the row number of this cell is returned.

If Reference is a range of cells, their row numbers are returned as a vertical array. Note: In this case, the
formula has to be entered as an array formula (see Working with arrays).

If Reference is omitted, the row number of the cell that invokes this function is returned.

Example:

ROW(D2) returns 2

ROW(D2:F4) returns {2;3;4}

ROW() returns 5 when you use this calculation in cell A5

See also:

COLUMN, ROWS, CELL, ADDRESS, INDIRECT, OFFSET

ROWS (number of rows in a range)

Syntax:

ROWS(Range)

Description:

Returns the number of rows in the specified cell range.

Example:

ROWS(A1:D5) returns 5
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See also:

ROW, COLUMNS, AREAS

RRI (interest for fixed-interest investments)

Syntax:

RRI(Per, PV, FV)

Description:

Returns the interest rate required to obtain a specific future value after a specific period.

This function is applicable to investments with just one payment (made at the beginning) and a fixed interest
rate.

The function expects the following arguments:

Per is the number of periods. For example, if the annual interest rate is considered, a period is one year.

PV is the present value.

FV is the future value.

Example:

To obtain $5000 with a fixed-interest investment of $3000 after 10 years. How high the annual interest rate has
to be?

RRI(10, 3000, 5000) returns 0.05241 (i.e., about 5.24%)

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

In older versions of PlanMaker this function was called PCF.

See also:

PERIOD, RATE
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RSQ (square of Pearson)

Syntax:

RSQ(Range1, Range2)

Description:

Returns the determination coefficient of two data sets.

This coefficient is a measure of the strength of the linear relationship between data sets. The closer it is to 1, the
greater the correlation.

Range1 and Range2 are cell references to the two data sets. These must contain numbers. Empty cells, text and
logical values are ignored.

The data sets must have the same number of values, otherwise the function returns a #N/A error value.

Example:

If A1:A3 contains the values 2, 5, 3 and B1:B3 contains 2, 7, 4:

RSQ(A1:A3, B1:B3) returns 0.99436

Annotation:

RSQ is the square of PEARSON (Pearson's correlation coefficient).

See also:

PEARSON

SEARCH (search for text)

Syntax:

SEARCH(Text, SearchedText [, StartPos])

Description:

Returns the position of the text string SearchedText within the text string Text.
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StartPos (optional) lets you specify the position (= character) at which to start the search. If omitted, the search
starts at the first character.

The SEARCH function is not case-sensitive, i.e., it will not distinguish between uppercase and lowercase
letters. To perform a case-sensitive search, use the FIND function instead.

Example:

SEARCH("a", "Banana") returns 2

SEARCH("A", "Banana") returns 2

SEARCH("a", "Banana", 3) returns 4

SEARCH("x", "Banana") returns a #VALUE! error value, since "x" does not occur in "Banana".

See also:

FIND, REPLACE, SUBSTITUTE, EXACT, MID

SECOND (second)

Syntax:

SECOND(Time)

Description:

Returns the seconds of a time value.

Example:

SECOND("12:34:56 AM") returns 56

SECOND("09/25/2018 10:30:36") returns 36

If cell A1 contains a date with the time 10:30:36 then SECOND(A1) returns 36

See also:

HOUR, MINUTE, MILLISECONDS
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SERIESSUM (sum of a power series)

Syntax:

SERIESSUM(x, n, m, Coefficients)

Description:

Returns a power series based on the following formula:

SERIESSUM(x,n,m,a) =

a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + a4*x^(n+3m) + ...

x is the base.

n is the exponent for the first element in the series.

m is the increment for n.

Coefficients is a one-dimensional cell range or array containing the coefficients that the series elements will be
multiplied by.

The number of coefficients also determines the number of elements the power series will consist of. For
example, if 10 coefficients are given, the series will consist of 10 elements.

Example:

SERIESSUM(2, 2, 1, {1; 2; 3; 4; 5}) returns 516

See also:

POWER

SHEET (index of a worksheet)

Syntax:

SHEET([SheetName])

Description:

Returns the index of a worksheet in the current document. The first worksheet in a document returns 1, the
second sheet returns 2, etc.
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If the optional argument SheetName is given, the index of the worksheet with the specified name is returned.
Otherwise, the index of the current worksheet is returned.

Note:

The SHEET function replaces the (almost) identical SHEETNUMBER function

Background info: The SHEETNUMBER function formerly was available in PlanMaker, but not in Excel. In
Excel 2013, Microsoft introduced the same function – but with a different name: SHEET.

There is only one little difference: When the specified parameter is a cell reference, SHEET will return the
index of the worksheet that contains this reference. SHEETNUMBER, on the other hand, will read the content
of the corresponding cell and return the index of the worksheet carrying that name.

Example:

On the third worksheet in a document, SHEET() returns 3.

SHEET("Expenses") returns the index of the worksheet named "Expenses".

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

SHEETNUMBER, SHEETNAME, SHEETS, FILENAME

SHEETNAME (name of a worksheet)

Syntax:

SHEETNAME([n])

Description:

Returns the name of a worksheet.

n is the number of the worksheet whose name you want to determine. The first worksheet in the workbook is
number 1, the second is number 2, etc. If n is omitted, the current worksheet is used.

Example:

A document contains four worksheets: "Spring", "Summer", "Autumn" and "Winter" (in that order). The cursor
is currently located in a cell of the third worksheet ("Autumn"). The following applies:
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SHEETNAME() returns Autumn

SHEETNAME(1) returns Spring

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

SHEET, SHEETS, FILENAME

SHEETNUMBER (compatibility function)

Syntax:

SHEETNUMBER([SheetName])

Description:

Compatibility function for older PlanMaker documents.

This function has been replaced by the (almost) identical SHEET function

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Tip: Instead of this function, use the Excel 2013-compatible function SHEET.

See also:

SHEET, SHEETS, SHEETNAME

SHEETS (number of worksheets)

Syntax:

SHEETS([reference])
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Description:

Returns the number of referenced worksheets (both visible and hidden sheets).

If the optional argument Reference is not specified, the function returns the number of worksheets in the
current workbook.

Example:

A document contains 3 worksheets.

SHEET() returns 3.

SHEET(A1) returns 1, because of the reference to a cell in the current worksheet.

SHEET(Table1:Table2!A1) returns 2, because of the reference to cells in worksheet1 and worksheet2.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

See also:

SHEET, SHEETNAME

SIGN (sign of a number)

Syntax:

SIGN(Number)

Description:

This function returns the sign of a Number. The following values may be returned:

1, if Number is positive,

-1, if Number is negative,

0, if Number is zero.

Example:

SIGN(-5) returns -1
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See also:

ABS, NEG

SIN (sine)

Syntax:

SIN(Number)

Description:

Returns the sine of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Example:

SIN(PI()/2) returns 1

SIN(RADIANS(90)) returns 1

See also:

ASIN, COS, TAN

SINH (hyperbolic sine)

Syntax:

SINH(Number)

Description:

Returns the hyperbolic sine of Number.
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Example:

SINH(0.45) returns 0.4653

See also:

ASINH, COSH, TANH

SKEW (skewness of a distribution)

Syntax:

SKEW(Number1, Number2, Number3 [, Number4 ...])

or

SKEW(Range1 [, Range2, Range3 ...])

Description:

Returns the skewness of a probability distribution.

The skewness is a measure of the asymmetry of a distribution.

If there are more values to the right of the arithmetic mean of the distribution, you have a "right-skewed"
distribution. SKEW returns a positive value here.

The opposite case is a "left-skewed" distribution. Here, SKEW returns a negative value.

When the SKEW approaches zero, the distribution is symmetric in good approximation.

Number1, Number2, Number3, etc. are the values to be evaluated. Empty cells, text and logical values are
ignored.

At least three values have to be given, otherwise the function returns a #DIV/0! error value.

Note:

This function does not accept value pairs (x value and y value) as arguments, but only the values of the
distribution. Duplicate values must be repeated in the argument list accordingly (see example).

Example:

Measuring the height of several test persons led to the following results: 1 x 1.60m, 2 x 1.65m, 4 x 1.70m, 2 x
1.75m and 1x1.80m.

To calculate the skewness of this distribution, use the following formula:
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SKEW(1.60, 1.65, 1.65, 1.70, 1.70, 1.70, 1.70, 1.75, 1.75, 1.80) returns 4.66562E-15.

See also:

INTERCEPT, FORECAST, KURT, NORM.DIST/NORMDIST

SLN (straight-line depreciation)

Syntax:

SLN(Cost, Salvage, Life)

Description:

Returns the depreciation per period of an asset, using the straight-line depreciation method.

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Example:

Initial values: Initial cost = 6000, Salvage value = 3000, Life of asset = 5 years

SLN(6000, 3000, 5) returns 600 (per year)

See also:

SYD, DDB, DB

SLOPE (slope of a linear trend)

Syntax:

SLOPE(y_values, x_values)

Description:

Returns the slope of a best-fit line for the given values. The slope of a line is the value the y value grows when
the x value is raised by 1.
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A best-fit line is the result of a linear regression, a statistical technique that adapts a line to a set of data points
(for example, the results of a series of measurements).

For the y_values and x_values arguments, you usually specify a cell range.

Y_values are the known y values.

X_values are the known x values.

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Annotation:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-sensitive resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures measured: 8, 20, 25, 28

Cells B1:B4 contain the resistances measured: 261, 508, 608, 680

The following calculation returns the slope of a best-fit line based on these values:

SLOPE(B1:B4, A1:A4) returns 20.76799

See also:

INTERCEPT, FORECAST, PEARSON, STEYX

SMALL (k-th smallest number)

Syntax:

SMALL(Range, k)

Description:

Returns the k-th smallest value in a data set. If k=1, the smallest value will be returned, if k=2, the second
smallest value will be returned, etc.

Range is a range with numeric data – usually a reference to a cell range in which numbers are entered.

k determines which number to return.
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k must not be smaller than 1 or greater than the total number of values in Range. Otherwise, the function
returns a #NUM! error value.

Example:

If the cells A1:A5 are filled with the numbers 4, 2, 6, 5 and 9:

SMALL(A1:A5, 1) returns 2

SMALL(A1:A5, 2) returns 4

SMALL(A1:A5, 3) returns 5

etc.

See also:

LARGE, MIN, PERCENTILE.EXC/PERCENTILE.INC/PERCENTILE,
PERCENTRANK.EXC/PERCENTRANK.INC/PERCENTRANK, RANK.EQ/RANK.AVG/RANK

SORTM (sort)

Syntax:

SORTM(Range, Key [, Mode] [, Columnwise] [, Column])

Description:

This function sorts a cell range or an array according to one or more criteria and returns an array with the sorted
values.

Range is the cell range or array containing the data to be sorted. You can specify a one- or two-dimensional cell
range or an array for this purpose.

Key is a two-row cell range or array containing the sort key(s): To do this, specify a two-row cell range or a
two-row array with the following contents:

The first row must contain the relative row numbers of the rows to be sorted by. If, for example, you enter {1,3}
for the sort key, the cell range is sorted by the first and by the third row of Range.

Its second row (optional) can contain logical values that specify the sort order:

FALSE or omitted: Ascending order

TRUE: Descending order

For example, if you use {1,3; true,false} as the sort key, the cell range is sorted by the first row in descending
order and by the third row in ascending order.
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Mode (optional) is a logical value that lets you specify if PlanMaker should distinguish between uppercase and
lowercase letters:

FALSE or omitted: Ignore case of letters

TRUE: Distinguish between uppercase and lowercase letters, i.e., place text strings starting with a lowercase
letter above text strings starting with an uppercase letter.

Columnwise (optional) is a logical value that lets you specify if the data should be sorted row-wise or column-
wise:

FALSE or omitted: Sort row-wise

TRUE: Sort column-wise

If you use the optional argument Column, the function returns only a specific column (or row – if sorted
column-wise) instead of the entire data:

If omitted, all columns are returned.

If set to n, only the n-th column is returned.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

SORTM({4;2;3}, {1}) returns {2;3;4}

SORTM({4;2;3}, {1;TRUE}) returns {4;3;2}

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

SORTV, section Sorting cells

SORTV (sort)

Syntax:

SORTV(Range [, Descending] [, Mode] [, Data])
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Description:

Returns a vector containing the values of the given one-dimensional cell range, in sorted order.

Unlike the SORTM function, SORTV is applicable to one-dimensional cell ranges (vectors) only. These are
ranges that cover either only one row or only one column.

Range is the cell range or array containing the data to be sorted.

Descending (optional) lets you specify the sort order:

FALSE or omitted: Ascending order

TRUE: Descending order

Mode (optional) is a logical value that lets you specify if PlanMaker should distinguish between uppercase and
lowercase letters:

FALSE or omitted: Ignore case of letters

TRUE: Distinguish between uppercase and lowercase letters, i.e., place text strings starting with a lowercase
letter above text strings starting with an uppercase letter.

If you use the optional argument Data, the function does not return the data from Range as a result, but the data
from Data. Data must be of exactly the same size as Range.

This is useful if, for example, you create a table that contains a column with the names of athletes and a column
with their scores next to it. If you enter the column with their scores as the Range here, but the column with
their names as the Data, the result is a list of names sorted by scores.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Example:

SORTV({4;2;3}) returns {2;3;4}

SORTV({4;2;3}, TRUE) returns {4;3;2}

SORTV({4,2,3}) returns {2,3,4}

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

See also:

SORTM, section Sorting cells
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SQRT (square root)

Syntax:

SQRT(Number)

Description:

Returns the square root of a Number.

Number 

Example:

SQRT(25) returns 5

SQRT(-25) returns a #NUM! error value

See also:

ROOTN, POWER

SQRTPI (square root of x*Pi)

Syntax:

SQRTPI(Number)

Description:

Returns the square root of (Number * pi).

Number 

Example:

SQRTPI(42) equals SQRT(42*PI()), which is 11.48681381

See also:

PI, SQRT, ROOTN
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STANDARDIZE (standardized value)

Syntax:

STANDARDIZE(x, Mean, StdDev)

Description:

Returns the normalized value of x for a distribution given by mean and standard deviation.

x is the value to be normalized.

Mean is the arithmetic mean of the distribution.

StdDev is the standard deviation of the distribution.

Example:

STANDARDIZE(5, 4, 1.25) returns 0.8

See also:

AVERAGE, STDEV.S/STDEV, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

STDEV (standard deviation of a sample)

Note: STDEV is supplemented by the new identical function STDEV.S, which is available in newer versions
of Microsoft Excel (2010 or later).

Syntax:

STDEV(Number1, Number2 [, Number3 ...])

Description:

Estimates the standard deviation of a population based on a sample.

The standard deviation indicates the amount that the specified values deviate from the average value.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).
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If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The standard deviation is calculated using the "unbiased" or "n-1" method.

Example:

STDEV(2, 2, 3, 4, 1) returns 1.14018

See also:

STDEV.S, STDEVA, STDEV.P/STDEVP, VAR.P/VARP, VAR.S/VAR, AVEDEV, STANDARDIZE,
DEVSQ

STDEVA (standard deviation of a sample)

Syntax:

STDEVA(Value1, Value2 [, Value3 ...])

Description:

The STDEVA function is almost identical to the STDEV function (see note). It estimates the standard deviation
of a population based on a sample, including logical values and text.

The standard deviation indicates the amount that the specified values deviate from the average value.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).

Note:

Unlike the STDEV function, STDEVA also evaluates logical values and text: FALSE evaluates as 0. TRUE
evaluates as 1. Text evaluates as 0.

Empty cells, however, are also ignored here.

Annotation:

The standard deviation is calculated using the "unbiased" or "n-1" method.
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Example:

STDEVA(2, 2, 3, 4, 1) returns 1.14018

See also:

STDEV.S/STDEV, STDEVPA

STDEVP (standard deviation of entire population)

Note: STDEVP is supplemented by the new identical function STDEV.P, which is available in newer
versions of Microsoft Excel (2010 or later).

Syntax:

STDEVP(Number1, Number2 [, Number3 ...])

Description:

Returns the standard deviation of an entire population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the standard deviation of a sample,
use the STDEV.S/STDEV function instead. This returns an estimate of the standard deviation.

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEVP(2, 2, 3, 4, 1) returns 1.0198

See also:

STDEV.P, STDEVPA, STDEV.S/STDEV, VAR.P/VARP, VAR.S/VAR
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STDEV.P (standard deviation of entire population)

Syntax:

STDEV.P(Number1, Number2 [, Number3 ...])

Description:

Returns the standard deviation of an entire population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the standard deviation of a sample,
use the STDEV.S/STDEV function instead. This returns an estimate of the standard deviation.

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEV.P(2, 2, 3, 4, 1) returns 1.0198

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

STDEVP, STDEVPA, STDEV.S/STDEV, VAR.P/VARP, VAR.S/VAR

STDEVPA (standard deviation of entire population)

Syntax:

STDEVPA(Value1, Value2 [, Value3 ...])
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Description:

The STDEVPA function is almost identical to the STEVP function (see note). It returns the standard deviation
of an entire population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the standard deviation of a sample,
use the STDEVA function instead. This returns an estimate of the standard deviation.

Note:

Unlike the STDEVP function, STDEVPA also evaluates logical values and text: FALSE evaluates as 0. TRUE
evaluates as 1. Text evaluates as 0.

Empty cells, however, are also ignored here.

Annotation:

The standard deviation is calculated using the "biased" or "n" method.

Example:

STDEVPA(2, 2, 3, 4, 1) returns 1.0198

See also:

STDEV.P/STDEVP

STDEV.S (standard deviation of a sample)

Syntax:

STDEV.S(Number1, Number2 [, Number3 ...])

Description:

Estimates the standard deviation of a population based on a sample.

The standard deviation indicates the amount that the specified values deviate from the average value.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.
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Annotation:

The standard deviation is calculated using the "unbiased" or "n-1" method.

Example:

STDEV.S(2, 2, 3, 4, 1) returns 1.14018

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

STDEV, STDEV.P/STDEVP, VAR.P/VARP, VAR.S/VAR

STEYX (standard error of a linear regression)

Syntax:

STEYX(y_values, x_values)

Description:

Returns the standard error of a linear regression.

The standard error is a measure of the reliability of a linear regression: the greater the standard error, the more
the estimated values deviate from the actual values.

For the y_values and x_values arguments, you usually specify a cell range.

Y_values are the known y values.

X_values are the known x values.

Note:

Note that this function expects the y_values first and then the x_values – not the other way around.

Annotation:

The linear regression is performed with this function using the least squares method.
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Example:

The resistance of a temperature-sensitive resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures measured: 8, 20, 25, 28

Cells B1:B4 contain the resistances measured: 261, 508, 608, 680

The following calculation returns the standard error of the resistances predicted by linear regression:

STEYX(B1:B4, A1:A4) returns 4.97351

See also:

INTERCEPT, SLOPE, FORECAST

SUBSTITUTE (replace text in a text string)

Syntax:

SUBSTITUTE(Text, OldText, NewText [, n])

Description:

Searches for OldText in a text string. If found, OldText will be replaced by NewText.

Text is the given text string.

OldText is the text to be replaced. Note: This function is case-sensitive, i.e. it distinguishes between uppercase
and lowercase letters.

NewText is the replacement text.

n (optional) lets you specify which occurrence of OldText to replace. If omitted, all occurrences will be
replaced.

Example:

SUBSTITUTE("aabbaabb", "aa", "xx") returns xxbbxxbb

SUBSTITUTE("aabbaabb", "aa", "xx", 2) returns aabbxxbb

SUBSTITUTE("aabbaabb", "AA", "xx") returns aabbaabb

See also:

FIND, SEARCH, REPLACE, REPT
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SUBTOTAL (calculations without hidden cells)

Syntax:

SUBTOTAL(FunctionID, Range1 [, Range2, Range3 ...])

Description:

Applies one of the arithmetic functions listed below to the specified cell range(s), ignoring all cells that are
currently hidden.

In details: If you use the commands from the ribbon tab Data | group Filter to apply a filter to a cell range and
then perform arithmetic calculations on this range, cells that have been filtered out are still included. If,
however, you use the SUBTOTAL function, filtered cells will be ignored.

Range1, Range2, etc. are the cell ranges you want to evaluate.

FunctionID is a number between 1 and 11 that specifies which arithmetic function to apply:

Value Function Explanation

1: AVERAGE (arithmetic mean)

2: COUNT (number of cells filled with numbers)

3: COUNTA (number of cells not empty)

4: MAX (maximum)

5: MIN (minimum)

6: PRODUCT (product)

7: STDEV (standard deviation of a sample)

8: STDEVP (standard deviation of entire population)

9: SUM (sum)

10: VAR (variance of a sample)

11: VARP (variance of entire population)

For example, if you set FunctionID to 9, SUBTOTAL returns the sum of the specified cell range(s) – ignoring
all cells that have been filtered out by the commands of the Sort and filter button on the ribbon tab Data |
group Filter.

Ignoring manually hidden cells as well:

There's a second variant of this function. In this case, all rows are ignored that have been hidden manually
(using e.g. the ribbon command Home | group Cells | Visibility | Hide rows or the ribbon command Data |
group Outliner | Group). To use this variant, simply set the FunctionID to a value between 101 and 111
instead of a value between 1 and 11, as shown in the following table:
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Value Function Explanation

101: AVERAGE (arithmetic mean)

102: COUNT (number of cells filled with numbers)

103: COUNTA (number of cells not empty)

104: MAX (maximum)

105: MIN (minimum)

106: PRODUCT (product)

107: STDEV (standard deviation of a sample)

108: STDEVP (standard deviation of entire population)

109: SUM (sum)

110: VAR (variance of a sample)

111: VARP (variance of entire population)

For example, if you set FunctionID to 9, SUBTOTAL returns the sum of the specified cell range(s) – ignoring
all cells that filtered out by the commands of the ribbon tab Home | group Filter. In addition, all rows will be
ignored that were hidden manually using the ribbon commands Home | group Cells | Visibility | Hide rows and
Data | group Outliner | Group.

Please note: Only hidden rows will be ignored, hidden columns are still included in the calculations.

Example:

SUBTOTAL(9, A1:A10) returns the sum of the range A1:A10, ignoring all cells filtered out by the commands
of the ribbon tab Home | group Filter.

See also:

For more information on filters, see Filtering cells by their contents.

SUM (Sum)

Syntax:

SUM(Number1 [, Number2, Number3 ...])

Description:

Returns the sum of the given numbers.

Number1, Number2, etc., are single values, cell ranges, or arrays containing the values to be summed.
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If you use this function with cell references (for example A1:A3), only numbers are considered while text
strings and logical values occurring in the referenced cells are ignored.

If you use this function with fixed values that you typed in directly, numbers entered as a text string (for
example, "42") are included. Furthermore the logical value TRUE evaluates as 1 and FALSE evaluates as 0.
See examples below.

Example:

SUM(1, 2, 3, 4) equals 1+2+3+4, which is 10

If the cells A1:A4 contains the values 1, 2, 3 and 4:

SUM(A1:A4) equals 1+2+3+4, which is 10

Please note:

If the cells A1:A3 contain 1, "2" and TRUE:

SUM(A1:A3) returns 1, since the text string and the logical value are ignored.

They are counted only if they were typed in directly as fixed values:

SUM(1, "2", TRUE) returns 1+2+1, which is 4

Annotation:

There are some special terms for the SUM formula, where PlanMaker automatically completes the formula with
additional functions. The following examples illustrate how it works:

If you enter SUM(A5:A), all values in column A are added, except A1:A4.

If you enter SUM(E2:2), all values in row 2 are added, except A2:D2.

If you enter SUM(A:A10), all values of A1:A10 are added.

If you enter SUM(2:E2), all values of A2:E2 are added.

Tip:

You can also use the AutoSum icon  on the ribbon tab Home | group Contents to quickly calculate the
sum of a specific cell range:

When you click this icon in a cell directly below a group of cells containing numbers, it will insert the SUM
function for this cell range there.

Or: When you first select a range of cells containing numbers, it will insert the sum of this cell range directly
below these cells.

You can use this icon with several other arithmetic functions as well. When you click on the arrow to the right
of this icon, a dropdown list containing all available functions will open (for example, Count, Product, Average,
etc.). Select the desired function and proceed as described above.
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See also:

PRODUCT, SUMPRODUCT, SUMIF, SUMIFS, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMIF (sum if condition is true)

Syntax:

SUMIF(Range, Criterion [, SumRange])

Description:

Returns the sum of those values in a cell range that fulfill the specified criterion.

Range is the cell range to be evaluated.

Criterion is the condition that the values in Range have to fulfill to be included:

Use numbers or text (like "42" or "bolts") to obtain the sum of all cells that contain that value.

Use conditions (like ">10" or "<=5") to sum all cells that match the specified condition.

Note: Criteria always have to be surrounded by double quotation marks (").

SumRange (optional) lets you specify the cell range containing the values to be summed. If omitted, the values
in Range will be summed.

Example:

If the cells A1:A5 contain the values 1, 2, 3, 2, 1. The following applies:

SUMIF(A1:A5, "2") returns 2+2, which is 4

SUMIF(A1:A5, ">=2") returns 2+3+2, which is 7

You enter your daily income in a table – like this:

How much is the sum of the sales, if you only consider sales larger than € 40?
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SUMIF(D2:D5, ">40") results in 100.80 Euro

How many flowers of the type "roses" were sold?

SUMIF(C2:C5, "Roses", B2:B5) returns 18

In the above formula, the optional SumRange argument was used: The Range C2:C5 (that is, the type) was
searched, but the numbers to be added were taken from the SumRange B2:B5 (that is, the number of pieces).

See also:

AVERAGEIF, AVERAGEIFS, SUM, SUMIFS, COUNTIF, COUNTIFS

SUMIFS (sum if conditions are true)

Syntax:

SUMIFS(SumRange, Range1, Criterion1 [, Range2, Criterion2 ...])

Description:

Returns the sum of those values in a cell range that fulfill all of the specified criteria.

This function is similar to the SUMIF function, but allows you to specify more than just one range/criterion to
be searched.

Apart from that, the order of the parameters is different: In SUMIF, SumRange is the last parameter – in
SUMIFS, it is the first.

SumRange is the cell range containing the values to be summed.

Range1 is the first cell range to be checked for the specified criterion. This range must have the same
dimensions as SumRange.

Criterion1 is the condition that the values in Range1 have to fulfill to be included:

Use numbers or text (like "42" or "bolts") to obtain the sum of all cells that contain that value.

Use conditions (like ">10" or "<=5") to sum all cells that match the specified condition.

Note: Criteria always have to be surrounded by double quotation marks (").

Unlike the SUMIF function, SUMIFS allows you to specify more than just one cell range and criterion to be
checked. If you do so, only occurrences where all criteria are fulfilled are included in the calculation of the
sum.

Compatibility notes:

This function is not supported by the .xls file format (used in Microsoft Excel 2003 and earlier). If you save a
document in this format, all calculations using this function will be replaced by their last result as a fixed value.
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Accordingly, if you use this function, you should not save your document in the "Microsoft Excel 97-2003
(.xls)" file format, but choose one of the following formats instead:

§ "PlanMaker document (.pmdx or .pmd)" 

§ or: "Microsoft Excel 2007-2021 (.xlsx)"

Example:

SUMIFS(A1:A10, C1:C10, ">1", C1:C10, "<2")

This formula returns the sum of only those cells in the cell range A1:A10 where the corresponding cell in the
range C1:C10 is greater than 1 and less than 2.

See also:

AVERAGEIF, AVERAGEIFS, SUM, SUMIF, ZÄHLENWENN, COUNTIFS

SUMPRODUCT (sum of products)

Syntax:

SUMPRODUCT(Range1 [, Range2, Range3 ...])

Description:

Multiplies the corresponding elements of two or more arrays and returns the sum of these products.

Range1, Range2, etc., are cell ranges or arrays containing the values to be evaluated. As a rule, the cell ranges
in which the values are contained must be specified here.

All ranges must have the same dimensions (height and width), otherwise the function returns a #N/A error
value.

Empty cells, text strings and logical values evaluate as zero.

Example:

You have created a document in which you enter your inventories.

The document contains two sections of equal size. In the first one the quantities of the articles are entered. In
the second section the corresponding prices per unit are entered.
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In order to calculate the total value of all articles, the quantities of each article must be multiplied by their
respective price per unit. Finally, the sum of these products must be created.

This entire calculation can be combined with the SUMPRODUCT function:

SUMPRODUCT(B4:C6, B11:C13) returns 12710.

So there are currently articles with a total value of € 12710.

See also:

SUM, SUMSQ, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMSQ (sum of squares)

Syntax:

SUMSQ(Number1 [, Number2, Number3 ...])

Description:

Returns the sum of the squares of the given numbers.

Example:

SUMSQ(1, 2, 3) equal 1^2 + 2^2 + 3^2, which is 14.
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See also:

SUM, SUMPRODUCT, SUMXMY2, SUMX2MY2, SUMX2PY2

SUMX2MY2 (sum of x^2 - y^2)

Syntax:

SUMX2MY2(Range1, Range2)

Description:

Returns the sum of the difference of squares of corresponding values in two arrays.

The equation for this function is:

SUMX2MY2 = å(x^2 - y^2)

Range1 and Range2 are the arrays whose SumX2MY2 is to be calculated. As a rule, the cell ranges in which
the values are contained must be specified here.

Both ranges must have the same dimensions (height and width), otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numerical value (text string or logical value)
are ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMX2MY2(A1:A3, B1:B3) here, this is equivalent to the following calculation:

(9^2) - (1^2) + (4^2) - (0^2) + (7^2) - (5^2)

The result is 120.

See also:

SUM, SUMPRODUCT, SUMX2PY2, SUMXMY2, SUMSQ
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SUMX2PY2 (sum of x^2 + y^2)

Syntax:

SUMX2PY2(Range1, Range2)

Description:

Returns the sum of the sum of squares of corresponding values in two arrays.

The equation for this function is:

SUMX2PY2 = å(x^2 + y^2)

Range1 and Range2 are the arrays containing the values to be evaluated. As a rule, the cell ranges in which the
values are contained must be specified here.

Both ranges must have the same dimensions (height and width), otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numerical value (text string or logical value)
are ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMX2PY2(A1:A3, B1:B3) here, this is equivalent to the following calculation

(9^2) + (1^2) + (4^2) + (0^2) + (7^2) + (5^2)

The result is 172.

See also:

SUM, SUMPRODUCT, SUMX2MY2, SUMXMY2, SUMSQ

SUMXMY2 (sum of (x - y)^2)

Syntax:

SUMXMY2(Range1, Range2)
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Description:

Returns the sum of squares of differences of corresponding values in two arrays.

The equation for this function is:

SUMXMY2 = å(x - y)^2

Range1 and Range2 are the arrays whose SumXMY2 is to be calculated. As a rule, the cell ranges in which the
values are contained must be specified here.

Both ranges must have the same dimensions (height and width), otherwise the function returns a #N/A error
value.

Pairs of values where at least one value is an empty cell or a non-numerical value (text string or logical value)
are ignored.

Example:

Cells A1 to A3 contain the following values: 9, 4, 7

Cells B1 to B3 contain the following values: 1, 0, 5

If you calculate SUMXMY2(A1:A3, B1:B3) here, this is equivalent to the following calculation

(9-1)^2 + (4-0)^2 + (7-5)^2

The result is 84.

See also:

SUM, SUMPRODUCT, SUMX2MY2, SUMX2PY2, SUMSQ

SWITCH (categorize initial value)

Syntax:

SWITCH(Calculation, Result1, Value1 [, Result2, Value2 ...] [, DefaultValue])

Description:

This function checks an initial value and compares it to a series of defined values for the first match.

Calculation is the initial value and can be any expression.

Result1 is the first element to be compared with the initial Calculation value.

Value1 is to be returned if Result1 matches the initial value for Calculation.

Result2; Value2 (optional) is the second compared element etc.
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As soon as the first match is found, its assigned value will be returned.

Note:

If no match is found, the #N/A error is returned.

However, you can instead specify a DefaultValue at the end of the formula, which will be returned if no match
is found (see example 2 below).

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

Example 1:

If a specific number is found in a cell A1, a name defined for this purpose should be output. The following key
applies: 1 stands for Lisa, 2 stands for Peter, 3 stands for Anna.

The formula SWITCH(A1, 1, "Lisa", 2, "Peter", 3, "Anna") then returns, for example

If cell A1 contains the number 1 = Lisa

If cell A1 contains the number 2 = Peter

If cell A1 contains the number 3 = Anna

If cell A1 contains anything other than 1, 2, or 3, the formula returns the result #N/A because no match was
found. Instead, you can also determine which default value the formula generally returns if no match is found
(see example 2).

Example 2:

You have the same initial situation as in example 1. Set a default value at the end of the formula that appears if
no match is found:

SWITCH(A1, 1, "Lisa", 2, "Peter", 3, "Anna", "no match")

For example, if cell A1 contains 4, the result "no match" is returned.

See also:

IF, IFS, VLOOKUP, CHOOSE

SYD (sum-of-years’ digits depreciation)

Syntax:

SYD(Cost, Salvage, Life, Per)
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Description:

Returns the depreciation of an asset for the specified period, using the sum-of-years' digits method.

The function expects the following arguments:

Cost = Initial cost of asset

Salvage = Salvage value (value at the end of the depreciation)

Life = Life of asset (in number of periods)

Per = Period to evaluate (in the same time unit as Life)

Note:

This function is only partially applicable to the tax law of some countries (e.g. Germany)!

Example:

For a machine purchased for € 200,000 that is used for 10 years and then has a salvage value of € 10,000, the
following annual depreciation amount must be applied for the first year:

SYD(200000, 10000, 10, 1) returns 34545.45 (depreciation in year 1)

See also:

DBB, DB, SLN

T (convert value into text string)

Syntax:

T(Value)

Description:

Converts a value to a text string.

The specified value must be a text string, otherwise the function returns an empty text string.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert values into text strings,
where necessary.
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Example:

T("Text") returns Text

T("42") returns 42

T(42) returns an empty text string

T(TRUE) returns an empty text string

See also:

N, VALUE, TEXT

TAN (tangent)

Syntax:

TAN(Number)

Description:

Returns the tangent of an angle.

The angle must be specified in radians.

Tip:

You can use the RADIANS function to convert an angle given in degrees into radians.

Example:

TAN(PI()/4) returns 1

TAN(RADIANS(45)) returns 1

See also:

ATAN, ATAN2, COT, SIN, COS
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TANH (hyperbolic tangent)

Syntax:

TANH(Number)

Description:

Returns the hyperbolic tangent of Number.

Example:

TANH(0.45) returns 0.4219

See also:

ATANH, COSH, SINH

TDIST (t-distribution)

Note: TDIST is supplemented by the new functions T.DIST.2T, T.DIST.RT and T.DIST with additional
functionalities, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

TDIST(X, DegreesFreedom, Tails)

Description:

Returns the probability of the Student's t-distribution.

X 

DegreesFreedom 
the right of the decimal point are ignored.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution
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See also:

T.DIST.2T/T.DIST.RT/T.DIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

T.DIST (t-distribution)

Syntax:

T.DIST(X, DegreesFreedom, Cumulative)

Description:

Returns the probability of the Student's t-distribution.

X 

DegreesFreedom 
the right of the decimal point are ignored.

Cumulative determines the type of function as a switch: If you enter the value TRUE, the cumulative
distribution function of the left-tailed Student's t-distribution is calculated. By entering the value FALSE, the
probability density function of the Student's t-distribution is calculated.

Note:

The T.DIST function supplements together with T.DIST.2T and T.DIST.RT the previous TDIST function,
whereby T.DIST has the additional argument Cumulative.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

T.DIST.2T/T.DIST.RT/TDIST, T.INV/T.INV.2T/TINV, T.TEST/TTEST

T.DIST.2T (t-distribution two-tailed)

Syntax:

T.DIST.2T(X, DegreesFreedom)
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Description:

Returns the probability of the two-tailed Student's t-distribution.

X 

DegreesFreedom 
the right of the decimal point are ignored.

Note:

The T.DIST.2T function supplements together with T.DIST.RT and T.DIST the previous TDIST function,
whereby T.DIST.2T returns the same result as TDIST with the argument Tails=2.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

T.DIST.RT/T.DIST/TDIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

T.DIST.RT (t-distribution right-tailed)

Syntax:

T.DIST.RT(X, DegreesFreedom)

Description:

Returns the probability of the right-tailed Student's t-distribution.

X 

DegreesFreedom 
the right of the decimal point are ignored.

Note:

The T.DIST.RT function supplements together with T.DIST.2T and T.DIST the previous TDIST function,
whereby T.DIST.RT returns the same result as TDIST with the argument Tails=1.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

T.DIST.2T/T.DIST/TDIST, T.INV.2T/T.INV/TINV, T.TEST/TTEST

TEXT (convert number into text string)

Syntax:

TEXT(Number, Format)

Description:

Converts a number to a text string in the specified number format.

Format is a text string specifying the desired format. Enter a corresponding text string here. It has to be built
like a format string for user-defined number formats that you specify in the dialog box of the ribbon tab Home |
group Number  (see Structure of a custom number format).

Annotation:

To change the format of numbers without having to convert them to a text string, choose the commands of the
ribbon tab Home | group Number and select the desired number format.

Example:

TEXT("9/25/2018", "MM/DD/YY") returns 09/25/18 (as a text string)

TEXT(2.715, "0.00 ""USD""") returns 2.72 USD (as a text string)

See also:

VALUE, T, N, FIXED

TEXTJOIN (concatenate strings with separators)

Syntax:

TEXTJOIN(Separator, IgnoreEmptyCells, String1 [, String2 ...])
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Description:

Combines two or more text strings into one text string. Unlike the CONCAT function, you can use TEXTJOIN
to specify separators between text strings. You can also specify whether empty cells should be ignored.

Separator is the desired separator between text strings. If omitted, no separator is used.

IgnoreEmptyCells determines whether empty cells should be ignored. TRUE or omitted ignores empty cells,
FALSE also concatenates empty cells.

String1, String2 etc. are the cells with text strings to be connected.

Example:

In the figure below, line G shows the result for the following formulas:

In row2 the formula is TEXTJOIN(",", TRUE, A2:E2)

In row3 (with an empty cell) the formula is TEXTJOIN(",", TRUE, A3:E3)

In row4 (with an empty cell) the formula is TEXTJOIN(",", FALSE, A4:E4)

Compatibility notes:

Microsoft Excel supports this function only in version 2019 or later. In older versions, the function is unknown.

See also:

CONCAT, CONCATENATE

TIME (create time)

Syntax:

TIME(Hour, Minute, Second)

Description:

Returns a serial date value based on the specified Hour, Minute and Second.
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Example:

TIME(0, 20, 0) returns 0.01389, the serial date value for the corresponding time. PlanMaker automatically
applies the number format "Date/Time" to it (e.g., 00:20:00 is displayed).

See also:

TIMEVALUE, DATE, DATEVALUE

TIMEDIFF (time difference)

Syntax:

TIMEDIFF(StartTime, EndTime)

Description:

Returns the time elapsed between two time values.

StartTime is the start time. EndTime is the end time.

Both can be either time values or date values including a time. Please note that in the latter case, both
StartTime and EndTime have to include a date, otherwise a #VALUE! error value is returned.

Note:

Compared to simply subtracting time values, this function has the following advantage when EndTime is
smaller than StartTime:

An employee starts his shift, for example, at 10:00 pm and leaves at 6:00 am. If calculating his hours of work
by subtracting 10:00 pm from 6:00 am, the result would be -16 hours. If the TIMEDIFF function is used, the
correct result (8 hours) is returned.

Example:

TIMEDIFF("8:00 AM", "4:00 PM") returns 8:00

TIMEDIFF("10:00 PM", "6:00 AM") returns 8:00

TIMEDIFF("10/01/2018 10:00 PM", "10/02/2018 6:00 AM") returns 8:00

Compatibility notes:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.
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See also:

TIME, TIMEVALUE, DAYS/DAYSP, DAYS360

TIMEVALUE (convert text into time)

Syntax:

TIMEVALUE(Text)

Description:

Converts a text string representing a date to a serial time value.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert values into date/time
values, where necessary.

Example:

TIMEVALUE("10:30:00 am") returns 0.4375.

If you now format this using the options of the ribbon tab Home | group Number  in one of the date/time
formats (for example h:mm), the cell will display the date behind this value: 10:30.

See also:

DATEVALUE, DATE, TIME

TINV (percentiles of the t-distribution)

Note: TINV is supplemented by the new identical function T.INV.2T and the completely new function
T.INV, which are available in newer versions of Microsoft Excel (2010 or later).

Syntax:

TINV(Probability, DegreesFreedom)
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Description:

Returns the inverse of the two-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom 
the right of the decimal point are ignored.

Please note: The result of this function is calculated using an iterative search technique. If PlanMaker does not
find a result after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and aborts the approximation.

See also:

T.INV.2T/T.INV, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

T.INV (percentiles of the t-distribution left-tailed)

Syntax:

T.INV(Probability, DegreesFreedom)

Description:

Returns the inverse of the left-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom 
the right of the decimal point are ignored.

Please note: The result of this function is calculated using an iterative search technique. If PlanMaker does not
find a result after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and aborts the approximation.

Note:

The T.INV function supplements together with T.INV.2T the previous TINV function.

T.INV.2T returns the same result as TINV (two-tailed percentiles).

T.INV (left-tailed percentiles) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

TINV/T.INV.2T, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

T.INV.2T (percentiles of the t-distribution two-tailed)

Syntax:

T.INV.2T(Probability, DegreesFreedom)

Description:

Returns the inverse of the two-tailed Student's t-distribution function (i.e., percentiles of this distribution).

Probability is the two-tailed probability to be evaluated. Must be in the range 0 to 1.

DegreesFreedom 
the right of the decimal point are ignored.

Please note: The result of this function is calculated using an iterative search technique. If PlanMaker does not
find a result after 100 iterations that deviates less than ±3x10^-7 from Probability, it displays the error value
#N/A and aborts the approximation.

Note:

The T.INV.2T function supplements together with T.INV the previous TINV function.

T.INV.2T returns the same result as TINV (two-tailed percentiles).

T.INV (left-tailed percentiles) is completely new.

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

TINV/T.INV, T.TEST/TTEST, T.DIST.2T/T.DIST.RT/T.DIST/TDIST
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TODAY (current date)

Syntax:

TODAY()

Description:

Returns the current date (without time).

Note:

The result is a serial date number. PlanMaker automatically formats it in date format so that it will be displayed
as a date. Using the options from the ribbon tab Home | group Number , you can adjust the date format
displayed to your needs.

Example:

TODAY() results in 07/31/2018

See also:

NOW, CREATEDATE

TRANSPOSE (transpose matrix)

Syntax:

TRANSPOSE(Array)

Description:

Returns the transpose of a matrix, i.e., swaps its columns with its rows. When you transpose, for example, a 2x4
matrix, the result is a 4x2 matrix.

Array is a cell range or array containing the matrix to be evaluated.

Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.
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Please note that the range you have to select before entering the formula must have the correct dimensions. If
the matrix consists of x rows and y columns, the resulting range must have y rows and x columns.

Example:

TRANSPOSE({1,2,3;4,5,6}) returns {1,4;2,5;3,6}

See also:

Section Working with arrays, MDETERM, MINVERSE, MMULT, MSOLVE

TREND (values of a linear regression)

Syntax:

TREND(y_values [, x_values] [, New_x_values] [, Constant])

Description:

Returns the values of a linear regression.

Linear regression is a statistical technique that adapts a line (called "trendline" or "best-fit line") to a set of data
points (for example, the results of a series of measurements).

The TREND function returns an array with the y values of a trendline calculated from the given y values and x
values.

In detail, the function expects the following arguments:

y_values: Here you specify the existing y-coordinates, that is, the dependent values. y_values can be either a
cell reference or an array.

x_values: Here you can optionally specify the x-coordinates, that is, the independent values. Also x_values can
be either a cell reference or an array. If x_values are omitted, the values 1, 2, 3, ... will be used automatically.
(according to the number of existing y_values).

New_x_values (optional) are the x values for which you want to determine the corresponding y values on the
curve. If omitted, the values in x_values will be used. However, if required, you can specify other x-coordinates
with New_x_values. New_x_values can also be either a cell reference or an array.

Constant (optional) is a logical value that lets you specify if the constant b (the y-intercept point) should be
calculated automatically or forced to equal zero:

TRUE or omitted: b will be calculated from the given data.

FALSE: b is forced to equal 0 (zero). This forces the trendline to run through the zero point. The m
coefficient(s) are adjusted accordingly.
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Note:

Formulas using this function have to be entered as an array formula. For more information, see Working with
arrays.

Annotation:

The linear regression is performed with this function using the least squares method.

Example:

The resistance of a temperature-sensitive resistor has been measured at several temperatures.

Cells A1:A4 contain the temperatures measured: 8, 20, 25, 28

Cells B1:B4 contain the resistances measured: 261, 508, 608, 680

The following calculation returns an array with the y coordinates of a best-fit line calculated from these values:

TREND(B1:B4, A1:A4)

See also:

LINEST, LOGEST, GROWTH, FORECAST

TRIM (remove spaces from text)

Syntax:

TRIM(Text)

Description:

Removes all spaces from the beginning and the end of the specified text string.

Example:

TRIM("    Text  ") returns Text

See also:

CLEAN
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TRIMMEAN (mean without marginal values)

Syntax:

TRIMMEAN(Area, Percentage)

Description:

Returns the mean of the values in the middle of a data set (by excluding the specified percentage of extreme
values).

"Extreme values" are the smallest and largest values of a data set. These are often "outliers" (untypically low or
high values, for example due to a measurement error).

Area is the cell range or array to evaluate.

Percentage is the percentage of values to be excluded.

If, for example, 100 values are given and Percentage is set to 10%, 10 values will be excluded: 5 from the
bottom and 5 from the top.

Note: For symmetry, the number of excluded values will automatically be rounded down to a multiple of 2. For
example, if 30 values are given and Percentage is set to 10%, only 2 values will be excluded instead of 3.

Example:

Cells A1:A10 contain the following values: 43, 45, 42, 0, 44, 45, 42, 1234, 40, 41

As you can see, two values are exceptionally low/high (e.g., because of a measuring error): 0 and 1234. Thus,
using the AVERAGE function would return an unusable result:

AVERAGE(A1:A10) returns 159.2

If you use TRIMMEAN instead and, for example, exclude 20% of the top and bottom values – in this case,
these are ideally exactly the two outliers among the 10 values – a usable average value is returned:

TRIMMEAN(A1:A10, 20%) returns 42.75

See also:

AVERAGE, GEOMEAN, HARMEAN
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TRUE (logical value TRUE)

Syntax:

TRUE()

Description:

Returns the logical value TRUE.

See also:

FALSE

TRUNC (truncate a number)

Syntax:

TRUNC(Number [, n])

Description:

Returns the given number truncated to n digits after the decimal point.

n is the number of decimal places.

If n is omitted, Number is truncated to an integer.

If n is a negative value, Number is truncated to the left of the decimal point (see last example).

Example:

TRUNC(5.779) returns 5

TRUNC(5.779, 2) returns 5.77

TRUNC(1234, -2) returns 1200

Annotation:

To obtain the decimal places use the DECIMALS function.
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See also:

ROUNDDOWN, ROUNDUP, DECIMALS, ROUND

TTEST (t-test)

Note: TTEST is supplemented by the new identical function T.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

TTEST(Array1, Array2, Tails, Type)

Description:

Returns the result of a Student's t-test.

The t-Test is typically used to test the difference of the means of two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution

Type is the type of t-test:

1: dependent samples ("paired")

2: independent samples, equal variances ("homoscedastic")

3: independent samples, different variances ("heteroscedastic")

See also:

T.TEST, T.INV.2T/T.INV/TINV, T.DIST.2T/T.DIST.RT/T.DIST/TDIST
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T.TEST (t-test)

Syntax:

T.TEST(Array1, Array2, Tails, Type)

Description:

Returns the result of a Student's t-test.

The t-Test is typically used to test the difference of the means of two samples.

Array1 and Array2 are the two arrays (samples) to be evaluated.

Tails is the number of distribution tails:

1: One-tailed distribution

2: Two-tailed distribution

Type is the type of t-test:

1: dependent samples ("paired")

2: independent samples, equal variances ("homoscedastic")

3: independent samples, different variances ("heteroscedastic")

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

TTEST, T.INV.2T/T.INV/TINV, T.DIST.2T/T.DIST.RT/T.DIST/TDIST

TYPE (type of a value)

Syntax:

TYPE(Value)



790Formulas and functions

Description:

Returns the type of the specified Value.

The following table shows which number results for which type:

"Value" is a ... Result

Number or empty cell 1

Text string 2

Logical value 4

Error value 16

Array 64

Example:

TYPE(42) returns 1

If A1 contains the text string "Text":

TYPE(A1) returns 2

See also:

ERRORTYPE

UPPER (convert text to upper case)

Syntax:

UPPER(Text)

Description:

Converts all characters in a text string to upper case letters.

Example:

UPPER("PlanMaker") returns PLANMAKER
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See also:

PROPER, LOWER

USERFIELD (output user info)

Syntax:

USERFIELD(FieldName)

Description:

Returns the content of one of the fields with your user information (name, address, etc.) entered in PlanMaker's
settings dialog.

Note: You can edit your user information by choosing the command File | Options , switching to the
General tab and clicking the User info button.

FieldName is the name of the field to be returned (see table below).

Uppercase and lowercase letters can be mixed. But please note that, if entered directly, FieldName has to be
surrounded by double quotation marks (") – as in USERFIELD("User.City").

FieldName can be one of the following text strings:

User info field Field name

Title User.Title

Name User.Name

Initials User.Initials

Company User.Company

Department User.Department

Address 1 User.Address 1

Address 2 User.Address 2

State, ZIP User.ZIP

City User.City

Country User.Country

Phone 1 User.Phone 1

Phone 2 User.Phone 2

Phone 3 User.Phone 3
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Fax User.Fax

E-mail 1 User.E-mail 1

E-mail 2 User.E-mail 2

E-mail 3 User.E-mail 3

Web site User.Website

Compatibility note 1:

This function is not supported by Microsoft Excel. If you save a document in Excel format, all calculations
using this function will be replaced by their last result as a fixed value.

Compatibility note 2:

In PlanMaker 2016 and older, there were two sets of user data: "User (home)" and "User (business)". This was
reduced to one set since PlanMaker 2018. When you open an old document that uses this function, its
parameters are automatically converted accordingly.

Example:

USERFIELD("User.Website") returns www.softmaker.com

VALUE (convert text into a number)

Syntax:

VALUE(Text)

Description:

Converts a text string into a number.

Text is the text string to convert. It must contain the text representation of a number, otherwise a #VALUE!
error value is returned.

Note:

This function was retained only for compatibility with older spreadsheet applications. It is no longer commonly
used, as current spreadsheet applications (including PlanMaker) automatically convert text strings into
numbers, where necessary.
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Example:

VALUE("42") returns 42

VALUE("42 USD") returns 42, since "USD" is a valid currency unit.

VALUE("42 bolts") returns a #VALUE! error value.

VALUE("TRUE") returns 1

VALUE("09/25/2014") returns 41907, the serial date value for the date 09/25/2014.

See also:

NUMBERVALUE, TEXT, T, N

VAR (variance of a sample)

Note: VAR is supplemented by the new identical function VAR.S, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

VAR(Number1, Number2 [, Number3 ...])

Description:

Estimates the variance of a population based on a sample.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VAR(2, 2, 3, 4, 1) returns 1.3
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See also:

VAR.S, VARA, VARPA, VAR.P/VARP, STDEV.S/STDEV, STDEV.P/STDEVP

VARA (variance of a sample)

Syntax:

VARA(Value1, Value2 [, Value3 ...])

Description:

The VARA function is almost identical to the VAR function (see note). It estimates the variance of a
population based on a sample.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).

Note:

Unlike the VAR function, VARA also evaluates logical values and text: FALSE evaluates as 0. TRUE
evaluates as 1. Text evaluates as 0.

Empty cells, however, are also ignored here.

Annotation:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VARA(2, 2, 3, 4, 1) returns 1.3

See also:

VAR.S/VAR, VARPA
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VARP (variance of entire population)

Note: VARP is supplemented by the new identical function VAR.P, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

VARP(Number1, Number2 [, Number3 ...])

Description:

Returns the variance of an entire population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the variance of a sample, use the
VAR.S/VAR function instead. This returns an estimate of the variance.

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The variance is calculated using the "biased" or "n" method.

Example:

VARP(2, 2, 3, 4, 1) returns 1.04

See also:

VAR.P, VAR.S/VAR, STDEV.S/STDEV, STDEV.P/STDEVP

VAR.P (variance of entire population)

Syntax:

VAR.P(Number1, Number2 [, Number3 ...])
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Description:

Returns the variance of an entire population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the variance of a sample, use the
VAR.S/VAR function instead. This returns an estimate of the variance.

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The variance is calculated using the "biased" or "n" method.

Example:

VAR.P(2, 2, 3, 4, 1) returns 1.04

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

VARP, VAR.S/VAR, STDEV.S/STDEV, STDEV.P/STDEVP

VARPA (variance of entire population)

Syntax:

VARPA(Number1, Number2 [, Number3 ...])

Description:

The VARPA function is almost identical to the VARP function (see note). Returns the variance of an entire
population.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated. Please
note that all values of the entire population have to be given. To calculate the variance of a sample, use the
VARA or VAR.S/VAR function instead. This returns an estimate of the variance.
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Note:

Unlike the VARP function, VARPA also evaluates logical values and text: FALSE evaluates as 0. TRUE
evaluates as 1. Text evaluates as 0.

Empty cells, however, are also ignored here.

Example:

VARPA(2, 2, 3, 4, 1) returns 1.04

See also:

VAR.P/VARP, VAR.S/VAR, VARA

VAR.S (variance of a sample)

Syntax:

VAR.S(Number1, Number2 [, Number3 ...])

Description:

Estimates the variance of a population based on a sample.

Number1, Number2, etc. are single values, cell ranges, or arrays containing the values to be evaluated
(sample).

If this function refers to empty cells or cells with error values, these are ignored. Also cells that contain text
strings or logical values, but these can be entered directly into the list of arguments and thus be taken into
account.

Annotation:

The variance is calculated using the "unbiased" or "n-1" method.

Example:

VAR.S(2, 2, 3, 4, 1) returns 1.3

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.
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See also:

VAR, VARA, VAR.P/VARP, VARPA, STDEV.S/STDEV, STDEV.P/STDEVP

VLOOKUP (look up column-wise)

Syntax:

VLOOKUP(Crit, Range, n [, Sorted])

Description:

Scans the first column of Range for the first given value of Crit. If found, the function returns the content of
the cell located in the same row and n-th column of Range.

Note: VLOOKUP can search vertically only. To search horizontally, use HLOOKUP instead

Crit is the value to be searched for (case insensitive).

Range is the cell range or array to be evaluated. Its first column should contain the values to be scanned. These
can be text strings, numbers or logical values.

n is the relative column number in Range from which a value will be returned, if Crit is found.

If n is less than 1, a #VALUE! error value is returned. If n is greater than the total number of columns in
Range, a #REF! error value is returned.

Sorted is a logical value determining whether the values in the first column of Range are in sorted order:

TRUE or omitted: Values have to be sorted in ascending order.

FALSE: Values do not have to be sorted.

Important: If you do not explicitly set Sorted to FALSE, these values must be in sorted order!

Note:

If Sorted is set to TRUE and VLOOKUP does not find a value that exactly matches the Crit, the next lower
value is automatically taken. If no smaller value exists because Crit is smaller than the smallest value available,
the function returns the error value #N/A.

Example:

You sell flowers at different unit prices – depending on the amount of flowers the customer buys. To do this,
you have created a table with a discount scale:



799Formulas and functions

Now you can use the VLOOKUP function to determine the price for a specific type of flower depending on the
number of pieces.

Use the following arguments:

For Crit, enter the name of the flower type (i.e. "roses", "carnations" or "tulips").

For Range you enter the cell range, which contains the names of the flower types in the first row and the prices
below – here A2:D4.

For n you enter the number of pieces plus one, because the first column (n=1) does not contain prices, but the
names of the flowers.

Some examples:

VLOOKUP("Roses", A2:D4, 2, FALSE) returns the unit price when purchasing one rose, i.e. 5.50 Euro.

VLOOKUP("Roses", A2:D4, 3, FALSE) returns the unit price when purchasing two roses, i.e. 5.10 Euro.

VLOOKUP("Roses", A2:D4, 4, FALSE) returns the unit price when three roses are purchased, i.e. 4.95 Euro.

VLOOKUP("Carnations", A2:D4, 4, FALSE) returns the unit price when three carnations are purchased, i.e.
4.50 Euro.

VLOOKUP("Carnations", A2:D4, 5, FALSE) returns the error value #REF because n is greater than the row
number of Range.

VLOOKUP("Petunias", A2:D4, 4, FALSE) returns the error value #N/A, because "Petunias" does not appear in
the first row of Range .

See also:

HLOOKUP, LOOKUP, INDEX, MATCH, SWITCH, CHOOSE, IFS

WEEKDAY (weekday)

Syntax:

WEEKDAY(Date [, Mode])
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Description:

Returns the day of the week of a date as a number (from 1 to 7 or from 0 to 6).

Mode (optional) lets you change the type of values to be returned:

1 or omitted: Numbers from 1 (Sunday) to 7 (Saturday) are returned.

2: Numbers from 1 (Monday) to 7 (Sunday) are returned.

3: Numbers from 0 (Monday) to 6 (Sunday) are returned.

Example:

WEEKDAY("09/25/1966") returns 1 (i.e., Sunday)

WEEKDAY("09/25/1966", 2) returns 7 (i.e., Sunday)

See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, YEAR, MONTH, DAY

WEEKNUM (week number)

Syntax:

WEEKNUM(Date [, WeekStartsOn])

Description:

Returns the week number of a Date.

For this purpose, the calculation method commonly used in the USA and many other parts of the world is
applied: The first calendar week of the year is always the week containing January 1st.

This method requires that the first calendar week cannot start in the previous year and in most cases does not
include a full 7 days.

Note:

In Germany (and some other countries like Switzerland and Austria), a different method of calculation is
normally used; here it is based on the ISO standard. See function ISOWEEKNUM (or see below
WeekStartsOn with value variant "21").

Important:

Also note that by default, this function considers Sunday as the beginning of the week – not Monday.
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However, you can change this with the optional argument WeekStartsOn. WeekStartsOn lets you specify on
which day a week begins:

1 or omitted: Week begins on a Sunday.

2: Week begins on a Monday.

In addition, the following variants are also defined:

11: Week begins on a Monday.

12: Week begins on a Tuesday.

13: Week begins on a Wednesday.

14: Week begins on a Thursday.

15: Week begins on a Friday.

16: Week begins on a Saturday.

17: Week begins on a Sunday.

21: Week begins on a Monday. Here, the first calendar week of the year is the week that contains January 4th,
in accordance with the ISO standard.

Compatibility notes:

Microsoft Excel supports the values 11-17 and 21 for the WeekStartsOn argument only in version 2010 or
later. In older versions these values are not known.

Example:

On Sunday, the 5th of January, 2020:

WEEKNUM("01/05/2020", 1) returns 2

WEEKNUM("01/05/2020", 2) returns 1

See also:

ISOWEEKNUM, ISOWEEK, YEAR, MONTH, DAY, WEEKDAY

WEIBULL (Weibull distribution)

Note: WEIBULL is supplemented by the new identical function WEIBULL.DIST, which is available in
newer versions of Microsoft Excel (2010 or later).

Syntax:

WEIBULL(x, Alpha, Beta, Cumulative)
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Description:

Returns the Weibull distribution function.

The Weibull distribution is an extension of the exponential distribution (see function
EXPON.DIST/EXPONDIST) to occurrences that are not purely random and do not exactly match the Poisson
distribution (see function POISSON.DIST/POISSON).

It is used especially for reliability analysis.

x 

Alpha is a parameter of distribution. Alpha determines the shape of the distribution curve. If Alpha = 1, the
Weibull distribution equals an exponential distribution with Lambda = 1/Beta.

Beta is another parameter of the distribution. Beta determines the scaling of the distribution curve, i.e. it
stretches or compresses the function graph.

Both parameters has to be greater than zero.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

WEIBULL(42, 2, 100, TRUE) returns 0.16172

WEIBULL(42, 2, 100, FALSE) returns 0.00704

See also:

WEIBULL.DIST, EXPON.DIST/EXPONDIST, POISSON.DIST/POISSON

WEIBULL.DIST (Weibull distribution)

Syntax:

WEIBULL.DIST(x, Alpha, Beta, Cumulative)

Description:

Returns the Weibull distribution function.

The Weibull distribution is an extension of the exponential distribution (see function
EXPON.DIST/EXPONDIST) to occurrences that are not purely random and do not exactly match the Poisson
distribution (see function POISSON.DIST/POISSON).



803Formulas and functions

It is used especially for reliability analysis.

x 

Alpha is a parameter of distribution. Alpha determines the shape of the distribution curve. If Alpha = 1, the
Weibull distribution equals an exponential distribution with Lambda = 1/Beta.

Beta is another parameter of the distribution. Beta determines the scaling of the distribution curve, i.e. it
stretches or compresses the function graph.

Both parameters has to be greater than zero.

The logical value Cumulative lets you specify which type of function will be returned:

FALSE: The probability density function is returned.

TRUE: The cumulative distribution function is returned.

Example:

WEIBULL.DIST(42, 2, 100, TRUE) returns 0.16172

WEIBULL.DIST(42, 2, 100, FALSE) returns 0.00704

Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

WEIBULL, EXPON.DIST/EXPONDIST, POISSON.DIST/POISSON

WORKDAY (date after x workdays)

Syntax:

WORKDAY(StartDate, Days [, Holidays])

Description:

Returns the date that is x workdays before/after StartDate.

This function counts workdays only, Saturdays and Sundays are skipped. Optionally, you can specify a list of
holidays to be skipped as well (see Holidays parameter).

StartDate is the start date.

Days is the number of workdays. A positive value will return a date in the future, a negative value will return a
date in the past.
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Holidays (optional) is a cell range or an array containing a list of dates to be skipped (e.g. holidays). (This is
usually done using a cell range or an array containing the corresponding date values)

Example:

WORKDAY("10/1/2016", 9) returns 10/13/2016.

The date that comes 9 working days after 10/1/2016 is therefore 10/13/2016.

The 10/3/2016 could be a holiday, however (for example, in Germany). If one wanted to take this into account,
you would have to write:

WORKDAY("10/1/2016", 9, "10/3/2016") – and this results in 10/14 instead of 10/13, since the holiday on
10/3 fell on a weekday, so the count is skipped.

See also:

HOLIDAY, NETWORKDAYS

XIRR (internal rate of return)

Syntax:

XIRR(Values, Dates [, Guess])

Description:

Returns an estimate for the internal rate of return of an investment with irregular cash flows.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, income as positive values. Payments may be made at any time. The date of each cash flow has
to be specified using the Dates argument.

The function expects the following arguments:

Values is a cell range or array containing the cash flows. At least one payment and one income have to be
given.

Dates is a cell range or array containing the dates for each cash flow specified in Values.

Guess (optional) lets you specify an estimate for the result (see note below).

Note:

The result of this function is calculated using an iterative search technique. If the function does not find a result
with an accuracy of 0.00001% or better after 20 iterations, it aborts and the #NUM! error value is returned. If
this occurs, try altering the Guess parameter.
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See also:

IRR, NPV, MIRR, XNPV, RATE

XNPV (net present value)

Syntax:

XNPV(Rate, Values, Dates)

Description:

Returns the net present value of an investment with irregular cash flows.

The calculation is based on the cash flows specified in the Values argument. Payments have to be entered as
negative values, income as positive values. Payments may be made at any time. The date of each cash flow has
to be specified using the Dates argument.

The function expects the following arguments:

Rate is the discount rate to apply to the cash flows.

Values is a cell range or array containing the cash flows. At least one payment and one income have to be
given.

Dates is a cell range or array containing the dates for each cash flow specified in Values.

See also:

NPV, XIRR

XOR (logical XOR function)

Syntax:

XOR(Value1 [, Value2, Value3 ...])

Description:

XOR ("exclusive or") returns the logical value TRUE if an odd number of the arguments is TRUE, otherwise it
returns FALSE.
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This function is often used with only two arguments. Here, the following applies: If either one or the other
argument is TRUE, it returns TRUE. On the other hand, if both are TRUE or both are FALSE, it returns
FALSE.

Compatibility notes:

Microsoft Excel supports this function only in version 2013 or later. In older versions, the function is unknown.

Example:

XOR(TRUE, TRUE) returns FALSE

XOR(TRUE, FALSE) returns TRUE

XOR(FALSE, TRUE) returns TRUE

XOR(FALSE, FALSE) returns FALSE

See also:

OR, AND, NOT

YEAR (year of a date)

Syntax:

YEAR(Date)

Description:

Returns the year of a date.

Example:

YEAR("09/25/2018") returns 2018

If cell A1 contains the date value 9/25/2018: YEAR(A1) returns 2018

See also:

ISOWEEKNUM, ISOWEEK, WEEKNUM, MONTH, DAY, DAYSPERYEAR, WEEKDAY
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ZTEST (z-test)

Note: ZTEST is supplemented by the new identical function Z.TEST, which is available in newer versions of
Microsoft Excel (2010 or later).

Syntax:

ZTEST(Area, x [, Sigma])

Description:

Returns the one-tailed probability of a z-test.

You can use this function to check the probability that a sample comes from a certain population.

Area is the cell range or array containing the values x will be tested against. There should be at least 30 values.

x is the value to be tested.

Sigma (optional) is the standard deviation of the population (if known). If omitted, the standard deviation of the
given sample (i.e., the values in Area) is used.

See also:

Z.TEST, STANDARDIZE, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST

Z.TEST (z-test)

Syntax:

Z.TEST(Area, x [, sigma])

Description:

Returns the one-tailed probability of a z-test.

You can use this function to check the probability that a sample comes from a certain population.

Area is the cell range or array containing the values x will be tested against. There should be at least 30 values.

x is the value to be tested.

Sigma (optional) is the standard deviation of the population (if known). If omitted, the standard deviation of the
given sample (i.e., the values in Area) is used.
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Compatibility notes:

Microsoft Excel supports this function only in version 2010 or later. In older versions, the function is unknown.

See also:

ZTEST, STANDARDIZE, NORM.DIST/NORMDIST, NORM.S.DIST/NORMSDIST
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Appendix
The appendix of the manual contains the following information:

§ Ribbon commands and corresponding menu commands 

In this section, you will find a table of all commands in the ribbon interface and the respective
corresponding menu command in the classic menu interface.

§ Shortcut keys 

This section contains tables with the most important shortcut keys that you can use in the program.

§ Command-line parameters 

Here, you will find an overview of parameters that can be used to directly trigger a specified program option
when you start PlanMaker.

Ribbon commands and corresponding menu commands
In this section, you will find a table of all commands in the ribbon interface and the respective corresponding
menu command in the classic menu interface.

Tip 1: You can switch the user interface between ribbon and classic menus at any time. To do so, choose the
command File | Options in the ribbon (or choose Tools > Options in the classic menu interface). In the
dialog box, switch to the Appearance tab and click on the User interface button. The program will display a
dialog box in which you can choose the desired user interface.

Tip 2: Use the "hamburger menu" (the icon  on the left in the Quick access toolbar) if you still want to
access the classic menu commands from the ribbon interface.

The subsequent table contains the following columns:

§ Left column: The left column lists all ribbon commands in the program, listed according to the order of
ribbon tabs and in the following format: Ribbon tab | Command group | Command 

§ Right column: The right column lists all corresponding classic menu commands in the program in the
following format: Menu > Command

Example: The ribbon command File | Document | Save can be found under File > Save in the classic menu
interface.

Another entry >> is also added for some commands if the command can only be found in the submenu of an
icon or in a dialog box.

Thus, here is the aforementioned table:
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Ribbon Menu

File | File | New File > New

File | File | Open File > Open

File | File | Close File > Close

File | Document | Save File > Save

File | Document | Save as File > Save as

File | Document | Save all File > Save all

File | Document | PDF export File > Export as PDF

File | Document | Send File > Send

File | Print | Page setup File > Page setup

File | Print | Define print range File > Print range > Define print range

File | Print | Define print range >> Remove print range File > Print range > Remove print range

File | Print | Print preview File > Print preview

File | Print | Print File > Print

File | File management | Properties File > Properties

File | File management | Versions File > File versions

File | File management | File manager File > File manager

File | Scripts | Edit script Tools > Edit script

File | Scripts | Run script Tools > Run script

File | Settings | Options Tools > Options

File | Settings | Customize >> Customize ribbon Tools > Customize

File | File | Exit (if no document is open) File > Exit
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Ribbon Menu

in the Quick access toolbar Edit > Undo

in the Quick access toolbar Edit > Redo

in the Quick access toolbar Edit > Repeat

in the Quick access toolbar View > Touch mode

Home | Edit | Paste Edit > Paste

Home | Edit | Paste >> Paste special Edit > Paste special

Home | Edit | Cut Edit > Cut

Home | Edit | Copy Edit > Copy

Home | Edit | Format painter Format > Transfer formatting

Home | Character | Bold Toolbar: Formatting

Home | Character | Italic Toolbar: Formatting

Home | Character | Underline Toolbar: Formatting

Home | Character | Font color Toolbar: Formatting

Home | Character | Increase font size

Home | Character | Decrease font size

Home | Alignment | Align top

Home | Alignment | Cell orientation

Home | Alignment | Line wrap Toolbar: Formatting

Home | Alignment | Default alignment Toolbar: Formatting

Home | Alignment | Merge cells Toolbar: Formatting

Home | Number | Percent format

Home | Number | Currency format
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Ribbon Menu

Home | Number | Increase decimal places Toolbar: Formatting

Home | Number | Decrease decimal places Toolbar: Formatting

Home | Format | Shading Format > Shading

Home | Format | Borders Format > Borders

Home | Format | Conditional formatting Toolbar: Formatting

Home | Format | Conditional formatting >> New rule Format > Conditional formatting > New rule

Home | Format | Conditional formatting >> Manage rules Format > Conditional formatting > Manage rules

Home | Format | Conditional formatting >> Delete rules in
selected cells

Format > Conditional formatting > Delete rules in
selected cells

Home | Format | Cell styles

Home | Format | Cell styles >> Manage cell styles Format > Cell style

Home | Cells | Insert Worksheet > Insert cells

Home | Cells | Insert >> Insert copied cells Worksheet > Insert copied cells

Home | Cells | Insert >> Insert worksheet Worksheet > Worksheet > Insert

Home | Cells | Delete Worksheet > Delete cells

Home | Cells | Delete >> Delete worksheet Worksheet > Worksheet > Delete

Home | Cells | Visibility

Home | Cells | Visibility >> Hide rows Worksheet > Row > Hide

Home | Cells | Visibility >> Show rows Worksheet > Row > Show

Home | Cells | Visibility >> Hide columns Worksheet > Column > Hide

Home | Cells | Visibility >> Show columns Worksheet > Column > Show

Home | Cells | Visibility >> Hide sheet Worksheet > Worksheet > Hide

Home | Cells | Visibility >> Show sheet Worksheet > Worksheet > Show
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Ribbon Menu

Home | Contents | Sort and filter Toolbar: Standard

Home | Contents | Sort and filter >> Sort Worksheet > Sort

Home | Contents | Sort and filter >> Sort ascending Toolbar: Standard

Home | Contents | Sort and filter >> Sort descending Toolbar: Standard

Home | Contents | Sort and filter >> AutoFilter Worksheet > Filter > AutoFilter

Home | Contents | Sort and filter >> Show all Worksheet > Filter > Show all

Home | Contents | Sort and filter >> Reapply filter Worksheet > Filter > Reapply filter

Home | Contents | Sort and filter >> Special filter Worksheet > Filter > Special filter

Home | Contents | Autosum Toolbar: Standard

Home | Contents | Fill Edit > Fill

Home | Contents | Fill >> Down Edit > Fill > Down

Home | Contents | Fill >> Right Edit > Fill > Right

Home | Contents | Fill >> Up Edit > Fill > Up

Home | Contents | Fill >> Left Edit > Fill > Left

Home | Contents | Fill >> Series Edit > Fill > Series

Home | Contents | Delete Edit > Delete special

Home | Contents | Delete >> All Edit > Delete special > All

Home | Contents | Delete >> Formatting Edit > Delete special > Formatting

Home | Contents | Delete >> Contents Edit > Delete special > Contents

Home | Contents | Delete >> Comments Edit > Delete special > Comments

Home | Contents | Delete >> Conditional formatting Edit > Delete special > Conditional formatting

Home | Contents | Delete >> Input validation Edit > Delete special > Input validation



814Appendix

Ribbon Menu

Home | Contents | Delete >> Reset character formatting Format > Standard

Home | Contents | Delete >> Remove link Format > Remove link

Home | Search | Search Edit > Search

Home | Search | Replace Edit > Replace

Home | Search | Search again Edit > Search again

Home | Search | Go to Edit > Go to

Home | Selection | Select all Edit > Select all

Insert | Tables | Table Worksheet > New table

Insert | Tables | Pivot table Worksheet > New pivot table

Insert | Tables | Sheet >> Insert Worksheet > Worksheet > Insert

Insert | Tables | Sheet >> Copy Worksheet > Worksheet > Copy

Insert | Tables | Sheet >> Move Worksheet > Worksheet > Move

Insert | Tables | Sheet >> Delete Worksheet > Worksheet > Delete

Insert | Tables | Sheet >> Rename Worksheet > Worksheet > Rename

Insert | Tables | Sheet >> Show Worksheet > Worksheet > Show

Insert | Tables | Sheet >> Hide Worksheet > Worksheet > Hide

Insert | Tables | Sheet >> Properties Worksheet > Worksheet > Properties

Insert | Objects | Picture frame Object > New picture frame

Insert | Objects | Picture frame >> From scanner File > Acquire

Insert | Objects | Picture frame >> Select source File > Select source

Insert | Objects | Text frame Object > New text frame

Insert | Objects | Chart frame Object > New chart frame
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Ribbon Menu

Insert | Objects | AutoShape Object > New drawing > AutoShape

Insert | Objects | Lines Object > New drawing > Line

Insert | Objects | TextArt object Object > New drawing > TextArt

Insert | Objects | Equation Editor object Object > New OLE object frame >> SoftMaker
Equation Editor

Insert | Objects | Form object >> Checkbox Object > New form object > Checkbox

Insert | Objects | Form object >> Radio button Object > New form object > Radio button

Insert | Objects | Form object >> Dropdown Object > New form object > Dropdown

Insert | Objects | Form object >> Listbox Object > New form object > Listbox

Insert | Objects | Form object >> Pushbutton Object > New form object > Pushbutton

Insert | Objects | Form object >> Spinner Object > New form object > Spinner

Insert | Objects | Form object >> Scrollbar Object > New form object > Scrollbar

Insert | Objects | Form object >> Label Object > New form object > Label

Insert | Objects | Form object >> Groupbox Object > New form object > Groupbox

Insert | Objects | OLE object frame Object > New OLE object frame

Insert | Objects | OLE object frame >> TextMaker object Object > New OLE object frame >> TextMaker
Document

Insert | Objects | OLE object frame >> Presentations object Object > New OLE object frame >> Presentations
Slide

Insert | Links | Hyperlink Format > Link

Insert | Comments | Comment Insert > Comment

Insert | Text | Header / footer Insert > Header and footer

Insert | Text | SmartText Insert > SmartText

Insert | Text | Symbol Insert > Symbol
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Ribbon Menu

Insert | Text | Character

Layout | Page setup | Page margins File > Page setup

Layout | Page setup | Page orientation File > Page setup

Layout | Page setup | Page size File > Page setup

Layout | Page setup | Page break Insert > Page break

Layout | Page Setup | Header / footer Insert > Header and footer

Layout | Cells | Cell size: Row height Worksheet > Row > Height

Layout | Cells | Cell size: Column width Worksheet > Column > Width

Layout | Cells | Optimum height Worksheet > Row > Optimum height

Layout | Cells | Optimum width Worksheet > Column > Optimum width

Layout | Position | Bring to front Object > Order > Bring to front

Layout | Position | Bring to front >> Bring forward one level Object > Order > Bring forward one level

Layout | Position | Send to back Object > Order > Send to back

Layout | Position | Send to back >> Send backward one level Object > Order > Send backward one level

Layout | Position | Rotate object Object > Rotate or flip

Layout | Position | Align objects Object > Align or distribute

Layout | Objects | Group Object > Group

Layout | Objects | Duplicate Edit > Duplicate

Formula | Function | Function Insert > Function

Formula | Function | Autosum Toolbar: Standard

Formula | Function | Recently used Insert > Function >> Category

Formula | Function | Financial Insert > Function >> Category
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Ribbon Menu

Formula | Function | Logic Insert > Function >> Category

Formula | Function | Strings Insert > Function >> Category

Formula | Function | Date and time Insert > Function >> Category

Formula | Function | Statistics Insert > Function >> Category

Formula | Function | Mathematics Insert > Function >> Category

Formula | Function | More functions Insert > Function >> Category

Formula | Named areas | Edit names Worksheet > Names > Edit

Formula | Named areas | Create names Worksheet > Names > Import

Formula | Named areas | Apply names Worksheet > Names > Apply

Formula | Named areas | Export names Worksheet > Names > Insert list

Formula | Traces | Trace to error Tools > Formula auditing > Trace to error

Formula | Traces | Trace predecessors Tools > Formula auditing > Trace predecessors

Formula | Traces | Trace predecessors >> Select
predecessors

Tools > Formula auditing > Select predecessors

Formula | Traces | Trace successors Tools > Formula auditing > Trace successors

Formula | Traces | Trace successors >> Select successors Tools > Formula auditing > Select successors

Formula | Traces | Remove all traces Tools > Formula auditing > Remove all traces

Formula | Traces | Remove all traces >> Remove traces to
predecessors

Tools > Formula auditing > Remove traces to
predecessors

Formula | Traces | Remove all traces >> Remove traces to
successors

Tools > Formula auditing > Remove traces to
successors

Formula | Traces | Previous error Tools > Formula auditing > Go to previous error

Formula | Traces | Next error Tools > Formula auditing > Go to next error

Formula | Watch | Show watch list View > Watch window
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Ribbon Menu

Formula | Update | Update data >> Update calculations Tools > Recalculate

Formula | Update | Update data >> Update charts Tools > Update charts

Formula | Update | Update data >> Update external
references

Tools > Update external references

Formula | Update | Update data >> Update pivot tables Tools > Refresh all pivot tables

Data | Filter | Sort Worksheet > Sort

Data | Filter | Ascending Toolbar: Standard

Data | Filter | Descending Toolbar: Standard

Data | Filter | AutoFilter Worksheet > Filter > AutoFilter

Data | Filter | Special filter Worksheet > Filter > Special filter

Data | Filter | Show all Worksheet > Filter > Show all

Data | Filter | Reapply AutoFilter Worksheet > Filter > Reapply filter

Data | Edit | External references Worksheet > External references

Data | Edit | Transpose Worksheet > Transpose

Data | Edit | Text to columns Worksheet > Text to columns

Data | Edit | Remove empty rows Worksheet > Remove > Empty rows

Data | Edit | Remove empty rows >> Remove duplicate rows Worksheet > Remove > Duplicate rows

Data | Analyze | Pivot table Worksheet > New pivot table

Data | Analyze | Data consolidation Worksheet > Data consolidation

Data | Analyze | Scenario manager Tools > Scenarios

Data | Analyze | Goal seek Tools > Goal seek

Data | Outliner | Group Worksheet > Outliner > Group

Data | Outliner | Ungroup Worksheet > Outliner > Ungroup
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Ribbon Menu

Data | Outliner | Remove all groups Worksheet > Outliner > Clear outline

Data | Outliner | Show details Worksheet > Outliner > Show details

Data | Outliner | Hide details Worksheet > Outliner > Hide details

Data | Input validation | Input validation Format > Input validation

Review | Input validation | Previous invalid cell Tools > Formula auditing > Go to previous invalid
cell

Data | Input validation | Next invalid cell Tools > Formula auditing > Go to next invalid cell

Review | Spelling | Spell check Tools > Check spelling

Review | Spelling | Spell check >> Edit user dictionaries Tools > Edit user dictionaries

Review | Spelling | Research Toolbar: Standard

Review | Comments | Add Tools > Comments > Insert comment

Review | Comments | Edit Tools > Comments > Edit comment

Review | Comments | Delete Next > Comments > Delete comments

Review | Comments | Previous comment Tools > Comments > Previous comment

Review | Comments | Next comment Tools > Comments > Next comment

Review | Comments | Comment visibility >> Show all
comments

Tools > Comments > Show all comments

Review | Comments | Comment visibility >> Show this
comment

Tools > Comments > Show this comment

Review | Comments | Comment visibility >> Restore all
comment positions

Tools > Comments > Reset comment position

Review | Protection | Cell protection Format > Cell: Protection tab >> Protect cell

Review | Protection | Hide cell Format > Cell: Protection tab >> Hide cell

Review | Protection | Sheet protection Tools > Sheet protection

Review | Protection | Workbook protection Tools > Workbook protection
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Ribbon Menu

Review | Input validation | Input validation Format > Input validation

Review | Input validation | Mark invalid data Tools > Formula auditing > Mark invalid data

Review | Input validation | Remove marks Tools > Formula auditing > Remove invalid data
marks

Review | Input validation | Previous invalid cell Tools > Formula auditing > Go to previous invalid
cell

Review | Input validation | Next invalid cell Tools > Formula auditing > Go to next invalid cell

View | Mode | Object mode View > Object mode

View | View | Row and column headers View > Row & column headers

View | View | Show formulas View > Show formulas

View | View | Syntax highlighting View > Syntax highlighting

View | View | Show zero values Worksheet > Worksheet > Properties >> Show zero
values

View | View | Show sheet grid Worksheet > Worksheet > Properties >> Gridlines

View | View | Show page breaks Worksheet > Worksheet > Properties >> Page
breaks

View | View | Page break preview View > Page break preview

View | Zoom | Set zoom View > Zoom level

View | Zoom | Actual size View > Actual size

View | Zoom | Fit to selection View > Zoom level >> Fit to selection

View | Windows | Freeze cells View > Freeze

View | Windows | Pivot table sidebar View > Pivot table sidebar

View | Windows | Pivot table sidebar >> Show at left View > Pivot table sidebar > Show at left

View | Windows | Pivot table sidebar >> Show at right View > Pivot table sidebar > Show at right

View | Windows | Full screen View > Full screen
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Ribbon Menu

View | Windows | Windows Window >

View | Windows | Windows >> View side by side Window > View side by side

View | Windows | Windows >> Close all Window > Close all

Table | Table | Range Worksheet > Table > Table range

Table | Table | Properties Worksheet > Table > Table settings

Table | Table | Summarize as pivot Worksheet > Table > Create pivot table

Table | Table | Convert to range Worksheet > Table > Convert to range

Table | Table | Delete table Worksheet > Table > Delete table

Table | Selection | Select rows Worksheet > Table > Select > Select rows

Table | Selection | Select columns Worksheet > Table > Select > Select columns

Table | Selection | Select table Worksheet > Table > Select > Select table

Table | Edit | Insert above Worksheet > Table > Insert > Insert rows above

Table | Edit | Insert below Worksheet > Table > Insert > Insert rows below

Table | Edit | Delete rows Worksheet > Table > Delete > Delete rows

Table | Edit | Insert left Worksheet > Table > Insert > Insert columns at left

Table | Edit | Insert right Worksheet > Table > Insert > Insert columns at
right

Table | Edit | Delete columns Worksheet > Table > Delete > Delete columns

Table | Style | Table styles Toolbar: Table

Table | Style | Header row Worksheet > Table > Header row

Table | Style | Total row Worksheet > Table > Total row

Object | Insert | New object Toolbar: Standard

Object | Format | AutoShape templates Toolbar: AutoShape
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Ribbon Menu

Object | Format | AutoShape templates >> More Object > Properties

Object | Format | AutoShape effects Toolbar of the respective object

Object | Format | Fill color Toolbar of the respective object

Object | Format | Line color Toolbar of the respective object

Object | Format | Line style Toolbar of the respective object

Object | Format | Line thickness Toolbar of the respective object

Object | Format | Line endings Toolbar: AutoShape

Object | Edit | Change AutoShape Toolbar: AutoShape

Object | Edit | Edit points Toolbar: AutoShape

Object | Edit | Combine objects Via the context menu

Object | Inner text | Text rotation Toolbar: AutoShape

Object | Inner text | Vertical alignment Toolbar: AutoShape

Object | Inner text | Change text area Toolbar: AutoShape

OLE object | OLE | OLE object Edit > OLE object

OLE object | OLE | Edit link Edit > Link

OLE object | Size | Cropping Toolbar: Picture

OLE object | Adjust | Recolor picture Toolbar: Picture

Picture | Adjust | Change source Object > Properties: Picture tab >> File...

Picture | Adjust | Reset Toolbar: Picture

Picture | Format | Photo frame Toolbar: Picture

Chart | Type | Chart type Toolbar: Chart

Chart | Type | Chart subtype Toolbar: Chart
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Ribbon Menu

Chart | Data | Series in columns Object > Chart > Data in columns

Chart | Data | Series in rows Object > Chart > Data in rows

Chart | Design | Chart colors Toolbar: Chart

Chart | Chart elements | Add chart element Toolbar: Chart

Chart | Chart elements | Select chart element Toolbar: Chart

Chart | Chart elements | Edit properties Object > Chart > xy element: Properties

Chart | Chart elements | Fill color

Chart | Chart elements | Line color

Chart | Chart elements | Line style

Chart | Chart elements | Line thickness

Chart | Position | Chart location Object > Chart > Change chart location

Chart | Export | Save chart as a picture Object > Chart > Save as picture

not available Edit > Delete

Home | Number >> group arrow Format > Cell

Home | Character >> group arrow Format > Character

Home | Alignment >> group arrow Format > Paragraph

Via the context menu Format > Character style

not available Format > AutoFormat

Via the context menu of the worksheet register Worksheet > Worksheet > Show > Show all

Data | Outliner >> group arrow Worksheet > Outliner > Automatically show outline
pane

Data | Outliner >> group arrow Worksheet > Outliner > Options

Via the context menu Worksheet > Table > Select > Select column data
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Ribbon Menu

not available Tools > Edit lists
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Shortcut keys
The following pages contain tables with Planmaker's most important shortcut keys:

§ Shortcut keys in Windows and Linux versions 

§ Shortcut keys in Mac version

Tip: If you choose the ribbon command File | Customize , you can customize the default shortcut keys
and create new shortcut keys. For more information, see Customizing shortcut keys.

Shortcut keys in Windows and Linux versions

In the Windows and the Linux version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Ctrl+Z

Quick access toolbar: Redo Ctrl+Y

Quick access toolbar: Repeat last command Ctrl+Shift+Y

File | New Ctrl+N

File | Open Ctrl+O

File | Close Ctrl+W or Ctrl+F4

File | Save Ctrl+S

File | Print Ctrl+P

File | File manager F12

File | Exit Ctrl+Q or Alt+F4

Home | Paste Ctrl+V

Home | Paste Special Ctrl+Alt+V

Home | Cut Ctrl+X
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Command Shortcut key

Home | Copy Ctrl+C

Home | Format painter (copying step) Ctrl+Shift+C

Home | Format painter (pasting step) Ctrl+Shift+V

Home | group Character:

Open the "Character" dialog box Ctrl+2

Select font from the list Ctrl+D

Bold on/off Ctrl+B

Italics on/off Ctrl+I

Underline on/off Ctrl+U

Superscript Ctrl+Shift+Plus key (numeric keypad)

Subscript Ctrl+Shift+Minus key (numeric keypad)

Remove superscript or subscript Ctrl+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Home | group Alignment:

Open the "Cell" dialog box Ctrl+1

Alignment: Left Ctrl+L

Alignment: Centered Ctrl+E

Alignment: Right Ctrl+R

Alignment: Justified Ctrl+J

Line break for current cell Ctrl+Enter

Home | group Number:

Open the "Cell" dialog box Ctrl+1

Number format: Number Ctrl+Shift+1

Number format: Scientific Ctrl+Shift+2

Number format: Currency Ctrl+Shift+4

Number format: Percentage Ctrl+Shift+5
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Command Shortcut key

Home| group Cells:

Insert cells Ctrl+Plus

Delete cells Ctrl+Minus

Hide current row Ctrl+9

Show current row Ctrl+Shift+9

Hide current column Ctrl+8

Show current column Ctrl+Shift+8

Home | Search Ctrl+F

Home | Replace Ctrl+H

Home | Search again (or Replace again) F3

Home | Go to F5 or Ctrl+G

Go to the next error Ctrl+F3

Home| Select all Ctrl+A

Insert | Table Ctrl+T

Insert | Hyperlink Ctrl+K

Insert | Comment Shift+F2

Insert | Character | Em dash (—) Ctrl+Alt+Minus key (numeric keypad)

Insert | Character | Non-breaking space Ctrl+Shift+Space

Formula | Insert function F7

Formula | Update data:

Update charts F8

Update calculations F9

Recalculate the current worksheet only Shift+F9

View | Full screen F6
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Other useful shortcut keys

Command Shortcut key

Display help content F1

Edit the content of the current cell F2

Show/hide ribbon Ctrl+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

Move to the next worksheet
(for open dialog boxes: move to the next tab)

Ctrl+Tab

Move to the previous worksheet
(for open dialog boxes: move to the previous tab)

Ctrl+Shift+Tab

Select the next object (in object mode) Tab

Select the previous object (in object mode) Shift+Tab

Move to the next cell ß/à/á/â

Move to the next / previous cell horizontally Tab / Shift+Tab

Move to the next / previous cell vertically Enter / Shift+Enter

Move to the next filled cell Ctrl+ß/à/á/â

Move to the first cell in the current column Ctrl+PageUpá

Move to the last cell in the current column Ctrl+PageDownâ

Move to the first cell in the current row Home

Move to the last filled cell in the current row End

Move to the first cell in the worksheet (A1) Ctrl+Home

Move to the last filled cell in the worksheet Ctrl+End

Move to the next circular reference Shift+F5

Go to the next error Ctrl+F3

Copy cell above Ctrl+, (comma)

Copy value from cell above Ctrl+Shift+, (comma)
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Command Shortcut key

Enter an array formula Ctrl+Shift+¿

Select current array formula Ctrl+7

Select current conditional formatting Ctrl+6

Open a selection list with the contents of the cells above or below
a cell

Alt+Shift+â

Switch between AUTO and TEXT input mode
(see Status bar)

Ctrl+Shift+F4

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Ctrl+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).

Shortcut keys in Mac version

Note: For most shortcut keys with the Cmd key, you can also use the Ctrl key instead of the Cmd key. For
the shortcut key Cmd+S, for example, you can also press Ctrl+S.

In the Mac version, the following shortcut keys are available:

Shortcut keys for commands

Command Shortcut key

Quick access toolbar: Undo last command Cmd+Z

Quick access toolbar: Redo Cmd+Y

Quick access toolbar: Repeat last command Cmd+Shift+Y

File | New Cmd+N

File | Open Cmd+O

File | Close Cmd+W or Cmd+F4

File | Save Cmd+S
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Command Shortcut key

File | Print Cmd+P

File | File manager F12

File | Exit Cmd+Q or Alt+F4

Home | Paste Cmd+V

Home | Paste Special Cmd+Alt+V

Home | Cut Cmd+X

Home | Copy Cmd+C

Home | Format painter (copying step) Cmd+Shift+C

Home | Format painter (pasting step) Cmd+Shift+V

Home | group Character:

Open the "Character" dialog box Cmd+2

Select font from the list Cmd+D

Bold on/off Cmd+B

Italics on/off Cmd+I

Underline on/off Cmd+U

Superscript Cmd+Shift+Plus key (numeric keypad)

Subscript Cmd+Shift+Minus key (numeric keypad)

Remove superscript or subscript Cmd+Shift+Multiply key (numeric keypad)

Change uppercase/lowercase of selected text 
(from "test" to "Test" to "TEST")

Shift+F3

Home | group Alignment:

Open the "Cell" dialog box Cmd+1

Alignment: Left Cmd+L

Alignment: Centered Cmd+E

Alignment: Right Cmd+R

Alignment: Justified Cmd+J

Line break for current cell Cmd+Enter



831Appendix

Command Shortcut key

Home | group Number:

Open the "Cell" dialog box Cmd+1

Number format: Number Cmd+Shift+1

Number format: Scientific Cmd+Shift+2

Number format: Currency Cmd+Shift+4

Number format: Percentage Cmd+Shift+5

Home| group Cells:

Insert cells Cmd+Plus

Delete cells Cmd+Minus

Hide current row Cmd+9

Show current row Cmd+Shift+9

Hide current column Cmd+8

Show current column Cmd+Shift+8

Home | Search Cmd+F

Home | Replace Cmd+H

Home | Search again (or Replace again) F3

Home | Go to Cmd+G or F5

Go to the next error Cmd+F3

Home| Select all Ctrl+A

Insert | Table Cmd+T

Insert | Hyperlink Cmd+K

Insert | Comment Shift+F2

Insert | Character | Em dash (—) Cmd+Alt+Minus key (numeric keypad)

Insert | Character | Non-breaking space Cmd+Shift+Space

Formula | Insert function F7

Formula | Update data:

Update charts F8
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Command Shortcut key

Update calculations F9

Recalculate the current worksheet only Shift+F9

View | Full screen F6

Other useful shortcut keys

Command Shortcut key

Edit the content of the current cell F2

Expand or collapse the ribbon Cmd+F1

Move to the next ribbon tab Ctrl+F12

Move to the previous ribbon tab Ctrl+Shift+F12

Move to the next worksheet
(for open dialog boxes: move to the next tab)

Ctrl+Tab

Move to the previous worksheet
(for open dialog boxes: move to the previous tab)

Ctrl+Shift+Tab

Select the next object (in object mode) Tab

Select the previous object (in object mode) Shift+Tab

Move to the next cell ß/à/á/â

Move to the next / previous cell horizontally Tab / Shift+Tab

Move to the next / previous cell vertically Enter / Shift+Enter

Move to the next filled cell Cmd+ß/à/á/â

Move to the first cell in the current column Cmd+PageUpá

Move to the last cell in the current column Cmd+PageDownâ

Move to the first cell in the current row Home

Move to the last filled cell in the current row End

Move to the first cell in the worksheet (A1) Cmd+Home

Move to the last filled cell in the worksheet Cmd+End

Move to the next circular reference Shift+F5
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Command Shortcut key

Go to the next error Cmd+F3

Copy cell above Ctrl+, (comma)

Copy value from cell above Ctrl+Shift+, (comma)

Enter an array formula Cmd+Shift+¿

Select current array formula Cmd+7

Select current conditional formatting Cmd+6

Open a selection list with the contents of the cells above or below
a cell

Alt+Shift+â

Switch between AUTO and TEXT input mode
(see Status bar)

Cmd+Shift+F4

Insert current date Ctrl+. (period)

Insert current time Ctrl+Shift+. (period)

Convert a hexadecimal character code into Unicode characters* Cmd+Alt+Shift+X

* If, for example, you type 20AC and then press this shortcut key, a euro sign € will appear (since this character has the code 20AC in the Unicode
character set).



834Appendix

Command-line parameters

Note: The command-line parameters described here only work on Windows.

Command-line parameters allow you to specify that PlanMaker is started immediately with a specific program
option rather than with the usual default behavior. Example: You would like PlanMaker to switch to the dialog
box for selecting a document template directly upon startup.

To insert a command-line parameter, proceed as follows:

1. Create a new shortcut to PlanMaker on the desktop. Ideally, give the link a distinctive name in order to
distinguish it more clearly.

2. Choose the properties of the shortcut: Right-click on the link for the context menu and select the entry
Properties.

3. The following dialog box with the Shortcut tab will then appear:
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4. In the input field Target after the file path "...\PlanMaker.exe", enter the desired parameter from the
table below. In the figure, for example, this is the parameter -FN.

Important: There must be a space in front of the parameter and the parameter starts with a hyphen.

5. Confirm with OK.

When you open PlanMaker via this newly created link (double-click the link), the program will start directly
with the behavior of the parameter that was used.

Command-line parameters

Parameter Description

 -N PlanMaker starts without opening a new default document.

 -FO PlanMaker starts with an open dialog box for selecting a file.

 -FN PlanMaker starts with an open dialog box for selecting a document
template.

 -P"Path\FileName" PlanMaker starts and prints the specified file directly on the default
printer.

 -Q"PrinterName","Path\FileName"
Note: No space is inserted
within the parameter.

PlanMaker starts and prints the specified file directly on the specified
printer.
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#
#DIV/0!   490

#N/A   490, 581, 639, 642, 685

#NAME?   490

#NULL!   490

#NUM!   490

#REF!   490

#VALUE!   490

$
$ sign   485

%
% sign (operator)   482

3
3D effect (for objects)   276

3D view  
for charts   347

A
ABS (absolute value)   495

Absolute cell references   485

Absolute value (ABS)   495

Accounting (number format)   186

ACOS (arccosine)   495

ACOSH (inverse hyperbolic cosine)   496

ACOT (arccotangent)   497

ACOTH (inverse hyperbolic cotangent)   497

Actual size (view)   454

Add/edit text  
for AutoShapes   302
for text frames   302

Addition (operator)   482

ADDRESS (cell address as text)   498

Align (object)  
align and distribute objects   265
snap to cells   424
to other objects with guides   424

Alignment  
of cell contents   199
of text in text frames   281, 283

All caps  
option for the character format   206
PROPER (function)   722

UPPER (function)   790

Analyze sheets   104

AND (logical AND function)   499

Android/iOS  
context menu   35
input method   33
select   67
share a document   400
user interface   33

Annuity  
see PMT   714

ANSI code of a character (CODE)   529

Anti-aliasing   431

Arabic scripts   415, 426

Arccosine (ACOS)   495

Arccotangent (ACOT)   497

Arcsine (ASIN)   500

Arctangent  
ATAN   501
ATAN2   502

Area chart   311

AREAS (number of areas)   500

Array functions  
MDETERM (matrix determinant)   670
MINVERSE (inverse)   675
MMULT (product of matrices)   677
MSOLVE (solution)   682
TRANSPOSE (transpose matrix)   783
working with arrays   491

Asian scripts   426

ASIN (arcsine)   500

ASINH (inverse hyperbolic sine)   501

Associate file types   438

ATAN (arctangent)   501

ATAN2 (arctangent)   502

ATANH (inverse hyperbolic tangent)   503

Auto input mode   38

Autocomplete cells   61, 427

AutoFilter   96

AutoFormat   226

Automatic percent input   427

Auto-Recover   436, 437

AutoShape  
add/edit text   302
AutoShape effects   303
AutoShape templates   303
change on ribbon tab Object   303
change on the ribbon tab Object   267
change text area   285
change via the dialog box   278, 305
drawing   300
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AutoSum   762

AutoText   371

AVEDEV (average deviation)   503

Average  
arithmetic mean (AVERAGE)   504
arithmetic mean (AVERAGEA)   504
if condition is true (AVERAGEIF)   505
if condition is true (AVERAGEIFS)   506

AVERAGE (arithmetic mean)   504

Average deviation (AVEDEV)   503

Average square deviation (DEVSQ)   571

AVERAGEA (arithmetic mean)   504

AVERAGEIF (average if condition is true)   505

AVERAGEIFS (average if conditions are true)   506

Axes (in charts)   317, 336, 337, 339, 341

Axis title (in charts)   317, 340

B
B (compatibility function)   507

Background color  
of cells   197
of text   207

Backup copies   382, 437

Backup folder   382, 437

BAK files   382

Banded rows and columns   133

Bar chart   311

BASE (convert decimal number into another base)   508

Based on (for cell styles)   220

Based on (for character styles)   217

BasicMaker   418

Beep on errors   431

Beep on errors (for spell check)   435

BESSELI (modified Bessel function In(x))   509

BESSELJ (Bessel function Jn(x))   509

BESSELK (modified Bessel function Kn(x))   510

BESSELY (Bessel function Yn(x))   510

Beta distribution  
BETA.DIST   511
BETA.INV   513
BETADIST   511
BETAINV   512

BETA.DIST (beta distribution)   511

BETA.INV (percentiles of the beta distribution)   513

BETADIST (beta distribution)   511

BETAINV (percentiles of the beta distribution)   512

BIN2DEC (binary to decimal)   514

BIN2HEX (binary to hexadecimal)   515

BIN2OCT (binary to octal)   516

Binary to decimal (BIN2DEC)   514

Binary to hexadecimal (BIN2HEX)   515

Binary to octal (BIN2OCT)   516

BINOM.DIST (binomial distribution)   518

BINOM.DIST.RANGE (binomial distribution)   519

BINOM.INV (binomial distribution)   520

BINOMDIST (binomial distribution)   517

Binomial distribution  
BINOM.DIST   518
BINOM.DIST.RANGE   519
BINOM.INV   520
BINOMDIST   517
CRITBINOM   550
NEGBINOM.DIST   687
NEGBINOMDIST   687

Bold (font)   206

Boolean (number format)   186

Borders  
of cells   195
of objects   275

Box and whisker plot   311

Boxplot chart   311

Bring forward one level (object)   264

Bring to front (object)   264

Bubble chart   311

C
Calculation in status bar   427

Calculations  
update   111, 449

Category axis (in charts)   317, 336

CEILING (round up to a multiple of base)   521

Cell   199
alignment   199
borders   195
change size   181
delete   69
do not print   403
enter data   61
fill automatically   79, 476
hide   403
insert   71
merge   199
number format   184, 186, 189
protect   203
protection   403
select   65
shading   197

CELL (information about a cell)   521

Cell address as text (ADDRESS)   498
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Cell contents  
copy   73
cut   73
delete   73
paste   73

Cell formatting, transfer   241

Cell frame   42, 424

Cell marker   424

Cell protection   403

Cell styles   219, 220
apply   219
based on   220
change   222
create   220
default style "Normal"   222
shortcut keys   220

Centered   199

Change shape   267

Change text area  
of AutoShapes   285
of text frames   285

CHAR (character from ANSI code)   523

Character format  
all caps   206
background color   207
bold   206
character pitch   209
font   203, 205
font color   207
font size   203, 205
italic   206
kerning   209
letter spacing   209
small caps   206
strikethrough   206
superscripts and subscripts   208
text styles   203, 206
underline   206

Character formatting  
apply to entire words   427
reset   210, 216

Character pitch   209

Character styles   214
apply   215
based on   217
change   215
create   214
default style "Normal"   217
shortcut keys   214, 215

Chart (dialog box)   344

Chart (ribbon tab)   309

Chart area   327

Chart title   318, 341, 346

Charts   308
add/delete data series   345
arrangement of data series   316, 345
change chart location   348
change chart type   311
change properties   344
data in columns   316
data in rows   316
edit   309
insert   309
save as picture   349
select chart elements   325
update   348, 449

Check for updates   438

Checkboxes (form object)   353

CHIDIST (chi-square distribution)   523

CHIINV (percentiles of the chi-square distribution)  
524

CHISQ.DIST.RT (chi-square distribution)   525

CHISQ.INV.RT (percentiles of the chi-square
distribution)   525

CHISQ.TEST (chi-square test)   526

Chi-square distribution  
CHIDIST   523
CHIINV   524
CHISQ.DIST.RT   525
CHISQ.INV.RT   525

Chi-square test  
CHISQ.TEST   526
CHITEST   527

CHITEST (chi-square test)   527

CHOICE (x>0, x=0, x<0?)   527

CHOOSE (choose value from list)   528

Circular reference   38, 449

Classic menus with toolbars   22, 431
list of all ribbon commands and menu commands  
809
user interface   32

CLEAN (remove non-printable characters)   529

Close (File)   422

Close document   422

CODE (ANSI code of a character)   529

Color  
of cells   197
of objects   273
of text   207

Color gradient (for objects)   273

Column  
change width   181, 182
delete   69
hide/show   183
insert   71
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Column  
optimum width   182
select   65

COLUMN (function: column number of cells)   530

Column chart   311

Column header  
change column width   182
print   244
show/hide   452
use for selection   65

COLUMNS (function: number of columns)   530

COMBIN (combinations)   531

Combine (object shapes)   268

Combine shapes   268

Command-line parameters   834

Comments   113
always show   113
delete   113
edit   113
insert   113
print   244
show always   447

Common logarithm (LOG10)   657

Complex numbers  
absolute value (IMABS)   623
angle (IMARGUMENT)   624
build complex number (COMPLEX)   531
conjugate (IMCONJUGATE)   624
cosine (IMCOS)   625
difference (IMSUB)   631
division (IMDIV)   625
exponential (IMEXP)   626
imaginary coefficient (IMAGINARY)   623
logarithm, base 10 (IMLOG10 )   627
logarithm, base 2 (IMLOG2 )   627
negative value (IMNEG)   628
power (IMPOWER)   628
product (IMPRODUCT)   629
real coefficient (IMREAL)   629
sine (IMSIN)   630
square root (IMSQRT)   630
sum (IMSUM)   632

Complex scripts   426

CONCAT (concatenate strings from list)   532

CONCATENATE (concatenate text strings)   533

Concatenation (operator)   482

Concatenation of strings (functions)  
CONCAT   532
CONCATENATE   533
TEXTJOIN   777

Condition  
CHOICE   527
IF   619

IFS   619

Conditional formatting   227
delete rules in selected cells   234
manage rules   232
new rule   228
types of conditions   229

Cone chart   311

CONFIDENCE (confidence interval)   534

Confidence interval  
CONFIDENCE   534
CONFIDENCE.NORM   535

CONFIDENCE.NORM (confidence interval)   535

Consolidate data   121

Context menu   35

CONVERT (unit conversion)   536

Convert decimal number into another base (BASE)   508

Convert EU currencies (EUROCONVERT)   582

Copy  
cell contents   73
formula   73
insert copied cells   72
object   73
text   73

Corners (in charts)   330

CORREL (correlation coefficient)   539

Correlation coefficient  
CORREL   539
PEARSON   705

Correlation coefficient (RSQ)   740

COS (cosine)   540

COSH (hyperbolic cosine)   541

Cosine (COS)   540

COT (cotangent)   541

Cotangent (COT)   541

COTH (hyperbolic cotangent)   542

Count  
COUNT   542
COUNTA   543
COUNTBLANK   544
COUNTIF   544
COUNTIFS   545

COUNT (number of cells filled with numbers)   542

COUNTA (number of cells filled)   543

COUNTBLANK (number of blank cells)   544

COUNTIF (count if condition is true)   544

COUNTIFS (count if conditions are true)   545

COUNTP (PlanMaker 97 compatibility function)   546

COVAR (population covariance)   547

Covariance  
COVAR (population)   547
COVARIANCE.P (population)   548
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Covariance  
COVARIANCE.S (sample)   549

COVARIANCE.P (population covariance)   548

COVARIANCE.S (sample covariance)   549

Create a complex number (COMPLEX)   531

Create new document   420

CREATEDATE (date the document was created)   550

Creation date   248

CRITBINOM (binomial distribution)   550

Cropping (of pictures)   288, 289

CSV file format   411

CUMIPMT (cumulative interest)   551

CUMPRINC (cumulative principal)   552

CURRENCY (format number as currency)   553

Currency (number format)   186

Custom number formats   186

Customize  
create user-defined icons   473
customize shortcut keys   473
customize toolbars   468
ribbon   458

Cut  
cell contents   73
formula   73
object   73
text   73

Cylinder chart   311

D
Data consolidation   121, 122, 125, 127

Data labels (in charts)   319, 330

Data points (in charts)   330

Data series (in charts)   345
add   345
delete   345
edit   330

Data series, fill automatically   79, 476

Data source area (of charts)   345

Data validation   110, 235

Database functions   493
DAVERAGE   557
DCOUNT   563
DCOUNTA   563
DGET   571
DMAX   572
DMIN   573
DPRODUCT   574
DSTDEV   575
DSTDEVP   576
DSUM   576

DVAR   577
DVARP   577

Date  
create a date value (DATE)   554
current (TODAY)   783
current, with time (NOW)   697
enter   61

DATE (create a date value)   554

Date before/after n months (EDATE)   578

Date difference (DATEDIF)   555

Date filters (AutoFilter)   96

Date last changed   248

Date the document was created (CREATEDATE)   550

Date/time (number format)   186

DATEDIF (date difference)   555

DATEVALUE (convert text into date value)   556

DAVERAGE (database function)   557

DAY (day of a date)   557

DAYS (days between two dates)   558

DAYS360 (days between two dates)   559

DAYSP (compatibility function)   560

DAYSPERMONTH (days per month)   561

DAYSPERYEAR (days per year)   561

DB (fixed-declining balance depreciation)   562

dBASE file format   409

DCOUNT (database function)   563

DCOUNTA (database function)   563

DDB (double-declining balance depreciation)   564

DEC2BIN (decimal to binary)   565

DEC2HEX (decimal to hexadecimal)   566

DEC2OCT (decimal to octal)   567

DECIBEL (decibel value of two quantities)   568

DECIMAL (convert number from any base into
decimal)   568

Decimal point after input   447

Decimal separator   427

Decimal to binary (DEC2BIN)   565

Decimal to hexadecimal (DEC2HEX)   566

Decimal to octal (DEC2OCT)   567

DECIMALS (fractional part of a number)   569

Default cell style "Normal"   222

Default character style "Normal"   217

Default currency   447

Default file format when saving   436

Default language for spell check   364, 435

Default number format   186

Default template (document template)  
"Normal"   44, 226
change   44
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Default template (document template)  
switch   226

Default unit of measure   431

Defined names   87, 90

Defined names (for cell ranges)   88
apply in existing formulas   91
export names as list   90

DEGREES (convert radians to degrees)   570

Degrees to radians (RADIANS)   726

Delete   42, 68
cell contents   68
cells   68, 69
duplicate rows   70
empty rows   70
object   73
special   68
text   73

DELTA (test for equality)   570

Depreciation  
double-declining balance (DDB)   564
fixed-declining balance (DB)   562
straight-line (SLN)   748
sum-of-years’ digits (SYD)   771

Design Science   298

Determinant of a matrix (MDET)   670

DEVSQ (average square deviation)   571

DGET (database function)   571

Dialog language   431

Dictionaries for spell check  
edit   367
install   478

Disable sheet protection   404

Display help content (F1 key)   825, 829

Display the formula a cell contains (FORMULATEXT)

 
 596

Distance to edge   242

Distribute (object)   265

Division (operator)   482

DMAX (database function)   572

DMIN (database function)   573

Document management   375

Document properties   445
Calculate tab   449
Colors tab   445
Fonts tab   452
Options tab   447
Protection tab   452
Statistics tab   447
Summary tab   377, 445

Document protection   406

Document statistics   447

Document summary  
enter   377
prompt for summary information when saving   436

Document tabs   37, 419

Document templates   224
apply   225
change   225
create   224
default template "Normal"   226

Document, print   48, 393

Document, save   48

DOLLARDE (convert to dollar price decimal)   573

DOLLARFR (convert to dollar price fraction)   574

Doughnut chart   311

DPRODUCT (database function)   574

Drag and drop   73

Draw circles   300

Draw connectors   300

Draw curves   300

Draw ellipses   300

Draw rectangles   300

Drawing object (dialog box)   305

Drawing object (ribbon tab)   303

Drawings   300
change properties   303, 305
combine   268
edit retroactively   270
insert   300
rotate   263

Dropdown lists (form object)   356

DSTDEV (database function)   575

DSTDEVP (database function)   576

DSUM (database function)   576

Duplicate (objects)   265

Duplicate rows (delete)   70

DVAR (database function)   577

DVARP (database function)   577

Dynamic tables   128

E
EDATE (date before/after n months)   578

Edit  
links (OLE objects)   294

Edit chart elements   325
axis title   340
chart area   327
chart title   341, 346
corners   330
data labels   330
data series   330
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Edit chart elements   325
error bars   330
floor   329
gridlines   342
legend   343
lines   330
plot area   328
trendline   334
up/down bars   330
walls   329
X axis   336
Y axis   337
Z axis   339

Edit color palette   445

Edit lists (for filling)   79, 476

Edit mode   261

Edit points (of objects)   270

Edit script   418

Edit shapes retroactively   270

Edit toolbar   36

EFFECT (effective interest rate)   579

Effective interest rate (EFFECT)   579

Effects (for objects)   277

E-mail a document   400

Empty rows, remove   70

En dashes, different widths   178

Enable OpenGL for AutoShapes   438

Encryption   406

Enter data in cells   61

EOMONTH (end of month in n months)   579

Equality (DELTA)   570

Equation Editor   298

ERF (Gaussian error function)   580

ERFC (complement to Gaussian error function)   581

Error bar (in charts)   320, 330

Error function  
ERF   580
ERFC (complement)   581

Error type (ERROR.TYPE)   581

Error values in calculations   110, 490, 639, 640

ERROR.TYPE (error type)   581

EUROCONVERT (convert EU currencies)   582

EVEN (round up to next even number)   584

EXACT (compare texts)   584

Excel file format   353, 409, 413, 414

Exclusive or (XOR)   805

Exit (file)   49

EXP (power of e)   585

EXPON.DIST (exponential distribution)   586

EXPONDIST (exponential distribution)   585

Exponential distribution  
EXPON.DIST   586
EXPONDIST   585

Exponential regression  
statistics (LOGEST)   658
values (GROWTH)   608

Exponentiation  
operator   482
POWER function   718

Export (other file format)   409

Export/Import of settings   442

Extended support  
for Arabic text   415, 426
for Asian fonts   426

External cell references   486

External references  
enter   486
manage   488
update   488

F
F distribution  

F.DIST.RT   589
F.INV.RT   592
FDIST   588
FINV   591

F.DIST.RT (F distribution)   589

F.INV.RT (percentiles of the F distribution)   592

F.TEST (F-test)   598

FACT (factorial)   587

FACTDOUBLE (double factorial)   587

FALSE (logical value FALSE)   588

FDIST (F distribution)   588

Fields (in headers/footers)   248

File  
export as PDF   396
send by e-mail   400

File formats   409

File manager   378

File properties   445
Calculate tab   449
Colors tab   445
Fonts tab   452
Options tab   447
Protection tab   406, 452
Statistics tab   447
Summary tab   377, 445

File type   409

File versions   382, 437

File: Close   422

File: Exit   49
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File: New   44

File: Open   46, 409

File: Page setup   242, 244, 248

File: Print   48, 393

File: Print preview   392

File: Properties   445

File: Save   48

File: Save all   48

File: Save as   48, 409

FILENAME (file name of the document)   590

Fill  
of objects   273

Fill cells (automatically)   79, 476

Filling  
of cells   197

Filters   96, 761
AutoFilter   96
special filter   101

FIND (search for text)   590

FINV (percentiles of the F distribution)   591

First column (emphasize)   133

First column, freeze   176

FISHER (Fisher transformation)   593

FISHERINV (Inverse of the Fisher transformation)  
593

FIXED (format number as text with fixed decimals)  
594

Flip (objects)   263

Floor (in charts)   329

FLOOR (rounding off to a multiple of n)   595

Folder for file versions   382, 437

Font   203, 205
bold   206
italic   206
underline   206

Font color   207

Font lists, hide fonts   441

Font size   203, 205

Footers   248

FORECAST (forecast using linear regression)   595

Form object (ribbon tab)   363

Form objects   351
edit   352
evaluate   352

Form objects, insert   351
checkboxes   353
dropdown lists   356
groupboxes   362
labels   362
listboxes   357

pushbuttons   359
radio buttons   355
scrollbars   360
spinners   359

Format painter   241

Formatting toolbar   32

Forms   350

Formula auditing   107, 108, 110

Formulas   481

FORMULATEXT (display formula contained in cell)  
596

Fraction (number format)   186

Freehand drawing   300

Freeze rows/columns   176

FREQUENCY (frequency)   597

F-test  
F.TEST   598
FTEST   598

Full screen mode (view)   455

Functions   481
functions from A to Z   495
insert   483

Future value  
FV   599
FVSCHEDULE   600

FV (future value)   599

FVSCHEDULE (future value)   600

G
GAMMA (gamma function)   601

Gamma distribution  
GAMMA.DIST   602
GAMMA.INV   603
GAMMADIST   601
GAMMAINV   602

Gamma function  
GAMMA   601
GAMMALN   604

GAMMA.DIST (gamma distribution)   602

GAMMA.INV (percentiles of the gamma distribution)  
603

GAMMADIST (gamma distribution)   601

GAMMAINV (percentiles of the gamma distribution)  
602

GAMMALN (logarithm of the gamma function)   604

GAUSS (standard normal distribution)   604

Gauss test  
Z.TEST   807
ZTEST   807

Gaussian distribution (NORM.DIST)   691
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Gaussian distribution (NORMDIST)   690

Gaussian error function  
ERF   580
ERFC complement   581

GCD (greatest common divisor)   605

GEOMEAN (geometric mean)   605

Geometric mean (GEOMEAN)   605

GESTEP (number greater or equal to threshold value?)  
606

GETPIVOTDATA   607

Glow effect (for objects)   277

Go to   257

Goal seek   115

Greatest common divisor (GCD)   605

Gridlines between table cells  
paint behind cells   424
print   244
show   452

Gridlines in charts   320, 342

Group  
cells (outliner)   386
in pivot tables   169
objects   266
show/hide cells   387

Groupboxes (form object)   362

GROWTH (values of an exponential regression)   608

Guidelines for text frames, show   447

H
Hamburger menu   28, 30

HARMEAN (harmonic mean)   609

Harmonic mean (HARMEAN)   609

Headers and footers   248

Height of a row   181, 182

HEX2BIN (hexadecimal to binary)   610

HEX2DEC (hexadecimal to decimal)   611

HEX2OCT (hexadecimal to octal)   611

Hexadecimal to binary (HEX2BIN)   610

Hexadecimal to decimal (HEX2DEC)   611

Hexadecimal to octal (HEX2OCT)   611

Hide  
cells contents   403
objects   267

Hide cells  
manually   183
using the outliner   385

High-low chart   311

HLOOKUP (look up row-wise)   612, 804

HOLIDAY (dates of movable Christian holidays)   614

Horizontal alignment of cell contents   199

HOUR (hour)   615

HTML document   389, 391

Hunspell dictionaries   435, 478

Hyperbolic cosine (COSH)   541

Hyperbolic cotangent (COTH)   542

Hyperbolic sine (SINH)   746

Hyperbolic tangent (TANH)   774

Hypergeometric distribution  
HYPGEOM.DIST   618
HYPGEOMDIST   617

HYPERLINK (function: hyperlink)   615

Hyperlinks (links)   389
applied to cells   389
for objects   277
for OLE objects   294
HYPERLINK function   615
remove   389
to jump target   389

HYPGEOM.DIST (hypergeometric distribution)   618

HYPGEOMDIST (hypergeometric distribution)   617

Hyphen  
non-breaking hyphen   178
soft hyphen   178

Hyphenation   368
in table cells   369
in text frames   368
set language   364

I
IF (if-then-else condition)   619

IFEMPTY (return a value if cell is empty)   621

IFERROR (return a value on errors)   621

IFNA (return defined value for #N/A)   622

IFS (first condition met)   619

Ignore words that start with a number   435

IMABS (absolute value of a complex number)   623

IMAGINARY (imaginary coefficient of a complex
number)   623

IMARGUMENT (angle of a complex number)   624

IMCONJUGATE (conjugate a complex number)   624

IMCOS (cosine of a complex number)   625

IMDIV (division of complex numbers)   625

IMEXP (exponential of a complex number)   626

IMLN (natural logarithm of a complex number)   626

IMLOG10 (base-10 logarithm of a complex number)  
627

IMLOG2 (base-2 logarithm of a complex number)   627

IMNEG (negative value of a complex number)   628
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Import (other file format)   409

Import/Export of settings   442

IMPOWER (power of a complex number)   628

IMPRODUCT (product of complex numbers)   629

IMREAL (real coefficient of a complex number)   629

IMSIN (sine of a complex number)   630

IMSQRT (square root of acomplex number)   630

IMSUB (difference of complex numbers)   631

IMSUM (sum of complex numbers)   632

In-cell editing   427

Indents (text frames only)   211

INDEX (cell in a particular row/column)   632

INDIRECT (create reference from text)   633

Information about a cell (CELL)   521

Inner margins  
of cells   199
of text frames   281, 283
of text in AutoShapes   306

Input method (Android)   33

Input validation   110, 235, 237, 240

Insert  
cells   71
characters   178
charts   309
columns   71
comments   113
copied cells   72
drawings   300
Equation Editor objects   298
form objects   351
functions   483
headers and footers   248
objects   260
OLE objects   292
page break   251
pictures   286
rows   71
SmartText entries   372
special characters   178
text frames   281

Insert characters   178

Insert frames and drawings immediately   427

Insert mode / Overwrite mode   38
disable   426

Insert pictures from the gallery/camera (Android and
iOS only)   287

Insert special characters   178

Installation   25
Android   27
iOS   27
Linux   27
macOS   26

Windows   25

INT (round down to nearest integer)   634

INTERCEPT (intercept point of a regression line)   635

Interest payment  
(IPMT)   637
CUMIPMT (cumulative)   551
ISPMT   648

Interest rate  
PCF   739
per period (RATE)   731
RRI   739

Internal rate of return  
IRR   638
MIRR   676

Intersection  
INTERSECTION function   636
operator   482

INTERSECTION (intersection of two ranges)   636

Inverse hyperbolic cosine (ACOSH)   496

Inverse hyperbolic cotangent (ACOTH)   497

Inverse hyperbolic sine (ASINH)   501

Inverse hyperbolic tangent (ATANH)   503

Inverse matrix (MINVERSE)   675

iOS/Android  
context menu   35
input method   33
select   67
share a document   400
user interface   33

IPMT (interest payment)   637

IRR (internal rate of return)   638

ISBLANK (is empty?)   639

ISERR (is an error value except #N/A?)   490

ISERR (is an error value other than #N/A?)   639

ISERROR (is an error value?)   490, 640

ISEVEN (is an even number?)   640

ISFORMULA (is a formula?)   641

ISLOGICAL (is a logical value?)   641

ISNA (is not available?)   642

ISNONTEXT (is no text?)   643

ISNUMBER (is numeric?)   643

ISNUMBERP (PlanMaker 97 compatibility function)  
644

ISODD (is an odd number?)   645

ISOWEEK (ISO week number)   646

ISOWEEKNUM (ISO week number)   647

ISPMT (interest payment)   648

ISREF (is a valid reference?)   648

ISTEXT (is text?)   649

Italic (font)   206
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Iterations for calculations   449

J
Jump target (hyperlink)   389

Justification (in text frames)   281, 283

K
Keep aspect ratio   272

Keep scaling   272

Kerning   209

KURT (kurtosis)   649

Kurtosis (KURT)   649

L
Labels (form object)   362

Landscape format   242

Language  
for spell check and hyphenation   364
for user interface   431

LARGE (k-th largest number)   650

Last column (emphasize)   133

LASTPRINTED (date last printed)   651

LASTSAVED (date last saved)   652

LCM (least common multiple)   652

Least common multiple (LCM)   652

LEFT (function: left part of a text string)   654

Left align   199

Left arrow key never exits cell editing   427

Legend (in charts)   321, 343

LEN (length)   653

Letter spacing   209

Line chart   311

Line spacing (text frame)   211

Linear regression  
FORECAST   595
INTERCEPT   635
show trend in charts   334
statistics (LINEST)   654
values (TREND)   784

Lines  
as borders of objects   275
drawing   300

Lines (in charts)   322, 330

LINEST (statistics of a linear regression)   654

Links (hyperlinks)  
applied to cells   389
for objects   277

HYPERLINK function   615

Links (OLE objects)  
edit   294
update   294

Listboxes (form object)   357

Live preview   431

LN (natural logarithm)   656

LOG (logarithm)   657

LOG10 (base-10 logarithm)   657

Logarithm  
any base (LOG)   657
base 10 (LOG10)   657
natural (LN)   656

LOGEST (statistics of an exponential regression)   658

LOGINV (percentiles of the lognormal distribution)  
660

LOGNORM.DIST (lognormal distribution)   661

LOGNORM.INV (percentiles of the lognormal
distribution)   662

Lognormal distribution  
LOGINV   660
LOGNORM.DIST   661
LOGNORM.INV   662
LOGNORMDIST   660

LOGNORMDIST (lognormal distribution)   660

LOOKUP (search cell range)   663

LOWER (convert text to lower case)   666

Lower case  
LOWER   666
PROPER   722

M
Macros   353, 414

Manage (button in the settings)   441

Manual (PlanMaker)   23

Margins  
inner margins of AutoShapes   306
inner margins of cells   199
inner margins of text frames   281, 283
page margins   242

Mark invalid data   240

MATCH (relative position in a range)   666

MathType   298

Matrix equation (MSOLVE)   682

MAX (maximum)   667

MAXA (maximum)   668

MAXIFS (conditional maximum)   668

Maximum number of undo steps   426

MDETERM (matrix determinant)   670

Mean  
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Mean  
geometric (GEOMEAN)   605
harmonic (HARMEAN)   609
without marginal values (TRIMMEAN)   786

MEDIAN   670

Menu bar   32

Menus with toolbars or ribbon?   28, 431

MID (part of a text string)   671

Middle mouse button   427

MILLISECONDS (milliseconds)   672

MIN (minimum)   672

MINA (minimum)   673

MINIFS (conditional minimum)   674

MINUTE (minute)   675

MINVERSE (inverse matrix)   675

MIRR (modified internal rate of return)   676

Mirror (objects)   263

MMULT (product of matrices)   677

MOD (remainder of a division, Excel method)   677

MODE (most frequently occurring value)   679

MODE.SNGL (most frequently occurring value)   679

Modified internal rate of return  
MIRR   676

MODP (remainder of a division, PlanMaker method)  
680

MONTH (month of a date)   681

Move by ... decimals   447

Move selection after input to ...   427

MROUND (round to a multiple of base)   682

MSOLVE (solution of matrix equation Ax=B)   682

MULTINOMIAL (multinomial coefficient)   684

Multinomial coefficient  
MULTINOMIAL   684
POLYNOMIAL   718

Multiplication (operator)   482

N
N (convert value into number)   684

NA (error value #N/A)   685

Name of a worksheet (SHEETNAME)   743

Names (for cell ranges)   87, 90
apply in existing formulas   91
assign   88
create from selection   89
edit   88
insert list   90

Names (of objects)   265

Names (of tables)   133, 136, 265

NEG (negative value)   686

Negation (NEG)   686

Negative binomial distribution  
NEGBINOM.DIST   687
NEGBINOMDIST   687

NEGBINOM.DIST (negative binomial distribution)  
687

NEGBINOMDIST (negative binomial distribution)  
687

Net present value  
NPV   698
XNPV   805

NETWORKDAYS (number of workdays)   689

Neumann function (BESSELY)   510

New (File)   44, 224, 225

New pivot table   141

New program window   420

New table (tables in worksheets)   128, 129, 130

NOMINAL (nominal interest rate)   689

Non-breaking hyphen   178

Non-breaking space   178

NORM.DIST (normal distribution)   691

NORM.INV (percentiles of the normal distribution)  
693

NORM.S.DIST (standard normal distribution)   694

NORM.S.INV (percentiles of the standard distribution)  
696

Normal  
cell style   222
character style   217

Normal distribution  
NORM.DIST   691
NORM.INV   693
NORMDIST   690
NORMINV   692

Normal distribution, logarithmic  
LOGINV   660
LOGNORM.DIST   661
LOGNORM.INV   662
LOGNORMDIST   660

Normal.pmvx   44, 226

NORMDIST (normal distribution)   690

NORMINV (percentiles of the normal distribution)  
692

NORMSDIST (standard normal distribution)   694

NORMSINV (percentiles of the standard distribution)  
695

NOT (logical NOT function)   696

NOW (current date and time)   697

NPER (number of periods)   697

NPV (net present value)   698

Number (number format)   186
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Number filters (AutoFilter)   96

Number format   184, 186, 189, 190

Number of periods (NPER)   697

Number of worksheets (SHEETS)   744

Number separators   427

Number series, fill automatically   79, 476

Numbers, enter   61

NUMBERVALUE (convert text to a number)   699

O
Object  

copy   73
cut   73
delete   73
paste   73
select   260

Object (dialog box)   272

Object mode   261

Object properties  
change default settings   279
for charts   344
for checkboxes   354
for drawings   303
for dropdown lists   356
for groupboxes   362
for labels   362
for listboxes   358
for OLE objects   295, 297
for pictures   289
for pushbuttons   359
for radio buttons   355
for scrollbars   361
for spinners   360
for text frames   281, 283
general properties   272

Objects   259
align and distribute   265
change order   264
change position and size   262
change properties   272
combine   268
distribute   265
duplicate   265
edit retroactively   270
group   266
hide   267
insert   260
rotate   272
rotate or flip   263
show hidden objects   267, 447
show text frame guidelines   447
ungroup   266

OCT2BIN (octal to binary)   701

OCT2DEC (octal to decimal)   702

OCT2HEX (octal to hexadecimal)   702

Octal to binary (OCT2BIN)   701

Octal to decimal (OCT2DEC)   702

Octal to hexadecimal (OCT2HEX)   702

ODD (round up to next odd number)   703

OFFSET (shifted reference)   704

OLE object (dialog box)   297

OLE object (ribbon tab)   295

OLE objects   292
change properties   295, 297
edit   294
edit links   294
Equation Editor   298
insert   292
update links   294
warning when loading   426

Open (File)   46, 225, 409

Operators in formulas   482

Optimum height   182

Optimum width   182

OR (logical OR function)   705

Order (of objects)   264

Orientation  
of printed pages   242

Other file formats   409

Outline pane   385, 387

Outlines   385, 386, 387
automatically show outline pane   387
change settings   387
clear outline   386
group cells   386
options   387
protect   387
show/hide grouped cells   387
ungroup   386

Overlapping objects   283, 306

Overwrite mode / Insert mode   38
disable   426

P
Page break preview   251

Page breaks  
adjust manually   251
show/hide   452

Page setup   242
copy to other worksheets   85
headers and footers   248
number of pages   248
page format   242
page margins   242
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Page setup   242
page number   244, 248
page orientation   242
page size   242
print options   244

Paper size   242

Paper trays   242

Paragraph format (text frame)   210
line spacing   211
spacing above/below   213
text alignment   212

Paragraph format (text frames)  
indents   211

Pascal distribution  
NEGBINOM.DIST   687
NEGBINOMDIST   687

Paste  
contents (selective)   75
reference   75

Paste copied content   73

Paste reference   75, 486

Paste special   75

Payment (PMT)   714

PCF (interest rate)   739

PDF export   396

PDF/A, create   396

Peakedness of a distribution (KURT)   649

PEARSON (Pearson correlation coefficient)   705

Percent (operator)   482

Percentage (number format)   186

PERCENTILE (percentiles of a data set)   706

PERCENTILE.EXC (percentiles of a data set)   707

PERCENTILE.INC (percentiles of a data set)   708

PERCENTRANK (percent rank in a data set)   709

PERCENTRANK.EXC (percent rank in a data set)   709

PERCENTRANK.INC (percent rank in a data set)   710

PERIOD (duration of fixed-interest investments)   711

PERMUT   712

PHI (standard normal distribution)   713

Photo frames   267, 288

PI (pi)   714

Picture (dialog box)   289

Picture (ribbon tab)   288

Pictures   286
change properties   289
change source   288
copy to document's folder   286
export   289
from scanner   287
insert   286

recolor   288, 289
rotate or flip   263
save within document   286
select source   287

Pie chart   311

Pinned files   46

Pinned templates   44

Pivot tables   139
change the source data range   172
column labels   145
copy   173
create from existing data   142
create from external data   144
create from tables in worksheets   141
custom name for fields   151, 152, 156, 161
custom name for pivot table   163
defer layout update   166
delete   173
field list: areas section   152
field list: configure the pivot table   155
field list: exercises   146
field list: fields section   151
field list: further options   154
field list: starting screen   145
field settings   156
fields: move and remove   152
filter   167
filter labels/filter values   167
form (field settings)   156
GETPIVOTDATA   607
group   169
layout (pivot table settings)   163
modify pivot table ranges   172
move   173
number format   161
outline form   156
pivot table settings   163
Pivot table sidebar   145
refresh when opening the file   163, 172
report filter   145, 167
row labels   145
save source data with file   163
sort A-Z (fields in the field list)   151
sort A-Z (fields in the pivot report)   167
styles for pivot tables   163
subtotals   156
tabular form   156
update   172
value settings   161
values area   145

Plain text file format   409, 411

PlanMaker  
basics   40
customize   423
settings   424
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PlanMaker  
user interface   28

PlanMaker basics   40

PlanMaker file format   409

PlanMaker manual   23

PlanMaker Tour   50

Plot area (in charts)   328

PMBAK files   382

PMD file format   409

PMDX file format   409

PMT (payment)   714

POISSON (Poisson distribution)   715

Poisson distribution  
POISSON   715
POISSON.DIST   716

POISSON.DIST (Poisson distribution)   716

POLYNOMIAL (polynomial coefficient)   718

Polynomial coefficient  
MULTINOMIAL   684
POLYNOMIAL   718

Portrait format   242

Position (of objects)   262

Position of a value in a range (MATCH)   666

POWER (power)   718

PPMT (payment on the principal)   719

Precision as displayed   449

Present value (PV)   722

Preview (of a document)   46

Primary axes (in charts)   346

Principal  
CUMPRINC (cumulative)   552
PPMT   719

Print a document   48, 393

Print date   248

Print order   244

Print preview   392

Print range  
define print range   244
remove print range   244

Print time   248

PROB (probability)   720

PRODUCT (product)   721

Product of matrices (MMULT)   677

Prompt for summary information when saving   436

PROPER (convert text to upper/lower case)   722

Properties (document)   445
Calculate tab   449
Colors tab   445
Fonts tab   452
Options tab   447

Protection tab   406, 452
Statistics tab   447
Summary tab   377, 445

Properties (object)  
for charts   344
for checkboxes   354
for drawings   303, 305
for dropdown lists   356
for groupboxes   362
for labels   362
for listboxes   358
for OLE objects   295, 297
for pictures   289
for pushbuttons   359
for radio buttons   355
for scrollbars   361
for spinners   360
for text frames   281, 283

Properties (objects in general)  
change default settings   279
general properties   272

Properties (worksheet)   452

Protect   402
cell protection   403
documents   406
sheet protection   402
workbooks   405

Protect outline   387

Protection indicator   447

Pushbuttons (form object)   359

PV (present value)   722

Pyramid chart   311

Q
QUARTILE (quartiles of a data set)   723

QUARTILE.EXC (quartiles of a data set)   724

QUARTILE.INC (quartiles of a data set)   725

Quick access toolbar   30
change position   431, 462
customize icons   462

Quick paths   375

QUOTIENT (quotient of a division)   726

R
Radar chart   311, 347

RADIANS (convert degrees to radians)   726

Radians to degrees (DEGREES)   570

Radio buttons (form object)   355

RAND (random value)   727

RANDBETWEEN (random value)   727
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Rank  
PERCENTRANK   709
PERCENTRANK.EXC   709
PERCENTRANK.INC   710
RANK   728
RANK.AVG   729
RANK.EQ   730

RANK (rank in a data set)   728

RANK.AVG (rank in a data set)   729

RANK.EQ (rank in a data set)   730

RATE (interest rate per period)   731

Rate of return  
IRR   638
MIRR   676

Recalc automatically   449

Recalc only before ...   449

Recalculate (sheet)   111, 449

Redo   43, 64

Redo (changes)   43, 64

Reflection effect (for objects)   277

Refresh data for pivot table   172

Regression, exponential  
statistics (LOGEST)   658
values (GROWTH)   608

Regression, linear  
statistics (LINEST)   654
values (TREND)   784

Relative cell references   485

Remainder of a division  
MOD (Excel method)   677
MODP (PlanMaker method)   680

Remove  
duplicate rows   70
empty rows   70

Remove duplicate rows   70

Remove non-printable characters (CLEAN)   529

Remove spaces (TRIM)   785

Repeat (commands)   64

Repeated columns   244

Repeated rows   244

REPLACE (replace text in a text string)   732

Replace (ribbon command Home | Search)   254, 255

Replace again (ribbon command Home | Search)   255

Replace text in a text string  
REPLACE   732
SUBSTITUTE   760

REPT (repeat text string n times)   733

Research via the Internet   370

Reset  
character formatting   210, 216
PDF export options   396

picture settings   288
ribbon   458
SoftMaker Office settings   442
toolbars   467

Revert to previous version (file)   382

Ribbon   22, 30
create user-defined icons   473
customize   456
customize groups   458
customize icons   458
list of all ribbon commands and menu commands  
809
manage   458
reset   458
show/hide   457
user interface   30, 431, 456

Ribbon or menus with toolbars?   28, 431

RIGHT (right part of a text string)   733

Right align   199

ROMAN (Roman numeral)   734

Root  
n-th root (ROOTN)   734
square root (SQRT)   753
square root of x*Pi (SQRTPI)   753

ROOTN (n-th root)   734

Rotate   199
axis labels   336, 337, 339, 341
cell contents   199
objects   263, 272
text in AutoShapes   306
text in text frames   281, 283

Rotate or flip (objects)   263

Round  
CEILING   521
EVEN   584
FIXED   594
FLOOR   595
INT   634
MROUND   682
ODD   703
ROUND   735
ROUNDDOWN   736
ROUNDUP   737
TRUNC   787

ROUND (round to n digits)   735

ROUNDDOWN (round down to n digits)   736

Rounding  
display numbers rounded   184
final result   449
intermediate results   449
precision as displayed   449

ROUNDUP (round up to n digits)   737

Row  
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Row  
change height   181, 182
delete   69, 70
hide/show   183
insert   71
optimum height   182
select   65

Row & column headers   452

ROW (function: row number of cells)   738

Row header  
change row height   182
print   244
show/hide   452
use for selection   65

Row number of cells (ROW)   738

ROWS (function: number of rows in a range)   738

RRI (interest rate)   739

RSQ (square of Pearson)   740

S
Save (File)   48

Save all (File)   48

Save as (File)   48, 409

Scale document   431

Scaling (of printed pages)   244

Scan pictures   287

Scenarios   117

Scientific (number format)   186

Scribble mode on iOS   33

Scripts   353, 414, 418

Scrollbars (form object)   360

Scrollbars, show/hide   447

Search (file manager)   379

Search (function)  
FIND (search for text)   590
FIND (search text in string)   740
HLOOKUP   612, 804
LOOKUP   663
SEARCH (search text in string)   740
VLOOKUP   798

Search (ribbon command Home | Search)   253, 255
cell contents   253
search again   255

Search again   255

Search files (file manager)   379

SECOND (second)   741

Secondary axes (in charts)   345, 346

Select   65
cells   65
objects   260

Select all   65, 261

Select chart elements   325

Select source (file)   287

Send a document by e-mail   400

Send backward one level (object)   264

Send to back (object)   264

Series axis (in charts)   317, 339, 341

SERIESSUM (sum of a power series)   742

Set as default  
document template   44
object properties   279

Settings (PlanMaker)   423, 424
Appearance tab   431
Backup tab   437
Edit tab   427
Files tab   436
Fonts tab   441
General tab   426
Language tab   435
System tab   438
View tab   424

Settings (SoftMaker Office)  
export/import   442
reset   442

Shading (of cells)   197

Shadow (for objects)   275

Share a document (via Android/iOS)   400

Sheet  
change properties   85
copy   85
delete   85
hide sheet   85
insert   84
move   85
rename   85
show sheet   85
visibility   85

SHEET (index of a worksheet)   742

Sheet direction   416, 452

Sheet grid (gridlines), show   452

Sheet protection   402, 404

SHEETNAME (name of a worksheet)   743

SHEETNUMBER (compatibility function)   744

SHEETS (number of worksheets)   744

Shortcut keys  
customize   473
for cell styles   220
for character styles   214, 215
for special characters   178
predefined: Mac   825
predefined: Windows/Linux   825

Show cells   183
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Show fonts in font list   431

Show formulas   104

Show hidden files and folders   438

Show hidden objects   267, 447

Show indicators (for comments)   447

Show tooltips  
for commands   431
for formulas   427

Show warning when loading OLE objects   426

Show watch list   106

Show/hide chart elements   316
axes (X, Y, Z)   317
axis title   317
chart title   318, 346
data labels   319
error bars   320
gridlines   320
legend   321
lines   322
trendline   323
up/down bars   324

Show/hide keyboard automatically   438

Sidebar for the pivot table   145

Sign (operator)   482

SIGN (sign of a number)   745

SIN (sine)   746

Sine (SIN)   746

SINH (hyperbolic sine)   746

Size  
of cells   181
of objects   262

SKEW (skewness of a distribution)   747

SLN (straight-line depreciation)   748

SLOPE (slope of a linear trend)   748

SMALL (k-th smallest number)   749

Small caps   206

SmartText   371, 373

SmartText entries  
create   372
edit   373
expand   427
insert   373
replace automatically   373

Smooth edges of pictures   438

Smooth edges of screen fonts   431

Snapshots (backup copies)   382, 437

Soft edges effect (for objects)   277

Soft hyphen   178

SoftMaker   23

SoftMaker Basic   418

SoftMaker Equation Editor   298

Sort and filter   93, 96

SORTM (sort function)   750

SORTV (sort function)   751

Spaces, different widths   178

Special filter   101

Spell check   365
as you type   367, 435
edit user dictionaries   367
install additional dictionaries   478
manual   365
set language   364

Spinners (form object)   359

SQRT (square root)   753

SQRTPI (square root of x*Pi)   753

Standard deviation  
entire population (STDEV.P)   757
entire population (STDEVP)   756
entire population (STDEVPA)   757
sample (STDEV)   754
sample (STDEV.S)   758
sample (STDEVA)   755

Standard error of a linear regression (STEYX)   759

Standard normal distribution  
GAUSS   604
NORM.S.DIST   694
NORM.S.INV   696
NORMSDIST   694
NORMSINV   695
PHI   713

Standard toolbar   32

STANDARDIZE (standardized value)   754

Start script   418

Statistics (of document)   447

Statistics of a regression  
LINEST (linear)   654
LOGEST (exponential)   658

Status bar   38
show/hide   431

STDEV (standard deviation of a sample)   754

STDEV.P (standard deviation of entire population)  
757

STDEV.S (standard deviation of a sample)   758

STDEVA (standard deviation of a sample)   755

STDEVP (standard deviation of entire population)   756

STDEVPA (standard deviation of entire population)  
757

STEYX (standard error of a linear regression)   759

Stock chart   311

Strikethrough   206

Student’s t-distribution  
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Student’s t-distribution  
T.DIST   775
T.DIST.2T (two-tailed)   775
T.DIST.RT (right-tailed)   776
T.INV (left-tailed)   781
T.INV.2T (two-tailed)   782
TDIST   774
TINV   780

Student’s t-test (T.TEST)   789

Student’s t-test (TTEST)   788

Subscripts   208

SUBSTITUTE (replace text in a text string)   760

SUBTOTAL (calculations without hidden cells)   761

Subtraction (operator)   482

SUM (Sum)   762

SUMIF (sum if condition is true)   764

SUMIFS (sum if conditions are true)   765

SUMPRODUCT (sum of products)   766

SUMSQ (sum of squares)   767

SUMX2MY2 (sum of x^2 - y^2)   768

SUMX2PY2 (sum of x^2 + y^2)   769

SUMXMY2 (sum of (x - y)^2)   769

Superscripts   208

Support   23

Surface chart   311

SWITCH (categorize initial value)   770

SYD (sum-of-years’ digits depreciation)   771

Syntax highlighting   105

System requirements   24

T
T (convert value into text string)   772

T.DIST (t-distribution)   775

T.DIST.2T (t-distribution two-tailed)   775

T.DIST.RT (t-distribution right-tailed)   776

T.INV (percentiles of the t-distribution left-tailed)   781

T.INV.2T (percentiles of the t-distribution two-tailed)  
782

T.TEST (t-test)   789

Tab width (in text frames)   447

Table (ribbon tab)   130

Tables in worksheets   128
banded rows and columns   133
cell references   136
convert to range   131
create   129
delete rows/columns   131
delete table   131
emphasize first column   133

emphasize last column   133
expand automatically   427
insert rows/columns   131
name of table   136
select rows/columns   131
select table   131
summarize as pivot table   130
table name   133
table properties   133
table range   131
table styles   133
totals row   135
using names and specifiers   136

Tablet mode (Android/iOS)   431

Tabs for documents   37, 419

TAN (tangent)   773

Tangent (TAN)   773

TANH (hyperbolic tangent)   774

TDIST (t-distribution)   774

t-distribution  
T.DIST   775
T.DIST.2T (two-tailed)   775
T.DIST.RT (right-tailed)   776
T.INV (left-tailed)   781
T.INV.2T (two-tailed)   782
TDIST   774
TINV   780

Technical support   23

Template folder   436

Text  
copy   73
cut   73
delete   73
enter   61
paste   73

TEXT (convert number into text string)   777

Text (number format)   186

Text (Object properties tab)   307

Text alignment (text frame)   212

Text direction   415, 416

Text filters (AutoFilter)   96

Text frame  
paragraph format   210

Text frames   281
add/edit text   302
change properties   281, 283
change text area   285
hyphenation   368
insert   281

Text input mode   38

Text strings  
compare (EXACT)   584
concatenate (CONCAT)   532
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Text strings  
concatenate (CONCATENATE)   533
concatenate (TEXTJOIN)   777
convert into a number (VALUE)   792
convert to a number (NUMBERVALUE)   699
cut a part (LEFT)   654
cut out part (RIGHT)   733
cut part (MID)   671
repeat n times (REPT)   733

Text styles   203, 206

Text to columns, split   92

TextArt objects  
change properties   307
drawing   300
transformation   307

TEXTJOIN (concatenate strings with separators)   777

TextMaker file format   409

Thousands separator   427

Three dimensional calculations   55, 87

Threshold value (GESTEP)   606

TIME (create time)   778

Time, enter   61

TIMEDIFF (time difference)   779

TIMEVALUE (convert text into time)   780

TINV (percentiles of the t-distribution)   780

Title (of charts)   346

Title bar   29

TODAY (current date)   783

Toolbar   32

Toolbars for Android/iOS  
customize   33
user interface   33, 431

Toolbars for classic menus  
create user-defined icons   473
customize   464, 468
delete   467
locked   466
manage   467
position   466
rename   467
reset   467
show/hide   464
user interface   431, 464
visible in mode   464

Top row, freeze   176

Touch mode   431

Trace to error   107

Transformation (of TextArt objects)   307

Transparency (of pictures)   289

Transpose  
matrix (MTRANS)   783
ribbon command Data | Edit   92

TRANSPOSE (transpose matrix)   783

TREND (values of a linear regression)   784

Trendline (in charts)   323, 334

TRIM (remove spaces from text)   785

TRIMMEAN (mean without marginal values)   786

TRUE (logical value TRUE)   787

TRUNC (truncate a number)   787

TTEST (t-test)   788

TYPE (type of a value)   789

U
Underline (font)   206

Undo (changes)   43, 64

Ungroup  
cells (outliner)   386
objects   266

Unit conversion (CONVERT)   536

Unit of measure   431

Unpinned files   46

Unpinned templates   44

Up/down bars (in charts)   324, 330

Update  
charts   348, 449
external references   488
pivot tables   172
worksheet (calculations)   111, 449

Updates   438

Upper  
option for the charcater format   206
PROPER (function)   722
UPPER (function)   790

UPPER (convert text to upper case)   790

Use left Alt as shortcut key   427

Use OpenGL engine   438

Use SHM extensions   438

Use system file dialogs   431

Use system menus   431

Use XIM   438

User dictionaries   367

User info   426, 791

User info (USERFIELD)   791

User interface (ribbon or menus?)   28, 431

User interface on Android/iOS   33, 431

User interface size   431

User-defined number formats   189, 190

USERFIELD (output user info)   791
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V
VALUE (convert text into a number)   792

Value axis (in charts)   317, 337

VAR (variance of a sample)   793

VAR.P (variance of entire population)   795

VAR.S (variance of a sample)   797

VARA (variance of a sample)   794

Variance  
of a sample (VAR)   793
of a sample (VAR.S)   797
of a sample (VARA)   794
of entire population (VAR.P)   795
of entire population (VARP)   795
of entire population (VARPA)   796

VARP (variance of entire population)   795

VARPA (variance of entire population)   796

VBA scripts   353, 414, 418

Version management   382, 437

Vertical alignment  
of cell contents   199
of text frames   281, 283
of text in AutoShapes   306

Vertical text   199

View  
edit mode   261
full screen   455
object mode   261
touch mode   431
windows   421
zoom level   454

View side by side (windows)   421

Visibility  
columns   183
rows   183
worksheet   85

Visual Basic   418

VLOOKUP (look up column-wise)   798

W
Walls (in charts)   329

Warning if a formula contains errors   427

Watch window   106

Weber function (BESSELY)   510

Week number  
ISOWEEK   646
ISOWEEKNUM   647
WEEKNUM   800

WEEKDAY (weekday)   799

WEEKNUM (week number)   800

WEIBULL (Weibull distribution)   801

WEIBULL.DIST (Weibull distribution)   802

Width of a column   181, 182

Window  
close all   422
view side by side   421

Workbook   83

Workbook properties   445

Workbook protection   405
disable   406
enable   405

WORKDAY (date after x workdays)   803

Workdays  
count (NETWORKDAYS)   689
date after x workdays (WORKDAY)   803

Worksheet   83, 452
alternating shade   452
change properties   85, 452
change sheet direction   452
copy   85
delete   85
hide sheet   85
insert   84
move   84, 85
rename   84, 85
select multiple   84
show sheet   85
visibility   85

Worksheet register   37, 84
change color   452
display   447
font size   424

Worksheets  
edit   59
format   180
protect   402
select   65
update calculations   111, 449

Workspace color   431

Wrap text   199

X
X axis (in charts)   317, 336

XLS file format   409

XLSX file format   409

XNPV (net present value)   805

XOR (logical XOR function)   805

XY scatter chart   311
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Y
Y axis (in charts)   317, 337

YEAR (year of a date)   806

Z
Z axis (in charts)   317, 339, 341

Z.TEST (z-test)   807

Zeros, show/hide  
for number formats of cells   184
worksheet properties   452

Zoom level (view)   454

z-test  
Z.TEST   807
ZTEST   807

ZTEST (z-test)   807
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